This is a publication of Sage Software, Inc.

Copyright © 2015. Sage Software, Inc. All rights reserved.

Sage, the Sage logos, and the Sage product and service names mentioned herein are registered trademarks or trademarks of Sage Software, Inc. or its affiliated entities. All other trademarks are the property of their respective owners.

Business Objects® and the Business Objects logo, BusinessObjects®, and Crystal Reports® are trademarks or registered trademarks of Business Objects Software Ltd. in the United States and in other countries. Business Objects is an SAP company.

Microsoft ®SQL Server®, Windows Vista® and the Windows logo are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or in other countries.

The names of all other products and services are property of their respective owners.

Your use of this document and the Sage product(s) described herein is governed by the terms and conditions of the Sage End User License Agreement ("EULA") or other agreement that is provided with or included in the Sage product. Nothing in this document supplements, modifies or amends those terms and conditions. Except as expressly stated in those terms and conditions, the information in this document is provided by Sage "AS IS" and Sage disclaims all express, implied or statutory warranties of any kind, including but not limited to the warranties of merchantability, fitness for a particular purpose or of non-infringement. No implied license is granted to you under any Sage intellectual property or trade secret right. Sage reserves the right to revise, supplement or remove information in this document at any time without notice to you or others.

Sage End User License: http://na.sage.com/sage-na/eula

Last updated: March 16, 2015
Contents

Introduction ........................................................................................................................................... 1

Chapter 1: Setting Up Inventory Control .............................................................................................. 5
Setting Up Inventory Control .................................................................................................................. 5
About Using Inventory Control with Other Sage 300 ERP Programs ................................................... 7
About Importing and Exporting Inventory Control Records ............................................................... 7
   Records You Can Import and Export .................................................................................................... 8
   Records You Can Import Only .............................................................................................................. 9
   Records You Can Export Only ........................................................................................................... 9
   Export Formats ................................................................................................................................... 9
   Import Formats .................................................................................................................................... 10
About Planning Your Item Numbering System .................................................................................... 10
   Sorting Order for Item Numbers ......................................................................................................... 12
   Summary of the Rules for Item Numbers ............................................................................................. 12
Setting Up Multicurrency Accounting in Inventory Control ................................................................. 13
Costing Methods ..................................................................................................................................... 14
   About FIFO and LIFO Costing Methods ............................................................................................ 15
   About the Standard Costing Method .................................................................................................... 16
   About the Moving Average Costing Method ....................................................................................... 17
   About the Most Recent Costing Method ............................................................................................. 17
   About the User-Specified Costing Method .......................................................................................... 18
   About Serial and Lot Costing Methods ............................................................................................... 18
Costing Methods Reference List ............................................................................................................ 19
Selecting Options for Inventory Control ............................................................................................... 21
   About Inventory Control Processing Options ..................................................................................... 21
   About Creating G/L Transactions ......................................................................................................... 31
   About Consolidating G/L Batches ......................................................................................................... 32
   Changing Inventory Control Options .................................................................................................. 34
Adding Historical Information ................................................................................................................ 38
About Entering Current and Historical Transactions .................................................. 38
Adding or Editing Transaction Statistics ........................................................................ 39
Adding Current Sales and Return Statistics ................................................................. 40
Account Sets ................................................................................................................. 41
  About Account Sets ........................................................................................................ 41
  Adding Account Sets ...................................................................................................... 43
  About Deleting Account Sets ......................................................................................... 46
Categories ...................................................................................................................... 47
  About Categories ............................................................................................................. 47
  Setting Up Categories .................................................................................................... 49
  About Deleting Categories ............................................................................................. 51
Inventory Locations ........................................................................................................ 52
  About Setting Up Locations ............................................................................................ 52
  About Deleting Locations ............................................................................................... 53
Segment Codes ................................................................................................................ 53
  About Segment Codes .................................................................................................... 54
  About Overriding General Ledger Account Segments for Locations ......................... 55
Item Structures ................................................................................................................ 55
  About Item Number Formats ......................................................................................... 55
  Adding Item Structures ................................................................................................. 59
Mask Structures .............................................................................................................. 61
  About Mask Structures .................................................................................................. 61
  Adding Mask Structures ................................................................................................. 61
  Changing or Deleting Mask Structures ......................................................................... 62
Contract Codes ................................................................................................................ 63
  Adding Contract Codes .................................................................................................. 63
Warranty Codes ................................................................................................................ 64
  Adding Warranty Codes ................................................................................................. 64
Price List Codes ............................................................................................................... 65
  Adding Price List Codes ................................................................................................. 65
Optional Fields ................................................................................................................ 69
  Setting Up Optional Fields for Inventory Control Records and Transactions ............... 69
### Contents

G/L Integration .......................................................................................................................... 72
  * Using Inventory Control with General Ledger ................................................................. 72
  * General Ledger Integration Options ............................................................................... 73
  * Changing I/C General Ledger Integration Options ......................................................... 77
Integration With Other Programs ............................................................................................. 79
  * Using Inventory Control with Order Entry ................................................................. 79
  * Using Inventory Control with Purchase Orders ............................................................ 80
  * Using Inventory Control with Project and Job Costing ............................................... 80
  * About Using Inventory Control with Sage Fixed Assets .............................................. 81
Units Of Measure .................................................................................................................. 82
  * About Units of Measure ................................................................................................. 82

### Chapter 2: Setting Up Items and Price Lists ................................................................. 85

Setting Up Price Lists ............................................................................................................ 85
  * About Price Lists ........................................................................................................ 86
  * Adding Items to Price Lists ......................................................................................... 91
  * Copying Pricing Information to Other Price Lists or Currencies ............................. 99
  * Changing Pricing Information for Single Items ......................................................... 102
  * Updating Pricing Information for Groups of Items ...................................................... 104
Setting Up Inventory Items .................................................................................................. 106
  * About Setting Up Inventory Items ............................................................................. 106
  * About Alternate Items .............................................................................................. 108
  * About Non-Stock Items ............................................................................................ 109
  * Adding Inventory Items Using the Items Wizard ......................................................... 109
  * Adding Item Records ............................................................................................... 112
  * Adding Current Item Quantities and Costs ............................................................... 117
  * Assigning Inventory Valuation Methods to Items ...................................................... 119
  * Assigning Units of Measure to Items ....................................................................... 121
  * Assigning Weight Units of Measure to Items ............................................................ 123
  * About Editing Item Records ...................................................................................... 126
  * About Changing Item Category or Account Set .......................................................... 126
  * Editing an Item Record ............................................................................................ 127
## Chapter 3: Entering and Posting Inventory Control Transactions ......................................................... 165

About Transaction Processing in Inventory Control ................................................................. 165
  Posting Transactions ...................................................................................................................... 165
  Costing During Posting or at Day End .......................................................................................... 166
  Printing the Audit Trail ............................................................................................................... 166

Processing Assemblies .................................................................................................................. 166
  About Processing Assemblies and Disassemblies .................................................................... 167
  About Assembling Master Items that Use FIFO or LIFO Costing Methods ............................ 169
  Assembling Items from Bills of Material .................................................................................... 170
  Disassembling Master Items ....................................................................................................... 172

Processing Adjustments ................................................................................................................ 175
  About Processing Adjustments .................................................................................................... 175
  Adjustment Types ....................................................................................................................... 176
  About Adjustments to Items that Use FIFO or LIFO Costing .................................................... 178
  Adjusting Item Quantities and Costs .......................................................................................... 179
  About Adjustment Details .......................................................................................................... 182

Processing Receipts and Returns .................................................................................................... 183
  About Receipts ............................................................................................................................ 184
  Receiving Goods from Vendors .................................................................................................... 184
  About Receipt Adjustments .......................................................................................................... 187
  Entering Adjustments to Existing Receipts .................................................................................. 188
  Posting Saved Receipts ............................................................................................................... 190
  About Returns ............................................................................................................................. 190
  Returning Goods to Vendors ....................................................................................................... 191

Processing Shipments and Customer Returns .............................................................................. 193
  About Shipments ......................................................................................................................... 193
Contents

Shipping Goods to Customers ................................................................. 196
Receiving Returned Goods from Customers .............................................. 199
Processing Transfers ............................................................................... 201
  About Transfers .................................................................................. 202
  About Transferring Stock Items that Use FIFO or LIFO Costing ................. 206
Transferring Goods between Two Inventory Locations ................................ 206
Transferring Goods Using a Goods-In-Transit Location ................................. 210
Receiving Goods from a Goods-In-Transit Location ...................................... 214
Processing Internal Usage Transactions .................................................... 217
  About Internal Usage Transactions ....................................................... 217
  Using Goods Internally ....................................................................... 218
  Identifying an Inventory Item as a Fixed Asset for Sage Fixed Assets .......... 220
About Using Optional Fields in Transactions ............................................. 223
  Editing Optional Field Information in Transactions .................................. 224
Using Optional Fields in Transactions ...................................................... 225
Posting Inventory Transactions ................................................................ 226
Journal Entries Generated by Posting or Day-End Processing ....................... 228
  Types of Journal Entries ..................................................................... 228
  Journal Entry Source Codes .................................................................. 230

Chapter 4: Keeping Track of Physical Inventory ....................................... 231
About Physical Inventory ........................................................................... 231
Counting and Reconciling Inventory Quantities ........................................ 232
Generating Inventory Worksheets for Stocktaking .................................... 233
Using Average (Actual) Cost for Physical Inventory Adjustments ................ 235
Entering Physical Inventory Quantities ....................................................... 236
Posting an Inventory Reconciliation ......................................................... 238
Inventory Reconciliation Errors ................................................................ 239
Deleting Inventory Reconciliations ............................................................ 241

Chapter 5: Serialized Inventory and Lot Tracking ...................................... 243
About Serialized Inventory and Lot Tracking ............................................. 243
Chapter 7: Looking Up Statistics and Information in Inventory Control ......................................................... 285
Looking Up Sales Statistics ................................................................. 285
Looking Up Stock Transactions ......................................................... 285
Looking Up Transaction Statistics ..................................................... 286
Looking Up Sales Orders or Purchase Orders by Item ............................ 287
Looking Up Current Order Entry and Purchase Orders Transactions ........ 288
Looking Up Serial Number Information ............................................. 289
Looking Up Lot Number Information ................................................ 290
Looking Up Transaction History ........................................................ 291
Looking Up Bills of Material by Component ......................................... 292
Looking Up Costs of LIFO and FIFO Items .......................................... 292

Chapter 8: Printing Inventory Control Reports ........................................ 295
Inventory Control Reports .................................................................... 295
About Audit Trail Reports .................................................................... 297
  Posting Journals .............................................................................. 298
About Posting Journals ..................................................................... 298
Report Printing Options ...................................................................... 298
Selecting a Print Destination ............................................................... 299
Selecting a Printer for Reports ........................................................... 300
Printing Setup Reports ....................................................................... 301
  Printing the Account Sets Report ...................................................... 302
  Printing the Alternate Items Report .................................................. 303
  Printing the Bills of Material Report ................................................ 304
  Printing the Categories Report ......................................................... 306
  Printing the Customer Details Report .............................................. 307
  Printing the G/L Integration Report .................................................. 308
  Printing the Item Structures Report ............................................... 309
  Printing the Mask Structures Report ............................................... 310
  Printing the Kitting Items Report ..................................................... 311
  Printing the Location Details Report ............................................... 312
Printing the Locations Report ................................................................. 313
Printing the Manufacturers’ Items Report ........................................ 314
Printing the Optional Fields Report ...................................................... 315
Printing the Options Report ................................................................. 316
Printing the Price List Codes Report ..................................................... 317
Printing the Reorder Quantities Report ................................................ 318
Printing the Segment Codes Report ...................................................... 319
Printing the Units of Measure Report .................................................... 321
Printing the Vendor Details Report ....................................................... 321
Printing the Warranty/Contract Codes Report ....................................... 323
Printing the Weight Units of Measure Report ........................................ 324
Printing Physical Inventory Reports ....................................................... 325
  Printing the Inventory Worksheet ....................................................... 325
  Printing Inventory Worksheets for Stocktaking .................................... 327
  Printing the Inventory Reconciliation Report ...................................... 329
Printing Stock Control Reports .............................................................. 330
  Printing the Aged Inventory Report .................................................... 331
  Printing Bin/Shelf Labels .................................................................. 333
  Printing the Inventory Movement Report ........................................... 335
  Printing Item Labels ........................................................................ 336
  Printing the Item Status Report ......................................................... 338
  Printing the Item Valuation Report ..................................................... 340
  Printing the Overstocked Items Report .............................................. 342
Printing the Quarantine Report .............................................................. 344
Printing the Recall Report ................................................................. 345
Printing the Reorder Report ................................................................. 346
Printing the Serial/Lot Number List Report ......................................... 348
Printing the Serial/Lot Number Quantity on Hand Report .................... 350
Printing the Serial/Lot Stock Listing Report ......................................... 351
Printing the Serial/Lot Transactions Report ......................................... 353
Printing the Slow Moving Items Report ............................................... 354
Printing the Stock Transactions Report ............................................... 356
Contents

Printing Transfer Slips ................................................................. 357
Printing the Warranty/Contract List Report .................................. 359
Printing Price/Sales Analysis Reports ........................................... 360
Printing the Contract Pricing Report .......................................... 361
About Reporting General Ledger Data ....................................... 362
Printing the G/L Transactions Report ......................................... 362
Printing the Markup Analysis Report ......................................... 364
Printing Posting Journals ............................................................. 365
Printing the Price Lists Report ..................................................... 368
Printing the Sales Statistics Report ............................................. 369
Printing the Selling Price/Margin Analysis Report ....................... 371
Printing the Transaction History Report ..................................... 372
Printing the Transaction Statistics Report .................................. 374
Printing Transaction Listings ....................................................... 375

Appendix A: Inventory Control Screen Guides ............................... 379

Items and Price Lists Screens ....................................................... 379
   I/C Bills of Material Screen .................................................... 380
   I/C Construct Item Number Screen ....................................... 383
   I/C Contract Pricing Screen ................................................ 385
   I/C Copy Bills of Material Screen ......................................... 387
   I/C Copy Item Pricing Screen .............................................. 391
   I/C Customer Details Screen ............................................... 395
   I/C Items Screen ............................................................... 396
   I/C Items Wizard ............................................................... 406
   I/C Item Pricing Screen ...................................................... 439
   I/C Kitting Items Screen ...................................................... 453
   I/C Location Details Screen ................................................ 454
   I/C Manufacturers' Items Screen ......................................... 459
   I/C Optimize Inventory Screen ............................................. 460
   I/C Reorder Quantities Screen ............................................. 471
   I/C Update Bills of Material Screen ..................................... 474

xii Sage 300 ERP Inventory Control
I/C Update Item Pricing Screen ................................................................. 475
I/C Vendor Details Screen ...................................................................... 479
I/C Serial Numbers Screen .................................................................... 481
I/C Lot Numbers Screen ......................................................................... 482
Periodic Processing Screens ................................................................... 483
  I/C Process Adjustments Screen .......................................................... 483
  I/C Create G/L Batch Screen ................................................................ 486
  I/C Delete Inactive Records Screen ..................................................... 487
  I/C Clear History Screen ..................................................................... 488
  I/C Day End Processing Screen ........................................................... 492
  I/C Lot Recalls/Releases Screen ............................................................ 493
  I/C Lot Splits/Combines Screen ............................................................ 495
  I/C Quarantine Release Screen .............................................................. 499
  I/C Serial/Lot Reconciliation Screen .................................................... 499
  I/C Serial Registration Screen ............................................................. 500
  I/C Warranty Update Screen .................................................................. 502
Physical Inventory Screens ....................................................................... 504
  I/C Generate Inventory Worksheet Screen ........................................ 504
  I/C Inventory Counts Screen ................................................................ 507
  I/C Physical Inventory Quantities Screen .......................................... 508
  I/C Post Inventory Reconciliation Screen ......................................... 512
Report Screens ....................................................................................... 515
  Physical Inventory Reports .................................................................. 515
  Stock Control Reports Screens .......................................................... 519
  Price Sales Analysis Report Screens ................................................. 531
  Setup Reports ..................................................................................... 544
  I/C Transaction Listing Report Screen ............................................. 557
Setup Screens .......................................................................................... 561
  I/C Account Sets Screen ..................................................................... 561
  I/C Categories Screen ......................................................................... 565
  I/C Contract Codes Screen .................................................................. 570
  I/C G/L Integration Screen ................................................................. 571
I/C Item Structures Screen ................................................................. 579
I/C Locations Screen ................................................................. 581
I/C Mask Structures Screen ................................................................. 586
I/C Options Screen ................................................................. 588
I/C Optional Fields Screen ................................................................. 608
I/C Price List Codes Screen ................................................................. 612
I/C Segment Codes Screen ................................................................. 617
I/C Units of Measure Screen ................................................................. 618
I/C Warranty Codes Screen ................................................................. 619
I/C Weight Units of Measure Screen ................................................................. 620
Statistics and Inquiries Screens ................................................................. 622
I/C Sales Statistics Screen ................................................................. 622
I/C Transaction Statistics Screen ................................................................. 625
I/C Current Transactions Inquiry Screen ................................................................. 628
I/C Transaction History Inquiry Screen ................................................................. 629
I/C LIFO/FIFO Inquiry Screen ................................................................. 631
I/C BOM Component Usage Inquiry Screen ................................................................. 632
I/C Item Location Details Quantity Inquiry Screen ................................................................. 633
I/C Stock Transactions Inquiry Screen ................................................................. 635
I/C Serial Number Inquiry Screen ................................................................. 638
I/C Lot Number Inquiry Screen ................................................................. 640
Transactions Screens ................................................................. 643
I/C Adjustments Screen ................................................................. 643
I/C Assemblies/Disassemblies Screen ................................................................. 650
I/C Internal Usage Screen ................................................................. 658
I/C Lot Number Transaction Inquiry Screen ................................................................. 666
I/C Post Transactions Screen ................................................................. 666
I/C Receipts Screen ................................................................. 667
I/C Serial/Lot Numbers Allocation/Generation Screen ................................................................. 677
I/C Shipments Screen ................................................................. 680
I/C Transfers Screen ................................................................. 688
I/C Optional Fields Screen ................................................................. 696
Appendix B: Inventory Control Security Authorizations .......... 699

Appendix C: Data Entry Tools, Tips, and Shortcuts .................. 705
Inventory Control Menu Commands ........................................... 705
    File Menu ........................................................................ 705
    Settings Menu .................................................................. 706
    Help Menu ....................................................................... 707
Data Entry Tools and Shortcuts .............................................. 707
Working with Detail Entry Tables ......................................... 711
Keyboard Shortcuts for Detail Tables ..................................... 712
Setting Finder Criteria ......................................................... 712

Appendix D: Support and Resources ...................................... 715
Finding Help and Documentation ............................................ 715
    The Sage 300 ERP Learning Center .................................. 715
    Context-Sensitive Help ....................................................... 715
    Product Documentation ...................................................... 716
Support and Resources ......................................................... 716
    How can we help you? ....................................................... 716

Index ................................................................................. 719
Introduction

Inventory Control maintains detailed perpetual inventory records and produces reports to help you manage your stock effectively.

Regardless of the size and complexity of your business, you can adapt Inventory Control to meet your needs. Inventory Control easily handles the requirements of your existing inventory system and offers many flexible features you can use to manage your inventory effectively.

You can use Inventory Control by itself or as part of an integrated system with other Sage 300 ERP accounting programs. You can also transfer Inventory Control data to and from spreadsheet and database programs.

The *Inventory Control User’s Guide* contains the following chapters:

- **Chapter 1: Setting Up Inventory Control**
  
  Set up records (such as account sets, locations, item structures, and units of measure) and specify options that determine how Inventory Control processes transactions and interacts with other Sage 300 ERP modules.

- **Chapter 2: Setting Up Items and Price Lists**
  
  Item records contain the information you need to manage your inventory. You must add inventory item records to Inventory Control before you can enter inventory transactions.

  You use price lists to store pricing information for all of your inventory items. You create price lists by adding items and prices to price list codes.

  You can have as many price lists as you need to handle different locations, different countries, and different currencies.

  Besides adding item records and creating price lists, you may need to create additional records to set up your Inventory Control system, depending on the Inventory Control features your company uses.

- **Chapter 3: Entering and Posting Inventory Control Transactions**
  
  Use Inventory Control transaction entry screens to record the receipt, shipment, return, and internal usage of inventory items, transfers of stock between locations, assemblies of master items from component items, and adjustments of quantities and costs of items.
Chapter 4: Keeping Track of Physical Inventory

Discrepancies between item quantities maintained by the program (quantities on hand) and your physical inventory count can occur for various reasons, such as shrinkage, missing receipts, or theft.

Use the screens in the I/C Physical Inventory folder to enter the results of physical inventory counts into your system and reconcile physical inventory totals with the totals in Inventory Control.

Chapter 5: Managing Serialized and Lotted Items

If you have a license to use Serialized Inventory and Lot Tracking, you can assign serial numbers and/or lot numbers to items when you process transactions in Inventory Control. You use the serial numbers and lot numbers to track items from their receipt in inventory to their sale to customers and beyond.

Chapter 6: Periodic Processing in Inventory Control

Use the Day End Processing screen to process transactions posted in Inventory Control, Order Entry, and Purchase Orders. Depending on options selected for your Inventory Control system, Day End Processing may update general ledger transactions, item statistics, transaction history, and item costs.

Use the other screens in the Periodic Processing folder to perform the tasks that are part of your regular period-end procedures, such as reconciling physical inventory, processing adjustments, clearing history, creating general ledger batches, and deleting inactive records.

Chapter 7: Looking Up Statistics and Information in Inventory Control

Use Inventory Control Statistics and Inquiries screens to look up information about inventory items and transactions.

Chapter 8: Printing Inventory Control Reports

Use Inventory Control report screens to print setup reports, stock control reports, and analytical reports.

Appendix A: Inventory Control Screen Guides

Learn how to find and use Inventory Control screens. Each screen guide includes navigation information, field help, and a list of tasks you can use the screen to perform.
• **Appendix B: Inventory Control Security Authorizations**
  
  If security is turned on for your Sage 300 ERP system, the system administrator must assign users security authorization for Inventory Control screens.

• **Appendix C: Data Entry Tools, Tips, and Shortcuts**
  
  Use these tools and shortcuts to speed up data entry in Sage 300 ERP.

• **Appendix D: Support and Resources**
  
  Find support and resources to help get Sage 300 ERP up and running quickly.
Chapter 1: Setting Up Inventory Control

Set up records (such as account sets, locations, item structures, and units of measure) and specify options that determine how Inventory Control processes transactions and interacts with other Sage 300 ERP modules.

Setting Up Inventory Control

This topic lists all the steps for setting up a new Inventory Control ledger.

Before you start:

- Install the Sage 300 ERP System Manager (with Tax Services, if needed) and Sage 300 ERP General Ledger (if you have it), and then install Inventory Control.
- Create a company database and choose company-wide options in Common Services.
- Activate Tax Services (if needed).
- If needed, add tax information and currencies used in your inventory control system.
- If you have General Ledger, set it up before setting up Inventory Control.

Step 1: Activate Inventory Control, select options, and add background information

- Activate the Inventory Control program for your data.
- Use the I/C Options screen to specify how your system will operate. For more information, see "I/C Options Screen" (page 588).
- Use the I/C G/L Integration screen to specify how your system sends transactions to the General Ledger module. For more information, see "I/C G/L Integration Screen" (page 571).
- Design coding schemes for your Inventory Control records.
- Add setup records and print reports:
Step 2: Add inventory items

Note: You can use the Items Wizard to add all of the information for new inventory items, or you can use the individual screens in the Items and Price Lists folder to perform these tasks separately.

- "Adding Item Records" (page 112)
- "Adding Items to Price Lists" (page 91)
- "Assigning Items to Locations" (page 138)
- "Adding Bills of Material" (page 155) (optional)
- "I/C Vendor Details Screen" (page 479) (optional)
- "About Reorder Information" (page 144) (optional)
- "About Manufacturers' Items" (page 142) (optional)
About Using Inventory Control with Other Sage 300 ERP Programs

Step 3: Transfer your accounting data to Inventory Control

- "Adding Current Item Quantities and Costs" (page 117)
- "I/C Customer Details Screen" (page 395) (optional)
- "I/C Kitting Items Screen" (page 453) (optional)

Step 4: Design label formats for your preprinted forms

- Design and test formats for printing item labels, bin/shelf labels, and transfer slips, or adapt the sample formats to print on your own forms.

About Using Inventory Control with Other Sage 300 ERP Programs

Inventory Control functions as a stand-alone inventory system or as the central component in a full inventory management system. For example, you can combine Inventory Control with Order Entry to automate order processing and with Purchase Orders to handle inventory purchasing.

For more information, see the following topics:

- "Using Inventory Control with General Ledger" (page 72)
- "Using Inventory Control with Order Entry" (page 79)
- "Using Inventory Control with Purchase Orders" (page 80)
- "Using Inventory Control with Project and Job Costing" (page 80)
- "Identifying an Inventory Item as a Fixed Asset for Sage Fixed Assets" (page 220)

About Importing and Exporting Inventory Control Records

If you have a computerized inventory control system, you may be able to transfer records directly into Inventory Control by importing them.
You can also export records from another Sage 300 ERP Inventory Control database, edit them in a spreadsheet or other program to change codes, amounts, and other information, then import them into the new Sage 300 ERP Inventory Control system you are setting up.

**Records You Can Import and Export**

Inventory Control records you can both import and export include:

- Account sets
- Adjustments
- Assemblies/disassemblies
- Bills of material
- Categories
- Contract pricing
- Customer details
- Item pricing
- Item structures
- Item records
- Location details
- Locations
- Manufacturers' Items
- Physical inventory quantities
- Price list codes
- Receipts
- Reorder quantities
- Sales statistics
- Segment codes
- Shipments
- Transaction statistics
- Transfers
About Importing and Exporting Inventory Control Records

- Units of measure
- Vendor details
- Weight units of measure
- Mask Structures
- Warranty codes
- Contract Codes
- Internal Usage

You can, for example, export sales statistics to a spreadsheet for further analysis. You can also export price lists to a spreadsheet, change some pricing information, then import them back into Inventory Control.

Records You Can Import Only

Inventory Control also lets you import or export transactions.

- Adjustments
- Shipments
- Assemblies
- Transfers
- Receipts
- Internal Usage

Note, however, that you cannot export transactions if you delete them after posting.

Records You Can Export Only

You can export transaction statistics and sales statistics, but you cannot import them, unless you select the Keep Item Statistics and Allow Edit Of Statistics options in the I/C Options screen. You can also export serial and lot numbers for the serialized and lotted items in inventory.

Export Formats

Inventory Control can create export files in several formats, including:
Chapter 1: Setting Up Inventory Control

- Excel 2000
- Single CSV File
- CSV File (Comma Separated Values)
- Access
- Excel 5.0
- dBase 5.0
- ODBC

You select the format to use when you export the data.

**Import Formats**

You can create files to be imported by Inventory Control in any of the following formats:

- Excel 2000
- Single CSV File
- Access
- Excel 5.0
- dBase 5.0
- ODBC
- XML

For information about importing and exporting Inventory Control records, see the System Manager Help.

**About Planning Your Item Numbering System**

Before you begin to set up your item numbering system, you should:

1. List all your items.
2. Design an item numbering scheme that suits your inventory reporting needs.

You need to design formats that will meet your needs for identifying items as well as for sorting and grouping items for inventory reports and lists.
Once you decide on the types of item numbers you need, you create one or more item structures in Inventory Control to use for formatting item numbers. For example, you may want all your item numbers to have the pattern #XX-XXXX. A sample item number using this pattern is #01-2C45.

**Important!** Keep in mind that it is easier to design your item formats carefully before entering them into the system than to change them afterward.

You need to be familiar with the following terms:

- **Item number.** An alphanumeric code that uniquely identifies an item in your inventory. For example, #6094-734-8-W might identify a particular kind of size 8 women’s shoes.

  Item numbers can contain uppercase letters and numbers, and can be up to 24 characters long, including all segments, separator characters, and a prefix character.

- **Item number segment.** An inventory item number can consist of up to ten parts called segments.

  Different items can use different sets of segments. For example, some of your items could have numbers with two segments and some could have numbers with three segments (you might use a segment to represent color only in the numbers of items where color is important).

  You use the segments to organize items by common attributes such as style, color, or size, and you can specify the segment of an item number by which you want reports to be sorted.

  All item numbers must contain at least one segment. Each item number contains from one to ten segments. For example, item number #6094-734-8-W contains four segments.

  Item numbers can contain a separator character between consecutive segments and a prefix character in front of the first segment. For example, item number #6094-734-8-W contains the prefix character # and three separator characters (–).

- **Item number structure.** An item number structure describes the number of item segments in an item number, the order in which the segments appear, and the position and type of separator and prefix characters.

  Inventory Control allows you to define more than one item number structure, so your item numbers can have more than one format. For example, you...
could define one item number structure having three segments and another having four segments.

Inventory Control lets you use more than one item number structure, so you may be able to accommodate a mix of existing item numbers.

### Sorting Order for Item Numbers

Inventory Control sorts item numbers for reports and lists from left to right in the following order:

```
0 1 2 3 4 5 6 7 8 9 A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
```

**Example:**
The program sorts the following sample item numbers in the order shown:

- 123
- 123A
- A12
- A2
- AB1234

**Note:** Separator and prefix characters do not affect the order.

### Summary of the Rules for Item Numbers

- Item numbers in Inventory Control can be up to 24 characters long.
- Item numbers are made up of one or more item number sections, called "segments." You can have item numbers with up to 10 segments.
  (Note, however, that Sage 300 Standard ERP lets you define a maximum of 4 item number segments.)
- A single segment can be up to 24 characters long, including the optional separator character.
  If some of your item numbers have 2 segments, and some have 3 segments, your I/C system has two different item number "structures."
- An item structure can be up to 24 characters long (including all segments, separator characters, and a prefix character), so you could have no more than one 24-character segment in an item structure.
- Item structures can have from one to ten segments. For example, you can use a segment to indicate color, model number, or size.

An optional separator character can follow each segment in the item structure so segments can be distinguished from each other, and an optional prefix character can be specified to appear at the front of the item structure.

The following table shows the separator and prefix characters you can use. (If you do not want a separator or prefix character, select "None" for the Prefix option and the Segment Separator field for each segment in the Item Structures screen.)

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>Hyphen</td>
</tr>
<tr>
<td>/</td>
<td>Slash</td>
</tr>
<tr>
<td>\</td>
<td>Backslash</td>
</tr>
<tr>
<td>*</td>
<td>Asterisk</td>
</tr>
<tr>
<td>.</td>
<td>Period</td>
</tr>
<tr>
<td>(</td>
<td>Left parenthesis</td>
</tr>
<tr>
<td>)</td>
<td>Right parenthesis</td>
</tr>
<tr>
<td>#</td>
<td>Number (pound) sign</td>
</tr>
</tbody>
</table>

- Inventory Control ignores separator and prefix characters when sorting item numbers.

- Inventory Control does not use separator and prefix characters to distinguish item numbers. For example, the program considers the item numbers #5200-010 and 5200/010 to be identical since the only difference is the prefix and separator characters, even though the numbers were formatted using different item structures.

**Note:** The program does not allow you to enter duplicate item numbers.

---

**Setting Up Multicurrency Accounting in Inventory Control**

You use multicurrency accounting if you want to process receipt transactions and shipment transactions, maintain price lists, and fill orders (using Sage 300 ERP Order Entry) in more than one currency.
To create a multicurrency Inventory Control system, you:

1. Turn on the Multicurrency option for the company and select a default rate type in the Company Profile of Common Services.

2. Use the Common Services Currency screens to add any currency codes you need for Inventory Control, and enter exchange rates for the currencies you use.

   Sage 300 ERP includes a large set of currency codes that use standard international abbreviations and the format and number of decimal places that are normally used with each currency. You probably will not need to define new codes unless you do not use the international codes.

3. Select the Multicurrency option in the Options screen in Inventory Control to turn on multicurrency accounting for your Inventory Control system.

   You can select the Multicurrency option at any time; but once you save the Options screen with the option selected, you cannot change back to single-currency accounting.

4. Use the Item Pricing screen and Copy Item Pricing screen to add item prices for every currency in which you sell each item.

   You do not need to enter multicurrency totals for Inventory Control sales statistics, because the program keeps these statistics in the functional currency.

Costing Methods

Inventory Control provides eight costing methods for valuing inventory and determining the cost of goods sold.

The costing method used for an item is determined by the account set specified in the I/C item record. When you set up an account set, you specify a costing method to use for valuing all items that are assigned to that account set.

Inventory Control values your inventory and determines the cost of goods sold by location. If you store the same inventory item at more than one location, the program tracks and costs the item at each location (rather than costing all the items together).
About FIFO and LIFO Costing Methods

Although these two costing methods differ in the way they calculate costs, they are similar enough to be discussed together.

- **First-In, First-Out (FIFO) costing method.** Under this method of cost calculation, Inventory Control assumes that the first units to arrive at a location are the first units shipped. Consequently, the units on hand in the closing inventory are assumed to be from the most recent purchases, and current revenues are matched to oldest costs.

- **Last-In, First-Out (LIFO) costing method.** Under this method of cost calculation, the program assumes that the last units to arrive at a location are the first ones shipped. Consequently, the units on hand in the closing inventory are assumed to be from the oldest purchases, and current revenues are match to most recent costs.

**Inventory Buckets**

Inventory Control keeps track of the order in which units arrive at a location by storing their receipt date, receipt number, quantity, and extended cost in individual "buckets." The program calculates the cost of units shipped from the costs stored in the buckets.

- For FIFO, units from the bucket having the oldest receipt date are shipped first.

- For LIFO, units from the bucket having the most recent receipt date are shipped first.

There is no limit to the number of buckets Inventory Control can use.

The inventory balance is calculated the same way for both FIFO and LIFO, by summing the costs from all buckets.

The Item Status report includes the information contained in each bucket, including the offset bucket.

**Offset Buckets**

For each item at each location, there is an "offset" bucket used for special cases, such as when you ship more items than there are in stock from a location. (You can ship more items than are in stock only if Inventory Control is set up to allow negative inventory levels.)

Inventory Control uses all buckets, including the offset bucket, to calculate the inventory balance for an item at a location.
Offset buckets contain a quantity and a cost, but do not contain a date or receipt number, like other buckets.

An offset bucket can contain a positive quantity, instead of a negative quantity, and other buckets may exist while the offset bucket has either a positive or a negative quantity.

If you ship more units of an item than the total quantity from all buckets, Inventory Controls records a negative quantity in the offset bucket, and uses the most recent cost for the item at the location to calculate the extended cost.

If you ship units when the offset bucket has a positive quantity, the units in the offset bucket are shipped before the units in other buckets.

If you ship units when the offset bucket has a negative quantity and there are units in other buckets, the offset bucket is cleared by shipping the number of units you specify plus enough units to cover the negative quantity in the offset bucket. Inventory Control includes in the calculation any cost in the offset bucket (positive or negative), so the offset bucket has zero quantity and zero cost after shipping.

Receipts do not affect the offset bucket.

About the Standard Costing Method

Standard costs are carefully predetermined target or attainable costs that are useful in building budgets and gauging performance. You might use this method if your item costs do not vary much, or if stock turnover is rapid.

When you use the standard costing method, Inventory Control records the difference between the weighted moving average cost and the standard cost in the cost variance general ledger account, and uses weighted moving average to value your inventory.

Under the standard costing method, actual costs are posted to inventory upon receipt. The inventory is then valued and reported on the basis of the weighted moving average cost for each item at a location. When you ship goods, the cost of goods sold is calculated using each shipped item’s standard cost.

You can change the standard cost of an item at any time using the Location Details screen.

**Warning!** If you ship units of an item for which you have not yet entered a standard cost, Inventory Control calculates the cost of goods sold using a standard cost of zero.
About the Moving Average Costing Method

Under this method, Inventory Control pools the costs of all acquired units at a location, so that the costs of one unit cannot be distinguished from the costs of another. The program assigns a unit cost to items that are withdrawn from a location’s inventory for sale or use. This unit cost is an average of all units in the location’s pool at that time.

When you receive new items into inventory, the program adds the total cost of the units received to the total cost of the items already in inventory at that location. When a unit cost is required, Inventory Control divides the total cost by the units on hand at the location, and rounds the result to the nearest currency unit (for example, the nearest cent).

To determine the total cost of a shipped item, Inventory Control multiplies the number of units shipped by the calculated average unit cost at the location (or the most recent cost if the inventory is less than zero).

The weighted moving average method tends to yield an item cost that is between those resulting from the FIFO and LIFO methods.

About the Most Recent Cost Costing Method

When you ship units from a location using the Most Recent Cost costing method, Inventory Control assigns the cost of the most recently acquired unit at the location to all units shipped. Consequently, the units on hand in the closing inventory are assumed to be from the oldest acquisitions.

The program uses the weighted moving average to value inventory when the costing method is most recent cost.

To determine the total cost of a shipment, the program multiplies the number of shipped units by their most recent cost at the location.

The program records the difference between the most recent cost and the average cost in the cost variance account of the category being used for the shipment. (The average cost is the total cost of units on hand divided by the total number of units on hand.)

Warning! If you ship units of an item for which you have not yet received any stock or entered a most recent cost, Inventory Control calculates the cost of goods sold using a most recent cost of zero.

You can change the most recent cost of an item at a location at any time.
Chapter 1: Setting Up Inventory Control

About the User-Specified Costing Method

User-specified costing allows you to enter costs for items as they are shipped. Inventory Control uses this costing method for all non-stock items. You can also use it for stock items.

Under this costing method, stock items are received and inventory valued at moving average cost. When you ship an item, you enter the unit cost or extended cost.

You can specify items as bills of material components (for example, non-stock items). You can specify the cost for the item when setting up a bill of material or during assembly of the master item.

About Serial and Lot Costing Methods

The Serial and Lot costing methods are available only if you have a license to use Serialized Inventory and Lot Tracking.

Inventory Control calculates the cost of received items that use the Serial or Lot costing method, as follows:

- The cost per serial number = Total cost for a detail line / Quantity of serial numbers generated for the detail.
- The cost per lot = Total cost for a detail line / Number of lots generated for the detail.

**Note:** The total cost of a detail line includes any additional costs.

Cost adjustments processed after serialized or lotted items are received also affect the cost of the adjusted serial numbers or lots.

Inventory Control determines the cost of shipped items that use the Serial or Lot costing method, as follows:

- When shipping serialized items, the cost associated with each serial number is the cost of the shipped item (that is, the receipt cost, including any additional costs, plus or minus any cost adjustments for that serial number).
- When shipping lotted items:
  - If you ship the entire lot, the cost of the shipment is the total cost of the lot.
If you ship less than the total lot quantity, the cost of the shipment is the average unit cost for the lot, multiplied by the number of units shipped.

**Example:**
Lot 1 Lot Quantity = 100

<table>
<thead>
<tr>
<th>Total lot cost = $1,000</th>
<th>Average unit cost = $10</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you ship 15 units from Lot 1, the cost of the shipped items is 15 x $10</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** For items that use the Serial costing method or the Lot costing method, the serial quantity and lot quantity must always be the same as the entry quantity in transactions. You cannot select the options Allow Serial Quantity To Be Different From The Quantity In The Entries or Allow Lot Quantity To Be Different From The Quantity In The Entries.

### Costing Methods Reference List

Use the chart in this topic as a quick reference when you add account sets, or when you assign account sets to items.

For more detailed information about each of the costing methods available in Inventory Control, see the following topics:

- "About FIFO and LIFO Costing Methods" (page 15)
- "About the Most Recent Cost Costing Method" (page 17)
- "About the User-Specified Costing Method" (page 18)
- "About the Moving Average Costing Method" (page 17)
- "About the Standard Costing Method" (page 16)
- "About Serial and Lot Costing Methods" (page 18)

<table>
<thead>
<tr>
<th>Costing Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Moving average</td>
<td>The unit cost is an average of the costs of all units in a location's pool at any one time. When you receive new items into inventory, the program adds the total cost of the units received to the total cost of the items already in inventory at that location, then divides the total cost by the units on hand at the location,</td>
</tr>
<tr>
<td><strong>Costing Method</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>and rounds the result to the nearest currency unit to obtain the new unit cost. To determine the total cost of a shipped item, Inventory Control multiplies the number of units shipped by the calculated average unit cost at the location (or the most recent cost if the inventory is less than zero).</td>
<td></td>
</tr>
<tr>
<td><strong>Standard Cost</strong></td>
<td>Standard costs are target or attainable costs you determine for building budgets and gauging performance. Under the standard costing method, actual costs are posted to inventory upon receipt. The inventory is then valued and reported on the basis of the weighted moving average cost for each item at a location. When you ship goods, the cost of goods sold is calculated using each shipped item's standard cost. Inventory Control records the difference between the weighted moving average cost and the standard cost in the general ledger cost variance general ledger account, and uses weighted moving average to value your inventory. If you ship units of an item for which you have not yet entered a standard cost, Inventory Control calculates the cost of goods sold using a standard cost of zero.</td>
</tr>
<tr>
<td><strong>First-in, first-out (FIFO)</strong></td>
<td>Under the FIFO (First-In, First-Out) method of cost calculation, Inventory Control assumes that the first units to arrive at a location are the first units shipped. Consequently, the units on hand in the closing inventory are assumed to be from the most recent purchases. As a result, current revenues are matched to oldest costs.</td>
</tr>
<tr>
<td><strong>Last-in, first-out (LIFO)</strong></td>
<td>Under the LIFO (Last-In, First-Out) method of cost calculation, the program assumes that the last units to arrive at a location are the first ones shipped. Consequently, the units on hand in the closing inventory are assumed to be from the oldest purchases.</td>
</tr>
<tr>
<td><strong>Most recent cost</strong></td>
<td>When you ship units from a location using this costing method, Inventory Control assigns the cost of the most recently acquired unit at the location to all units shipped. Consequently, the units on hand in the closing inventory are assumed to be from the oldest acquisitions. The program uses weighted moving average to value inventory when the costing method is most recent cost. To determine the total cost of a shipment, the program multiplies the number of shipped units by their most recent cost at the location. The program records the difference between the most recent cost and the average cost in the general ledger cost variance account of the category</td>
</tr>
</tbody>
</table>
### Costing Method

<table>
<thead>
<tr>
<th><strong>Costing Method</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>being used for the shipment. (The average cost is the total cost of units on hand divided by the total number of units on hand.)</td>
<td><strong>Warning!</strong> If you ship units of an item for which you have not yet received any stock or entered a most recent cost, Inventory Control calculates the cost of goods sold using a most recent cost of zero.</td>
</tr>
<tr>
<td>User-specified</td>
<td>User-specified costing allows you to enter costs for items as they are shipped. Inventory Control uses this costing method for all non-stock items. You can also use it for stock items. Under this costing method, stock items are received and inventory valued at moving average cost. When you ship an item, you enter the unit cost or extended cost. You can specify items as bills of material components (for example, non-stock items). You can specify the cost for the item when setting up a bill of material or during assembly of the master item.</td>
</tr>
<tr>
<td>Serial</td>
<td>The Serial costing method is available only if you have a license to use Serialized Inventory and Lot Tracking. Under this costing method, Inventory Control calculates a cost for each serial number. The program computes the average cost, including additional costs, for serialized items when you receive them. It uses specific cost calculated for the serial number when you sell a serialized item.</td>
</tr>
<tr>
<td>Lot</td>
<td>The Lot costing method is available only if you have a license to use Serialized Inventory and Lot Tracking. Under this costing method, Inventory Control computes the cost of an entire lot, including additional costs, when you receive the lot. When you ship items from the lot, the cost of the lot is prorated for the lotted items sold.</td>
</tr>
</tbody>
</table>

---

**Selecting Options for Inventory Control**

You use the I/C Options screen to select options that determine how Inventory Control processes transactions and tracks inventory items. You can also specify contact information for the person or position in charge of inventory management for your company.

**About Inventory Control Processing Options**

After activating Inventory Control, your first task is to use the I/C Options screen to select Inventory Control processing options.
Your choices determine how your Inventory Control system operates and the types of data that it stores and displays. You can also use the screen after setup to review your entries and, as needed, change most of them.

This topic describes the options you can select on the Processing tab in the Options screen.

**Using Multicurrency Accounting**

You can set up an Inventory Control system that lets you process and report receipt transactions, and set up price lists for items in all the currencies used by your company.

To use more than one currency in Inventory Control, select the **Multicurrency** option on the Processing tab on the I/C Options screen.

You can turn on this option only if you have already selected the **Multicurrency** option for the company on the Company Profile screen in Common Services.

You also specify a default rate type, such as spot rate, for converting source-currency amounts in transactions to their functional-currency equivalents.

**Important!** You can select the **Multicurrency** option at any time, but once you select the option, you cannot change Inventory Control back to a single-currency ledger.

**Mixing Multicurrency and Single-Currency Modules**

If you turn on the Multicurrency option in Inventory Control, System Manager automatically turns on the Multicurrency option in Order Entry and Purchase Orders, if either or both are installed.

All other Sage 300 ERP modules that you integrate with Inventory Control can use either single-currency accounting or multicurrency accounting.

**Using Fractional Quantities**

If you allow transactions that use fractional quantities (such as 0.5 dozen) in your present inventory control system and want to set up your Sage 300 ERP Inventory Control system to do the same, select the **Allow Fractional Quantities** option.

Fractional quantities are useful if your inventory includes homogeneous items. (Homogeneous items are those with identical elements that can be broken
Selecting Options for Inventory Control

down into multiple, smaller units, such as oil or grain.) These items can require a wide range of units of measure.

**Tips:**
- **Fractional quantities let you use bigger stocking units.** Instead of using the smallest unit (such as ounces) as the stocking unit, use a larger stocking unit (such as pounds), and fractional quantities for amounts of less than a pound.
- **Fractional quantities in BOMs.** You must select the Allow Fractional Quantities option before creating BOMs that will include fractional quantities.
- **Do not select fractional quantities unless you need them.** If you do not intend to enter any transactions that use fractional quantities, you can simplify transaction entry by not selecting the Allow Fractional Quantities option. This means you do not have to enter decimal places for quantities, and it means that unnecessary decimal places do not appear on reports.

**Note:** You can select the **Allow Fractional Quantities** option at any time. However, once you select the option, you cannot change back.

**Allowing Items at All Locations**

If your company stores inventory at more than one location (for example, warehouses in different regions), you can set up the Sage 300 ERP Inventory Control system to manage items at multiple locations.

After you enter all your inventory items and set up all the locations in Inventory Control, you need to specify which items are stored at which locations before you can start entering transactions. There are two ways you can do this. Either specify which item or group of items can be stored at each location, or permit every inventory item to be stored at all locations.

**Note:** All items that you transfer through a goods-in-transit location must be allowed at the GIT location that you use.

If your company has only one location, or it does not need to restrict any items from being stored at any locations, you can save time setting up your Inventory Control system by permitting every item at all locations. This allows you to start entering transactions right away involving any item at any location. (Transactions include receipts, shipments, returns, transfers, adjustments, and assemblies.)
To allow every inventory item at all storage locations, select the **Allow Items At All Locations** option on the Processing tab in the Options screen.

If you do not turn on this option, you must use the Location Details screen or the Locations screen to allow an item to be stored at a location before you can enter transactions for the item at the location.

Inventory Control shows an item to be stocked at a location only after you enter the first transaction (such as a receipt) involving the item at the location. If you stock the item at more than one location, the item appears on reports and in screens only at the locations for which a transaction has been entered, even if the item can be stocked at any location. For example, only after you enter the first transaction for an item at a location does the item appear in the Location Details screen or report at that location.

**Note:** You can turn the **Allow Items At All Locations** option off or on at any time. (This option is selected automatically when you install Inventory Control.)

### Allowing Negative Inventory Quantities

If you allow transactions that cause an item’s quantity on hand to go below zero in your present inventory control system, you can set up your Sage 300 ERP Inventory Control system to do the same. (For example, negative quantities can result from timing problems when you enter shipments for items before entering their receipts. In this situation, your computer’s inventory figures do not match your physical inventory.)

To allow transactions that result in negative inventory levels, select the **Allow Negative Inventory Levels** option on the Processing tab in the Options screen.

If you do not want inventory levels to go below zero for any reason, do not select this option.

**Note:** You can turn the **Allow Negative Inventory Levels** option on or off at any time.

### Allow Receipt of Non-Stock Items

Select the **Allow Receipt of Non-Stock Items** if you want to maintain a list of items that you purchase regularly but for which you do not maintain an inventory quantity.
Saving Transaction History for Reporting

Inventory Control can save detailed transaction records when you post, so you can print a transaction history report later. The Transaction History report lists all transactions posted for items assigned to selected account sets within a specified period.

To save transaction history for reporting, select the Keep Transaction History option on the Processing tab in the Options screen.

**Note:** You can turn the Keep Transaction History option on or off at any time. If you turn it off after you have used it, Inventory Control immediately stops saving transaction history, although it retains those records already collected until you clear (delete) them using the I/C Clear History screen. If you turn the option on again, there will be a gap in the collected information corresponding to the period when the option was not used.

You can export transaction history to other databases or to spreadsheets for further analysis.

If you do not save transaction history, nothing is reported in the Transaction History report.

Maintaining Transaction History

Saving transaction history uses a large amount of storage space on your computer, so you should turn this option on only when needed. To avoid wasting storage space on your computer, use the I/C Clear History screen to clear (delete) transaction history when you are finished using it. If you turn the Keep Transaction History option on then off without clearing transaction history, there will be a gap in the history records, making the information incomplete.

Prompt to Delete During Posting

Inventory Control provides an option for deleting individual transactions after posting if you do not want to save transaction information.

To delete transaction information, you must select the option Prompt To Delete During Posting, on the Processing tab in the I/C Options screen.

If you want to keep all transaction information, make sure that you turn off this option.

**Note:**
If you delete transactions after posting, you cannot view posted transactions or drill down to them from General Ledger.
Also, if you post transactions using the I/C Post Transactions screen (instead of from transaction entry), you cannot choose to delete them. Instead, you can remove transactions using the I/C Clear History screen.

**Only Use Defined UOM**

You can specify whether to use only units of measure that are defined in Inventory Control, or any units of measure for an item.

If you select the *Only Use Defined UOM* option, you can use only inventory units of measure that are set up on the I/C Units of Measure setup screen. This setting lets you enforce consistency for all items added after you select this option.

If you do not choose this setting, you can specify any units of measure for new inventory items—whether or not they have been added to Inventory Control.

*Note:* This option affects only new inventory items or new units of measure that you add to existing items. Turning on this option has no effect on existing items, unless you add new units of measure to item records.

**Alternate Cost Fields**

You can create two alternate cost fields to use in Inventory Control, and in Sage 300 ERP Order Entry and Purchase Orders, if you use them with Inventory Control.

You create alternate cost fields by entering meaningful names (up to ten characters long) into the *Alternate Amount 1 Name* and the *Alternate Amount 2 Name* fields on the Processing tab in the Options screen.

*Example:* You could assign the name Landed to one of the alternate cost fields to indicate the nature of the amount it contains.

Names for alternate amounts can contain uppercase letters, numbers, blanks, symbols (such as @ and #), and punctuation marks (such as ? and !).

Alternate cost fields appear in the I/C Location Details screen with the names you assign to them. These fields appear on and are used by the following Inventory Control reports: Location Details, Item Status, Markup Analysis, Selling Price/Margin Analysis.
Sage 300 ERP Order Entry and Purchase Orders

Order Entry and Purchase Orders use alternate costs as the basis for tax calculations when taxes are charged on costs, if you select an alternate cost as the tax base for the tax authorities.

Use the Tax Authorities screen in the Tax Services folder of Common Services to select an alternate cost as the tax base for a tax authority.

Default Weight Unit of Measure

You can choose the weight unit of measure which is the basic or standard unit that you use for measuring the weight of your inventory items—such as pounds or kilograms.

You specify a default weight unit of measure using the Default Weight UOM field on the I/C Options screen.

Note: Usually, you will add weight units of measure after choosing inventory options, but before adding item records. You can add as many weight UOMs that you need for your items, along with conversion factors to convert different UOMs to the default unit.

If you use Inventory Control with Order Entry, Order Entry uses the weights you supply in Inventory Control to estimate the total weight of each order in the unit of weight you specify here. Order Entry uses the estimated total weight of an order to calculate the cost of shipping the order.

If you use Inventory Control with Purchase Orders, Purchase Orders can use the weight unit of measure you supply in Inventory Control to prorate (distribute) additional costs on orders.

Handling Additional Costs on Receipt Returns

When you post a receipt return transaction to record the return of goods to suppliers, Inventory Control can treat any additional costs assigned to the receipt in either of two ways. It can automatically prorate any additional cost assigned to the goods being returned over the remaining goods on the receipt, or leave the additional cost on the receipt. (Freight charges and duty charges are two examples of additional costs.)

You use the Additional Cost For Items On Receipt Returns field to specify how to handle additional costs, as follows:

- To have the program prorate the additional cost on receipt returns to the remaining items on the receipt, select Prorate for this option.
To have the program leave the additional cost assigned to the goods being returned, select **Leave** for this option. Use the I/C Adjustments screen to reassign to another general ledger account the additional cost that was assigned to the items being returned.

You can change your selection for this option at any time, and you can override your choice for this option when entering receipt returns using the I/C Receipts screen.

**Note:** If you return all of the items on a receipt, you must use the I/C Adjustments screen to reassign to another general ledger account the additional cost that was specified on the receipt.

---

**Default Goods In Transit Location**

A goods-in-transit location is a virtual location where you store goods while they are in transit. This allows you to more closely match the transfer process, where goods may be on trucks or in transit for days or weeks at a time.

Each time you transfer goods between inventory locations, you can choose to transfer goods:

- Directly (and immediately) to the destination location.
- Using a goods-in-transit location.

Goods in transit are moved to the GIT location first, and then are received at the destination location. This means that goods can travel on different trucks and be received in separate lots. It also means that goods can stay in transit indefinitely.

A goods-in-transit location is treated just like any other inventory location, so you can check item quantities in transit.

**Keeping Item Statistics**

Inventory Control can save item statistics from transactions posted for your inventory items, and display this information or print it on the Sales Statistics and Transaction Statistics reports.

Select the **Keep Item Statistics** option if you want to accumulate statistics from posted transactions.

Inventory Control retains transaction and sales statistics from the transactions processed for up to 53 periods per year, for any number of years. (Sage 300
Selecting Options for Inventory Control

Standard ERP is limited to accumulating statistics by fiscal year and fiscal period.

Inventory Control uses these statistics to produce the Transaction Statistics report and the Sales Statistics report. You can print the statistics for an item by period and year, as far back as the oldest year and period for which you keep this information.

You can turn on or turn off the Keep Item Statistics option at any time. If you turn off the option, Inventory Control immediately stops saving statistics, although it retains those already collected until you clear (delete) them using the I/C Clear History option. If you turn the option on again, there will be a gap in the statistics corresponding to the period when the option was not used.

**Organizing Statistics**

You also specify whether to accumulate the statistics by fiscal year or calendar year.

The **Accumulate By** and **Period Type** fields let you choose whether to report period statistics by fiscal year or calendar year, and to specify the period type to use.

If you choose to accumulate by calendar year, the starting date for statistics will be January 1st. If you choose to accumulate by fiscal year the starting date will be the first day of your fiscal year.

You also specify the type of period by which the statistics are totaled and reported—weekly (Sunday=day 1), seven days (beginning on the first day of the week in your fiscal calendar), bi-weekly (Sunday=day 1), four weeks, monthly, bi-monthly, quarterly, semi-annually, annually, or fiscal period (if you select Fiscal Year for the Accumulate By option) (use the Period Type option).

You can change the type of year and period by which Inventory Control reports statistics, but you will not be able to compare new period figures directly to figures in past periods.

**Tip:** If you need to change the type of year or period by which Inventory Control reports statistics, you should either do so after year-end, or edit the statistics for the earlier periods in the year to correct distortions.

**Note:** The **Accumulate By** option appears only if the **Keep Item Statistics** option is selected.
Chapter 1: Setting Up Inventory Control

Editing Statistics

Select the **Allow Edit of Statistics** option if you want to add or edit either of the following statistics:

- Sales statistics for previous periods of the current year or for previous years. (You might want to do this if you set up your Inventory Control system partway through a fiscal year.)
- Transaction statistics from posted transactions.

**Note:** This option appears only if the **Keep Item Statistics** option is turned on.

You use the I/C Sales Statistics screen to add and edit sales statistics, and the I/C Transaction Statistics screen to edit transaction statistics.

Normally, you do not need to edit statistics, because they are updated automatically and accurately each time you run Day End Processing. However, if you set up your Inventory Control system partway through a fiscal year, you may want to use the Allow Edit Of Statistics option. You can then enter more complete inventory records by adding the statistics from your previous system for previous periods in the current year, and for previous years. (You use the Sales Statistics screen to edit the statistics.)

Once your system is operating, you should turn off the option because the program automatically updates the statistics when you post transactions.

You can turn on or turn off the Allow Edit Of Statistics option at any time.

Reviewing Statistics

Use the Transaction Statistics and Sales Statistics screens to display the statistics.

Reports

The Sales Statistics and Transaction Statistics reports will be blank if you do not turn on the Keep Item Statistics option.
About Creating G/L Transactions

Use one of the following Create G/L Transactions options (on the Integration tab of the G/L Integration screen) to specify when to create general ledger transactions:

- **During Posting or During Day End Processing.** This option lets you create general ledger transactions during posting or when you run day end processing—depending on your settings on the Costing tab of the I/C Options screen.

  You choose when to create G/L transactions and audit information on the Costing tab of the I/C Options screen. The Create Subledger Transactions And Audit Info. During option gives you one of two choices on this screen:

  - **During Posting (available only if you cost items during posting)**
    
    G/L transactions will be created when transactions are posted.

  - **During Day End Processing**
    
    G/L transactions will be created when you run the Day End Processing task.

  **Note:** These choices can have a large impact on the speed of processing transactions in Inventory Control, Order Entry, and Purchase Orders. If you need to speed up order processing, switch to costing inventory when you run Day End Processing (in I/C Options), and create G/L transactions using the Create G/L Batch icon.

  **Note:** This option changes depending on the options you chose on the Costing tab of the I/C Options screen.

- **On Request Using Create G/L Batch Icon.** This option lets you create general ledger transactions at any time that's convenient for you.

  Once you create the transactions, you cannot print the G/L Transactions report in Inventory Control. If you wish to print the report, select the On Request Using G/L Batch Icon for this option. You must then print the report before you use the Create G/L Batch screen to create the transactions.

  You can change your selection any time. If you were using the Create G/L Batch screen to create the transactions, print a copy of the latest G/L Transactions report, then create any outstanding transactions before changing your choice for the option.
You can also choose whether to add new general ledger transactions to new batches or create new batches and optionally post them automatically to the general ledger.

You can:

- Add general ledger transactions to an existing Sage 300 ERP General Ledger batch.
- Create a new General Ledger batch each time you generate G/L transactions.
- Create a new General Ledger batch each time you generate G/L transactions, and automatically post the batch in the General Ledger program.

**Note:** If you are using Serialized Inventory and Lot Tracking, you cannot use this option to create and automatically post G/L batches during I/C transaction posting.

If you want to post batches automatically, you should choose the option to create subledger batches during day end processing (on the I/C Options screen).

**Tip:** Remember to create and post G/L batches for outstanding transactions before locking periods for General Ledger.

To have only one General Ledger batch to which all transactions are appended, turn on the Append G/L Transactions To Existing Batch option. Inventory Control must use the same database as Sage 300 ERP General Ledger.

If you do not use Sage 300 ERP General Ledger—or if your Sage 300 ERP General Ledger system is at another location—Inventory Control appends its general ledger transactions to a file in your company’s data directory called icgltran.csv, which can be imported by a remote site Sage 300 ERP General Ledger, or transferred to another general ledger that you use. The file is in a Comma Separated Values (CSV) format.

**About Consolidating G/L Batches**

Use the Consolidate G/L Batches option on the G/L Integration screen to specify whether to combine transaction details for the same general ledger account into a single detail, or send unconsolidated Inventory Control transaction details to General Ledger.
Consolidation reduces the amount of information in the general ledger batch, and results in a shorter G/L Transactions Listing.

**Important!**
Consolidation also:

- Removes transaction-specific information from the Reference and Description fields for each transaction.
- Removes optional field information from transactions.
- Blocks drilldown from G/L transactions to the originating entries in Inventory Control (unless consolidating by account only).

### Consolidation Options

You can choose:

- **Do Not Consolidate.** All the details posted in Inventory Control will be included in the General Ledger transaction batch.

  Choose this option if you use optional fields and pass optional field information from I/C transaction details to the G/L transaction details.

- **Consolidate Transaction Details by Account.** All the details within a transaction with the same general ledger account number are combined into one detail if the G/L Detail Description and the G/L Detail Reference are also the same. The program will not consolidate details that have a different description or reference.

  Choose this option if you do not use optional fields, but still want to associate general ledger transactions with originating documents (for drilldown or to maintain a manual audit trail).

- **Consolidate by Account and Fiscal Period.** All the details with the same general ledger account number and fiscal period are combined into one detail.

- **Consolidate by Account, Fiscal Period, and Source.** All the details with the same general ledger account number, fiscal period, and source code are combined into one detail.

  This option will consolidate details from different transactions if you create transaction batches using the G/L Batch screen.

  This option will consolidate details from different transactions if you create transaction batches using the G/L Batch screen.
Chapter 1: Setting Up Inventory Control

**Note:** The posting date for consolidated entries is the last date of the fiscal period.

If the option On Request Using Create G/L Batch Icon is turned on for Inventory Control and you select either the **Consolidate by Account and Fiscal Period** or the **Consolidate by Account, Fiscal Period, and Source** consolidation option, you can consolidate transaction details from all transactions for each general ledger account.

If you create batches of G/L transactions during posting or day end processing, the program can only consolidate the details within transactions. It cannot consolidate the details from different transactions.

**Changing Inventory Control Options**

After setup, you can change any of the selections and information you entered in the I/C Options screen, with some exceptions and restrictions.

**Changing Inventory Control Processing Options**

After setup, you can change any of the selections and information you entered in the I/C Options screen, with the following exceptions and restrictions:

- You can select the **Multicurrency** and **Allow Fractional Quantities** options at any time, but you cannot turn either option off after saving changes to the I/C Options screen.

- You can change the type of year (fiscal or calendar) and period by which you accumulate item statistics, but you should do so only at fiscal or calendar year end. (If you change either method partway through a year, the statistics already accumulated will be incorrect or in the wrong period.)

- If you change from updating costs during day end processing to updating costs during posting, you must first run day end to cost all outstanding posted transactions.

**Note:** You cannot change settings on the Processing tab of the I/C Options screen if other Inventory Control screens are open, or other users are working with the Inventory Control database.

**Before you start:**

- Make sure that no one else is using the Inventory Control data and that no other Inventory Control screens are open for the company before you save
changes.

- Print the I/C Options report from the Setup Reports folder so you have a record of your processing options before you start.

- If you are changing from updating costs during day end processing to updating costs during posting, you must first run Day End Processing to cost all outstanding posted transactions.

**To change I/C processing options:**

1. Open **Inventory Control > I/C Setup > Options**.

2. On the Processing tab, make any required changes to processing options.

   **Important!**
   - Costing items and creating subledger transactions and audit information during posting will increase the time it takes to post transactions in Inventory Control, Order Entry, and Purchase Orders.
   - If you change from updating costs during day end processing to updating costs during posting, you must first run Day End Processing to cost all outstanding posted transactions.

3. Click **Save** when you have finished changing processing options.

**After changing I/C Options**

Print the I/C Options report from the I/C Setup Reports folder to check that new settings are correct.

**Changing Posting and Day End Processing Options**

Inventory Control lets you choose:

- When the program costs inventory (either when posting transactions or during day-end processing).

- When it creates subledger and audit information.

- When it creates General Ledger transaction batches, and whether it should also post them automatically.

- Whether to post transactions immediately entering them or save them after entry and post them later. (See "About Transaction Processing in Inventory Control" (page 165) for the difference between immediate and batch posting.)
Chapter 1: Setting Up Inventory Control

**Note:** You cannot change Posting or Day End Processing options if any other Inventory Control screens are open, or other users are working with the Inventory Control database.

**Before you start:**

- Make sure you understand the consequences of any changes you make.
  
  For more information about the G/L Integration screen and its fields and options, see "I/C G/L Integration Screen" (page 571).
  
  To understand how Day End Processing works, see "About Day End Processing" (page 272).

- Print the G/L Integration report from the I/C Setup Reports folder, so you have a record of your G/L Integration settings before you start.

- If you are changing from updating costs during day end processing to updating costs during posting, you must first run Day End Processing to cost all outstanding posted transactions.

- If you are changing from using the Create G/L Batch screen to creating general ledger transactions during day-end processing, be sure to run Create G/L Batch to process any outstanding transactions first, to avoid accidentally omitting transactions from your general ledger batches.

- Make sure that no other Inventory Control screens are open, and that no other users are working with the Inventory Control database.

**To change day end processing options:**

**Important!** Make sure that no one else is using the Inventory Control data and that no other Inventory Control screens are open for the company before you change options.

1. Open **Inventory Control > I/C Setup > Options**.

2. Click the **Costing** tab.

3. Change day-end processing options, as required.

4. Click **Save** when you are finished.
To change G/L batch creation and posting options:

**Important!** Make sure that no one else is using the Inventory Control data and that no other Inventory Control screens are open for the company before you change options.

1. Open **Inventory Control > I/C Setup > G/L Integration**.
2. Change batch creation options as you require.
3. Click **Save** when you are finished.

**After changing Day End Processing and posting options**
- Print the I/C Options report from the I/C Setup Reports folder to check that the new settings are correct.
- Print the G/L Integration report from the I/C Setup Reports folder if you changed integration settings.

**Allowing Editing of Sales and Transaction Statistics**
You can allow editing of item statistics and sales and return quantities and amounts while you are setting up your Inventory Control system.

**To allow editing of sales and transactions statistics:**
1. Open **Inventory Control > I/C Setup > Options**.
2. On the **Processing** tab select **Keep Item Statistics** (if it is not already selected) and **Allow Edit Of Statistics**.
3. Click **Save**.

**After changing the option to allow edit of statistics**
- Add or edit sales statistics and transaction statistics
- Collect current year and previous years transaction data that you intend to add to Inventory Control.
- Turn off the **Allow Edit of Statistics** option when you have finished setting up your Inventory Control system.
Adding Historical Information

Inventory Control maintains sales and transaction statistics for the current year and for all the previous years for which you retain the data.

You add the following historical and current information during setup:

- Your current item quantities and costs.
- If you set up partway through a fiscal year, any sales and transaction statistics from previous periods of the current year that you want to view online or for which you want to print reports.
- Any sales and transaction statistics from previous years that you want to view online or for which you want to print reports.

Inventory Control automatically updates the statistical information each time you run Day End Processing.

About Entering Current and Historical Transactions

**Note:** You can enter current-year and previous-years sales and transaction statistics either during or after setup.

For step-by-step instructions on adding your current item quantities and costs, see "Adding Current Item Quantities and Costs" (page 117).

Entering Current Item Quantities and Costs

When you set up your Inventory Control system, you must add the current quantities and costs for your inventory items.

You add your current item quantities and costs by receiving them using the I/C Receipts screen. You can also import receipts from a spreadsheet or other non-Sage 300 ERP program.

Entering Sales Statistics for Current and Previous Years

If you want prior-period sales statistics, you can enter the sales data (units sold, number of transactions, sales amount, and actual cost) from current and previous years that you want to view online or for which you want to print reports either during or after setup.

Before you can add sales data, you must select the **Allow Edit Of Statistics** option on the Processing tab of the I/C Options screen.
Use the Sales Statistics screen to add sales data from current and previous years to your Inventory Control system.

**Entering Transaction Statistics for Current and Previous Years**

Either during or after setup, you can enter transaction data from current and previous years that you want to view online or for which you want to print reports.

Before you can add transaction data, you must select the **Allow Edit Of Statistics** option on the Processing tab of the Options screen.

Use the Transaction Statistics screen to add transaction data from current and previous years to your Inventory Control system.

**Adding or Editing Transaction Statistics**

If you selected the **Keep Item Statistics** and **Allow Edit Of Statistics** options on the I/C Options screen, you can use the I/C Transaction Statistics screen to add and edit transaction data for your inventory items.

**Before you start:**

- Collect current year and previous years’ transaction data that you intend to add to Inventory Control.
- The **Keep Item Statistics** and **Allow Edit Of Statistics** options must be selected on the I/C Options screen.
- Print the I/C Transaction History report. After you add or edit transaction information, you can print the report again to verify that you made the required changes correctly.

**To add or edit transaction statistics:**

1. Open **Inventory Control > I/C Statistics and Inquiries > Transaction Statistics**.
2. Specify the year for which you want to add or edit statistics.
3. For each transaction type, add or edit the number of transactions, and if applicable, the actual cost of goods and/or sales/returns amounts.
4. After adding or changing statistics for a period, click **Save** when prompted to save your changes.
5. Repeat steps 2 through 5 for each period for which you want to add or edit transaction data.
Chapter 1: Setting Up Inventory Control

**After adding or editing sales statistics**

- Print the I/C Transaction Statistics report to check the new record information and to update your printed records.

- Compare the report you printed before adding or editing transaction information to the report printed after the changes, to verify that you made the required changes correctly.

- If you want to prevent other users from manually editing transaction statistics, clear the **Allow Edit Of Statistics** option on the I/C Options screen.

**Adding Current Sales and Return Statistics**

Use the I/C Sales Statistics screen to:

- View sales and return statistics for inventory items.

- Enter sales and return quantities and amounts for the years and periods for which you keep data in Inventory Control (if you selected the **Allow Edit of Statistics** option on the I/C Options screen).

**Before you start:**

- Print the I/C Sales Statistics report. After you add or edit statistics, you can print the report again to verify that you made the required changes correctly.

- Collect current year and previous years' sales data to add to Inventory Control.

- The **Keep Item Statistics** and **Allow Edit Of Statistics** options must be selected on the I/C Options screen.

**To add or edit sales and return statistics:**

1. Open **Inventory Control > I/C Statistics and Inquiries > Sales Statistics**.

2. Specify the item number, location, and year for which you want to add or edit sales statistics.

3. To add or edit statistics, double-click a field, and then add or edit information. You can add and edit the following statistics:
• **Count** (Number of sales and return transactions posted)

• **Quantity** (Number of items sold and returned, in stocking units)

• **Amount** (Amount of sales and returns, in functional currency if you use multicurrency accounting)

• **Cost** (Cost of goods sold and returned, in functional currency if you use multicurrency accounting)

4. If you want to delete statistics for the year, click **Delete**.

5. After adding or changing statistics for a period, click **Save** when prompted to save your changes.

6. Repeat steps 2 through 5 for each item and period for which you want to add sales and return statistics.

**After adding or editing sales statistics**

- Print the I/C Sales Statistics report to check the new record information and to update your printed records.

- Compare the report you printed before changing or deleting sales statistics to the report printed after the changes, to verify that you made the required changes correctly.

**Account Sets**

Account sets are groups of general ledger accounts to which you post Inventory Control transactions.

**About Account Sets**

You can use as many account sets as you need for your inventory items, but you must define at least one account set for your inventory items.

By creating more than one set of control accounts you can:

- Maintain separate inventory control accounts for different types of inventory items.

You can group items by the accounts to which you post item transactions in your general ledger. For example, you can use separate account sets for different item categories, for items assembled in different areas, or for items obtained from different suppliers.
Use different inventory valuation methods for different groups of items. Because you assign a costing method to each account set, you can group items by the costing method you use to valuing inventory and determining the cost of goods sold.

You use the Account Sets screen in the I/C Setup folder to add account sets.

**Contents of Account Sets**

When you add an account set, you enter a unique code of up to six characters for the set, and a description (for example, Assembled Items). Account set codes can contain upper-case letters and numbers.

For each account set, you specify a costing method, and you enter account numbers for a set of general ledger accounts.

Account sets do not specify all of the accounts that are used with an item. You specify the following account codes for sales and COGS with inventory categories. Sage 300 ERP Order Entry uses the Sales account and Returns account—Inventory Control does not use them:

- Sales
- Returns
- Cost of Goods Sold
- Cost Variance
- Damaged Goods
- Internal Usage

**Selecting a Costing Method**

You must specify a costing method for each account set.

You can select one of eight costing methods for your account sets. Since different methods of inventory valuation are appropriate in different situations, you may want to ask your accountant to determine which method best suits your needs and to ensure that the calculation methods used by Sage 300 ERP are appropriate for your business.

For more information, see "Costing Methods Reference List" (page 19).

**Editing Account Sets**

You can change all of the information in an account set except the identifying code.
To change the code, you first add an account set with the code you want to use, then delete the account set with the code you do not want.

**Deleting Account Sets**

You can delete account sets only when they are not assigned to inventory items.

If you want to delete a code that is assigned to an inventory item, you must first assign a different account set to the inventory item, and then delete the unwanted code.

For more information, see "About Deleting Account Sets" (page 46).

**Adding Account Sets**

You can use as many account sets as you need for your inventory items, but you must define at least one account set for your inventory items.

By creating more than one set of control accounts you can:

- Maintain separate inventory control accounts for different types of inventory items.

  You can group items by the accounts to which you post item transactions in your general ledger. For example, you can use separate account sets for different item categories, for items assembled in different areas, or for items obtained from different suppliers.

- Use different inventory valuation methods for different groups of items. Because you assign a costing method to each account set, you can group items by the costing method you use to valuing inventory and determining the cost of goods sold.

**Before you start:**

- Print the Account Sets report for the records you want to edit or delete. Double-click the Account Sets icon in the Setup Reports folder to open the report screen.

- Print the Item Status report, including the Profile information for the account sets you want to change so you know which items will be affected.

- If changing account numbers, check that your general ledger contains the accounts you want to assign for these general ledger accounts:
Inventory Control account
Payables Clearing account
Adjustment Write-Off account
Assembly Cost Credit account
Non-stock Clearing account
Transfer Clearing account
Shipment Clearing account
Disassembly Expense account
Physical Inventory Adjustment account
Credit/Debit Note Clearing account

If your database does not include Sage 300 ERP General Ledger, Inventory Control does not verify any general ledger account numbers. You must check the numbers you specify against the general ledger that you use.

**To add an account set:**

1. Open **Inventory Control > I/C Setup > Account Sets**.
2. In the **Account Set Code** field, type the new code that will identify this account set.
3. Type a description of the account set.
4. In the **Costing Method** field, specify a costing method.
5. In the remaining fields, enter the numbers of the general ledger accounts to use for this account set.

Enter the general ledger account numbers for:

- **Inventory Control account.** An asset account containing the total value of the inventory on hand (at actual cost). The account increases when you receive goods, and decreases when you ship goods.

  The word "control" in the account name means that the account contains only totals, whereas the information stored by Inventory Control contains details on an item-by-item basis.
When you process all accounting entries correctly, the total cost of the inventory in the Inventory Control system equals the totals in the Inventory Control accounts in the general ledger.

- **Payables Clearing account.** A suspense account to which Inventory Control posts the "other side" of the accounting entries for inventory you receive (and for previous receipts you return to suppliers).

  Inventory Control normally generates credit entries to this account for inventory you receive; therefore, the account can be thought of as the accrued amount payable for goods received into inventory. Inventory Control debits this account when you enter receipt returns.

  As you post the related vendor invoices in Sage 300 ERP Accounts Payable, offsetting journal entries (debits) related to the inventory purchased are generated against the Payables Clearing account to clear the balance that is left in this account from posting the inventory receipt.

- **Adjustment Write-Off account.** The account to which you post inventory adjustments and write-offs. Entries to this account are normally expenses (debits); therefore, the account number you specify should be in the expenses or cost of goods sold section of your general ledger.

- **Assembly Cost Credit account.** The account to which you post the variable and fixed costs of assembling items. The program credits this account with the variable and fixed cost of assembly. You may want to create manual entries in the general ledger to redistribute the assembly cost credit to accounts such as labor costs.

- **Non-stock Clearing account.** The account which you credit when you ship non-stock items, and debit when you enter shipment returns for non-stock items.

  You can use non-stock items to handle specially ordered items which you do not stock in your inventory, and to handle service charges that appear on invoices.

- **Transfer Clearing account.** This account is used for the additional cost amount in the Transfer screen.

- **Shipment Clearing.** Debited instead of Cost of Goods sold when shipping goods from Order Entry.
Chapter 1: Setting Up Inventory Control

The Shipment Clearing account is required because the shipment and invoicing functions in Order Entry are separated. The COGS account is debited when you invoice the shipment.

- **Disassembly Expense.** Used if you specify an expense amount when you disassemble items that were previously assembled in Inventory Control.

- **Physical Inventory Adjustment.** The expense account that balances the change in inventory value when you adjust inventory quantities after making a physical inventory count.

- **Credit/Debit Note Clearing.** Debited instead of the IC Control account or the Damaged Goods account in Order Entry returns sent to Accounts Receivable. The G/L transaction credits the clearing account instead of COGS and A/R Control.

The Credit/Debit Note Clearing account is required because the inventory return and credit note functions in Order Entry are separated, with one side of the transaction going through the Accounts Receivable program.

6. Click **Add** (or **Save**, if you added the account set before).

**After adding or editing an account set**
Print the I/C Account Sets report for your records.

**About Deleting Account Sets**

You can delete account sets one at a time using the Account Sets screen (the same screen you use to add account sets to Inventory Control).

You can also use the Delete Inactive Records screen in the I/C Periodic Processing folder to delete groups of inactive account sets.

**Note:** You cannot delete an account set if any item records are assigned to it. You must assign its item records to another account set, or delete the item records.

**Setting Account Sets Inactive before Deletion**

Before trying to delete an account set, it is a good idea to assign the Inactive status to the record, to ensure that no further items are assigned to it. You can then wait until the end of the fiscal or calendar year to delete it (depending on the method you use to accumulate item statistics).

You use the Account Sets screen to make account sets inactive.
Identifying Inactive Account Sets

Print the Account Sets report to identify inactive account sets. If an account set is inactive, the date it was made inactive appears on this report in the Inactive On field. See "Printing the Account Sets Report" (page 302) for more information.

Categories

You use the I/C Categories screen to create categories for your Inventory Control system. You use categories to:

- Classify items into logical groups for reporting purposes.
- Allocate the sales, returns, cost of goods sold, cost variance, and damaged goods amounts for different kinds of items to different sets of general ledger accounts.

Note: You must add at least one category to Inventory Control before you can add item records.

About Categories

You use the I/C Categories screen to create categories for your Inventory Control system. You can use categories to:

- Classify items into logical groups for reporting purposes.

  Example:
  A furniture company might use the following categories:
  
  C2 (Chairs, steno)
  D1 (Desks, executive)
  D2 (Desks, secretarial)
  F1 (Filing, cabinets)

- Allocate the cost of goods sold and revenue by category.

  When you add a category, you specify the general ledger cost of goods sold and revenue account numbers for that category. All items sold in the category use the specified accounts, unless you change the category when entering transactions.
Chapter 1: Setting Up Inventory Control

- Specify whether commissions can be earned on sales and, if so, the maximum commission rate allowed. Commission information is used by Order Entry.

- Specify tax authorities and sales tax classes for use by Order Entry, and purchase tax classes for use by Purchase Orders.

**Note:** You must add categories before you can add items to Inventory Control.

You assign a unique code, using up to six characters, to identify each category you create. Category codes can contain upper-case letters and numbers.

If you do not group your inventory items, you can set up one category code and assign it to all items.

You can override the category when you ship an item, and you can change the category assigned to an item record at any time. For example, on a shipment you could specify the category as "sample" to deal separately with costs and revenues for goods shipped out as samples.

**Editing and Deleting Category Records**

If you change the tax classes or the price list code in a category after assigning the category to inventory items, the changes appear only in the item records to which you assign the category after the changes.

You cannot delete a category if it is assigned to any items. (For more information, see "About Deleting Categories" (page 51).)

**Integration with General Ledger**

For each category, you must enter general ledger account numbers for the following accounts:

- **Sales.** A revenue account that Order Entry credits with the revenue from goods sold.

- **Returns.** A revenue contra account that Order Entry debits to record the reduction of revenue caused when previously sold goods are returned or credit notes are issued.

- **Cost of Goods Sold.** An expense account that Inventory Control automatically debits with the cost of goods sold, and credits with the cost of goods returned.
- **Cost Variance.** An expense account in that Inventory Control records the cost variance between the actual cost and either the standard cost (for items using the standard costing method) or the most recent cost (for items using the most recent costing method) of inventory items sold.

- **Damaged Goods.**

- **Internal Usage.**

  **Note:** Sage 300 ERP Order Entry uses the Sales account and Returns account—Inventory Control does not use them.

**Integration with Order Entry**

If you use Order Entry, the Inventory Control categories:

- Specify whether commissions can be paid on the sale of items in a category and, if so, the maximum commission rate.

- Assign a taxing authority, and tax classes for sales and purchases.

Tax information from categories appears automatically in item records to which you assign the category. You can override the category tax information in item records.

Order Entry uses the commission rate and tax information—Inventory Control does not use them.

**Integrating with Purchase Orders**

If you use Purchase Orders, the Inventory Control categories assign a taxing authority and tax classes for purchases.

**Setting Up Categories**

You use categories in Inventory Control to group inventory items with similar characteristics.

**Note:** You must add at least one category to Inventory Control before you can add item records.

**Before you start:**

- Choose a code of up to six characters to identify each category you plan to
add.

- Decide which price list code to assign to each category.
- Decide which general ledger account numbers to assign to each category for:
  - Cost of goods sold
  - Cost variance
  - Sales
  - Returns
  - Damaged goods
  - Internal Usage
- Be sure your general ledger contains the accounts you want to assign to categories in Inventory Control.

**To add a category:**

1. Open **Inventory Control > I/C Setup > Categories**.
2. In the **Category Code** field, type a code to identify the item category (using up to six alphanumeric characters), and then enter a description for the new category in the adjacent field.
3. On the Options tab:
   a. In the **Default Price List** field, select the code for the price list to use as the default when you assign this category to new items.
   b. If you use Sage 300 ERP Order Entry and want to allow commissions to be earned on the sale of items in the category, select **Allow Commissions**, and then specify the rate in the **Commission Rate** field. (If you do not select this option and specify a maximum commission rate, Order Entry will not record commissions for the sales of items that use the category.)
   c. Specify the general ledger accounts to use for this category.
      - **Sales.** A revenue account that Order Entry credits with the revenue from goods sold.
Returns. A revenue contra account that Order Entry debits to record the reduction of revenue caused when previously sold goods are returned or credit notes are issued.

Cost of Goods Sold. An expense account that Inventory Control automatically debits with the cost of goods sold, and credits with the cost of goods returned.

Cost Variance. An expense account in that Inventory Control records the cost variance between the actual cost and either the standard cost (for items using the standard costing method) or the most recent cost (for items using the most recent costing method) of inventory items sold.

Damaged Goods.

Internal Usage.

4. On the Taxes tab:
   - Use the Finder for the Tax Authority field to select the tax authorities you need to assign to this category. (You define taxing authorities in the Tax Services feature in Common Services.)
   - Enter a tax class or select the numbers of the tax classes you want to assign to the category for sales for each selected tax authority. (You can override this sales tax class for items you assign to this category.)
   - Enter the tax class number or select the numbers of the tax classes you want to assign to the category for purchases for each selected tax authority. (You can override this purchase tax class for items you assign to this category.)

5. Click Save.

After adding categories
Print the I/C Categories report for your records.

About Deleting Categories

You can delete categories one at a time using the Categories screen (the same screen you use to add categories to Inventory Control).

You can also use the Delete Inactive Records screen in the I/C Periodic Processing folder to delete groups of categories.
Chapter 1: Setting Up Inventory Control

**Note:** You cannot delete a category if any item records are assigned to it. You must first assign its item records to another category or delete them.

**Setting Categories Inactive before Deletion**

Before trying to delete a category, you can set the category record *Inactive* to ensure that no additional items are assigned to it.

You can then wait until the end of the fiscal or calendar year to delete it (depending on the method you use to accumulate item statistics).

You use the I/C Categories screen to make categories inactive.

**Identifying Inactive Categories**

Print the Categories report to identify inactive categories. If a category is inactive, the date it was made inactive appears on this report in the Inactive On field.

**Inventory Locations**

You use the Locations screen in the I/C Setup folder to add location records in Inventory Control, and to assign items to particular locations.

A location is a place, such as a warehouse or retail store, where you keep some or all of your inventory. You must set up at least one location in Inventory Control for your inventory items.

**About Setting Up Locations**

You use the Locations screen in the I/C Setup folder to add location records in Inventory Control, and to assign items to particular locations.

A location is a place, such as a warehouse or retail store, where you keep some or all of your inventory. You must set up at least one location in Inventory Control for your inventory items.

Before you can post a transaction for an item at a location, such as receive the item at the location, you must do one of the following:

- Select the Allow Items At All Locations option in the I/C Options screen.
- Assign the item to the location.

**Note:** You can assign an item to more than one location.
If you want to override General Ledger account segments in Inventory Control transactions that include items stocked at a particular location, you select the **Override G/L Account Segments** option on the Integration tab of the location record, and then specify the segment to override, as well as the segment code with which to replace the segment.

For more information about overriding account segments for a location see "About Overriding General Ledger Account Segments for Locations" (page 55).

**About Deleting Locations**

You can delete locations one at a time using the Locations screen (the same screen you use to add locations to Inventory Control).

You can also use the Delete Inactive Records screen in the I/C Periodic Processing folder to delete groups of inactive locations.

**Note:** You cannot delete a location if any item records are assigned to it, or if any inventory worksheets exist for the location. You must first assign its item records to another location, or delete the items. If an inventory worksheet exists for the location, delete it also.

**Setting Locations Inactive before Deletion**

Before trying to delete a location, you can set the location record Inactive to ensure that no additional items are assigned to it. You can then wait until the end of the fiscal or calendar year to delete it (depending on the method you use to accumulate item statistics).

Use the I/C Locations screen to set locations Inactive. See "I/C Locations Screen" (page 581) for more information.

**Identifying Inactive Locations**

Print the I/C Locations report to identify inactive locations. If a location is inactive, the date it was made inactive appears on this report below the Last Maintained date in the Telephone/Fax column. See "Printing the Locations Report" (page 313) for more information.

**Segment Codes**

Inventory Control can validate item number segments when you add new items.
You turn on the option to validate particular segments on the Items tab on the I/C Options screen.

You add valid codes for segments you want to validate using the Segment Codes screen in the I/C Setup folder.

**About Segment Codes**

Inventory Control can validate item number segments when you add new items.

You turn on the option to validate particular segments on the Items tab on the I/C Options screen.

You add valid codes for segments you want to validate using the Segment Codes screen in the I/C Setup folder.

**Example:**
The following table shows how you can set up two segment codes:

(Consecutive Xs denote a segment in an item structure.)

<table>
<thead>
<tr>
<th>Segment</th>
<th>Length</th>
<th>Description</th>
<th>Segment Code and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XX</td>
<td>2</td>
<td>Style</td>
<td>R1 / Regular</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>M1 / Modern</td>
</tr>
<tr>
<td>XXX</td>
<td>3</td>
<td>Color</td>
<td>RED / Red</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>WHI / White</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>BLU / Blue</td>
</tr>
</tbody>
</table>

Adding segment codes is optional, as is using them once you have entered them.

**Note:**
Before adding segment codes, you must:

- Add segments to the Options screen.
- Decide which codes to use for each segment. Segment codes can be neither longer nor shorter than the length of the segment for which they will be used.
About Overriding General Ledger Account Segments for Locations

Inventory Control lets you replace (override) segments in general ledger accounts when you generate Inventory Control transactions that include items stocked at a location.

If you want to override General Ledger account segments in Inventory Control transactions that include items stocked at a particular location, you select the **Override G/L Account Segments** option on the Integration tab of the location record, and then specify the segment to override, as well as the segment code with which to replace the segment.

**Example:** If you have a location segment in your general ledger inventory control account, you can value your stock by physical location—as well as by account set—if you replace the location segment with segment codes that identify physical locations.

The accounts affected are those defined by an item's category and account set. You can replace any account segment except the account segment, which identifies the general ledger account as an asset, liability, income or expense account.

Item Structures

Inventory Control uses item structures to format item numbers. Item structures control which segments are included in item numbers and the order in which the segments appear. You select the item structure you want to use when you add items to Inventory Control.

About Item Number Formats

Inventory Control uses item structures to format item numbers. Item structures control which segments are included in item numbers and the order in which the segments appear. You select the item structure you want to use when you add items to Inventory Control.

**The general steps required to set up item number formats include:**

1. Defining the segments you require for your item numbers.

   An item number can consist of up to ten segments. Use the segments in item numbers to organize items by common attributes. Also, you can sort reports by any segment of an item number.
2. Adding segment codes (optional) to control what the program allows you to enter in segments of the item number.

**Example:** If you define a two-digit segment for color, you might set up the following segment codes: 01 for red, 02 for white, and 03 for blue.

3. Setting up one or more item structures in Inventory Control.

The following sections provide more information and examples of segments, segment codes, and item structures.

### Defining Segments

Use the Items tab of the I/C Options screen to add the segments you want to use in your Inventory Control system.

You can define up to ten segments, any number of which you can then combine to define item structures, which are used to format item numbers.

**Note:** Sage 300 Standard ERP allows a maximum of 4 item segments.

**Example:**

Item number #01-RED-L3401 has the following item number segments:

<table>
<thead>
<tr>
<th>Segment</th>
<th>Length</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XX</td>
<td>2</td>
<td>Style</td>
</tr>
<tr>
<td>XXX</td>
<td>3</td>
<td>Color</td>
</tr>
<tr>
<td>XXXX</td>
<td>5</td>
<td>Size</td>
</tr>
</tbody>
</table>

You can change the name of a segment after it is set up, but you cannot change or delete the segment itself.

**Note:**
- Each segment can be up to 24 characters long.
- An item structure can be up to 24 characters long (including all segments, separator characters, and a prefix character).

### Adding Segment Codes

Use the Segment Codes screen to define segment codes for your segments.
After you define the segments you plan to use for your inventory item numbers, you can store valid segment codes for each segment. In other words, you can list all the valid codes that you can enter into a segment of an item number.

Adding segment codes is optional, as is using them once you have entered them. Use the Items tab in the Options screen to turn on the Validate option to restrict entries to the list of segment codes for individual segments at any time.

A segment code can contain upper-case letters and numbers. Segment codes can be neither longer nor shorter than the length of the segment for which they will be used.

You can turn the Validate option for segment codes on or off for individual segments at any time. When you add a new inventory item number, Inventory Control verifies what you enter in each segment (for which the segment code Validate option is on) of the item structure, against the segment codes you entered for the segment. If the segments are all valid, the program adds the item number to the system.

If you choose to use segment codes, you must enter all the codes you want the program to allow for a segment in the Segment Codes screen before you add your items.

**Example:**
The following table shows two examples of how you can set up segment codes (consecutive Xs denote a segment in an item structure):

<table>
<thead>
<tr>
<th>Segment</th>
<th>Length</th>
<th>Description</th>
<th>Segment Code and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XX</td>
<td>2</td>
<td>Style</td>
<td>R1 -- Regular</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>M1 -- Modern</td>
</tr>
<tr>
<td>XXX</td>
<td>3</td>
<td>Color</td>
<td>RED -- Red</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>WHI -- White</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>BLU -- Blue</td>
</tr>
</tbody>
</table>

**Note:** You can add segment codes as needed, but you can delete segment codes only if they are not used by any item numbers.

**Setting Up Item Structures**

Use the Item Structures screen in the Setup folder to define item structures for your Inventory Control system.
You create item structures by combining up to ten segments (which you must set up first), in any order, and you can create as many item structures as you require for your item numbers. You must create at least one item structure.

You should set up your item structures to format your item numbers in a way that meets your needs for sorting and grouping items for inventory reports and lists.

The following table provides samples of several item structures. Note the following about the table:

- Consecutive Xs denote a segment in an item structure.
- Characters appearing between the segments of an item structure or item number are called separator characters.
- A character appearing at the front of an item structure or item number (such as the # in the fourth example in the following table) is called a prefix character.

<table>
<thead>
<tr>
<th>Item Structure</th>
<th>Sample Item Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>XXXX</td>
<td>F605</td>
</tr>
<tr>
<td>XXX.X</td>
<td>120.5</td>
</tr>
<tr>
<td>XX-XXX/X</td>
<td>K1-501/A</td>
</tr>
<tr>
<td>#XXX-XXXXX-XX-X</td>
<td>#L31-GT213-8A-0</td>
</tr>
</tbody>
</table>

**Tips:**

While you design your item numbering format, consider the following suggestions:

- Use numbers (rather than letters or combinations of numbers and letters) for all segments to make the order in which item numbers appear on reports and in lists more predictable.

- Define item numbers so you have room to add items in the future. For example, assign large numbers such as 1100, 1200, and 1300 to a segment for consecutive items, rather than 1100, 1101, and 1102. Using large numbers leaves you room to assign a new item number, such as 1150, between two existing numbers (1100 and 1200).

- Assign item numbers according to the order in which you want items to appear on reports and lists. For example, identify the style of an item as...
Designating a Default Item Structure

If you create more than one item structure, you can designate one item structure code as the default for formatting item numbers.

The item structure code you select is used as the default when you add item records to Inventory Control. You should choose the item structure code that you will use most often.

Using Separator Characters

When you define an item structure, you can select a separator character to appear between segments so item numbers are easier to read. For example, for a three-segment item number it is easier to distinguish the segments in 5046-010-92 than in 504601092.

If you select a separator character for the last segment in an item structure, the character appears at the end of item numbers using that item structure. For example, 5046-010-92#.

If your current inventory item numbers already follow the rules for item numbers listed in the next section, you can create the item structures you need for entering item numbers into Inventory Control. Otherwise, design a new item number format before creating your item structures.

Adding Item Structures

You use item structures to format item numbers for sorting and grouping items on reports and in lists.

You can have as many different item structures as you need to accommodate different item number formats. However, you must add at least one item structure to Inventory Control before you can add item records.

Note: You create item structures from the segments you have added to the Options screen.
**Before you start:**

- Add segments in the Options screen.
- Choose a code of up to six characters (letters and numbers) to identify each item structure you plan to add.
- Design the item structures you plan to add, based on what you want your item numbers to look like.
- If you have more than one item structure, decide which one you will use the most, and mark it as the default item structure.

**To add an item structure:**

1. Open *Inventory Control > I/C Setup > Item Structures*.
2. In the *Structure Code* field, type a code to identify the item structure, using up to six alphanumeric characters.
3. If this is the item structure you will use most often to format item numbers, select *Use as Default Item Structure*.
4. In the *Description* field, type a description for the structure code.
5. If item numbers using this structure will start with a prefix, select the prefix from the *Prefix* list. Otherwise, accept None as the entry for this field.

   **As you create the item structure:**
   - The Item Structure field displays a sample format.
   - The Total Length field indicates how many characters are used in the structure.

6. Tab to the table, or click the table.
7. Using a line for each segment, in the order it will appear in the item number:
   a. Select the segment name.
   b. Select a separator (optional).
   c. Specify the segment length.

   An item structure can be up to 24 characters long (including all segments, separator characters, and a prefix character).
8. Click *Add*, or click *Save* if you added the structure code before.
After adding item structures
Print the I/C Item Structures report.

Mask Structures
If you use Serialized Inventory and Lot Tracking, you use the Mask Structures screen in the I/C Setup folder to define formats, or mask structures, for your serial numbers and lot numbers.

About Mask Structures
A mask structure can include:

- Up to five alphanumeric segments
- One segment that increments automatically, and it must be a numeric segment
- A prefix
- A total of 40 characters, including all segments, separators, and prefixes

Note: Plan your mask structures carefully before setting them up. Mask structures cannot be changed for an item after you have already started assigning numbers to it. Also, you cannot edit or delete a mask structure if any serial numbers or lot numbers have been assigned to inventory units using that mask structure.

Adding Mask Structures
If you use Serialized Inventory and Lot Tracking, you use the Mask Structures screen in the I/C Setup folder to define formats, or mask structures, for your serial numbers and lot numbers.

Before you start:

- Design the mask structures you plan to add, based on what you want your serial numbers and/or lot numbers to look like. You can have up to 40 characters total in a mask that consists of up to five segments, one of which you can increment.
- Choose a code of up to six characters (letters and numbers) to identify your serial number structure and/or lot number structure.
If you want to ensure that your mask structures never use specific characters for segment separators, set the Separators Used in Serial Mask Structures or Separators Used in Lot Mask Structures for these characters to No on the I/C Options screen.

**To add a mask structure:**

1. Open **Inventory Control > I/C Setup > Mask Structures**.
2. Enter a code of up to six characters to identify the mask structure.
3. Select the type of mask, either **Serial** (for serial number) or **Lot** (for lot number).
4. Enter a description for the mask structure.
5. Optionally, select a prefix character from the drop-down list.
6. For each segment you want in the mask structure, select the segment type and enter the length of the segment. If desired, select a segment separator, or leave it at None.
7. If you want a segment that increments automatically, make one segment numeric, and change the increment setting to **Yes**. You can increment only one segment.

   When you enter a segment, the Mask Structure and Total Length fields are updated to display the current structure and length of the mask.

   **Tip:** To delete a segment from the mask, highlight the line, and then press the **Delete** key.

8. Click **Save** to add the mask structure.

**After adding mask structures**

Print the Mask Structures report.

**Changing or Deleting Mask Structures**

If you use Serialized Inventory and Lot Tracking, you use the Mask Structures screen in the I/C Setup folder to define formats, or mask structures, for your serial numbers and lot numbers.

**Note:** You cannot edit or delete a mask if any serial numbers or lot numbers have been assigned to inventory units using that mask structure.
To change mask structures:
1. Open Inventory Control > I/C Setup > Mask Structures.
2. Use the Finder for the Structure Code field to select the mask structure to edit.
3. Enter the changes to the mask structure.
4. Click Save.

To delete mask structures:
1. Open Inventory Control > I/C Setup > Mask Structures.
2. Use the Finder for the Structure Code field to select the mask structure to delete.
3. Click Delete, and then confirm the deletion.

Contract Codes

If you use Serialized Inventory and Lot Tracking, you can use the Contract Codes screen to enter the terms of sales agreements with your suppliers.

Each contract code can have up to five periods, and you can define the number of days in each period of the contract. The number of days in the periods are cumulative. For example, for a 90-day contract, you can have three periods set to 30 days.

Adding Contract Codes

Before you start:
Confirm the terms of the contracts with your vendors.

To add a contract code:
1. Open Inventory Control > I/C Setup > Contract Codes.
2. In the Contract Code field, type the new contract code using up to six characters, and then type a description in the adjacent field.
3. In the table, add a line for each period in the contract code, including the following information for each period:
Chapter 1: Setting Up Inventory Control

- **Period.** To add a period, press the Insert key while the pointer is in the table. The next period number is displayed on the new line. (You can add up to five periods.)

- **Lifetime.** If the period is for a lifetime contract, double-click this field to change it to **Yes.**

- **Contract Days.** Enter the number of contract days in this period.

  **Note:** This field is not available if you set the Lifetime field to **Yes.**

- **Effective Days.** Type the number of days after the sold date that the contract period becomes effective.

  **Example:**
  - If Effective Days = 0 (zero), the start date of the contract period is the sold date.
  - If Effective Days = 5, the start date of the contract period is 5 days after the sold date.

- **Description.** Enter a description of the contract period, using up to 60 characters.

  **Tip:** To delete a period, highlight (select) the line, and then press the Delete key.

4. When you have finished entering information for the contract code, click **Save.**

**After adding contract codes**

Print the Contract Codes report (using the I/C Warranty/Contract Codes Report icon).

**Warranty Codes**

Use the I/C Warranty Codes screen to enter the terms of sales agreements with your customers on the serialized or lotted items that they purchase from you.

**Adding Warranty Codes**

Use the I/C Warranty Codes screen to enter the terms of sales agreements with your customers on the serialized or lotted items that they purchase from
you.

Each warranty code can have up to five periods, and you can define the number of days in each period of the warranty. The number of days in the periods are cumulative. For example, for a 90-day warranty, you can have three periods set to 30 days.

**Note:** The Warranty Codes screen is available only if you have a license to use Serialized Inventory and Lot Tracking.

**To add warranty codes:**

1. Open **Inventory Control > I/C Setup > Warranty Codes**.
2. Enter a **Warranty Code** of up to six characters and a description of the warranty code in the adjacent field.
3. Add a line in the table for each period in the warranty code:
   - If the period is for a lifetime, double-click the **Lifetime** field to change it to **Yes**. Otherwise, leave it as **No**.
   - Enter the number of warranty days in this period. (not available for a period where the Lifetime field is set to Yes.)
   - Enter the number of days after the sold date that the warranty period becomes effective.
   - Enter a description of the warranty period, up to 60 characters.

   To add another period, press the **Insert** key.

   To delete a period, highlight the line, and then press the **Delete** key on your keyboard.
4. Click **Save** to add the warranty code.

**Price List Codes**

You use price lists to store pricing information for all of your inventory items. You can have as many price lists as you need to handle different locations, different countries, and different currencies.

**Adding Price List Codes**

You use price lists to store pricing information for all of your inventory items. You can have as many price lists as you need to handle different locations,
different countries, and different currencies.

For example, you can use different price lists to store:

- Regular prices.
- Sale prices.
- Wholesale prices.
- Regional prices.
- Prices for volume discounts to customers who make large purchases.
- Prices in each currency with which your company deals (if you use multicurrency accounting).

**Note:**
Each price list code can support one set of prices (including discount, tax, and price check information) in each of the currencies that you use in your business. You do not need to add price list codes for each currency.

**Before you start:**

- Choose a code of up to six characters to identify each price list you plan to add.
- Decide on default options for calculating customer discounts or markups for each price list code.
- Decide on default price check options.
- Add any new tax authorities you might need to Tax Services.

**To add a new price list code:**

1. Open **Inventory Control > I/C Setup > Price List Codes**.

2. In the **Price List Code** field, type a code to identify the price list using up to six characters.

3. In the **Description** field, enter a description for the price list (for example, "US mail order prices").

4. On the Discounts tab, enter the following information:
   
   a. In the **Price By** field, specify whether the price of the item is based on weight or on quantity.
If you specify weight, you can set volume discount amounts or percentages that are determined by item weight. The weights are calculated in Order Entry by multiplying the unit weight of an item times the quantity ordered, and converting the weight to default units.

**Note:** Pricing by weight is available only for Sage 300 Premium ERP.

b. From the **Price Decimals** list, select the number of decimal places to use to display prices for this price list.

c. From the **Selling Price Based on** list, select the default method for calculating discount prices for items on this price list.

Inventory Control calculates selling prices for each method, as follows:

- **Discount.** The base price for the item is discounted. (You assign base prices when you assign items to the price list.)

- **Markup on Markup Cost.** The program marks up the item's markup cost. (You assign markup costs when you assign items to the price list.)

- **Markup on Standard Cost.** The program marks up the item's standard cost. (You assign standard costs when you add location details for items.)

- **Markup on Most Recent Cost.** The program marks up the item's most recent cost.

- **Markup on Average Cost.** The program marks up the average cost for the item.

- **Markup on Last Cost.** The program marks up the last cost for the item.

- **Markup on Alternate Amount 1 or Alternate Amount 2.** Inventory Control calculates the selling price by marking up the cost that you enter in the Alternate Amount 1 or 2 fields (defined on the Processing tab on the I/C Options screen).

  **Note:** If you are pricing by weight, you can choose Discount and Markup On Markup Cost only.

d. From the **Discount on Price by/Markup on Cost by** list, select whether to discount the base price or mark up the cost.
If you select **Percentage**, you specify the percentages in the Discount Percent fields that appear.

If you select **Amount**, you specify the amounts in the Discount Amount fields that appear.

e. From the **Pricing Determined by** list, specify whether to determine price discounts by customer type or by volume.

- If you select **Customer Type**, Inventory Control determines prices according to the customer’s type ("A, B, C, D, E").
  
Customer types are assigned to customers in Accounts Receivable.

- If you select **Volume Discounts**, Inventory Control determines prices according to the quantity of an item the customer purchases.

5. On the **Price Check** tab, specify how Inventory Control will check price overrides for Order Entry orders that use this price list.

a. From the **Price Check Type** list, specify how Order Entry will respond to price overrides.

- Do nothing (if you select **None**).

- Display a warning message, and let you continue.

- Display an error message, and reject the price override.

- Force you to get a supervisor’s approval on price overrides.

b. From the **Check** list, select whether to check the unit price or the sales margin.

   i. If you are checking the unit price, in the **Check Base** field, specify whether price checks are based on cost plus a range of percentages, cost plus a range of amounts, or a fixed range of prices.

   ii. In the **Cost/Margin Base** field, specify the cost on which you are calculating the acceptable range of prices.

   Note: This field does not appear if you selected Fixed Amount in the Check Base field.

c. In the table, enter the range of prices available to each user ID.
You can create several price approval levels for sales clerks and supervisors.

**Important!** The Default price check range applies to all users who are not listed in the table. If you delete the price check for the Default user, the program checks prices only for the listed user IDs.

6. On the Taxes tab, fill in the tax information as follows:

**Authority.** Enter a tax authority (such as state or province) or use the Finder to select the tax authority that taxes sales of the item.

**Cust. (Customer) Tax Class.** Enter the customer tax class or use the Finder to select a customer tax class for the tax authority.

For more information about tax authorities and tax classes, see the help for Tax and Bank Services (in the Sage 300 ERP System Manager help).

7. Click **Add**, and then repeat these steps for each price list code that you want to add.

**After adding price list codes**

- Print a list of the price list codes that you added to verify that they are correct and complete.
- Add items directly to the new price list, or use the Copy Item Pricing screen to assign items from another price list to this one.

---

**Optional Fields**

Optional fields are custom fields that you can use to store additional information with Inventory Control records and transactions. You can define an unlimited number of optional fields for transaction entries and details lines, and other Inventory Control records.

**Setting Up Optional Fields for Inventory Control Records and Transactions**

Optional fields are custom fields that you can use to store additional information with Inventory Control records and transactions. You can define an unlimited number of optional fields for transaction entries and details lines, and other Inventory Control records.
Once you have added optional fields, you can enter data in the optional fields when you add new I/C items and enter inventory transactions.

**Before you start:**

- Determine which optional fields you need in Inventory Control.
- Decide which optional field information you want to pass to other ledgers with item records and with G/L transactions to the General Ledger.
- If the optional fields you need have not been added to Sage 300 ERP, use the Optional Fields screen in Common Services to add them.

**Important!** Make sure that no one else is using the Inventory Control data and that no other Inventory Control screens are open for the company before you try to save changes to optional fields.

**To set up optional fields for use in I/C item records and transactions:**

1. Open **Inventory Control > I/C Setup > Optional Fields**.
2. In the **Optional Fields For** list, select the type of record or transaction for which you are setting up optional fields.
3. Click in the table, and then press the Insert key to start a new line.
4. Enter information for each optional field you are adding to the record, transaction, or transaction detail, as follows:
   
   a. In the **Optional Field** column, click the Finder (or press F5), and then select an optional field from the Finder.
   
   b. Double-click in the **Value Set** column to change it to Yes.

   The Value Set field alerts the data entry clerk that a seemingly blank optional field actually has an entry. By looking at the Value field, you cannot tell whether it has a “blank” default value or no value at all.

   c. To set a default value for the selected optional field, in the **Default Value** column, click the Finder, and then type or select the value to appear as the default for each optional field.

   If the optional field you selected requires validation, you must select a value that is defined for the optional field in Common Services. If the optional field allows blanks, you can leave the default value field blank.
If the optional field does not use validation, you can select a value that is defined for the optional field in Common Services or leave the field blank.

**Note:** The entry must be consistent with the type of field (text, number, date, amount, and so on) and must not exceed the number of characters specified for the optional field. In a Yes/No field, you can enter only Yes or No.

d. To make the optional field mandatory, double-click in the **Required** column.

During data entry, if an optional field is required, but does not have a default value, you must fill in the field before you can proceed. If the optional field has a default value, you can accept the value that appears, or assign a different one.

e. If you want the optional field and its default value to appear automatically in new records and transactions, in the **Auto Insert** column, double-click to select **Yes**.

f. If the Settings button is available (for example, for certain transaction detail optional fields):

i. Click **Settings** to open a separate screen where you specify whether to include this optional field with transactions sent to General Ledger and other subledgers.

ii. Specify which optional fields to include in transactions sent to General Ledger or other subledgers.

**Note:** Consider carefully the purpose of each optional field that you add. For example, send to General Ledger only optional fields that are used for financial analysis, and only to the accounts where they are required.

iii. Click **Close** to close the Settings screen.

5. Click **Add** on the I/C Optional Fields screen, and then click **Close**.

*After adding optional fields to Inventory Control transactions and records*

- You can now open the screen to which you added optional fields and enter data. For example, if you defined an optional field for shipments, you would
see the optional field when you clicked the Zoom button beside Optional Fields check box in the Shipments screen.

- Use the Optional Fields screen in General Ledger to add optional fields to G/L transaction details, if you are passing optional fields from Inventory Control transaction details to General Ledger.

- Use the Optional Fields screen in Order Entry and Purchase Orders if you want to add optional fields associated with inventory items to O/E and P/O transaction details.

**G/L Integration**

Inventory Control creates batches of general ledger transactions in General Ledger either when you run day-end processing, or when you use the Create G/L Batch screen. Inventory Control also displays and validates General Ledger account numbers in Inventory Control.

**Using Inventory Control with General Ledger**

Inventory Control creates batches of general ledger transactions in General Ledger either when you run day-end processing, or when you use the Create G/L Batch screen. Inventory Control also displays and validates General Ledger account numbers in Inventory Control.

The summary at the end of each Inventory Control posting journal lists the general ledger accounts that will be debited and credited when you post the Inventory Control batch of general ledger entries in General Ledger.

If you use the I/C Create G/L Batch screen to create the General Ledger batch, after running Day End Processing, the G/L Transactions report also shows the general ledger accounts that will be debited and credited.

*Note: Inventory Control deletes the G/L Transactions report when you use the Create G/L Batch screen.*

You specify whether or not to consolidate transaction details for the same general ledger account into a single detail using the I/C Options screen.
General Ledger Accounts Used with Inventory Control

Inventory Control uses the following general ledger accounts:

- Inventory control
- Payables clearing
- Shipment clearing
- Non-stock clearing
- Adjustment write-off
- Assembly cost credit
- Disassembly expense
- Sales (for use by Order Entry)
- Returns (for use by Order Entry)
- Damaged goods (for use by Order Entry)
- Cost of goods sold
- Cost variance

General Ledger Integration Options

This topic discusses the options you can select on the Integration tab of the G/L Integration screen, to specify how your Inventory Control system creates transactions for your general ledger.

Overview

Inventory Control produces general ledger transactions from the inventory transactions you post. Each general ledger transaction includes all the information you need to update inventory control accounts in your general ledger.

If you use Sage 300 ERP General Ledger and Inventory Control with the same database, Inventory Control creates General Ledger batches or appends to existing batches either when you post the transaction, or when you run day-end processing, or at a later time that you choose.

If your General Ledger is at another location or in a separate database, Inventory Control appends general ledger transactions to a file you can import into another general ledger, or print, then enter manually into your general ledger.
ledger. Inventory Control appends to the transaction file either when you run day-end processing or at a later time that you choose.

Specify when to generate general ledger transactions: either during posting, or when you run day-end processing, or at a later time of your choosing (using the Create G/L Batch screen).

- To create a batch or append to an existing batch or transaction file only when you are ready, use the On Request Using Create G/L Batch Icon option. When you are ready to create general ledger transactions, you then use the Create G/L Batch screen.
  
  Select this option if you want to be able to consolidate general ledger transaction details and print Inventory Control’s G/L Transactions report.

- To create a batch or append to an existing batch or transaction file when you run day-end processing, select the During Day End Processing option.

Using Inventory Control and General Ledger at the Same Site

If you use Sage 300 ERP General Ledger with Inventory Control, the Inventory Control general ledger batches are created in General Ledger. To avoid making accidental changes to General Ledger batches created by Inventory Control, select No Edit for the Edit Imported Entries option in General Ledger's Options screen.

Specifying the Number of General Ledger Batches to Produce

Specify whether to append general ledger transactions to an existing Sage 300 ERP General Ledger batch each time you run day-end processing, or to create a new General Ledger batch.

To have only one General Ledger batch to which all transactions are appended, turn on the Append G/L Transactions To Existing Batch option. Inventory Control must use the same database as Sage 300 ERP General Ledger.

Using Inventory Control without Sage 300 ERP General Ledger at the Same Site

If you do not use Sage 300 ERP General Ledger—or if your Sage 300 ERP General Ledger system is at another location—Inventory Control appends its general ledger transactions to a file in your company’s data directory called icgltrn.csv, which can be imported by a remote site General Ledger, or transferred to another general ledger that you use. The file is in a Comma Separated Values (CSV) format.
Choosing Consolidation Options for General Ledger Transactions

If you selected the On Request Using Create G/L Batch Icon option to create general ledger transactions, you can create consolidated batches of general ledger transactions that combine several details into a single detail, or you can create unconsolidated batches that include all the details posted to each general ledger account. Select the consolidation method you want from the Consolidate G/L Batches option.

If you selected the During Day End Processing option to create general ledger transactions then you cannot create consolidated batches of general ledger transactions.

Consolidation reduces the amount of information in the general ledger batch and results in a shorter G/L Transactions Listing. Consolidation also "consolidates" the information in the Reference and Description fields for each transaction.

Consolidate transaction details if you do not need a record of all details posted to each general ledger account from Inventory Control transactions.

The options available include the following:

- Do not consolidate.
  
  All the details posted in Inventory Control will be included in the General Ledger transaction batch.
  
  Choose this option if you use optional fields and pass optional field information from I/C transaction details to G/L transaction details.

- Consolidate transaction details by account.
  
  All the details within a transaction with the same general ledger account number are combined into one detail.
  
  Choose this option if you do not use optional fields, but still want to associate general ledger transactions with originating documents (for drill down or to maintain a manual audit trail).

- Consolidate by account and fiscal period.
  
  All the details with the same general ledger account number and fiscal period are combined into one detail.
  
  Note that this choice only consolidates details from different transactions if you create transaction batches using the G/L Batch screen.
• Consolidate by account, fiscal period, and source.

All the details with the same general ledger account number, fiscal period, and source code are combined into one detail.

This choice only consolidates details from different transactions if you create transaction batches using the G/L Batch screen.

Creating Detailed General Ledger Transactions

Use the Do Not Consolidate option if:

• You require detailed general ledger transaction information for your Inventory Control records.

• You want to drill down from transactions in General Ledger to the source transactions in Inventory Control.

The Do Not Consolidate option provides complete information in your general ledger transaction batch, but can result in a long G/L Transactions report and a large general ledger batch. However, if you use Sage 300 ERP General Ledger, you can consolidate the transaction details when you post the batch in General Ledger.

Selecting References and Descriptions for General Ledger Transactions

You can specify the type of information to use in the Description, Reference, and Comment fields for each unconsolidated general ledger transaction and transaction detail. The information appears in Inventory Control’s G/L Transactions report, and on reports in General Ledger.

Select the information you need for your audit trail of unconsolidated Inventory Control transactions using the Transactions tab of the G/L Integration screen.

When you consolidate general ledger transactions by account number and fiscal period, the source code after consolidation is IC-CO.

When you consolidate general ledger transactions, the reference for each transaction becomes blank, and the description for each transaction is changed to "Consol. by I/C on date." (Note that when there is only one of a particular transaction type, the reference and description for the transaction are whatever you selected on the Transactions tab of the G/L Integration screen.)
Changing I/C General Ledger Integration Options

You use the I/C G/L Integration screen to select options and settings that determine how your Inventory Control ledger interacts with your general ledger.

Important! Make sure that no one else is using the Inventory Control data and that no other Inventory Control screens are open for the company before you save changes to the G/L Integration screen. You cannot change I/C G/L integration settings if other Inventory Control screens are open, or if other users are working with the Inventory Control database.

Before you start:

- Print the G/L Integration report from the Setup Reports folder so you have a record of your G/L Integration settings before you start.
- If you want to change from using the Create G/L Batch screen to produce your general ledger transactions to creating them during day-end processing, be sure to run Create G/L Batch to process any outstanding transactions first, to avoid accidentally omitting transactions from your general ledger batches.

To change G/L integration options:

1. Open **Inventory Control > I/C Setup > G/L Integration**.
2. On the Integration tab, modify settings as needed.

You can change:

- When I/C creates transactions for posting to the General Ledger.

You can choose to create transactions when I/C costs inventory items (this is set in the I/C Options screen) or using the Create G/L Batch screen.

Note: This choice can have a large impact on the speed of processing inventory transactions and transactions in Order Entry. If you are costing inventory during posting, you may want to create transactions at a later date.

- Whether I/C adds new transactions to existing G/L batches or creates new batches (and, optionally, automatically posts the new batches).
• Whether I/C consolidates G/L transactions to send less detail to the general ledger. (This choice can also limit drilldown from the general ledger.)

• The codes attached to each transaction sent from Inventory Control.
  
  New source codes are automatically added to G/L, but you will have to update G/L source journal profiles to include transactions on source journals.

  **Note:** Any changes you make apply only to general ledger transactions created after the change, and do not affect existing general ledger batches.

3. To change the information that appears with G/L transactions, use the table on the Transactions tab.

   The table lists the types of transactions Inventory Control creates, along with the information that is currently used for the entry description, detail description, detail reference, and comment fields in the G/L transactions created from these I/C transactions.

   a. Select (highlight) the line for the information that you want to change, and then click **Open**, or double-click the line.

   b. On the G/L Integration Detail screen that appears, select information to add to or remove from the transaction field, and then click the **Include** or **Exclude**.

      **Note:** You can assign one or more pieces of information (segments) to each G/L transaction field, provided that the combined length of the segments and separators does not exceed 60 characters. Fields exceeding this limit will be truncated when you post the general ledger transactions.

   c. Click **Save** to save the contents of the G/L transaction field.

   d. When you have finished, click **Close** to return to the Transaction tab.

4. Click **Save** to save changes to the I/C G/L Integration screen.

**After changing G/L integration options**

Print the G/L Integration report from the Setup Reports folder to check that the settings were changed correctly.
Integration With Other Programs

Sage 300 ERP Inventory Control integrates with General Ledger and the following optional modules:

- Order Entry
- Purchase Orders
- Project and Job Costing
- Sage Fixed Assets

Using Inventory Control with Order Entry

Order Entry provides a fully featured sales order and invoice processing system that works with Inventory Control.

**Note:** Order Entry is not a standalone accounting module. You must install and activate Inventory Control before you can activate Order Entry.

Order Entry Uses I/C Price Lists

Order Entry displays item numbers and price list information such as prices and pricing units, sale prices, and discounted prices from Inventory Control when you enter sales orders.

Effect of Order Entry Transactions on Inventory Control

Order Entry transactions affect Inventory Control data as follows:

- Sales orders posted in Order Entry increase the item quantities on sales order in Inventory Control.
- Shipments posted in Order Entry decrease the item quantities on sales order and the item quantities on hand in Inventory Control.
- Returns posted in Order Entry increase the item quantities on hand in Inventory Control (unless the goods are damaged).
- Credit notes posted in Order Entry that return items to inventory increase item quantities on hand in Inventory Control.

Sage 300 ERP keeps item quantities updated online, which means that stock quantities in Inventory Control affected by Order Entry transactions are always up to date.
Day End Processing in Inventory Control updates sales statistics and transaction history for Order Entry transactions (and for Inventory Control transactions) in both Order Entry and Inventory Control, and creates Accounts Receivable invoices and credit notes from Order Entry transactions.

**Using Inventory Control with Purchase Orders**

Purchase Orders provides a fully featured purchase orders system that works with Inventory Control.

**Note:** You must activate Inventory Control before you activate Purchase Orders to take advantage of the seamless integration of these two modules. If you activate Purchase Orders first, you will activate it as a standalone accounting module.

Purchase Orders displays inventory item information from Inventory Control when you enter purchase orders, and can generate purchase orders automatically when inventory item quantities fall below the minimum quantity or projected sales quantity that you specify in the Reorder Quantities screen in Inventory Control.

Purchase Orders transactions affect Inventory Control data as follows:

- Purchase orders update the item quantities on purchase order in Inventory Control.
- Receipts, returns, and invoices update the item quantities on hand in Inventory Control.

Sage 300 ERP keeps item quantities updated online, which means that stock quantities in Inventory Control affected by Purchase Orders transactions are always up to date.

Day End Processing in Inventory Control updates inventory item costs affected by transactions you enter in Purchase Orders (unless you chose to update costs during posting) and updates transaction history in Inventory Control. Day-end processing also creates Accounts Payable invoices for invoices you enter in Purchase Orders.

**Using Inventory Control with Project and Job Costing**

Inventory Control fully supports Project and Job Costing.
Inventory Control determines the costs for material usage and return transactions that you process in Project and Job Costing, as follows:

- When you post a material usage transaction, then run Day End in Inventory Control, Inventory Control determines the cost of items and creates the journal entries that debit Work In Progress (WIP) and credit Inventory Control (and credit Overhead, if appropriate).

- When you post a material return transaction, Inventory Control creates the same journal entry, but reverses the debit and credit entries.

- When you print reports, the Shipment Posting Journal will show Job-related details.

**About Using Inventory Control with Sage Fixed Assets**

Sage 300 ERP provides full integration with Sage Fixed Assets, allowing you to enter asset transactions in Inventory Control, Purchase Orders, Accounts Payable, and Intercompany Transactions.

You use the Internal Usage screen in Sage 300 ERP Inventory Control to withdraw items from inventory for use by your company (or organization) and identify them as fixed assets for Sage Fixed Assets.

**Note:** You must install Sage Fixed Assets and set up Sage Fixed Assets Integration before you can use this feature.

Sage Fixed Assets Integration lets you:

- In Inventory Control, identify items as fixed assets when you withdraw them from inventory for internal use by your company.

  **Note:** You must run Create Assets in Sage Fixed Assets Integration to update Sage Fixed Assets with the asset information.

- In Purchase Orders, Accounts Payable, and Intercompany Transactions, identify items as financial assets when you purchase them.

- Send asset information to Sage Fixed Assets to set up program assets that you have identified in Sage 300 ERP.

  **Note:** Sage Fixed Assets works with Inventory Control 5.5 and later versions.
Chapter 1: Setting Up Inventory Control

Units Of Measure

Inventory Control lets you define all of your units of measure in a single place so you can add them more easily to item records.

Units of measure can be numbers of items, dry measures, liquid measures, or weights. You can add all of your stocking units and multiples of stocking units to the Units Of Measure screen, and then choose the group of units you need for each item you add.

About Units of Measure

Inventory Control lets you define all of your units of measure in a single place so you can add them more easily to item records.

Units of measure can be numbers of items, dry measures, liquid measures, or weights. You can add all of your stocking units and multiples of stocking units to the Units Of Measure screen, and then choose the group of units you need for each item you add.

Note: You can choose in the I/C Options screen whether to allow only defined units of measure in inventory records. If you do not choose Only Use Defined UOM, you can use other units of measure with items.

You define units of measure using the Units of Measure screen in the I/C Setup folder.

You assign units of measure to particular items in the I/C item record.

The Stocking Unit of Measure

One of the units of measure assigned to each inventory item is the item’s stocking unit of measure. The stocking unit of measure is important in Inventory Control for the following reasons:

- Inventory Control uses it to report stock levels for the item.

  Note: Different items can use different stocking units.

- If you did not select the Allow Fractional Quantities option on the I/C Options screen, the stocking unit is the smallest unit of measure that you can specify for shipping or selling the item.

  All other units of measure for an item are based on the stocking unit of measure.
• The conversion factor for a stocking unit of measure is always 1.
Chapter 2: Setting Up Items and Price Lists

Item records contain the information you need to manage your inventory. You must add inventory item records to Inventory Control before you can enter inventory transactions.

You use price lists to store pricing information for all of your inventory items. You create price lists by adding items and prices to price list codes. You can have as many price lists as you need to handle different locations, different countries, and different currencies.

Besides adding item records and creating price lists, you may need to create additional records to set up your Inventory Control system, depending on the Inventory Control features your company uses. You may need to:

- Add inventory items to locations and add location details
- Assign vendors to items (optional)
- Set up contract pricing (optional)
- Add bills of material and kitting items (optional)
- Add manufacturers’ items (optional)
- Add customer item numbers (optional)
- Add reorder information (optional)
- Add current item quantities and cost
- Add sales and transaction statistics (optional)

Setting Up Price Lists

You use price lists to store pricing information for all of your inventory items. You create price lists by adding items and prices to price list codes. You can have as many price lists as you need to handle different locations, different countries, and different currencies.

Sage 300 ERP Order Entry uses price lists to calculate prices on orders and invoices.
Chapter 2: Setting Up Items and Price Lists

Inventory Control uses price lists for information purposes. You can see item prices when you ship goods from Inventory Control, and you can print item prices on Inventory Control reports and on item labels and bin/shelf labels.

To have items appear on a price list, you must assign the items to the price list code using the Item Pricing screen (available in the I/C Items and Price Lists folder).

About Price Lists

You use price lists to store pricing information for all of your inventory items. You create price lists by adding items and prices to price list codes. You can have as many price lists as you need to handle different locations, different countries, and different currencies.

For example, you can use different price lists to store:

- Regular prices.
- Sale prices.
- Wholesale prices.
- Regional prices.
- Prices for volume discounts to customers who make large purchases.
- Prices in each currency with which your company deals (if you use multicurrency accounting).

**Note:**
Each price list code can support one set of prices (including discount, tax, and price check information) in each of the currencies that you use in your business. You do not need to add price list codes for each currency.

Sage 300 ERP Order Entry uses price lists to calculate prices on orders and invoices.

Inventory Control uses price lists for information purposes. You can see item prices when you ship goods from Inventory Control, and you can print item prices on Inventory Control reports and on item labels and bin/shelf labels.
Overview of Price List Setup

Setting up price lists for your items in Inventory Control involves the following general steps, which are described later in this topic:

1. Add a new price list code using the Price List Codes screen.
   - You select default options for customer discounts, price checks, and taxes for the items you add to price lists.

2. Do one of the following:
   - Add items to the new price list using the Item Pricing screen.
   - Copy items to the new price list from an existing price list using the Copy Item Pricing screen.
     - You can adjust prices while copying and select the information that you want to copy.
     - You can copy prices from one currency to another, adjusting prices for the different exchange rate.

Note: You must add inventory items and price list codes before you can add items to price lists. You do not need to create price lists before you add inventory items.

Adding Price List Codes

You use the Price List Codes screen (in the I/C Setup folder) to add the price lists you need.

You assign a unique code to identify the price list. (Price list codes can contain up to six upper-case letters and numbers.)

For each price list, you also specify default settings for items that you add to price lists, including:

- Options for calculating customer discounts for the items you add to price lists.
  
  Discount options include:
  
  - Whether to calculate customer discounts by discounting your selling price, by marking up your markup cost, or by marking up your standard cost.
Chapter 2: Setting Up Items and Price Lists

- Whether to calculate customer discounts by discounting or marking up by a percentage or a specific amount, and the percentage or specific amount to discount or mark up.
- Whether to base customer discounts on customer type, or on the number of items purchased (volume discount).

You can override these options when you add item prices to the price lists.

- The rounding method (up, down, or none) that you want the program to use when calculating discount or markup prices. If you discount or mark up prices by a percentage, you can also specify a number to which you want all prices rounded, such as the nearest five cents.
- Tax authorities (such as state or province) and customer tax classes that apply to the sale of items on the price list.

**Note:** When you define price lists, they contain no items or prices. You add items and prices later.

**Adding Items to Price Lists**

To have items appear on a price list, you must assign the items to the price list code using the Item Pricing screen (available in the I/C Items and Price Lists folder).

When you assign items to their first price list code, you specify pricing information for one item at a time.

Afterwards, if you want to assign items to other price list codes, you can use the I/C Copy Item Pricing screen to copy a single item or group of items to additional price lists, adjusting pricing information as needed in the process. For example, you can create a price list of your regular prices first, then create a sale price list based on the regular price list. Basing the sale price list on the regular price list allows you to create the sale price list more quickly than if you enter item prices one at a time.

When adding an item to a price list, you specify:

- The currency code, for multicurrency ledgers. (A price list can contain items that use different currencies.)
- The price list code.
- The item number.
• The description to appear for the item on price list reports. This description also appears in Order Entry detail lines and on orders and invoices.

  **Tip:** You can translate this description if the price list is for other countries.

• The number of decimal places to use for displaying and printing the prices and costs of the item.

• A base price (the expected selling price).

  If you have Sage 300 Premium ERP, you can also:
  • Price volume discounts by quantity or weight.
  • Enter one or more base prices for multiple units of measure.
  • Calculate the base price using the cost plus a percentage or amount.

• A sale price with start and end dates for the sale (optional).

  If you have Sage 300 Premium ERP, you can also:
  • Enter one or more base prices for multiple units of measure.
  • Calculate the base price using the cost plus a percentage or amount.

• A markup cost, and a factor by which to mark up this cost to calculate a selling price for the item.

• A start and end date for the price list. This means that you can easily cut over from an old price list to a new one on a particular date.

• Whether to calculate selling prices by discounting your selling (base) price, or by marking up your cost. You can also choose to mark up your standard cost. In multicurrency ledgers, you can mark up on standard cost only on functional-currency price lists.

• Whether to calculate customer discounts on selling prices by a percentage or by a specific amount, and whether customer discounts are calculated based on volume purchased or on customer type.

• If you are using Sage 300 Premium ERP, whether to check for price overrides in Order Entry for orders that use this price list, and display warnings, error messages, or require supervisors' approval for prices that exceed a particular range.
• Tax authorities (such as state or province) and customer tax classes if you want the program to include taxes in the prices of items for Order Entry.

**Copying Items to a Price List**

When copying items already on a price list to another price list, you specify:

• The price list code of the price list to which the items already belong.
• The pricing currency you are copying from.
• The price list code of the price list to which you are copying the items.
• The pricing currency you are copying to.
• Which items to add.
• Which pricing information to copy exactly and which to adjust.

**Note:** You can change most of the information in an item pricing record at any time, but the Quantity Purchased field cannot be zero if you entered a discount or markup percentage or amount. (The Quantity Purchased field appears on the Discounts tab when you select Volume Discounts in the Prices Determined By field.)

**Maintaining Price Lists**

Inventory Control includes the following screens for maintaining price lists for inventory items:

• **Price List Codes.** Use the Price List Codes screen to add new codes to identify price lists, as well as to change default discount (or markup) and tax information for each price list.

• **Item Pricing.** Use Item Pricing to assign items to price lists, to edit pricing information for items, and to remove items from price lists.

• **Copy Item Pricing.** Use Copy Item Pricing to copy pricing information from a range of items on one price list to another price list.

• **Update Item Pricing.** Use Update Item Pricing to change prices or costs for a range of items on one or more price lists.

• **Contract Pricing.** Use Contract Pricing to set up pricing arrangements for specific customers.
Adding Items to Price Lists

You can add items to as many price lists as you want. Each price list can include prices—including discount and sale amounts—in each of the currencies that you use in your business.

Typically, when adding item prices to several price lists, you:

- Assign items to their first price list.
- Print the Price Lists report to check that the items appear on the price lists to which you assigned them.
- Use the Copy Item Pricing screen to copy items to other price lists, converting prices according to currency exchange rates or adjusting them for different purposes.

**Note:**
Each price list code can support one set of prices (including discount, tax, and price check information) in each of the currencies that you use in your business. You do not need to add price list codes for each currency.

**Before you start:**

- Add the price list codes you want to use.
- Gather the existing pricing information for each item in your inventory.

**To assign items to price lists:**

1. Open **Inventory Control > I/C Items and Price Lists > Item Pricing**.
2. Use the Finder or the navigation buttons for the **Item Number** field to display the item you need, and then do one of the following:
   - To add the item to a price list, click **New**.
   - To update an item on a price list, select (highlight) the item on the table, and then click **Open**.
3. If you use multicurrency accounting, enter a currency code for the prices that you are adding, or use the Finder beside the **Currency Code** field to select the currency code you need.
4. In the **Price List Code** field, enter or select the code for the price list you want.
5. On the Prices tab:
Chapter 2: Setting Up Items and Price Lists

a. Change the description for the item price, if necessary. (The item description appears as the default description.)

b. In the Price By field, specify whether the price is based on weight or on quantity.

Specify whether the price of this item is based on weight or on quantity.

Note: Pricing by weight is available in Sage 300 Premium ERP only.

If you specify weight, Inventory Control lets you set volume discount amounts or percentages that are determined by item weight.

The weights are calculated in Order Entry by multiplying the unit weight of an item times the quantity ordered, and converting the weight to default units.

c. In the Price Decimals field, specify the decimal places to use when displaying and printing this item price.

d. In the Base Price Type field, specify how to calculate the base price. You can enter a base price for a single unit of measure or for multiple units of measure, or you can calculate the base price from a cost.

If you use Sage 300 Premium ERP, you can:

- Enter a base price for a single unit of measure and specify the unit.
  (You can select this option, and have Inventory Control calculate the base price using the item cost. After choosing this option, select the Zoom button to perform the calculation.)

- Enter base prices for multiple units of measure, and set a default unit of measure for I/C Shipments.

  Note: The default price is in effect only if you do not specify a price for the stocking unit. If you specify a price for the stocking unit, I/C Shipments will automatically use it as the default.

You can still set additional prices for volume or customer type discounts on base prices for multiple units of measure.
Calculate the base price as the cost plus a percentage or amount.

If you are calculating volume discounts by weight, you cannot calculate the base price from the cost (because the cost is based on quantity).

e. Enter the base price using the **Base Price** field.

You use this field differently depending on your choice for the Base Price Type. If you selected:

- **Base Price for Single Unit of Measure**

  Enter the normal or suggested selling price for the item, and then, in the **Pricing Unit** field, enter the unit on which the base price is expressed.

  To calculate the base price using a cost as a starting point:
  - Click the Zoom button beside the **Base Price** field to display the Base Price for Multiple Units of Measure screen.
  - Fill in the fields on the screen that appears.
  - You must fill in a location for the cost.
  - Click **Proceed** to return the calculated base price to the Base Price field, where you can edit it.

- **Base Price for Multiple Units of Measure**

  Click the Zoom button beside the **Base Price** field to display the Base Price for Multiple Units of Measure screen.

  In the table, enter a set of base prices:
  - **Unit of Measure**. Enter the item units or use the Finder to select the item units in which the base price is expressed.
  - **Base Price**. Enter the normal or suggested selling price for this item unit of measure, including in the price any taxes that you assign to the item on the Taxes tab.
  - **Default**. The program forces you to select a default unit of measure and price for entering I/C shipments.
The first line you enter is automatically set as the default price, and you can only set it to No by choosing a different line as the default.

Double-click the Default column for the line which you want to be the default.

The default price and UOM is in effect only if you do not specify a price for the stocking unit. If you specify a price for the stocking unit, I/C Shipments will automatically use it as the default.

**Note:** In Order Entry, when you specify the unit of measure for an order detail, Order Entry checks to see if you defined a base price for the specified UOM. If you did not define a base price for the specified UOM, Order Entry uses the default pricing UOM.

The default pricing UOM is in effect only if the order UOM does not match a defined pricing UOM.

If you specify a price for the stocking unit, I/C Shipments automatically uses it as the default.

**Base Price Calculated Using a Cost**

- Click the Zoom button beside the **Base Price** field to display the Default Base Price screen.
- In the **Calculate Base Price Using** field, specify whether to add a percentage or amount to the cost.
- In the **Cost Base** field, select the cost to use as the base.
- In the **Percentage / Amount** field, enter the percentage or amount that you are adding to a cost.
- If you have a multicurrency system, in the **Exchange Rate** field, specify the exchange rate or the rate type and rate date.
  - In the **Sales Price Type** field, specify how to calculate the selling price for the item.
If you use Sage 300 Premium ERP, you can:

- Enter a sale price for a single unit of measure and specify the unit.
  (You can select this option and have Inventory Control provide a starting point for the sale price based on the item cost. After selecting this option, click the Zoom button to perform the calculation.)

- Enter sale prices for multiple units of measure and set a default unit of measure for Order Entry.

  **Note:** The default price is in effect only if you do not specify a price for the stocking unit. If you specify a price for the stocking unit, I/C Shipments will automatically use it as the default.

You can still set additional prices for volume or customer type discounts on sale prices for multiple units of measure.

- Calculate the sale price as the cost plus a percentage or amount.
  If you are calculating volume discounts by weight, you cannot calculate the sale price from the cost (because the cost is based on quantity).

  g. In the **Sale Price** field, specify whether to enter a sale price for a single unit of measure or for multiple units of measure, or calculate the sale price from a cost.

  You use this field differently depending on your choice for **Sale Price Type.** If you selected:

  - **Sale price for a single unit of measure**

    Enter a sale price for the item if you are including sale prices on price lists.

    **Note:** You can also calculate the sale using a cost as a starting point, and edit the calculated amount in this field. To do so, click the Zoom button and fill in the fields on the screen that appears. Note that you must fill in a location for the cost, and you must click the Proceed button when finished to return the calculated sale price to the Sale Price field, where you can edit it.
\* Sale prices for multiple units of measure

If you are entering sale prices for multiple units of measure, click the Zoom button to display the screen for entering multiple units.

You must also specify the default UOM and price if specifying several sale prices.

**Note:** In Order Entry, when you specify the unit of measure for an order detail, Order Entry checks to see if you defined a price for the specified UOM. If you did not define a price for the specified UOM, Order Entry will use the default pricing UOM.

The default pricing UOM is in effect only if the order UOM does not match a defined pricing UOM.

If you specify a price for the stocking unit, I/C Shipments will automatically use it as the default.

\* Sale price calculated using a cost

If you are calculating the sale price from a cost, click the Zoom button, and then:

- Specify whether to base the price on a single unit of measure.
- Click the Zoom button beside the Sale Price field to display the Default Sale Price screen.
- Specify:
  - Whether to add a percentage or an amount to the cost.
  - The type of cost.
  - The percentage or amount to add.
  - The exchange rate if a multicurrency database.

h. If you entered a sale price, in the Sale Starts and Sale Ends fields, enter the range of dates over which the sale price applies.

i. If you are setting up the price list to calculate selling prices by marking up your cost, enter a markup cost, and then specify:

- In the Markup Unit field, enter or select the item units in which the markup cost is expressed.
In the **Markup Factor** field, enter the factor (number) by which you want to multiply the markup cost to calculate the desired selling price for the item.

**Note:** This is a reference field (used on reports), and is not used to calculate the selling price. You enter the actual markup on the Discounts tab.

6. On the Discounts tab:

   a. In the **Selling Price Based on** field, specify the default method for calculating discount prices on this price list.

      Use this option to specify how the discount prices of items assigned to this price list will be calculated by default.

      - **Discount.** Inventory Control calculates the selling price by discounting your base price for the item.

      - **Markup on Markup Cost.** Inventory Control calculates the selling price by marking up your "markup cost" for the item (entered on the previous tab).

      - **Markup on Standard Cost/Most Recent Cost/Average Cost/Last Cost/Alternate Amount 1 or 2.** Inventory Control calculates the selling price by marking up the cost you keep for your items (including the value you enter as "Alternate Amount 1" or "Alternate Amount 2" on the I/C Options screen).

      **Note:** If you are pricing by weight, you can choose Discount and Markup On Markup Cost only.

   b. From the **Discount on Price by/Markup on Cost by** list, select the method to use to discount or mark up customer discounts.

      - **Percentage.** The program either discounts the base price, or marks up the cost you select using the percentages you specify in the fields in the lower part of the screen.

      - **Amount.** The program either discounts the base price, or marks up the cost you select using the amounts you specify in the fields on the lower part of the screen.

   c. From the **Pricing Determined by** list, select the method to use to
determine price discounts for items.

- **Customer Type.** Inventory Control determines prices according to the customer’s type (A, B, C, D, or E).

  **Note:** "A, B, C, D, E" denote the types of customers to which the discounts or markups you enter apply. Customer types are assigned to customers in Accounts Receivable and looked up when you add orders in Sage Order Entry.

- **Volume Discounts.** Inventory Control determines prices according to the quantity of an item the customer purchases.

  The selections you make for the Selling Price Based On, Discount On Price By/Markup On Cost By, and Pricing Determined By fields determine the remaining fields that appear on the Discounts tab.

7. If you use Sage 300 Premium ERP, click the Price Check tab, and then specify how to handle price check overrides in Order Entry.

  **Price Check Type.** Specify the type of warning or message Order Entry displays for price overrides.

  - Do nothing (if you choose None).
  - Display a warning message and let you continue.
  - Display an error message and reject the price override.
  - Force you to get a supervisor’s approval on price overrides.

**Check.** Specify whether to check the unit price or the sales margin.

**Check Base.** If you are checking the unit price, specify a percentage or an amount cost range, or a fixed range to check.

**Cost/Margin Base.** Specify the cost on which you are calculating the acceptable range of unit price or sales margin. (This field does not appear if you selected a fixed unit price.)

**User ID / Greater Than... / Less Than...** Enter the range of prices available to each user ID. If you want, you can create several price approval levels for sales clerks and supervisors.
The Default price check range applies to all users who are not specifically listed in the table. If you delete the price check for the Default user, the program only performs checks for the listed user IDs.

8. On the Taxes tab, fill in the tax information as follows:

**Authority.** Enter a tax authority (such as state or province) or use the Finder to select the tax authority that taxes sales of the item.

**Cust. (Customer) Tax Class.** Enter the customer tax class or use the Finder to select a customer tax class for the tax authority.

For more information about tax authorities and tax classes, see the help for Tax and Bank Services (in the Sage 300 ERP System Manager help).

9. Click **Add.**

Repeat steps 2 through 9 for each price list code that you want to add.

**After adding pricing information**

- After assigning items to their first price list, you can use this screen to assign them to other price lists, depending on your needs.

  You can also use the "I/C Copy Item Pricing Screen" (page 391) to assign items on one price list to another price list.

- Print the price lists that include the information you changed, using the Price Lists icon in Price/Sales Analysis Reports folder, to check the new record information.

- Compare the price lists you printed before making changes to those printed afterwards to verify that you made all changes correctly.

**Copying Pricing Information to Other Price Lists or Currencies**

The Copy Item Pricing screen copies pricing information from one price list or currency to another price list or currency, adding items to a new or existing price list.

**Note:** You cannot copy an item or a range of items if any of the items already appear on the list you are copying to. Use the Update Item Pricing screen to change existing price list information.
Before you start:

- Use the Price List Codes screen to add the price list codes you need for new price lists you want to create.
- Use the Price Lists screen in Price/Sales Analysis Reports folder to print the price lists from which you are copying information.
- Choose how you are going to copy pricing information. For example, map out item ranges and price changes between the source price list and the target.

To copy items and prices to another price list:

1. Open Inventory Control > I/C Items and Price Lists > Copy Item Pricing.

2. If you have a multicurrency system, enter (or use the Finder to select) the currency from which you want to copy item pricing information.
   
   If you have a multicurrency system, you must specify the currency of the prices you are copying.
   
   You can copy prices to a different currency in the same price list, specifying an exchange rate to convert prices from one currency to another. This is the simplest way to update prices in different currencies.

3. Enter (or use the Finder to select) the code for the price list from which you want to copy item pricing information.

4. If you have a multicurrency system, enter or select the code for the currency to which you are copying pricing information.

5. Enter or select the code for the price list to which you want to copy pricing information.

6. Use the Select by list to specify a selection method, and then use the From and To fields to specify the range of item prices to copy.

   You can copy prices for all or a portion of the price list, selecting the range of prices by one of the following elements:

   - Item numbers
   - Item categories
   - Item segments
• Vendor numbers

• Any optional field defined for Inventory Control items

7. In the Select Fields section, select the pricing information to copy.

Choose which pricing information you want copied to the target price list:

• **Base Price.** Select the Base Price option to copy the base price.

• **Decimal Places.** If you select the Base Price option, select the number of decimal places to use when displaying or printing the base and sale prices.

• **Sale Price.** Select the Sale Price option to copy the sale price.

• **Sale Starts/Ends.** If you select the Sale Price option, select the first and last dates from the drop-down calendar for a sale period during which sale prices apply.

• **Markup Cost.** Select the Markup Cost option to copy the markup cost.

• **Markup Factor.** To select the Markup Cost option, enter the number by which to multiply the markup costs to calculate the selling prices for items on the new price list.

• **Discount/Markup Information.** Select the Discount/Markup Information option to copy the item’s discount or markup information that is specified on the Discounts tab of the Item Pricing screen.

If you specify discounts or markups by percentage, this information is unaffected by increases or decreases when copying.

• **Price Check Information.** Select the Price Check Information option to copy the price check information that is specified on the Price Check tab of the Item Pricing screen. Price check information includes item and employee-specific rules for checking price override amounts entered in Order Entry.

**Note:** Price checks are available only in Sage 300 Premium ERP.

• **Tax Information.** Select the Tax Information option to copy the item’s tax information that is specified on the Taxes tab of the Item Pricing screen.
The tax information may not be valid in the target price list if you are copying between currencies. Tax information is unaffected by increases or decreases when copying.

8. In the Create the Selected Fields section, specify whether to increase or decrease prices in the target price list by a percentage, or (in a multicurrency system) apply an exchange rate.

   You can increase or decrease the pricing information when you copy it by specifying a percentage or, if you have a multicurrency system, an exchange rate. This feature lets you quickly set up discounted price lists or price lists in another currency.

   **Note:**
   - If you calculate discount and markup amounts by percentages, these percentages are not affected by increases or decreases you specify when copying.
   - Tax information is not affected by copying with an increase or decrease.

9. Click **Copy** to copy pricing information for the selected range of items.

   **After copying items and prices**
   - Print the price lists to which you copied information, using the Price Lists screen in Price/Sales Analysis Reports folder.
   - Compare the new price lists to your original price lists to verify that you copied pricing information correctly.

**Changing Pricing Information for Single Items**

You can use the Item Pricing screen to change item prices on an existing price list at any time.

Inventory Control includes the following screens for maintaining price lists for inventory items:

- **Price List Codes.** Use the Price List Codes screen to add new codes to identify price lists, as well as to change default discount (or markup) and tax information for each price list.

- **Item Pricing.** Use Item Pricing to assign items to price lists, to edit pricing information for items, and to remove items from price lists.
- **Copy Item Pricing.** Use Copy Item Pricing to copy pricing information from a range of items on one price list to another price list.

- **Update Item Pricing.** Use Update Item Pricing to change prices or costs for a range of items on one or more price lists.

- **Contract Pricing.** Use Contract Pricing to set up pricing arrangements for specific customers.

**Before you start:**

Use the Price Lists screen in the Price/Sales Analysis Reports folder to print the items that you are changing to make sure that you have a complete list of the price lists and currencies where they appear.

**To change item pricing:**

1. Open **Inventory Control > I/C Items and Price Lists > Item Pricing.**

2. Use the Finder or the navigation buttons for the Item Number field to display the item you need, and then do one of the following:
   - To add the item to a price list, click **New.**
   - To update an item on a price list, select (highlight) the item on the table, and then click **Open.**

3. If you use multicurrency accounting and you are adding item prices for a different currency, enter or select the currency code.

4. If you want to assign a different item to the price list, enter its code in the Item Number field.

   **Note:** To delete an item from the price list, select it, and then click the Delete button. If a message appears asking you to confirm the deletion, click Yes.

5. Select the tab where you want to make changes.
   - Use the Prices tab to change base prices and sale prices.
   - Use the Discounts tab to change discount or markup information for calculating item prices for volume sales or preferred customers.
   - Use the Price Check tab to set checks for price overrides in Order Entry.
   - Use the Taxes tab to change tax authorities and customer tax classes for taxes that are included in the item price.
For help on the settings and the choices you can select on this screen, see "I/C Item Pricing Screen" (page 439).

6. When you are finished, click Save.

**After changing item pricing**
Use the Price Lists screen in the Price/Sales Analysis Reports folder to print a report of the item pricing information that you changed.

### Updating Pricing Information for Groups of Items

The Update Item Pricing screen updates item pricing information for a range of items on one or more price lists.

**Note:** If you want to create a new price list, use the Item Pricing screen or the Copy Item Pricing screen.

**Before you start:**
- Determine the price lists and items you want to update.
- Determine the method you want to use to update prices.
- Print the Price Lists report from the Price/Sales Analysis Reports folder for the price lists you want to change.

**To update item pricing:**

1. Open Inventory Control > I/C Items and Price Lists > Update Item Pricing.

2. If you have a multicurrency system, in the Currency field, specify the currency of the item prices you are changing.

3. In the From Price List Code and To fields, specify the range of price lists to update.

4. In the Select By field, specify the filter to use to select item prices, and then in the From and To fields, specify the range to update.

You can specify a range of item numbers, categories, item segments, vendor numbers, or optional field values. You can choose from any character optional fields that are active.
5. From the **Update** list select the type of information to update.

You can use the Update Item Pricing to update any of the following information:

- **Base Price.** Select this option to add, increase or decrease item base prices.
- **Sale Price.** Select this option to add, increase, or decrease sale prices for a range of items. You can also specify the beginning and ending dates for the period during which the sale price applies.
- **Markup Cost.** Select this option to increase or decrease the cost on which markups are currently based.
- **Price Check Type.** Select this option to change how Order Entry responds to price overrides (for example, displaying an error message or requiring price approval).
- **Price List Dates.** Select this option to update the period for which the selected price lists are valid.

6. In the **using** field, specify whether to apply a percentage or an amount, or (in a multicurrency system) apply an exchange rate to the base price, sale price, or markup cost.

**Note:** This field appears only if you are updating a price or a cost

7. Depending on your choices for the Update and Using fields, fill in the remaining fields as follows:

- If you selected Base Price or Markup Cost, specify whether to increase or decrease the price or cost, and then specify the percentage or the amount.
- If you selected Sale Price or Price List Date in the Update field, specify the range of dates for which the updated information is valid.
- If you selected Price Check in the Update field, specify the type of price check message to display in Order Entry.

Specify how you want Order Entry to respond to price overrides. Order Entry can:
Do nothing (if you select **None**).

Display a warning message and let you continue.

Display an error message and reject the price override.

Require a supervisor’s approval on price overrides.

8. Click **Update** to update the selected price lists.

**After updating pricing information**

- Print the price lists that include the information you changed, using the Price Lists screen in Price/Sales Analysis Reports folder, to check the new record information.

- Compare the price lists you printed before making changes to those printed afterwards, to verify that you made all changes correctly.

**Setting Up Inventory Items**

Item records contain the information you need to manage your inventory. You must add inventory item records to Inventory Control before you can enter inventory transactions.

**About Setting Up Inventory Items**

Item records contain the information you need to manage your inventory. You must add inventory item records to Inventory Control before you can enter inventory transactions.

This topic provides an overview of the item setup process. For detailed instructions on adding item records to Inventory Control, see the following topics:

"Adding Inventory Items Using the Items Wizard" (page 109)

"Adding Item Records" (page 112)

**Note:** Before you can add item records to Inventory Control, you must set up item number formats, account sets, categories, and locations.
You follow these general steps to set up item records in Inventory Control:

1. Add the item information from your existing inventory system to Inventory Control, selecting the options you want to use.

Adding item records to Inventory Control involves transferring your existing item information to Sage 300 ERP, and selecting options that help you process inventory data effectively.

When you add an item, you record the following information on the I/C Items screen:

- The item number you use to identify the item.
- A description of the item.
- The item number structure (the code you use to identify the item number format).
- The category to which the item belongs.
- The account set the item uses.
  
  You assign an account set to define the costing method and general ledger balance-sheet accounts for the item.
- The default price list from which you want the I/C Shipments screen to display the item’s price.
  
  You can override this price list when you enter shipments.
- The picking sequence / bin number so items can easily be found in the warehouse.
- Whether the item is active, sellable, allowed in a Web store, a stock item, serialized, lotted, or is a kitting item.
- A commodity number, if your company reports a value-added tax (VAT). (Optional)
- The unit weight and the weight unit of measure.
- An alternative item that can be used if this item is out of stock.
- Comments.
- The units of measure used for stocking, shipping, and receiving the item.
Chapter 2: Setting Up Items and Price Lists

- Tax authorities used when selling the item through Order Entry.
- Entries for optional fields that have been added to the item records.

2. Add minimum and maximum desired stock quantities for items so you can print reports to identify understocked and overstocked items in your inventory. (Optional)

   Purchase Orders uses reorder information to generate purchase orders automatically for understocked items.

3. If you have already set up your inventory locations, assign items to the locations where you want to stock them, or you can do this later. (Optional)

   **Note:** If the Allow Items At All Locations option is selected on the Options screen, Inventory Control assigns all items to all locations.

4. If you repackage or assemble items before selling them, add bills of material to define master items that you make from component items. (Optional)

5. Use the Manufacturers’ Items screen to associate bar codes with your item numbers. (Optional)

**About Alternate Items**

For each item in your inventory, you can specify another inventory item as its alternate item.

Items can have more than one alternate item, although you specify only one alternate item on each item’s record. An item’s list of alternate items grows as you assign alternate items to items which are themselves alternate items.

**Example:**

1. Add items A, B, and C to Inventory Control.

2. On A’s item record, select item B as its alternate item.

   The program links the two items so that item A is also an alternate for item B.

3. On B’s item record, select item C as its alternate item.
Item C is linked to the alternate item list that already contains A and B. The result is that each of items A, B, and C has two alternates. The following table shows this result:

<table>
<thead>
<tr>
<th>Item</th>
<th>Alternate Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B,C</td>
</tr>
<tr>
<td>B</td>
<td>A,C</td>
</tr>
<tr>
<td>C</td>
<td>A,B</td>
</tr>
</tbody>
</table>

4. Remove item B from Inventory Control by deleting its item record.

By deleting item B, you remove it from the alternate item list, and the link between items A and C is broken. Items A and C now have no alternate items.

About Non-Stock Items

You can create non-stock item records to use when shipping specially ordered items that you do not normally stock in your inventory, or to handle service charges or other non-inventory charges.

Non-stock items must use the user-specified costing method.

Note: Kitting items are non-stock items.

Adding Inventory Items Using the Items Wizard

The I/C Items Wizard is the simplest way to set up items in your Inventory Control system. It streamlines the process by stepping you through all the tasks involved in adding items and related records.

The Items Wizard takes you through the process of adding the following records:

- Items
- Location Details
- Vendor Details
- Item Pricing
- Contract Pricing
- Manufacturers’ Items
Chapter 2: Setting Up Items and Price Lists

- Customer Details
- Bills of Material
- Kitting Items
- Reorder Quantities

You can also use the Items Wizard to change information for existing inventory items.

**Note:** You can also use the Items screen to add the basic item record, and then add other information later. (See "I/C Items Screen" (page 396) for more information.)

**Before you start:**

Make sure that you have each of the following types of records for the inventory items that you want to add:

- Account sets for posting transactions to general ledger accounts. (See "I/C Account Sets Screen" (page 561) for more information.)
- Item categories to group your inventory items. (See "I/C Categories Screen" (page 565) for more information.)
- Item number structures. (See "I/C Item Structures Screen" (page 579) for more information.)
- Item number segment codes to control the item numbers the program allows to be entered. (See "I/C Segment Codes Screen" (page 617) for more information.)
- Inventory locations. (See "I/C Locations Screen" (page 581) for more information.)
- Price list codes to vary your basic item prices and to provide international prices. (See "I/C Price List Codes Screen" (page 612) for more information.)
- Units of measure for stocking and pricing inventory items, required if you selected the **Only Use Defined UOM** option in the I/C Options screen. (See "I/C Units of Measure Screen" (page 618) for more information.)
- Weight units of measure used to determine shipment weights (required if you want to show order weights in Order Entry). (See "I/C Weight Units of Measure Screen" (page 620) for more information.)
• If you want to include additional information in your item records, add optional fields for inventory items in Common Services, and then assign them to Inventory items in the I/C Optional Fields screen. (You can also add optional fields to item records at a later time.)

• Add the taxing authorities and tax classes you require (using the Tax Services icon in Common Services).

If you use Serialized Inventory and Lot Tracking, you should also set up the following records:

• Serial and lot number mask structures to format serial and lot numbers. (See "I/C Mask Structures Screen" (page 586) for more information.)

• Warranty Codes to identify the warranties you provide to customers who purchase serialized or lotted items. (See "I/C Warranty Codes Screen" (page 619) for more information.)

• Contract Codes to identify the quality assurances vendors provide you on the serialized and lotted items you purchase. (See "I/C Contract Codes Screen" (page 570) for more information.)

To add inventory items using the Items Wizard:

1. Open Inventory Control > I/C Items and Price Lists > Items Wizard.

2. Click Next to move to the first item information page.

3. Beside the Item Number field, click the New button, and then enter a code for the item that you are adding.

   You can enter the number directly, or click the Zoom button to use the Construct Item Number screen.

   **Tip:** To make sure that the item number matches the structure code you plan to use to format the item number, use the Construct Item Number screen.


   **Tip:** Use the Finder beside a field (where available) to see a list of the choices for the field.

5. When you have finished filling in the fields on a page, click Next to move to the next page.

   If you have to leave the wizard while adding an item, click Done or Cancel.
Chapter 2: Setting Up Items and Price Lists

If you click Cancel, the Wizard asks you whether to save your entries.

The next time you start the Items Wizard, you can continue by entering the same Item Number, and then clicking Next until you reach the point where you saved your work.

**Note:** The Done button appears on the 4th wizard page, unless you use Serialized Inventory and Lot Tracking.

6. After you finish entering the required information for the item record, click **Done** or **Finish**.

The Finish button appears after you complete the last wizard page for the item.

**Tip:** If you just want to add basic item information, you can click **Done** to add the inventory item. You can add more item information later by selecting the item number in the Items Wizard, or by using the other screens in the Items And Price Lists folder.

**After adding inventory items**

Print inventory control reports to update printed records and ensure that items were added correctly:

- Item Status
- Location Details
- Price Lists
- Manufacturers’ Items (typically used for bar codes)
- Bills of Material
- Kitting Items
- Vendor Details
- Customer Details
- Contract Pricing
- Reorder Quantities

**Adding Item Records**

Use the Items screen to add or modify inventory item records.
Setting Up Inventory Items

**Note:** You must add item records before you can enter and process transactions in Inventory Control.

You can also use the Items Wizard to add item records.

The I/C Items Wizard is the simplest way to set up items in your Inventory Control system. It streamlines the process by stepping you through all the tasks involved in adding items and related records.

The Items Wizard takes you through the process of adding the following records:

- Items
- Location Details
- Vendor Details
- Item Pricing
- Contract Pricing
- Manufacturers’ Items
- Customer Details
- Bills of Material
- Kitting Items
- Reorder Quantities

You can also use the Items Wizard to change information for existing inventory items.

**Before you start:**

Make sure that you have each of the following types of records for the inventory items that you want to add:

- Account sets for posting transactions to general ledger accounts. (See "I/C Account Sets Screen" (page 561) for more information.)

- Item categories to group your inventory items. (See "I/C Categories Screen" (page 565), for more information.)

- Item number structures. (See "I/C Item Structures Screen" (page 579) for more information.)
Chapter 2: Setting Up Items and Price Lists

- Item number segment codes to control the item numbers the program allows to be entered. (See "I/C Segment Codes Screen" (page 617) for more information.)

- Inventory locations. (See "I/C Locations Screen" (page 581) for more information.)

- Price list codes to vary your basic item prices and to provide international prices. (See "I/C Price List Codes Screen" (page 612) for more information.)

- Units of measure for stocking and pricing inventory items, required if you selected the **Only Use Defined UOM** option in the I/C Options screen. (See "I/C Units of Measure Screen" (page 618) for more information.)

- Weight units of measure used to determine shipment weights (required if you want to show order weights in Order Entry). (See "I/C Weight Units of Measure Screen" (page 620) for more information.)

- If you want to include additional information in your item records, add optional fields for inventory items in Common Services, and then assign them to Inventory items in the I/C Optional Fields screen. (You can also add optional fields to item records at a later time.)

- Add the taxing authorities and tax classes you require (using the Tax Services icon in Common Services).

If you use Serialized Inventory and Lot Tracking, you should also set up the following records:

- Serial and lot number mask structures to format serial and lot numbers. (See "I/C Mask Structures Screen" (page 586) for more information.)

- Warranty Codes to identify the warranties you provide to customers who purchase serialized or lotted items. (See "I/C Warranty Codes Screen" (page 619) for more information.)

- Contract Codes to identify the quality assurances vendors provide you on the serialized and lotted items you purchase. (See "I/C Contract Codes Screen" (page 570) for more information.)

**To add a new item record using the Items screen:**

Double-click the Items icon in the Items And Price Lists folder, then do one of the following:
1. Open **Inventory Control > I/C Items and Price Lists > Items**.

2. Beside the **Item Number** field, click the New icon, then enter a code for the new item record.

   To copy information from an existing item record:
   a. Enter or select the item number for the record you want to copy.
   b. When the item record is displayed, enter the new item number in the Item Number field (typing over the previous number).

3. Click the Zoom button beside the Item Number field or press F9 to open the Construct Item Number screen, and then select the structure and segments for the new item number.
   a. Type the structure code you want to use or select it from the Finder.
   b. Enter a value for each segment of the item number.
      
      Use the Finder to select codes for segments that require valid segment codes.
   c. Check the Item Number field to be sure the entry in the field is correct.
      
      - If the entry is correct, click **Select**. The program formats the new number and inserts it in the Item Number field on the Items tab, and closes the Construct Item Number screen.
      
      - To cancel the item number you were defining and return to the Items screen, click **Close**.

4. Tab to the next field on the Items screen, and then enter a description for the item.

5. Fill in or update the fields on the Items tab, as needed.

   If you did not copy an existing record, you must enter valid codes in the following fields:
   - Structure Code
   - Category
   - Account Set Code

**Tip:** For help with any of the fields on this screen, press the F1 key.
6. Click the Units tab, and enter units of measure to be used for this item.

   **Note:** You must enter one stocking unit of measure, with a conversion factor of 1, or you will not be able to save the Item record.

7. On the Taxes tab, enter the tax authorities to be used for this item (if known).

8. On the Optional Fields tab, enter any optional fields to be used with this item.

   **Note:** You can assign only optional fields that are set up for use with items.

9. If you use Serialized Inventory and Lot Tracking and you selected Serial Number or Lot Number on the Items tab, fill in the fields on the Serials tab and the Lots tab, as needed.

10. Click **Add**.

**After adding inventory items**

Print inventory control reports to update printed records and ensure that items were added correctly:

- Item Status
- Location Details
- Price Lists
- Manufacturers' Items (typically used for bar codes)
- Bills of Material
- Kitting Items
- Vendor Details
- Customer Details
- Contract Pricing
- Reorder Quantities
Adding Current Item Quantities and Costs

This topic describes the steps you take to post the current item quantities and costs for each of your inventory items when you are setting up your Inventory Control system.

Before you start:

- From your existing system, gather the amounts and costs for your items at each location.
- On the G/L Integration screen’s Integration tab:
  - Select On Request Using Create G/L Batch for the Create G/L Transactions option.
  - Clear (do not select) the Append G/L Transactions To Existing Batch option.
- On the I/C Options screen’s Processing tab, clear (do not select) the following options:
  - Keep Transaction History
  - Keep Item Statistics

To add current item quantities and costs:

1. Use the I/C Receipts screen (available in the I/C Transaction folder) to add your current item quantities and costs to Inventory Control.

   Tip: You can also add item quantities and costs by importing receipts into Inventory Control from another Sage 300 ERP Inventory Control system, or from a non-Sage 300 ERP application.

2. Use the I/C Day End Processing screen (available in the I/C Periodic Processing folder) to update your Inventory Control records.

3. Print the Item Valuation report (available in the I/C Stock Control Reports folder) to check that the item quantities and costs you added match those on your source documents.

   Note: If you need to adjust the item quantities and costs you added, use the Adjustments screen in the I/C Transactions folder.

4. Print the Receipts Posting Journal (available in the Price/Sales Analysis Reports folder), including the posted receipts and adjustments, if any.
Chapter 2: Setting Up Items and Price Lists

Compare the posting journal(s) to the Item Valuation report and your source documents.

5. Use the Clear History screen (available in the Periodic Processing folder) to delete the printed posting journal(s) for receipts (and adjustments, if necessary).

   Select the Printed Posting Journals option, then select Receipts (and Adjustments, if you made any).

6. Print the G/L Transactions report (available in the Price/Sales Analysis Reports folder), using the displayed posting sequence number.

7. Use the Create G/L Batch screen (available in the I/C Transaction folder) to create general ledger transactions for the Inventory Control transactions you posted. (Use the displayed day-end number.)

   Compare the G/L Transactions report you printed earlier to your general ledger listing to be sure the totals balance.

8. Delete the general ledger batches that you created.

   **Warning!**
   If you do not delete the batches, you risk posting them twice in your general ledger.

   If you use another general ledger, or if your Sage 300 ERP General Ledger uses a different database than Inventory Control, open your General Ledger and import G/L batches. You can then delete the batches from the directory in which you keep your company’s Inventory Control data. (Delete the files that begin with the letters glic, and have the file name extension .csv.)

   If you have just set up your inventory control balances and need to delete General Ledger batches, follow the instructions in the General Ledger help for deleting a batch. (The batches from Inventory Control will appear as open General Ledger batches.)

   You must select the General Ledger option **Allow Edit Of Imported Entries** on the Posting tab of the G/L Options screen.

**After adding current item quantities and costs**

If you had to change options on the I/C Options screen or the I/C G/L Integration screen before entering item quantities and costs, you can now restore the settings as they were before you made the changes.
Assigning Inventory Valuation Methods to Items

The account set that an item uses determines its item valuation (or costing) method. This means that assigning or changing the item valuation method really involves two steps:

1. Use the Account Sets screen to assign the item valuation method to the account set, creating a new account set for the valuation method, if necessary.

2. Use the Items screen or the Items Wizard to assign the account set to inventory items.

Before you start:

- Print the Account Sets report to see the inventory valuation methods assigned to account sets.
  
  Double-click the Account Sets icon in the Setup Reports folder to open the report.

- If you are updating an existing account set, print the Item Status report, including the Profile information for the account set you want to change, so you know which items will be affected.

- If you are assigning an existing item to an account set that uses a different costing method:
  
  - Print the Item Valuation report for all items that are changing.

  You need to transfer the asset amount of all items that you change from the old inventory control accounts to the new control accounts in the General Ledger after updating item records.

- Run Day End Processing.

**Note:** Inventory Control displays an error message if you try to change an item’s account set while there are posted transactions for the item for which Day End Processing has not been run.
Chapter 2: Setting Up Items and Price Lists

To assign the inventory valuation method to an account set:
1. Open Inventory Control > I/C Setup > Account Sets.
2. Fill in the fields on the Account Sets screen as follows:
   - **Account Set Code.** Type a code of up to six characters to identify the account set.
   - **Description.** Type a description for the account set.
   - **Costing Method.** Select the costing method that the account set will use for valuing your inventory and determining the cost of goods sold.
   - **General Ledger Accounts.** Enter general ledger account numbers for the inventory control, payables clearing, adjustment write off, assembly cost credit, non stock clearing, transfer clearing, shipment clearing, disassembly expense, and physical inventory adjustment accounts that make up the set.

   Click the Finder or press F5 to display a list of general ledger account numbers. Highlight the account you want, and then press Enter to select it.
3. Click Add or Save (if you created the account set before).

To assign or change the inventory costing method for an item:

**Note:** If you are adding a new item, follow the steps in "Adding Inventory Items Using the Items Wizard" (page 109).

1. Open Inventory Control > I/C Items and Price Lists > Items.
2. Enter or select the item number.
3. On the Items tab, click the Finder Q beside the Account Set Code field.

   The Finder displays the account set codes, along with their description, status, and costing method.
4. Select the account set that uses the costing method you want to assign.
5. Click Save.
6. If you are changing the costing method for an existing item:

   **Warning!**
   If you ship units of an item that use the standard costing method and you have not entered a standard cost, Inventory Control calculates the cost of goods sold using a standard cost of zero.
Similarly, if you ship units of an item that uses most recent costing and you have not received any stock or entered a most recent cost, Inventory Control calculates the cost of goods sold using a most recent cost of zero.

After changing costing methods

- Print the Item Status report, including the Profile information for the account sets you want to change, to check the items that you changed.

- Transfer the asset amount from the old inventory control accounts to the new control accounts in the General Ledger after updating item record account sets. (Otherwise, you will have old balances that are never reconciled.)

Assigning Units of Measure to Items

If your Inventory Control system uses the processing option Only Use Defined UOM, you can assign to items only units of measure that exist on the Units of Measure Setup screen. Therefore, assigning a unit of measure to an item can involve two steps:

1. Adding a new unit of measure and conversion to Inventory Control using the Units of Measure setup screen.

2. Assigning units of measure to inventory items using the Items screen or the Items Wizard.

This topic elaborates these general steps.

Before you start:

- Decide on your stocking units for each inventory item.

  **Note:** If you did not select the Allow Fractional Quantities option in the I/C Options screen, the stocking unit is the smallest unit of measure that you can specify for shipping or selling the item.

- Calculate the conversion factors between the stocking units of measure and additional units.

- Decide what to call each of the units of measure. The names you use appear on data entry screens.

- Print the Unit of Measure report (available in the I/C Setup Reports folder) to see which units have already been defined for your company. You can also
view the units of measure by opening the Units of Measure screen in the Setup folder.

**To add units of measure to Inventory Control:**

1. Open **Inventory Control > I/C Setup > Units of Measure**.

2. In the table, press the Insert key to start a new line, and then fill in the fields as follows:

   **Unit of Measure.** Use up to ten characters to identify the unit of measure (for example, "each," "crate," "pallet," etc).

   **Default Conversion Factor.** Enter the factor for converting this unit to the item stocking unit.

   For example, if “each” is a stocking unit of measure (with a conversion factor of 1), the conversion factor for “dozen” would be 12.

   **Note:** Your inventory system can have more than 1 stocking unit with a conversion factor of "1." See the "I/C Units of Measure Screen" (page 618) for more information.

3. Click **Close**.

**To add units of measure to an item record:**

1. Open the I/C Items screen or the I/C Items Wizard.

   Do one of the following:

   - Open **Inventory Control > I/C Items and Price Lists > Items**.

   - Open **Inventory Control > I/C Items and Price Lists > Items Wizard**.

2. If you are adding a new item, see "Adding Inventory Items Using the Items Wizard" (page 109).

   If you adding a unit of measure for an existing item:

   a. If using the Items Wizard:

      - Click **Next** to move to the first data entry Wizard page.

      - Enter the item number or select the item number from the Finder.

      - Click **Next** to move to the page containing units of measure.
If using the I/C Items screen:

- Enter the item number, or select the item number from the Finder.
- Click the **Units** tab.

b. Click a line in the Units of Measure table, and then press the Insert key to start a new line.

**Unit of Measure.** Click the Finder in the column heading to select from the list of all units of measure defined for Inventory Control.

If you allow undefined units of measure, you can enter the UOM and tab directly to the conversion factor column.

**Conversion Factor.** If necessary, change the default factor for converting this unit to the item stocking unit.

**Stocking Unit of Measure.** If you are adding the stocking unit of measure, note that:

- The conversion unit must be "1."
- If another item is currently selected as the stocking unit of measure, you must double-click in the **Stocking UOM** column for that item to set it to "No" before you can set the new UOM to "Yes."

c. Click **Save** when you have finished adding units of measure.

If using the Items Wizard, click **Next** until the Done button appears, and then click **Done** to save the changes.

**After assigning units of measure**

Print the Item Status report, including the Units of Measure to check that you changed all items properly.

**Assigning Weight Units of Measure to Items**

You use units of measure for the weights that you assign to items. Order Entry and Purchase Orders use item weights to calculate the total weights of orders. In general you:

1. Add weight unit of measures and conversion factors to Inventory Control using the Units of Measure setup screen.
2. Assign weight units of measure to inventory items using the Items screen or the Items Wizard.
This topic elaborates these general steps.

**Before you start:**

- Print the Weight Unit of Measure report to see which units have already been defined for your company.
- Decide what to call the new weight units of measure. The names you use appear on data entry screens.
- Calculate the conversion factors between the default weight unit of measure and the weight units of measure that you are adding.
- If you are just setting up your system, decide on the default weight unit of measure to use on all orders entered through Order Entry and Purchase Orders.

You set the default weight unit of measure on the I/C Options screen after adding it to the Weight Units of Measure screen.

**To add a new weight unit of measure to Inventory Control:**

1. Open **Inventory Control > I/C Setup > Weight Units of Measure**.
2. Press the **Insert** key to start a new line in the table, and then fill in the fields as follows:

   **Weight Unit of Measure.** Type the weight unit of measure as you want it to appear on data entry screens. For example, “lb” or “kg.”

   **Description.** Enter a description for the weight unit of measure, such as pound or kilogram.

   **Weight Conversion Factor.** Enter the factor for converting this weight unit to the default weight unit of measure. For example, if “pound” is the default weight unit of measure (with a conversion factor of 1), the conversion factor for “ton” would be 2,000.

   You can use fractions in weight conversion factors even if you do not use fractional inventory quantities. For example, the factor to convert kilograms to pounds would be 2.2.

   **Default Weight UOM.** You select the default weight unit of measure in the I/C Options screen. This is the unit in which the total order weight is expressed in Order Entry.
1.0000 In Default Weight. The reciprocal of the conversion factor is automatically calculated by Inventory Control. It provides a visual check on the conversion factor.

See the "I/C Weight Units of Measure Screen" (page 620) for more information.

3. Click Close.

To assign a weight unit of measure to an item:

1. Open the I/C Items screen or the I/C Items Wizard.

   Do one of the following:

   - Open **Inventory Control > I/C Items and Price Lists > Items.**
   - Open **Inventory Control > I/C Items and Price Lists > Items Wizard.**

2. If adding a new item, see "Adding Inventory Items Using the Items Wizard" (page 109).

   If adding a weight unit of measure for an existing item:

   a. If using the Items Wizard:

      - Click **Next** to move to the first data entry Wizard page.
      - Enter the item number, or select the item number from the Finder.
      - Click **Next** again to move to the page containing Unit Weight field and Weight Unit of Measure field (beside the unit weight).

      If using the I/C Items screen:

      - Enter the item number, or select the item number from the Finder.

   b. Use the Finder beside the Weight Unit of Measure field to select the unit of measure that matches the unit weight for the item.

      The program displays the conversion factor between the weight unit of measure and the default weight unit of measure used for orders in Order Entry and Purchase Orders.

   c. Click **Save.**

      If using the Items Wizard, click **Next** until the Done button appears, and then click **Done** to save your changes.
Chapter 2: Setting Up Items and Price Lists

**After assigning weight units of measure to an item**

Print the Item Status report, including the profile information to check that you added the weights and weight units of measure properly.

**About Editing Item Records**

Use the Items screen to edit item records in Inventory Control.

You can change most of the information in an item record at any time, with these restrictions:

- After you make an item record inactive:
  - You cannot post receipts, shipments, adjustments, assemblies, or transfers for that item.
  - You cannot use the item as an alternate item.
- You cannot assign an item to a category or an account set that has an Inactive status.
- You cannot directly change an item number.
  
  You must first create a new item record with the new number, copy the item information to the new record, then delete the old item record.
- You cannot select a different item structure code for an existing item.
- If the item is a master or component item in a bill of material, you cannot change the account set to one that uses the user-specified costing method.
- You cannot change a stock item to a non-stock item unless:
  - The total cost and quantity for the item is zero at all locations, and the item is removed from all locations using the Location Details screen or the Locations screen.
  - The account set and category codes for the item are active.
  - The item is assigned an account set that uses the user-specified costing method.

**About Changing Item Category or Account Set**

We do not recommend that you change the item category or account set assigned to an item record to which you have posted transactions.
If you change the item category:

- The default choices for the new item category will replace existing choices in the item record, although you can edit the item record to change the new selections.
- You may need to correct statistics for the affected item categories.
- The new category may not distribute COGS (cost of goods sold) and cost variance to the same general ledger accounts as the old category, invalidating statistical comparisons among reporting periods.

If you change the item's account set:

- You may need to transfer the asset amount in the inventory control account balances to a new control account in the General Ledger after updating the item record with the new account set code; otherwise, you may have old balances that are never reconciled.
- The new account set may use a different costing method, and all subsequent transactions posted for the item number will be posted to the set of general ledger accounts linked to the new account set code.
- Inventory Control will display an error message if you attempt to change account sets for an item while there are posted transactions for the item for which Day End Processing has not been run.

**Editing an Item Record**

1. Open **Inventory Control > I/C Items and Price Lists > Items**.
2. Enter the code for the item record you want to delete, or select it from the Finder.
3. Make the changes you need in the record.
4. When you are finished, click **Save** to record your changes.

**After changing item records**

- Print the Item Status report to check the new record information.
- Compare the report you printed before changing or deleting item records to that printed after the changes to verify that all changes were made correctly.
Changing Inventory Item Descriptions Using the Items Wizard

We suggest that you use the Items Wizard to update an item description to ensure that you change it consistently throughout Inventory Control.

Because you enter the description for an inventory item in several records, it is possible to have different descriptions for the same item (for example, on price lists and in the item record). This means that to change an item description after setting up inventory items and prices, you should also change the item description on price lists.

The Items Wizard makes this process more efficient, helping you to change the description in all the associated records. You can also add comments regarding the changes to Customer Details and Manufacturers' Item Numbers to prevent possible confusion.

To change inventory item descriptions:
1. Open Inventory Control > I/C Items and Price Lists > Items Wizard.
2. Click Next to move to the first item information page.
3. In the Item Number field, enter or select the code for the item record that you want to change.
4. In the Item Description field, type the new description for the item.
   This description appears when you look up item numbers using the Finder in Inventory Control, Order Entry, Purchase Orders, and Project and Job Costing.
5. Click Next to move to the second information page, and then change the additional item information, if necessary, to match the new description.
6. Click Next until you reach the Item Pricing page.
7. For each price list in turn, double-click the description field, and then edit the item description.
   These descriptions appear as defaults for new detail lines in Order Entry.
8. Click Next until you reach the Manufacturers' Item Numbers page, and then enter a note about the changed description in the Comments field.
9. Click Next until you reach the Customer Details page, and then enter a note about the change.
10. When you are finished, click **Done** to save your changes and leave the wizard.

**After changing item descriptions**

Print inventory control reports to update printed records and ensure that items were added correctly:

- Item Status
- Location Details
- Price Lists
- Manufacturers’ Items (typically used for bar codes)
- Bills of Material
- Kitting Items
- Vendor Details
- Customer Details
- Contract Pricing
- Reorder Quantities

**About Placing Lots on Quarantine**

You can quarantine lots in the following ways:

- You can quarantine a range of lots and a range of items using the Lot Numbers screen.

- Specific items can be put on quarantine immediately when they are received if the Days on Quarantine option is selected in the I/C Items record.

Lotted inventory items may be placed on quarantine if they have defects that must be resolved before the items are sold, or if you must provide paperwork and/or duties to customs authorities before the items can be used. Once the issues have been resolved, you can release the lots from quarantine.

**Releasing Lots from Quarantine**

You use the I/C Quarantine Release screen to release lots you have placed on quarantine.

**Note:** You must release all quantities of a quarantined lot, or none.


**About Deleting Item Records**

You can use the I/C Items screen to delete inventory item records one at a time. (This is the same screen you use to add items to Inventory Control.)

You can also use the Delete Inactive Records screen in the I/C Periodic Processing folder to delete groups of inactive item records.

You cannot delete an item record unless:

- The quantity of the item in stock at each location, on sales order, and on purchase order is zero.
- The total cost of the item at each location is zero.
- The item is not a master item or a component item on any bills of material.
- You have run day-end processing if you have posted any transactions for the item since the last day-end processing.

If you want to delete an item that does not meet these conditions, enter shipments, transfers or adjustments (as you require) until the specified conditions are met, then make the item Inactive.

**Tip:** Before trying to delete an item record, it is a good idea to assign the Inactive status to the record, to ensure that no further transactions are posted to it. You can then wait until the end of the fiscal or calendar year to delete it (depending on the method you use to accumulate item statistics).

**Identifying Inactive Item Records**

Print the Item Status report to identify inactive item records and their quantities on hand, on purchase order, and on sales order. When printing the report, select the Inactive Items, Profile, and Quantity By Location options.

Print the Item Valuation report to determine the total cost of each inactive item on the Item Status report.

**Deleting Item Records**

Use the Items screen to delete inventory item records one at a time. (This is the same screen you use to add items to Inventory Control.)

**Tip:** Use the Delete Inactive Records screen in the I/C Periodic Processing folder to delete groups of inactive item records.
Before you start:

- Make sure that:
  - The quantity of the item in stock at each location, on sales order, and on purchase order is zero. You can delete an item record only if the item has zero quantities and no outstanding amounts on order.
  - The total cost of the item at each location is zero.
  - You have run day-end processing if you have posted any transactions for the item since the last day-end processing, and have completed all receipts involving the item.
  - The item is not a master item or component item for a bill of material.

- Print the Item Status Report to identify inactive item records and their quantities on hand, on purchase order, and on sales order. Select the Inactive Items option from the list beside the Print field. Select also the Profile option and the Quantity By Location option. For more information, see "Printing the Item Status Report" (page 338).

- Print the Item Valuation Report to determine the total cost of each inactive item on the Item Status report. For more information, see "Printing the Item Valuation Report" (page 340).

To delete an active item record:

1. Open Inventory Control > I/C Items and Price Lists > Items.
2. Enter the code for the item record you want to delete, or select it from the Finder.
3. Select the Inactive option.
4. Click Save to save your changes.

5. At the end of your fiscal year or calendar year, use Delete Inactive Records (in the Periodic Processing folder) to delete the item record.

To delete an unused item record:

Note: Use this method to delete an item record if you added it by accident or if you have not yet posted any transactions for the item:
Chapter 2: Setting Up Items and Price Lists

1. Open **Inventory Control > I/C Items and Price Lists > Items**.
2. Enter the code for the item record you want to delete, or select it from the Finder.
3. Click **Delete**.
4. If you see a message asking you to confirm that you wish to delete the record, click **Yes**.

**Vendor Details**

You use the I/C Vendor Details screen to add detailed information about each vendor and what they charge for a selected item. You can also assign a priority to each vendor of the item.

**About Vendor Details**

If you buy the same item from more than one vendor, you can assign up to nine vendors to an item record in order of priority. (Normally, you assign Vendor 1 to the vendor you use the most.)

You use the I/C Vendor Details screen to record detailed information about each vendor, including the cost, for each item in your inventory.

After you link a vendor to an item, you can select the vendor’s item number when you enter item details on requisitions and purchase orders. Purchase Orders fills in the cost of the item for you.

**Note:** These changes do not affect the master vendor list. The Finder for vendors elsewhere in the program does not reflect changes made here. To add or modify a vendor permanently, you must do so from within Accounts Payable.

**Adding Vendor Information to Items**

You use the I/C Vendor Details screen to add detailed information about each vendor and what they charge for a selected item. You can also assign a priority to each vendor of the item.

**Before you start:**

- Add the item records in Inventory Control.
• Add the vendor records in Accounts Payable.

**To add vendor information to items:**

1. Open *Inventory Control > I/C Items and Price Lists > Vendor Details*.

2. In the **Item Number** fields, enter or select the item number for which you are adding vendor information.

3. In the table, for each vendor:
   a. Click in the table, or press the Insert key to start a new line.
   b. If you use Sage 300 ERP Accounts Payable, click the Finder in the **Vendor Number** column heading, and then select the vendor.

   If you do not use Accounts Payable, double-click in the **Vendor Number** field, then type the vendor number. Also, in the **Vendor Name** field, type the vendor name.

   **Note:**
   The first vendor that you add is automatically assigned "Vendor 1." Each vendor that you add is automatically assigned the next highest number, but you can change the vendor type by selecting one from the list.

   You cannot assign the same vendor type to two different vendors for the same item.

   c. Enter the vendor contact, vendor item number, cost unit, vendor cost, and vendor currency.

4. Click **Save**.

**After adding vendor details**

Print the Vendor Details report to verify the new information and to update your printed records.

---

**Customer Details**

Customer item numbers are particular to the customer, so different customers can use the same number for different items. Because they specify the customer’s unit of measure, using customer item numbers can reduce confusion during order entry.
Customer item numbers are often required for large customers, who use their own stock numbers when ordering from you. If you supply goods to several large outlets, several customer item numbers can be associated with a single item.

You use the Customer Details screen in the I/C Items and Price Lists folder to add customer details for an item.

**Adding Customer Item Numbers**

Customer item numbers are particular to the customer, so different customers can use the same number for different items. Because they specify the customer’s unit of measure, using customer item numbers can reduce confusion during order entry.

Customer item numbers are often required for large customers, who use their own stock numbers when ordering from you. If you supply goods to several large outlets, several customer item numbers can be associated with a single item.

You use the Customer Details screen in the I/C Items and Price Lists folder to add customer details for an item.

**Before you start:**

- Add the item records in Inventory Control.
- Add the customer records in Accounts Receivable.

**To add customer item numbers:**

1. Open **Inventory Control > I/C Items and Price Lists > Customer Details**.

2. Enter or select the item number for which you are adding customer item numbers.

3. In the table, for each customer:
   
a. Click in the table, or press the Insert key to start a new line.

   b. If you use Sage 300 ERP Accounts Receivable, click the Finder in the **Customer Number** column heading, and then select the customer.

   If you do not use Accounts Receivable, double-click in the **Customer Number** field, then type the customer number. Also, in the **Customer Name** field, type the customer name.
Note:
The first customer that you add is automatically assigned "Customer 1." Each customer that you add is automatically assigned the next highest number, but you can change the customer type by selecting one from the list.

You cannot assign the same customer type to two different customer for the same item.

c. In the Customer's Item Number field, type the item number, and then type the customer's description of the item.
d. Enter the unit of measure.
e. Enter any comments and particular instructions for handling or shipping.

Comments and instructions appear on orders when you use the customer item number in Order Entry.

4. Click Save.

After adding customer details
Print the Customer Details report to verify the new information and to update your printed records.

Contract Pricing

You use the I/C Contract Pricing screen to set up contract pricing for specific items and customers.

Order Entry uses contract prices to calculate default item prices for transactions.

Adding Contract Prices for Customers

You use the I/C Contract Pricing screen to set up contract pricing for specific items and customers.

Order Entry uses contract prices to calculate default item prices for transactions.

Before you start:
- Decide whether the pricing contract is for individual items or entire item
categories.

- Decide how the price will be determined (a fixed amount, or calculated using a discount or cost-plus method, or determined by customer type).

**To add contract prices for a customer:**

1. Open **Inventory Control > I/C Items and Price Lists > Contract Pricing**.
2. In the **Customer Number** field, type the code for the customer for whom you are setting up a pricing contract, or select it using the Finder.
3. In the **Price by** field, select a pricing method.
   - If you select Item Number:
     - In the **Item Number** field, select the item number.
     - In the **Price List** field, select a price list.
   - If you select Category Code, select the code for the product category.
4. Select **Use Lowest Price** if you want the program to determine the best price for the customer, regardless of the contract price.
5. In the **Contract Price Type** field, select a contract price type, and then fill in the remaining fields, consistent with your selection.
   - If you selected Customer Type, specify the customer type.
   - If you selected any other contract price type, enter an amount or a percentage. You can use up to five decimal places to express the percentage.

   **Note:** If you selected Cost Plus Fixed Amount or Cost Plus Fixed Percentage, you must specify the cost base, and then enter the amount or percentage.

6. Enter or select the start date and expiration date for the contract.

   **Tip:** For an open-ended contract, leave these fields blank.

7. Click **Add**.
After adding contract prices

- You can use the Finder or the scroll buttons to select a Contract Price record for editing or to add another contract for the same customer.
- Clear expired contract prices using the Clear History screen.

Location Details

You must allow an item to be stocked at a location before you can post transactions for the item and location. For example, you must assign an item to a location before you can receive into Inventory Control a number of units and cost for the item at the location.

If Inventory Control does not use the Allow Items At All Locations option, you must assign items individually to the locations where you want to stock them.

You use the Location Details screen in the I/C Items and Price Lists folder to assign items to specific locations.

About Assigning Items to Locations

You must allow an item to be stocked at a location before you can post transactions for the item and location. For example, you must assign an item to a location before you can receive into Inventory Control a number of units and cost for the item at the location.

You can assign active items to any number of locations. (You cannot assign inactive items to locations.)

Inventory Control provides three ways for you to assign items to locations. You can assign:

- All your inventory items to all locations.
- A group of items to specific locations.
- A single item to specific locations.

If Inventory Control does not use the Allow Items At All Locations option, you must assign items individually to the locations where you want to stock them.

Tip: To see whether items are stocked automatically at all locations, check the Processing tab of the I/C Options screen in the I/C Setup folder.
The following sections can help you to decide which of these methods (or combination of methods) of assigning items to locations is the most efficient for you.

**Assign All Items to All Locations**

If your company does not keep inventory at more than one location, or it does not need to restrict any items from being kept at any of several locations, you can save time setting up your Inventory Control system by assigning all your inventory items to all locations. This allows you to start entering transactions right away involving any item at any location.

To allow every item to be stocked at all storage locations, select the **Allow Items At All Locations** option on the Processing tab on the I/C Options screen. You can turn the option on or off at any time.

**Assign a Single Item to a Specific Location**

If your company keeps some inventory items at more than one location, but restricts others, you can assign items individually to as many locations as you want.

You use the I/C Location Details screen (in the I/C Items and Price Lists folder) to assign single items to inventory locations.

**Assign Multiple Items to a Specific Location**

If your company keeps different categories or types of inventory items at different locations, you can assign ranges of items (by item category, item number, or a segment of an item number) to any locations.

For example, if you had the three item categories F1, F2, and F3 for different types of filing cabinets, you could assign all the filing cabinets to a location by specifying that all items having a category in the range F1 to F3 be assigned to the location.

You use the I/C Locations screen (in the I/C Setup folder) to assign a group of items at the same time to a specific inventory location.

**Assigning Items to Locations**

**Note:** You use the Location Details screen to assign inventory items to each location where you want to stock them, unless the option **Allow Items At All Locations** is selected in the I/C Options screen.
You can assign an item to as many locations as you want, but you must assign it to at least one location before you can post transactions for that item.

You must also allow items to be stocked at goods-in-transit locations if you want to use them to transfer items.

**Before you start:**

- Choose a code of up to ten characters to identify each picking sequence code you plan to add.
- Add item records to Inventory Control, and decide on the locations at which you want to stock individual items.
- Determine the most recent cost for each item in your inventory.
- Determine the standard cost of items that use the standard costing method.
- Determine the picking sequence code / bin number for the item at the new location.

**To assign items to locations:**

1. Open **Inventory Control > I/C Items and Price Lists > Location Details**.
2. Enter an item number, or select it using the Finder.
3. Tab to the entry table, and then, for each location to which you want to assign items:
   a. Click the Finder in the Location column heading to select the location.
      
      **Tip:** If necessary, press the Insert key to start a new line.
   b. Enter a picking sequence number (often a bin number).
   c. Double-click the **Allowed** field to change it to Yes.
   d. The **In Use** field specifies No until you post transactions for the item at this location.
   e. In the **Cost Unit of Measure** field, enter or select the unit of measure to use when costing transactions for the item at this location.
   f. Enter costing information for the item in the specified cost unit of measure.
Chapter 2: Setting Up Items and Price Lists

**Note:** The program updates costing information when you run day-end processing after processing a receipt, transfer, or assembly for the item. It updates and displays quantities when you post inventory transactions for this location.

4. Click **Save**.

**After changing location details**

- Print the Location Details report (in the I/C Setup Reports folder) to check the new information, and to update your printed records.
- Compare the report you printed before changing or deleting location details to those printed after the changes to verify that you made the changes correctly.

**Viewing Location Details for an Item**

You can use the I/C Location Details screen to look up information about the locations where you stock individual items, and to view the number of items at each location on purchase order, on sales order, and committed to orders.

**To view details for an item at a specific location:**

1. Open **Inventory Control > I/C Items and Price Lists > Location Details**.
2. In the Item Number field, enter the item number.
3. In the table, select (highlight) the location, and then click the **Drilldown** button in the **Quantity on P/O**, the **Quantity on S/O**, or the **Quantity Committed** headings to see details for the location.

**Note:** You can drill down to specific orders in the next screen that appears.

**Modifying Location Details**

If your company keeps some inventory items at more than one location, but restricts others, you can assign items individually to as many locations as you want.

You use the I/C Location Details screen (in the I/C Items and Price Lists folder) to assign single items to inventory locations.
You can change the following information in a location details record at any time:

- Picking Sequence
- Cost Unit of Measure
- Standard Cost (Costing Unit)
- Most Recent Cost (Costing Unit)
- Allowed
- Last Unit Cost (Costing Unit)

If you added names for the Alternate Amount 1 Name and Alternate Amount 2 Name fields on the Processing tab on the I/C Options screen, you can also modify the contents of those fields in the location details record.

**Adding Picking Sequences / Bin Numbers to Items**

Because they can be different at each inventory location, picking sequences or bin numbers are part of an item's location details.

**Before you start:**
Find out the picking sequence code or bin number to use for the item at each inventory location.

**To add picking sequences / bin numbers to items:**

1. Open **Inventory Control > I/C Items and Price Lists > Location Details**.

2. In the **Item Number** field, enter the item number, or use the Finder to select it.

3. If the location does not appear in the table, add the location details as usual. (For more information see "Assigning Items to Locations" (page 138).)

4. In the table, select (highlight) the location where you want to add the picking sequence, and then:
   a. Double-click in the **Picking Sequence** column.
   b. Type the picking sequence number (often a bin number).

5. Click **Save**.
Manufacturers' Items

You can associate unlimited additional item numbers with the items in your inventory using the Manufacturers' Items screen, available in the I/C Items and Price Lists folder.

About Manufacturers' Items

You can associate unlimited additional item numbers with the items in your inventory using the Manufacturers' Items screen, available in the I/C Items and Price Lists folder.

Manufacturers' item records let you associate bar codes with your inventory items.

Manufacturers' item numbers are automatically translated to your inventory item numbers when you enter them in item number fields in the Inventory Control, Order Entry, or Purchase Orders programs.

Note: Manufacturers' item codes also provide a unit of measure, so you can assign different codes for single items, a box, and a pallet.

You can create several different item coding systems for the same inventory items, but first:

- Decide what bar coding schemes you want to use. UPC codes are specific to manufacturers' items.

- If you are creating shortcut aliases, design a logical coding scheme that is easy to remember.

Adding Bar Codes / Manufacturers' Numbers to Items

The Manufacturers' Items screen lets you associate additional numbers (such as bar codes) with the items in your inventory. Manufacturers' item numbers are automatically translated during data entry to your inventory item numbers.

Before you start:

- Decide what bar coding schemes you want to use. UPC codes are specific to particular manufacturers.
You can add as many manufacturers' item numbers as you need to each inventory item.

**Note:** Manufacturers' item codes also provide a unit of measure, so you can assign different codes for single items, a box, or a pallet.

You can also use Manufacturers' item numbers to create shortcut aliases for your best-selling items.

Take the time to design an easily-remembered, logical coding scheme.

**To add bar codes to items:**

1. Open **Inventory Control > I/C Items and Price Lists > Manufacturers' Items**.

2. In the **Item Number** field, enter or select the item number for which you want to add a code.

3. In the table:
   a. If necessary, press the Insert key to start a new line.
   b. Double-click in the **Manufacturer's Item Number** column, and then type the manufacturer's code for the inventory item.

   **Tip:** You can also use a scanner to enter bar codes.

   c. Tab to the **Manufacturer's Item Description** field, and then type a description.

   d. Tab to the **Unit of Measure** field, and then use the Finder to select the unit of measure for this code.

   You can use different codes for single items, or for cases, and so on.

   e. Tab to the Comments field, and then type a comment for the code.

4. Click **Save**.

**Reorder Quantities**

If you add reorder information to Inventory Control, you can print reports that list understocked and overstocked items in your inventory. You can use these reports to help you decide when to reorder items.
You use the I/C Reorder Quantities screen to add reorder information for your inventory items.

**About Reorder Information**

If you add reorder information to Inventory Control, you can print reports that list understocked and overstocked items in your inventory. You can use these reports to help you decide when to reorder items.

You use the I/C Reorder Quantities screen to add reorder information for your inventory items.

If you stock an item at more than one location, you add reorder information for the item at each location.

**Tip:** If you use Inventory Control with Sage 300 ERP Purchase Orders, you can use the Purchase Orders program to generate purchase orders automatically for items that you need to reorder.

**Varying Reorder Information**

You can keep different reorder information for different periods of the year.

You can specify quantities for as many periods as you want within the calendar year.

You can record the following reorder information for each period:

- The minimum and maximum number of units you want in inventory.
- The projected sales.
- The number of units to order when the item’s quantity falls either below the minimum, or below the projected sales.

You record all quantities in terms of the stocking unit of measure (which is the unit Inventory Control uses to report stock levels for the item).

**Minimum and Maximum Quantities**

Inventory Control calculates the number of units for an item as the quantity on hand plus the quantity on purchase order, minus the quantity on sales order.

**Example:**
If the quantity of an item on hand is 100, on purchase order is 50, and on sales order is 80, then the quantity of stock for that item is 70 (that is, 100+50-80).
If you want to specify different reorder information for each calendar quarter, enter the four period-start dates: January 1, April 1, July 1, and October 1. For bi-monthly coverage enter the six period start-dates: January 1, March 1, May 1, July 1, September 1, and November 1.

Note that you enter period-start dates numerically in the order month, day. For example, you would enter the period-start date June 30 as 6/30.

In the preceding two examples, the first period starts on January 1 and all periods are of equal duration, but these are not requirements. For example, here is another set of valid period-start dates: May 2, September 10, January 20, and March 25.

You may want to add reorder information only for part of your inventory, such as expensive or high-volume items.

**Tip:** You can use the Optimize Inventory screen to optimize your item reorder quantities based on a just-in-time inventory management model. For more information, see "I/C Optimize Inventory Screen" (page 460).

---

**Adding Item Reorder Quantities**

You use the I/C Item Reorder Quantities screen to set up reorder information for your inventory items. You can specify separate reorder criteria for each item at each inventory location where you stock the item, or for all locations.

**Before you start:**

- Decide on the items (all, some, or none) for which you will add reorder criteria to Inventory Control.

- For each item, decide on the minimum number and maximum number you want stocked at each location in your inventory, or set overall maximum and minimum reorder quantities for all locations.

Make sure the item is allowed to be stocked at specific locations for which you are setting up reorder information.

**Tip:** You can use the Optimize Inventory screen to optimize your item reorder quantities based on a just-in-time inventory management model. For more information, see "I/C Optimize Inventory Screen" (page 460).
• Decide on the number of each item you want to order if the amount of the item in stock at a location drops below the minimum number you specify for the time period.

• Estimate the quantity of each item you expect to sell during each time period.

**To add item reorder quantities:**

1. Open **Inventory Control > I/C Items and Price Lists > Reorder Quantities**.

2. Enter or select the item number for which you want to add reorder criteria.

3. In the **Reorder For** field, specify whether to set reorder quantities for a specific location or for all locations.

   If you choose to set reorder quantities for a specific location, you cannot later set quantities for the same item for all locations, unless you first delete the reorder quantities for each of the specific locations. Similarly, if you choose to set quantities for all locations, you cannot later set quantities for a specific location unless you first delete the quantities for all locations.

4. If you selected Specific Location, enter or select the location code in the adjacent field.

5. If you want to add information for optional fields for this item and location, click the Zoom button beside the Optional Fields field. (You can assign optional fields that are set up for use with reorder quantities records.)

6. Click the Go button (or press F7).

7. In the table:
   a. Press the Tab key or the Insert key to start a new line.
   b. Enter the period start date and the quantities for each desired period.

8. Click **Save** to save your entries.

**After adding reorder quantities**

• Print the Reorder report to check the new record information and to update your printed records.
- Compare the report you printed before changing or deleting reorder quantities to those printed after the changes to verify that you made the required changes correctly.

**Optimizing Item Reorder Quantities**

Use the Optimize Inventory screen to optimize minimum and maximum quantities for item reorder. Using sales data, Sage 300 ERP calculates optimal item reorder quantities based on a just-in-time inventory management model. You can select some or all of the recommended changes, and then automatically update the quantities specified on the Reorder Quantities screen.

**Note:** Reorder quantities for an item are not updated if All Locations is selected for the item in the Reorder for field on the Reorder Quantities screen.

**Before you start:**

- Specify settings and options on the Optimizer tab of the Options screen. For more information, see "I/C Options Screen" (page 588).

- On the Items screen, select the Seasonal option for each seasonal item you stock. For more information, see "I/C Items Screen" (page 396).

- If you use Sage 300 ERP Purchase Orders to create purchase orders automatically based on reorder quantities defined in Inventory Control, ensure that items on the Reorder Quantities screen have a full year's set of periods: 12 (or 13, if you use 13 fiscal periods). If you use the Optimize Inventory screen to update reorder quantities for an item that does not have a full year's set of periods, when you create purchase orders for that item, projected sales quantities may be incorrect.

**To optimize item reorder quantities:**

1. Open **Inventory Control > I/C Items and Price Lists > Optimize Inventory.**

2. In the Specify Criteria section, enter search criteria to find items for which you want to optimize reorder quantities.

**Note:** By default, the Year/Period field displays the current fiscal year and period. To ensure that optimal item reorder quantities are calculated correctly, you should not change this default.
3. Click **Go**.

Results appear in the table matching the search criteria you specified.

**Note**: After you click **Go**, the fields in the **Specify Criteria** section can no longer be changed. And even if you close the screen, the information shown on the screen is saved, allowing you to later resume working where you stopped. This can be helpful if you are reviewing a long list of items, and you cannot finish at one time. To enter new criteria, you must click **Clear**.

4. Review the table for recommended changes to your current item reorder quantities.

**Tip**: You can change the quantities in the **Order Minimum** and **Order Maximum** fields.

5. Select each row that contains changes you want to make to item reorder quantities.

6. Click **Apply Selected Changes**.

Minimum and maximum item reorder quantities are changed to the order minimum and order maximum displayed in the rows you selected, and the rows are removed from the table.

**Note**: If the **Update Location Details** option is selected on the Options screen, the **Inventory Minimum (SIA)** field on the Location Details screen is also changed to the order minimum.

### Serial/Lot Numbers

You can use the I/C Serial Numbers screen to view the status of a serial number, and to edit serial number details, such as contract codes and optional fields.

You can use the I/C Lot Numbers screen to view the status of a lot number, to edit details for the lot number (such as contract codes and optional fields), and to place a lot on quarantine.

**Viewing or Editing Details for a Serial Number**

You can use the I/C Serial Numbers screen to view the status of a serial number, and to edit serial number details, such as contract codes and optional...
Note: You cannot create new serial numbers using this screen. Use the Reconcile Serial/Lot Numbers screen to do so. For more information, see "Reconciling Serial Numbers and Lot Numbers" (page 266).

To view or edit serial number details:

1. Open Inventory Control > I/C Items and Price Lists > Serial Numbers.
2. In the Serial Number field, type the serial number or use the Finder or the navigation buttons to select it.
   
   Tip: If you specify an item number before the serial number, only serial numbers that are assigned to the item appear in the Finder.

3. On the Serial Number tab, change details for the serial number, as required.
4. To view, add, or edit optional fields assigned to the selected serial number, click the Optional Fields tab.
5. To view or edit the item record, click the Items button. (The I/C Items screen appears.)
6. To view transactions that include the selected serial number:
   a. Click the Transactions button.
      
      The Serial Number Inquiry screen appears, displaying a list of transactions.
   b. To drill down to a source document, select a transaction on the list, and then click the Details button.
7. Click Save on the I/C Serial Numbers screen to save any changes you make.

After viewing details for serial numbers
To see which serial numbers have been reserved for pending orders, print the Reserved Stock report. For more information, see "Printing the Serial/Lot Stock Listing Report" (page 351).

Viewing or Editing Details for a Lot Number

You can use the I/C Lot Numbers screen to view the status of a lot number, to edit details for the lot number (such as contract codes and optional fields), and
to place a lot on quarantine.

**Note:** You cannot create new lot numbers using this screen. Use the Reconcile Serial/Lot Numbers screen to do so. For more information, see "Reconciling Serial Numbers and Lot Numbers" (page 266).

**To view or edit details for a lot number:**

1. Open **Inventory Control > I/C Items and Price Lists > Lot Numbers**.

2. In the **Lot Number** field, type the lot number or use the Finder or the navigation buttons to select it.

**Tip:** If you specify an item number before the lot number, only lot numbers that are assigned to the item appear in the Finder.

3. In the **Location** field, specify the location of the items in the lot you want to view.

4. On the **Lot Number** tab, change details for the lot number, as required.

**Note:** Although you can enter fractional quantities into lots, the program may round the amount up or down to the nearest whole number. This rounding can result in discrepancies in the lot amounts and costs reported in the I/C Lot Number Inquiry and I/C Lot Numbers screens.

5. To view, add, or edit optional fields assigned to the selected lot number, click the **Optional Fields** tab.

6. To view or edit the item record, click the **Items** button. (The I/C Items screen appears.)

7. To view transactions that include the lot number:
   a. Click the **Transactions** button.

      The Lot Number Inquiry screen appears, displaying a list of transactions.
   
   b. To drill down to a source document, select a transaction on the list, and then click the Details button.

8. Click **Save** on the I/C Lot Numbers screen to save any changes you make.

**After viewing lot number details**

To see which lot numbers have been reserved for pending orders, create a
Reserved Stock report using the "Printing the Serial/Lot Stock Listing Report" (page 351).

**Bills Of Materials**

Many companies repackage items or assemble items before selling them.

In Inventory Control, you use the I/C Assembly screen to assemble master items from component items (or subassemblies), as defined in a bill of material, or BOM.

You use the I/C Bills Of Material screen to add bills of material to Inventory Control.

**About Bills of Material**

Many companies repackage items or assemble items before selling them.

In Inventory Control, you use the I/C Assembly screen to assemble master items from component items (or subassemblies), as defined in a bill of material, or BOM.

You use the I/C Bills Of Material screen to add bills of material to Inventory Control.

A bill of material specifies:

- The number of units (build quantity) of a master item required for one assembly of a BOM.
- The component items and quantity of each item needed for the build quantity.
- Fixed and variable costs associated with assembling the master items.

When you assemble a bill of material, you take component items out of inventory, and create a supply of master items.

**Whether to Use Bills of Material or Kits**

Bills of material are designed for manufacturing items from other items (or subassemblies), and for tracking the assembled items in inventory. You can include fixed and variable costs with BOMs.

If you are simply grouping items together for sale—and have no manufacturing costs and no need to track assembled items—you can use kits, instead. Kits allow you to group items and sell them as a single item. Kits do not have build
costs, and they are not treated as stock items. There are no stocked quantities of the kit—only of the components.

**Example:** You might package a particular computer, keyboard, and monitor for a special promotion, or put together a binder, pencil case, and felt pen set for a "back-to-school" sale.

**Note:** Before you can add a record for a kitting item or a BOM, you must add the master item record and all of the component item records.

For more information about kitting items, see "About Kitting Items" (page 160).

**Build Quantity**

The build quantity is the number of master items that one assembly of a bill of material produces. For the build-quantity unit of measure, you can use any of the units of measure specified in the master item record.

The build quantity is the number of master items that one assembly of a bill of material produces.

- You can use fractional build quantities if the **Allow Fractional Quantities** option is selected for Inventory Control on the I/C Options screen.
- For the build-quantity unit of measure, you can use any of the units of measure specified in the master item record.

**Example:**
Consider the following BOM:

- Master item: Mixture A
- Build quantity: 10 bottles
- Components:
  - X1 = 3 boxes
  - Y1 = 4 cans
  - Z1 = 7 lbs.
**Fixed and Variable Costs**

When you add a bill of material, you can specify fixed and variable costs associated with assembling the master item.

The fixed cost is the cost required to prepare to assemble a bill of material one or more times. The fixed cost is the same regardless of the number of times you assemble the build quantity of the master item.

The variable cost is the cost of assembling the build quantity once. When you assemble a bill of material, the program multiplies the variable cost by the number of assemblies (not the number of master items produced). The cost of labor for an assembly is an example of a variable cost.

**Example:**
Consider the following bill of material:

- Master item = Mixture A
- Build quantity = 10 bottles
- Components: X1 = 3 boxes, Y1 = 4 cans, Z1 = 7 lb.
- Fixed cost = $16.00 (for setup)
- Variable cost = $15.00 (for labor)

Assembling the preceding bill of material five times:

- Produces fifty bottles (5 times 10 bottles) of the master item (mixture A).
- Requires 15 boxes of X1, 20 cans of Y1, and 35 pounds of Z1.
- Incurs a fixed cost of $16.00 (this is the setup cost).
- Incurs a variable cost of $75.00 (5 times $15.00).

**Example:**
One assembly of the above bill of material requires 3 boxes of X1, 4 cans of Y1, and 7 pounds of Z1 to make 10 bottles of Mixture A.

**Negative Inventory Levels**

If you allow negative inventory levels, you can process an assembly transaction for a master item, even if its component items are not in stock.

The costs of the components are transferred to the master item, and you can physically assemble the master item at a later time.
**Multilevel Bills of Material**

Inventory Control lets you set up multilevel BOMs for manufacturing or assembling items for sale. Multilevel BOMs include component BOMs that are subassemblies with their own component items, quantities, and fixed and variable costs.

**Note:** You cannot create multilevel BOMs that include master items or component items that are serialized or lotted.

**Alternative Bills of Material**

The components of a bill of material are fixed. You cannot use alternate items as components.

If you want to assemble a master item using alternate items as components, you must create a separate bill of material that includes the alternate items and uses a different BOM number.

When you assemble the master item, you specify the BOM number that includes the components you want to use.

**Setting Up and Assembling Bills of Material**

When setting up and assembling bills of material, keep the following rules in mind:

- Before you can set up a BOM, you must add item records for the master item and all component items of the BOM.

  Each item is tracked in Inventory Control, even if it is never separately bought or sold.

  **Tip:** You can create component bills of material on the fly while defining the master bill of material.

- You can create multilevel BOMs that have subassemblies. These are bills of material that include the master item from a separate bill of material as a component item.

  **Important!**
  - When assembling a multilevel BOM, you must assemble sufficient component items, or subassemblies, required to build the next level of
Before you can post assembly transactions, master items and all the component items must be stocked at the same Inventory Control location.

If the **Allow Items At All Locations** option is not selected for Inventory Control (on the I/C Options screen), you must allow each item to be stocked at each inventory location where it will be used.

- You assign a unique BOM number to each bill of material. BOM numbers can contain numbers and uppercase letters.
- Master items and component items can use any costing method except the user-specified costing method.
- To use fractional quantities for a master item, the **Allow Fractional Quantities** option must be selected for Inventory Control (on the Processing tab of the I/C Options screen).
- You cannot delete an item from inventory if it is a master item or a component of a BOM.

### Adding Bills of Material

Use the I/C Bills of Material screen to set up bills of material for master items that you assemble or repackage from component items.

**Before you start:**

- Decide on the bill of material numbers (BOM numbers) to use. BOM numbers can be up to six characters long.
- Add the item records for the master items you will create and for the component items you will use when you assemble those master items. (See "Adding Inventory Items Using the Items Wizard" (page 109).)
- Collect the fixed and variable costs associated with assembling the master item.

**To add bills of material for manufacturing inventory items:**

1. Open **Inventory Control > I/C Items and Price Lists > Bills of Material.**
2. In the **Master Item Number** field, enter the inventory item for which you are adding a bill of material, or use the Finder to select it.

   **Note:** The item must exist before you can add a BOM.

3. In the **BOM Number** field, enter a number or a code.

   You must enter a BOM number (for example, "1").

4. Click the **Go** button, and then fill in the remaining fields in the top portion of the screen.

   a. Add a description for the BOM.
   
   b. Enter the fixed cost for setting up a manufacturing run.
   
   c. Specify the number of master items that 1 assembly of the BOM produces.
   
   d. Enter the variable cost for producing the build quantity of master items.
   
   e. Enter or choose the unit of measure for the build quantity.
   
   f. If necessary, specify a period of time during which master items can be assembled.

5. In the table, add the component items to the bill of material.

   **Tip:** Components can also be master items. You can change or add components to component BOMs.

6. When you have finished adding components, click **Add**.

**About Deleting Bills of Material**

You can delete bills of material one at a time using the Bills of Material screen in the I/C Items and Price Lists folder.

You can also delete a number of bills of material at the same time using the I/C Delete Inactive Records screen in the I/C Periodic Processing folder.

**Note:** You cannot delete a bill of material that is a component item (or subassembly) of a multilevel bill of material.

**Tips:**

- To ensure that a bill of material is not used as a subassembly in additional
bills of material, set the record **Inactive** using the I/C Bills of Material screen. Then, delete the bill of material at fiscal- or calendar-year end (depending on how you accumulate item statistics).

- To view inactive records, print the I/C Bills of Material report, or browse through bills of material records using the I/C Bills of Material screen.
- To see where component assemblies are used, use the I/C BOM Component Usage Inquiry screen.

## Copying Bills of Material

Use the I/C Copy Bills of Material screen to create a new bill of material based on an existing bill of material.

**Before you start:**

Use the Items screen to add the new master or component inventory items for which you are creating bills of material. (See "Adding Inventory Items Using the Items Wizard" (page 109).)

**To copy bills of material to new master items:**

1. Open **Inventory Control > I/C Items and Price Lists > Copy Bills of Material.**

2. In the **From Master Item Number** and **From BOM Number**, specify the source master item and bill of material.

3. In the **To Master Item Number** and **To BOM Number**, specify the destination master item and bill of material, and then click the **Go >>** button.

**Note:** The destination item number must already exist.

4. Fill in the following information for the BOM that you are creating.

   **Description.** Enter a description to identify the bill of material you are creating. The description is especially important if you use several alternative BOMs to create the same master item.

   **Fixed Cost.** Enter the setup cost for assembling the new bill of material. The cost from the original BOM appears as the default.
Chapter 2: Setting Up Items and Price Lists

**Build Quantity.** Enter the number of master items that one assembly of the bill of material produces. The build quantity from the original BOM appears as the default.

**Variable Cost.** Enter the cost for one assembly of the bill of material. (One assembly produces the "build quantity" of master items.) The cost from the original BOM appears as the default.

**Unit of Measure.** Enter the unit of measure or use the Finder to select the unit of measure to assign to the master items that you create when you assemble the bill of material. The UOM from the original BOM appears as the default. The Finder lists the units of measure that have been assigned to the master item on the Units tab of the I/C Items screen. If you want to use a different UOM, you must add it to the master item record.

**Start Date / End Date.** This is the period of time during which the master item can be assembled. For example, you might keep a particular master item in stock only for the duration of a contract.

**Comments.** Enter comments that you want to save with the new BOM.

**Copy Detail.** All component items from the old bill of material will be copied to the new BOM as defaults. If you do not want to copy a particular component, double-click the Copy Detail column to select No.

5. Click **Create** to copy the selected BOM.

**After copying bills of material**

- Print the Bills Of Material report using the Bills Of Material icon in the Setup Reports folder, or choose Print from the File menu in the Bills Of Material screen.
- Verify that you copied bills of material correctly.
- Use the Bills Of Material screen if you want to add, remove, or replace item details, or want to edit information copied over from the original.

**Updating Bills of Material**

Use the I/C Update Bills of Material screen to update costs, or to add, remove, or replace components for a range of bills of material.

**Before you start:**

- Determine the bills of material and the component items, or costs, to
To update bills of material:

1. Open **Inventory Control > I/C Items and Price Lists > Bills of Material**.

2. In the **From Master Item Number** and **To** fields, specify the range of master items to update.

3. In the **From BOM Number** and **To** fields, specify the range of BOM numbers to update.

4. In the **Update** field, specify whether to update components or a cost.
   
   Your selection in this field determines the remaining fields that appear on the screen.

5. Fill in the remaining fields according to your selection in the Update field.

   **If you are updating components:**

   a. In the **Type** field, specify whether to add, remove, or replace a component.

   b. In the **Component Item Number** field, enter or select the item number for the component that you want to add, remove, or replace.

   Then, if the component is itself a master item, in the **BOM Number** field, also specify the BOM number that is used to assemble the component item.

   c. If you are replacing a component, enter or select the replacement item number.

   If the replacement component is a master item, in the next **BOM Number** field, specify the BOM for assembling the replacement item.

   d. If you are replacing or adding a component item:

   i. In the **Quantity** field, enter the number of items to add to the build in the unit of measure displayed on the screen.
ii. In the **Unit Cost** field, if the new item has a user-specified costing method, enter the cost for one unit.

**If you are updating a cost:**

a. In the **Type** field, specify whether you are updating fixed costs or variable costs.

b. In the **Using** field, specify whether to update costs by an amount or a percentage.

c. In the **Base** field, specify whether to increase or decrease the cost.

d. Specify the amount or percentage by which you are increasing or decreasing the cost.

6. Click **Update**.

**After updating bills of material**

- Print the Bills Of Material report using the Bills Of Material icon in the Setup Reports folder, or choose Print from the File menu in the Bills Of Material screen.

- Verify that you made all changes correctly by comparing the new printout to the report you printed before making the changes.

### Kitting Items

Kitting items are collections of items that are priced and sold through Order Entry as a single item, and are often collected together at sale time—such as a particular computer, keyboard, and monitor combination, or a back-to-school binder, pencil case, and felt pen set.

The cost of a kit is based on each individual item in the kit. If the price is based on costs, it is determined by the cost of all the items together.

---

**Important!** You use the I/C Items screen to add a kitting (master) item record and all of the component item records. Then, you specify the kit contents using the I/C Kitting Items screen.

### About Kitting Items

Kitting items are collections of items that are priced and sold through Order Entry as a single item, and are often collected together at sale time—such as a
particular computer, keyboard, and monitor combination, or a back-to-school binder, pencil case, and felt pen set.

The cost of a kit is based on each individual item in the kit. If the price is based on costs, it is determined by the cost of all the items together.

**Important!** You use the I/C Items screen to add a kitting (master) item record and all of the component item records. Then, you specify the kit contents using the I/C Kitting Items screen.

The difference between kitting items and items assembled using bills of materials is that:

- **Kitting items** allow you to group items for special promotions, and sell them as a single item.
  - Kits do not have build costs, and the kitting item is not treated as a stock item. Therefore, there are no stocked quantities of the kit—only of the components.
  - Bills of material, on the other hand, are designed for manufacturing items from other items or subassemblies, and for stocking the new items.

For both kinds of assemblies, you must add the master item record and all of the component item records before you can define the kit or BOM.

When setting up kitting items, note that:

- **Kitting items** must use an account set code that has a user-specified costing method.

- You must choose the **Kitting Item** option for kitting items.

- **Kitting items** cannot be stock items.

- **Kitting items** can include non-stock components—such as shipping or installation fees.

- **Kitting items** cannot use serial numbers.

**Serialized Inventory and Lot Tracking**

If you use Sage 300 ERP Lot Tracking, you can track kits by using lot numbers or serialized inventory numbers for kitting item components. However, the actual kitting master item cannot have a serial number.

See the Order Entry help for instructions about assigning lot numbers to the tracked components.
Adding Kitting Items

Kitting items are collections of items that are priced and sold through Order Entry as a single item, and are often collected together at sale time—such as a particular computer, keyboard, and monitor combination, or a back-to-school binder, pencil case, and felt pen set.

The cost of a kit is based on each individual item in the kit. If the price is based on costs, it is determined by the cost of all the items together.

**Important!** You use the I/C Items screen to add a kitting (master) item record and all of the component item records. Then, you specify the kit contents using the I/C Kitting Items screen.

When setting up kitting items, note that:

- Kitting items must use an account set code that has a user-specified costing method.
- You must choose the **Kitting Item** option for kitting items.
- Kitting items cannot be stock items.
- Kitting items can include non-stock components—such as shipping or installation fees.
- Kitting items cannot use serial numbers.

**Note:** You can track kits using lot numbers or serial numbers for kitting item components. However, the actual kitting (master) item cannot be serialized.

**Before you start:**
Add each component item record before you add the inventory record for the kitting item.

**To add an item record for a kitting item:**

1. Open **Inventory Control > I/C Items and Price Lists > Items**.
2. In the **Item Number** field, use the Finder to select the item number, or type the code.
3. On the Items tab, in the **Account Set Code** field, select a code that has a user-specified costing method.
4. Clear the **Stock Item** field.
5. Select the **Kitting Item** option.

6. Continue entering information for the item, as usual.

7. Click **Add** to save the item.

**To add a record for the kitting (master) item**

1. Open **Inventory Control > I/C Items and Price Lists > Kitting Items**.

2. In the **Item Number** field, use the Finder to select the item number for the kitting item, or type the code.

3. In the **Kitting Number** field, enter a kitting number, and then click the Go button to activate the rest of the fields on the screen.

   The kitting number identifies a list of components. You can have as many component lists as you need to accommodate alternative or substitute component items.

4. Enter a description for the kit.

5. If you want to use this kit record as the default for setting up kitting items, select **Use as Default**.

6. Enter a comment (optional).

7. In the table, for each component item:
   
   a. Use the Finder to select the component item number.
   
   b. Enter the quantity and the unit of measure for the quantity.
   
   c. Enter a unit cost, if allowed (for example, if the item has a user-specified cost).

8. When you have finished adding component items, click **Add**.

**After adding kitting items**

See the Order Entry help for instructions about assigning lot numbers to the components that you are tracking (if you use Sage 300 ERP Lot Tracking).
Chapter 3: Entering and Posting Inventory Control Transactions

Use Inventory Control transaction entry screens to record the receipt, shipment, return, and internal usage of inventory items, transfers of stock between locations, assemblies of master items from component items, and adjustments of quantities and costs of items.

About Transaction Processing in Inventory Control

This topic presents an overview of transaction processing in Inventory Control.

For an introduction to each type of transaction you can process, see the following topics:

- "About Processing Adjustments" (page 175)
- "About Processing Assemblies and Disassemblies" (page 167)
- "About Internal Usage Transactions" (page 217)
- "About Receipts" (page 184)
- "About Receipt Adjustments" (page 187)
- "About Returns" (page 190)
- "About Shipments" (page 193)
- "About Transfers" (page 202)

Posting Transactions

You use the icons in the I/C Transaction folder to enter and post transactions in Inventory Control.

You can choose whether to post each transaction when you enter it, or save transactions after entering them for later editing or posting (using the Post Transactions screen).

When you post a transaction, the program immediately updates item quantities, so you always know your inventory levels. This is especially important when you are using Order Entry and need to know whether an item is in stock.
As well as posting transactions to the current session date and reporting period, you can post them to past or future dates and reporting periods.

**Note:** Posting does not update accounting and statistical information—those procedures are performed by Day End Processing.

### Costing During Posting or at Day End

Depending on your program settings, posting also updates the cost of goods in stock and the cost of goods sold.

**Note:** You specify on the I/C Options screen whether Inventory Control calculates inventory costs when you post transactions or when you run Day End Processing.

If you have a large transaction volume, we suggest that you cost items during day-end processing.

You must run Day End Processing to update item and sales statistics, audit information, and to generate general ledger transactions.

If necessary, you can run Day End Processing several times a day to update this information frequently.

### Printing the Audit Trail

To view your audit trail for transactions, print the posting journal for the type of transaction you want, after running day-end processing.

If the Keep Transaction History option is turned on in the I/C Options screen, Inventory Control keeps a copy of the audit trail information that is printed on the posting journal. You can then print the Transaction History report to list audit trail information that you may have cleared from the posting journal.

### Processing Assemblies

Many companies repackage items or assemble items before selling them.

In Inventory Control, you use the I/C Assembly screen to assemble master items from component items (or subassemblies), as defined in a bill of material, or BOM.

You use the I/C Bills Of Material screen to add bills of material to Inventory Control.
About Processing Assemblies and Disassemblies

You use the I/C Assemblies/Disassemblies screen to:

- Record assemblies or repackaging of component inventory items into master items for resale.
  Conceptually, assembling is like shipping component items and receiving master items.
- Disassemble items that you previously assembled.

Assembling Master Items

You must set up bills of material to define master items before you can assemble the master items.

For each assembly transaction, you enter the following information:

- **Assembly Number.** Each assembly transaction is assigned a unique number to distinguish it from other assemblies for audit control purposes.
  Press the Tab key to accept a program-generated number.
- **Description** and **Reference.** You can add any information you want about the assembly—for example, the reason you are assembling the master items.
- **Date.** Enter the date for the assembly or select it from the calendar (using the calendar button beside the date field).
- Inventory Control automatically displays the session date by default (the date that you entered when you started Sage 300 ERP), but you can change it.
- **Posting Date.** This is the date to which the transaction will be posted in the general ledger.
- **Year/Period.** The year and period to which the assembly is posted in the general ledger are determined by the posting date you enter. You cannot change this field directly.
- **Master Item Number.** Use the Finder to select the master stock item for which you are assembling units.
  You cannot enter assemblies for non-stock items.
**Chapter 3: Entering and Posting Inventory Control Transactions**

- **BOM Number.** Specify the number of the bill of material to use for assembling units of the master item.

  **Tip:** You can view and edit the bill of material you specify, by clicking the Zoom button beside this field to display the Bills Of Material screen.

- **Component Assembly Method.** You can choose to assemble no subassemblies, all component subassemblies in the master build quantity, or only subassemblies that have insufficient quantities to complete the master item build quantities.

- **Location.** Specify the inventory location of the component items and the location where the assembled master items will be stocked.

  Locations in Inventory Control can be physical locations or logical locations. You can assemble goods only from a physical location. (Logical locations are used for goods in transit.)

  **Note:** If the **Allow Items At All Locations** option is not selected on the I/C Options screen, you can post the transaction only if the specific master item and its components are allowed to be stocked at this inventory location.

- **Build Quantity.** The Build Quantity field displays the build quantity specified for the master item in the Bills Of Material screen. The number you enter in the Quantity field must be a multiple of this number. You cannot change this field. The program displays the number of master items to produce from one assembly of the bill of material. The build quantity comes from the bill of material record.

- **Quantity.** Specify the number of master items to assemble, which must be a multiple of the build quantity.

  The quantity must be a multiple of build quantity.

  **Example:** If the build quantity for the bill of material is 25, you must specify some multiple of 25 (such as 25, 50, or 75) for the quantity, or you cannot post the assembly.

  **Note:** If the **Allow Negative Inventory Levels** option is selected on the I/C Options screen, you can post assemblies for which there are insufficient item quantities in stock.
**Disassembling Master Items**

You can reference particular assemblies to correctly cost component items returned to inventory. When you disassemble an existing assembly, the assembly is reversed and items are returned to inventory at the same cost.

For standalone disassembly, since you are adding inventory back, the cost is determined by the current costing method. For items using the LIFO or FIFO costing method, the program calculates the average cost.

**Note:** You can disassemble master items after clearing the assembly transaction information.

**About Assembling Master Items that Use FIFO or LIFO Costing Methods**

Inventory Control keeps track of the order in which units arrive at a location by storing their receipt date, receipt number, quantity, and extended cost in individual "buckets." The program calculates the cost of units shipped from the costs stored in the buckets.

- For FIFO, units from the bucket having the oldest receipt date are shipped first.
- For LIFO, units from the bucket having the most recent receipt date are shipped first.

There is no limit to the number of buckets Inventory Control can use.

When you assemble units of a master item the program removes each of the components from inventory at the location you specify, and costs them according to their item costing methods. The component costs are added to the fixed cost and variable cost of the master item.

Inventory Control then creates a bucket at the same location and stores the assembly number in the bucket. If, later, you want to adjust the item quantity or cost in a specific bucket created by an assembly, you can identify the bucket by the assembly number, which you will find on the Assemblies Posting Journal.

**Tip:**

Before posting assemblies, click the **Verify Quantities** button to display a list of component items that have insufficient quantities in stock to assemble the quantity of master items you specified.
If the Allow Items At All Locations option is not selected on the I/C Options screen, the Verify Quantities button also displays a list of component items not stocked at the location you specified.

**Assembling Items from Bills of Material**

Many companies repackage items or assemble items before selling them.

In Inventory Control, you use the I/C Assembly screen to assemble master items from component items (or subassemblies), as defined in a bill of material, or BOM.

You use the I/C Bills Of Material screen to add bills of material to Inventory Control.

**Before you start:**
You must set up bills of material to specify the components of master items before you can add assembly transactions.

**To assemble master items from bills of material:**

1. Open Inventory Control > I/C Transactions > Assemblies.
2. With ***NEW*** displayed in the Assembly Number field, press the Tab key to start a new assembly.

   **Tip:** If ***NEW*** does not appear, click the New button.

   The program automatically assigns a document number when you save or post the transaction.

   Alternatively, you can enter a new transaction number yourself, and then press Tab.
3. Select Assembly as the transaction type.
4. Enter an optional description and reference.
5. In the Date field, enter the date for the assembly or select it from the calendar (using the calendar button beside the date field).

   Inventory Control automatically displays the session date as the default date, but you can change it. (The session date is the date that you entered when you started Sage 300 ERP.)
You can also enter a separate posting date, which determines the fiscal year and period to which a transaction is posted in the general ledger.

You can change the document date and the posting date, but you cannot directly change the fiscal period.

6. In the **Posting Date** field, enter the date to which to post the transaction in the general ledger.

7. In the **Master Item Number** field, enter the item number to be assembled, or select it using the Finder.

8. Enter the BOM (bill of material) number, or select the number from the Finder.

9. If this is a multi-level bill of material, in the **Component Assembly Method** field, specify how to assemble the components.

10. Enter the location code or select it from the Finder.

11. In the **Quantity** field, enter the quantity to assemble (a multiple of the build quantity).

   **Tip:** Click **Verify Quantities** to check that there are enough items on hand for the quantity you are posting.

12. If you are working with serialized and/or lotted items, you are prompted to assign serial or lot numbers. (For more information, see "Assigning Serial/Lot Numbers to Assemblies/Disassemblies" (page 250).)

13. When you are finished, click **Post** or **Save**, and then click **OK** at the confirmation message.

   - If you choose Save, Inventory Control saves the transaction so you can edit and post it later.

   - If you choose Post, Inventory Control posts the transaction immediately.

   **Important!** If you use the option to allow you to delete transactions after posting, Inventory Control asks if you want to delete the transaction. Click **No**, unless your company always deletes posted transactions. If you delete the posted transaction, you will not be able to drill down to the transaction details from General Ledger.

**After assembling items**

1. If you saved the transactions, instead of posting them immediately:
a. Print the transaction listings for all the transactions that you entered.

b. Compare the listings to the original documents, and edit transactions if any need correction.

c. Use the Post Transactions screen to post transactions and update inventory quantities and costs (depending on the I/C Options you use).

2. Run Day End Processing to update Inventory Control's audit data, costing data (if you perform costing during Day End Processing), and item statistics.

3. Print the posting journal for the transactions you posted to keep as part of your audit trail.

**Disassembling Master Items**

If you disassemble a master item and return its component items to inventory, you record the disassembly using the I/C Assemblies/Disassemblies screen.

**Before you start:**

Have the following information on hand:

- The transaction number for the build that you are disassembling.
  
  You can reference particular assemblies to correctly cost component items returned to inventory.

- The master item number and BOM number if you are disassembling items after clearing the assembly transaction information.

- Any additional costs required to disassemble items.

- The disassembly quantity.

**To disassemble a master item:**

1. Open **Inventory Control > I/C Transactions > Assemblies**.

2. With ***NEW*** displayed in the Assembly Number field, press the Tab key to start a new disassembly.

   **Tip:** If ***NEW*** does not appear, click the New button.
The program automatically assigns a document number when you save or post the transaction.

Alternatively, you can enter a new transaction number yourself, and then press Tab.

3. Select **Disassembly** as the transaction type.

4. In the **From Assembly Number** field, select the assembly that you are disassembling.

   If the assembly transaction no longer exists in Inventory Control, leave the field blank.

   **Note:** If you are disassembling an existing assembly, you can specify only the quantity being disassembled and a disassembly cost.

5. Enter a description and reference for the disassembly (optional).

   The program generates a general ledger transaction which debits the inventory control account, and credits the items' assembly cost credit accounts.

6. In the **Date** field, enter the date for the assembly or select it from the calendar (using the calendar button beside the date field).

   Inventory Control automatically displays the session date as the default date, but you can change it. (The session date is the date that you entered when you started Sage 300 ERP).

   You can also enter a separate posting date, which determines the fiscal year and period to which a transaction is posted in the general ledger.

   You can change the document date and the posting date, but you cannot directly change the fiscal period.

7. In the **Posting Date** field, enter the date to which to post the transaction in the general ledger.

8. Enter the item number of the master item being disassembled, if you did not specify an assembly, or select the number from the Finder.

   If you are disassembling a specific assembly, you cannot change the item number.

   Note that the program automatically displays a bill of material number in the BOM Number field if you select the item number from the Finder. Any
remaining amount in the master item's assembly cost credit account represents the variable and fixed costs for the disassembled items.

9. Enter a number or type over the existing BOM number for the bill of material to use for assembling or disassembling units of the master item, or select the number from the Finder.

**Tip:** You can view and edit the specified bill of material in the Bills Of Material screen. (To open the screen, click the Zoom button beside the BOM Number field, or point to the field and then press F9.)

If you are disassembling a specific assembly, you cannot change the BOM.

10. Enter a cost in the **Disassembly Cost** field.

11. To change the number displayed in the Quantity field, type over it. Inventory Control automatically displays the bill of material's build quantity in the bill of material's unit of measure.

**Note:** The quantity must be a multiple of the number in the Build Quantity field. For example, if the build quantity for the bill of material is 25, then you must specify a multiple of 25 (such as 25, 50, or 75) for the quantity, or the program will not allow you to save or post the assembly.

12. If you are working with serialized and/or lotted items, you are prompted to assign serial or lot numbers. (For more information, see "Assigning Serial/Lot Numbers to Assemblies/Disassemblies" (page 250).)

13. When you are finished, click **Post** or **Save**, and then click **OK** at the confirmation message.

- If you choose Save, Inventory Control saves the transaction so you can edit and post it later.
- If you choose Post, Inventory Control posts the transaction immediately.

**Important!** If you use the option to allow you to delete transactions after posting, Inventory Control asks if you want to delete the transaction. Click **No**, unless your company always deletes posted transactions. If you delete the posted transaction, you will not be able to drill down to the transaction details from General Ledger.

**After disassembling built items**

- If you saved the assembly/disassembly, post the transaction using the Post
Transactions screen.

The program generates a general ledger transaction that debits the inventory control account and credits the items’ assembly cost accounts.

Any remaining amount in the master item's assembly cost credit account represents the variable and fixed costs for the disassembled items.

- Run Day End Processing to update Inventory Control's audit data, costing data (unless you update costs during posting), and item statistics.
- Print the Assemblies Posting Journal to check the assembly transactions you posted.

**Processing Adjustments**

Inventory Control provides several screens for adjusting item costs and quantities.

You use the Adjustments screen in the I/C Transactions folder to:

- Update the quantity on hand at a location to agree with your physical inventory count.
- Return goods to a vendor after you have completed the receipt.
- Remove additional cost remaining on a receipt when you return the total quantity received for an item at a location to the vendor.

*Do not* use the I/C Adjustments screen to create write-off adjustments, to adjust the total cost of items that have a zero total cost, or to post counts and costs entered on the Physical Inventory Quantities screen

- Use the Process Adjustments screen in the I/C Periodic Processing folder to create write-off adjustments automatically.
- Use the Post Inventory Reconciliation screen in the I/C Physical Inventory folder to post the item counts and costs that you enter in the Physical Inventory Quantities screen.

**About Processing Adjustments**

Inventory Control provides several screens for adjusting item costs and quantities:
Chapter 3: Entering and Posting Inventory Control Transactions

- Use the Adjustments screen in the I/C Transactions folder to change item costs and quantities as needed.

**Example:**
You would use the Adjustments screen to:

- To update the quantity on hand at a location to agree with your physical inventory count.
- To return goods to a vendor after you have completed the receipt.
- To remove additional cost remaining on a receipt when you return the total quantity received for an item at a location to the vendor.

For more information, see "I/C Adjustments Screen" (page 643).

- Use the Process Adjustments screen in the I/C Periodic Processing folder to create adjustments automatically to:

  - Write off the cost of items with zero quantities.
  - Write off the quantities of items with zero cost.
  - Adjust the total costs of items with non-zero quantities and zero total cost to a new cost.

For more information, see "I/C Process Adjustments Screen" (page 483).

- Use the Post Inventory Reconciliation screen in the I/C Physical Inventory folder to post the item counts and costs that you enter in the Physical Inventory Quantities screen. Inventory Control creates adjustment transactions when you post an inventory reconciliation.

**Note:** When you post an inventory reconciliation for which an adjustment number already exists, the Inventory Worksheet will create separate adjustments for every one hundred items, and append "1", "2", "3", etc. to the end of the document number.

For more information, see "I/C Physical Inventory Quantities Screen" (page 508) and "I/C Post Inventory Reconciliation Screen" (page 512).

**Adjustment Types**

You can enter six types of adjustments using the Adjustments screen.

You specify the type of adjustment for each detail in an adjustment transaction.
The journal entries created for adjustments vary, depending on the type of adjustment. Quantity adjustments do not create journal entries.

### Adjustment Types

<table>
<thead>
<tr>
<th>Type</th>
<th>Effect on I/C Quantities and Costs</th>
<th>Effect on General Ledger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantity increase</td>
<td>Increases the item quantity on hand at the location by the number you specify.</td>
<td>Inventory Control does not create general ledger transactions for this type of adjustment because the value of the inventory does not change.</td>
</tr>
<tr>
<td></td>
<td>Quantity increase adjustments affect the item's unit cost, but the extended cost does not change.</td>
<td></td>
</tr>
<tr>
<td>Quantity decrease</td>
<td>Decreases the item quantity on hand at the location by the number you specify.</td>
<td>Inventory Control does not create general ledger transactions for this type of adjustment.</td>
</tr>
<tr>
<td></td>
<td>Quantity decrease adjustments affect the item's unit cost, but the extended cost does not change.</td>
<td></td>
</tr>
<tr>
<td>Cost increase</td>
<td>Increases the extended item cost at the location by the amount you specify.</td>
<td>The G/L entry debits the inventory control account for the change in costs, and credits the adjustment write-off account you specify when you enter the adjustment.</td>
</tr>
<tr>
<td></td>
<td>Inventory Control recalculates the unit cost based on the increased extended cost.</td>
<td></td>
</tr>
<tr>
<td>Cost decrease</td>
<td>Decreases the extended item cost at the location by the amount you specify.</td>
<td>The G/L entry credits the inventory control account for the change in costs, and debits the adjustment write-off account you specify when you enter the adjustment.</td>
</tr>
<tr>
<td></td>
<td>Inventory Control recalculates the unit cost based on the decreased extended cost.</td>
<td></td>
</tr>
<tr>
<td>Both Increase</td>
<td>Increases both the item quantity on hand and the extended item cost at the location by the increases you specify.</td>
<td>The G/L entry debits the inventory control account for the change in costs, and credits the adjustment write-off account you specify when you enter the adjustment.</td>
</tr>
</tbody>
</table>
### Type | Effect on I/C Quantities and Costs | Effect on General Ledger
---|---|---
Both decrease | Reduces both the item quantity on hand and the extended item cost at the location by the decreases you specify. Inventory Control recalculates the unit cost based on the decreases. | The G/L entry credits the inventory control account for the change in costs, and debits the adjustment write-off account you specify when you enter the adjustment.

### About Adjustments to Items that Use FIFO or LIFO Costing

For items that use the FIFO or LIFO costing method, Inventory Control keeps track of the order in which units arrive at a location by storing each item's receipt date, receipt number, quantity, and extended cost in individual "buckets."

When adjusting a detail for an item that uses one of these costing methods, you specify one of the following bucket types:

- **Offset bucket.** If you select Offset Bucket, the adjustment affects only the offset bucket.

  **Note:** For each item at each location, there is an "offset" bucket that Inventory Control uses for special cases, such as when you ship more items than there are in stock from a location. (Inventory Control must be set up to allow negative inventory levels in order to ship negative quantities.) Offset buckets contain a quantity and a cost, but do not contain a date or receipt number, like other buckets.

- **Specific Receipt.** If you specify the Specific Receipt bucket type, you specify a receipt number to select the cost and quantity information for a particular receipt.

  The number of the receipt from which a bucket is created is contained in the bucket.

- **Prorate.** Select Prorate to have the program prorate the adjustment across all buckets (including the offset bucket) for the item at the location.
The number of units and the amount of cost prorated to each bucket is based on the quantity in each bucket.

The program determines the particular buckets to adjust consistent with the costing method (FIFO or LIFO).

**Adjusting Item Quantities and Costs**

You use the Adjustments screen in the I/C Transactions folder to:

- Update the quantity on hand at a location to agree with your physical inventory count.
- Return goods to a vendor after you have completed the receipt.
- Remove additional cost remaining on a receipt when you return the total quantity received for an item at a location to the vendor.

**Do not** use the I/C Adjustments screen to create write-off adjustments, to adjust the total cost of items that have a zero total cost, or to post counts and costs entered on the Physical Inventory Quantities screen.

You use the Process Adjustments screen to:

- Write off the cost of items with zero quantities.
- Write off the quantities of items with zero cost.
- Adjust the total costs of items with non-zero quantities and zero total cost to a new cost.

For help on the Process Adjustments screen, see "I/C Process Adjustments Screen" (page 483).

You use the Post Inventory Reconciliation screen to post the counts and costs that you entered in the Physical Inventory Quantities screen. The program creates adjustment transactions when you post inventory reconciliations.

For help on the Post Inventory Reconciliation screen, see "I/C Post Inventory Reconciliation Screen" (page 512).

**Note:** If you use Project and Job Costing, material adjustment transactions created by Project and Job Costing appear in Inventory Control showing adjustments to particular contracts, projects, job categories and overhead accounts. However, you cannot use Inventory Control to adjust materials for jobs.
Before you start:

- Get the item numbers, along with the adjusted quantities or costs that you need to adjust.

- Decide whether to post each return as you enter it, or save the returns to post them later in a batch using the Post Transactions screen.

To adjust item quantities and costs:

1. Open Inventory Control > I/C Transactions > Adjustments.

2. With ***NEW*** displayed in the Adjustment Number field, press the Tab key to start a new assembly.

   **Tip:** If ***NEW*** does not appear, click the New button.

   The program automatically assigns a document number when you save or post the transaction.

   Alternatively, you can enter a new transaction number yourself, and then press Tab.

3. In the Adjustment Date field, enter the date for the adjustment, or select it using the calendar icon beside the field.

   Inventory Control automatically displays the session date as the default date, but you can change it. (The session date is the date that you entered when you started Sage 300 ERP).

   You can also enter a separate posting date, which determines the fiscal year and period to which a transaction is posted in the general ledger.

   You can change the document date and the posting date, but you cannot directly change the fiscal period.

4. In the Posting Date field, enter the date to which to post the transaction in the general ledger.

5. Enter an optional description and reference for the adjustment.

6. Click the Zoom button beside the Optional Fields check box (if one appears) to add optional field information for this adjustment.

7. Add the detail lines, specifying the item number, adjustment type, and location for each, then:
If the item uses the FIFO or LIFO costing method, specify the bucket type, receipt number, and cost date.

Select a bucket type from the list to specify the way in which the program is to process the adjustment. Inventory Control automatically displays Offset Bucket.

If the adjustment type is Quantity Increase, Quantity Decrease, Both Increase, or Both Decrease, specify the quantity and unit of measure. If the item is serialized and/or lotted, you are prompted to assign serial/lot numbers. (For more information see "Assigning Serial/Lot Numbers to Adjustments" (page 248).)

If the adjustment type is Cost Increase, Cost Decrease, Both Increase, or Both Decrease, specify the cost adjustment and adjustment/write-off general ledger account.

Enter any comments you want to keep with the detail.

Click the Zoom button for the Optional Fields column (or check box), if one appears, to add optional field information for this adjustment detail.

8. When you are finished, click **Post** or **Save**, and then click **OK** at the confirmation message.

- If you choose Save, Inventory Control saves the transaction so you can edit and post it later.

- If you choose Post, Inventory Control posts the transaction immediately.

**Important!** If you use the option to allow you to delete transactions after posting, Inventory Control asks if you want to delete the transaction. Click **No**, unless your company always deletes posted transactions. If you delete the posted transaction, you will not be able to drill down to the transaction details from General Ledger.

**After adjusting item quantities and costs**

1. If you saved the transactions, instead of posting them immediately:
   a. Print the transaction listings for all the transactions that you entered.
   b. Compare the listings to the original documents, and edit transactions if any need correction.
c. Use the Post Transactions screen to post transactions and update inventory quantities and costs (depending on the I/C Options you use).

2. Run Day End Processing to update Inventory Control's audit data, costing data (if you perform costing during Day End Processing), and item statistics.

3. Print the posting journal for the transactions you posted to keep as part of your audit trail.

**About Adjustment Details**

The costing method used for an item determines the information you need to enter for each detail line on a transaction.

**Note:** There are no restrictions on the number of detail lines you can enter on adjustment transactions.

- **Item Number.** Enter the code for the item for which you are entering an adjustment.
- **Item Description.** Inventory Control displays the description from the item record.
- **Transaction Type.** Select the type of adjustment you want to make for the item (quantity increase, quantity decrease, cost increase, cost decrease, both increase, or both decrease).
- **Location.** Specify the inventory location at which to make the adjustment.
- **Bucket Type.** For items that use the FIFO or LIFO costing method, you specify how to adjust items.

You specify one of the following processing types:

- **Offset Bucket.**
- **Specific Receipt** and **Receipt Number.** If you select Specific Receipt, you specify the receipt number of the transaction used to enter item units into inventory to adjust the FIFO or LIFO bucket the program created to store the quantity and cost of the units. (The receipt number you specify must appear in the Finder for this field.)
- **Prorate.**
- **Cost Date.** Inventory Control displays the transaction date for the specified receipt number (if you specified one).
- **Quantity.** Specify the number of units by which to adjust the item quantity.

  **Note:** To decrease the quantity of an item in stock to below zero, you must have selected the Allow Negative Inventory Levels option in the Options screen.

- **Cost Adjustment.** Enter the amount by which to adjust the item cost.
- **Unit of Measure.** This is the unit of measure for the item.

  **Note:** You specify a unit of measure only when adjusting the quantity of the item.

- **Adjustment/Write-Off Account.** This is the general ledger account to which you post cost adjustments and write-offs for the item. Inventory Control displays the account from the item record’s account set, but you can specify a different account.

  **Note:** You specify an account number only when adjusting item costs. (Inventory Control does not create general ledger transactions for adjustments that affect only the item quantity.)

- **Comments.** Enter any comments you want to appear on the Adjustments Posting Journal regarding the detail line. (Optional)
- **Optional Fields.** If optional fields are set up for use in adjustment details, you can enter information in the detail optional fields by selecting the detail line, and then clicking the **Optional Fields** column heading in the Detail table.

**Processing Receipts and Returns**

You use the I/C Receipts screen to record the receipt of items into inventory and the return of items to suppliers.

If you return items to a supplier from an incomplete receipt, you can use the Receipts screen to record the transaction. If the receipt has been deleted, you must enter an adjustment using the Adjustments screen to record the return.
Chapter 3: Entering and Posting Inventory Control Transactions

About Receipts

You use the I/C Receipts screen to record the receipt of items into inventory and the return of items to suppliers.

Tip: If you use the Sage 300 ERP Purchase Orders program, you can process receipts either in Inventory Control or Purchase Orders.

There are no restrictions on the number of detail lines you can enter on receipt transactions.

You can enter the Quantity Returned only on a return, and you can enter an Adjusted Unit Cost or Adjusted Cost only on an adjustment.

You can enter returns and adjustments on posted receipts that you have not yet deleted. You cannot adjust or return receipt transactions that have been deleted (either immediately after posting, or later, using the Transactions option on the Clear History screen).

For more information on the types of information you can change on an existing receipt, see "About Receipt Adjustments" (page 187).

Multicurrency Ledgers

If you have a multicurrency system, you specify the receipt currency and the currency to use for any additional costs when you enter the receipt. The additional cost currency must be the same as either the receipt currency or your company's functional (home) currency.

Receiving Goods from Vendors

You use the I/C Receipts screen to record the receipt of items into inventory and the return of items to suppliers.

Before you start:

- Determine the receipt numbers to use for new receipts, or have the program allocate numbers for you automatically.
- Decide whether to post each new receipt as you enter it, or save the receipts to post them later in a batch using the Post Transactions screen.
- Find out the numbers of the receipts to which you wish to post returns and adjustments.
To receive items in Inventory Control:

1. Open **Inventory Control > I/C Transactions > Receipts**.

2. To start a new receipt, do one of the following:
   - To have the program automatically assign a document number when you save or post the transaction, press the Tab key. (If ***NEW*** is not displayed in the Receipt Number field, click the New button, and then press Tab.)
   - In the Receipt Number field, type a new receipt number, and then press Tab.

3. Enter header information for the receipt in the top section of the screen.
   a. Enter an optional description and reference for the receipt.
   b. Specify the transaction date and fiscal year and period to which you will post it.
   c. If a vendor number applies to the receipt, enter that number. If you use Sage 300 ERP Accounts Payable with Inventory Control, you can select vendor numbers from the Finder beside the Vendor Number field.
   d. Enter a purchase order number, if any.
   e. If you use multicurrency accounting, specify the currency in which you will enter item costs and specify the exchange rate.
   f. Indicate whether you want to print labels for the receipt.
   g. Click the Zoom button beside the Optional Fields check box (if one appears) to add optional field information to this receipt.
   h. If you use multicurrency accounting, specify the currency in which you will enter any additional costs.

**Note:** In a multicurrency system, you specify the receipt currency and the currency to use for any additional costs when you enter the receipt. The additional cost currency must be the same as either the receipt currency or your company’s functional (home) currency.
Chapter 3: Entering and Posting Inventory Control Transactions

4. Enter details for the receipt in the table, using a separate line for each detail, as follows:
   a. Enter the amount of any additional cost.
   b. For each item on the receipt, type or use the Finder to enter the item number and location.
   c. Enter the quantity received and unit of measure.
      If the item is serialized or lotted, you are prompted to assign serial/lot numbers.
   d. Enter the unit cost or the extended cost if it is different from the cost displayed by the program.
   e. Indicate the number of labels you require, if any, and enter any comments or optional fields you want to appear on the Receipts Posting Journal regarding the detail line (optional).
   f. Press the Insert key to start a new line.

5. When you are ready, click **Save** or **Post**.
   - If you choose Save, Inventory Control saves the transaction so you can edit and post it later.
   - If you choose Post, Inventory Control posts the transaction immediately.

| Important! If you use the option to allow you to delete transactions after posting, Inventory Control asks if you want to delete the transaction. Click No, unless your company always deletes posted transactions. If you delete the posted transaction, you will not be able to drill down to the transaction details from General Ledger. Also, you will not be able to recall the receipt for returns or adjustments. |

6. At the confirmation message, click **OK**.

   **After entering, adjusting, or posting returns to receipts**
   1. If you saved the transactions, instead of posting them immediately:
      a. Print the transaction listings for all the transactions that you entered.
      b. Compare the listings to the original documents, and edit transactions if any need correction.
c. Use the Post Transactions screen to post transactions and update inventory quantities and costs (depending on the I/C Options you use).

2. Run Day End Processing to update Inventory Control’s audit data, costing data (if you perform costing during Day End Processing), and item statistics.

3. Print the posting journal for the transactions you posted to keep as part of your audit trail.

**About Receipt Adjustments**

You can change the following fields in saved receipts:

- Description
- Date, Year, and Period
- Additional Cost
- Comments for each detail
- Adjusted Unit Cost for each detail
- Adjusted Cost (adjusted extended cost for each detail)

You use this feature to receive goods into inventory before you get the invoice in either of the following ways:

- Save an incomplete receipt that does not contain the cost of the goods, and then edit the receipt and post it later.
- Post the receipt, and when you know the cost of the goods, you enter it as an adjustment to the receipt.

For instructions on using the I/C Receipts screen to record receipt adjustments, see "Entering Adjustments to Existing Receipts" (page 188).

**Important!**

Do not confuse the Adjustment option in the I/C Receipts screen with the I/C Adjustments screen.

You use the I/C Adjustments screen to change (adjust) item quantities and costs for the items in your inventory, whereas you use the Adjustment option in the I/C Receipts screen to make changes to incomplete receipts.

To adjust the quantities and costs of items for a deleted receipt, you must enter an adjustment transaction using the I/C Adjustments screen.
Chapter 3: Entering and Posting Inventory Control Transactions

**Entering Adjustments to Existing Receipts**

You can use the I/C Receipts screen to adjust the additional cost for a receipt, as well as the unit cost and total cost of each received item.

You cannot adjust receipt quantities, nor can you change the vendor information or the exchange rate for a multicurrency transaction.

**Note:** You can post adjustments only to incomplete receipts. If the receipt is marked Complete, or is no longer available, you must use the Adjustments screen to adjust inventory quantities or costs.

**Before you start:**

- Determine the receipt numbers to use for new receipts, or have the program allocate numbers for you automatically.
- Decide whether to post each new receipt as you enter it, or save the receipts to post them later in a batch using the Post Transactions screen.
- Find out the numbers of the receipts to which you wish to post returns and adjustments.

1. Open **Inventory Control > I/C Transactions > Receipts**.

   **Note:** If you received goods through Sage 300 ERP Purchase Orders, you must edit the receipt using Purchase Orders.

2. Use the Finder or the navigation buttons to select the receipt to adjust.

3. Select **Adjustment** from the Type list.

4. Enter a description for the adjustment, and then specify the transaction date and fiscal year and period to which you will post it.

5. Make any changes you need in the description, date, fiscal year, and fiscal period.

6. Change the additional cost for the receipt, if necessary.

7. Click the Zoom button to edit optional fields for the receipt, if you use optional fields.
8. To adjust the receipt details:
   a. Select the receipt line that you are adjusting.
   b. Tab to the comments field and provide a reason for the adjustment. (Your comments will be included on the Receipts Posting Journal for the items being adjusted.)
   c. Tab to the Adjusted Cost or the Total Adjusted Cost to enter or change the value or the goods received. You cannot change the quantity on the receipt.
   d. Click the Zoom button in the Optional Fields column heading to enter optional field information.

You cannot add or remove lines from the receipt.

9. When you are finished, click **Post** or **Save**, and then click **OK** at the confirmation message.

   - If you choose Save, Inventory Control saves the transaction so you can edit and post it later.
   - If you choose Post, Inventory Control posts the transaction immediately.

   **Important!** If you use the option to allow you to delete transactions after posting, Inventory Control asks if you want to delete the transaction. Click **No**, unless your company always deletes posted transactions. If you delete the posted transaction, you will not be able to drill down to the transaction details from General Ledger.

10. Click **OK** at the confirmation message.

**After entering, adjusting, or posting returns to receipts**

1. If you saved the transactions, instead of posting them immediately:
   a. Print the transaction listings for all the transactions that you entered.
   b. Compare the listings to the original documents, and edit transactions if any need correction.
   c. Use the Post Transactions screen to post transactions and update inventory quantities and costs (depending on the I/C Options you use).

2. Run Day End Processing to update Inventory Control’s audit data, costing data (if you perform costing during Day End Processing), and item statistics.
3. Print the posting journal for the transactions you posted to keep as part of your audit trail.

**Posting Saved Receipts**

You can post a single receipt using the I/C Receipts screen, or you can post a range of saved receipts using the Post Transactions screen.

**To post a single receipt:**

1. Open *Inventory Control > I/C Transactions > Receipts*.
2. In the Receipt Number field, type the number of an existing receipt, or use the Finder or the navigation buttons to select the receipt.
3. Click **Post**.
4. Click **Close** at the "Posting completed" message.

**To post a range of saved receipts:**

1. Open *Inventory Control > I/C Transactions > Post Transactions*.
2. Select the Receipts option.
3. Use the **From** and **To** fields to specify the range of receipt numbers to post.
4. Click **Process**.
5. Click **Close** at the "Posting completed" message.

**About Returns**

If you return items to a supplier from an incomplete receipt, you can use the Receipts screen to record the transaction. If the receipt has been deleted, you must enter an adjustment using the Adjustments screen to record the return.

When entering receipt returns, you can change the following fields in the I/C Receipts screen:

- Description
- Date, Year, and Period
- Prorate/Leave Additional Cost
• Comments

• Quantity Returned

You cannot change the vendor information or the exchange rate for a multicurrency transaction.

**Returning Goods to Vendors**

If you return items to a supplier from an incomplete receipt, you can use the Receipts screen to record the transaction. If the receipt has been deleted, you must enter an adjustment using the Adjustments screen to record the return.

When entering receipt returns, you can change the following fields in the I/C Receipts screen:

• Description

• Date, Year, and Period

• Prorate/Leave Additional Cost

• Comments

• Quantity Returned

You cannot change the vendor information or the exchange rate for a multicurrency transaction.

**Note:** You can post returns only to incomplete receipts. If the receipt is marked Complete, or is no longer available, you must use the Adjustments screen to adjust inventory levels or costs.

**Before you start:**

• Find out the numbers of the receipts to which you wish to post returns.

• Determine whether to prorate or leave any additional costs that were on the original receipt for the items that you are returning.

• Decide whether to post each return as you enter it, or save the returns for posting in a batch (using the Post Transactions screen).
To return goods to vendors:

1. Open Inventory Control > I/C Transactions > Receipts.

   **Note:** If you received goods through Sage 300 ERP Purchase Orders, you should return those goods using Purchase Orders.

2. Use the Finder or the navigation buttons to select the receipt for which you are returning goods.

3. From the **Type** list, select **Return**.

4. Enter a description for the return, and then specify the transaction date and fiscal year and period to which you will post it.

5. Specify whether to leave the additional cost assigned to the items being returned or to prorate it over the remaining items on the receipt.

   **Note:** If you return all of the items on the receipt, you must use the Adjustments screen to write off the additional cost from the receipt to a general ledger write-off account, even if you select the Prorate option.

6. Click the Zoom button to edit optional fields for the return, if you use optional fields.

7. In the table, fill in the return details:

   a. Select the receipt line for the goods that you are returning.

   b. In the Quantity Returned field, enter the quantity being returned.

      If the item is serialized or lotted, you are prompted to assign serial numbers or lot numbers. (For more information see "Assigning Serial/Lot Numbers when Receiving Goods" (page 246).)

   c. Enter comments to be included on the Receipts Posting Journal for the items being returned.

   d. Click the Zoom button in the Optional Fields column heading, and then enter optional field information.

8. When you are ready, click **Save** or **Post**.

   - If you choose Save, Inventory Control saves the transaction so you can edit and post it later.

   - If you choose Post, Inventory Control posts the transaction immediately.
Important! If you use the option to allow you to delete transactions after posting, Inventory Control asks if you want to delete the transaction. Click No, unless your company always deletes posted transactions. If you delete the posted transaction, you will not be able to drill down to the transaction details from General Ledger.

Also, you cannot later recall the returns or adjustments.

9. Click OK at the confirmation message.

After entering, adjusting, or posting returns to receipts

- If you used the Save button to save transactions (instead of immediately posting transactions):
  - Print the Transaction Listing report to list all transactions that you entered.
  - Compare listings to original documents and edit transactions if necessary.
  - Use the Post Transactions screen to post transactions and update inventory quantities and costs (depending on the Setup Options that you choose).
- Run Day End Processing to update Inventory Control's audit data, costing data (unless you cost items during posting), and item statistics after posting receipts, returns, and adjustments.
- Print the Receipts Posting Journal to check the receipts, receipt returns, and receipt adjustments that you posted.
- You can post more than one return to a receipt.

Processing Shipments and Customer Returns

You use the Shipments screen in the I/C Transactions folder for shipping items out of inventory, and for returning items to inventory (sales returns).

About Shipments

You use the Shipments screen in the I/C Transactions folder for shipping items out of inventory, and for returning items to inventory (sales returns).

You can display or drill down to posted shipment and sales return transactions from General Ledger, unless you delete or clear them. However, you cannot edit the posted transactions.

Note: You cannot modify posted shipments or sales returns.
**Shipment Entry Information**

For each shipment transaction, you enter the following "header" information:

- **Shipment Number.** Each shipment transaction is assigned a unique number to distinguish it from other shipments for audit control purposes. Press the Tab key to accept a program-generated number.

- **Entry Type.** Select Shipment or Return.

- **Description** and **Reference.** Use these fields to add any additional descriptive information you want about the shipment or return for example, a purchase order number or an invoice number. (Optional)

- **Ship Date.** Enter the transaction date.

- **Posting Date.**

- **Year/Period.** The posting date determines the year and period to which the transaction is posted in your general ledger. You cannot change the Year/Period field directly.

- **Customer Number.** If you use Accounts Receivable, enter code to identify the customer. (Optional)

- **Contact.** Enter the person or position you use to contact the customer.

- **Price List.** Specify the code for the price list to use as the default for the shipment details.

- **Optional fields.** If optional fields are set up to use in shipment transactions, you can click the Zoom button beside the field to add shipment optional fields, or edit any automatically inserted optional fields.

- **Currency** and **Exchange Rate.** These fields appear in multicurrency ledgers. Enter the currency in which you will enter prices, and the rate of exchange between the price list currency and the functional currency.

**Shipment Detail Information**

For each shipment detail, you enter the following information:

- **Item Number.** Use this field to identify the item being shipped or returned.

- **Item Description.** Inventory Control displays the description from the item record.
• **Category.** Inventory Control displays the category from the item record as the default entry in this field, but you can specify a different category.

• **Location.** Specify the inventory location from which you are shipping or to which you are returning the units.

• **Quantity.** Specify the number of units to ship or return.

• **Unit of Measure.** (the unit of measure for the quantity being shipped or returned.)

• **Price List.** Specify the code for the price list to use for the detail.

• **Unit Price and Extended Price.** Inventory Control calculates the extended price by multiplying the unit price by the quantity being shipped or returned. You can change the amounts.

• **Unit Cost and Extended Cost.** When shipping items that use the user-specified costing method, enter the unit cost or the extended cost. (You cannot enter costs when shipping items that do not use user-specified costing method.) Inventory Control automatically displays the item’s most recent cost, but you can change it.

• **Comment.** Add any comments you want to appear on the Shipments Posting Journal for the detail line. (Optional)

• **Optional Fields.** If optional fields are set up for use in shipment details, you can enter information in the detail optional fields by selecting the detail line, and then clicking the **Optional Fields** column heading in the Detail table.

There are no restrictions on the number of detail lines you can enter on shipments and sales returns.

For information on the calculation of item costs, see "Costing Methods Reference List" (page 19).

### Integration with Other Programs

• If you use Sage 300 ERP Project and Job Costing, you assign material to jobs (remove items from inventory) by processing material usage transactions in Project and Job Costing. You return material by processing material return transactions in Project and Job Costing. You cannot assign goods to jobs using the Inventory Control program.

When these job-related transactions appear in Inventory Control, the details include the particular contracts, projects, job categories, and WIP accounts to which the material was allocated, or from which it was returned.
(Inventory Control displays Contract, Project, Category and WIP account fields in the detail lines only for shipments created in the Project and Job Costing module.)

- If you use Sage 300 ERP Order Entry, you can process shipments and sales returns in either Inventory Control or Order Entry.
- If you ordered goods through Sage 300 ERP Purchase Orders, you should receive the shipment in Purchase Orders.

**Shipping Goods to Customers**

**Note:** If you are shipping an order that was entered in the Order Entry module, you should process the shipment in Order Entry.

**Before you start:**

- Determine the shipment numbers to use for new shipments or have the program allocate numbers for you automatically.
- Decide whether to post each new shipment as you enter it, or save the shipments to post them later in a batch using the Post Transactions screen.
- Find out the numbers of the shipments to which you wish to post returns.

**To add shipments of inventory in the Inventory Control module:**

1. Open **Inventory Control > I/C Transactions > Shipments.**
2. With ***NEW*** displayed in the Shipment Number field, press the Tab key to start a new shipment.

   **Tip:** If ***NEW*** does not appear, click the **New** button.

   The program automatically assigns a document number when you save or post the transaction.

   Alternatively, you can enter a new transaction number yourself, and then press Tab.
3. In the **Entry Type** field, select Shipment.
4. In the **Ship Date** field, enter the date of the shipment, or select it using the calendar icon.
Inventory Control automatically displays the session date as the default date, but you can change it. (The session date is the date that you entered when you started Sage 300 ERP).

You can also enter a separate posting date, which determines the fiscal year and period to which a transaction is posted in the general ledger.

You can change the document date and the posting date, but you cannot directly change the fiscal period.

5. In the **Posting Date** field, enter the date to which to post the transaction in the general ledger.

6. In the **Posting Date** field, enter the date to which to post the transaction in the general ledger.

7. Enter an optional description and reference for the shipment.

8. If the shipment is for an Accounts Receivable customer, use the Finder beside the **Customer Number** field to select the customer number, or type the number in the field.

   If you don't specify an existing customer, in the **Contact** field, type the contact information (such as a contact name and phone number).

9. In the **Price List** field, select the price list for the shipment.

   The program displays the default price list for the customer, but you can change it.

   You can override any prices on the individual detail lines.

10. Click the Zoom button beside the **Optional Fields** check box to add optional field information to this shipment.

11. If you use multicurrency accounting, specify the currency and the exchange rate for all prices.

   **Tip:** Click the Zoom button beside the Exchange Rate field to change exchange rate information.

12. For each item you are shipping, in the table:

   a. Type or use the Finder to enter the item number, location, quantity, and unit of measure.
If working with serialized and/or lotted items, you are prompted to assign serial and/or lot numbers after specifying a quantity. For more information, see "Assigning Serial/Lot Numbers for Shipments" (page 256).

b. Enter the unit price or the extended price if it is different from the price displayed by the program.

c. If necessary, enter comments, optional fields, and WIP account information for job-related returns.

d. Press the Insert key on your keyboard to start a new line.

**Tip:** Click the **Detail** button to view all detail fields on a single entry screen.

13. When you are finished, click **Post** or **Save**, and then click **OK** at the confirmation message.

   - If you choose Save, Inventory Control saves the transaction so you can edit and post it later.
   - If you choose Post, Inventory Control posts the transaction immediately.

   **Important!** If you use the option to allow you to delete transactions after posting, Inventory Control asks if you want to delete the transaction. Click **No**, unless your company always deletes posted transactions. If you delete the posted transaction, you will not be able to drill down to the transaction details from General Ledger.

14. Note the shipment number, and click **OK** at the confirmation message.

**After shipping goods**

1. If you saved the transactions, instead of posting them immediately:
   a. Print the transaction listings for all the transactions that you entered.
   b. Compare the listings to the original documents, and edit transactions if any need correction.
   c. Use the Post Transactions screen to post transactions and update inventory quantities and costs (depending on the I/C Options you use).
2. Run Day End Processing to update Inventory Control’s audit data, costing data (if you perform costing during Day End Processing), and item statistics.

3. Print the posting journal for the transactions you posted to keep as part of your audit trail.

Receiving Returned Goods from Customers

**Note:** If you are returning goods from an order that was shipped using the Order Entry module, you should process the return in Order Entry.

**Before you start:**

- Have a copy of the original shipment or invoice showing the prices charged on shipped and returned goods.
- Determine the transaction numbers to use for the shipment returns or have the program allocate numbers for you automatically.
- Decide whether to post each new return as you enter it, or save returns to post them later in a batch using the Post Transactions screen.

**To add returns from shipments of inventory in the I/C module:**

1. Open **Inventory Control > I/C Transactions > Shipments**.

2. With ***NEW*** displayed in the Shipment Number field, press the Tab key to start a new return.

   **Tip:** If ***NEW*** does not appear, click the **New** button.

   The program automatically assigns a document number when you save or post the transaction.

   Alternatively, you can enter a new transaction number yourself, and then press Tab.

3. In the **Entry Type** field, select Return.

4. In the **Ship Date** field, enter the date of the return, or select it using the calendar icon.

   Inventory Control automatically displays the session date as the default date, but you can change it. (The session date is the date that you entered when you started Sage 300 ERP).
You can also enter a separate posting date, which determines the fiscal year and period to which a transaction is posted in the general ledger.

You can change the document date and the posting date, but you cannot directly change the fiscal period.

5. In the **Posting Date** field, enter the date to which to post the transaction in the general ledger.

6. Enter an optional description and reference for the return.

7. If the shipment was to an Accounts Receivable customer, use the Finder beside the **Customer Number** field to select the customer number, or type the number in the field.

   If you don't specify an existing customer, in the **Contact** field, type the contact information (such as a contact name and phone number).

8. In the **Price List** field, select the price list that was in effect for the shipment.

   The program displays the default price list for the customer, but you can change it.

   You can override any prices on the individual detail lines.

9. Click the Zoom button beside the **Optional Fields** check box to add optional field information to this return.

10. If you use multicurrency accounting, specify the currency and the exchange rate for all prices.

    **Tip:** Click the Zoom button beside the Exchange Rate field to change exchange rate information.

11. For each item you are returning to inventory, in the table:

    a. Type or use the Finder to enter the item number, location, quantity, and unit of measure.

       If working with serialized and/or lotted items, you are prompted to "Assigning Serial/Lot Numbers for Shipments" (page 256) to items after specifying a quantity.

    b. Enter the unit price or the extended price if it is different from the price displayed by the program.
c. If necessary, enter comments, optional fields, and WIP account information for job-related returns.

d. Press the Insert key on your keyboard to start a new line.

**Tip:** Click the Detail button to view all detail fields on a single entry screen.

12. When you are finished, click **Post** or **Save**, and then click **OK** at the confirmation message.

- If you choose Save, Inventory Control saves the transaction so you can edit and post it later.
- If you choose Post, Inventory Control posts the transaction immediately.

**Important!** If you use the option to allow you to delete transactions after posting, Inventory Control asks if you want to delete the transaction. Click **No**, unless your company always deletes posted transactions. If you delete the posted transaction, you will not be able to drill down to the transaction details from General Ledger.

13. Note the return number, and then click **OK** at the confirmation message.

**After returning goods to inventory**

1. If you saved the transactions, instead of posting them immediately:
   a. Print the transaction listings for all the transactions that you entered.
   b. Compare the listings to the original documents, and edit transactions if any need correction.
   c. Use the Post Transactions screen to post transactions and update inventory quantities and costs (depending on the I/C Options you use).

2. Run Day End Processing to update Inventory Control’s audit data, costing data (if you perform costing during Day End Processing), and item statistics.

3. Print the posting journal for the transactions you posted to keep as part of your audit trail.

**Processing Transfers**

Use Inventory Control’s Transfers screen to record stock transfers between physical inventory locations, if you store inventory items at more than one
About Transfers

Use Inventory Control's Transfers screen to record stock transfers between physical inventory locations, if you store inventory items at more than one location.

Transfers change item quantities at locations without changing the total number of items in inventory, or the total inventory valuation.

When you post transfers, the program generates journal entries to track the movement of stock because costing is done by location.

**Note:** Before you can post transfers, you must allow the items being transferred to be stocked at the locations to which you are transferring them.

Types of Transfers

Inventory Control provides two ways to transfer goods between locations:

- Directly (and immediately) to the destination location.
- Via a goods-in-transit location to the destination location, specifying a transfer number to track the shipment.

Goods in transit are transferred first to a goods-in-transit location (usually marked as a logical inventory location). When they reach their destination, they must be received from the goods-in-transit location.

In other words, goods in transit:

- Exist between locations—as in the real world.
- Can travel on different trucks and be received in separate lots.

**Note:** When you ship via a goods-in-transit location, all goods must be received separately at the destination location.
Information Entered with Transfers

For each transaction, you enter the following general information:

- **Document number.** Each transfer is assigned a unique number to distinguish it from other transfers for audit control purposes.
  
  Press the Tab key to accept a program-generated number.

- **Document type.** Select Transfer, Transit Transfer, or Transit Receipt. A transfer goes immediately between two locations. Transit transfers and transit receipts move goods in and out of a goods-in-transit location.

- **Transfer number.** Use this field to specify an additional transit transfer or receipt.

- **Date.** Enter the date for the transfer or select it from the calendar (using the calendar button beside the date field).
  
  Inventory Control automatically displays the session date by default (the date that you entered when you started Sage 300 ERP), but you can change it.

- **Posting Date.** This is the date to which the transaction will be posted in the general ledger.

- **Year/Period.** The year and period to which the transfer is posted in the general ledger are determined by the posting date you enter. You cannot change this field directly.

- **Expected arrival date.**

- **Additional Cost.** Include any additional costs incurred because of the item transfers.

- **Proration Method.** Specify how to prorate the additional cost to the items in the transfer (by quantity, by weight, by cost, equally or manually).

- **Description and Reference.** You can add any information you want about the transfer—for example, the reason for making the stock transfer.

- **Optional fields.** If optional fields are set up to use in transfer transactions, you can click the Zoom button beside the field to add transfer optional fields, or edit any automatically inserted optional fields.
Information Entered for Transfer Details

For each numbered detail line on a transaction, you enter the following information:

- **Item number.** Specify the stock item for which you are transferring units.

- **Description.** Inventory Control displays the description from the item record.

- **From location.** Specify the location from which you are transferring stock. The program displays the location description from the location record.

  **Note:** If you are entering a transit receipt (receiving goods from a goods-in-transit location), you cannot change this field.

- **GIT Location.** If you are entering a transit transfer, enter the code for the goods-in-transit inventory location.

  If you are entering a transit receipt (receiving goods from a goods-in-transit location), you cannot change this field.

- **To location.** Specify the location to which you are transferring stock. The program displays the description is supplied from the location record.

  **Note:** If you did not select the Allow Items At All Locations option on the I/C Options screen, you must have previously specified that the item be allowed at the inventory location to which you are transferring stock.

- **Requested Quantity.** This field appears only if you are using a goods-in-transit location, and is useful when you are adding to a transfer over some period of time (for example, loading several trucks over a period of days). When you enter an amount in this field, the same amount appears automatically in the Transfer Quantity field.

  The transfer quantity cannot exceed the amount requested.

- **Unit of Measure.** Enter the unit of measure for the quantity being transferred. You can post transfers in any unit of measure defined for the item.

  **Example:** If you specified Each and Dozen as the units of measure for an item, you can post transfers using either unit of measure.

- **Outstanding Quantity.** This is the amount still required to meet the requested quantity.
- **Transfer Quantity.** Specify the number of units to transfer between locations. The requested quantity appears as the default in this field.

  **Note:** You can transfer more items than are in stock at locations if the Allow Negative Inventory Levels option is selected on the I/C Options screen.

To assign a lot number or a serialized inventory number to a transfer, click the Zoom button at the top of the Transfer Quantity column. A Lot Tracking allocation screen appears.

- **Transfer Unit.** If you want to change the unit of measure, type over it or select one from the Finder. Inventory Control automatically displays the stocking unit for the items being transferred.

- **Transferred to Date.** This is the number of units previously entered for this transfer to the GIT location.

- **Manual Proration.** This is a dollar amount to cover the item’s portion of the additional costs of the transfer. You can enter an amount only if you selected Prorate Manually as the proration method.

- **Received to Date.** This is the number of units received from the GIT location for this transfer.

- **Unit Weight, Extended Weight.** Make sure that you enter this information when transferring items that use cost proration by weight.

- **Unit Cost, Extended Cost.** These fields are used for transferring items that use the user-specified costing method.

  If you enter a unit cost, the program calculates the extended cost. If you enter an extended cost, the program calculates the unit cost.

  If you use multicurrency accounting, enter costs in your functional (home) currency.

- **Completed.** Select the completed field if you want to complete the transaction.

  **Note:** Generally, you complete a line for a GIT transfer on receipt of all goods. If you complete it before all goods are received, the unreceived items will remain in the GIT location, and you will have to create a new transfer to move them to the destination location.
Chapter 3: Entering and Posting Inventory Control Transactions

- **Comments.** Add any comments you want to appear on the Transfers Posting Journal regarding the detail line. (Optional)

- **Optional Fields.** If optional fields are set up for use in transfer details, you can enter information in the detail optional fields by selecting the detail line, and then clicking the **Optional Fields** column heading in the Detail table.

There are no restrictions on the number of detail lines you can enter on stock transfer transactions.

**About Transferring Stock Items that Use FIFO or LIFO Costing**

Inventory Control keeps track of the order in which units arrive at a location by storing their receipt date, receipt number, quantity, and extended cost in individual "buckets."

When you transfer units between locations, Inventory Control creates a bucket at the receiving location and stores the transfer number in the bucket. If, later, you want to adjust the item quantity or cost in a specific bucket created by a transfer, you can identify the bucket by the transfer number, which you can find on the Transfers Posting Journal.

**Transferring Goods between Two Inventory Locations**

Inventory Control provides two ways to transfer goods between inventory locations:

- Directly (and immediately) to the destination location.
- Via a goods-in-transit location to the destination location.

When you ship via a goods-in-transit location, all goods must be separately received at the destination location. Goods can travel on different trucks and be received in separate lots.

This topic contains instructions for direct transfers. For instructions on using a goods-in-transit location, see "Transferring Goods Using a Goods-In-Transit Location" (page 210).

**Before you start:**

- You must allow the items being transferred to be stocked at the locations to which you are transferring them.
For a list of the information entered with each transfer, see "About Transfers" (page 202).

To transfer goods directly to another inventory location:

1. Open **Inventory Control > I/C Transactions > Transfers**.

2. With ***NEW*** displayed in the Document Number field, press the Tab key to start a new transfer.

   **Tip:** If ***NEW*** does not appear, click the *New* button.

   The program automatically assigns a document number when you save or post the transaction.

   Alternatively, you can enter a new transaction number yourself, and then press Tab.

3. In the **Document Type** field, select Transfer (to move goods directly and instantly between two locations—without using a goods-in-transit location or receiving goods at the destination location).

4. If you are completing a previously entered transfer (say, to add to the number of items transferred):
   
   a. In the **Transfer Number** field, use the Finder to look up and select the number of the incomplete transfer.
   
   b. In the detail table, select the outstanding items that can now be transferred.
   
   c. Enter the additional amounts being transferred.
   
   d. Skip the remaining steps, and post or save the transaction (as in step 12).

   **Example:** If the original transfer request included 10 pallets of fertilizer, but you could only fit 5 in the truck, you can select the previous transfer, and transfer the remaining 5 pallets.

5. In the **Document Date** field, enter the date of the transfer, or select it using the calendar icon.

   Inventory Control automatically displays the session date as the default date, but you can change it. (The session date is the date that you entered when you started Sage 300 ERP.)
You can also enter a separate posting date, which determines the fiscal year and period to which a transaction is posted in the general ledger.

You can change the document date and the posting date, but you cannot directly change the fiscal period.

6. In the **Posting Date** field, enter the date to which to post the transaction in the general ledger.

7. If there are additional costs associated with the transfer (for example, shipping charges):
   a. Enter the amount of the additional costs in the **Additional Cost** field.
   b. Select a proration method.

      You can prorate by quantity, by weight, by cost, equally, or manually. Selecting Manually allows you to enter each item’s share of the additional cost in the Manual Proration field. All other options cause the program to automatically calculate amounts, and you cannot use the Manual Proration field.

8. Enter a description and reference for the transaction.

9. In the **Expected Arrival Date** field, enter the date that you expect the goods to arrive at the destination location.

10. If you use optional fields, click the Zoom button beside the Optional Fields check box to display the Optional Fields screen, where you can view or edit the optional fields assigned to this transaction.

11. For each item detail line on the receipt, in the table:
   a. Specify the item number, from and to locations, requested quantity and unit of measure, and transfer quantity.

      If the transfer quantity is less than the requested quantity, the program fills in the Outstanding Quantity when you save or post the transaction. You can create a new transfer transaction at a later time, specifying this transaction number, to complete the transfer.

      If you are working with serialized and/or lotted items, you are prompted to assign serial and/or lot numbers after specifying a quantity. For more information, see "Assigning Serial/Lot Numbers to Transfers" (page 257).

   b. If you are prorating additional costs manually, enter an amount in the **Manual Proration** field.
c. If the items use the user-specified costing method, type the unit cost and extended cost.

d. If you received all items, double-click in the **Completed** to mark the detail line as completed.

**Note:**
If you received the full requested quantity, the program automatically marks the detail Completed when you post the transaction.

If you mark a detail Complete before all goods are received, the unreceived items remain in the goods-in-transit location, and you will have to create a new transfer to move them to the destination location.

e. Enter any comments you want to add.

f. If you use optional fields, click the Optional Fields column heading to view or edit optional field information for a selected detail.

12. When you are finished, click **Post** or **Save**, and then click **OK** at the confirmation message.

- If you choose Save, Inventory Control saves the transaction so you can edit and post it later.

- If you choose Post, Inventory Control posts the transaction immediately.

**Important!** If you use the option to allow you to delete transactions after posting, Inventory Control asks if you want to delete the transaction. Click **No**, unless your company always deletes posted transactions. If you delete the posted transaction, you will not be able to drill down to the transaction details from General Ledger.

13. Make a note of the transfer number, and click **OK** at the confirmation message.

**After transferring goods to another inventory location**

1. If you saved the transactions, instead of posting them immediately:
   a. Print the transaction listings for all the transactions that you entered.
   b. Compare the listings to the original documents, and edit transactions if any need correction.
c. Use the Post Transactions screen to post transactions and update inventory quantities and costs (depending on the I/C Options you use).

2. Run Day End Processing to update Inventory Control's audit data, costing data (if you perform costing during Day End Processing), and item statistics.

3. Print the posting journal for the transactions you posted to keep as part of your audit trail.

**Transferring Goods Using a Goods-In-Transit Location**

Inventory Control provides two ways to transfer goods between inventory locations:

- Via a goods-in-transit location to the destination location.

  Note these points:
  
  - Goods-in-transit locations let you look up inventory quantities for all goods being transferred.
  - When you ship via a goods-in-transit location, all goods must be separately received at the destination location.
  - With goods-in-transit locations, goods can travel on different trucks and be received in separate lots.

- Directly (and immediately) to the destination location.

This topic contains instructions for using a goods-in-transit location. For instructions on entering direct transfers, see "Transferring Goods between Two Inventory Locations" (page 206).

**Before you start:**

- You must allow the items being transferred to be stocked at the locations to which you are transferring them.

- For a list of the information entered with each transfer, see "About Transfers" (page 202).
To transfer goods to a goods-in-transit location to be received later at another inventory location:

1. Open Inventory Control > I/C Transactions > Transfers.

2. With ***NEW*** displayed in the Document Number field, press the Tab key to start a new transfer.

   **Tip:** If ***NEW*** does not appear, click the New button.

   The program automatically assigns a document number when you save or post the transaction.

   Alternatively, you can enter a new transaction number yourself, and then press Tab.

3. In the Document Type field, select Transit Transfer (to move goods to a goods-in-transit location while they are between physical inventory locations).

4. If you are completing a previously entered transfer (say, to add to the number of items transferred):
   a. In the Transfer Number field, use the Finder to look up and select the number of the incomplete transfer.
   b. In the detail table, select the outstanding items that can now be transferred.
   c. Enter the additional amounts being transferred.
   d. Skip the remaining steps, and post or save the transaction (as in step 12).

   **Example:** If the original transfer request included 10 pallets of fertilizer, but you could only fit 5 in the truck, you can select the previous transfer, and transfer the remaining 5 pallets.

5. In the Document Date field, enter the date of the transfer, or select it using the calendar icon.

   Inventory Control automatically displays the session date as the default date, but you can change it. (The session date is the date that you entered when you started Sage 300 ERP).

   You can also enter a separate posting date, which determines the fiscal year and period to which a transaction is posted in the general ledger.
You can change the document date and the posting date, but you cannot directly change the fiscal period.

6. In the **Posting Date** field, enter the date to which to post the transaction in the general ledger.

7. If there are additional costs associated with the transfer (for example, shipping charges):
   a. Enter the amount of the additional costs in the **Additional Cost** field.
   b. Select a proration method.

   You can prorate by quantity, by weight, by cost, equally, or manually. Selecting Manually allows you to enter each item’s share of the additional cost in the Manual Proration field. All other options cause the program to automatically calculate amounts, and you cannot use the Manual Proration field.

8. Enter a description and reference for the transaction.

9. In the **Expected Arrival Date** field, enter the date that you expect the goods to arrive at the destination location.

10. If you use optional fields, click the Zoom button beside the Optional Fields check box to display the Optional Fields screen, where you can view or edit the optional fields assigned to this transaction.

11. For each item detail line on the receipt, in the table:
   a. Specify the item number, the from location, the goods-in-transit location and to location, the requested quantity and unit of measure, and the transferred quantity.

   If the transfer quantity is less than the requested quantity, the program fills in the Outstanding Quantity when you save or post the transaction. You can create a new transfer transaction at a later time, specifying this transaction number, to complete the transfer.

   If you are working with serialized and/or lotted items, you are prompted to assign serial and/or lot numbers after specifying a quantity. For more information, see "Assigning Serial/Lot Numbers to Transfers" (page 257).

   b. If you are prorating additional costs manually, enter an amount in the **Manual Proration** field.

   c. If the items use the user-specified costing method, type the unit cost
and extended cost.

d. If you received all items, double-click in the Completed to mark the detail line as completed.

**Note:**
If you received the full requested quantity, the program automatically marks the detail Completed when you post the transaction.

If you mark a detail Complete before all goods are received, the unreceived items remain in the goods-in-transit location, and you will have to create a new transfer to move them to the destination location.

e. Enter any comments you want to add.

f. If you use optional fields, click the Optional Fields column heading to view or edit optional field information for a selected detail.

12. When you are finished, click **Post** or **Save**, and then click **OK** at the confirmation message.

- If you choose Save, Inventory Control saves the transaction so you can edit and post it later.
- If you choose Post, Inventory Control posts the transaction immediately.

**Important!** If you use the option to allow you to delete transactions after posting, Inventory Control asks if you want to delete the transaction. Click **No**, unless your company always deletes posted transactions. If you delete the posted transaction, you will not be able to drill down to the transaction details from General Ledger.

13. Make a note of the transfer number, and click **OK** at the confirmation message.

**After transferring goods to a goods-in-transit location**

1. If you saved the transactions, instead of posting them immediately:

   a. Print the transaction listings for all the transactions that you entered.

   b. Compare the listings to the original documents, and edit transactions if any need correction.

   c. Use the Post Transactions screen to post transactions and update inventory quantities and costs (depending on the I/C Options you use).
2. Run Day End Processing to update Inventory Control's audit data, costing data (if you perform costing during Day End Processing), and item statistics.

3. Print the posting journal for the transactions you posted to keep as part of your audit trail.

**Receiving Goods from a Goods-In-Transit Location**

All goods that are transferred between locations using a goods-in-transit location must be received separately at the destination location.

**Before you start:**

- You must allow the items being transferred to be stocked at the locations to which you are transferring them.
- For a list of the information entered with each transfer, see "About Transfers" (page 202).

**To receive goods transferred from another location:**

1. Open **Inventory Control > I/C Transactions > Transfers**.

2. With ***NEW*** displayed in the Document Number field, press the Tab key to start a new receipt.

   **Tip:** If ***NEW*** does not appear, click the New button.

   The program automatically assigns a document number when you save or post the transaction.

   Alternatively, you can enter a new transaction number yourself, and then press Tab.

3. In the **Document Type** field, select Transit Receipt (to receive goods that are in transit between physical inventory locations).

4. In the **Transfer Number** field, enter the number assigned to the transfer that you are receiving.

   The transfer details appear on the screen.

5. In the **Document Date** field, enter the date of the receipt, or select it using the calendar icon.
Inventory Control automatically displays the session date as the default date, but you can change it. (The session date is the date that you entered when you started Sage 300 ERP).

You can also enter a separate posting date, which determines the fiscal year and period to which a transaction is posted in the general ledger.

You can change the document date and the posting date, but you cannot directly change the fiscal period.

6. In the **Posting Date** field, enter the date to which to post the transaction in the general ledger.

7. If there are additional costs associated with the transfer:
   a. Enter the amount of the additional costs in the **Additional Cost** field.
   b. Select a proration method.
      
      You can prorate by quantity, by weight, by cost, equally, or manually. Selecting **Manually** allows you to enter each item’s share of the additional cost in the **Manual Proration** field. All other options cause the program to automatically calculate amounts (and you cannot use the Manual Proration field).

8. Enter a description and reference for the transaction.

9. In the **Expected Arrival Date** field, enter the date that you received the goods.

10. If you use optional fields, click the Zoom button beside the Optional Fields check box to display the Optional Fields screen, where you can view or edit the optional fields assigned to this transaction.

11. For each item detail line on the receipt, in the table:
   a. In the **Transfer Quantity** field, accept or enter the number of items that you are receiving.
      
      If you are working with serialized and/or lotted items, you are prompted to assign serial and/or lot numbers after specifying a quantity. (For more information, see "Assigning Serial/Lot Numbers to Transfers" (page 257).)
   
   b. If you are prorating additional costs manually, enter an amount in the **Manual Proration** field.
   
   c. If the items use the user-specified costing method, type the unit cost and
Chapter 3: Entering and Posting Inventory Control Transactions

extended cost.

d. If you received all items, double-click in the Completed to mark the detail line as completed.

**Note:**
If you received the full requested quantity, the program automatically marks the detail Completed when you post the transaction.

If you mark a detail Complete before all goods are received, the unreceived items remain in the goods-in-transit location, and you will have to create a new transfer to move them to the destination location.

e. Enter any comments you want to add.

f. If you use optional fields, click the Optional Fields column heading to view or edit optional field information for a selected detail.

12. When you are finished, click **Post** or **Save**, and then click OK at the confirmation message.

- If you choose Save, Inventory Control saves the transaction so you can edit and post it later.
- If you choose Post, Inventory Control posts the transaction immediately.

**Important!** If you use the option to allow you to delete transactions after posting, Inventory Control asks if you want to delete the transaction. Click **No**, unless your company always deletes posted transactions. If you delete the posted transaction, you will not be able to drill down to the transaction details from General Ledger.

13. Make a note of the transfer number, and click OK at the confirmation message.

**After receiving goods transferred from another location**

1. If you saved the transactions, instead of posting them immediately:
   a. Print the transaction listings for all the transactions that you entered.
   b. Compare the listings to the original documents, and edit transactions if any need correction.
c. Use the Post Transactions screen to post transactions and update inventory quantities and costs (depending on the I/C Options you use).

2. Run Day End Processing to update Inventory Control’s audit data, costing data (if you perform costing during Day End Processing), and item statistics.

3. Print the posting journal for the transactions you posted to keep as part of your audit trail.

Processing Internal Usage Transactions

When you use an inventory item in your own business, you record the removal of the item from inventory by processing an internal usage transaction.

About Internal Usage Transactions

When you use an inventory item in your own business, you record the removal of the item from inventory by processing an internal usage transaction.

Example:
- You remove items from inventory to stock the store's washroom.
- An office supply company uses a desk from inventory for its own office.

If you also use Sage Fixed Assets, you can identify inventory such as office furniture, computers, and so on, as fixed assets during transaction entry. Sage 300 ERP transfers the asset information to Sage Fixed Assets. For more information, see "Identifying an Inventory Item as a Fixed Asset for Sage Fixed Assets" (page 220).

Internal Usage Transactions

Typically, when you sell inventory items, you credit the inventory account by the cost of the items sold, and you debit the cost of goods sold account.

When you record an internal usage transaction, you still credit the inventory account by the cost of the items, and you either debit an expense account or an asset account, depending on the type—or value—of the item.

For instructions on entering Internal Usage transactions, see "Using Goods Internally" (page 218).
Using Goods Internally

You may receive into inventory items and assets that you intend to use within your own company. You use the Internal Usage screen to record your company's use of inventory items.

Inventory Control lets you:

- Record the withdrawal of items from inventory for your own company's use.
  
  For example, an office supply store could take a desk from inventory for a new employee, or use office supplies, such as paper, pencils, and pens.

- Import internal usage transactions from other Sage 300 ERP databases or from non-Sage 300 ERP programs.

- Export internal usage transactions.

- Assign serial and/or lot numbers for internal usage of serialized or lotted items if you have a license to use Serialized Inventory and Lot Tracking.

If you use Sage Fixed Assets to manage the fixed assets in your company, you can also mark goods that are taken out of inventory for internal use as fixed assets. Sage 300 ERP will transfer the asset information to Sage Fixed Assets. (For more information, see "About Using Inventory Control with Sage Fixed Assets" (page 81).)

Before you start:

- Have ready all transaction information, such as the name of the person or department ordering the goods.

- Determine the internal usage numbers to use for new transactions, or have the program allocate numbers for you automatically.

- Decide whether to post each new transaction as you enter it, or save the transactions to post them later in a batch using the Post Transactions screen.

To take goods from inventory for your company's use:

1. Open Inventory Control > I/C Transactions > Internal Usage.

2. If ***NEW*** appears in the Internal usage Number field, press the Tab key to start a new transaction.

   If ***NEW*** is not displayed, click the New button.
The program automatically assigns a document number when you save or post the transaction.

**Note:** You can also enter a new transaction number yourself, and press Tab.

3. In the top part of the screen, enter header information for the transaction, as follows:
   a. Specify the date, fiscal year, and fiscal period to which to post the transaction in the general ledger.
   b. Enter an optional description and reference for the internal use transaction.
   c. Enter or select the person in your company who ordered the goods. If you use the US or Canadian Payroll module, you can choose employees from the Finder.
   d. Click the Zoom button to add optional fields for this transaction (appears only if you use optional fields).

4. In the table, using a separate line for each detail of the transaction:
   a. Specify the item number, category, location, quantity, and unit of measure.
      If you are working with serialized and/or lotted items, you are prompted to assign serial and/or lot numbers after specifying a quantity. (For more information, see "Assigning Serial/Lot Numbers for Internal Usage Transactions" (page 252).)
   b. Enter an optional comment.
   c. Enter optional fields, if you use them.

**Note:** If you are entering an asset and use Sage Fixed Assets, see "Identifying an Inventory Item as a Fixed Asset for Sage Fixed Assets" (page 220) for instructions on entering fixed asset information.

5. When you are ready, click **Save** or **Post**.
   - If you choose Save, Inventory Control saves the transaction so you can edit and post it later.
   - If you choose Post, Inventory Control posts the transaction immediately.
Important! If you use the option to allow you to delete transactions after posting, Inventory Control asks if you want to delete the transaction. Click No, unless your company always deletes posted transactions. If you delete the posted transaction, you will not be able to drill down to the transaction details from General Ledger.

6. Make a note of the transaction number, and then click OK at the confirmation message.

After recording the internal usage of items
- If you saved the transactions, instead of immediately posting them:
  - Print the Transaction Listing report to list all transactions that you entered.
  - Compare listings to original documents and edit transactions if necessary.
  - Use the Post Transactions screen to post transactions and update inventory quantities and costs (depending on the Setup options that you choose).
- Run Day End Processing to update Inventory Control’s audit data, costing data (if you cost during Day End Processing), and item statistics after posting internal usage transactions.
- Print the Transaction Listing Report or Posting Journal for internal transactions to check the transactions that you saved and posted.

Identifying an Inventory Item as a Fixed Asset for Sage Fixed Assets

Sage 300 ERP provides full integration with Sage Fixed Assets, allowing you to enter asset transactions in Inventory Control, Purchase Orders, Accounts Payable, and Intercompany Transactions.

You use the Internal Usage screen in Sage 300 ERP Inventory Control to withdraw items from inventory for use by your company (or organization) and identify them as fixed assets for Sage Fixed Assets.

Note: You must install Sage Fixed Assets and set up Sage Fixed Assets Integration before you can use this feature.
Before you start:

- Have ready all transaction information, such as the name of the person or department ordering the goods, the template used to create the asset in Sage Fixed Assets, the value of the asset for Sage Fixed Assets, and whether each asset will be tracked separately.

- Determine the internal usage numbers to use for new transactions, or have the program allocate numbers for you automatically.

To record the internal use of inventory for Sage Fixed Assets:

1. Open **Inventory Control > I/C Transactions > Internal Usage**.

2. If ***NEW*** appears in the Internal usage Number field, press the Tab key to start a new transaction.
   
   If ***NEW*** is not displayed, click the **New** button.
   
   The program automatically assigns a document number when you save or post the transaction.

   **Note:** You can also enter a new transaction number yourself, and press Tab.

3. In the top part of the screen, enter header information for the transaction, as follows:
   
   a. Specify the date, fiscal year, and fiscal period to which to post the transaction in the general ledger.
   
   b. Enter an optional description and reference for the internal use transaction.
   
   c. Enter or select the person in your company who ordered the goods. If you use the US or Canadian Payroll module, you can choose employees from the Finder.
   
   d. Click the Zoom button to add optional fields for this transaction (appears only if you use optional fields).

4. In the table, using a separate line for each detail of the transaction:
   
   a. Specify the item number for the asset you are withdrawing from inventory, location, quantity, and unit of measure, as usual.
Chapter 3: Entering and Posting Inventory Control Transactions

Tips:
- Press the Insert key to start a new line.
- Select a detail line, and then click the Detail button (or press the F9 key) to use the zoomed detail entry screen.

b. Select the Fixed Assets option, and then click the Zoom button to open the Fixed Assets screen.

c. On the Fixed Assets screen, enter information for the asset record as follows:

i. If you want to use a different template than the default, use the Finder for the Template field to select a different one.

Otherwise, either accept the default template code or clear the entry from this field. (You do not have to use a template to create the asset in Sage Fixed Assets.)

ii. In the Description field, enter the description to use for the asset in Sage Fixed Assets.

iii. If you are using more than one asset item and you want to create separate asset records for each one in Sage Fixed Assets, select the Separate Assets option.

The program allocates the fixed asset value entered on the Fixed Assets screen proportionately to each Sage Fixed Assets record it creates. For example, for a quantity of 10 and a value of $25,000, the program creates 10 asset records with a value of $2,500 each.

iv. In the Fixed Asset Quantity field, type the quantity of asset items you are removing for internal use. If working with serialized and/or lotted items, you are prompted to assign serial and/or lot numbers after specifying a quantity. (For more information, see "Assigning Serial/Lot Numbers for Internal Usage Transactions" (page 252).)

v. In the Fixed Asset UOM field, type the unit of measure for the quantity you entered.

vi. In the Fixed Asset Value field, type the value to book for the asset in Sage Fixed Assets.

5. Click Close to return to the detail entry screen.

6. Click Add.
7. When you have finished adding details for the transaction, click **Close** to return to the Internal Usage screen.

8. Click **Add**, and then click **Close**.

**After recording the internal use of inventory for Sage Fixed Assets**

1. If you saved the transactions, instead of posting them immediately:
   a. Print the transaction listings for all the transactions that you entered.
   b. Compare the listings to the original documents, and edit transactions if any need correction.
   c. Use the Post Transactions screen to post transactions and update inventory quantities and costs (depending on the I/C Options you use).

2. Run Day End Processing to update Inventory Control's audit data, costing data (if you perform costing during Day End Processing), and item statistics.


4. Print the posting journal for the transactions you posted to keep as part of your audit trail.

**About Using Optional Fields in Transactions**

Optional fields are custom fields that you can use to store additional information with Inventory Control records and transactions. You can define an unlimited number of optional fields for transaction entries and details lines, and other Inventory Control records.

Before you can use optional fields in Inventory Control transactions, you must:

- Define system-wide optional fields in Common Services.
- Set up optional fields for use in transaction headers and transaction details for individual transaction entry screens using the Optional Fields screen in the I/C Setup folder.

If you want Inventory Control to pass optional field information to General Ledger along with G/L transactions you must:

- Assign the same optional fields to Inventory Control transactions as used for the associated accounts in General Ledger. If the optional fields used for the General Ledger accounts match the detail optional fields used in Inventory
Control transactions, the optional field data can also be passed automatically to General Ledger.

- Make sure that the optional field settings indicate the type of accounts to which optional fields will be sent.

Also, if you use the same fields in Inventory Control transactions, optional field information is passed as default entries from one transaction to the next transaction in the transaction cycle—from shipments to returns, for example.

**Editing Optional Field Information in Transactions**

When you start a new transaction, Inventory Control uses the optional fields that are marked for automatic insertion in that type of transaction, and displays their default values, if any were assigned.

You can add or delete optional fields for a transaction. However, you can add only optional fields that are defined for the particular type of transaction (header) or transaction detail in the I/C Optional Fields setup screen.

- You click the Optional Fields Zoom button in the transaction header to view or edit optional fields for a selected transaction.

- You click the Optional Fields column heading or double-click the cell in the detail table to view or assign optional fields for a selected transaction detail.

You can also change the value that appears for an optional field. If the optional field is validated, you must specify a value that is defined for the optional field in Common Services. You can leave the value blank only if the optional field allows blanks. If the optional field is not validated, you can either select a value that is defined for the optional field in Common Services, or you can enter any value that is consistent with the type of optional field and that does not exceed the length specified for the field.

**Note:** Changing the information in any of these fields has no other effect on the transaction.
Using Optional Fields in Transactions

If you use Transaction Analysis and Optional Field Creator, you can use optional fields in transactions.

Optional field information from Inventory Control transactions is passed to General Ledger with G/L transactions if:

- You specified in the optional field setup record that optional field information will be passed to the General Ledger account.
- You used the same optional fields in the transaction header and transaction details as you assigned for transaction details in the General Ledger account record.

**Before you start:**

- Make sure that the optional fields you want to use in Inventory Control transactions are defined in Common Services.
- Assign optional fields to the transaction entry screen using the I/C Optional Fields setup screen.

If you want Inventory Control to pass optional field information to General Ledger along with G/L transactions:

- Assign the same optional fields to Inventory Control transactions as used for the associated accounts in General Ledger.
- Make sure that the optional field settings indicate the type of accounts to which optional fields will be sent.

**To add optional fields to a transaction header:**

**Note:** Optional fields that you assign to a transaction header apply to the transaction as a whole.

1. Open the Inventory Control transaction screen.
   
   Open **Inventory Control > I/C Transactions > Adjustments** or **Assemblies** or **Internal Usage** or **Receipts** or **Shipments** or **Transfers**.

2. Fill in the transaction header as usual, and then click the **Optional Fields** Zoom button.

   Inventory Control displays optional fields that are set up for automatic insertion in this type of transaction, along with their default values.
3. In the **Optional Field** column, click the Finder, and then select an optional field from the list that appears.

4. In the **Value** column, click the Finder, and then select a value from the list that appears. (Values are the values assigned in Common Services when the optional fields were created. If none appear, you can add a value or leave it blank.)

**To add optional fields to a transaction detail:**

*Note:* Optional fields that you assign to a detail line apply only to the particular transaction detail.

1. Open the Inventory Control transaction screen.

   Open **Inventory Control > I/C Transactions > Adjustments** or **Assemblies** or **Internal Usage** or **Receipts** or **Shipments** or **Transfers**.

2. Select an existing transaction, or enter a new one, as usual.

3. Select the detail line in the detail table.

4. Click the **Optional Fields** column heading.

   Inventory Control displays optional fields that are set up for automatic insertion in this type of transaction detail, along with their default values.

5. Using the Finders, select optional fields and values.

6. Click **Close**.

   *Note:* When you add optional fields, the entry in the Optional Fields column displays Yes and the Optional Fields check box is selected.

7. When you have finished editing the transaction, click **Save** or **Post**.

**Posting Inventory Transactions**

You can post transactions as you enter them, or you can save the transactions, and then post them together later using the I/C Post Transactions screen.

When you post transactions, the program immediately updates item quantities, so you know your inventory levels.
Before you start:

1. Enter receipts, shipments, adjustments, stock transfers, item assemblies, and internal usage transactions.

   **Note:** Click Save after entering each transaction—do not click Post.

2. Print transaction listings of transactions to check they were entered correctly.

To post inventory receipts, shipments, adjustments, transfer, assemblies, and internal usage transactions:

1. Open **Inventory Control > I/C Transactions > Post Transactions**.

2. Select the types of transactions that you want to post.

3. Use the From and To fields to specify ranges of transaction numbers to post, or accept the default ranges to post all unposted transactions.

4. Click **Process**.

5. Click **Close** at the "Posting completed" message.

   **Note:** If the program displays a message that no transactions were posted, this may mean that all transactions were posted immediately when they were entered (using the Post button).

After posting

1. Run Day End Processing to update item and sales statistics, audit information, costing data (if you cost items during day end processing), and to generate general ledger transactions.

   Depending on your program settings, posting also updates the cost of goods in stock and the cost of goods sold.

2. Print the transaction posting journals to check the transactions that you posted.

   You can also print the Transaction History report to list audit trail information. This is especially useful if you cleared the posting journal.
Chapter 3: Entering and Posting Inventory Control Transactions

Journal Entries Generated by Posting or Day-End Processing

This article describes the journal entries that are created for your general ledger when you post transactions or run day-end processing (depending on when you do item costing).

If your Inventory Control ledger is not set to generate general ledger batches during posting or day-end processing, make sure you create General Ledger batches as part of your period-end procedures.

If you do not use Sage 300 ERP General Ledger, Inventory Control creates its general ledger transactions in a file called ICGLTRAN.CSV, which can be imported by a Sage 300 ERP General Ledger at another site or transferred to another general ledger that you use. The file is in a Comma Separated Values (CSV) format.

**Note:** Inventory Control does not create invoices for Accounts Payable and Accounts Receivable. If you want to generate invoices with your Inventory Control receipts and shipments, you must use Purchase Orders and Order Entry.

Types of Journal Entries

The following types of journal entries may be created for your general ledger:

- **Receipts.** Receipt transactions debit the general ledger inventory control account, and credit the item's payables clearing account.

  When you enter the related vendor invoices in Accounts Payable, you will debit the payables clearing account for the value of the invoice, and credit the vendor's payables account. The debit to the payables clearing account clears the balance that is left in this account from posting receipts.

  If you do not enter a vendor invoice in Accounts Payable (such as when no vendor is specified on the posted receipt), you enter a cash transaction in the General Ledger that debits the payables clearing account for the cost of the goods on the receipt, and credits the cash account. The debit to the payables clearing account clears the balance that is left in this account from posting receipts.

- **Receipt returns.** Returns posted to incomplete receipts debit the payables clearing account and credit the inventory control account.

- **Shipments.** Shipment transactions debit the item's cost of goods sold account, and credit the general ledger inventory control account.
If an item's costing method is the standard method or the most recent cost method, then the item's cost variance account is debited or credited with the difference between the standard or most recent cost, and the weighted average cost of the items shipped.

When you enter the related customer invoices in Accounts Receivable, you must credit the sales accounts and the necessary tax accounts, and debit your customer accounts.

- **Sales returns.** Sales returns debit the inventory control account and credit the cost of goods sold account.

- **Non-stock shipments.** Non-stock shipments debit the cost of goods sold account and credit the non-stock clearing account.

- **Adjustments.** The journal entries that are created vary depending on the type of adjustment.
  - An adjustment cost increase debits the inventory control account and credits the adjustment write-off account you specify when you enter the adjustment.
  - An adjustment cost decrease credits the inventory control account and debits the adjustment write-off account you specify when you enter the adjustment.
  - Quantity adjustments do not create journal entries.

- **Transfers.** Stock transfer transactions both debit and credit the inventory control account specified in the item's account set, although you can set up location records in Inventory Control to override general ledger account segments that appear in the item's inventory control account.

Here is an example to show how you might override account segments:

An item's general ledger inventory control account is 1300-00, where the second segment is the location segment. You set up location1 and location2 to override the location segment of the account with 01 and 02, respectively.

If you transfer an item from location1 to location2, the program credits account 1300-01 and debits account 1300-02.

Stock transfers debit the inventory control account for the original location and credit the inventory control account for the new location.

- **Assemblies.** Assembly transactions debit the master item's inventory control account, and credit the inventory control account of each component item on the bill of material being assembled. If a fixed or variable cost is
specified on the bill of material, then the master item's assembly cost credit account is credited.

**Journal Entry Source Codes**

Each type of journal entry has a source code which is used on the G/L Transactions report. The following table lists these source codes:

<table>
<thead>
<tr>
<th>Type of Journal Entry</th>
<th>Source Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receipts</td>
<td>IC-RC</td>
</tr>
<tr>
<td>Receipt returns</td>
<td>IC-RR</td>
</tr>
<tr>
<td>Receipt adjustments</td>
<td>IC-RA</td>
</tr>
<tr>
<td>Shipments</td>
<td>IC-SH</td>
</tr>
<tr>
<td>Sales returns</td>
<td>IC-SR</td>
</tr>
<tr>
<td>Adjustments</td>
<td>IC-AD</td>
</tr>
<tr>
<td>Transfers</td>
<td>IC-TF</td>
</tr>
<tr>
<td>Assemblies</td>
<td>IC-AS</td>
</tr>
</tbody>
</table>

For more information about the G/L Transactions report, see the General Ledger help.
Chapter 4: Keeping Track of Physical Inventory

Discrepancies between item quantities maintained by the program (quantities on hand) and your physical inventory count can occur for various reasons, such as shrinkage, missing receipts, or theft.

Use the screens in the I/C Physical Inventory folder to enter the results of physical inventory counts into your system and reconcile physical inventory totals with the totals in Inventory Control.

About Physical Inventory

You use the icons in the I/C Physical Inventory folder to enter the results of physical counts into your Inventory Control system and to reconcile any differences between your physical count and the calculated quantities-on-hand in your Inventory Control system.

The physical inventory screens include:

- **Generate Inventory Worksheet.** Use the Generate Inventory Worksheet screen to generate inventory worksheets that specify the locations, account sets, and items for which you want to count inventory.

  You can use the Default Quantity On Hand option to automatically include the current quantity on hand for each item in the Quantity Counted column of the Inventory Worksheet.

  If you need to use the average cost to calculate adjustments for standard cost items, make sure that the **UseActualCostForPI** switch is set to Yes in the IC.INI file before generating a physical inventory worksheet. (For more information, see "Using Average (Actual) Cost for Physical Inventory Adjustments" (page 235).)

- **Inventory Worksheet.** Use the Inventory Worksheet to print copies of the inventory worksheets you generate, if you want to write the physical counts on them while taking stock.

  If you used the Default Quantity On Hand option in the Generate Inventory Worksheet, you can choose the Quantity option to print the current quantity on hand in the Quantity Counted column. This means that you have to enter
quantities only when the quantity counted differs from the quantity on hand stored in Inventory Control.

- **Physical Inventory Quantities** and **Inventory Counts**. Use the Physical Inventory Quantities or the Inventory Counts to enter counted item quantities. You can also assign an adjustment unit cost for items with the Physical Inventory Quantities screen, and view, edit, and delete inventory worksheets that you created.

- **Inventory Reconciliation**. Use the Inventory Reconciliation screen to print a report of the counts and costs that will be posted when you reconcile your inventory counts.

- **Post Inventory Reconciliation**. Use the Post Inventory Reconciliation screen to post the counts and costs that you entered in the Physical Inventory Quantities screen. The program creates adjustment transactions when you post inventory reconciliations.

After posting a reconciliation, print the I/C Inventory Reconciliation report to check for any items that the program could not post.

## Counting and Reconciling Inventory Quantities

This article provides an overview of the steps in the stocktaking process.

Inventory Control includes six screens to help you physically count inventory items, and then enter and post adjustments for the differences between the physical counts and the calculated quantities-on-hand in your Inventory Control system.

### To count and reconcile inventory quantities:

1. Generate inventory worksheets. For detailed instructions, see "Generating Inventory Worksheets for Stocktaking" (page 233).

2. Print the inventory worksheets that you generated. For detailed instructions, see "Printing Inventory Worksheets for Stocktaking" (page 327).

3. Count the items in stock.

4. Enter counted item quantities. For detailed instructions, see "Entering Physical Inventory Quantities" (page 236).

5. Print the Inventory Reconciliation report. For detailed instructions, see "Printing the Inventory Reconciliation Report" (page 329).
Generating Inventory Worksheets for Stocktaking

6. Post the inventory reconciliation. For detailed instructions, see "Posting an Inventory Reconciliation" (page 23).

7. Confirm that all items were posted, except those with a status of On Hold. For information about reasons items may not be posted, see "Inventory Reconciliation Errors" (page 23).

Generating Inventory Worksheets for Stocktaking

Inventory Control provides six screens to help you physically count inventory items. For an overview of the complete stocktaking process, see "Counting and Reconciling Inventory Quantities" (page 23).

You must generate worksheets in order to enter physical counts later in Inventory Control and generate adjustments. You can also print generated worksheets to help with the physical counts.

**Note:** If you generate an inventory worksheet for a location that already has a worksheet, the program replaces the old worksheet with a new one. The program warns you if there are existing worksheets for locations and lets you choose whether to replace them.

Before you start:

- Run Day End Processing to update the company's Inventory Control data if you have posted transactions since the last time you ran Day End Processing. (You should run Day End Processing even if you cost items during posting.)

- Decide on the inventory locations, account sets, and items that you want to count.

- Decide on the sorting order in which to list items on the physical inventory worksheets.

- Make sure no other users are working with the Inventory Control database and no other Inventory Control screens are open on your computer.

- If you need to use the average cost to calculate adjustments for standard cost items, make sure that the **UseActualCostForPI** switch is set to **Yes** in the IC.INI file before generating a physical inventory worksheet. (For more information, see "Using Average (Actual) Cost for Physical Inventory Adjustments" (page 235).)
Chapter 4: Keeping Track of Physical Inventory

**Warning!** To ensure quantities and costs on worksheets are current, do not post transactions (receipts, shipments, transfers, adjustments, assemblies, or internal usage), and then run Day End Processing between the time you generate inventory worksheets and the time you post the inventory reconciliation.

**To generate inventory worksheets:**

1. Open **Inventory Control > I/C Physical Inventory > Generate Inventory Worksheet**.
2. Specify the range of locations and account sets for which you require the worksheet.
3. Specify the order in which you want to list items on the worksheet.
   - This is also the method by which you will select the items that you want to list. For example, you can choose a range of item categories or item numbers, or you can select a warehouse area by choosing a range of picking sequences (bin numbers).
4. Enter an optional comment to be printed on the worksheet.
5. Specify which items you want to include on the worksheet:
   - **All Items from Inventory List**. Includes all the items in your inventory that are in the Sort By range.
   - **In Use Items Only**. Includes only the items in the Sort By range that are assigned to and have been used in one or more transactions at the locations for which you are generating worksheets.
   - **Items from Location Only**. Includes only the items in the Sort By range that are assigned to the locations for which you are generating worksheets.

   **Note:** Items are included regardless of whether they are currently allowed to be used in Inventory Control transactions.

6. Select the **Default Quantity On Hand** option if you want Inventory Control to automatically display the current quantity on hand in the Quantity Counted column in the Physical Inventory Quantities screen or the Inventory Counts screen when you enter counts in Inventory Control.
Regardless of whether or not you select this option when you generate the inventory worksheet, you can later print the current quantity on hand on Inventory Worksheets.

7. Click **Generate**, and then click **OK** from the message that appears.

**After generating inventory worksheets**

- Optionally, print inventory worksheets on which to write the physical inventory counts. (For instructions on printing this report, see "Printing Inventory Worksheets for Stocktaking" (page 327)).
- Count inventory items.
- Use the Physical Inventory Quantities screen or the Inventory Counts screen to enter physical inventory counts for inventory worksheets.

**Using Average (Actual) Cost for Physical Inventory Adjustments**

By default, Sage 300 ERP uses an item's standard cost to calculate inventory adjustments for standard cost items in the Generate Inventory Worksheet screen.

If you need to adjust inventory using the average (actual) cost, rather than the standard cost, when generating inventory worksheets, you must edit the IC.INI file before creating inventory worksheets using the Generate Inventory Worksheet screen.

**Warning!** If you are not sure whether to use average or standard cost for adjustments, do not change the default method. Consult your accountant.

**To change the method for costing physical inventory adjustments:**

1. In the Inventory Control program folder, open the IC.INI file.
2. In the Physical Inventory section, specify one of the following values for the **UseActualCostForPI** switch:
   - **No.** Specify this to use standard cost to calculate inventory adjustments.
   - **Yes.** Specify this to use average (actual) cost to calculate inventory adjustments.

The next time a user adjusts inventory using the Generate Inventory Worksheet screen, the adjustments will be based on the specified cost.
Chapter 4: Keeping Track of Physical Inventory

Entering Physical Inventory Quantities

After counting inventory, you enter physical inventory quantities on one of the following screens:

- **I/C Physical Inventory Quantities screen.** On this screen, you can enter item quantities and adjustment unit costs, compare calculated quantities to actual counts during entry, and change the posting status for individual items.

- **I/C Inventory Counts screen.** This screen is a simplified version of the I/C Physical Inventory Quantities screen, designed just for entering item quantities.

**Before you start:**

- Count inventory quantities, check unit costs, and determine whether you want to place any items on hold. (Use the Inventory Worksheet screen if you want to print worksheets on which to record counted quantities, unit costs, and posting status.)

- Use the Generate Inventory Worksheet screen to create inventory worksheets.

- Decide on the inventory locations, account sets, and items for which you want to generate worksheets.

- Decide on the sorting order in which to list items on the worksheets.

- Run Day End Processing to update the company’s Inventory Control data if you have posted transactions since the last time you ran Day End Processing.

- Make sure no other users are working with the Inventory Control database and no other Inventory Control screens are open on your computer.

**To enter physical inventory quantities:**

1. Open **Inventory Control > I/C Physical Inventory > Physical Inventory Quantities** or **Inventory Counts**.

2. Enter a location code and starting item number for the worksheet.

3. If you use optional fields, click the Zoom button to edit optional fields that apply to the whole worksheet.
4. Enter or edit inventory quantities and other information.

**Note:** If you selected the Default Quantity On Hand option on the I/C Generate Inventory Worksheet screen, the current quantities on hand are inserted for each item in the Quantity Counted column, but you can change the figures.

The information you enter may vary depending on the screen you’re using:

- **I/C Physical Inventory Quantities screen.** Enter or edit the physical count, adjustment cost, and status for each item on the worksheet.

- **I/C Inventory Counts screen.** Enter the physical count or edit the count in the Quantity Counted column.

You can also assign serial/lot numbers to items, and/or enter item quantities in multiple units of measure.

a. On the detail table, click the Zoom button or press F9.

   The I/C Quantities screen appears.

   **Note:** This screen also appears after you specify a quantity counted for items that are serialized and/or lotted.

b. On the I/C Quantities screen:

   - For serialized/lotted items, assign serial/lot numbers.

   - If more than one unit of measure is defined for an item, enter new counts for each unit of measure. (Each unit of measure is displayed, and you can enter counted quantities in any unit or combination of units.)

c. Click the navigation buttons to move to another item.

d. Click Close to save your changes and close the I/C Quantities screen.

5. If you use optional fields for item details, use the Zoom button to edit detail optional fields.

6. When you are finished, click Close to save your changes and close the screen.

**After entering physical inventory quantities**

- Use the Inventory Reconciliation screen to print the Inventory Reconciliation
report, then check the report before posting the reconciliation (optional).

- Use the Post Inventory Reconciliation screen to post the inventory reconciliation.

**Posting an Inventory Reconciliation**

When you post an inventory reconciliation, the program creates adjustment transactions for any discrepancies between your physical inventory count and the figures calculated by Inventory Control.

**Before you start:**

- Print the Inventory Reconciliation report (optional) before posting to check that the information you entered in the Physical Inventory Quantities screen is accurate for each location.

  The Inventory Reconciliation report lists the quantities and costs that the program will post the next time you use the Post Inventory Reconciliation screen. The only items that will be posted are those that have the status "Ready to post."

- You can also check item statuses by displaying the worksheet in the Physical Inventory Quantities screen.

**To post an inventory reconciliation:**

1. Open Inventory Control > I/C Physical Inventory > Post Inventory Reconciliation.

2. Specify the range of locations for which you want to post reconciliation adjustments.

3. Enter the transaction date, fiscal year, and period to which you will post the transaction.

4. Enter a reconciliation number and, optionally, a description or reference.

5. Click Post, and then click OK on the message that appears.

6. Click Close to close the Post Inventory Reconciliation screen.

**After posting an inventory reconciliation**

- Confirm that all items were posted, except those with a status of "On Hold." You can do this in the following ways:
Check the Physical Inventory Quantities screen.

If any items were not posted, the status of each item indicates the reason it was not posted.

Print the Inventory Reconciliation report.

The report lists all items that were not posted, including items that had the posting status "On hold" prior to posting. Items that were posted successfully do not appear on the report.

**Note:** If all items were posted, the Inventory Reconciliation report is blank.

For more information about inventory reconciliation errors and how to resolve them, see "Inventory Reconciliation Errors" (page 239).

- Run day end processing to update the company's costing and statistical data (this is not necessary if you cost items during posting). For more information, see "I/C Day End Processing Screen" (page 492).

- Print the Adjustments Posting Journal to check the adjustment transactions posted by the program for the reconciliation. For more information, see "I/C Posting Journals Screen" (page 534).

  **Note:** When you post an inventory reconciliation for which an adjustment number already exists, the Inventory Worksheet will create separate adjustments for every one hundred items, and append "1", "2", "3", etc. to the end of the document number.

- Delete inventory worksheets that you do not need. For example, delete worksheets that contain only items that you do not want to post.

**Inventory Reconciliation Errors**

When you post an inventory reconciliation, some items may not be posted. The status of each item that was not posted changes from "Ready to post" to a status that indicates the reason the item was not posted. The table below lists these statuses, along with information about changes you can make that will allow you to post the items.

Check each item's status to decide whether you want to make the changes needed to post the item.
**Note:** After making the changes described, use the Physical Inventory Quantities screen to change the item’s status back to “Ready to post”.

<table>
<thead>
<tr>
<th>Item Status</th>
<th>Issue</th>
<th>Resolution</th>
</tr>
</thead>
</table>
| Insufficient Quantity            | Reconciling the on-hand and counted quantities entered in the Physical Inventory Quantities screen will reduce the item’s on-hand quantity to below zero in Inventory Control. (If the Allow Negative Inventory Levels option is selected, the program does not assign this status.) | Do one of the following:  
  - Select the **Allow Negative Inventory Levels** option on the Processing tab of the I/C Options screen.  
  - On the Physical Inventory Quantities screen, change the number in the Quantity Counted column so that the sum of the quantity counted and the quantity on hand is zero or greater. |
| Item Does Not Exist              | The item record was deleted between the time you generated the worksheet and the time you posted the worksheet. | Add the item record back into Inventory Control. |
| Item Not Active                  | The Inactive option is selected in the item record. Inventory Control allows transactions to be posted only for active items. | Clear (uncheck) the **Inactive** option in the item record in the I/C Items screen. |
| Item Not Allowed at Location     | You have not assigned the item to the worksheet’s inventory location. (If the Allow Items At All Locations option is turned on, the program does not assign this status.) | Do one of the following:  
  - Allow the item to be stocked at the worksheet’s location.  
  - Select the **Allow Items At All Locations** option on the Processing tab of the I/C Options screen. |
| Non-stock Item                   | The item is a non-stock item. Inventory Control does not maintain quantities and costs for non-stock items. | Select the **Stock Item** option in the item record on the Item tab of the I/C Items screen. |
Deleting Inventory Reconciliations

Use the Physical Inventory Quantities screen to delete inventory worksheets that you do not need, such as worksheets you accidentally generated for the wrong location or worksheets with leftover items you do not want to post.

To delete an inventory reconciliation (or worksheet):

1. Open **Inventory Control > I/C Physical Inventory > Physical Inventory Quantities**.
2. Enter the location code for the inventory worksheet you want to delete.
3. Click **Delete**.
4. Click **Close** to close the Physical Inventory Quantities screen.
Chapter 5: Serialized Inventory and Lot Tracking

If you have a license to use Serialized Inventory and Lot Tracking, you can assign serial numbers and/or lot numbers to items when you process transactions in Inventory Control. You use the serial numbers and lot numbers to track items from their receipt in inventory to their sale to customers and beyond.

When you process transactions for serialized and lotted items in Inventory Control, you are prompted to allocate or generate numbers for the items.

About Serialized Inventory and Lot Tracking

If you have a license to use Serialized Inventory and Lot Tracking, you can assign serial numbers and/or lot numbers to items when you process transactions in Inventory Control. You use the serial numbers and lot numbers to track items from their receipt in inventory to their sale to customers and beyond.

Defining Formats for Serial Numbers and Lot Numbers

Before you use serial number and lot numbers in transactions, you must define formats for the numbers.

You use the Mask Structures screen to define serial number and lot number formats.

For more information, see "About Mask Structures" (page 61) and "I/C Mask Structures Screen" (page 586).

Setting Up Warranties and Contract Codes for Serialized and Lotted Items

Because high-value items often have warranties available to customers and quality guarantees from vendors, you should set up warranty codes and contract codes for use with serialized and lotted items.

For more information, see "I/C Contract Codes Screen" (page 570) and "I/C Warranty Codes Screen" (page 619).
**Options for Processing Serial Numbers and Lot Numbers**

You use the I/C Options screen to specify settings that determine how to process transactions for serialized and lotted items, including:

- Default masks to use when you add new item records for serialized and lotted items, and the separators you can use in mask structures.
- Whether you must allocate or generate numbers for all the serialized or lotted items in a transaction before you can save the transaction.
- The default number of days from receipt into inventory before serialized or lotted items expire (or "go bad," as for medicines and food items), and whether to display a warning or an error message, or no message, if you use an expired serial or lot number in a transaction.
- Whether you can use the quantity ordered (rather than the quantity shipped) when allocating serial numbers and lot numbers in Order Entry.
- How to allocate serial numbers and lot numbers when allocating numbers automatically.

For more detailed information about the settings you can choose for Inventory Control, see "I/C Options Screen" (page 588).

**Options for Serialized and Lotted Inventory Items**

You specify whether a particular item is serialized and/or lotted in the I/C Item record.

- To designate an item as serialized, you select the Serial Number option.
  
  You use the Serials tab that becomes available to specify the next serial number to assign to the item, and the codes and conditions for the warranty and contracts that apply to the serialized item. You can also override default settings, such as the serial number mask and days to expiry.

- To designate an item lotted, you select the Lot Number option.
  
  You use the Lots tab that becomes available to specify the next lot number to assign to item quantities, and the codes and conditions for the warranty and contracts that apply to the lotted item. You can also override default settings, such as the lot number mask and days to expiry.

For more information about the options you can select for serialized and lotted items, see "I/C Items Screen" (page 396).
Assigning Serial and Lot Numbers in Transactions

When you process transactions for serialized and lotted items in Inventory Control, you are prompted to allocate or generate numbers for the items.

For more information on how to assign serial and lot number in specific types of transactions, see the following topics:

- "Assigning Serial/Lot Numbers when Receiving Goods" (page 246)
- "Assigning Serial/Lot Numbers to Adjustments" (page 248)
- "Assigning Serial/Lot Numbers to Assemblies/Disassemblies" (page 250)
- "Assigning Serial/Lot Numbers for Internal Usage Transactions" (page 252)
- "Assigning Serial/Lot Numbers to Physical Inventory Quantities" (page 254)
- "Assigning Serial/Lot Numbers for Shipments" (page 256)
- "Assigning Serial/Lot Numbers to Transfers" (page 257)

Tip:
If you plan to use a bar code reader to enter serial numbers in transactions:

- Program the scanner to add a carriage return after the number.

- When you enter multiple serial numbers in transactions, first click a blank line on the Serial Number table. If you point to the Next Serial Number field when scanning a bar code, for example, you will have to click Add to add the number to the table.

Maintaining and Reporting Serial and Lot Numbers

You perform the following tasks to maintain records for serialized and lotted items:

- "Reconciling Serial Numbers and Lot Numbers" (page 266)
- "Registering Serial Numbers for Customer Warranties" (page 263)
- "Updating Warranties for Serialized and Lotted Items" (page 262)
- "Recalling and Releasing Lotted Inventory Items" (page 264)
- "Releasing Lots From Quarantine" (page 266)
- "Splitting and Combining Lots" (page 259)
Use the following reports and inquiry screens to determine the status of the serial and lot numbers in your system:

- "Printing the Serial/Lot Number List Report" (page 348)
- "Printing the Serial/Lot Number Quantity on Hand Report" (page 350)
- "Printing the Serial/Lot Stock Listing Report" (page 351)
- "Printing the Serial/Lot Transactions Report" (page 353)
- "Printing the Mask Structures Report" (page 310)
- "I/C Quarantine Report" (page 527)
- "I/C Recall Report" (page 527)
- "Printing the Warranty/Contract Codes Report" (page 323)
- "Printing the Warranty/Contract List Report" (page 359)
- "I/C Lot Number Inquiry Screen" (page 640)
- "I/C Serial Number Inquiry Screen" (page 638)

**Assigning Serial/Lot Numbers when Receiving Goods**

When receiving serialized or lotted items from suppliers, you assign serial numbers and/or lot numbers in the I/C Receipts screen to retain a full transaction history.

**Note:** You can allocate and generate serial numbers and lot numbers only if you have a license to use Serialized Inventory and Lot Tracking.

**To assign serial numbers or lot numbers to items you are receiving:**

1. Open **Inventory Control > I/C Transactions > Receipts**.
2. Enter information for the receipt, including item details, as usual.

   When you specify the quantity for a serialized or lotted item in a detail, and then tab out of the quantity field, the respective Serial/Lot Numbers Allocation or Generation screen appears. You use it to assign the required serial numbers and lot numbers to items in the detail line.

   You can also open the Serial/Lot Number Allocation/Generation screen by clicking the quantity column heading (with the Zoom button).
Assigning Serial/Lot Numbers when Receiving Goods

**Tip:** If you enter serial numbers or lot numbers manually in the following steps, make sure the numbers conform to the serial number mask or lot number mask assigned in the item record.

3. If the item is serialized, use the Serials tab to allocate serial numbers as follows:
   - To add or assign the required serial numbers to the selected item automatically, click **Auto-Gen.**
   - To add or assign one serial number at a time, in the **Next Serial Number** field, accept or change the number that appears, and then click **Add.**
   - To enter serial numbers manually, click the first line in the table (or press the Insert key to start a new line), and then use the Finder in the **Serial Number** column to select the number from a list of serial numbers available for the specified location.

4. If the item is lotted, on the Lots tab, use the **Make X Lots** field or the **Each Lot has X** field to specify the required number of lots or the required quantity in each lot, and then do one of the following:
   - To assign the required lot numbers to the selected item automatically, click **Auto-Gen.**
   - To assign lots one at a time, accept or change the number that appears in the **Next Lot Number** field, and then click **Add.**
   - To enter lot numbers manually, click the first line in the table (or press the Insert key to start a new line), and then use the Finder in the **Lot Number** column to select the lot from the list of lot numbers available for the specified location.

5. Click **Close** to return to the underlying transaction in the transaction entry screen.

**Tip:** Before you try to close the screen, refer to the count section at the bottom of the screen to make sure you have assigned the required number of serial and/or lot numbers.

6. When you have finished entering the transaction, click **Post.**

**After assigning serial numbers or lot numbers to received items**
You can use the Serial Numbers or Lot Numbers screens to update the status of the serial numbers or lot numbers you assigned to the receipt.
Example: You can add an expiry date to a serial number, or quarantine a lot.

Assigning Serial/Lot Numbers to Adjustments

When you adjust the quantity or cost of a serialized or lotted item using the I/C Adjustments screen, you assign serial numbers and/or lot numbers to maintain your audit trail.

Note: You can allocate and generate serial numbers and lot numbers only if you have a license to use Serialized Inventory and Lot Tracking.

To assign serial numbers or lot numbers to items in adjustments:

1. Open Inventory Control > I/C Transactions > Adjustments.
2. Enter the adjustment, including details for serialized or lotted items, as usual.

   When you specify the quantity for a serialized or lotted item in a detail, and then tab out of the quantity field, the respective Serial/Lot Numbers Allocation or Generation screen appears. You use it to assign the required serial numbers and lot numbers to items in the detail line.

   You can also open the Serial/Lot Number Allocation/Generation screen by clicking the quantity column heading (with the Zoom button).

   Tip: If you enter serial numbers or lot numbers manually in the following steps, make sure the numbers conform to the serial number mask or lot number mask assigned in the item record.

3. Use the Serials tab to adjust a serialized item, as follows:
   a. If you are increasing the quantity, do one of the following:
      - To add or assign the required serial numbers to the selected item automatically, click Auto-Gen.
      - To add or assign one serial number at a time, in the Next Serial Number field, accept or change the number that appears, and then click Add.
      - To enter serial numbers manually, click the first line in the table (or press the Insert key to start a new line), and then use the Finder in
Assigning Serial/Lot Numbers to Adjustments

1. **Serial Number** column to select the number from a list of serial numbers available for the specified location.

   **Note:** If you are decreasing the quantity, you follow the same procedure, except you click **Auto-Alloc** (instead of Auto-Gen), and you use the **Auto-Allocate From** field (rather than the Next Serial Number field) to allocate numbers.

2. b. If you are adjusting the cost, enter a cost adjustment value in the table for each serial number you assign or allocate.

   **Important!** The total remaining cost must be zero before you can save the detail.

4. Use the Lots tab to adjust a lotted item, as follows:

   a. If you are increasing the quantity, use the **Make X Lots** field or the **Each Lot has X** field to specify the required number of lots or the required quantity in each lot, and then do one of the following:

      - To assign the required lot numbers to the selected item automatically, click **Auto-Gen**.
      - To assign lots one at a time, accept or change the number that appears in the **Next Lot Number** field, and then click **Add**.
      - To enter lot numbers manually, click the first line in the table (or press the Insert key to start a new line), and then use the Finder in the **Lot Number** column to select the lot from the list of lot numbers available for the specified location.

   **Note:**

   If you are decreasing the quantity for a lotted item, you follow the same procedure, except you click **Auto-Alloc** (instead of Auto-Gen), and you use the **Auto-Allocate From** field (rather than the Next Lot Number field).

   Because you do not generate new lot numbers when decreasing quantities, the **Make X Lots** and **Each Lot has X** fields do not appear.

   b. If you are adjusting the cost, you must enter a cost adjustment for each lot you assign or allocate.
5. Click **Close** to return to the underlying transaction in the transaction entry screen.

**Tip:** Before you try to close the screen, refer to the count section at the bottom of the screen to make sure you have assigned the required number of serial and/or lot numbers.

6. When you have finished entering the transaction, click **Post**.

**Assigning Serial/Lot Numbers to Assemblies/Disassemblies**

You can use serialized and lotted items as components or master items when you assemble or disassemble items in Inventory Control, assigning serial numbers and/or lot numbers in the I/C Assemblies/Disassemblies screen before you post the transaction.

**Note:** You can allocate and generate serial numbers and lot numbers only if you have a license to use Serialized Inventory and Lot Tracking.

**To assign serial numbers or lot numbers to assemblies and disassemblies:**

1. Open **Inventory Control > I/C Transactions > Assemblies**.

2. Enter the assembly or disassembly transaction, as usual, and then save it.

   Inventory Control displays a Serial/Lot Numbers Generation/Allocation screen, which you use to generate or allocate serial numbers or lot numbers to items. (You generate or allocate numbers, depending on whether you are assembling or disassembling an item.)

   If you are working with an existing assembly, you can also click the **Serials/Lots** button to display the Serial/Lot Numbers Allocation/Generation screen.

   **Tip:** If you enter serial numbers or lot numbers manually in the following steps, make sure the numbers conform to the serial number mask or lot number mask assigned in the item record.

3. To work with a serialized item, use the Serials tab to assign serial
Assigning Serial/Lot Numbers to Assemblies/Disassemblies

numbers, as follows:

- To add or assign the required serial numbers to the selected item automatically, click **Auto-Gen**.
- To add or assign one serial number at a time, in the **Next Serial Number** field, accept or change the number that appears, and then click **Add**.
- To enter serial numbers manually, click the first line in the table (or press the Insert key to start a new line), and then use the Finder in the **Serial Number** column to select the number from a list of serial numbers available for the specified location.

**Note:** If you are disassembling a serialized item, you follow the same procedure, except you click **Auto-Alloc** (instead of Auto-Gen), and you use the **Auto-Allocate From** field (rather than the Next Serial Number field) to allocate numbers.

4. To work with a lotted item, use the Lots tab to assign lot numbers, as follows:

- **Lotted master items.** For a master item, you can create only one lot.
  Assign a lot number in one of the following ways:
  - To assign a lot number automatically, click **Auto-Gen**.
  - To assign a specific lot number, enter it in the **Next Lot Number** field, and then click **Add**.
  - To enter a lot number manually, click the first line in the table, and then use the Finder in the **Lot Number** column to select a lot from the list of lot numbers available for the specified location.

**Note:** If you are disassembling a lotted master item, you follow the same procedure, except you click **Auto-Alloc** (instead of Auto-Gen), and you use the **Auto-Allocate From** field (instead of the Next Lot Number field).

- **Lotted component items.** For a component item, use the **Make X Lots** field or the **Each Lot has X** field to specify the required number of lots or the required quantity in each lot, and then:
  - To assign the required lot numbers to the selected item automatically, click **Auto-Alloc**.
To assign lots one at a time, accept or change the number that appears in the **Auto-Allocate From** field, and then click **Add**.

To enter lot numbers manually, click the first line in the table (or press the Insert key to start a new line), and then use the Finder in the **Lot Number** column to select the lot from the list of lot numbers available for the specified location.

**Note:** If you are disassembling a lotted component item, you follow the same procedure, except you click **Auto-Gen** (instead of Auto-Alloc), and you use the **Next Lot Number** field (rather than the Auto-Allocate From field).

5. Click **Save** to return to the underlying transaction in the I/C Assemblies/Disassemblies screen.

**Tip:** Before you try to close the screen, refer to the count section at the bottom of the screen to make sure you have assigned the required number of serial and/or lot numbers.

6. When you have finished entering the transaction, click **Post**.

**Assigning Serial/Lot Numbers for Internal Usage Transactions**

When removing serialized or lotted items from inventory for internal use, you assign serial numbers and/or lot numbers in the I/C Internal Usage screen to retain a full transaction history.

**Note:** You can allocate and generate serial numbers and lot numbers only if you have a license to use Serialized Inventory and Lot Tracking.

**To assign serial numbers or lot numbers to items you are using in your company:**

1. Open **Inventory Control > I/C Transactions > Internal Usage**.
2. Process the internal usage transaction as usual.

When you specify the quantity for a serialized or lotted item in a detail, and then tab out of the quantity field, the respective Serial/Lot Numbers
Assigning Serial/Lot Numbers for Internal Usage Transactions

Allocation or Generation screen appears. You use it to assign the required serial numbers and lot numbers to items in the detail line.

You can also open the Serial/Lot Number Allocation/Generation screen by clicking the quantity column heading (with the Zoom button).

Tip: If you enter serial numbers or lot numbers manually in the following steps, make sure the numbers conform to the serial number mask or lot number mask assigned in the item record.

3. If the item is serialized, use the Serials tab to allocate serial numbers as follows:
   • To assign the required serial numbers to the selected item automatically, click **Auto-Alloc**.
   • To assign serial numbers in sequence starting with a certain number, select the **Auto-Allocate from** check box, specify the starting serial number in the adjacent field, and then click **Auto-Alloc**.
   • To enter serial numbers manually, click the first line in the table (or press the Insert key to start a new line), and then use the Finder in the **Serial Number** column to select the number from a list of serial numbers available for the specified location.

4. If the item is lotted, on the Lots tab, use the **Make X Lots** field or the **Each Lot has X** field to specify the required number of lots or the required quantity in each lot, and then do one of the following:
   • To assign the required lot numbers to the selected item automatically, click **Auto-Alloc**.
   • To assign lot numbers in sequence starting with a certain number, select the **Auto-Allocate from** check box, specify the starting lot number in the adjacent field, and then click **Auto-Alloc**.
   • To enter lot numbers manually, click the first line in the table (or press the Insert key to start a new line), and then use the Finder in the **Lot Number** column to select the lot from the list of lot numbers available for the specified location.

5. Click **Close** to return to the underlying transaction in the transaction entry screen.
Chapter 5: Serialized Inventory and Lot Tracking

Tip: Before you try to close the screen, refer to the count section at the bottom of the screen to make sure you have assigned the required number of serial and/or lot numbers.

6. When you have finished entering the transaction, click Post.

Assigning Serial/Lot Numbers to Physical Inventory Quantities

When updating inventory quantities for serialized or lotted items using the I/C Physical Inventory Quantities screen, you must assign serial numbers and/or lot numbers to the items to retain a full transaction history.

Note: You can allocate and generate serial numbers and lot numbers only if you have a license to use Serialized Inventory and Lot Tracking.

To assign serial numbers or lot numbers to items when you update inventory quantities:

1. Open Inventory Control > I/C Physical Inventory > Physical Inventory Quantities.

2. Process the physical inventory count as usual.

When you specify the quantity for a serialized or lotted item in a detail, and then tab out of the quantity field, the respective Serial/Lot Numbers Allocation or Generation screen appears. You use it to assign the required serial numbers and lot numbers to items in the detail line.

You can also open the Serial/Lot Number Allocation/Generation screen by clicking the quantity column heading (with the Zoom button).

Note: You generate serial and lot numbers when you are increasing the quantity, and allocate serial and lot numbers when you decrease the quantity.

Tip: If you enter serial numbers or lot numbers manually in the following steps, make sure the numbers conform to the serial number mask or lot number mask assigned in the item record.
3. Use the Serials tab to adjust a serialized item, as follows:

If you are increasing the quantity, do one of the following:

- To add or assign the required serial numbers to the selected item automatically, click **Auto-Gen**.

- To add or assign one serial number at a time, in the **Next Serial Number** field, accept or change the number that appears, and then click **Add**.

- To enter serial numbers manually, click the first line in the table (or press the Insert key to start a new line), and then use the Finder in the **Serial Number** column to select the number from a list of serial numbers available for the specified location.

**Note:** If you are decreasing the quantity, you follow the same procedure, except you click **Auto-Alloc** (instead of Auto-Gen), and you use the **Auto-Allocate From** field (rather than the Next Serial Number field) to allocate numbers.

4. Use the Lots tab to adjust a lotted item, as follows:

If you are increasing the quantity, use the **Make X Lots** field or the **Each Lot has X** field to specify the required number of lots or the required quantity in each lot, and then do one of the following:

- To assign the required lot numbers to the selected item automatically, click **Auto-Gen**.

- To assign lots one at a time, accept or change the number that appears in the **Next Lot Number** field, and then click **Add**.

- To enter lot numbers manually, click the first line in the table (or press the Insert key to start a new line), and then use the Finder in the **Lot Number** column to select the lot from the list of lot numbers available for the specified location.

**Note:**
If you are decreasing the quantity for a lotted item, you follow the same procedure, except you click **Auto-Alloc** (instead of Auto-Gen), and you use the **Auto-Allocate From** field (rather than the Next Lot Number field).

Because you do not generate new lot numbers when decreasing quantities, the **Make X Lots** and **Each Lot has X** fields do not appear.
5. Click Close to return to the underlying transaction in the transaction entry screen.

**Tip:** Before you try to close the screen, refer to the count section at the bottom of the screen to make sure you have assigned the required number of serial and/or lot numbers.

6. When you have finished entering the transaction, click Post.

**Assigning Serial/Lot Numbers for Shipments**

When shipping serialized or lotted items using the I/C Shipments screen, you assign serial numbers and/or lot numbers to retain a full transaction history.

**Note:** You can allocate and generate serial numbers and lot numbers only if you have a license to use Serialized Inventory and Lot Tracking.

**To assign serial numbers or lot numbers to items you are shipping:**

1. Open Inventory Control > I/C Transactions > Shipments.

2. Process the shipment, including details for serialized or lotted items, as usual.

   When you specify the quantity for a serialized or lotted item in a detail, and then tab out of the quantity field, the respective Serial/Lot Numbers Allocation or Generation screen appears. You use it to assign the required serial numbers and lot numbers to items in the detail line.

   You can also open the Serial/Lot Number Allocation/Generation screen by clicking the quantity column heading (with the Zoom button).

   **Tip:** If you enter serial numbers or lot numbers manually in the following steps, make sure the numbers conform to the serial number mask or lot number mask assigned in the item record.

3. If the item is serialized, use the Serials tab to allocate serial numbers as follows:
   - To assign the required serial numbers to the selected item automatically, click Auto-Alloc.
Assigning Serial/Lot Numbers to Transfers

When transferring serialized or lotted items to another location using the I/C Transfers screen, you assign serial numbers and/or lot numbers to retain a full transaction history.

Note: You can allocate and generate serial numbers and lot numbers only if you have a license to use Serialized Inventory and Lot Tracking.

To assign serial numbers in sequence starting with a certain number, select the Auto-Allocate from check box, specify the starting serial number in the adjacent field, and then click Auto-Alloc.

To enter serial numbers manually, click the first line in the table (or press the Insert key to start a new line), and then use the Finder in the Serial Number column to select the number from a list of serial numbers available for the specified location.

4. If the item is lotted, on the Lots tab, use the Make X Lots field or the Each Lot has X field to specify the required number of lots or the required quantity in each lot, and then do one of the following:

- To assign the required lot numbers to the selected item automatically, click Auto-Alloc.

- To assign lot numbers in sequence starting with a certain number, select the Auto-Allocate from check box, specify the starting lot number in the adjacent field, and then click Auto-Alloc.

- To enter lot numbers manually, click the first line in the table (or press the Insert key to start a new line), and then use the Finder in the Lot Number column to select the lot from the list of lot numbers available for the specified location.

5. Click Close to return to the underlying transaction in the I/C Shipments screen.

6. When you have finished entering the transaction, click Post.

Tip: Refer to the count section at the bottom of the screen to see what remains to be assigned. An error message will appear if you try to close the screen without assigning the required number of serial and/or lot numbers, unless the Allow Serial/Lot Quantity To Be Different From The Quantity In The Entries option is selected in the I/C Options screen.
To assign serial numbers or lot numbers to items you are transferring to another location:

1. Open **Inventory Control > I/C Transactions > Transfers**.
2. Process the inventory transfer, including details for serialized or lotted items, as usual.

   When you specify the quantity for a serialized or lotted item in a detail, and then tab out of the quantity field, the respective Serial/Lot Numbers Allocation or Generation screen appears. You use it to assign the required serial numbers and lot numbers to items in the detail line.

   You can also open the Serial/Lot Number Allocation/Generation screen by clicking the quantity column heading (with the Zoom button).

   **Tip:** If you enter serial numbers or lot numbers manually in the following steps, make sure the numbers conform to the serial number mask or lot number mask assigned in the item record.

3. Use the Serials tab to assign numbers to a serialized item, as follows:

   - To assign the required serials numbers automatically, select the **Auto-Allocate from** check box, specify a starting value in the field, then click **Auto-Alloc**.

   - To enter serial numbers manually, click the first line in the table (or press the Insert key to start a new line), and then use the Finder in the **Serial Number** column to select the number from a list of serial numbers available for the specified location.

4. Use the Lots tab to assign lot numbers to a lotted item, as follows:

   - To assign the required number of lots automatically, select the **Auto-Allocate from** check box, specify a starting value in the adjacent field, and then click **Auto-Alloc**.

   - To enter lot numbers manually, click the first line in the table (or press the Insert key to start a new line), and then use the Finder in the **Lot Number** column to select the lot from the list of lot numbers available for the specified location.

5. Click **Close** to return to the underlying transaction in the transaction entry screen.
Tip: Before you try to close the screen, refer to the count section at the bottom of the screen to make sure you have assigned the required number of serial and/or lot numbers.

6. When you have finished entering the transaction, click Post.

Splitting and Combining Lots

When working with lotted inventory items, you can split existing lots into two or more parts, or combine two lots into one. The lots must be for the same inventory item and location.

You can split or combine expired lots. However, you cannot split quarantined or recalled lots, or lots that have been assigned a contract code.

Note: You require a license for Serialized Inventory and Lot Tracking to work with lotted inventory items.

To split a lot into two or more lots:

1. Open Inventory Control > I/C Periodic Processing > Lot Splits/Combines.
2. Accept *** NEW *** as the split number, and accept Split as the type.
3. In the Item Number field, enter the number of the lotted item you want to work with.
4. In the Location field, specify where the lot you want to split is stored.
5. In the Transaction Date field, accept the default transaction date, or change the date, if necessary.
6. In the From section:
   a. In the Lot Number field, enter the lot you want to split.
   b. Specify the quantity to include in the split.
7. Use the table in the To section to specify how to split the quantities:
   a. Select existing lot(s) to which to add quantities, or create new lots by typing new lot numbers in the Lot Number column. (New lot numbers must conform to the lot number mask specified in the item record.)
Important! The total of all quantities in the Qty. Split column must equal the quantity in the Qty. to Split field in the From section, or you will not be able to post the transaction.

b. Enter an **Expiry Date**, if one is required.

c. Change the **Stock Date** of the destination lot, if necessary.

8. Click **Post** to split the lot.

**To combine two or more lots:**

1. Open **Inventory Control > I/C Periodic Processing > Lot Splits/Combines**.

2. From the **Type** list, select **Combine**.

   The Split Number field changes to Combine Number. Accept *** NEW *** as the combine number.

3. In the **Item Number** field, specify the lotted item you want to work with.

4. In the **Location** field, specify where the lots you want to combine are stored.

5. In the **Transaction Date** field, accept the default transaction date, or change the date, if necessary.

6. In the **To** section:

   a. In the **Lot Number** field, specify an existing destination lot you want to combine items into, or create a new lot by typing the new lot number in the field. (The new lot number must conform to the lot number mask specified in the item record.)

   b. In the **Qty. Combine** field, enter the quantity to move to the destination lot.

   c. Enter an **Expiry Date**, if one is required for the combined lot.

   d. Change the **Stock Date** for the destination lot, if necessary.

7. Use the table in the **From** section to specify the lots and quantities that you are combining in the destination lot.
Tracking Serialized or Lotted Item Components

You can use Serialized Inventory and Lot Tracking to track component items of a kit.

In Inventory Control, you set up item records for the serialized and/or lotted items. You also add a kitting item record for the master item, to which you assign component items.

You can then use the Order Entry program to assign serial numbers and lot numbers to the components you want to track.

**Before you start:**

- Add the kitting item record and all of the component item records.
- Set up account sets that have a user-specified costing method.

1. Open **Inventory Control > I/C Items and Price Lists > Items**.
2. For each component item of the kit that you want to track:
   a. Select the **Serial Number** or the **Lot Number** option (as needed).

   **Note:** Not all kit components require lot numbers – only those that require tracking.

   b. Click **Save** before selecting the next item.
3. After saving the change for the final component, close the I/C Items screen.
4. Open **Inventory Control > I/C Items and Price Lists > Kitting Items**.
5. Use the Finder or the navigation buttons to select the master item number for the kit.
6. In the **Kitting Number** field, assign a number, and then enter a description.
7. Click the **Go ** button.
8. Enter a comment (optional).
9. If this kit is typical of the kits you will create, select the **Use as Default** option.

10. In the table:
   - Use the Finder for the **Component Item Number** column to select components for this kit.
     - Components can be the items for which you selected the Serial Number option in step 2, or other items.
   - Enter the quantity and the unit cost for each component.

11. Click **Add** to add the kitting item, and then click **Close**.

**After adding kitting components**
Open Order Entry to assign serial numbers and lot numbers to the components that you are tracking. (See the Order Entry help for instructions.)

### Updating Warranties for Serialized and Lotted Items

You use the I/C Warranty Update screen to apply a warranty for a serialized or lotted item after a sale.

**Example:** A customer might want to purchase an extended warranty for an item, or you might sell a discounted floor model without a warranty during a clearance sale.

**Tip:** You can also apply warranties to serialized and lotted items automatically when you sell the items. (You select options to apply warranties automatically in the individual I/C item records.)

**Note:** You can update warranties for serialized and lotted items only if you have a license to use Serialized Inventory and Lot Tracking.

**Before you start:**
- Make sure a warranty code exists that has the required terms. You must specify the code when adding or updating a warranty.
- Determine the serial and/or lot number of the item and the document number of the sale.
Registering Serial Numbers for Customer Warranties

To apply or update a warranty for a serialized or lotted item:

1. Open Inventory Control > I/C Periodic Processing > Warranty Update.

2. Select Serials or Lots.

3. In the Item Number field, enter the code for the item you want to work with.

4. In the Serial Number or Lot Number field, specify the serial number or the lot number that was assigned to the item.

   When you tab out of the field, Inventory Control supplies the document number and the date of the transaction in which the serial number or lot number was allocated to the item.

5. In the Warranty Code field, select the warranty that has the terms you want to apply to the item.

6. Click Update to save your changes to the warranty.

Registering Serial Numbers for Customer Warranties

You can register serial numbers for warranty management purposes when you sell serialized inventory items, or when you receive completed registration forms from your customers.

The inventory item record for each serialized item specifies the type of warranty, and whether to place the item on warranty when it is sold or when it is registered.

**Note:** You can register warranties only for serialized items.

**Before you start:**

Find out the I/C shipment number, the O/E invoice, or the O/E debit note in which the serial number was assigned to the item.

**Note:** You must enter the number of the document that assigned the serial number when you register the serial number.

**To register a serial number for warranty purposes:**

1. Open Inventory Control > I/C Periodic Processing > Serial Registration.
Chapter 5: Serialized Inventory and Lot Tracking

2. Use the **Document Type** list and the **Document Number** field to identify the transaction that assigned the serial number.

3. In the **Item Number** field, specify the item to which the serial number was assigned.
   
   You must enter an item number that was included in the specified document.

4. In the **Serial Number** field, specify the serial number you are registering.
   
   You must specify a serial number that was assigned to the item in the specified document.

5. Click **Register**.

**After registering a serial number**

For a list of serialized items with registered warranties, generate a Serial/Lot Stock Listing report, selecting Registered as the Report Type.

---

**Recalling and Releasing Lotted Inventory Items**

If an item is recalled by your vendor, or if your customers consistently report negative experiences, you should recall the items to restrict further sales, and notify your customers.

Later, you can release recalled units that are subsequently tested and found safe or usable.

---

**Important!** Do not confuse the lot release procedure with the quarantine release procedure, which you use to release lots that are quarantined upon receipt.

---

**Note:** You can recall and release lotted inventory items only if you have a license to use Serialized Inventory and Lot Tracking.

---

**Before you start:**

- If you are recalling items, find out the number of the lot(s) you need to recall.
Recalling and Releasing Lotted Inventory Items

Tip: To obtain a list of recalls and releases, print the I/C Recall report, available from the I/C Stock Control Reports folder.

- If you are releasing items from recall, find out the recall number (assigned when the items were recalled).

  Tip: To view a list of transactions posted for a specified lot number, item and location, in the table on the I/C Lot Recalls/Releases screen, select the location, and then click Transactions.

To recall lotted inventory items:

1. Open Inventory Control > I/C Periodic Processing > Lot Recalls/Releases.
2. From the Entry Type list, select Recall.
3. In the Lot Number field, select the lot that you want to recall.
   - In the Item Number field, select the I/C item number of the lotted item you are recalling.
4. Click Post.
5. Record the recall number, which you will need to release the items if they are deemed safe and usable in future.

To release lotted inventory items from recall:

1. Open Inventory Control > I/C Periodic Processing > Lot Recalls/Releases.
2. Enter the Recall Number assigned when the items were recalled.
3. Click Post.

   The recalled items are released and available for use in Inventory Control.

Note: The lot is released from its current location. If the lot was transferred to a different location after being recalled, it is released from the new location.

After recalling or releasing items

Print the I/C Recall report by selecting File > Print in the Lot Recalls/Releases screen or using the Recall report icon in the I/C Stock Control Reports folder.


Chapter 5: Serialized Inventory and Lot Tracking

Releasing Lots From Quarantine

Lotted inventory items may be placed on quarantine if they have defects that must be resolved before the items are sold, or if you must provide paperwork and/or duties to customs authorities before the items can be used. Once the issues have been resolved, you can release the lots from quarantine.

You must release the total quantity in a quarantined lot, or no quantity.

**Before you start:**
Find out the number of the lot you want to release, or the number of the item that is included in the lot.

**To release lots from quarantine:**
1. Open Inventory Control > I/C Periodic Processing > Quarantine Release.
2. Use the **From** and **To** fields to release lots or items from quarantine, as follows:
   - Specify a range of lot numbers to release all items in that range of lots.
   - Specify a range of item numbers to release all quarantined lots for that range of items.
3. In the **As at** field, specify the effective date of release if you do not want to use the session date.
4. Click **Process** to release the specified lots or items from quarantine.

Reconciling Serial Numbers and Lot Numbers

Use the I/C Serial/Lot Reconciliations screen to reconcile serial numbers and lot numbers assigned to inventory on hand.

You should reconcile serial number and lot numbers periodically to ensure that the numbers assigned match the quantity of items on hand.

**Example:** If Inventory Control uses the options to allow the quantities in entries to be different from the serial and lot quantities, you may need to add serial or lot numbers that were not generated when you received items, or remove serial or lot numbers that were not allocated when you sold the items.
Important! Do not use the I/C Serial/Lot Reconciliation screen to enter original receipts from vendors, shipments to customers, or invoices of serialized and or lotted items. You use this screen to adjust numbers only for items already processed in inventory.

Before you start:
1. Post all transactions that affect inventory.
2. Run Day End Processing.

To reconcile serial numbers or lot numbers:
1. Open Inventory Control > I/C Periodic Processing > Serial/Lot Reconciliations.
2. Make a selection from the Transaction Type field.
   You can select from the following transaction types:
   - Use Receipt to add serial numbers or lot numbers to match the number of items on hand.
   - Use Shipment to subtract serial numbers or lot numbers to match the number of items you have on hand.
   - Use OE Invoice to change the serial numbers or lot numbers assigned when items were sold, or to add the numbers if they were not assigned.
   - Use PO Invoice to change the serial numbers or lot numbers assigned when items were received from a vendor, or to add the numbers if they were not assigned.
3. Fill in the remaining fields in the header section, as follows:
   - Apply to Document. If you selected OE Invoice or PO Invoice as the transaction type, enter the invoice number.
   - Item Number. Specify the item for which are reconciling serial numbers or lot numbers.
   - Location. Specify the location of the items.
   - Stock Date. Specify the date that the items with serial or lot numbers were received into inventory. (The default date is the session date.)
   - Quantity. Enter the quantity to reconcile.
Chapter 5: Serialized Inventory and Lot Tracking

- **Cost.** If you selected Receipt or PO Invoice as the transaction type, adjust the unit cost of the item, if necessary.

4. For a serialized item, use the Serials tab to reconcile serial numbers, as follows:

   - **If you selected Receipt or PO Invoice as the transaction type, add serial numbers.**

     Accept or change the number that appears in the Next Serial Number field, and then do one of the following:

     - To add or assign the required serial numbers to the selected item automatically, click Auto-Gen.

     - To add or assign one serial number at a time, in the Next Serial Number field, accept or change the number that appears, and then click Add.

     - To enter serial numbers manually, click the first line in the table (or press the Insert key to start a new line), and then use the Finder in the Serial Number column to select the number from a list of serial numbers available for the specified location.

     **Note:** If you click Auto-Gen or Add, the program assigns numbers sequentially starting with the number in the Next Serial Number field.

- **If you selected Shipment or OE Invoice as the transaction type, subtract serial numbers.**

  - To remove the required serial numbers automatically, select the Auto-Allocate From option, and then click Auto-Alloc. The program removes serial numbers starting with the number in the Auto-Allocate From field.

  - To remove serial numbers manually, click the first line in the table (or press the Insert key to start a new line), and then use the Finder in the Serial Number column to select a number from a list of serial numbers available for the specified location.

5. For a lotted item, use the Lots tab to reconcile lot numbers, as follows:

   - **If you selected Receipt or PO Invoice as the transaction type, add lots.**
Use the **Make X Lots** field or the **Each Lot has X** field to specify the required number of lots or the required quantity in each lot, and then do one of the following:

- To add the required lot numbers to the selected item automatically, accept or change with the next lot number, click **Auto-Gen**.
- To add lots one at a time, accept or change the number that appears in the **Next Lot Number** field, and then click **Add**.
- To add lot numbers manually, click the first line in the table (or press the Insert key to start a new line), and then use the Finder in the **Lot Number** column to select the lot from the list of lot numbers available for the specified location.

**If you selected Shipment or OE Invoice as the transaction type, subtract lots.**

- To remove the required lot numbers automatically, click **Auto-Alloc**.
- To remove lot numbers in sequence starting with a certain number, select the **Auto-Allocate from** option, specify the starting lot number in the adjacent field, and then click **Auto-Alloc**. The program removes lot numbers starting with the number in the Auto-Allocate From field.
- To enter lot numbers manually, click the first line in the table (or press the Insert key to start a new line), and then use the Finder in the **Lot Number** column to select the lot from the list of lot numbers available for the specified location.

**Note:** When reconciling a shipment, make sure you select lots that are not recalled or in quarantine, or will not be able to save the transaction.

6. Click **Post** to complete the reconciliation.
Chapter 6: Periodic Processing in Inventory Control

Use the Day End Processing screen to process transactions posted in Inventory Control, Order Entry, and Purchase Orders. Depending on options selected for your Inventory Control system, Day End Processing may update general ledger transactions, item statistics, transaction history, and item costs.

Use the other screens in the Periodic Processing folder to perform the tasks that are part of your regular period-end procedures, such as reconciling physical inventory, processing adjustments, clearing history, creating general ledger batches, and deleting inactive records.

About Periodic Processing

Inventory Control provides several tools you can use to process transactions and keep your inventory system up to date. You can perform the following periodic tasks:

- Day-end processing.
- Creating transaction batches for your general ledger.
- Clearing history data.
- Deleting inactive records.

You use the icons in the Periodic Processing folder to display the following screens for periodic processing tasks:

- **Day End Processing.** Use this screen to update statistics, cost inventory (if you choose the option to cost during day end processing) and process Order Entry and Purchase Orders transactions. Run Day End Processing before creating G/L batches, clearing history, or deleting inactive records.

- **Create G/L Batch.** If you do not use the option to create general ledger transactions during day end processing, you must use this screen to create a general ledger transaction batch. Process the batch in Sage 300 ERP General Ledger, if you use it, or post it manually to your other general ledger.
Important! If you want to print the I/C G/L Transactions report, you must print it before you create the general ledger batch. When you create the general ledger batch, Inventory Control deletes the information used to produce the I/C G/L Transactions report.

- **Clear History.** Use this screen to clear the transaction and sales data you no longer need.
- **Delete Inactive Records.** Use this screen to delete inactive records from your Inventory Control system.

If you have a license to use Serialized Inventory and Lot tracking, additional icons appear that allow you to recall and release lots, split or combine lots, reconcile serial and lot numbers, release lots from quarantine, register serial numbers, and update warranties on serialized and lotted items.

### About Day End Processing

When you post Inventory Control transactions, the program always updates the affected item quantities in your system, so you always know what you have in stock.

**Costing Inventory During Posting or During Day End Processing**

You can choose whether Inventory Control updates costing and creates transactions when you post transactions, or later, when you run Day End Processing.

**Note:** Costing inventory during posting is time consuming. To speed up processing (especially from posting orders in Order Entry), choose Costing During Day End Processing in the I/C Options screen.

### What Day End Processing Does

If you choose Costing During Day End Processing, you must run Day End Processing to update the rest of your Inventory Control data—such as item costs, general ledger transactions, item statistics, and transaction history. Each time you run day-end processing, the program processes all the transactions you have posted since the last time you ran Day End Processing.

Use the Day End Processing screen to update your Inventory Control data and the transaction and audit data for Order Entry and Purchase Orders.
Performing Day End Processing as part of your daily routine, to keep your Inventory Control audit trail and reports up to date. You can run day-end processing as many times a day as you want.

Depending on your selection for the Create G/L Transactions option on the I/C G/L Integration screen, Day End Processing either creates a batch of general ledger transactions (and optionally posts it in General Ledger), or just updates Inventory Control data so you can create the general ledger batch when you want, using the I/C Create G/L Batch screen.

If you do not use Sage 300 ERP General Ledger, or if it is at another location from Inventory Control, Day End Processing creates a batch you can import into another program, or print, and then enter manually into your general ledger.

Day End Processing also does the following:

- Updates audit trail data, which you print using the Posting Journals screen.
- Assigns the day-end number that is displayed in the Next Day End Number field on the Documents tab of the Options screen, to all the Inventory Control transactions being processed, then increases the day-end number to prepare for the next time you run Day End Processing.
- Updates costing data for all transactions.
- Updates statistics and history used by the analysis reports.
- If you are showing costs, you must perform day-end processing if you want an accurate reflection of costs for labels.
- Note that the G/L Transactions report is updated by Day End Processing only if you create the general ledger batch manually, using the Create G/L Batch screen. Note also that if you create the general ledger batch during day-end processing, you cannot print this report.

Using Sage 300 ERP Order Entry and Purchase Orders

If you use Order Entry, Purchase Orders, or both of these programs with Inventory Control, their data is also updated by running Inventory Control's Day End Processing.

Performing Day End Processing

Run day end processing as part of your daily routine, to keep your Inventory Control audit trail and reports up to date. You can run day end processing as many times a day as you want.
Day End Processing performs the following tasks:

- Optionally updates costing data from all transactions. (You can choose to update costing information during transaction posting.)

- Optionally produces general ledger journal entries from the transactions that were posted during the day. (You can choose to create G/L entries at the same time as you cost items, or you can use the Create G/L Batch screen to create G/L transactions.)

- Optionally produces other subledger journal entries from the transactions that were posted during the day. (If you cost items during posting, you can also choose to create subledger entries at the same time.)

- Always updates item statistics and transaction history for I/C, O/E and P/O (if you have them).

- Creates the posting journals for each type of transaction posted.

- Deletes completed transaction detail if you do not keep transaction history.

- Activates and posts future sales orders and purchase orders that have reached their order date, and updates quantities on sales orders and purchase orders.

- Removes quotes and purchase requisitions with expiration dates up to and including the session date for day end processing.

- Updates sales commissions.

**Note:** The tasks performed by Day End Processing vary, depending on the processing options you select on the I/C Options screen. For more information, see "I/C Options Screen" (page 588).

**Before you start:**

- Post all the transactions that you want to be processed by Day End Processing.

**Note:** Any transactions you post while Day End Processing is running will not be processed if processing has already been completed for the transaction type.
Performing Day End Processing

To be sure of processing all the day’s transactions, post them before starting day end processing. Transactions are processed in the following order:

a. Receipts
b. Adjustments
c. Transfers
d. Assemblies
e. Shipments

- Allow enough time to run Day End Processing.

The time it takes to complete day end processing varies according to your computer and the number of transactions you entered since the last time you ran Day End Processing.

**Tip:** We recommend that you run Day End Processing when you do not need to use your computer for other tasks. You might find it best to run it overnight.

- Back up your Inventory Control data.

**To perform day end processing:**

1. Open Inventory Control > I/C Periodic Processing > Day End Processing.
2. Click Process.
3. When the message appears to indicate that processing is complete, click **OK** or press Enter to close the message and the Day End Processing screen.

**After performing day end processing**

- Print the Item Valuation Report and compare it to the report that you printed earlier.

- Print the Adjustment Posting Journal to check the actual posted adjustments.

- Before posting any transactions:
  - Print the posting journals.
  - Print the G/L Transactions report if you create the general ledger batch manually (using the Create G/L Batch screen). Note that you cannot print
the G/L Transactions report in Inventory Control if you use the option to create the general ledger batch during posting or day end processing.

- Print any other reports, such as Item Valuation, Transaction Statistics, Sales Statistics, or Transaction History, that you want for updating your records.
- Modify Inventory Control account sets, categories, and other records that could affect costing, as needed.

**Processing Adjustments Automatically**

Usually, you process adjustments after printing the Item Valuation Report and finding that your costs are out of balance with inventory amounts.

**Which screen should I use to process adjustments?**

- Use the I/C Adjustments Screen to change item costs and quantities as needed.
  - To update the quantity on hand at a location to agree with your physical inventory count.
  - To return goods to a vendor after you have completed the receipt.
  - To remove additional cost remaining on a receipt when you return the total quantity received for an item at a location to the vendor.

  For more information, see "I/C Adjustments Screen" (page 643).

- Use the Post Inventory Reconciliation screen to post the counts and costs that you entered in the Physical Inventory Quantities screen. The program creates adjustment transactions when you post inventory reconciliations.

  For more information, see "I/C Post Inventory Reconciliation Screen" (page 512).

**Can I adjust material usage for a project?**

If you use Project and Job Costing, material adjustment transactions created by Project and Job Costing will appear in Inventory Control showing adjustments to particular contracts, projects, job categories and overhead accounts.

**Note:** You cannot adjust materials for jobs from the Inventory Control program.
**Before you start:**

1. Print the Item Valuation Report.
2. Physically check inventory quantities to make sure that the items will be adjusted properly.

**To process adjustments automatically:**

1. Open **Inventory Control > I/C Periodic Processing > Process Adjustments**.
2. Enter the range of item numbers for which you want to create adjustments.
3. Enter the range of locations for which you want to create adjustments.
4. Choose one of the following types of adjustments:
   - Total cost to zero for items with zero quantities.
   - Total quantity to zero for items with zero total cost.
   - Total cost for items with non-zero quantities and zero total cost.
     - If you choose this type of adjustment, you must also choose the type of cost to which you want the cost adjusted:
       - Standard cost.
       - Most recent cost (includes the tax).
       - Last Unit cost (does not include the tax).
       - User defined cost 1.
       - User defined cost 2.
5. Click **Process**.

**After processing adjustments automatically**

- Print the Item Valuation Report and compare it to the report that you printed earlier.
- Print the Adjustment Posting Journal to check the actual posted adjustments.
Clearing History

Use the I/C Clear History screen to selectively clear (remove) data from your Inventory Control system.

**Before you start:**
- Print reports to check usage.
- Assign **Inactive** status to all records you want to delete.
- Make sure the records you want to delete are not used anywhere, and update dependent records if necessary.

  For example, you cannot delete account sets, categories or locations that are used by items records, and you cannot delete a bill of material that is used as a component in a multi-level BOM.

- Run Day End Processing to update Inventory Control transactions and statistics that could affect records you want to clear. (You should run Day End Processing even if you cost items during posting.)
- Determine the fiscal year and period through which to clear transaction statistics, sales statistics, and transaction history.
- Determine the day-end number through which to clear printed posting journals, the date through which to clear serial numbers, and the receipts for which to clear printed item labels.
- For transactions:
  - Make sure that you no longer want transactions for drilldown purposes. You cannot drill down to transactions if you delete them.
  - Make sure that you want to delete the receipts. You cannot enter returns for receipts after you delete the receipt transactions.

- Print reports of the data you plan to clear. For example:
  - **Transaction History.** Print this report for transaction history.
  - **Transaction Statistics.** Print this report for transaction statistics.
  - **Sales Statistics.** Print this report for sales statistics.
  - **Contract Pricing.** Print this report for expired contract prices.
- **G/L Transactions.** If you use the I/C Create G/L Batch screen to create the general ledger batch, print this report for the journals.

  **Note:** You must print the G/L Transactions report before creating the general ledger batch.

- **Serial/Lot Transactions.** Print this report for serial/lot numbers that are assigned to shipped and returned items.

  - Print a copy of each posting journal you plan to clear.

  **Note:** When printing posting journals that you want to clear, you must use Printer or File as the printer destination.

**To clear history:**

1. Open **Inventory Control > I/C Periodic Processing > Clear History.**
2. Select the types of data you want to clear.

   You can clear the following types of data:

   - Transaction history
   - Transaction statistics
   - Sales statistics
   - Printed posting journals
   - Printed item labels
   - Expired contract prices
   - Transactions
   - Serial numbers
   - Lot numbers
   - Serial history
   - Lot history

   You can clear one or more types of data at the same time.

   For more information, see "I/C Clear History Screen" (page 488).
3. Click **Process** to clear the specified data.

**After clearing history**
Print new copies of the lists of the types of records you deleted, to update your files with current information.

**Deleting Inactive Records**

Use the I/C Delete Inactive Records screen to remove obsolete items, account sets, categories, and locations from Inventory Control.

You can delete one or more types of inactive records at the same time.

**Before you start:**

- Print reports to check usage.
- Assign Inactive status to all records you want to delete.
- Make sure that the records are not used anywhere, and update dependent records if necessary.

For example, you cannot delete account sets, categories or locations that are used by items records, and you cannot delete a bill of material that is used as a component in a multi-level BOM.

**To delete inactive records:**

1. Open **Inventory Control > I/C Periodic Processing > Delete Inactive Records**.

2. Select the types of inactive records to delete.

   **Note:** Range fields appear for each type of inactive record you select. Only records that are in the specified range are deleted.

3. In the **Inactive Dates** fields, specify a range of dates.

   Only records that were made inactive in the specified range are deleted.

   **Note:** By default, this range ends on the current session date.

   **Tip:** If you do not want to use the same date range for all types of inactive records, process each type of records separately.

4. Click **Process**.
Creating a Batch of General Ledger Transactions

After deleting inactive records
Print new copies of the lists of the types of records you deleted, to update your files with current information.

Creating a Batch of General Ledger Transactions

Use the I/C Create G/L Batch screen to create batches of general ledger transactions from posted receipts, shipments, assemblies, internal usage transactions, adjustments, and transfers.

Note: Creating G/L batches in this screen is not necessary if you create G/L transactions automatically (either when you post transactions or when you run Day End Processing). For more information about options that control how general ledger transactions are created, see "I/C G/L Integration Screen" (page 571).

If you do not use General Ledger, or if your General Ledger system is at another location, general ledger transactions created by Inventory Control are added to a file called icgltran.csv, which is located in the same directory as your company database.

The file is in Comma Separated Values (CSV) format. This file can be imported by a remote site Sage 300 ERP General Ledger or transferred to another general ledger that you use.

All general ledger transactions are placed in the same CSV file. Each time you create general ledger transactions in Inventory Control, you must choose whether to add the transactions to the file, or replace the file.

Warning! If you choose to replace the file, you will destroy all transactions that are already in the file.

Before you start:

- On the Integration tab of the G/L Integration screen, specify G/L batch creation and posting options.
- Run Day End Processing to update the company's Inventory Control data.
- If you use General Ledger, print the G/L Transactions report, then file it with your audit trail reports.
To create a batch of G/L transactions:

1. Open Inventory Control > I/C Periodic Processing > Create G/L Batch.

2. Specify the day-end number through which to create general ledger transactions. (transactions are created for all outstanding day-end numbers up to and including the number you specify.)

3. Click Process.

After creating a batch of general ledger transactions

Post the batches in General Ledger (unless they are posted automatically).

If you use a different general ledger, do one of the following:

- Import the CSV batch file into your general ledger, and then delete the original CSV file.
- Using the G/L Transactions report, transfer the entries to your general ledger manually, and then delete the CSV batch file.

About Exporting General Ledger Batches

If you do not use Sage 300 ERP General Ledger—or if your Sage 300 ERP General Ledger system is at another location—Inventory Control appends its general ledger transactions to a file called ICGLTRAN.CSV, which can be imported by a remote site Sage 300 ERP General Ledger, or transferred to another general ledger that you use. The file is in a Comma Separated Values (CSV) format, in the same directory as your company database.

Important!

General ledger transactions are placed in the same CSV file each time. When Inventory Control creates transactions, it asks whether you want to add to the file, or replace it. (Inventory Control creates general ledger transactions when you run day-end processing.)

Always append to the CSV file. If you overwrite the file, you will destroy all transactions that are already in the file.

When you are ready to transfer the batch to your general ledger, copy the file to the computer or directory where your general ledger is located, and delete the original CSV file from your Sage 300 ERP company database. Then make a backup copy of the CSV file from the computer or directory where your general ledger is located.
If you delete the original CSV file, Inventory Control creates a new ICGLTRAN.CSV file the next time it creates general ledger transactions.
Use Inventory Control Statistics and Inquiries screens to look up information about inventory items and transactions.

**Looking Up Sales Statistics**

If you selected the *Keep Item History* option on the I/C Options screen, you can view sales and return statistics kept for each item.

**To look up item sales statistics:**

1. Open *Inventory Control > I/C Statistics and Inquiries > Sales Statistics*.
2. Specify the item number, location, and year for which you want to view sales statistics.

Sales statistics appear in the table.

**Looking Up Stock Transactions**

Use the I/C Stock Transactions Inquiry screen to view opening and closing costs for a fiscal period, and to view transactions that result in movement of inventory items.

**To look up stock transactions:**

1. Open *Inventory Control > I/C Statistics and Inquiries > Stock Transactions Inquiry*.
2. Select a year and period.

**Note:** The opening and closing costs that appear in the table are calculated from the start of the year up to the period you specify.
3. Specify a range of item numbers, account sets, and locations to include in the inquiry.

**Note:** The **Quantity** and **Average Cost** columns appear in the table only if you specify a single item (by specifying the same item number in the **From** and **To** fields).

4. Click the **Go** button to view documents that match the criteria you specified.

The table displays opening and closing costs as at the year and period you selected (calculated from the start of the year up to the period you specify). It also displays information about transactions for the period, such as receipts, returns, sales, adjustments, transfers, assemblies, and internal usage transactions.

**Note:** The **Total Cost** column appears for all inquiries. The **Quantity** and **Average Cost** columns appear in the table only if you specify a single item (by specifying the same item number in the **From** and **To** fields).

5. If you want to open the I/C Stock Transactions Inquiry Detail screen and view a list of transactions that include an item (such as Purchase Orders receipts, or Order Entry shipments and invoices):

   a. Select a row, and then click **Details**.

   b. On the I/C Stock Transactions Inquiry Detail screen, if you want to view information about a transaction in a transaction entry screen, select a row, and then click the **Drilldown** button.

   c. Click **Close** to return to the I/C Stock Transactions Inquiry screen.

6. If you want to print the I/C Stock Transactions report, click **Print**. For more information, see "Printing the Stock Transactions Report" (page 356).

### Looking Up Transaction Statistics

You can view transaction statistics for the years and statistical periods for which you keep data.
To look up item transaction statistics:
1. Open Inventory Control > I/C Statistics and Inquiries > Transaction Statistics.
2. Specify the year for which you want to view transaction statistics.
Transaction statistics appear in the table.

Looking Up Sales Orders or Purchase Orders by Item

Use the I/C Item Location Details Quantity Inquiry screen to look up sales orders and purchase orders that include an item. You can filter inquiry results by location and by document type.

To look up sales orders or purchase orders that include a particular inventory item:
1. Open Inventory Control > I/C Statistics and Inquiries > Item Loc. Detial Qty Inquiry.
2. Select an item.
3. Select a location for which you want to view sales orders quantities, or select all locations.
4. Select the type of document to include in your inquiry:
   - Quantity on S/O (all sales orders).
   - Quantity on P/O (all purchase orders).
   - Quantity Committed (documents where the item has been committed for the order).
5. Click the Go button to view documents that match the criteria you specified.
6. To open an order in a transaction entry screen and view additional order details, select a row, and then click the Details button.
Looking Up Current Order Entry and Purchase Orders Transactions

Use the I/C Current Transactions Inquiry screen to look up the following information for an item:

- Current sales orders originating in Order Entry.
- Purchase orders originating in Purchase Orders.

To look up Order Entry and Purchase Orders transactions:

1. Open **Inventory Control > I/C Statistics and Inquiries > Current Transactions Inquiry**.
2. Specify an item number.
3. Specify whether to inquire about purchase orders or sales orders.
4. Specify a range of orders, as follows:
   - For sales orders, specify a range of expected shipping dates.
   - For purchase orders, specify a range of expected arrival dates.
5. Click the Go button to view orders that match the criteria you specified.

The following information appears in the table:

Sales order information
- Order number
- Customer number
- Customer name
- Expected ship date
- Location
- Original quantity ordered
- Unit of measure
- Quantity shipped
• Quantity outstanding

Purchase order information
• Purchase order number
• Vendor number
• Vendor name
• Expected arrival date
• Location
• Quantity ordered
• Unit of measure
• Quantity received
• Quantity outstanding

6. To see more information about a transaction, select a row in the table, and then click the Details button to view the transaction in a transaction entry screen.

Looking Up Serial Number Information

If you use Serialized Inventory and Lot Tracking, you can use the I/C Serial Number Inquiry screen to look up serial numbers by criteria such as item number, location, stock date, and status.

To look up serial number information:

1. Open Inventory Control > I/C Statistics and Inquiries > Serial Number Inquiry.

2. Specify a range of serial numbers, items, locations, and stock dates.

3. Select the status of serial numbers about which to inquire. You can inquire on available numbers, unavailable numbers, or both.

4. Click the Go button to view documents that match the criteria you specified.
5. When viewing serial number information in the table, you can select a row and view the following information about a serial number:

- **Details.** View details for the selected serial number on the I/C Serial Numbers screen. For more information, see "I/C Serial Numbers Screen" (page 481).

- **Transactions.** View a list of transactions for the selected serial number on the I/C Serial Number Transaction Inquiry screen. For more information, see I/C Serial Number Transaction Inquiry Screen.

6. If you want to print the I/C Serial/Lot List report, click **Print.**

### Looking Up Lot Number Information

If you use Serialized Inventory and Lot Tracking, you can use the I/C Lot Number Inquiry screen to look up lot numbers by criteria such as item number, location, stock date, and status.

**To look up lot number information:**

1. Open **Inventory Control > I/C Statistics and Inquiries > Lot Number Inquiry.**

2. Specify a range of lot numbers, items, locations, and stock dates.

3. Select the status of lot numbers about which to inquire. You can inquire on available numbers, unavailable numbers, or both.

4. Click the Go button to view documents that match the criteria you specified.

5. When viewing lot number information in the table, you can select a row, and then view the following information for a lot number:

- **Details** (to view details for the selected lot number on the I/C Lot Numbers screen). For more information, see "I/C Lot Numbers Screen" (page 482).

- **Transactions** (to view a list of transactions for the selected lot number on the I/C Lot Number Transaction Inquiry screen). For more information, see "I/C Lot Number Transaction Inquiry Screen" (page 642).
Looking Up Transaction History

Use the I/C Transaction History Inquiry to view transactions created in Sage 300 ERP Order Entry, Purchase Orders or Inventory Control.

To look up transactions:

1. Open Inventory Control > I/C Statistics and Inquiries > Transaction History Inquiry.
2. Select a year and period.
3. Specify a range of item numbers, account sets, and locations to include in the inquiry.
4. Click the Go button to view documents that match the criteria you specified.
   Items that match the criteria you specified are displayed in the table.
5. If you want to open the I/C Transaction History Inquiry Detail screen and view a list of transactions that include an item:
   a. Select a row, and then click Details.
   b. On the I/C Transaction History Inquiry Detail screen, if you want to view information about a transaction in a transaction entry screen, select a row, and then click the Drilldown button.
   c. Click Close to return to the I/C Transaction History Inquiry screen.
6. If you want to print the I/C Transaction History report, click File > Print.
For more information, see "I/C Transaction History Report" (page 542).

Note: While you are able to enter fractional quantities into lots, Inventory Control may round the amount up or down to the nearest whole number, which can result in discrepancies when reporting lot amounts and costs on the I/C Lot Number Inquiry and I/C Lot Numbers screens.
Looking Up Bills of Material by Component

Use the BOM Component Usage Inquiry screen to:

- View all bills of material in which a component item appears.
- View bills of material details for BOMs that include the selected component item.

**To look up BOMs that include a particular component item:**

1. Open **Inventory Control > I/C Statistics and Inquiries > BOM Component Usage Inquiry**.
2. Specify the number of the component item that you want to review.

The following details are displayed for each BOM in which the component appears:

- Master item number
- Master BOM number
- Description of the BOM
- Build quantity
- Master unit of measure
- Component’s quantity in the build
- Component’s BOM number if the component is also a master item.

3. To view complete BOM details, select the row with the master item number and BOM number that you want to review, and then click the **Details** button.

Looking Up Costs of LIFO and FIFO Items

Use the I/C LIFO/FIFO screen to look up the costs of received, shipped and available items that use LIFO or FIFO costing by item and by location.
To look up the costs of LIFO and FIFO items on particular transactions:

1. Open Inventory Control > I/C Statistics and Inquiries > LIFO/FIFO Inquiry.

2. Select the account set or sets (LIFO or FIFO) for which you want to view information.

3. Specify an item number or range of item numbers.

4. Select a location or locations.

5. Click the Go button to view items that match the criteria you specified.

6. To see more information about an item, select a row in the table, and then click the Details button.

   The following information is displayed for the item:

   - Document number
   - Date
   - Quantity received and cost
   - Quantity shipped and cost
   - Quantity available and cost

   Below the table, additional information is displayed about items that have not yet been processed by Day End Processing.

7. To return to the LIFO/FIFO Inquiry screen, click the Close button.
Chapter 8: Printing Inventory Control Reports

Use Inventory Control report screens to print setup reports, stock control reports, and analytical reports.

Inventory Control Reports

Inventory Control Reports are divided into the following categories:

- **Setup reports.** These reports list the information entered to define your Inventory Control system:
  - "Printing the Account Sets Report" (page 302)
  - "Printing the Alternate Items Report" (page 303)
  - "Printing the Bills of Material Report" (page 304)
  - "Printing the Categories Report" (page 306)
  - "Printing the Customer Details Report" (page 307)
  - "Printing the G/L Integration Report" (page 308)
  - "Printing the Item Structures Report" (page 309)
  - "Printing the Mask Structures Report" (page 310)
  - "Printing the Kitting Items Report" (page 311)
  - "Printing the Location Details Report" (page 312)
  - "Printing the Locations Report" (page 313)
  - "Printing the Manufacturers’ Items Report" (page 314)
  - "Printing the Optional Fields Report" (page 315)
  - "Printing the Options Report" (page 316)
  - "Printing the Price List Codes Report" (page 317)
Chapter 8: Printing Inventory Control Reports

- "Printing the Reorder Quantities Report" (page 318)
- "Printing the Segment Codes Report" (page 319)
- "Printing the Units of Measure Report" (page 321)
- "Printing the Vendor Details Report" (page 321)
- "Printing the Weight Units of Measure Report" (page 324)
- "Printing the Warranty/Contract Codes Report" (page 323)

- **Stock Control reports.** These reports provide you with status information, and also allow you to print item labels and bin/shelf labels:
  - "Printing the Aged Inventory Report" (page 331)
  - "Printing Bin/Shelf Labels" (page 333)
  - "Printing the Inventory Movement Report" (page 335)
  - "Printing Item Labels" (page 336)
  - "Printing the Item Status Report" (page 338)
  - "Printing the Item Valuation Report" (page 340)
  - "Printing the Overstocked Items Report" (page 342)
  - "Printing the Reorder Report" (page 346)
  - "Printing the Stock Transactions Report" (page 356)
  - "Printing the Slow Moving Items Report" (page 354)
  - "Printing Transfer Slips" (page 357)
  - "Printing the Serial/Lot Transactions Report" (page 353)
  - "Printing the Serial/Lot Number Quantity on Hand Report" (page 350)
  - "I/C Recall Report" (page 527)
  - "Printing the Serial/Lot Number List Report" (page 348)
  - "Printing the Serial/Lot Stock Listing Report" (page 351)
About Audit Trail Reports

- "Printing the Warranty/Contract List Report" (page 359)
- "I/C Quarantine Report" (page 527)

- **Price/Sales Analysis reports.** These reports interpret, analyze, and summarize your data:
  - "Printing the G/L Transactions Report" (page 362)
  - "I/C Contract Pricing Report" (page 531)
  - "Printing the Markup Analysis Report" (page 364)
  - "Printing Posting Journals" (page 365)
  - "Printing the Price Lists Report" (page 368)
  - "Printing the Sales Statistics Report" (page 369)
  - "Printing the Selling Price/Margin Analysis Report" (page 371)
  - "Printing the Transaction History Report" (page 372)
  - "Printing the Transaction Statistics Report" (page 374)

- **Transaction reports.** This report lists the details of saved or posted transactions:
  - "I/C Transaction Listing Report Screen" (page 557)

- **Physical Inventory reports.** These reports allow you to enter the results of an inventory count and reconcile inventory totals:
  - "I/C Inventory Reconciliation Report" (page 516)
  - "I/C Inventory Worksheet Report" (page 515)

**Note:** If you have a multicurrency ledger, some reports can include source and functional-currency (home-currency) information.

**About Audit Trail Reports**

You can trace any transaction from source to general ledger entry if you:
- Carefully maintain and identify source documents.
- Print and file each posting journal as it is created.
Print the G/L Transactions report after running Day End Processing, but before you create the general ledger batch. (This does not apply if your Inventory Control system is set up to create general ledger batches when you run Day End Processing.)

**Posting Journals**

Each time you run Day End Processing, Inventory Control creates a journal of the entries from the transactions you posted since the last time you ran Day End Processing.

These posting journals provide a record of all posted details and of the general ledger distributions they generated.

**About Posting Journals**

A posting journal is the printed record of the transactions that were processed together during day-end processing.

You can print the following types of posting journals, one for each transaction type you can post in Inventory Control:

- Adjustments
- Assemblies
- Receipts
- Shipments
- Internal usage
- Transfers

For instructions on printing posting journals, see "Printing Posting Journals" (page 365).

For details about the information that is printed on each type of posting journal, see "I/C Posting Journals Screen" (page 534).

**Report Printing Options**

You can print Sage 300 ERP data in a variety of reports to view key information. Printed reports also serve as a source of backup information in case your data is damaged on your computer.
Sage 300 ERP provides four destinations for printing reports. You can:

- Print to a physical printer, to create permanent copies of the information.
- Print to a preview on your screen, for quick review.
- Print to a file that you can save, print later, import into another program, or transfer to other electronic media.
- Print to e-mail, to send a report as an e-mail attachment.

For instructions on specifying the print destination for Sage 300 ERP reports, see "Selecting a Print Destination" (page 299).

If you print reports to a physical printer, you can also specify a particular printer to use for printing a report. For instructions, see "Selecting a Printer for Reports" (page 300).

**Selecting a Print Destination**

You can print reports to a printer, to the screen, to a file, or as an attachment to an e-mail message.

**Note:** If you are not assigned to a security group that has authorization to change the print destination, the only destination available is a physical printer.

**To select a print destination:**

1. On the Sage 300 ERP Desktop menu, click **File > Print Destination**.
2. Select a print destination:
   - **Printer.** Print to a physical printer.

**Note:** If you have multiple printers, you can specify the one to use when you print. For more information, see "Selecting a Printer for Reports" (page 300).

**Tip:** If you want to confirm the destination printer, page size, and orientation each time you print a report, on the Desktop, click **View > Preferences**, and then select **Confirm on print**.
Preview. Display reports in a preview screen.

Note: From the preview screen, you can do things such as saving the report to a file, or printing the report to a physical printer.

File. Print to a file.

When you print, you specify details about the file to create, including:

- Format (for example, PDF, DOC, or XLS).
- Destination.
- Name.
- Location.

E-mail. Print reports as attachments to e-mail messages.

You specify the type of file to create:

- Adobe Acrobat (PDF). You can open PDF files with Adobe Acrobat Reader (available as a free download from the Adobe Software website).
- Rich Text Format (RTF). You can open RTF files with most Windows and Linux word processing programs.

When you print a report, Sage 300 ERP creates a PDF or RTF version of the report and attaches the report file to a new e-mail message.

3. Click OK.

Selecting a Printer for Reports

When your print destination is Printer, Sage 300 ERP prints reports to the Windows default printer, unless you have assigned a specific printer to a report.

The ability to assign different printers to different reports at print time means that you are not limited to printing to the default printer. For example, you can use a different printer to print item labels than you use to print inventory worksheets.
To assign a specific report to a specific printer:

1. Open the report screen that you want to assign to a printer.
2. On the report screen, click File > Print Setup.
   
   The program displays the Windows default printer, but you can change the printer for a specific report.
3. Select the Specific Printer option, and then select from the list the printer to use for this report.
   
   The printer list includes all printers that have been added to the Printers and Faxes list in Windows.
4. Select a paper source if you want to use a particular paper tray or paper stock for this report.
5. Click OK to close the Print Setup screen.

To clear the assigned printer for a specific report:

1. On the Sage 300 ERP desktop, select (highlight) the icon for the report.
2. On the Desktop Object menu, click Restore Defaults, or right-click the report icon, and then click Restore Defaults on the list that appears.
3. In the Restore Defaults dialog box, select the Print Settings option, then click OK.
   
   The print setup for that report is reverted to the desktop default.

To have the program prompt you to specify a printer and print options each time you print:

On the Sage 300 ERP Desktop View menu, click Preferences > Confirm On Print.

Printing Setup Reports

Setup reports provide the following information:

- The options you selected in the I/C Options screen and G/L Integration screen.
- Records that you added to set up your Inventory Control system, such as account sets, item categories, price list codes, inventory locations, item
number structures and segment codes, units of measure, weight UOMs, and optional fields.

- Additional item information such as item location details, alternate items, bills of material, kit components, manufacturers' item numbers (e.g. bar codes), customer details (item numbers), and reorder quantities.

**Printing the Account Sets Report**

The I/C Account Sets report lists descriptions and numbers of the general ledger accounts in your Inventory Control account sets, and the costing method used by each account set.

**To print the Account Sets report:**

1. Open **Inventory Control > I/C Setup Reports > Account Sets**.

2. Specify the range of account sets you want to print. The default range includes all account sets.

3. Click **Print**.

- If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.

- If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

  **Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

- If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:

  - **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.

  - **Disk file.** Save the report to a location you specify.

  - **Microsoft Mail.** Send the report as an e-mail attachment.
You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing the Alternate Items Report**

The I/C Alternate Items report lists the numbers of items to which alternate items are assigned, together with the numbers and descriptions of the corresponding alternate items.

You can print the report by item numbers, categories, item number segments, optional fields, and vendor numbers.

**To print the Alternate Items report:**

1. Open **Inventory Control > I/C Setup Reports > Alternate Items**.

2. Specify the order in which to list item numbers that include alternate items.
   - **Item Number.** List items that have alternates in order by the primary item numbers.
   - **Category.** Group all items that have alternates by the item categories specified for the report.
   - **Item Segment.** List only items that contain the specified segment in their item numbers and that have alternate items, grouped by each of the segment codes in the specified range.
   - **Optional Field Entries.** List all items that have alternates by the contents of the selected optional field. These choices appear only if you have added optional fields to the I/C Items screen.

3. Specify the range of item numbers, categories, segments, or optional field entries to include in the report.

4. Click **Print.**
   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.
   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.
Chapter 8: Printing Inventory Control Reports

Note: For Web-based clients, the preview screen appears first when you click the Print button.

- If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
  - Application. View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
  - Disk file. Save the report to a location you specify.
  - Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the Bills of Material Report

The I/C Bills Of Material report lists the component items and quantities required to build the master items in your Inventory Control system.

Before you start:
If you want to include the latest costing information, run Day End Processing before printing the report.

To print the Bills Of Material report:
1. Open Inventory Control > I/C Setup Reports > Bills of Material.
2. Specify the order in which to list bills of material records.
   - Item Number. List bills of material in order by master item numbers.
   - Category. Group all bills of material by the item categories specified for the report.
• **Item Segment.** List all bills of material by item numbers that contain the specified segment, grouped by the specified range of segment codes.

• **Optional Field Entries.** List bills of material by the contents of the selected optional field. These options appear only if you have added optional fields to the I/C Bills of Material screen using the I/C Optional Fields setup screen.

3. Specify the range of item numbers, categories, segments, or optional field entries to include in the report.

4. To include the unit cost and assembly cost for each of the component items and the total assembled cost (based on the average actual cost), select **Include Costs for Each Item**, and then specify a location in the **Location** field that appears.

5. To list all components for items that are themselves built from subassemblies, select **Include Component BOMs.**

The report will list components of subassemblies immediately below the master component item.

6. Click **Print.**

   • If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK.** Otherwise, click **Cancel** or **Setup.**

   • If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

   **Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

   • If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:

     ○ **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.

     ○ **Disk file.** Save the report to a location you specify.

     ○ **Microsoft Mail.** Send the report as an e-mail attachment.
You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing the Categories Report**

The I/C Categories report lists the information entered to define the category codes you use to group inventory items.

**To print the Categories report:**

1. Open **Inventory Control > I/C Setup Reports > Categories**.
2. Specify a range of category codes to include in the report.
3. Click **Print**.

- If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.

- If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

**Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

- If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
  - **Application**. View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
  - **Disk file**. Save the report to a location you specify.
  - **Microsoft Mail**. Send the report as an e-mail attachment.
You can enter the name of a non-existent file or directory to be created by
the system when you print. When you print to a file, the report is assigned
a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report
  attached.

**Printing the Customer Details Report**

The I/C Customer Details report lists customer item numbers and inventory
item numbers that they identify.

**Note:** This report includes details only for customers that are assigned to
items on the I/C Customer Details screen. The report will be blank if you have
not entered customer item numbers.

**To print the Customer Details report:**

1. Open *Inventory Control > I/C Setup Reports > Customer Details*.
2. Specify whether to sort customer item numbers by customer or by item
   number.
3. Specify the range of customer numbers and item numbers to include in the
   report.
4. Click **Print**.
   - If you are printing to a physical printer, the Print window appears.
     Confirm your printer selection and the number of copies to print, and then
click **OK**. Otherwise, click **Cancel** or **Setup**.
   - If you are printing to the screen (preview), the report appears in a new
     window. You can print the report or export it to a file.

**Note:** For Web-based clients, the preview screen appears first when
you click the **Print** button.

- If you are printing to a file, the Export window appears. Specify the file
  format (for example, PDF, DOC, or XLS). Also, specify a destination for
  the file:
  - **Application.** View the report in an application that can open files of the
    specified format (for example, if you specify PDF as the file format, the
report opens in Adobe Acrobat). You can then save the file.

- **Disk file.** Save the report to a location you specify.
- **Microsoft Mail.** Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing the G/L Integration Report**

The I/C G/L Integration report lists the General Ledger transaction and batch creation options and other information you entered on the G/L Integration screen to specify how your Inventory Control system sends transactions to General Ledger.

**To print the G/L Integration report:**

1. Open **Inventory Control > I/C Setup Reports > G/L Integration**.
2. Click **Print**.

   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.

   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

     **Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

   - If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:

     - **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
Disk file. Save the report to a location you specify.

Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing the Item Structures Report**

The I/C Item Structures report lists the information you entered in your Inventory Control system to format item numbers.

**To print the Item Structures report:**

1. Open Inventory Control > I/C Setup Reports > Item Structures.
2. Specify a range of item structures to include in the report.
3. Click Print.
   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click OK. Otherwise, click Cancel or Setup.
   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

   **Note:** For Web-based clients, the preview screen appears first when you click the Print button.

   - If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
     - Application. View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
     - Disk file. Save the report to a location you specify.
     - Microsoft Mail. Send the report as an e-mail attachment.
You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

### Printing the Mask Structures Report

**Note:** The Mask Structures report is available only if you have a license to use Serialized Inventory and Lot Tracking.

This report lists the different serial and lot number formats that were created in "I/C Mask Structures Screen" (page 586).

**To print the Mask Structures report:**

1. Open **Inventory Control > I/C Setup Reports > Mask Structures**.

2. In the **From Mask Structure** and **To Mask Structure** fields, specify a range of structures to include on the report, or accept the default selections to include all mask structures.

3. Click **Print**.

- If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.

- If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

**Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

- If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:

  - **Application**. View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
Disk file. Save the report to a location you specify.

Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the Kitting Items Report

The Kitting Items report prints all kits defined in Inventory Control, or a range you specify.

To print a list of kitting items:

1. Open Inventory Control > I/C Setup Reports > Kitting Items
2. Specify the order in which to list kitting items in the report.
3. If you are sorting the report by item segment, select the item segment.
4. Specify the range of kits to include in the report.
5. If you want to print costs for each item, select Include Costs for Each Item, and then specify a location in the Location field that appears.
6. Click Print.

   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click OK. Otherwise, click Cancel or Setup.
   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

   **Note:** For Web-based clients, the preview screen appears first when you click the Print button.

   - If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
     - Application. View the report in an application that can open files of the
specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.

- **Disk file.** Save the report to a location you specify.
- **Microsoft Mail.** Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing the Location Details Report**

The I/C Location Details report lists information for items at each location where you allow the items to be stocked.

**Before you start:**
If you want to include the latest costing information, run Day End Processing before printing the report.

**To print the Location Details report:**
1. Open **Inventory Control > I/C Setup Reports > Location Details**
2. Specify whether to sort location detail records by item number or location.
3. Specify a range of item numbers and locations to include in the report.
4. Select the type of location details to print.
5. Click **Print**.

- If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.
- If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

**Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.
• If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
  ○ **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
  ○ **Disk file.** Save the report to a location you specify.
  ○ **Microsoft Mail.** Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

• If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing the Locations Report**

The I/C Locations report lists the information entered to define the inventory locations used in Inventory Control.

**To print the Locations report:**

1. Open **Inventory Control > I/C Setup Reports > Locations**
2. Specify a range of locations to include in the report.
3. Click **Print**.

• If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.

• If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

**Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.
If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:

- **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.

- **Disk file.** Save the report to a location you specify.

- **Microsoft Mail.** Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing the Manufacturers' Items Report**

The I/C Manufacturers' Items report lists the information for manufacturers' item numbers (such as bar codes) that have been added for your inventory items.

**To print the Manufacturers' Items report:**

1. Open **Inventory Control > I/C Setup Reports > Manufacturers' Items**

2. Specify whether to sort the report by item numbers or by manufacturers' item numbers.

3. Specify a range of item numbers and of manufacturers' item numbers to include in the report.

4. Click **Print.**

   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK.** Otherwise, click **Cancel** or **Setup.**

   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.
**Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

- If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
  - **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
  - **Disk file.** Save the report to a location you specify.
  - **Microsoft Mail.** Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing the Optional Fields Report**

The Optional Fields report lists the optional field codes used in your Inventory Control program, along with their descriptions, default values, and other settings.

**To print the Optional Fields report:**

1. **Inventory Control > I/C Setup Reports > Optional Fields.**

2. If you want to include account settings with optional fields used with transaction details, select **Show Settings.**

   The report will indicate the general ledger and other subledger accounts to which optional field information is passed.

3. Click **Print.**

   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK.** Otherwise, click **Cancel** or **Setup.**

   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.
Note: For Web-based clients, the preview screen appears first when you click the **Print** button.

- If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
  - **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
  - **Disk file.** Save the report to a location you specify.
  - **Microsoft Mail.** Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

### Printing the Options Report

The Options report lists the selected options and other information you entered in the Options screen to specify how your Inventory Control system operates.

For more information on the contents of this report, see "I/C Options Report" (page 552).

**To print the Options report:**

1. Open **Inventory Control > I/C Setup Reports > Options.**
2. Click **Print.**

   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK.** Otherwise, click **Cancel** or **Setup.**

   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.
Printing the Price List Codes Report

The Price List Codes report lists codes you defined to identify your company's price lists.

For more information on the contents of this report, see "I/C Price List Codes Report" (page 553).

To print the Price List Codes report:

1. Open Inventory Control > I/C Setup Reports > Price List Codes.
2. Enter a range of price list codes.
3. Click Print.

   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click OK. Otherwise, click Cancel or Setup.
   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.
Note: For Web-based clients, the preview screen appears first when you click the Print button.

- If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
  - Application. View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
  - Disk file. Save the report to a location you specify.
  - Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

### Printing the Reorder Quantities Report

The Reorder Quantities report lists the maximum and minimum item quantities permitted at your locations during each period. The report also shows the number of units you usually order at a time and the number of units you expect to sell in each period.

The report includes only items for which you have entered reorder information in the Reorder Quantities screen.

For more information on the contents of this report, see "I/C Reorder Quantities Report" (page 553).

**To print the Reorder Quantities report:**

1. Open Inventory Control > I/C Setup Reports > Reorder Quantities.
   You can also click File > Print in the Reorder Quantities screen.

2. Use the From Item Number and To Item Number fields to specify a range of item numbers to include in the report.
3. In the **Reorder Quantities for** field, specify whether to print reorder quantities for all locations, for a specific location, or for specific and all locations.

4. If you are printing reorder quantities for a specific location, or for specific and all locations, use the **From Location** and **To Location** fields to specify a range of locations to include in the report.

5. To print optional fields that are assigned to reorder quantity records for each item, select the **Include Optional Fields** option.

6. Click **Print**.
   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.
   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.
     
     **Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

   - If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
     - **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
     - **Disk file.** Save the report to a location you specify.
     - **Microsoft Mail.** Send the report as an e-mail attachment.

     You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

   - If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing the Segment Codes Report**

The Segment Codes report lists the segments used in your Inventory Control system and the segment codes and corresponding descriptions used with each
segment.

For more information on the contents of this report, see "I/C Segment Codes Report" (page 554).

**To print the Segment Codes report:**

1. Open **Inventory Control > I/C Setup Reports > Segment Codes**.
2. Specify whether to list all your Inventory Control segments and segment codes, or a specific segment.
3. If you selected Specific Segment, specify the segment and a range of codes assigned to the segment.
4. Click **Print**.
   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.
   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

   **Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

   - If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
     - **Application**. View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
     - **Disk file**. Save the report to a location you specify.
     - **Microsoft Mail**. Send the report as an e-mail attachment.

   You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

   - If you are printing to e-mail, an e-mail message appears with the report attached.
Printing the Units of Measure Report

The Units of Measure report lists the information entered to define the units of measure used in your Inventory Control system.

For more information on the contents of this report, see "I/C Units of Measure Report" (page 555).

To print the Units of Measure report:

1. Open Inventory Control > I/C Setup Reports > Units of Measure.
2. Click Print.
   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click OK. Otherwise, click Cancel or Setup.
   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

   **Note:** For Web-based clients, the preview screen appears first when you click the Print button.

   - If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
     - **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
     - **Disk file.** Save the report to a location you specify.
     - **Microsoft Mail.** Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the Vendor Details Report

The Vendor Details report lists vendors from whom you purchase inventory items and the items each supplies. The report includes only the vendors you
have assigned to Inventory Control items in the I/C Vendor Details screen. The report will be blank if no vendors are assigned to items.

For more information on the contents of this report, see "I/C Vendor Details Report" (page 555).

**To print the Vendor Details report:**

1. Open **Inventory Control > I/C Setup Reports > Vendor Details**.

2. Make selections in the following fields:

   - **Sort by.** Specify the order in which to list vendor information for item records. You can print by the vendor numbers, or you can print vendor information by item category codes, Inventory Control item numbers, segment codes, or the entries in any of the optional fields you assigned to items in the I/C Optional Fields screen.

   - **From [ ] To [ ].** Specify the range of vendor numbers, categories, item numbers, segments, or optional field entries to include in the report.

3. Click **Print**.

   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.

   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

     **Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

   - If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:

     - **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.

     - **Disk file.** Save the report to a location you specify.

     - **Microsoft Mail.** Send the report as an e-mail attachment.
You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing the Warranty/Contract Codes Report**

**Note:** The Warranty/Contract Codes is available only if you have a license to use Serialized Inventory and Lot Tracking.

This report lists the Contract Codes and Warranty Codes that are defined in your Inventory Control system. It is useful when you are setting up new codes, and want to know which ones are currently used.

**Tip:** If you want a report of specific serialized or lotted items with assigned warranties and contracts, print the Warranty/Contract List report, available in the I/C Stock Control Reports folder.

**To print the Warranty/Contract Codes report:**

1. Open **Inventory Control > I/C Setup Reports > Warranty/Contract Codes**.

2. From the **Report Type** list, select Contract Codes or Warranty Codes.

3. Use the **From** and **To** fields to select a range of codes to print, or accept the default selections to print all contract codes or warranty codes.

4. Click **Print**.

- If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.

- If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

**Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.
If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:

- **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.

- **Disk file.** Save the report to a location you specify.

- **Microsoft Mail.** Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

### Printing the Weight Units of Measure Report

The Weight Units of Measure report lists the information entered to define the weight units of measure used in your Inventory Control system.

For more information on the contents of this report, see "I/C Weight Units of Measure Report" (page 556).

**To print the Weight Units of Measure report:**

1. Open **Inventory Control > I/C Setup Reports > Weight Units of Measure**.
2. Click **Print**.

- If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.

- If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

**Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.
If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:

- **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.

- **Disk file.** Save the report to a location you specify.

- **Microsoft Mail.** Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

If you are printing to e-mail, an e-mail message appears with the report attached.

### Printing Physical Inventory Reports

Use the following reports when reconciling actual (physical) inventory quantities to your records in Inventory Control:

- "I/C Inventory Reconciliation Report" (page 516). Use the I/C Inventory Reconciliation report to compare physical inventory counts with the totals in your Sage 300 ERP Inventory Control system.

- "I/C Inventory Worksheet Report" (page 515). Use the I/C Inventory Worksheet report to record inventory quantities when taking a physical count of inventory. You enter these quantities into Inventory Control to prepare for inventory reconciliation.

### Printing the Inventory Worksheet

You can print an Inventory Worksheet report to fill out when taking a physical count of inventory. Enter the total quantities for each unit of measure to prepare for inventory reconciliation.

For more information on the contents of this report, see "I/C Inventory Worksheet Report" (page 515).

**Before you start:**

- Run Day End Processing if you want to include the latest costing information
in the report.

- Generate a worksheet for each location you want to include in the report, using the Generate Inventory Worksheet screen.

**To print the Physical Inventory Worksheet:**

1. Open **Inventory Control > I/C Physical Inventory > Inventory Worksheet**.

2. Make your selections as follows:
   - **From Location [ ] to [ ].** Enter location codes or use the Finder to select the range of locations at which you want to count inventory.
   - **Include.** Select the information to include in the report.
   - **Unit Cost.** Prints the unit cost for each item on the worksheet.
   - **Quantity on Hand.** Prints the quantity on hand for each unit of measure defined for each selected item.
   - **Comment.** Select this option to include a comment line for each item. Use the comment line to record remarks while doing the physical count.
   - **Inactive Items.** Select this option to include inactive items.

8. Click **Print**.

   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.

   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

   **Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

   - If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:

     - **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
Disk file. Save the report to a location you specify.

Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing Inventory Worksheets for Stocktaking**

For an overview of the complete stocktaking process, see "Counting and Reconciling Inventory Quantities" (page 232).

**Important!** You must generate worksheets before you can print them.

**Before you start:**

- Run Day End Processing to update the company's Inventory Control data.

- Create inventory worksheets for each location using the Generate Inventory Worksheet screen.

**To print inventory worksheets:**

1. Open Inventory Control > I/C Physical Inventory > Inventory Worksheet.

2. Make your selections as follows:

   From Location [ ] to [ ]. Enter location codes or use the Finder to select the range of locations at which you want to count inventory.

   Include. Select the information to include in the report.

   - Unit Cost. Prints the unit cost for each item on the worksheet.

   - Quantity. Prints the quantity on hand for each unit of measure defined for each selected item.

   You can print the current quantity on hand in the Quantity Counted column—whether or not you chose the Default Quantity On Hand choice when you generated the inventory worksheet.
Chapter 8: Printing Inventory Control Reports

- **Comment.** Includes space for a comment for each item. Use the comment line to record remarks while doing the physical count.

- **Inactive Items.** Includes inactive items.

  This option is selected by default. If you have many inactive items, you can reduce the length of the worksheet by not selecting this option.

3. Click **Print.**

- If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK.** Otherwise, click **Cancel** or **Setup.**

- If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

  **Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

- If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:

  - **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.

  - **Disk file.** Save the report to a location you specify.

  - **Microsoft Mail.** Send the report as an e-mail attachment.

    You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

    If you are printing to e-mail, an e-mail message appears with the report attached.

**After printing inventory worksheets**

- Count inventory items.

- Use the Physical Inventory Quantities screen or the Inventory Counts screen to enter physical inventory counts for inventory worksheets.
• Print the Inventory Reconciliation report again to check for any items that the program could not post.

**Printing the Inventory Reconciliation Report**

The Inventory Reconciliation report lets you compare actual physical inventory totals with the totals in your Sage 300 ERP Inventory Control system. The report identifies discrepancies between item quantities and costs, and shows what will be posted by the Post Inventory Reconciliation screen.

For more information on the contents of this report, see "I/C Inventory Reconciliation Report" (page 516).

**Before you start:**
Run Day End Processing if you want to include the latest costing information in the report.

**To print the Inventory Reconciliation report:**
1. Open **Inventory Control > I/C Physical Inventory > Inventory Reconciliation**.
2. Make your selections in the following fields:

   **From Location [ ] To [ ].** Specify the range of locations to include in the report.

   **Show Only Items with Quantity Variance.** Select this option to list only those items that show a variation between the quantity on hand recorded in Inventory Control and the physical count you entered in the Physical Inventory Quantities screen. The report then excludes items for which the totals are the same in Inventory Control as in your physical count.

   **Show Only Items with Serial/Lot Quantity Variance.** Select this option to show only those items that have a variance between the quantity counted and the serial/lot numbers assigned. The report will exclude items for which the quantity counted equals the numbers assigned.

   **Include Comment for Each Item.** Select this option to print a blank comment line for each item listed in the report.

   **Include Inactive Items.** Select this option to include inactive items. This option is selected by default. If you have many inactive items, you can reduce the length of the worksheet by not selecting this option.

   **Include [ ] .** Select from two types of report.
Chapter 8: Printing Inventory Control Reports

- **All Units of Measure.** The report lists quantities counted for each unit of measure.

- **Stocking Unit Only.** The report lists total quantities counted in the stocking unit of measure only.

3. **Click Print.**

- If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.

- If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

**Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

- If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
  
  - **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.

  - **Disk file.** Save the report to a location you specify.

  - **Microsoft Mail.** Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing Stock Control Reports**

Stock Control reports can help you manage your inventory by providing detailed information about your inventory items.

If you use Serialized Inventory and Lot Tracking, you can generate reports that provide details about serialized and lotted items.
Printing the Aged Inventory Report

The report prints the net changes in item quantities and costs for a set of four aging periods specified by the user at print time.

**Note:** Depending on the options chosen at print time, the report can be printed in a detailed or summary version. The detailed version prints all individual transactions affecting item quantities and costs. The summary version prints only the totals of the net changes for each period.

For information on the contents of this report, see "I/C Aged Inventory Report" (page 519).

To print the report

1. Open *Inventory Control > I/C Stock Control Reports > Aged Inventory*.
2. Make your selections in the following fields:

   **Age Transactions As Of.** Specify the date on which to report the inventory. The program uses this date to assign transactions to aging periods. For example, if you print the report by due date, the program assigns each transaction to an aging period by calculating the number of days between its due date and the Age As Of date.

   **Cutoff By.** The report includes only those transactions that have a document date or a fiscal period before or on the cutoff date you specify. There are two methods for selecting a cutoff date.

   - **Document Date.** Use this method if you want to include all transactions up to a specific date that is not the fiscal period end date. Enter a date in the Cutoff Date field. If you enter zeros for the month, day, and year, the report includes all transactions, regardless of date.

   - **Year/Period.** Use this method if you want to include all transactions up to the end of a fiscal period. Make your selections in the Year and Period fields.

   **Print Separate or Consolidated Locations.** If you select Separate Locations, the report prints each location on a new page. If you select Consolidated Locations, the report prints a single total for each item for all locations (within the range you specify).
**Print Transactions In.** Indicate whether to print a Summary or detailed report (one that prints only one line per item, or one that includes all transactions).

**Start Date.** Specify the date of the oldest transactions that you want to have printed on a detail report.

**Include.** Specify whether you want all net totals to be printed, or print only positive, negative, zero, or non-zero net changes in costs and in quantities.

**From/To.** Indicate the ranges of account sets, locations, and item numbers that you want to include in the report. You can also select a range of values for the field that you use to sort the report.

**Sort By.** You can choose to sort the report by item category, item segment, or by optional field value. You can also choose a range of values for the sort field.

**Use Aging Periods.** The aging periods entered in the I/C Options screen appear here, but you can assign different periods for the report, if you wish.

3. Click **Print**.

- If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.

- If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

  **Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

- If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
  - **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
  - **Disk file.** Save the report to a location you specify.
• **Microsoft Mail.** Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

• If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing Bin/Shelf Labels**

These instructions are for printing labels for the bins or shelves where you store items at your inventory locations.

To print labels such as price tags or bar codes labels that you can attach to items, use the I/C Item Labels report screen in the Stock Control Reports folder. For instructions on printing the report, see "Printing Item Labels" (page 336).

You can print bin or shelf labels to attach to the bins or shelves where you store inventory items.

For more information on the contents of this report, see "I/C Bin/Shelf Labels Screen" (page 520).

**Before you start:**

• Find out which report file to use for printing labels.

  For example, you might have different labels for different stores, warehouses, or types of goods within your warehouse.

• Run Day End Processing if you want to include the latest costing information on the labels.

**To print bin/shelf labels:**

1. Open **Inventory Control > I/C Stock Control Reports > Bin/Shelf Labels.**

2. Make your selections for the following fields:

   **Location.** Select the location.

   **Currency.** If you use multicurrency accounting, select the currency of the price list for which you want to print labels.
Use Label. Enter the name of the file, including the RPT file extension, that contains the format for the labels you want to print, or choose the default filename.

If you do not know the file name or the location of the file you want to use, click the Browse button to select from the list of your directories and files.

Price List. Select a price list for the labels.

Sort by. Specify the order in which to generate labels.

From [ ] to [ ]. Specify the range of item numbers, categories, segments, or optional field entries to include in the label run.

Note: To print a test sheet of labels to test the alignment of the forms in your printer, click the Align button. This button is available only if the printing destination is Printer.

3. Click Print.

- If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click OK. Otherwise, click Cancel or Setup.

- If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

Note: For Web-based clients, the preview screen appears first when you click the Print button.

- If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:

  - Application. View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.

  - Disk file. Save the report to a location you specify.

  - Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.
If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing the Inventory Movement Report**

The Inventory Movement report shows the quantities and extended costs of inventory items that were received into stock and shipped out of stock during the period that you specify.

The report displays the stock activity showing each transaction in and out of stock for the period. Users can group items in all locations together or display items in each location separately.

For information on the contents of this report, see "I/C Inventory Movement Report" (page 520).

**To print the report:**

1. Choose the Inventory Movement Report icon from the Stock Control Reports folder.

2. Make your selections in the following fields:

   **Select Transactions By.** There are two methods for selecting a cutoff date.

   **Document Date.** Use this method if you want to specify transactions for a specific range of dates.

   **Year/Period.** Use this method if you want to include all transactions up to the end of a fiscal period. Make your selections in the Year and Period fields.

   **Print Separate or Consolidated Locations.** If you select Separate Locations, the report prints each location on a new page. If you select Consolidated Locations, the report prints a single total for each item for all locations (within the range you specify).

   **Report Currency.** In a multicurrency ledger, choose whether you want to see amounts in source and functional currency.

   **From/To.** Indicate the ranges of account sets, locations, and item numbers that you want to include in the report. You can also select a range of values for the field that you use to sort the report.
**Sort By.** You can choose to sort the report by item category, item segment, or by optional field value. You can also choose a range of values for the sort field.

3. Click **Print**.

- If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.
- If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

**Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

- If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
  - **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
  - **Disk file.** Save the report to a location you specify.
  - **Microsoft Mail.** Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing Item Labels**

These instructions are for printing labels, such as price tags or bar codes, that you can attach to items when you receive them from your suppliers, and to items already in your inventory.

You can print labels for items at any time—for example, to replace damaged labels or to update item descriptions and pricing information.
To print labels for the bins or shelves where you store items at your inventory locations, use the Bin/Shelf Labels screen.

For information on the contents of this report, see "I/C Item Labels Screen" (page 521).

**Before you start:**

- If you want to print labels for items you receive, choose Require Labels when you receive inventory items, and make sure that your receipt detail lines include the number of labels that you need.

  Inventory Control automatically generates item labels when you post receipts and then run Day End Processing.

- Find out which report file to use for printing labels.

  For example, you might have different labels for bar codes and for price tags.

**To print item labels:**

1. Open **Inventory Control > I/C Stock Control Reports > Item Labels**.

2. Make your selections in the following fields:

   - **For Each Item [ ]**. Use this field to select the items for which you want to print labels.

   - **Use Label**. Enter the name of the file (including the file extension) that contains the format for the labels you want to print, or choose the default filename.

     If you do not know the file name or the location of the file you want to use, click the **Browse** button to select from the list of directories and files.

     If you choose to print labels for each item received, make your selections.

     If you choose to print labels for each item on file or in stock, specify the label format in the **Use Label** field as described earlier, then make your selections.

   - **From [ ]To [ ]**. Specify the range of item numbers, categories, segments, picking sequences, or optional field entries to include in the label run.

3. You can print either the labels or a sheet of dummy labels to test your format and the alignment of label forms in your printer.
To print a test sheet of labels to check the alignment of the forms in your printer, click the Align button. This button can only be clicked if the printing destination is Printer.

4. Click Print.

- If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click OK. Otherwise, click Cancel or Setup.
- If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

**Note:** For Web-based clients, the preview screen appears first when you click the Print button.

- If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
  - Application. View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
  - Disk file. Save the report to a location you specify.
  - Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing the Item Status Report**

Use the Item Status report to print the information entered for each item in the I/C Items screen, as well as the quantities on hand at your inventory locations. If you use the Keep Item Statistics option, the report also shows shipment and receipt statistics for each item.

For more information on the contents of this report, see "I/C Item Status Report" (page 522).
To print the Item Status report:

1. Open **Inventory Control > I/C Stock Control Reports > Item Status**.

2. Make your selections in the following fields:

   - **From Account Set [ ] to [ ].** Enter a range or use the Finder to select a range of account sets for the report.

   - **Sort by.** Specify the order in which to list item records. You can choose:
     - **Item Number.** Lists items in order by item numbers.
     - **Category.** Groups all items by the item categories specified for the report.
     - **Item Segment.** Lists all items that contain the specified segment in their item numbers, grouped by the specified range of segment codes.
     - **Optional Field Entries.** Lists all items by the contents of the selected optional field. These choices appear only if you have added optional fields to the I/C Items screen.

   - **From [ ] To [ ].** Specify the range of item numbers, categories, segments, or optional field entries to include in the report.

   - **Print.** Specify the type of items to include on the report. You can choose all items, only active items, or only inactive items.

   - **Include.** For each item included in the report, print all or a combination of the information entered in the item record (Profile, Unit of Measure, Taxes, Additional Item Information, Optional Fields, Vendors), as well as the quantities on hand at each location, total quantities on hand, item statistics (if you use the option to keep statistics) and FIFO or LIFO costing information. If you have serialized or lotted items in inventory you can choose to include them in the report as well.

3. Click **Print**.

   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.

   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

   **Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.
If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:

- **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
- **Disk file.** Save the report to a location you specify.
- **Microsoft Mail.** Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing the Item Valuation Report**

The Item Valuation report shows the value of inventory quantities on hand, calculated for the items, locations, costs, or optional fields you select for the report.

For more information on the contents of this report, see "I/C Item Valuation Report" (page 523).

**Before you start:**

Run Day End Processing if you want to include the latest costing information in the report.

**To print the Item Valuation report:**

1. Open **Inventory Control > I/C Stock Control Reports > Item Valuation**.

2. Specify the type of valuation report that you want to print.
   - Select **Location Detail Costs** to print the current value of your inventory using all data stored in costing buckets.
   - Select **Transaction Costs** to print all transactions and item costs for the period you specify (from receipts, shipments, transfers). For each
item, the report includes opening inventory costs, transaction amounts and costs, and closing inventory costs.

3. Make your selections in the following fields:

Select Transactions by Cutoff Date or Fiscal Year/Period. If you select Transaction Costs, you also select the date range or period range for printing transaction information.

Print [ ] in [ ]. Select the method of presenting the information on the report.

Print Transaction Details (if using transaction costs). If you selected Transaction Costs instead of Location Details Costs in the first field, you can print the details for all of the transactions in the range that you specified.

Include [ ] Quantities and Costs. Select which quantities and costs to print.

From Account Set [ ] to [ ]. Enter a range or use the Finder to select a range of account sets by which to select items for the report.

From Location [ ] to [ ]. Enter a range or use the Finder to select a range of locations from which to include items on the report.

Sort by. Specify how you want item records sorted.

From [ ] to [ ]. Specify the range of item numbers, categories, segments, or optional field entries to include in the report.

Select up to 4 Costing Methods for Valuation. Each costing method you select adds a column to the report.

4. Click Print.

- If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click OK. Otherwise, click Cancel or Setup.

- If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

Note: For Web-based clients, the preview screen appears first when you click the Print button.
If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:

- **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.

- **Disk file.** Save the report to a location you specify.

- **Microsoft Mail.** Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

### Printing the Overstocked Items Report

The Overstocked Items report lists each item at each location for which the quantity on hand (plus the quantity on PO minus the quantity on sales order) exceeds the maximum or project sales quantity assigned for the item and location.

You can report item quantities for locations that are over the maximum level or over the projected sales figures entered for the items in the Reorder Quantities screen. You can include cost figures on the report to see the costs of carrying the extra inventory items.

Use the Annualized Turn And Earn Ratio version of this report to find out how many times your company's average inventory was sold during the year to date. The report also shows the profit margin, total sales, and total cost for each item in the year to date.

For more information on the contents of this report, see "I/C Overstocked Items Report" (page 525).

**Before you start:**

- Run Day End Processing if you want to include the latest costing information in the report.
• To print meaningful data on some versions of this report, you must first enter figures for the items in the Reorder Quantities screen.

To print the Overstocked Items report:

1. Open Inventory Control > I/C Stock Control Reports > Overstocked Items.
2. Make your selections as follows:
   - **Sort by.** Specify the order in which to list item records.
   - **From [ ] To [ ].** Specify the range of item numbers, categories, segments, or optional field entries to include in the report.
   - **From Location [ ] to [ ].** Enter a range or use the Finder to select a range of locations.
   - **Print Items with.** Select the criterion you want to use to determine whether items are overstocked.
3. Click **Print.**
   • If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK.** Otherwise, click **Cancel** or **Setup.**
   • If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

   **Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

• If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
  - **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
  - **Disk file.** Save the report to a location you specify.
  - **Microsoft Mail.** Send the report as an e-mail attachment.
You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing the Quarantine Report**

The I/C Quarantine report lists the lot numbers that are currently on quarantine, as well as the expected release date, lot quantity, and lot cost.

---

**Note:** This report is available only if you have a license to use Serialized Inventory and Lot Tracking.

---

**To print the Quarantine report:**

1. Open **Inventory Control > I/C Stock Control Reports > Quarantine**.
2. In the **Lot Number From** and **To** fields, specify a range of lots to include on the report, or accept the default selections to include all lots.
3. In the **Item Number From** and **To** fields, specify a range of item to print on the report.
4. In the **Location From** and **To** fields, specify a range of locations. Items and lots that are not at these locations do not appear on the report.
5. In the **Quarantine Date From** and **To** fields, specify a range of quarantine dates to include on the report. Lots quarantined before or after these dates do not appear on the report.
6. Click **Print**.

   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.

   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

---

**Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.
If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:

- **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
- **Disk file.** Save the report to a location you specify.
- **Microsoft Mail.** Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

### Printing the Recall Report

The I/C Recall report lists the lots that are currently on recall or have been released from recall, and information related to those lots.

**Note:** This report is available only if you have a license to use Serialized Inventory and Lot Tracking.

**To print the Recall report:**

1. Open **Inventory Control > I/C Stock Control Reports > Recall.**
2. In the **Sort By** field, specify whether to sort the report by Customer/Vendor Number, Item Number, or Recall Number.
3. In the **Recall Number From** and **To** fields, specify a range of recall numbers to include on the report, or accept the default selections to print the report for all recall numbers.
4. In the **Item Number From** and **To** fields, specify a range of items to include on the report.
5. Use the **Customer Number From** and **To** fields to specify a range of customers to include on the report. Customers who have bought recalled goods, but are outside the range, will not appear on the report.
6. In the **Vendor Number From** and **To** fields, specify one or more vendors. The report will list the lots purchased from these vendors that are or have been on recall.

7. In the **Location From** and **To** fields, specify the range of locations to include on the report.

8. In the **Recall Date From** and **To** fields, specify a range of recall dates for the report.

9. Click **Print**.
   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.
   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

   **Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

   - If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
     - **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
     - **Disk file.** Save the report to a location you specify.
     - **Microsoft Mail.** Send the report as an e-mail attachment.

     You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

   - If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing the Reorder Report**

The Reorder report lists items that are out of stock or have low quantities on hand at the selected locations. It also lists the suggested reorder quantity,
estimated cost to replenish, and names of the usual suppliers you assigned for each item on the report.

**Tip:** Compare the report to the Reorder Quantities report to check maximum quantities and projected sales for each period, to determine whether you need to order exactly the reorder quantity shown for each item.

For more information on the contents of this report, see "I/C Reorder Report" (page 528).

**To print the Reorder report:**

1. Open **Inventory Control > I/C Stock Control Reports > Reorder**.
2. Make your selections in the following fields:
   - **Report Type.** Choose whether to list reorder information for specific locations or for all locations.
   - **Show Location Quantities.** If you selected All Locations as the report type, specify whether to print quantities for each location.
   - **From Location [ ] to [ ].** If you selected Specific Locations as the report type, select a range of locations to include in the report.
   - **For Quantities [ ].** Specify criteria for selecting records.
   - **Cost.** Specify whether to print most recent costs or vendor costs.
   - **Sort by.** Specify the order in which to list item records, and then specify a range of records in the From and To fields.
   - **From [ ] to [ ].** Specify the range of item numbers, categories, segments, or optional field entries to include in the report.
3. Click **Print**.
   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click OK. Otherwise, click Cancel or Setup.
   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

**Note:** For Web-based clients, the preview screen appears first when you click the Print button.
If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:

- **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.

- **Disk file.** Save the report to a location you specify.

- **Microsoft Mail.** Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

### Printing the Serial/Lot Number List Report

**Note:** The Serial/Lot Number List report is available only if you have a license to use Serialized Inventory and Lot Tracking.

This report lists the serial numbers and lot numbers used for each lotted or serialized inventory item. You can sort reports by serial/lot number, location, or item number.

**To print the Serial/Lot Number List report:**

1. Open **Inventory Control > I/C Stock Control Reports > Serial/Lot Number List**.

2. In the **Print** list, select whether to print the report for lot numbers or serial numbers.

3. In the **Report Type** field, specify whether to print a summary or a detail report.

   Summary reports show the serial/lot numbers assigned to the selected items, location, status, stock dates, and serial/lot cost.

   Detail reports provide additional transaction information, including any optional fields used.
4. In the first **Select By** list, specify whether to select records by Item Number, Serial/Lot Number, or Customer Number.

Use the **From** and **To** fields to specify the range of numbers to appear on the report.

5. In the second **Select By** list, optionally specify whether to select records also by Vendor Number, Sold Date, Location, or Expiry Date.

Use the **From** and **To** fields to specify the range you want to appear on the report.

6. If necessary, make a selection from the third **Select By** list, and then specify the range of records to appear on the report.

7. In the **Sort By** list, specify whether to sort the information by serial or lot number, item number, or location.

8. Click **Print**.

   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.

   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

   **Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

   - If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:

     - **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.

     - **Disk file.** Save the report to a location you specify.

     - **Microsoft Mail.** Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.
If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing the Serial/Lot Number Quantity on Hand Report**

**Note:** The Serial/Lot Number Quantity on Hand report is available only if you have a license to use Serialized Inventory and Lot Tracking.

This report is helpful when reconciling serial or lot quantities with physical inventory quantities. It lists all serial or lot numbers and their quantities for each item number at each location. You can print summary or detailed reports, and you can sort the report by item number or location.

**To print the Serial/Lot Number Quantity on Hand report:**

1. Open **Inventory Control > I/C Stock Control Reports > Serial/Lot Number Quantity on Hand**.
2. In the **Print** field, specify whether to print the report for lot numbers or serial numbers.
3. In the **Report Type** field, specify whether to print a detail or a summary report.
   - Summary reports show the serial/lot numbers assigned to items, the quantities on hand, and any differences.
   - Detail reports provide also provide the individual serial/lot numbers for the quantity on hand.
4. In the **Location From** and **To** fields, specify one or more locations to include on the report.
5. In the **Item Number From** and **To** fields, specify a range of item to include on the report.
6. In the **Sort By** list, specify whether to sort the information on the report by item number or location.
7. To exclude items if their physical quantity matches the quantity assigned to serial/lot numbers, select the **Show Only Items With IC Quantity Variance** option.
8. Click **Print**.
   - If you are printing to a physical printer, the Print window appears.
     - Confirm your printer selection and the number of copies to print, and
then click OK. Otherwise, click Cancel or Setup.

- If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

  **Note:** For Web-based clients, the preview screen appears first when you click the Print button.

- If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
  - **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
  - **Disk file.** Save the report to a location you specify.
  - **Microsoft Mail.** Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

### Printing the Serial/Lot Stock Listing Report

**Note:** The Serial/Lot Stock Listing report is available only if you have a license to use Serialized Inventory and Lot Tracking.

This report generates a list of either lot or serial numbers that are categorized as sold, reserved or expired. Serials have an additional option that lists the serial numbers that have been sold that have registered warranties. You can sort this report by item number, customer number or location.

**To print the Serial/Lot Stock Listing report:**

1. Open **Inventory Control > I/C Stock Control Reports > Serial/Lot Stock Listing.**

2. In the **Print** field, specify whether to print the report for lot numbers or serial numbers.
3. In the Report Type field, specify the type of report to print as follows:
   - If you are printing the report for lot numbers, you can specify **Sold Stock, Reserved Stock, or Expired Stock**.
   - If you are printing the report for serial numbers, you can specify an additional type: **Sold Stock, Reserved Stock, Expired Stock, or Registered Stock**.

4. Use the **Date From** and **To** fields to define the date range for the report.

5. Use the **Location From** and **To** fields to specify a range of locations to include on the report.

6. Use the **Item Number From** and **To** fields to specify a range of items to include on the report.

7. Use the **Number From** and **To** fields to specify a range of serial numbers or lot numbers, or accept the default selections to include all the numbers on the report.

8. Use the **Customer Number From** and **To** fields to specify a range of customers to include on the report.

9. In the **Sort By** field, specify whether to sort the report by item number, customer number, or location.

10. Click **Print**.
   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.
   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

   **Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

   - If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
     - **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the
file.

- **Disk file.** Save the report to a location you specify.
- **Microsoft Mail.** Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

### Printing the Serial/Lot Transactions Report

**Note:** The Serial/Lot Transactions report is available only if you have a license to useSerialized Inventory and Lot Tracking.

This report generates a list of lot numbers or serial numbers, along with the transactions that include the numbers. You can sort the report by serial/lot number or item number.

#### To print the Serial/Lot Transactions report:

1. Open **Inventory Control > I/C Stock Control Reports > Serial/Lot Transactions**.

2. In the **Print** field, specify whether to print the report for lot numbers or serial numbers.

3. Use the **Number From** and **To** fields to specify a range of serial numbers or lot numbers to appear on the report, or accept the default selections to include all the numbers.

   **Tip:** To specify a single serial or lot number, enter the number in both fields.

4. Use the **Item Number From** and **To** fields to specify the item(s) you want to appear on the report.

5. Use the **Location From** and **To** fields to specify one or more locations that you want to appear on the report.
6. Use the **Document Date From** and **To** fields to define the date range for the report. Transactions that occurred outside the defined date range will not appear in the report.

7. In the **Status** field, specify the status of serial or lot numbers to include on the report.

8. In **Sort By** field, specify whether to sort the report by item number, or serial/lot number.

9. Click **Print**.

   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.
   
   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

   **Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

   - If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:

     - **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.

     - **Disk file.** Save the report to a location you specify.

     - **Microsoft Mail.** Send the report as an e-mail attachment.

      You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

   - If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing the Slow Moving Items Report**

The Slow Moving Items report lists items that are not selling well, according to the criteria you select when you print the report.
Important! Because the Slow Moving Items report uses data from the Sales Statistics screen, Inventory Control must use the Keep Item Statistics option to produce the report. The Accumulate By and Period Type options determine the dates used to calculate statistics for the report.

For more information on the contents of this report, see "I/C Slow Moving Items Report" (page 529).

Before you start:
Run Day End Processing if you want to include the latest costing information in the report.

To print the Slow Moving Items report:
1. Open Inventory Control > I/C Stock Control Reports > Slow Moving Items.
2. Make your selections in the following fields:
   - Sort by. Specify the order in which to list item records.
   - From [ ] To [ ]. Specify the range of item numbers, categories, segments, or optional field entries to include in the report.
   - Include Items with. Specify a criterion for items to include in your report.
3. Click Print.
   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click OK. Otherwise, click Cancel or Setup.
   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

   Note: For Web-based clients, the preview screen appears first when you click the Print button.

   - If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
     - Application. View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
Disk file. Save the report to a location you specify.

Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the Stock Transactions Report

The Stock Transactions reports list the inventory changes or status for one or more items from one or more account sets and locations.

- The Stock Transactions report lists transactions that resulted in changes to inventory levels for selected items.
- The Stock Status report lists all the items in the range, even if no inventory movements occurred.

You can print a summary report or a detailed report, group results by items or locations, and include costs or quantities, or both costs and quantities.

To print the stock transactions report:

1. Open Inventory Control > I/C Stock Control Reports > Stock Transactions.
2. Make your selections in the following fields:
   - Report Type. Select a report type, and then specify whether to print a summary or detail report.
   - Group By. Specify whether to group report results by items or locations.
   - Print. The report prints both the costs and quantity of the selected items as the default. You can choose to print only the costs or only the quantities.
   - As at Year/Period. Select the period(s) for the report.

Note: If you are printing a Stock Transactions report, you can select a range of periods. If you are creating a Stock Status report, select a single period.
From Account Set/To, From Location/To, From Item Number/To Item Number. Specify ranges of account sets, locations, and item numbers to include on this report.

Note: Make sure the starting value is smaller than the ending value. For example, specify From Account Set AVG To LIFO, or From Location 1 To 2, not the other way around.

Include Inactive Items. Select this option to include inactive items on the report.

3. Click Print.

- If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click OK. Otherwise, click Cancel or Setup.
- If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

Note: For Web-based clients, the preview screen appears first when you click the Print button.

- If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
  - Application. View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
  - Disk file. Save the report to a location you specify.
  - Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

Printing Transfer Slips

When you post transfers, you can print transfer slips to accompany goods to the receiving location.
For more information on the contents of this report, see "I/C Transfer Slips Report" (page 529).

**To print transfer slips:**

1. Open **Inventory Control > I/C Stock Control Reports > Transfer Slips**.

   Or, save or post a new transfer transaction, and then click **Yes** when Inventory Control displays the transfer number and asks if you want to print transfer slips.

2. In the **Use Transfer Slip** field, select the transfer slip form to use. Inventory Control ships with two transfer slips: one prints the Quantity Received on the slip, and the other leaves this field blank.

3. If you used the Transfer Slips icon to open the screen, select the range of inventory transfers for which to print transfer slips.

4. Select **Include Serial/Lot Numbers** to print serial/lot numbers for serialized or lotted items on the transfer slips.

5. Select **Include Transfer Slips Already Printed** if you are reprinting a transfer slip.

6. Click **Print**.

   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.

   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

**Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

- If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
  - **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
Disk file. Save the report to a location you specify.

Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing the Warranty/Contract List Report**

**Note:** The Warranty/Contract List report is available only if you have a license to use Serialized Inventory and Lot Tracking.

This report provides the lot/serial numbers that have warranty and/or contract codes assigned to them.

You can select a range of warranty codes, contract codes, item numbers and locations to print on the report.

**To print the Warranty/Contract List report:**

1. Open **Inventory Control > I/C Stock Control Reports > Warranty/Contract List**.

2. From the **Report Type** list, select Item Summary, Contract Summary, or Warranty Summary.

3. In the **Print** field, select Serial Numbers or Lot Numbers.

4. If you selected Warranty Summary or Contract Summary as the report type, in the **Order By** list, specify whether to print the report by item numbers or by serial/lot numbers.

5. In the **Sort By** field, specify the sort order for the report details. (The choices available depend on your selections in the Report Type and Print fields.)

6. Use the **Status** field to include or exclude items or numbers by their status (Available, Not Available or Both).

7. If you selected Warranty Summary as the report type, and you are printing serial numbers on the report, in the **Show** list, specify whether to include registered warranties, unregistered warranties, or both on the report.
8. In the **From** and **To** fields, select a range of codes (Warranty and/or Contract), Item Numbers, Locations and Dates (Expiry, Stock or Sold) to include on the report.

9. In the **Use** field, specify the latest or the earliest expiry date for the warranties and/or contracts to include on the report.

10. Click **Print**.

   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.

   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

   **Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

   - If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:

     - **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.

     - **Disk file.** Save the report to a location you specify.

     - **Microsoft Mail.** Send the report as an e-mail attachment.

     You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

   - If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing Price/Sales Analysis Reports**

Use the reports in the Price/Sales Analysis Reports folder to review the effects of purchasing and sales activities, and to help determine the optimal prices, margin, and markup levels you need to meet your business objectives.
**Printing the Contract Pricing Report**

The Contract Pricing report lists the contract pricing arrangements you have established for a customer or for a range of customers.

For more information on the contents of this report, see "I/C Contract Pricing Report" (page 531)

**To print the report:**

1. Open **Inventory Control > I/C Price/Sales Analysis Reports > Contract Pricing**.

2. Select a range of customer numbers to include in the report. If you are printing to a printer, Inventory Control displays the Print Destination dialog box to let you confirm your printer selection and change the number of copies to print. Click OK if the settings are correct; otherwise, click Cancel or Setup.

3. Click **Print**.

   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.

   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

   **Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

- If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
   - **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
   - **Disk file.** Save the report to a location you specify.
   - **Microsoft Mail.** Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.
If you are printing to e-mail, an e-mail message appears with the report attached.

About Reporting General Ledger Data

The G/L Transactions report is a listing of the general ledger transactions created by Inventory Control that you might need to print as part of your audit trail.

If you selected the On Request Using Create G/L Batch Icon option, you can print the G/L Transactions report from Inventory Control after you run day-end processing (unless you create transactions during posting), but before you create or append to general ledger batches.

You can print this report whether or not you use Sage 300 ERP General Ledger with the same database as Inventory Control.

If you selected the During Posting or Day End Processing option for creating the general ledger batch, you cannot print the G/L Transactions report from Inventory Control. However, you can print the general ledger batch from your general ledger if you need this information for your audit control.

Printing the G/L Transactions Report

The G/L Transactions report is a list of the general ledger journal entries created from all transactions posted in Inventory Control since the last time you created the general ledger batch.

You can print detailed or summary versions of the report. If you use multicurrency accounting, you can print amounts either in the functional currency or in the source currencies in which you posted the transactions in Inventory Control.

For more information on the contents of this report, see "I/C G/L Transactions Report" (page 532).

Before you start:

- On the I/C Options screen, select On Request Using G/L Batch Icon for the Create G/L Transactions option.

  Note: If you use the option to create transactions during day-end processing, you cannot print the G/L Transactions report.
- Run Day End Processing if you want to include the latest costing information in the report.

**To print the G/L Transactions report:**

1. Open **Inventory Control > I/C Price/Sales Analysis Reports > G/L Transactions**.

2. Make your selections for the following fields:

   **Through Posting Sequence.** The program displays the latest posting sequence number, but you can enter an earlier number. The report lists all transactions for posting sequences up to and including the number you specify.

   **Report Format.** Select **Detail** or **Summary**.

   **Sort by.** If you are printing the detailed report, specify the order in which to list the transactions on the report. The choices are by general ledger Account Number, by Year/Period, and by Batch/Entry Number.

   **Report Currency.** If you use multicurrency, specify whether to print amounts in each source currency or in the functional currency.

3. Click **Print**.

   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.

   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

   **Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

   - If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:

     - **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.

     - **Disk file.** Save the report to a location you specify.
Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing the Markup Analysis Report**

The Markup Analysis report lists each item whose base price varies from a desired selling price by more than the percentage you specify for the report.

For more information on the contents of this report, see "I/C Markup Analysis Report" (page 533).

**Before you start:**
Run Day End Processing if you want to include the latest costing information in the report.

**To print the Markup Analysis report:**

1. Open Inventory Control > I/C Price/Sales Analysis Reports > Markup Analysis.

2. Make your selections in the following fields:

   Price List [ ] to [ ]. Enter a range or use the Finder to select a range of price lists for the report.

   Sort by. Specify the order in which to list item records.

   From [ ] To [ ]. Specify the range of item numbers, categories, segments, or optional field entries to include in the report.

   Location [ ] to [ ]. Enter a range or use the Finder to select a range of locations for the report.

   Calculate Markup Based on. Select a costing method for calculating the desired selling price and variance from the base price

   Print Items with Absolute Variance over [ ] %. Enter the amount you want to use as the cut-off point for your analysis. The report then lists
only those items whose base and desired selling prices vary by the specified percentage or more.

**Currency.** If you use multicurrency accounting, enter a currency or use the Finder to select a currency in which to report figures.

**Rate Type.** If you use multicurrency accounting, enter a rate type or use the Finder to select a rate type to use to calculate currency amounts for the report.

**Exchange Rate.** If you use multicurrency accounting, enter a rate or use the Finder to select an exchange rate for the report.

3. Click **Print**.

- If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.

- If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

  **Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

- If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:

  - **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.

  - **Disk file.** Save the report to a location you specify.

  - **Microsoft Mail.** Send the report as an e-mail attachment.

    You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing Posting Journals**

A posting journal is the printed record of the transactions that were processed
together during day-end processing.

You can print the following types of posting journals, one for each transaction type you can post in Inventory Control:

- Adjustments
- Assemblies
- Receipts
- Shipments
- Internal usage
- Transfers

For more information on the contents of this report, see "About Posting Journals" (page 298).

**Before you start:**
Remember to run Day End Processing if you want to print the most current posting journals.

**To print posting journals:**

1. Open **Inventory Control > I/C Price/Sales Analysis Reports > Posting Journals**.

2. Make your selections in the following fields:

   **Select Journal.** Select the type of posting journal to print: Adjustments, Assemblies, Receipts, Shipments, Internal Usage, or Stock Transfers.

   **From Day End Number** and **To Day End Number.** Type the lowest and highest numbers in the range of day-end numbers you want to include in the journal. A unique day-end number is assigned each time you run Day End Processing.

   These fields display the lowest and highest day-end numbers in your Inventory Control system for the type of journal you select.

   **Sort By.** Specify the order in which to list transactions on the posting journal.

   - **Day End Number.** Lists transactions in order by the day-end and entry numbers they were assigned when you processed them.
• **Transaction Date.** Lists transactions in order by the dates you entered with them.

• **Adjustment/Assembly/Receipt/Shipment/Internal Usage/Transfer Number.** Lists transactions in order by the document numbers that you entered with the transactions.

**Reprint Previously Printed Journals.** Select this option if you want to print additional copies of journals you printed before and have not yet cleared.

**Include Optional Fields.** Select this option to include optional fields added to transactions and transaction details.

**Include Serial/Lot Numbers.** Choose whether to show serial and/or lot numbers of applicable items in the posting journal.

3. Click **Print.**

   • If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK.** Otherwise, click **Cancel** or **Setup.**

   • If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

   **Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

   • If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:

     o **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.

     o **Disk file.** Save the report to a location you specify.

     o **Microsoft Mail.** Send the report as an e-mail attachment.

     You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

   • If you are printing to e-mail, an e-mail message appears with the report attached.
Printing the Price Lists Report

The Price Lists report lists price, markup, discount, and tax information for items in the range of price lists you select.

There are four versions of the report: Price List, Detail, Price List Summary, and Item Number Summary.

For more information on the contents of this report, see "I/C Price Lists Report" (page 538).

To print the Price Lists report:

1. Open Inventory Control > I/C Price/Sales Analysis Reports > Price Lists.
2. Make your selections in the following fields:
   - **Print.** Select the type of report you want to print.
   - **From Price List [ ] to [ ].** Select a range of price list codes to include in the report.
   - **From Currency [ ] to [ ].** Select a range of currencies used in price lists, if you have a multicurrency system.
   - **Display Price Calculated Using a Cost.** This choice applies only to Inventory Control items that have the Base or Sale Price specified as Base/Sale Price Calculated Using a Cost in the price list.
     - Select this option if you want to calculate item prices based on costs as the report is being printed. (This option does not appear for a Detail report.)
   - **Use Cost Base for Specific Location or All Locations.** If you choose All Locations, the report will calculate the price based on the Base/Sale Cost of an item for each location where the item exists. Otherwise, choose the location for which you want to calculate prices.
   - **Sort by.** Specify the order in which to list item records.
     - **From [ ] To [ ].** Specify the range of item numbers, categories, segments, or optional field entries to include in the report.
   - **Include.** When printing the Detail version of the report, you can also select additional information.
     - **From Currency [ ] to [ ].** If you use multicurrency accounting, select the currency for the report.
3. Click **Print**.

- If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.

- If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

  **Note**: For Web-based clients, the preview screen appears first when you click the **Print** button.

- If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
  - **Application**. View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
  - **Disk file**. Save the report to a location you specify.
  - **Microsoft Mail**. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

### Printing the Sales Statistics Report

The Sales Statistics report lists figures for sales and returns by the statistical reporting periods you specify in the Options screen.

The report includes current statistics only if you use the Keep Item Statistics option in the Options screen.

For more information on the contents of this report, see "I/C Sales Statistics Report" (page 539).

**Before you start:**

Run Day End Processing if you want to include the latest costing information in the report.
To print the Sales Statistics report:

1. Open **Inventory Control > I/C Price/Sales Analysis Reports > Sales Statistics**.

2. Make your selections in the following fields:

   - **Sort by.** Specify the order in which to list item records.
   - **From [ ] To [ ].** Specify the range of item numbers, categories, segments, or optional field entries to include in the report.
   - **Location [ ] to [ ].** Select a range of locations to include in the report.
   - **From Year [ ] and Period [ ], To Year [ ] and Period [ ].** Specify the range of reporting periods for the report.
   - **[ ] for Each Period Selected.** Specify what item information will appear on the report.

3. Click **Print**.

   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.

   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

   **Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.

   - If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
     - **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
     - **Disk file.** Save the report to a location you specify.
     - **Microsoft Mail.** Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.
If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing the Selling Price/Margin Analysis Report**

The Selling Price and Margin Analysis report lists items whose base prices or discount or markup prices have a gross profit margin that is less than the percentage you specify.

Use the report to identify items with unusually low or high profit margins.

For more information on the contents of this report, see "I/C Selling Price/Margin Analysis Report" (page 541).

**Before you start:**

Run Day End Processing if you want to include the latest costing information in the report.

**To print the Selling Price/Margin Analysis report:**

1. Open **Inventory Control > I/C Price/Sales Analysis Reports > Selling Price/Margin Analysis**.

2. Make your selections in the following fields:

   - **Price List [ ] to [ ]**: Select a range of price lists to include in the report.
   - **Location [ ] to [ ]**: Select a range of locations to include in the report.
   - **Sort by**: Specify the order in which to list item records.
   - **From [ ] To [ ]**: Specify the range of item numbers, categories, segments, or optional field entries to include in the report.
   - **Print Items with Margin Less than [ ] Percent**: Specify the largest margin percentage for the report. Items whose margins fall below this amount will be included.
   - **Calculate Margin by**: Select a method for calculating the margin.

   Currency-related fields appear only if you use multicurrency accounting.

3. Click **Print**.

   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.
Chapter 8: Printing Inventory Control Reports

- If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

  Note: For Web-based clients, the preview screen appears first when you click the Print button.

- If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
  - Application. View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
  - Disk file. Save the report to a location you specify.
  - Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing the Transaction History Report**

The Transaction History report lists all transactions posted for the items assigned to the account sets you select within the period you specify. The report shows the net change to the inventory control account for the account set and period.

Transaction history is accumulated and reported according to the settings you chose in the Fiscal Calendar in Common Services. Transactions are accumulated for this report only if you use the Keep Transaction History option in the Options screen.

Transactions cleared in the Clear History screen will not be included in the report.

For more information on the contents of this report, see "I/C Transaction History Report" (page 542)
Before you start:
Run Day End Processing if you want to include the latest costing information in the report.

To print the Transaction History report:

1. Open Inventory Control > I/C Price/Sales Analysis Reports > Transaction History.

2. Make a selection from the Report Type list. You can print a summary report or a detail report with serial and lot numbers included for applicable transactions.

3. Make your selections in the following fields:

   As at Year [ ] and Period [ ]. Select the ending period for the range of transactions you want to print. Inventory Control will list all transactions occurring before and during the specified period, excluding those you cleared in the Clear History screen.

   By. Specify the method of sorting transactions. Choose either Account Set Code or Item Number.

   From Account Set [ ], To Account Set [ ]. Select a range of accounts sets to include in the report.

   From Item Number [ ], To Item Number [ ]. If you chose to sort by item number, select a range of item numbers to include in the report.

4. Click Print.

   • If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click OK. Otherwise, click Cancel or Setup.

   • If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

      Note: For Web-based clients, the preview screen appears first when you click the Print button.

   • If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:

      • Application. View the report in an application that can open files of the
specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.

- **Disk file.** Save the report to a location you specify.

- **Microsoft Mail.** Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.

**Printing the Transaction Statistics Report**

The Transaction Statistics report lists statistics from posted transactions for the current year and all the previous years for which you keep history.

Transaction statistics are accumulated according to the selections you made for the Accumulate By and Period Type fields in the Options screen. You must use the Keep Item Statistics option if you want to print the Transaction Statistics report.

For more information on the contents of this report, see "I/C Transaction Statistics Report" (page 543).

**Before you start:**
Run Day End Processing if you want to include the latest costing information in the report.

**To print the Transaction Statistics report:**

1. Open **Inventory Control > I/C Price/Sales Analysis Reports > Transaction Statistics.**

2. Specify the range of years and periods for which to report statistics.

3. Click **Print.**

- If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK.** Otherwise, click **Cancel** or **Setup.**

- If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.
Printing Transaction Listings

A transaction listing provides a list of saved and/or posted transactions that have not been cleared from Inventory Control, including details about those transactions.

You can print the following types of transaction listings, one for each transaction type you can post in Inventory Control:

- Adjustments
- Assemblies
- Receipts
- Shipments
- Internal usage
- Transfers

For more information on the contents of this report, see "I/C Transaction Listing Report Screen" (page 557).

Note: For Web-based clients, the preview screen appears first when you click the Print button.

- If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
  - Application. View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
  - Disk file. Save the report to a location you specify.
  - Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

- If you are printing to e-mail, an e-mail message appears with the report attached.
To print transaction listings:

1. Open **Inventory Control > I/C Transactions > Transaction Listing**.

2. Make your selections in the following fields:

   **Select Transaction Type.** Select the type of listing to print: Adjustments, Assemblies, Receipts, Shipments, Stock Transfers, or Internal Usage.

   **Reprint Previously Printed Transactions.** Choose whether to reprint previously printed transactions.

   **Include Comments.** Choose whether to show comments entered with each transaction (doesn't apply to assemblies).

   **Include Serial/Lot Numbers.** Choose whether to show serial and/or lot numbers of applicable items in the report.

   **Include Optional Fields.** Choose whether to print optional field information with transactions.

   **From [Document] Number and To [Document] Number.** Type the lowest and highest document numbers that you want to include in the listing.

   **From Transaction Date and To Transaction Date.** Type the first and last dates for which you want to print transactions.

   **Entered / Posted.** Choose the status of transactions that you want to appear. If you are reviewing saved transactions only, select Entered.

3. Click **Print**.

   - If you are printing to a physical printer, the Print window appears. Confirm your printer selection and the number of copies to print, and then click **OK**. Otherwise, click **Cancel** or **Setup**.

   - If you are printing to the screen (preview), the report appears in a new window. You can print the report or export it to a file.

**Note:** For Web-based clients, the preview screen appears first when you click the **Print** button.
• If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, DOC, or XLS). Also, specify a destination for the file:
  - **Application.** View the report in an application that can open files of the specified format (for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). You can then save the file.
  - **Disk file.** Save the report to a location you specify.
  - **Microsoft Mail.** Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

• If you are printing to e-mail, an e-mail message appears with the report attached.
Appendix A: Inventory Control
Screen Guides

Learn how to find and use Sage 300 ERP screens. Each screen guide includes navigation information, field help, and a list of tasks you can use the screen to perform.

Items and Price Lists Screens

Item records contain the information you need to manage your inventory. You must add inventory item records to Inventory Control before you can enter inventory transactions.

You use price lists to store pricing information for all of your inventory items. You create price lists by adding items and prices to price list codes. You can have as many price lists as you need to handle different locations, different countries, and different currencies.

Besides adding item records and creating price lists, you may need to create additional records to set up your Inventory Control system, depending on the Inventory Control features your company uses. You may need to:

- Add inventory items to locations and add location details
- Assign vendors to items (optional)
- Set up contract pricing (optional)
- Add bills of material and kitting items (optional)
- Add manufacturers’ items (optional)
- Add customer item numbers (optional)
- Add reorder information (optional)
- Add current item quantities and cost
- Add sales and transaction statistics (optional)
I/C Bills of Material Screen

To open this screen:
Open Inventory Control > I/C Items and Price Lists > Bills of Material.

Related tasks:
- "Adding Bills of Material" (page 155)
- "Setting Up Inventory Control" (page 5)

Overview

Use the I/C Bills of Material screen to:

- Set up bills of material if you plan to assemble or repackage inventory items to create a supply of "master items" to sell.

A bill of material specifies:

- The number of units (build quantity) of a master item required for one assembly of a BOM.
- The component items and quantity of each item needed for the build quantity.
- Fixed and variable costs associated with assembling the master items.

Fields and Controls

Buttons

Go
Click the Go button to view documents that match the criteria you specified.

Hide Tree/Show Tree
This button toggles, allowing you to hide or display a panel that shows the component items of a BOM.

BOM Description
Enter a description to identify the bill of material you are creating. The
description is especially important if you use several alternative BOMs to create the same master item.

**BOM Number**

Enter a number or code to identify the bill of material you are creating. The code can be up to six characters long, and contain letters and numbers.

The BOM number lets you create alternative bills of material for building the same master item.

The BOM description helps you identify the particular BOM number.

**Build Quantity**

Enter the number of master items that one assembly of the bill of material produces.

**Comments**

Enter comments you want to save with the bill of material record.

**Component Description**

This column displays the description for each item number you add to the bill of material.

**Component Item Number**

Enter an item number or use the Finder to select each item number you require to assemble the master item.

**Component Quantity**

Enter the quantity of each of the component items you require to assemble the number of master items you specified in the **Build Quantity** field.

**Component Unit of Measure**

Enter a unit of measure or use the Finder to select the unit of measure to be used for each component item.

**Component's BOM Number**

If the component item is the master item of a subassembly, specify which of the component's BOM numbers you are using to assemble the component.

**Components**

If the component item is the master item of a subassembly, and you specified the BOM number, this field displays Yes, and you can click the button in the column header to display and subassembly components.
If the BOM number does not exist, you can add the subassembly components on the BOM screen that appears.

**End Date**
This is the period of time during which the master item can be assembled.

For example, you might keep a particular master items in stock only for the duration of a contract.

**Fixed Cost**
Enter the setup cost for assembling the bill of material.

The fixed cost is a one-time cost that is the same regardless of how many units you assemble of the master item. For example, the time required to prepare an assembly line is a fixed cost.

**Inactive**
Select this option if you want to keep this BOM but do not want it to be assembled.

For example, you might make a seasonal BOM inactive for most of the year, or you might have a BOM that is used as a template for several component BOMs but is never assembled in its entirety.

You can change the option from Inactive to Active at any time.

**Master Item Number**
Enter an item number or use the Finder to select the item number you want to use as the master item for the bill of material. This is the item that you are assembling from components.

**Start Date**
This is the period of time during which the master item can be assembled.

For example, you might keep a particular master item in stock only for the duration of a contract.

**Unit Cost**
You can enter a cost in this field if the item is assigned a user-specified costing method. (The account set for the item determines the costing method.)

For all other costing methods (where the program calculates the cost), this field will be blank.
**Unit of Measure**

Enter the unit of measure (UOM) or use the Finder to select the unit of measure that you want to assign to the master items that you create when you assemble the bill of material.

**Note:** The Finder lists the units of measure that have been assigned to the master item on the Units tab of the I/C Items screen. If you want to use a different UOM, you must add it to the master item record.

**Use as Default**

Specify whether the BOM number is used by default on the I/C Assemblies/Disassemblies screen when you select the BOM item.

**Notes:**
- Even if you select this option, the BOM number is not used by default in Order Entry.
- This information is also used by Sage Inventory Advisor (SIA).

**Variable Cost**

Enter the cost for one assembly of the bill of material. (One assembly produces the "build quantity" of master items.)

**I/C Construct Item Number Screen**

**To open this screen:**

1. Open **Inventory Control > Items and Price Lists > Items**.
2. Click the zoom button ▲ beside the Item Number field, or press F9 in the field.

**Related tasks:**

"Adding Item Records" (page 112)

**Overview**

Use the I/C Construct Item Number screen to add new item numbers, selecting the desired item structure and entering values for the segments in the number.

Using this screen to enter new item numbers saves you from having to remember the format of an item structure. It lets you choose the correct segment codes from the Finder for validated segments. (Validated segments are specified on the Segments tab of the I/C Options screen.)
Fields and Controls

Description
This field displays the description (name) entered for each segment on the I/C Options screen.

Note: You can change the description for the segment only on the Items tab of the I/C Options screen.

Item Number
This field displays the separator characters used in the structure code you specified. As you enter the code for each segment, it is also added to the Item Number field.

Check the number in the field to be sure it is correct before you click Select.

Length
This field displays the number of characters required in each segment of the item structure. You must enter a code of exactly the specified length.

You specify the length of each segment on the Segments tab of the I/C Options screen.

Segment
This field displays the name you have assigned to each segment in the selected item structure.

Segment Number
This field displays the number assigned to each segment in the item structure.

Structure Code
Enter the structure code to use or select it from the Finder. When you specify the structure code, the segments used in the code automatically appear.

You define structure codes on the I/C Item Structures screen.

Value
Enter the code for the associated segment, or select it from the Finder if you selected the Validate option for the segment on the I/C Options
Each code you enter is immediately inserted in the Item Number field.

**I/C Contract Pricing Screen**

**To open this screen:**
Open Inventory Control > I/C Items and Price Lists > Contract Pricing.

**Related tasks:**
"Adding Contract Prices for Customers" (page 135)

**Overview**
Use the I/C Contract Pricing screen to set up contract pricing for specific customers. Sage 300 ERP Order Entry uses this information to calculate the default price for any item affected by the customer’s pricing contract.

**Fields and Controls**

**Calculated Unit Price**
This field displays the customer's unit price for the item calculated according to your previous entries.
This field appears only when you have chosen to price by item number.

**Category Code**
Specify a category code.

**Contract Price Type**
Select a contract price type. Your selection affects the fields that appear (or are active) below the Contract Price Type field.

**Cost Base**
Select a cost base you have set up.
This field appears only if you selected Cost Plus a Percentage or Cost Plus Fixed Amount as the contract price type.

**Customer Number**
Enter a customer number or select one using the Finder.
**Customer Type**
This field appears only if you selected **Customer Type** as the contract price type.

Available customer types include Base, A, B, C, D or E.

**Discount Amount**
This field appears only if you selected **Discount Amount** as the contract price type.

Enter a fixed discount amount.

**Discount Percentage**
This field appears only if you selected **Discount Percentage** as the contract price type.

Enter a discount percentage with up to five decimal places.

**Expiration Date**
Enter a date for the pricing contract to expire. If you do not enter a date, the contract will remain in effect indefinitely.

**Fixed Amount**
Enter the setup cost for assembling the bill of material.

The fixed cost is a one-time cost that is the same regardless of how many units you assemble of the master item. For example, the time required to prepare an assembly line is a fixed cost.

**Fixed Price**
Enter a price that will not change.

This field appears only when you select **Fixed Price** as the contract price type.

**Item Number**
Enter an item number or select one using the Finder.

**Percentage**
Enter a percentage, using up to five decimal points.

This field appears only if you selected **Cost Plus Percentage** as the contract price type.
**Price By**
Specify whether to set up the contract pricing by category code or by individual item number.

**Price List**
Enter, or select using the Finder, the price list from which you want to draw the base price for the item you selected.

**Start Date**
Select a date to ensure that the contract price will be picked only if the transaction date is after the contract start date.

If you want the contract to be open-ended, leave this field blank.

**Use Lowest Price**
Select this option if you want the program to determine the best price for the customer automatically, regardless of the contract price.

**Variable Cost**
Enter the cost for one assembly of the bill of material.

One assembly produces the "build quantity" of master items.

**I/C Copy Bills of Material Screen**

To open this screen:
Open Inventory Control > I/C Items and Price Lists > Copy Bills of Material.

**Related tasks:**
- "Copying Bills of Material" (page 157)
- "Adding Bills of Material" (page 155)
- "Updating Bills of Material" (page 158)

**Overview**
Use the I/C Copy Bills of Material screen to:
- Create a new bill of material based on an existing bill of material. The new BOM can be:
- For the same master item or for a different master item.
- A single-level or multilevel bill of material.
- Accept the existing values of the selected bill of material (such as the fixed cost, variable cost, or build quantity), or change the values for the new build.
- Choose which items from the original bill of material should be copied to the new bill of material.

**Note:** The I/C Copy Bills of Material screen copies bill of material information, adding a new bill of material to an existing master item. You cannot add components to the new bill of material or change the item numbers of components.

**Tip:** To update component item numbers or costs for a range of bills of material, use the "I/C Update Bills of Material Screen" (page 474).

**Fields and Controls**

**Description**
Enter a description to identify the bill of material you are creating. The description is especially important if you use several alternative BOMs to create the same master item.

**Build Quantity**
Enter the number of master items that one assembly of the bill of material produces. The build quantity from the original BOM appears as the default.

**Comments**
Enter comments you want to save with the bill of material record.

**Component Description**
This column displays the description for each component item number in the new bill of material.

**Component Item Number**
You can change this for the BOM that you are creating. Enter an item number or use the Finder to select each item number you require to assemble the master item.
Component Quantity
Enter the quantity of each of the component items you require to assemble the number of master items you specified in the Build Quantity field.

Component Unit of Measure
Enter a unit of measure or use the Finder to select the unit of measure to be used for each component item.

Component's BOM Number
If the component item is the master item of a subassembly, this field shows which of the component's BOM numbers was used to assemble the component in the original BOM.

You can change this for the BOM that you are creating.

Components
If the component item is the master item of a subassembly, and you specified the BOM number, this field displays Yes, and you can click the button in the column header to display and subassembly components.

If the BOM number does not exist, you can add the subassembly components on the BOM screen that appears.

Copy Detail
All component items from the old bill of material will be copied to the new BOM as defaults. If you do not want to copy a particular component, double-click the Copy Detail column to select No.

End Date
This is the period of time during which the master item can be assembled.

For example, you might keep a particular master items in stock only for the duration of a contract.

Fixed Cost
Enter the setup cost for assembling the new bill of material. The cost from the original BOM appears as the default.

The fixed cost is a one-time cost that is the same regardless of how many units you assemble of the master item. For example, the time required to prepare an assembly line is a fixed cost.

From/To BOM Number
In the From field, enter the code that identifies the bill of material that you
are copying.

In the **To** field, enter a code for the BOM that you are creating. The code can be up to six characters long, and contain letters and numbers.

You can have as many alternative bills of material as you need for building the same master item with alternative components.

**Tip:** You can use the **Description** field to identify the particular BOM number.

### From/To Master Item Number

In the **From** field, specify the number of the inventory item which has the BOM that you want to copy.

In the **To** field, specify the number of inventory item for which you want to set up a bill of material.

You can create a new BOM for a different master item number or create a new BOM number for the same master item (with alternative components).

### Inactive

Select this option if you want to make sure that the BOM is not assembled before it is approved.

For example, you might make all copied BOMs inactive until you have printed and reviewed the Bill of Materials report to ensure that the build will be correct.

You can change the option from Inactive to Active at any time.

### Start Date / End Date

This is the period of time during which the master item can be assembled.

For example, you might keep a particular master item in stock only for the duration of a contract.

### Unit Cost

You can enter a cost in this field if the item is assigned a user-specified costing method. (The account set for the item determines the costing method.)

For all other costing methods (where the program calculates the cost), this field will be blank.
**Unit of Measure**

Enter the unit of measure or use the Finder to select the unit of measure to assign to the master items that you create when you assemble the bill of material. The UOM from the original BOM appears as the default.

**Note:** The Finder lists the units of measure that have been assigned to the master item on the Units tab of the I/C Items screen. If you want to use a different UOM, you must add it to the master item record.

**Variable Cost**

Enter the cost for one assembly of the bill of material. (One assembly produces the "build quantity" of master items.)

The cost from the original BOM appears by default.

**I/C Copy Item Pricing Screen**

**To open this screen:**

Open **Inventory Control > I/C Items and Price Lists > Copy Item Pricing.**

**Related tasks:**

- "Adding Items to Price Lists" (page 91)
- "Changing Pricing Information for Single Items" (page 102)
- "Copying Pricing Information to Other Price Lists or Currencies" (page 99)

**Overview**

Use the I/C Copy Item Pricing screen to:

- Copy the contents of one price list to create a new price list and, if you wish, specify a percentage increase or decrease in the base price, sale price, markup cost and discount pricing (if specified by amounts).

- Copy the prices in one currency to another currency on the same price list to create a new set of prices—adjusting prices using current exchange rates.

**Tip:** The Copy Item Pricing screen copies pricing information, adding items to a new or existing price list. To update item prices on an existing price list, use the "I/C Update Item Pricing Screen" (page 475).
Multicurrency Ledgers

If you have a multicurrency system, you can include prices in different currencies for items on the same price list.

Use the Item Pricing screen to set up the price list in one currency, then use Copy Item Pricing to create prices in other currencies for the items.

Fields and Controls

Create the Selected Fields Using Percentage / Exchange Rate

You can increase or decrease the pricing information when you copy it by specifying a percentage or, if you have a multicurrency system, an exchange rate. This feature lets you quickly set up discounted price lists or price lists in another currency.

Note:
- If you calculate discount and markup amounts by percentages, these percentages are not affected by increases or decreases you specify when copying.
- Tax information is not affected by copying with an increase or decrease.

Exchange Rate for Default Price/Calculate Price Using Cost

If you calculate prices based on costs, you must specify the exchange rate for converting costs from your functional currency to the currency of the target price list (the list to which you are copying item pricing).

You can specify the rate type, rate date, and exchange rate to use for cost conversion.

From/To Currency Code

If you have a multicurrency system, you must specify the currency of the prices you are copying.

You can copy prices to a different currency in the same price list, specifying an exchange rate to convert prices from one currency to another. This is the simplest way to update prices in different currencies.

From/To Item Number/Category/Item Segment/Vendor Number

Specify a range of item numbers, category, item segments, vendor numbers, or optional fields whose pricing information will be copied to the
target price list.

**From/To Price List**
Specify the price list from and to which you are copying the prices. If you have a multicurrency system, you can copy to a different currency on the same price list.

**Increase/Decrease by Percent**
You can increase or decrease the base rate, sale price, markup cost, and discount information (if calculated by amounts) by the percentage you specify.

**Note:**
- If you calculate discount and markup amounts by percentages, these percentages are not affected by increases or decreases you specify when copying.
- Tax information is not affected by copying with an increase or decrease.

**Rate Type and Multiply By Exchange Rate**
If you have a multicurrency system, and are creating sets of prices in different currencies, you can apply the currency exchange rate as you copy the base rate, sale price, markup cost, and discount information (if calculated by amounts).

**Note:**
- If you calculate discount and markup amounts by percentages, these percentages are not affected by increases or decreases you specify when copying.
- Tax information is not affected by copying with an increase or decrease.

**Select By**
You can copy prices for all or a portion of the price list, selecting the range of prices by one of the following elements:

- Item numbers
- Item categories
- Item segments
- Vendor numbers
- Any optional field defined for Inventory Control items
Select Fields
Choose which pricing information you want copied to the target price list:

- **Base Price.** Select the Base Price option to copy the base price.

- **Decimal Places.** If you select the Base Price option, select the number of decimal places to use when displaying or printing the base and sale prices.

- **Sale Price.** Select the Sale Price option to copy the sale price.

- **Sale Starts/Ends.** If you select the Sale Price option, select the first and last dates from the drop-down calendar for a sale period during which sale prices apply.

- **Markup Cost.** Select the Markup Cost option to copy the markup cost.

- **Markup Factor.** To select the Markup Cost option, enter the number by which to multiply the markup costs to calculate the selling prices for items on the new price list.

- **Discount/Markup Information.** Select the Discount/Markup Information option to copy the item's discount or markup information that is specified on the Discounts tab of the Item Pricing screen.

  If you specify discounts or markups by percentage, this information is unaffected by increases or decreases when copying.

- **Price Check Information.** Select the Price Check Information option to copy the price check information that is specified on the Price Check tab of the Item Pricing screen. Price check information includes item and employee-specific rules for checking price override amounts entered in Order Entry.

  **Note:** Price checks are available only in Sage 300 Premium ERP.

- **Tax Information.** Select the Tax Information option to copy the item's tax information that is specified on the Taxes tab of the Item Pricing screen.

  The tax information may not be valid in the target price list if you are copying between currencies. Tax information is unaffected by increases or decreases when copying.
I/C Customer Details Screen

To open this screen:
Open Inventory Control > I/C Items and Price Lists > Customer Details.

Related tasks:
"Adding Customer Item Numbers" (page 134)

Overview

Use the I/C Customer Details screen to set up a list of numbers that your customers use to order your inventory items.

Customer item numbers are particular to the customer, so different customers can use the same number for different items. Because they specify the customer’s unit of measure, using customer item numbers can reduce confusion during order entry.

Customer item numbers are often required for large customers, who use their own stock numbers when ordering from you. If you supply goods to several large outlets, several customer item numbers can be associated with a single item.

You use the Customer Details screen in the I/C Items and Price Lists folder to add customer details for an item.

Fields and Controls

Comments and Instructions
Add any comments or instructions that you want with the item number.
Comments and instructions entered here will appear in the comments and instructions fields for an order in Order Entry.

Customer Number
Select the customer for whom you are adding the item number.

Customer's Item Description
Enter the description that your customer uses for the item. You can use this description to verify that you are entering the correct item when entering orders.
Customer's Item Number
Enter the number that your customer uses for the inventory item.

Item Number
Enter or select the item in inventory for which your customer uses their own item number.

Unit of Measure
Specify the unit of measure that your customer uses with this item to make sure that orders are filled correctly.

I/C Items Screen

To open this screen:
Open Inventory Control > I/C Items and Price Lists > Items.

Fields and Controls

Item Number
The item number identifies the item in Inventory Control.

To create a new item record, enter a unique code of up to 24 characters (including separator and prefix characters) that matches one of the item number structures you have defined. You can also click the zoom button beside the Item Number field to select the item structure and enter the segment information to use, then have Inventory Control automatically insert the new number in the Item Number field.

When adding a single-segment item number, you can enter from one character to the maximum number of characters permitted in your item numbers. For example, if the segment length you defined for item numbers allows six characters, you can enter item numbers that contain one, two, three, four, five, or six characters.

To open an existing item record, enter its number or use the Item Number Finder to select it.

The description can be up to 60 characters long. Enter the description as you want it to appear in Inventory Control and Order Entry screens and on reports (for example, generic type, followed by specific item).

In most item number fields, you can enter manufacturers' item numbers that have been added to Inventory Control. When you press the Tab key, the program replaces the field contents with the inventory item number,
and places the manufacturer's item number that you used in the **Manuf. Item No.** field (by default the last field in the table).

**Items Tab**

**Account Set Code**

Enter an account set code or use the Finder to select the general ledger account set you want to assign to the item. (The program displays the costing method used by the account set in the **Costing Method** field.)

**Note:** Non-stock items and kitting items must use the user-specified costing method (determined by the account set choice). The non-stock and kitting item options are not available if you select an account set with any other costing method.

**Additional Item Information**

Enter any additional information you want to record about the item.

You can print this information on the Item Status report.

**Allow Item in Web Store**

Select this option to allow this item to appear in your web store. This setting is used by eTransact.

**Alternate Item**

Enter an item number or use the Finder to select the item number of a substitute item that you can ship when the regular item is out of stock.

**Category Code**

Enter a category code or use the Finder to select the category to which you want to assign the item. (When you ship an item, you can override the category to which you assigned the item.)

**Commodity Number**

If your company reports a value-added tax (VAT), enter the commodity number for the item.

**Costing Method**

This is the costing method assigned to the account set you selected.
If you want to use a different costing method, you must select another account set or create a different one.

**Default Picking Sequence**

Enter a picking code (for example, a warehouse bin number or aisle number) that identifies the physical location where an item is stored.

In Order Entry, you can print the picking sequence on picking slips to help warehouse staff assemble shipments.

**Default Price List**

Enter a price list code or use the Finder to select the code of the price list from which you want the Shipments screen to display the item’s price. (You can override this price list when you enter shipments.)

The prices Sage 300 ERP Order Entry displays for items come from this price list (if there are prices in the customer's currency).

**Inactive**

Select this option if you do not want to use this inventory item any longer.

You would generally use this option when you decide to delete an item, and want to ensure no further transactions are posted for it.

However, you can still process transactions in P/O Returns and O/E Credit Notes for an inactive item. For example, if a customer returns the item or you return the remaining stock to the vendor, you will need to process transactions for those inactive items.

You can change the option from Inactive to Active at any time.

**Kitting Item**

This option is available only if you use the user-specified costing method (determined by the account set you select).

To allow the item to be the master item for a kit, you must take the following steps:

- In the **Account Set Code** field, select **User Specified Cost**.
- Clear the default **Stock Item** option, and then select the **Kitting Item** option.
Last Maintained
This field displays the date of the last change made to the account set.

Lot Number
If you track this item using lot numbers, select this option.

Note: This option appears only if you use Serialized Inventory and Lot Tracking.

Seasonal
Select this option to specify that an item is seasonal (mainly or exclusively sold during particular fiscal periods each year).

On the Optimize Inventory screen, the periods used to calculate optimal reorder quantities for an item differ depending on whether or not the item is seasonal. For more information, see "I/C Optimize Inventory Screen" (page 460).

Serial Number
If you track this item using serial numbers, select this option.

Note: This option appears only if you use Serialized Inventory and Lot Tracking.

Sellable
If the item is not for sale, clear this option.

Example: You would not select the Sellable option for goods that are used only in bills of material, for internal usage transactions, or for projects managed through Project and Job Costing.

Stock Item
If the item is a regular inventory (stock) item, select this option.

Services or specially ordered items which are not normally kept in inventory are considered non-stock items, and you should not select this option for either of them. Kitting items are also non-stock items.

Note: Non-stock items must use the user-specified costing method (determined by the account set you specify). The Stock Item option is not available if you select any other costing method.
Appendix A: Inventory Control Screen Guides

**Structure Code**
Enter the item number structure code for this inventory item or use the Finder to select the item structure that matches the format of the item number you are entering.

If you are not sure which code to select, click the Zoom button beside the **Item Number** field to view details of your item number structures.

You can use as many item number formats as you need, with up to ten segments in each code (four segments in Sage 300 Standard ERP), and a maximum of 24 characters in all.

**Unit Weight**
Enter the weight for one stocking unit of the item, using the weight unit of measure that you specify in the **Weight Unit of Measure** field.

This weight is used in Order Entry to calculate total order weight.

**Weight Unit of Measure and Conversion Factor**
Enter the unit of measure that you use for measuring the weight of one stocking unit of this item.

Weight units of measure are defined on the I/C Weight Units Of Measure setup screen. The unit of measure includes a conversion factor for converting this unit to the default weight unit of measure specified on the I/C Options screen.

The default weight unit of measure is the weight unit used for calculating the total weight of orders in Order Entry.

**Optional Fields Tab**

**Optional Field and Description**
Enter a value for any optional fields that appear. If a field is required, you cannot save the item record until you enter the value.

To add optional item fields that were not automatically inserted, press the Insert key to add a new line to the table, and then use the Finder to add the optional field.

Optional fields must be assigned to the Items screen using the I/C Optional Fields screen before you can add them to item records.

When you select an optional field code, Inventory Control displays the description for the optional field.
Value Set
This field indicates whether a blank optional field currently has a value. (By looking at the field, you cannot know otherwise whether the field has a default value which is blank, or no value at all.)

The entry in this field will change from No to Yes if you make an entry in the Value field.

Value and Description
- If the optional field is required, you cannot save the item record until you enter a value.
- If the optional field you selected requires validation, you must select a value that is defined for the optional field in Common Services (unless the optional field allows blanks).
- If you select a value, the description for the value you select will appear in the description column.
- If you delete the value, the optional field will be deleted from the table. If the field is required, you will have to reinsert it and enter a value before you can save the item record.

Taxes Tab
Tax Authority and Description
Enter the tax authority or use the Finder to select the tax authorities (such as state or province) that tax sales and/or purchases of the item. Inventory Control displays the tax authority description when you enter a tax authority code.

You may have a long list of authorities if you sell goods in several jurisdictions or countries.

You define taxing authorities in Tax Services in Common Services. For more information about tax authorities and tax classes, see the help for Tax Services.

Purchase Tax Class and Description
Enter the numbers or select the numbers of the tax classes you want to assign to the item for purchases for each selected tax authority.


**Sales Tax Class and Description**

Enter or select the numbers of the tax classes you want to assign to the item for sales for each selected tax authority.

**Units Tab**

**Conversion Factor**

Enter the number of stocking units for the unit of measure. For example, if the unit of measure is "dozen," you type 12.

The conversion factor must be 1 (one) for the unit of measure you intend to use for the stocking unit.

**Stocking Unit of Measure**

Enter or select Yes for the unit of measure you intend to use for the stocking unit (the smallest unit by which you purchase or sell the item if you do not use the **Allow Fractional Quantities** option).

You can specify only one stocking unit of measure for each item.

**Unit of Measure**

Enter the name for the unit of measure (for example: dozen, gallon, ton) or select it using the Finder.

If you selected the **Use Only Defined UOM** option on the I/C Options screen, you must use the Finder to select an existing unit of measure.

Use the Insert key to enter a new unit of measure. Remember that one unit must be the stocking unit of measure.

**Secondary screens:**

"I/C Construct Item Number Screen" (page 383)

**Related tasks:**

- "Adding Item Records" (page 112)
- "Editing an Item Record" (page 127)
- "Deleting Item Records" (page 130)
- "Tracking Serialized or Lotted Item Components" (page 261)
Overview

Use the I/C Items screen to:

- Add new items, and change or delete existing item records.
- Select the item structure and enter segment information for a new item number. (Click the Zoom button to open the "I/C Construct Item Number Screen" (page 383).)

Note that you can include blanks in your item numbers. This means, for example, that you can have two difference item numbers: "12 3" and "1 23".

- Set item attributes, such as whether items are sellable, have serial numbers, are sold on the Web, are kits (a collection of other items), are kept in stock, etc.
- Enter and revise picking sequences (or bin numbers), item weights, units of measure and tax information.
- Add or change optional field information for items.

You must add items to Inventory Control before you can use them in transactions.

**Note:**
If you did not select the Allow Items At All Locations option in the I/C Options screen, you must use the Locations screen (in the I/C Setup folder) or the Location Details screen (in the I/C Items and Price Lists folder) to specify which items you want to stock at each location.

For an overview of item records, see "About Setting Up Inventory Items" (page 106).

Items Tab

Use this tab to:

- Specify the structure code, category code, and account set code for new items.
- Assign a default picking sequence and price list for the item.
- Indicate whether the item is sellable, and whether it is an inventory item, a non-stock item, or a kitting item.
- Specify whether you assign serial or lot numbers to the item.
Appendix A: Inventory Control Screen Guides

- Specify the weight of a single stocking unit of the item and the weight unit of measure.
- Enter an alternate item number for the item.
- Enter a commodity number (if you report VAT).

**Lots Tab**

*Note:* This tab appears only if you have a license to use Serialized Inventory and Lot Tracking and the selected item is lotted.

Use this tab to:

- See the lot number mask used for the item.
- View or change the next lot number that will be assigned for this item.
- Set an expiration period for the lot, or view the days to expiry.
- Put the lot on quarantine, or view the days left on quarantine.
- Make it optional to assign lot numbers before saving transactions by selecting the Allow Lot Quantity To Be Different From The Quantity In The Entries option. (You cannot select this option for items that use lot costing.)

This setting allows lotted items that use a costing method other than lot costing to use different quantities than the lot numbers that are allocated in transactions in Sage 300 ERP Inventory Control, Purchase Orders, and Order Entry.

Note that when entering orders, you can enter an order quantity and choose to not allocate lot numbers. However, you must allocate lot numbers when shipping the order.

- Assign or view a warranty code, and automatically place the lot on warranty when sold
- Assign or view a contract code, and automatically place the lot on contract when received
- Add or view any optional fields for this item
Optional Fields Tab

Use the Optional Fields tab to:

- Enter data into automatically inserted fields on this tab.
  If a field is required, you cannot save the item record until to fill in the value.
- Add optional item fields that were not automatically inserted.

Use the Insert key to add a new line to the table, and then use the Finder to add the optional field.

**Note:** Optional fields must be assigned to the Items screen in the I/C Optional Fields screen before you can add them.

Serials Tab

**Note:** This tab appears only if you have a license to use Serialized Inventory and Lot Tracking and the selected item is serialized.

Use this tab to:

- View the serial number mask used for the item.
- View or change the next serial number that will be assigned for this item.
- Set an expiration period for the serial, or view the days to expiry.
- Make it optional to assign serial numbers before saving transactions by selecting the option **Allow Serial Quantity To Be Different From The Quantity In The Entries**. This option is not available for items that use serial costing.

This setting allows serialized items that use a costing method other than serial costing to have different quantities in entries than the number serials allocated in transactions using Sage 300 ERP Inventory Control, Purchase Orders, and Order Entry.

Note that when entering orders, you can enter an order quantity and choose to not allocate serial numbers. However, you must allocate serial numbers when shipping the order.

- Assign or view a warranty code, and automatically place the serial on warranty when sold and/or registered.
Appendix A: Inventory Control Screen Guides

- Assign or view a contract code, and automatically place the serial on contract when received.
- Add or view any optional fields for this item.

**Taxes Tab**

**Note:** This tab appears only if you have activated Tax Services.

Use the tab to specify the tax authorities and sales and purchase tax classes that apply to the item.

If the category you selected on the Items tab contains tax information, the information appears in fields on this tab. You can make changes to this information without affecting the tax information in the category record.

**Units Tab**

Use this tab to:
- Enter the units of measure by which you purchase or sell the item.
- Identify the stocking unit of measure for the item.

**I/C Items Wizard**

**To open this screen:**
Open **Inventory Control > I/C Items and Price Lists > Items Wizard**.

**Secondary screens:**
- "I/C Construct Item Number Screen" (page 383)

**Related tasks:**
- "Adding Inventory Items Using the Items Wizard" (page 109)
- "Changing Inventory Item Descriptions Using the Items Wizard" (page 128)

**Overview**

Use the I/C Items Wizard to:
- Add a new item with all applicable information.
- Add information for an item that already exists.
The I/C Items Wizard is the simplest way to set up items in your Inventory Control system. It streamlines the process by stepping you through all the tasks involved in adding items and related records.

The Items Wizard takes you through the process of adding the following records:

- Items
- Location Details
- Vendor Details
- Item Pricing
- Contract Pricing
- Manufacturers’ Items
- Customer Details
- Bills of Material
- Kitting Items
- Reorder Quantities

You can also use the Items Wizard to change information for existing inventory items.

**Fields and Controls**

**Page 1 Items (basic information)**

**Account Set Code**

Enter an account set code or use the Finder to select the general ledger account set you want to assign to the item. (The program displays the costing method used by the account set in the **Costing Method** field.)

**Note:** Non-stock items and kitting items must use the user-specified costing method (determined by the account set choice). The non-stock and kitting item options are not available if you select an account set with any other costing method.

**Allow Item in Web Store**

Select this option to allow this item to appear in your web store. This
setting is used by eTransact.

**Category Code**
Enter a category code or use the Finder to select the category to which you want to assign the item. (When you ship an item, you can override the category to which you assigned the item.)

**Commodity Number**
If your company reports a value-added tax (VAT), enter the commodity number for the item.

**Costing Method**
This is the costing method assigned to the account set you selected.

If you want to use a different costing method, you must select another account set or create a different one.

**Default Price List**
Enter a price list code or use the Finder to select the code of the price list from which you want the Shipments screen to display the item's price. (You can override this price list when you enter shipments.)

The prices Sage 300 ERP Order Entry displays for items come from this price list (if there are prices in the customer's currency).

**Default Picking Sequence**
Enter a picking code (for example, a warehouse bin number or aisle number) that identifies the physical location where an item is stored.

In Order Entry, you can print the picking sequence on picking slips to help warehouse staff assemble shipments.

**Description**
This field displays the description (name) entered for each segment on the I/C Options screen.

**Note:** You can change the description for the segment only on the Items tab of the I/C Options screen.

**Inactive**
Select this option if you do not want to use this inventory item any longer.
You would generally use this option when you decide to delete an item, and want to ensure no further transactions are posted for it.

However, you can still process transactions in P/O Returns and O/E Credit Notes for an inactive item. For example, if a customer returns the item or you return the remaining stock to the vendor, you will need to process transactions for those inactive items.

You can change the option from Inactive to Active at any time.

**Item Number and Description**

The item number identifies the item in Inventory Control.

To create a new item record, enter a unique code of up to 24 characters (including separator and prefix characters) that matches one of the item number structures you have defined. You can also click the zoom button beside the **Item Number** field to select the item structure and enter the segment information to use, then have Inventory Control automatically insert the new number in the **Item Number** field.

When adding a single-segment item number, you can enter from one character to the maximum number of characters permitted in your item numbers. For example, if the segment length you defined for item numbers allows six characters, you can enter item numbers that contain one, two, three, four, five, or six characters.

To open an existing item record, enter its number or use the **Item Number** Finder to select it.

The description can be up to 60 characters long. Enter the description as you want it to appear in Inventory Control and Order Entry screens and on reports (for example, generic type, followed by specific item).

In most item number fields, you can enter manufacturers' item numbers that have been added to Inventory Control. When you press the Tab key, the program replaces the field contents with the inventory item number, and places the manufacturer's item number that you used in the **Manuf. Item No.** field (by default the last field in the table).

**Item Number**

This field displays the separator characters used in the structure code you specified. As you enter the code for each segment, it is also added to the **Item Number** field.
Check the number in the field to be sure it is correct before you click **Select**.

**Kitting Item**
This option is available only if you use the user-specified costing method (determined by the account set you select).

To allow the item to be the master item for a kit, you must take the following steps:

- In the **Account Set Code** field, select **User Specified Cost**.
- Clear the default **Stock Item** option, and then select the **Kitting Item** option.

**Length**
This field displays the number of characters required in each segment of the item structure. You must enter a code of exactly the specified length.

You specify the length of each segment on the Segments tab of the I/C Options screen.

**Lot Number**
If you track this item using lot numbers, select this option.

**Note:** This option appears only if you use Serialized Inventory and Lot Tracking.

**Master Item**
Select **Master Item** to allow this item to be the master item for a bill of material.

**Notes:**
- Master items cannot use the user-specified costing method (determined by the account set choice). The Master Item option is not available if you selected this costing method.
- The Bills of Material page appears later in the Items Wizard only if you select this option.

**Sellable**
If the item is not for sale, clear this option.
Example: You would not select the **Sellable** option for goods that are used only in bills of material, for internal usage transactions, or for projects managed through Project and Job Costing.

**Segment**
This field displays the name you have assigned to each segment in the selected item structure.

**Segment Number**
This field displays the number assigned to each segment in the item structure.

**Serial Number**
If you track this item using serial numbers, select this option.

**Note:** This option appears only if you use Serialized Inventory and Lot Tracking.

**Stock Item**
If the item is a regular inventory (stock) item, select this option.

Services or specially ordered items which are not normally kept in inventory are considered non-stock items, and you should not select this option for either of them. Kitting items are also non-stock items.

**Note:** Non-stock items must use the user-specified costing method (determined by the account set you specify). The **Stock Item** option is not available if you select any other costing method.

**Structure Code**
Enter the structure code to use or select it from the Finder. When you specify the structure code, the segments used in the code automatically appear.

You define structure codes on the I/C Item Structures screen.

**Value**
Enter the code for the associated segment, or select it from the Finder if you selected the **Validate** option for the segment on the I/C Options screen.

Each code you enter is immediately inserted in the **Item Number** field.
Page 2 Items (additional information, units of measure)

Additional Item Information
Enter any additional information you want to record about the item.
You can print this information on the Item Status report.

Alternate Item Number
Enter an item number or use the Finder to select the item number of a substitute item that you can ship when the regular item is out of stock.

Conversion Factor
Enter the number of stocking units for the unit of measure. For example, if the unit of measure is "dozen," you type 12.
The conversion factor must be 1 (one) for the unit of measure you intend to use for the stocking unit.

Stocking Unit of Measure
Enter or select Yes for the unit of measure you intend to use for the stocking unit (the smallest unit by which you purchase or sell the item if you do not use the Allow Fractional Quantities option).
You can specify only one stocking unit of measure for each item.

Unit Weight
Enter the weight for one stocking unit of the item, using the weight unit of measure that you specify in the Weight Unit of Measure field.
This weight is used in Order Entry to calculate total order weight.

Units of Measure
Enter the name for the unit of measure (for example: dozen, gallon, ton) or select it using the Finder.
If you selected the Use Only Defined UOM option on the I/C Options screen, you must use the Finder to select an existing unit of measure.
Use the Insert key to enter a new unit of measure. Remember that one unit must be the stocking unit of measure.

Weight Unit of Measure
Enter the unit of measure that you use for measuring the weight of one
stocking unit of this item.

Weight units of measure are defined on the I/C Weight Units Of Measure setup screen. The unit of measure includes a conversion factor for converting this unit to the default weight unit of measure specified on the I/C Options screen.

The default weight unit of measure is the weight unit used for calculating the total weight of orders in Order Entry.

Page 3 Items (tax and optional fields information)

Automatically Insert All Tax Authorities
Select this option and click the Create button that appears to add all of the tax authorities defined in your system. You can then delete any authorities that do not apply.

Note: This page is only for exceptions to standard tax settings. For example, if this inventory item is not taxed by most authorities, you would add the tax authorities here, and change the sales or purchase tax classes to non-taxable.

For more information about tax authorities and tax classes, see the help for Tax Services.

Optional Field and Description
Enter a value for any optional fields that appear. If a field is required, you cannot save the item record until you enter the value.

To add optional item fields that were not automatically inserted, press the Insert key to add a new line to the table, and then use the Finder to add the optional field.

Optional fields must be assigned to the Items screen using the I/C Optional Fields screen before you can add them to item records.

When you select an optional field code, Inventory Control displays the description for the optional field.

Purchase Tax Class and Description
Enter the numbers or select the numbers of the tax classes you want to assign to the item for purchases for each selected tax authority.
**Sales Tax Class and Description**

Enter or select the numbers of the tax classes you want to assign to the item for sales for each selected tax authority.

**Tax Authority and Description**

Enter the tax authority or use the Finder to select the tax authorities (such as state or province) that tax sales and/or purchases of the item. Inventory Control displays the tax authority description when you enter a tax authority code.

You may have a long list of authorities if you sell goods in several jurisdictions or countries.

You define taxing authorities in Tax Services in Common Services. For more information about tax authorities and tax classes, see the help for Tax Services.

**Value and Description**

- If the optional field is required, you cannot save the item record until you enter a value.
- If the optional field you selected requires validation, you must select a value that is defined for the optional field in Common Services (unless the optional field allows blanks).
- If you select a value, the description for the value you select will appear in the description column.
- If you delete the value, the optional field will be deleted from the table. If the field is required, you will have to reinsert it and enter a value before you can save the item record.

**Value Set**

This field indicates whether a blank optional field currently has a value. (By looking at the field, you cannot know otherwise whether the field has a default value which is blank, or no value at all.)

The entry in this field will change from No to Yes if you make an entry in the Value field.

**Page 3 B for Serialized Items only**

**Allow Serial Quantity to be Different from the Quantity in the Entries**

Select this option to allow entries to be saved even if the number of
assigned serial numbers is less than the quantity of serialized units that you are working with.

**Example:** Receiving 15 serialized items from a vendor will require you to generate 15 serial numbers during receipt before saving the transaction, unless this option is cleared.

**Contract**
A code of up to six characters to identify the contract, and a description of the contract code in the next field. Contracts can be provided by vendors on the serialized and/or lotted items you purchase from them.

There are options that allow you to place the serial number automatically on warranty or contract when sold, received or registered. Select the three options to enable the respective settings.

**Days to Expiry**
If you want lot numbers to expire after a specified number of days, select the **Days to Expiry** option, and then enter the number of days from creation to expiration.

**Tip:** To enforce the expiration period, you should also select **Warning** or **Error** as the Expired Lot Allocation Message.

**Serial Number Mask**
Select the code for **Serial Numbers Mask** to use as the default for serial numbers that are added to the system.

You can change the serial numbers mask for individual serialized items in the I/C Items screen.

The **Next Serial Number** appears after you select a serial number mask. You can edit the incremental portion of this default number, but it must conform to the mask.

**Warranty Code**
Enter a code of up to six characters that identifies the warranty, and enter a description of the warranty code in the next field. Warranties can be provided to customers on the serialized and/or lotted items they purchase from you.

**Page 3 C for Lotted Items only**

**Allow Lot Quantity to be Different from the Quantity in the Entries**
Select the **Allow Lot Quantities to be Different from the Quantity in Entries** option to allow entries to be saved even if the number of assigned lot numbers is less than the quantity of lotted units that you are working with.

**Example:** Receiving 15 lots from a vendor requires you to generate 15 lot numbers during receipt before saving the transaction, unless this option is cleared.

**Contract**

A code of up to six characters to identify the contract, and a description of the contract code in the next field. Contracts can be provided by vendors on the serialized and/or lotted items you purchase from them.

**Days on Quarantine**

If you want all lots to be quarantined for a number of days after receiving them, select the **Days on Quarantine** option, and then specify the number of days for the quarantine period in the adjacent field. Lots are then automatically placed on quarantine after the receipt is processed.

**Note:** You can release individual lots before the specified period using the Quarantine Release screen.

**Days to Expiry**

If you want lot numbers to expire after a specified number of days, select the **Days to Expiry** option, and then enter the number of days from creation to expiration.

**Tip:** To enforce the expiration period, you should also select **Warning** or **Error** as the Expired Lot Allocation Message.

**Lot Number Mask**

Select the code for the lot number mask to use as the default for lot numbers that you add to Inventory Control.

When you select a code, the program displays the description of the mask in the adjacent field.

**Note:** You can change the mask for a particular item using the I/C Items screen.
The next lot number appears after you select a lot number mask. You can edit the incremental portion of this default number, but it must conform to the mask.

**Warranty**

Enter a code of up to six characters that identifies the warranty, and enter a description of the warranty code in the next field. Warranties can be provided to customers on the serialized and/or lotted items they purchase from you.

There are options that allow you to place the lot number automatically on Warranty or Contract when sold or received. Select the two options to enable the respective settings.

**Page 4 Location Details**

**Allowed**

If you want to allow the item to be used in transactions at the location, select *Yes*.

If you selected the **Allow Items At All Locations** option when you set up I/C Options, Yes is selected by the program. You can change the **Allowed** option to *Yes* or *No* at anytime.

**Alternate Amount (Costing Unit)**

If you added field names to the **Alternate Amount 1 Name** and **Alternate Amount 2 Name** fields on the Processing tab of the Options screen, columns using these names are added to the Location Details screen, where you can enter cost amounts.

You can also use these fields as the base for discount pricing, marking up an alternate cost by percentages or by amounts.

**Automatically Include All Locations**

To add all of your inventory locations to list of locations on this page of the wizard, select this option, enter the default costs for this item at all locations, and click the **Create** button.

You can then select *Yes* in the **Allowed** column for each location where you want to stock this item.
If you did not turn on the **Allow Items At All Locations** option on the I/C Options screen, you must use this screen (or the I/C Location Details screen) to assign the item to each location where you plan to stock it.

If you selected the **Allow Items At All Locations** option, you do not need to add locations here.

**Cost Unit of Measure**

Specify a unit of measure to use when costing transactions for the item at the location.

The program automatically displays the stocking unit you specified for the item in the Items screen. You can accept or override the stocking unit.

**Inventory Minimum (SIA)**

Enter the minimum quantity that must be in inventory at this location.

**Note:** This information is used by Sage Inventory Advisor (SIA). It is also used by the Optimize Inventory screen.

**Lead Time (SIA)**

Enter the number of days it takes after you place an order until the goods arrive at this location.

**Note:** This information is used by Sage Inventory Advisor (SIA). It is also used by the Optimize Inventory screen.

**Last Unit Cost / Costing Unit**

The most recent cost for the item, expressed in the functional currency per costing unit of measure, and exclusive of any additional costs.

**Location**

Specify a location for which to add location details for the item.

You can assign an item to as many locations as you use in your Inventory Control system.

**Most Recent Cost (Costing Unit)**

Enter the most recent cost for the item in the unit selected in the **Cost Unit Of Measure** column.
The program updates the most recent cost each time you process a receipt, transfer, or assembly for the item and run Day End Processing.

**Name**
This field displays the location name.

**Picking Sequence**
Enter a code of up to ten characters (such as an aisle or a bin number) that identifies where the item is kept in the inventory location.

If you specified a default picking sequence in the Items screen, it appears in this field. You can accept or override a default picking sequence.

You can print bin/shelf labels in picking sequence order.

**Set the Costs To**
You can automatically enter the various costs for your items for all of your inventory locations.

If you clicked the Create button before adding the costs, you can delete each location, enter your costs, and then click the Create button again.

You can:

- Specify a standard cost for items that use the standard costing method, or if you use the Markup On Standard Cost option on the item's price list.

- Enter the most recent cost for the item in the unit selected in the Cost Unit Of Measure column.

  The program updates the most recent cost each time you process a receipt, transfer, or assembly for the item and run day-end processing.

- Enter a Last unit cost / costing unit—the most recent cost for the item, expressed in the functional currency per costing unit of measure, and exclusive of any additional costs.

- **Alternate Amount 1 and Alternate Amount 2 (Costing Units).** If you added field names to the Alternate Amount 1 Name and Alternate Amount 2 Name fields on the Processing tab of the I/C Options screen, you can enter costs for these optional cost amounts.

  You can also use these fields as the base for discount pricing, marking up an alternate cost by percentages or by amounts.
Standard Cost (Costing Unit)

Enter your estimated cost (using the functional currency) for the item in the unit selected in the **Cost Unit Of Measure** column.

Specify a standard cost for items that use the standard costing method, or if you use the **Markup On Standard Cost** option on the item's price list.

**Page 5 Vendor Details**

**Cost Unit**

Enter the vendor’s cost unit, such as "ea." or "doz.", or select one using the Finder.

**Order Minimum (SIA)**

Enter the minimum quantity of the item that you must order from this vendor.

**Note:** This information is used by Sage Inventory Advisor (SIA). It is also used by the Optimize Inventory screen.

**Preferred Vendor (SIA)**

If you purchase the item from multiple vendors, you can use this field to specify a preferred vendor.

**Note:** This information is used by Sage Inventory Advisor (SIA). It is also used by the Optimize Inventory screen.

**Vendor Contact**

Enter the name of a contact person at the vendor company. You may use up to 60 characters.

**Vendor Cost**

Enter the vendor’s cost for the item in this field.

**Vendor Currency**

Enter the three-letter code for the vendor’s currency or select one using the Finder.
Vendor Item Number
Enter the number, up to 24 characters long, that the vendor uses to identify the item.

Vendor Name
Enter the name of the contact person or position for the vendor.

Vendor Number
Enter the identification number you use for the vendor of the item.

The Finder is available for this field only if you use Sage 300 ERP Accounts Payable.

Tip: You might want to enter the vendors in order of primary vendor, secondary vendor, and so on.

Vendor Type
Specify the priority (type) to indicate which is the primary vendor, secondary vendor, and so on, of the item. You can change the vendor type at any time by selecting a new one from the drop-down list, but you cannot give two vendors the same type.

You can specify up to nine vendors. The program displays the list of vendors in ascending order from one to nine.

Note: You cannot specify a priority after the record has been added.

Page 6 Item Pricing

Authority and Description
Enter the tax authority or use the Finder to select the taxes that are included by default in the item price.

For example, in Canada the GST can be included or excluded from the item price. You would add the GST to this tab if it is included in the price of this item.

Note: The Finder lists only tax authorities for which the Allow Tax In Price option is selected in Tax Services. If a tax that should be included in the price is not available here, you need to change the option for the tax authority in Tax Services.
Also note that you can change the Tax Included setting when you create invoices in Order Entry.

**Base Price**
You use this field differently depending on your choice for the Base Price Type. If you selected:

- **Base Price for Single Unit of Measure**
  Enter the normal or suggested selling price for the item, and then, in the **Pricing Unit** field, enter the unit on which the base price is expressed.

  To calculate the base price using a cost as a starting point:
  a. Click the Zoom button beside the **Base Price** field to display the Base Price for Multiple Units of Measure screen.
  b. Fill in the fields on the screen that appears.
  c. You must fill in a location for the cost.
  d. Click **Proceed** to return the calculated base price to the Base Price field, where you can edit it.

- **Base Price for Multiple Units of Measure**
  a. Click the Zoom button beside the **Base Price** field to display the Base Price for Multiple Units of Measure screen.

  b. In the table, enter a set of base prices:
     - **Unit of Measure.** Enter the item units or use the Finder to select the item units in which the base price is expressed.
     - **Base Price.** Enter the normal or suggested selling price for this item unit of measure, including in the price any taxes that you assign to the item on the Taxes tab.
     - **Default.** The program forces you to select a default unit of measure and price for entering I/C shipments.

     The first line you enter is automatically set as the default price, and you can only set it to No by choosing a different line as the default.
Double-click the Default column for the line which you want to be the default.

The default price and UOM is in effect only if you do not specify a price for the stocking unit. If you specify a price for the stocking unit, I/C Shipments will automatically use it as the default.

**Note:** In Order Entry, when you specify the unit of measure for an order detail, Order Entry checks to see if you defined a base price for the specified UOM. If you did not define a base price for the specified UOM, Order Entry uses the default pricing UOM.

The default pricing UOM is in effect only if the order UOM does not match a defined pricing UOM.

If you specify a price for the stocking unit, I/C Shipments automatically uses it as the default.

- **Base Price Calculated Using a Cost**
  
a. Click the Zoom button beside the Base Price field to display the Default Base Price screen.
  
b. In the Calculate Base Price Using field, specify whether to add a percentage or amount to the cost.
  
c. In the Cost Base field, select the cost to use as the base.
  
d. In the Percentage / Amount field, enter the percentage or amount that you are adding to a cost.
  
e. If you have a multicurrency system, in the Exchange Rate field, specify the exchange rate or the rate type and rate date.

**Base Price Type**

If you use Sage 300 Premium ERP, you can:

- Enter a base price for a single unit of measure and specify the unit.
  
  (You can select this option, and have Inventory Control calculate the base price using the item cost. After choosing this option, select the Zoom button to perform the calculation.)

- Enter base prices for multiple units of measure, and set a default unit of measure for I/C Shipments.
Note: The default price is in effect only if you do not specify a price for the stocking unit. If you specify a price for the stocking unit, I/C Shipments will automatically use it as the default.

You can still set additional prices for volume or customer type discounts on base prices for multiple units of measure.

- Calculate the base price as the cost plus a percentage or amount.
  
  If you are calculating volume discounts by weight, you cannot calculate the base price from the cost (because the cost is based on quantity).

Check
Specify whether the price check should be done on the unit price or on the sales margin.

Check Base
If you are checking the unit price, you can check that the price falls within a percentage range of the cost, an amount range on the cost, or within a fixed range.

Cost Base
Select the cost on which you are basing the price.

You can select from standard cost, most recent cost, average cost, last cost, or either of the user-specified costs.

Cost / Margin Base
Select the cost on which you are calculating the acceptable range of unit price or sales margin. (This field will not appear if you select a fixed unit price.)

Calculate Sale Price Using
Specify how you are calculating this price from a cost.

Currency Code
Enter a code or use the Finder to select the currency code for the currency in which you want to enter pricing information for the item.

Customer Tax Class and Description
Enter a customer tax class or use the Finder to select one for the tax
authority. Inventory Control displays the tax class description when you enter the tax class code.

**Customer Types**
These letters denote the five possible types of customers to which the discounts or markups you enter apply.

Customer types are assigned to customers in Accounts Receivable.

Inventory Control does not use customer types—Sage 300 ERP Order Entry uses them.

Enter discounts or markups for as many customer types as you use.

**Default Base Price Using**
Select either **Cost Plus a Percentage** or **Cost Plus an Amount** as the method for calculating a default price based on the item cost.

If you have a multicurrency database, you can also select **Cost Converted Using Exchange Rate Plus a Percentage or Amount**.

**Default Sale Price Using**
Select either **Cost Plus a Percentage** or **Cost Plus an Amount** as the method for calculating a default price based on the item cost.

If you have a multicurrency database, you can also select **Cost Converted Using Exchange Rate Plus a Percentage or Amount**.

**Description**
Enter a description you want to appear with the item on price list reports.

This is also the description that appears in Order Entry detail lines and on orders and invoices. This means that you can translate this description for price lists, orders, and invoices in other languages.

The Finder in Inventory Control and Order Entry always uses the description from the I/C Items screen.

**Discount on Price by**
Select the method you want to use to calculate discounts on customer invoices:

- **Percentage**. The program discounts the base price using the percentages you specify in the fields below this field.
Appendix A: Inventory Control Screen Guides

- **Amount.** The program discounts the base price using the amounts you specify in the fields below this field.

**Discount Percentage/Amount**
Enter up to five price discount percentages or amounts (as appropriate) in the fields.

Enter discount amounts in pricing units (include any taxes that are assigned on the Taxes tab).

**Include All Tax Authorities Allowing Tax in the Price**
Select this option and click the Create button to insert all tax authorities defined in your system that allow tax to be included in the price.

For example, in Canada the GST can be included or excluded from the item price. You would add the GST to this tab if it is included in the price of this item.

**Note:** This choice will only insert tax authorities that have the Allow Tax In Price option selected in Tax Services.

If the tax that you want is not included here, you will have to change the option in Tax Services.

Also note that you can change the "tax included" setting when you create invoices in Order Entry if the Tax Included option is selected for the authority in Tax Services.

**Location**
Specify a location for the cost to be used in cost calculation.

**Markup Cost**
If you are setting up the price list to calculate selling prices by marking up your cost, enter a markup cost.

**Markup Factor**
This is a reference field and is not used in the calculation. (Markup cost is the only value used in a calculation.)

**Markup on Cost by**
Select the method you want to use to mark up items to create different prices for different customers or for volume discounts.
- **Percentage.** The program marks up the cost (markup cost or standard cost) using the percentages you specify in the fields below this field.

- **Amount.** The program marks up the cost (markup cost or standard cost) using the amounts you specify in the fields below this field.

**Markup Percentage/Amount**

Enter up to five price markup percentages or markup amounts (as appropriate) in the fields.

Enter markup amounts in pricing units.

**Markup Unit**

Specify the item units in which the markup cost is expressed.

**Percentage / Amount**

Enter the percentage or amount that you are adding to a cost if you are calculating the base/sale price from a cost base plus a percentage or amount.

**Price By**

Specify whether the price of this item is based on weight or on quantity.

**Note:** Pricing by weight is available in Sage 300 Premium ERP only.

If you specify weight, Inventory Control lets you set volume discount amounts or percentages that are determined by item weight.

The weights are calculated in Order Entry by multiplying the unit weight of an item times the quantity ordered, and converting the weight to default units.

**Price Check Type**

Specify how you want Order Entry to respond to price overrides. Order Entry can:

- Do nothing (if you select **None**).
- Display a warning message and let you continue.
- Display an error message and reject the price override.
- Require a supervisor’s approval on price overrides.
**Price Decimals**
Select the number of decimal places you want the program to use for displaying and printing prices and costs.

**Price Determined by**
Select the method you want to use to determine price discounts for items.
- **Customer Type.** Inventory Control determines prices according to the customer’s type (A, B, C, D, or E).
- **Volume Discounts.** Inventory Control determines prices according to the quantity of an item the customer purchases.

**Price List Code**
Enter the code or use the Finder to select the price list code for the price list you want to use.

**Price List Ends**
You can set the period during which this price list is in effect. This means that you can easily cut over from an old price list to a new one on a particular date.
- Enter a start date if you have a new price list that comes into effect on a particular date.
- Enter an end date if the price list expires on a particular date.

The price list is always valid if the starting and ending dates are blank.

If you choose a price list in Order Entry before the start date or after the end date, the program will display an error message and enter a 0.00 price.

**Price List Starts**
You can set the period during which this price list is in effect. This means that you can easily cut over from an old price list to a new one on a particular date.
- Enter a start date if you have a new price list that comes into effect on a particular date.
- Enter an end date if the price list expires on a particular date.

The price list is always valid if the starting and ending dates are blank.
If you choose a price list in Order Entry before the start date or after the end date, the program will display an error message and enter a 0.00 price.

**Pricing Unit**

Enter the item unit of measure or use the Finder to select the unit of measure in which the base price is expressed.

**Quantity Purchased**

Enter up to five quantities in the fields for different quantity discount levels (in the stocking units for the item).

Each quantity you enter corresponds to the amount or percentage discount or markup (as appropriate) that you enter in the field to the left of it.

**Rate Type, Rate Date, and Exchange Rate**

If this is a multicurrency company, specify the rate type, rate date and exchange rate to be applied to the cost to calculate the base or sale price in the price list currency.

**Rounding Method**

Select a rounding method, either **Round Up** or **Round Down**, for the program to use when it calculates customer discount prices. The program uses the selected rounding method when you discount or mark up prices by a percentage.

If you select **No Rounding**, prices appear exactly as calculated, to the number of decimal places your functional currency uses.

**Round to a Multiple of**

Enter the number to which you want the program to round customer discount prices. For example, enter **.05** to round prices that are not already a multiple of .05 to the next such multiple.

The program rounds prices up or down according to your selection in the **Rounding Method** field.

The **Round To A Multiple Of** field does not appear if you selected the **No Rounding** option in the **Rounding Method** field.

**Sale Ends**

If you entered a sale price, select the last date for which the sale price
Sale Price

You use this field differently depending on your choice for Sale Price Type. If you selected:

- **Sale price for a single unit of measure**
  
Enter a sale price for the item if you are including sale prices on price lists.

  **Note:** You can also calculate the sale price using a cost as a starting point, and edit the calculated amount in this field. To do so, click the Zoom button and fill in the fields on the screen that appears. Note that you must fill in a location for the cost, and you must click the Proceed button when finished to return the calculated sale price to the Sale Price field, where you can edit it.

- **Sale prices for multiple units of measure**
  
  If you are entering sale prices for multiple units of measure, click the Zoom button to display the screen for entering multiple units.

  You must also specify the default UOM and price if specifying several sale prices.

  **Note:** In Order Entry, when you specify the unit of measure for an order detail, Order Entry checks to see if you defined a price for the specified UOM. If you did not define a price for the specified UOM, Order Entry will use the default pricing UOM.

  The default pricing UOM is in effect only if the order UOM does not match a defined pricing UOM.

  If you specify a price for the stocking unit, I/C Shipments will automatically use it as the default.

- **Sale price calculated using a cost**
  
  If you are calculating the sale price from a cost, click the Zoom button, and then:

  a. Specify whether to base the price on a single unit of measure.
  b. Click the Zoom button beside the **Sale Price** field to display the **Default Sale Price** screen.
c. Specify:
   - Whether to add a percentage or an amount to the cost.
   - The type of cost.
   - The percentage or amount to add.
   - The exchange rate if a multicurrency database.

**Sale Price Type**

If you use Sage 300 Premium ERP, you can:

- Enter a sale price for a single unit of measure and specify the unit.

  (You can select this option and have Inventory Control provide a starting point for the sale price based on the item cost. After selecting this option, click the Zoom button to perform the calculation.)

- Enter sale prices for multiple units of measure and set a default unit of measure for Order Entry.

  **Note:** The default price is in effect only if you do not specify a price for the stocking unit. If you specify a price for the stocking unit, I/C Shipments will automatically use it as the default.

You can still set additional prices for volume or customer type discounts on sale prices for multiple units of measure.

- Calculate the sale price as the cost plus a percentage or amount.

  If you are calculating volume discounts by weight, you cannot calculate the sale price from the cost (because the cost is based on quantity).

**Sale Starts**

If you entered a sale price, select the first date for which the sale price applies.

**Sale Unit**

If you entered a sale price, enter the item units or use the Finder to select the item units in which that price is expressed.

**Selling Price Based on**

Use this option to specify how the discount prices of items assigned to this
price list will be calculated by default.

- **Discount.** Inventory Control calculates the selling price by discounting your base price for the item.

- **Markup on Markup Cost.** Inventory Control calculates the selling price by marking up your "markup cost" for the item (entered on the previous tab).

- **Markup on Standard Cost/Most Recent Cost/Average Cost/Last Cost/Alternate Amount 1 or 2.** Inventory Control calculates the selling price by marking up the cost you keep for your items (including the value you enter as "Alternate Amount 1" or "Alternate Amount 2" on the I/C Options screen).

  **Note:** If you are pricing by weight, you can choose Discount and Markup On Markup Cost only.

**User ID**

Enter the range of prices available to each user ID for which you want to do a price check.

If you want, you can create several price-approval levels for sales clerks and supervisors.

The default price check range applies to all users who are not specifically listed in the table.

If you delete the price check for the Default user, the program will only perform price checks for the listed user IDs.

**Page 7 Contract Pricing**

**Calculated Unit Price**

This field displays the customer’s unit price for the item calculated according to your previous entries.

This field appears only when you have chosen to price by item number.

**Contract Price Type**

Select a contract price type. Your selection affects the fields that appear (or are active) below the Contract Price Type field.
Copy from Previous Line
Chose this option to automatically copy contract pricing information for each new line from the previous line in the table.

Cost Base
Select a cost base you have set up.

This field appears only if you selected Cost Plus a Percentage or Cost Plus Fixed Amount as the contract price type.

Currency Code
Enter a code or use the Finder to select the currency code for the currency in which you want to enter contract pricing information for this customer and this item.

Customer Number
Enter a customer number or select one using the Finder.

Customer Type
This field appears only if you selected Customer Type as the contract price type.

Available customer types include Base, A, B, C, D or E.

Discount Amount
This field appears only if you selected Discount Amount as the contract price type.

Enter a fixed discount amount.

Discount Percentage
This field appears only if you selected Discount Percentage as the contract price type.

Enter a discount percentage with up to five decimal places.

Expiration Date
Enter a date for the pricing contract to expire. If you do not enter a date, the contract will remain in effect indefinitely.

Fixed Price
Enter a price that will not change.
This field appears only when you select **Fixed Price** as the contract price type.

**Plus Amount ("Fixed Amount") in Contract Pricing**
Enter an amount to be added to the price derived from the cost base you selected.

This field appears (or is used in the Items Wizard) only if you selected **Cost Plus Fixed Amount** as the contract price type.

**Plus Percentage**
Enter a percentage, using up to five decimal points.

This field appears only if you selected **Cost Plus Percentage** as the contract price type.

**Price List**
Enter, or select using the Finder, the price list from which you want to draw the base price for the item you selected.

**Pricing Unit**
Choose the unit of measure to which the contract pricing applies. (For example, a customer may get a discount if they buy by the case, but not on individual items.)

**Start Date**
Select a date to ensure that the contract price will be picked only if the transaction date is after the contract start date.

If you want the contract to be open-ended, leave this field blank.

**Use Lowest Price**
Select this option if you want the program to determine the best price for the customer automatically, regardless of the contract price.

**Page 8 Manufacturers' Item Numbers**

**Comments**
Enter a comment to describe how this item code is used, if necessary.

**Manufacturers' Item Description**
Provide a description of the item code, such as "UPC -- Classic Desk"
Lamp."

**Manufacturers' Item Number**
The manufacturers' item number can be up to 24 characters long (numbers or letters). It must be unique.

**Unit of Measure**
Specify the unit of measure that is used with this code. Manufacturers' item numbers can use any of the units of measure defined for the inventory item.

**Page 9 Customer Details**

**Comments and Instructions**
Add any comments or instructions that you want with the item number.

Comments and instructions entered here will appear in the comments and instructions fields for an order in Order Entry.

**Customer Number and Name**
Select the customer for whom you are adding the item number.

**Customer's Item Description**
Enter the description that your customer uses for the item. You can use this description to verify that you are entering the correct item when entering orders.

**Customer's Item Number**
Enter the number that your customer uses for the inventory item.

**Unit of Measure**
Specify the unit of measure that your customer uses with this item to make sure that orders are filled correctly.

**Page 10 Bills of Material**

**BOM Description**
Enter a description to identify the bill of material you are creating. The description is especially important if you use several alternative BOMs to create the same master item.
BOM Number
Enter a number or code to identify the bill of material you are creating. The code can be up to six characters long, and contain letters and numbers.

The BOM number lets you create alternative bills of material for building the same master item.

The BOM description helps you identify the particular BOM number.

Build Quantity
Enter the number of master items that one assembly of the bill of material produces.

Comments
Enter comments you want to save with the bill of material record.

Components
If the component item is the master item of a subassembly, and you specified the BOM number, this field displays Yes, and you can click the button in the column header to display and subassembly components.

If the BOM number does not exist, you can add the subassembly components on the BOM screen that appears.

End Date
This is the period of time during which the master item can be assembled.

For example, you might keep a particular master items in stock only for the duration of a contract.

Fixed Cost
Enter the setup cost for assembling the bill of material.

The fixed cost is a one-time cost that is the same regardless of how many units you assemble of the master item. For example, the time required to prepare an assembly line is a fixed cost.

Inactive
Select this option if you want to keep this BOM but do not want it to be assembled.
For example, you might make a seasonal BOM inactive for most of the year, or you might have a BOM that is used as a template for several component BOMs but is never assembled in its entirety.

You can change the option from Inactive to Active at any time.

**Start Date**
This is the period of time during which the master item can be assembled.

For example, you might keep a particular master item in stock only for the duration of a contract.

**Unit of Measure**
Enter the unit of measure (UOM) or use the Finder to select the unit of measure that you want to assign to the master items that you create when you assemble the bill of material.

**Note:** The Finder lists the units of measure that have been assigned to the master item on the Units tab of the I/C Items screen. If you want to use a different UOM, you must add it to the master item record.

**Use as Default**
Specify whether the BOM number is used by default on the I/C Assemblies/Disassemblies screen when you select the BOM item.

**Notes:**
- Even if you select this option, the BOM number is not used by default in Order Entry.
- This information is also used by Sage Inventory Advisor (SIA).

**Variable Cost**
Enter the cost for one assembly of the bill of material. (One assembly produces the "build quantity" of master items.)

**Page 11 Reorder Quantities**

**Copy from Previous Line**
Chose this option to automatically copy reorder information for each new line (period) from the previous line in the table.
**Maximum Quantity**

Enter the maximum number of units (in the item's stocking units) you want in stock at any time for the item during the specified period. If more than this specified number of units are in stock during the period, the item appears on the Overstocked Items report.

Inventory Control calculates the quantity available as the quantity in stock, plus the quantity on purchase order, minus the quantity on sales order.

**Minimum Quantity**

Enter the minimum number of units (in the item's stocking units) you want in inventory for the item during the specified period.

If fewer than this specified number of units are in stock during the period, the item appears on the Reorder Report.

**Optional Fields**

If optional fields were defined for this screen, click the zoom button, then add or edit optional field information as follows:

- Fill in the value field for any optional fields that appear.
  
  If a field is required, you cannot save the item record until you fill in the value.

- To add optional item fields that were not automatically inserted, use the Insert key to add a new line to the table, and then use the Finder to add the optional field.

- When you select an optional field code, the program displays the description for the optional field.

Optional fields must be assigned to the Items screen using the I/C Optional Fields screen before you can add them to item records.

**Period Start**

Enter the date (month and day) of the first day for which you want the reorder criteria to apply.

If you add reorder criteria for more than one period in a 12-month period, then the current reorder criteria are in effect until the next period starting date.
For example, if you add different reorder criteria for periods starting on the first day of every month beginning with December 1st of the current year, then the first reorder criteria expire on December 31 and the next reorder criteria take effect on January 1st of the next year.

**Projected Sales Qty**
Enter the number of units of the item (in the item’s stocking units) you expect to sell during the specified period.

**Reorder for (Location)**
Enter a location code or use the Finder to select an inventory location. You must have previously allowed the item to be stocked at the location.

**Reorder Quantity**
Enter the number of units (in the item’s stocking units) that you want to order during the specified period when either:

- The number of the items in stock is less than the amount you specified in the **Minimum Quantity** field, or
- The projected sales of the item for the period is greater than the amount of the item in stock.

**Unit of Measure**
The program displays the stocking unit of measure from the item record. You enter reorder information in stocking units.

**I/C Item Pricing Screen**

To open this screen:
1. Open **Inventory Control > I/C Items and Price Lists > Item Pricing**.
2. Use the Finder or the navigation buttons for the **Item Number** field to display the item you need, and then do one of the following:
   - To add the item to a price list, click **New**.
   - To update an item on a price list, select (highlight) the item on the table, and then click **Open**.

**Related tasks:**
- "Adding Items to Price Lists" (page 91)
Appendix A: Inventory Control Screen Guides

- "Changing Pricing Information for Single Items" (page 102)

Overview

Use the I/C Item Pricing screen to:

- Assign items to price lists.
- Specify and edit item pricing information for each price list. If you have Sage 300 Premium ERP, you can also:
  - Price volume discounts by quantity or weight.
  - Enter one or more base prices for multiple units of measure.
  - Calculate the base price using the cost plus a percentage or amount.
- Edit discount or markup information for calculating item prices.
- Assign the tax authorities and customer tax classes for taxes that are included in the item price.
- Set checks for price overrides in Order Entry.
- Remove items from a price list.

Inventory Control uses price lists for reporting purposes only.
Order Entry uses price lists to calculate the prices of goods, taxes, and discounts on customer orders and invoices.

Discounts Tab

Use the Discounts tab to:

- Specify whether to calculate additional prices for the item based on the selling (base) price or a markup of the markup cost, standard cost, most recent cost, average cost, last cost, or alternate costs 1 or 2 (if you added them).
- Select the method for calculating discount or markup prices and enter the discount/markup percentages or amounts to use.

Price Check Tab

**Note:** This tab appears only if you are using Sage 300 Premium ERP.
Use the Price Check tab to specify how to handle price overrides in Order Entry for orders that use this price list. Order Entry can:

- Do nothing. (If you choose None for the Price Check Type, the rest of this tab remains blank.)
- Display a warning message when prices exceed the boundaries you define, and let you continue.
- Display an error message and reject the price override.
- Force you to get a supervisor’s approval on price overrides.

The Default price check range applies to all users who are not specifically listed in the table.

**Prices Tab**

Use the Prices tab to:

- Enter a new description for the item on the price list.
- Specify the number of decimals to use in item prices.
- Choose the base price type (single unit of measure, multiple units of measure, or calculated on cost).
- Enter the base price, prices, or price calculation method.
- Enter the pricing unit for a single base price.
- If entering prices for multiple UOMs, specify the default price and UOM for shipments. (The default price is in effect only if you do not specify a price for the stocking unit. If you specify a price for the stocking unit, I/C Shipments will automatically use it as the default.)
- Choose the sale price type (single unit of measure, multiple units of measure, or calculated on cost).
- Enter a sale price, prices, or price calculation method.
- Enter the pricing unit for a single base price.
- If entering prices for multiple UOMs, specify the default price and UOM for shipments. (The default price is in effect only if you do not specify a price for the stocking unit. If you specify a price for the stocking unit, I/C Shipments will automatically use it as the default.)
• Enter the sale dates for the item.
• Specify the item’s markup cost, markup unit, and markup factor.

**Taxes Tab**

**Note:** This tab appears only if Tax Services is activated for your system.

Use the Taxes tab to assign the tax authorities and customer tax classes for taxes that are included by default in the item price.

**Tip:** The Finder lists only tax authorities that have the Allow Tax In Price option selected in Tax Services.

**Fields and Controls**

**Currency Code**

Enter a code or use the Finder to select the currency code for the currency in which you want to enter pricing information for the item.

**Item Number**

Enter an item number or use the Finder to select the number of the item for which you want to enter pricing information.

**Price List Code**

Enter the code or use the Finder to select the price list code for the price list you want to use.

**Discounts Tab**

**Customer Types**

These letters denote the five possible types of customers to which the discounts or markups you enter apply.

Customer types are assigned to customers in Accounts Receivable.

Inventory Control does not use customer types—Sage 300 ERP Order Entry uses them.

Enter discounts or markups for as many customer types as you use.
Discount on Price By
Select the method you want to use to calculate discounts on customer invoices:

- **Percentage.** The program discounts the base price using the percentages you specify in the fields below this field.

- **Amount.** The program discounts the base price using the amounts you specify in the fields below this field.

Discount Percentage/Amount
Enter up to five price discount percentages or amounts (as appropriate) in the fields.

Enter discount amounts in pricing units (include any taxes that are assigned on the Taxes tab).

Markup On Cost By
Select the method you want to use to mark up items to create different prices for different customers or for volume discounts.

- **Percentage.** The program marks up the cost (markup cost or standard cost) using the percentages you specify in the fields below this field.

- **Amount.** The program marks up the cost (markup cost or standard cost) using the amounts you specify in the fields below this field.

Markup Percentage/Amount
Enter up to five price markup percentages or markup amounts (as appropriate) in the fields.

Enter markup amounts in pricing units.

Price Determined By
Select the method you want to use to determine price discounts for items.

- **Customer Type.** Inventory Control determines prices according to the customer’s type (A, B, C, D, or E).

- **Volume Discounts.** Inventory Control determines prices according to the quantity of an item the customer purchases.

Quantity Purchased
Enter up to five quantities in the fields for different quantity discount
levels (in the stocking units for the item).

Each quantity you enter corresponds to the amount or percentage discount or markup (as appropriate) that you enter in the field to the left of it.

**Round to a Multiple Of**

Enter the number to which you want the program to round customer discount prices. For example, enter .05 to round prices that are not already a multiple of .05 to the next such multiple.

The program rounds prices up or down according to your selection in the **Rounding Method** field.

The **Round To A Multiple Of** field does not appear if you selected the **No Rounding** option in the **Rounding Method** field.

**Rounding Method**

Select a rounding method, either **Round Up** or **Round Down**, for the program to use when it calculates customer discount prices. The program uses the selected rounding method when you discount or mark up prices by a percentage.

If you select **No Rounding**, prices appear exactly as calculated, to the number of decimal places your functional currency uses.

**Selling Price Based On**

Use this option to specify how the discount prices of items assigned to this price list will be calculated by default.

- **Discount.** Inventory Control calculates the selling price by discounting your base price for the item.

- **Markup on Markup Cost.** Inventory Control calculates the selling price by marking up your "markup cost" for the item (entered on the previous tab).

- **Markup on Standard Cost/Most Recent Cost/Average Cost/Last Cost/Alternate Amount 1 or 2.** Inventory Control calculates the selling price by marking up the cost you keep for your items (including the value you enter as "Alternate Amount 1" or "Alternate Amount 2" on the I/C Options screen).
Note: If you are pricing by weight, you can choose Discount and Markup On Markup Cost only.

Price Check Tab

Check
Specify whether the price check should be done on the unit price or on the sales margin.

Check Base
If you are checking the unit price, you can check that the price falls within a percentage range of the cost, an amount range on the cost, or within a fixed range.

Cost/Margin Base
Select the cost on which you are calculating the acceptable range of unit price or sales margin. (This field will not appear if you select a fixed unit price.)

Price Check Type
Specify how you want Order Entry to respond to price overrides. Order Entry can:
- Do nothing (if you select None).
- Display a warning message and let you continue.
- Display an error message and reject the price override.
- Require a supervisor’s approval on price overrides.

User ID
Enter the range of prices available to each user ID for which you want to do a price check.

If you want, you can create several price-approval levels for sales clerks and supervisors.

The default price check range applies to all users who are not specifically listed in the table.

If you delete the price check for the Default user, the program will only perform price checks for the listed user IDs.
**Prices Tab**

**Base Price**
You use this field differently depending on your choice for the Base Price Type. If you selected:

- **Base Price for Single Unit of Measure**
  Enter the normal or suggested selling price for the item, and then, in the Pricing Unit field, enter the unit on which the base price is expressed.

To calculate the base price using a cost as a starting point:

a. Click the Zoom button beside the Base Price field to display the Base Price for Multiple Units of Measure screen.

b. Fill in the fields on the screen that appears.

c. You must fill in a location for the cost.

d. Click **Proceed** to return the calculated base price to the Base Price field, where you can edit it.

- **Base Price for Multiple Units of Measure**
  a. Click the Zoom button beside the Base Price field to display the Base Price for Multiple Units of Measure screen.

b. In the table, enter a set of base prices:
   - **Unit of Measure.** Enter the item units or use the Finder to select the item units in which the base price is expressed.
   - **Base Price.** Enter the normal or suggested selling price for this item unit of measure, including in the price any taxes that you assign to the item on the Taxes tab.
   - **Default.** The program forces you to select a default unit of measure and price for entering I/C shipments.
   - The first line you enter is automatically set as the default price, and you can only set it to No by choosing a different line as the default.
   - Double-click the Default column for the line which you want to be the default.
The default price and UOM is in effect only if you do not specify a price for the stocking unit. If you specify a price for the stocking unit, I/C Shipments will automatically use it as the default.

**Note:** In Order Entry, when you specify the unit of measure for an order detail, Order Entry checks to see if you defined a base price for the specified UOM. If you did not define a base price for the specified UOM, Order Entry uses the default pricing UOM.

The default pricing UOM is in effect only if the order UOM does not match a defined pricing UOM.

If you specify a price for the stocking unit, I/C Shipments automatically uses it as the default.

- **Base Price Calculated Using a Cost**
  
  a. Click the Zoom button beside the **Base Price** field to display the Default Base Price screen.
  
  b. In the **Calculate Base Price Using** field, specify whether to add a percentage or amount to the cost.
  
  c. In the **Cost Base** field, select the cost to use as the base.
  
  d. In the **Percentage / Amount** field, enter the percentage or amount that you are adding to a cost.
  
  e. If you have a multicurrency system, in the **Exchange Rate** field, specify the exchange rate or the rate type and rate date.

**Base Price Type**

If you use Sage 300 Premium ERP, you can:

- Enter a base price for a single unit of measure and specify the unit.
  
  (You can select this option, and have Inventory Control calculate the base price using the item cost. After choosing this option, select the Zoom button to perform the calculation.)

- Enter base prices for multiple units of measure, and set a default unit of measure for I/C Shipments.
Note: The default price is in effect only if you do not specify a price for the stocking unit. If you specify a price for the stocking unit, I/C Shipments will automatically use it as the default.

You can still set additional prices for volume or customer type discounts on base prices for multiple units of measure.

- Calculate the base price as the cost plus a percentage or amount.

  If you are calculating volume discounts by weight, you cannot calculate the base price from the cost (because the cost is based on quantity).

**Calculate Base Price Using**
Specify how you are calculating this price from a cost.

**Calculate Sale Price Using**
Specify how you are calculating this price from a cost.

**Cost Base**
Select the cost on which you are basing the price.

You can select from standard cost, most recent cost, average cost, last cost, or either of the user-specified costs.

**Default Base Price Using**
Select either Cost Plus a Percentage or Cost Plus an Amount as the method for calculating a default price based on the item cost.

If you have a multicurrency database, you can also select Cost Converted Using Exchange Rate Plus a Percentage or Amount.

**Default Sale Price Using**
Select either Cost Plus a Percentage or Cost Plus an Amount as the method for calculating a default price based on the item cost.

If you have a multicurrency database, you can also select Cost Converted Using Exchange Rate Plus a Percentage or Amount.

**Description**
Enter a description you want to appear with the item on price list reports.
This is also the description that appears in Order Entry detail lines and on orders and invoices. This means that you can translate this description for price lists, orders, and invoices in other languages.

The Finder in Inventory Control and Order Entry always uses the description from the I/C Items screen.

**Location**
Specify a location for the cost to be used in cost calculation.

**Markup Cost**
If you are setting up the price list to calculate selling prices by marking up your cost, enter a markup cost.

**Markup Factor**
This is a reference field and is not used in the calculation. (Markup cost is the only value used in a calculation.)

**Markup Unit**
Specify the item units in which the markup cost is expressed.

**Price By**
Specify whether the price of this item is based on weight or on quantity.

*Note:* Pricing by weight is available in Sage 300 Premium ERP only.

If you specify weight, Inventory Control lets you set volume discount amounts or percentages that are determined by item weight.

The weights are calculated in Order Entry by multiplying the unit weight of an item times the quantity ordered, and converting the weight to default units.

**Price Decimals**
Select the number of decimal places you want the program to use for displaying and printing prices and costs.

**Price List Starts/Ends**
You can set the period during which this price list is in effect. This means that you can easily cut over from an old price list to a new one on a particular date.
• Enter a start date if you have a new price list that comes into effect on a particular date.

• Enter an end date if the price list expires on a particular date.

The price list is always valid if the starting and ending dates are blank.

If you choose a price list in Order Entry before the start date or after the end date, the program will display an error message and enter a 0.00 price.

**Location**
Specify a location for the cost to be used in cost calculation.

**Percentage/Amount**
Enter the percentage or amount that you are adding to a cost if you are calculating the base/sale price from a cost base plus a percentage or amount.

**Pricing Unit**
Enter the item unit of measure or use the Finder to select the unit of measure in which the base price is expressed.

**Rate Type, Rate Date, and Exchange Rate**
If this is a multicurrency company, specify the rate type, rate date and exchange rate to be applied to the cost to calculate the base or sale price in the price list currency.

**Sale Ends**
If you entered a sale price, select the last date for which the sale price applies.

**Sale Price**
You use this field differently depending on your choice for **Sale Price Type**. If you selected:

• **Sale price for a single unit of measure**

  Enter a sale price for the item if you are including sale prices on price lists.
Note: You can also calculate the sale price using a cost as a starting point, and edit the calculated amount in this field. To do so, click the Zoom button and fill in the fields on the screen that appears. Note that you must fill in a location for the cost, and you must click the Proceed button when finished to return the calculated sale price to the Sale Price field, where you can edit it.

- **Sale prices for multiple units of measure**

  If you are entering sale prices for multiple units of measure, click the Zoom button to display the screen for entering multiple units.

  You must also specify the default UOM and price if specifying several sale prices.

  Note: In Order Entry, when you specify the unit of measure for an order detail, Order Entry checks to see if you defined a price for the specified UOM. If you did not define a price for the specified UOM, Order Entry will use the default pricing UOM.

  The default pricing UOM is in effect only if the order UOM does not match a defined pricing UOM.

  If you specify a price for the stocking unit, I/C Shipments will automatically use it as the default.

- **Sale price calculated using a cost**

  If you are calculating the sale price from a cost, click the Zoom button, and then:

  a. Specify whether to base the price on a single unit of measure.

  b. Click the Zoom button beside the Sale Price field to display the Default Sale Price screen.

  c. Specify:

     - Whether to add a percentage or an amount to the cost.
     - The type of cost.
     - The percentage or amount to add.
     - The exchange rate if a multicurrency database.
Sale Price Type

If you use Sage 300 Premium ERP, you can:

- Enter a sale price for a single unit of measure and specify the unit.
  (You can select this option and have Inventory Control provide a starting point for the sale price based on the item cost. After selecting this option, click the Zoom button to perform the calculation.)
- Enter sale prices for multiple units of measure and set a default unit of measure for Order Entry.

  **Note:** The default price is in effect only if you do not specify a price for the stocking unit. If you specify a price for the stocking unit, I/C Shipments will automatically use it as the default.

  You can still set additional prices for volume or customer type discounts on sale prices for multiple units of measure.

- Calculate the sale price as the cost plus a percentage or amount.
  If you are calculating volume discounts by weight, you cannot calculate the sale price from the cost (because the cost is based on quantity).

Sale Starts

If you entered a sale price, select the first date for which the sale price applies.

Sale Unit

If you entered a sale price, enter the item units or use the Finder to select the item units in which that price is expressed.

Taxes Tab

**Authority and Description**

Enter the tax authority or use the Finder to select the taxes that are included by default in the item price.

For example, in Canada the GST can be included or excluded from the item price. You would add the GST to this tab if it is included in the price of this item.
**Note:** The Finder lists only tax authorities for which the **Allow Tax In Price** option is selected in Tax Services. If a tax that should be included in the price is not available here, you need to change the option for the tax authority in Tax Services.

Also note that you can change the Tax Included setting when you create invoices in Order Entry.

**Customer Tax Class and Description**

Enter a customer tax class or use the Finder to select one for the tax authority. Inventory Control displays the tax class description when you enter the tax class code.

**I/C Kitting Items Screen**

**To open this screen:**

Open **Inventory Control > I/C Items and Price Lists > Kitting Items**.

**Related tasks:**

- "Adding Kitting Items" (page 162)
- "Tracking Serialized or Lotted Item Components" (page 261)

**Overview**

Use the I/C Kitting Items screen to set up collections of items that are priced and sold as a single item.

Kitting items are collections of items that are priced and sold through Order Entry as a single item, and are often collected together at sale time—such as a particular computer, keyboard, and monitor combination, or a back-to-school binder, pencil case, and felt pen set.

The cost of a kit is based on each individual item in the kit. If the price is based on costs, it is determined by the cost of all the items together.

**Important!** You use the I/C Items screen to add a kitting (master) item record and all of the component item records. Then, you specify the kit contents using the I/C Kitting Items screen.

**Fields and Controls**

**Comments**
Enter comments to be saved with the kitting item record.

**Component Item Number**
Select an item as a component of the kit.

**Description**
Add a description for this kitting assembly. This is especially useful if you have alternative kits for the same master item number.

**Item Number**
Specify the item number you want to use as the master item for the kitting item.

The Finder will display only items for which you have selected the Kitting Item option.

**Kitting Number**
Enter a number for the kitting item assembly that you are creating, and then click the Go button to proceed.

You could have several alternative sets of components for building the same kitting item. For example, you might have black, red, or green binders in back-to-school kits.

**Quantity**
Double-click this field and then enter the number of items for this component.

**Unit Cost**
Enter the cost of using this component in the kitting item.

**Unit of Measure**
Enter the stocking unit of measure for the kitting item, or verify that the displayed information is correct.

**Use as Default**
Specify whether the kitting number is used by default in Order Entry when you select the kitting item.

**I/C Location Details Screen**

To open this screen:
Open Inventory Control > I/C Items and Price Lists > Location
Details.

Related tasks:
- "Assigning Items to Locations" (page 138)
- "Adding Picking Sequences / Bin Numbers to Items" (page 141)
- "Viewing Location Details for an Item" (page 140)

Overview

Use the I/C Location Details screen to:
- Enter costing information for items at each location where you allow the item to be stocked.
- Look up information about the locations where you stock individual items.
- Specify the locations at which you allow items to be stocked.
- Specify the locations at which you allow items to be used in transactions.
- View the number of items at each location on purchase order, on sales order, and committed to orders.
- View and edit the last cost for purchasing an item.
- View the serial or lot cost for an item (if working with a serialized and/or lotted item that uses the serial or lot costing methods)

Note: You use the Location Details screen to assign inventory items to each location where you want to stock them, unless the option Allow Items At All Locations is selected in the I/C Options screen.

You can assign an item to as many locations as you want, but you must assign it to at least one location before you can post transactions for that item.

You must also allow items to be stocked at goods-in-transit locations if you want to use them to transfer items.

Fields and Controls

Buttons

Serial Cost/Lot Cost

If you are working with a serialized and/or lotted item that uses one of the Serial or Lot costing methods, you can click these buttons to view
additional item information, including the serial or lot cost, stock date, status, and vendor.

**Allowed**

If you want to allow the item to be used in transactions at the location, select **Yes**.

If you selected the **Allow Items At All Locations** option when you set up I/C Options, Yes is selected by the program. You can change the **Allowed** option to **Yes** or **No** at anytime.

**Alternate Amount**

If you added field names to the **Alternate Amount 1 Name** and **Alternate Amount 2 Name** fields on the Processing tab of the Options screen, columns using these names are added to the Location Details screen, where you can enter cost amounts.

You can also use these fields as the base for discount pricing, marking up an alternate cost by percentages or by amounts.

**Average Cost**

This column displays the average cost for the item for the unit of measure you selected in the **Cost Unit Of Measure** field.

The average cost is calculated as the total item cost multiplied by the costing unit's conversion factor, divided by the quantity on hand.

**Note:** Average costs are calculated from posted transactions; you do not enter them.

**Cost Unit of Measure**

Specify a unit of measure to use when costing transactions for the item at the location.

The program automatically displays the stocking unit you specified for the item in the Items screen. You can accept or override the stocking unit.

**In Use**

This field displays Yes if transactions have been posted for the item at the location, or No if no transactions have been posted for the item.

**Inventory Minimum (SIA)**

Enter the minimum quantity that must be in inventory at this location.
**Note:** This information is used by Sage Inventory Advisor (SIA). It is also used by the Optimize Inventory screen.

**Item Number**
Specify the item number for which you are adding location details.

**Lead Time (SIA)**
Enter the number of days it takes after you place an order until the goods arrive at this location.

**Location**
Specify a location for which to add location details for the item.

You can assign an item to as many locations as you use in your Inventory Control system.

**Most Recent Cost**
Enter the most recent cost for the item in the unit selected in the **Cost Unit Of Measure** column.

The program updates the most recent cost each time you process a receipt, transfer, or assembly for the item and run Day End Processing.

**Name**
This field displays the location name.

**Picking Sequence**
Enter a code of up to ten characters (such as an aisle or a bin number) that identifies where the item is kept in the inventory location.

If you specified a default picking sequence in the Items screen, it appears in this field. You can accept or override a default picking sequence.

You can print bin/shelf labels in picking sequence order.

**Quantity Available to Ship**
This field displays the number of stocking units of the item that can be shipped.
This figure is calculated as the difference between quantity on hand and quantity committed for orders in Order Entry.

**Note:** If you do not use Sage 300 ERP Order Entry, the quantity available to ship is the same as the item's quantity on hand.

**Quantity Committed**

This column displays the number of units of the item that have been committed in Sage 300 ERP Order Entry but not yet shipped. The quantities in this column are updated when you post transactions in Order Entry.

If you do not use Sage 300 ERP Order Entry, the column displays zeroes.

To drill down to more detail, highlight the location you want, and then click the Drilldown button to see document details. You can drill down again to specific sales orders.

**Quantity on Hand**

This field displays the item quantity on hand at each location, in the item's stocking unit of measure.

These figures are updated when you post receipts, shipments, and other transactions involving the item.

**Quantity on P/O**

This column displays the number of units of the item that are on purchase order in Sage 300 ERP Purchase Orders, if you use that program. The quantities in this column are updated when you post transactions in Purchase Orders.

If you do not use Sage 300 ERP Purchase Orders, the column displays zeroes.

To drill down to more detail, highlight the location you want, and then click the Drilldown button to see document details. You can drill down again to specific sales orders.

**Quantity on S/O**

This column displays the number of units of the item that are on sales order in Sage 300 ERP Order Entry, if you use that program. The quantities in this column are updated when you post transactions in Order Entry.

If you do not use Sage 300 ERP Order Entry, the column displays zeroes.
To drill down to more detail, highlight the location you want, and then click the Drilldown button to see document details. You can drill down again to specific sales orders.

**Standard Cost**

Enter your estimated cost (using the functional currency) for the item in the unit selected in the **Cost Unit Of Measure** column.

Specify a standard cost for items that use the standard costing method, or if you use the **Markup On Standard Cost** option on the item's price list.

**I/C Manufacturers' Items Screen**

**To open this screen:**
Open **Inventory Control > I/C Items and Price Lists > Manufacturers' Items**.

**Related tasks:**
"Adding Bar Codes / Manufacturers' Numbers to Items" (page 142)

**Overview**

Use the I/C Manufacturers' Items screen to associate additional numbers with the items in your inventory. You can:

- Use manufacturers' bar codes (or UPC and ISBN codes) for entering transactions in Inventory Control, Order Entry, or Purchase Orders.

  Manufacturers' item numbers are automatically translated during data entry to your inventory item numbers.

  **Note:** Manufacturers' item codes also provide a unit of measure, so you can assign different codes for single items, a box, or a pallet.

- Simplify data entry by creating a set of shortcut item numbers for your most popular items.

You can add as many manufacturers' item numbers as you need for each item number.

**Fields and Controls**

**Comment**
Enter a comment to describe how this item code is used, if necessary.
Item Number
Enter or select the item for which you are adding manufacturers' item numbers.

Manufacturers' Item Description
Provide a description of the item code, such as "UPC -- Classic Desk Lamp."

Manufacturers' Item Number
The manufacturers' item number can be up to 24 characters long (numbers or letters). It must be unique.

Unit of Measure
Specify the unit of measure that is used with this code. Manufacturers' item numbers can use any of the units of measure defined for the inventory item.

I/C Optimize Inventory Screen

To open this screen:
Open Inventory Control > I/C Items and Price Lists > Optimize Inventory.

Related tasks:
- "Optimizing Item Reorder Quantities" (page 147)

Overview
Use the Optimize Inventory screen to optimize minimum and maximum quantities for item reorder. Using sales data, Sage 300 ERP calculates optimal item reorder quantities based on a just-in-time inventory management model. You can select some or all of the recommended changes, and then automatically update the quantities specified on the Reorder Quantities screen.

Optimal item reorder quantities are calculated for the year/period specified in the Specify Criteria section at the top of the screen.

By default, the Year/Period field displays the current fiscal year and period. To ensure that optimal item reorder quantities are calculated correctly, you should not change this default. However, there are situations when you may want to change the year/period.

By changing the year/period, you can use the Optimize Inventory screen to see statistical data for past years and periods.
For example, to see statistics for non-seasonal items from 2009, you would specify the following:

- In the **Year/Period** field: 2010 period 1.
- In the **Sales Periods** field on the Options screen: 12 (or 13, if you use 13 fiscal periods).

This is particularly useful for seeing statistics about items that are sold both individually and as part of a kit, because statistics are not kept elsewhere for units sold with kits.

The specific periods used to calculate reorder quantities for an item are determined by:

- The number of periods used in calculating reorder quantities. This is specified in the **Sales Periods** field on the Optimizer tab of the Options screen. For more information, see "I/C Options Screen" (page 588).
- Whether or not the item is seasonal.

For non-seasonal items, Period 1 is the period immediately preceding the current year/period.

For seasonal items, Period 1 is the same period as the current period, but from the previous year.

You specify that an item is seasonal by selecting the **Seasonal** option on the Items screen. For more information, see "I/C Items Screen" (page 396).

**Example:**
If the **Year/Period** field is set to 2015 period 6, and the number of periods is set to 3 (on the Options screen), the following periods are used in the calculations:

- Non-seasonal items:
  - Period 1 = 2015 period 5
  - Period 2 = 2015 period 4
  - Period 3 = 2015 period 3
Appendix A: Inventory Control Screen Guides

- Seasonal items:
  - Period 1 = 2014 period 6
  - Period 2 = 2014 period 7
  - Period 3 = 2014 period 8

**Notes:**
- Reorder quantities for an item are not updated if All Locations is selected for the item in the **Reorder for** field on the Reorder Quantities screen.

- After you click **Go**, the fields in the **Specify Criteria** section can no longer be changed. And even if you close the screen, the information shown on the screen is saved, allowing you to later resume working where you stopped. This can be helpful if you are reviewing a long list of items, and you cannot finish at one time. To enter new criteria, you must click **Clear**.

- If you export data from this screen, do not click **Clear** before importing the data, because doing so prevents the import from working correctly.

- If you use Sage 300 ERP Purchase Orders to create purchase orders automatically based on reorder quantities defined in Inventory Control, ensure that items on the Reorder Quantities screen have a full year’s set of periods: 12 (or 13, if you use 13 fiscal periods). If you use the Optimize Inventory screen to update reorder quantities for an item that does not have a full year’s set of periods, when you create purchase orders for that item, projected sales quantities may be incorrect.

**Fields and Controls**

**Buttons**

- **Apply Selected Changes**
  Changes item reorder quantities for the specified year/period to the **Order Minimum** and **Order Maximum** displayed in the rows that are selected in the table.

- **Clear**
  Clears all information from the screen, and sets the **Year/Period** field to the current fiscal year and period.
Close
Closes the screen.

**Note:** If you close the screen, the information shown on the screen is saved, allowing you to later resume working where you stopped. This can be helpful if you are reviewing a long list of items, and you cannot finish at one time.

**Account Set (From / To)**
Specify the range of account sets that are assigned to items for which you want to optimize reorder quantities.

**Category (From / To)**
Specify the range of categories that include items for which you want to optimize reorder quantities.

**Current Maximum**
Displays the total cost of current maximum reorder quantities for all items shown in the table.

**Current Minimum**
Displays the total cost of current minimum reorder quantities for all items shown in the table.

**Filter Results**
You can refine the list of results shown in the table by selecting a filter:

- **All.** The table displays all items that match the criteria specified in the top part of the screen.
- **Recommendations to increase minimum.** The table displays only items for which the order minimum is more than the current minimum.
- **Recommendations to decrease minimum.** The table displays only items for which the order minimum is less than the current minimum.
- **Understocked items (based on recommended minimum).** The table displays only items for which the order minimum is more than the quantity available.
- **Overstocked items (based on recommended maximum).** The table displays only items for which the order maximum is less than the quantity available.
**Item Number (From / To)**
Specify a range of items for which you want to optimize reorder quantities.

**Location**
Specify whether to search for items at all locations or at one specific location. If you select **Specific Location**, a field appears in which you specify a location.

**Order Maximum**
Displays the total cost of order maximum quantities for all items shown in the table.

**Order Minimum**
Displays the total cost of order minimum quantities for all items shown in the table.

**Quantity Available**
Displays the total cost of all available inventory for items shown in the table.

**Summary**
Select this option to hide the **Period** fields in the table.

**To Update to Order Maximum**
Displays the total cost to change your available inventory for all items shown in the table to the order maximum.

**Note:** If you have more inventory than the order maximum, this field displays a negative number.

**To Update to Order Minimum**
Displays the total cost to change your available inventory for all items shown in the table to the order minimum.

**Note:** If you have more inventory than the order minimum, this field displays a negative number.

**Variance for Maximum**
Displays the difference between the total cost of current and order maximum quantities for all items shown in the table.
**Note:** If the cost for current maximum quantities is more than the cost for order maximum quantities, this field displays a negative number.

**Variance for Minimum**
Displays the difference between the total cost of current and order minimum quantities for all items shown in the table.

**Note:** If the cost for current minimum quantities is more than the cost for order minimum quantities, this field displays a negative number.

**Vendor Number (From / To)**
Specify the range of vendors who sell items for which you want to optimize reorder quantities.

**Year/Period**
Specify the year and period for which you want to optimize item reorder quantities.

By default, this field displays the current fiscal year and period. To ensure that optimal item reorder quantities are calculated correctly, you should not change this default.

**Table**
The table includes a separate row for each location at which you stock an item, allowing you to control item reorder quantities for each location.

**Note:** If no locations are specified for an item (on the Location Details screen), the table does not include any rows for the item, even if the item matches your search criteria.

**Account Set**
Displays the general ledger account set that is assigned to the item.

**Average Sales**
Displays expected sales in the current period, based on a weighted average calculation.
Example:
Suppose you use a fiscal calendar with 12 periods, the Year/Period field is set to 2015 period 6 (June), and the number of periods is set to 3 (on the Options screen). The following table shows how weighted sales for a non-seasonal item are calculated:

<table>
<thead>
<tr>
<th>Period</th>
<th>Period Weight*</th>
<th>Unit Sales</th>
<th>Weighted Sales (Period Weight × Unit Sales)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Period 1 = May, 2015</td>
<td>3</td>
<td>58</td>
<td>174</td>
</tr>
<tr>
<td>Period 2 = April, 2015</td>
<td>2</td>
<td>52</td>
<td>104</td>
</tr>
<tr>
<td>Period 3 = March, 2015</td>
<td>1</td>
<td>46</td>
<td>46</td>
</tr>
</tbody>
</table>

* The weight of period 1 is equal to the number of periods. The weight of each following period decreases by 1, so that the last period always has a weight of 1.

Average sales are calculated as follows:

Total weighted sales (324) ÷ the total of the period weights (6) = 54.

When you click **Apply Selected Changes**, the quantity in this field is used to update the projected sales quantity on the Reorder Quantities screen.

**Category Code**
Displays the category to which the item is assigned.

**Cost of Current Maximum**
Displays the total cost of the current maximum reorder quantity for the item.

**Cost of Current Minimum**
Displays the total cost of the current minimum reorder quantity for the item.

**Cost of Order Maximum**
Displays the total cost of the order maximum quantity for the item.
**Cost of Order Minimum**
Displays the total cost of the order minimum quantity for the item.

**Cost Variance for Maximum**
Displays the difference between the total cost of current and order maximum quantities for the item.

**Cost Variance for Minimum**
Displays the difference between the total cost of current and order minimum quantities for the item.

**Current Maximum**
Displays the current maximum reorder quantity for the item.

**Current Minimum**
Displays the current minimum reorder quantity for the item.

**Item Description**
Displays the description for the item.

**Item Number**
Displays the number you use to identify the item in Inventory Control.

**Lead Time**
Displays the number of days it takes after you place an order until the goods arrive at the location. This is specified in the **Lead Time (SIA)** field on the Location Details screen.

**Note:** If lead time for an item is 0, optimal reorder quantities for the item are also 0. This is because a lead time of 0 means the item is available immediately, any time (for example, an electronic book), and for such items you do not need to keep any inventory on hand.

**Location**
Displays the location at which the item is stocked. If the item is stocked at multiple locations, the table includes a separate row for each location, allowing you to control item reorder quantities for each location.

**Most Recent Cost**
Displays the cost you paid (based on cost unit of measure) the last time
you purchased the item. For more information, see "I/C Location Details Screen" (page 454).

**Optimal Maximum**

Displays the optimal maximum reorder quantity for the item, calculated as follows:

\[
\text{Optimal Minimum} \times \text{Maximum Quantity} \times \text{margin factor (specified on the Options screen)}.
\]

**Optimal Minimum**

Displays the optimal minimum reorder quantity for the item, calculated as follows:

\[
\text{Average Sales} \times \text{Minimum Quantity} \times \text{margin factor (specified on the Options screen)} \times \text{Lead Time} \div 30.
\]

**Note:** If lead time for an item is 0, optimal reorder quantities for the item are also 0. This is because a lead time of 0 means the item is available immediately, any time (for example, an electronic book), and for such items you do not need to keep any inventory on hand.

**Order Maximum**

Specify the maximum reorder quantity for the item. The quantity in this field is used to update the Reorder Quantities screen when you click **Apply Selected Changes**.

By default, this field displays the maximum reorder quantity from the **Optimal Maximum** field, rounded up to an even multiple of the quantity in the **Order Minimum (SIA)** field on the Vendor Details screen.

**Note:** You can change the quantity in this field.

**Order Minimum**

Specify the minimum reorder quantity for the item. The quantity in this field is used to update the Reorder Quantities screen when you click **Apply Selected Changes**.
By default, this field displays the minimum reorder quantity from the **Optimal Minimum** field, rounded up to an even multiple of the quantity in the **Order Minimum (SIA)** field on the Vendor Details screen.

For example, if the **Optimal Minimum** is 18, and the **Order Minimum (SIA)** is 5, this field displays 20.

**Note:** You can change the quantity in this field.

**Period fields**

The table includes numbered Period fields (**Period 1**, **Period 2**, etc) up to the number specified in the **Sales Periods** field on the Optimizer tab of the Options screen. For more information, see "I/C Options Screen" (page 588).

Each Period field displays the number of units of the item that were sold or otherwise consumed in the period, including those used in:

- Bills of Materials
- Kits
- Internal usage

**Quantity Available**

Displays the number of units of the item that you have available, in the item's stocking unit of measure. This is calculated using the other quantity fields, as follows:

**Quantity On Hand + Quantity On P/O − Quantity On S/O**

**Quantity On Hand**

Displays the number of units of the item that are on hand at the location, in the item's stocking unit of measure.

**Quantity On P/O**

Displays the number of units of the item that are on purchase order in Sage 300 ERP Purchase Orders, if you use that program.

**Quantity On S/O**

Displays the number of units of the item that are on sales order in Sage 300 ERP Order Entry, if you use that program.
Sales Trend
This field provides a rough indication of whether sales of the item are trending up or down.

Example:
If the number of periods is set to 4 (on the Options screen), the field displays the result of one of the following calculations:

- **Non-seasonal items.** Average of periods 1 and 2 – average of periods 3 and 4.
- **Seasonal items.** Average of periods 3 and 4 – average of periods 1 and 2.

Seasonal
Indicates whether or not an item is seasonal. You specify if an item is seasonal on the Items screen. For more information, see "I/C Items Screen" (page 396).

The periods used to calculate optimal reorder quantities for an item differ depending on whether or not the item is seasonal.

Example:
If the **Year/Period** field is set to 2015 period 6, and the number of periods is set to 3 (on the Options screen), the following periods are used in the calculations:

- Non-seasonal items:
  - Period 1 = 2015 period 5
  - Period 2 = 2015 period 4
  - Period 3 = 2015 period 3
- Seasonal items:
  - Period 1 = 2014 period 6
  - Period 2 = 2014 period 7
  - Period 3 = 2014 period 8

Select
Select this option in each row that contains recommended changes that
you want to make to item reorder quantities. When you click **Apply Selected Changes**, item reorder quantities are changed to the order minimum and order maximum displayed in the rows you've selected.

**Unit of Measure**
Displays the stocking unit of measure you use for the item.

**Vendor Cost**
Displays the cost at which the vendor is currently selling the item.

**Vendor Item Number**
Displays the number that the vendor uses to identify the item.

**Vendor Name**
Displays the name of the contact person or position for the vendor.

**Vendor Number**
Displays the identification number you use for the vendor of the item.

**Note:** If the item is sold by multiple vendors, your preferred vendor is used. If there is no preferred vendor, your primary vendor is used. For more information about specifying a preferred or primary vendor, see "I/C Vendor Details Screen" (page 479).

---

**I/C Reorder Quantities Screen**

**To open this screen:**
Open **Inventory Control > I/C Items and Price Lists > Reorder Quantities.**

**Related tasks:**
- "Adding Item Reorder Quantities" (page 145)
- "Optimizing Item Reorder Quantities" (page 147)
- "Printing the Overstocked Items Report" (page 342)
- "Printing the Reorder Quantities Report" (page 318)
- "Printing the Reorder Report" (page 346)
**Overview**

Use the I/C Reorder Quantities screen to:

- Set up reorder information (maximum, minimum, reorder, and projected sales quantities in item stocking units) for your inventory items if you want to use the Overstocked Items report or the Reorder Report to assist you in managing your inventory.

- Specify separate reorder criteria for each item at each inventory location where you stock the item, or for all locations.

**Fields and Controls**

**Item Number**

Specify the item number for which you want to add reorder criteria.

**Maximum Quantity**

Enter the maximum number of units (in the item's stocking units) you want in stock at any time for the item during the specified period. If more than this specified number of units are in stock during the period, the item appears on the Overstocked Items report.

Inventory Control calculates the quantity available as the quantity in stock, plus the quantity on purchase order, minus the quantity on sales order.

**Minimum Quantity**

Enter the minimum number of units (in the item's stocking units) you want in inventory for the item during the specified period.

If fewer than this specified number of units are in stock during the period, the item appears on the Reorder Report.

**Optional Fields**

If optional fields were defined for this screen, click the zoom button, then add or edit optional field information as follows:

- Fill in the value field for any optional fields that appear.

  If a field is required, you cannot save the item record until you fill in the value.
To add optional item fields that were not automatically inserted, use the Insert key to add a new line to the table, and then use the Finder to add the optional field.

When you select an optional field code, the program displays the description for the optional field.

Optional fields must be assigned to the Items screen using the I/C Optional Fields screen before you can add them to item records.

**Period Start**
Enter the date (month and day) of the first day for which you want the reorder criteria to apply.

If you add reorder criteria for more than one period in a 12-month period, then the current reorder criteria are in effect until the next period starting date.

For example, if you add different reorder criteria for periods starting on the first day of every month beginning with December 1st of the current year, then the first reorder criteria expire on December 31 and the next reorder criteria take effect on January 1st of the next year.

**Projected Sales**
Enter the number of units of the item (in the item's stocking units) you expect to sell during the specified period.

**Reorder For**
Enter a location code or use the Finder to select an inventory location. You must have previously allowed the item to be stocked at the location.

**Reorder Quantity**
Enter the number of units (in the item's stocking units) that you want to order during the specified period when either:

- The number of the items in stock is less than the amount you specified in the *Minimum Quantity* field, or
- The projected sales of the item for the period is greater than the amount of the item in stock.

**Unit of Measure**
The program displays the stocking unit of measure from the item record. You enter reorder information in stocking units.
I/C Update Bills of Material Screen

To open this screen:
Open Inventory Control > I/C Items and Price Lists > Update Bills of Material.

Related tasks:
"Updating Bills of Material" (page 158)

Overview

Use the I/C Update Bills of Material screen to:

- Change the fixed or variable costs for a range of bills of material by a percent or an amount.
- Add, remove, or replace particular components in a range of bills of material.

Note: This screen updates information on existing bills of material. If you want to create new bills of material, use the Bills Of Material screen or the Copy Bills Of Material screen.

Fields and Controls

Amount/Percent
Specify the amount or percent that the cost is being increased or decreased.

Base
If you are updating costs, specify whether this is an increase or a decrease.

BOM Number
If the component is also a master item, select the BOM that you are using to assemble the component item.

Component Item Number
Select the item number for the component that you want to add, remove, or replace.

From/To BOM Number
Specify the range of bills of material that you are updating.
From/To Master Item Number
Specify the range of master inventory items that you want to update.

Quantity
Enter the number of items that are being added to the build, in the unit of measure that you specified.

Replace by Item Number
If you are replacing a component, specify the replacement item number.

Type
If you are updating a component on one or more BOMs, specify whether you are updating fixed costs or variable costs. or whether you are adding a component, removing a component, or replacing one component with another one.

Unit Cost
If you are adding an item or replacing one item with another that uses user-specified costing, enter the cost for one unit (in the unit of measure that you selected).

Unit of Measure
Specify the unit of measure for the quantity of new component items that are being added to the build.

Update
Specify whether you are updating components or updating costs on the bills of material.

• If updating components, you can choose to replace, add, or remove components.
• If updating costs, you can increase or decrease the fixed or variable costs by a fixed amount or by a percentage.

Using
If you are updating costs, specify whether you are changing costs by an amount or by a percent.

I/C Update Item Pricing Screen

To open this screen:
Open Inventory Control > I/C Items and Price Lists > Update Item
Pricing.

Related tasks:
- "Changing Pricing Information for Single Items" (page 102)
- "Updating Pricing Information for Groups of Items" (page 104)

Overview
Use the I/C Update item Pricing screen to:
- Change prices, costs, or price check type for a range of items on one or more price lists.
- Change the start and end dates for a price list, or for a range of price lists.
- Change the type of price check performed on items.
- Update the base price, sale price, or markup cost by a percentage, amount, markup, or margin.

Note: This screen updates item information on existing price lists. If you want to create a new price list, use the Item Pricing screen or the Copy Item Pricing screen.

If you have a multicurrency system, you can update prices by currency and exchange rate.

Example:
If you update US prices first, you can update Canadian prices on your price list by using exchange rates, and basing the new prices on the US currency prices. Say the price list code is RETAIL.

1. You enter the following information in the Update Pricing fields:
   - **Currency**: CAD
   - **Price List Code**: from RETAIL to RETAIL
   - **Update**: Base Price using Exchange Rate
   - **Base on currency**: USD

2. The program first locates the item pricing with:
   - **Currency**: USD
**Price list code:** RETAIL

3. Then it multiplies the base price times the exchange rate, and update the item pricing for:

   **Currency:** CAD
   
   **Price List Code:** RETAIL

---

### Fields and Controls

**Amount**

You can increase or decrease the base price or the markup cost by a set amount. You can also enter an amount for calculating the sale price from the base price.

**Base on Currency**

If you have a multicurrency system, you can specify an exchange rate to change the price or markup cost. Once you select "exchange rate," you must select the currency code on which you want to base the rate.

**Currency**

If you have a multicurrency system, you must select the currency you are updating on the price list.

For example, you might update Canadian currency prices on your wholesale price list using exchange rates, and base the new prices on the US currency prices.

If you have a single-currency Inventory Control system, this field will not appear.

**Multiply by Exchange Rate**

You can override the exchange rate supplied by the rate type.

**Increase/Decrease**

If you choose to adjust the base price or the markup cost by percentage or amount, you must specify whether you are increasing or decreasing the price or cost, and then specify the amount or percent of the adjustment.

**Margin**

The margin is the difference between the markup cost and the price (either
sale price or base price) expressed as a percentage of the price.

The markup factor, on the other hand, is a multiplier of the markup cost. In other words, a margin of 33% is the same as a markup of 1.5.

**Markup Factor**
The markup factor is a multiplier applied to the markup cost to calculate the sale price or the base price.

**Example:** To set the base price to 1.5 times the markup cost, enter a markup factor of 1.5.

**Percentage**
For base price and markup cost, enter the percentage of change over the previous figure as a whole number.

**Example:** If the new base price is 1.5 times the previous price, enter the percentage increase as 50.00000.

For the sale price, enter the percentage to decrease the base price.

**Price Check Type**
Specify how you want Order Entry to respond to price overrides. Order Entry can:

- Do nothing (if you select None).
- Display a warning message and let you continue.
- Display an error message and reject the price override.
- Require a supervisor’s approval on price overrides.

**Price List Code**
Specify the price list or alphabetical range of price lists that you want to update (for example, from EUAU to EUUK).

**Sale Starts/Ends**
If you are changing the sale price, you can also enter starting and ending dates for the sale.

**Segment**
If you are selecting item numbers by item segment for updating, you must choose the item segment you want, then specify a range of the segment.
**Select By**
Specify how you want to select item numbers for updating. You can specify a range of item numbers, categories, item segments, vendor numbers, or optional field values. You can choose from any character optional fields that are active.

**Update Base Price / Sale Price / Markup Cost / Price Check**
You can use the Update Item Pricing to update any of the following information:

- **Base Price.** Select this option to add, increase or decrease item base prices.

- **Sale Price.** Select this option to add, increase, or decrease sale prices for a range of items. You can also specify the beginning and ending dates for the period during which the sale price applies.

- **Markup Cost.** Select this option to increase or decrease the cost on which markups are currently based.

- **Price Check Type.** Select this option to change how Order Entry responds to price overrides (for example, displaying an error message or requiring price approval).

- **Price List Dates.** Select this option to update the period for which the selected price lists are valid.

**Using Percentage / Amount / Markup / Margin / Exchange Rate**
Select the method for updating the base price, sale price, or markup cost.

**Note:** The exchange rate option appears only if you have a multicurrency Inventory Control system.

**I/C Vendor Details Screen**

**To open this screen:**
Open **Inventory Control > I/C Items and Price Lists > Vendor Details.**

**Related tasks:**
"Adding Vendor Information to Items" (page 132)
Overview

Use the I/C Vendor Details screen to:

- Link up to nine vendors to each item in your inventory.
- Assign a priority (type) to the vendors who supply you with each item.
- Enter detailed information about each vendor and their costs for the item.

**Note:** Before you can add vendor detail records, you must add the item records in Inventory Control, and add the vendor records in Accounts Payable.

Fields and Controls

**Cost Unit**

Enter the vendor’s cost unit, such as "ea." or "doz.", or select one using the Finder.

**Item Number**

Enter the number, up to 24 characters long, that the vendor uses to identify the item.

**Order Minimum (SIA)**

Enter the minimum quantity of the item that you must order from this vendor.

**Note:** This information is used by Sage Inventory Advisor (SIA). It is also used by the Optimize Inventory screen.

**Preferred Vendor (SIA)**

If you purchase the item from multiple vendors, you can use this field to specify a preferred vendor.

**Note:** This information is used by Sage Inventory Advisor (SIA). It is also used by the Optimize Inventory screen.

**Vendor Contact**

Enter the name of a contact person at the vendor company. You may use up to 60 characters.
**Vendor Cost**
Enter the vendor’s cost for the item in this field.

**Vendor Currency**
Enter the three-letter code for the vendor’s currency or select one using the Finder.

**Vendor Item Number**
Enter the number, up to 24 characters long, that the vendor uses to identify the item.

**Vendor Name**
Enter the name of the contact person or position for the vendor.

**Vendor Number**
Enter the identification number you use for the vendor of the item.

The Finder is available for this field only if you use Sage 300 ERP Accounts Payable.

**Tip:** You might want to enter the vendors in order of primary vendor, secondary vendor, and so on.

**Vendor Type**
Specify the priority (type) to indicate which is the primary vendor, secondary vendor, and so on, of the item. You can change the vendor type at any time by selecting a new one from the drop-down list, but you cannot give two vendors the same type.

You can specify up to nine vendors. The program displays the list of vendors in ascending order from one to nine.

**Note:** You cannot specify a priority after the record has been added.

**I/C Serial Numbers Screen**

**To open this screen:**
Open Inventory Control > I/C Items and Price Lists > Serial Numbers.

**Related tasks:**
- "Viewing or Editing Details for a Serial Number" (page 148)
"Registering Serial Numbers for Customer Warranties" (page 263)
"Reconciling Serial Numbers and Lot Numbers " (page 266)

Overview

Use the I/C Serial Numbers screen to:

- View the status of a serial number. (For example, serial numbers that have been sold have a Not Available status.)
- Edit details for a serial number, such as the contract code and optional fields.
- Open the I/C Items screen to view or edit information for a selected serialized item. (Click the Items button.)
- Open the Serial Number Transaction Inquiry screen to view transaction history for a selected serial number, and drill down to source documents for greater detail. (Click the Transactions button.)

To see which serial numbers have been reserved for upcoming orders, print the Reserved Stock report using the I/C Serial Numbers Report screen. For more information, see "Printing the Serial/Lot Stock Listing Report" (page 351).

Note: You cannot create new serial numbers using this screen. Use the Serial/Lot Reconciliations screen to do so. (For more information, see "Reconciling Serial Numbers and Lot Numbers " (page 266).

I/C Lot Numbers Screen

To open this screen:
Open Inventory Control > I/C Items and Price Lists > Lot Numbers.

Related tasks:
- "Viewing or Editing Details for a Lot Number" (page 149)
- "Recalling and Releasing Lotted Inventory Items" (page 264)
- "Reconciling Serial Numbers and Lot Numbers " (page 266)
Overview

Use the I/C Lot Numbers screen to:

- View the status of a lot.
- Edit lot number details, such as contract codes and optional fields.
- Place a specific lot on quarantine.
- View transaction history for lots, and drill down to source documents for greater detail.
- Open the I/C Items screen to view or edit item information.

**Note:** You cannot create new lot numbers using this screen. Use the "Reconciling Serial Numbers and Lot Numbers" (page 266) screen to do so.

Periodic Processing Screens

Use the Day End Processing screen to process transactions posted in Inventory Control, Order Entry, and Purchase Orders. Depending on options selected for your Inventory Control system, Day End Processing may update general ledger transactions, item statistics, transaction history, and item costs.

Use the other screens in the Periodic Processing folder to perform the tasks that are part of your regular period-end procedures, such as reconciling physical inventory, processing adjustments, clearing history, creating general ledger batches, and deleting inactive records.

I/C Process Adjustments Screen

To open this screen:
Open **Inventory Control > I/C Periodic Processing > Process Adjustments**.

**Related tasks:**
- "Processing Adjustments Automatically" (page 276)
- "Printing the Item Valuation Report" (page 340)
- "Printing Posting Journals" (page 365)
- "Adjusting Item Quantities and Costs" (page 179)
• "Posting an Inventory Reconciliation" (page 238)

**Overview**

Use the I/C Process Adjustments screen to automatically:

• Write off the cost of items with zero quantities.
  Zero quantities can appear after physical inventory counts -- or improperly entered adjustments.

• Write off the quantities of items with zero cost.
  Zero costs can arise if user-specified costs are not entered properly on shipments or receipts, or if adjustments are entered incorrectly.

• Adjust the total costs of items with non-zero quantities and zero total cost to a new cost.

**Which screen should I use to process adjustments?**

• Use the I/C Adjustments Screen to change item costs and quantities as needed.
  • To update the quantity on hand at a location to agree with your physical inventory count.
  • To return goods to a vendor after you have completed the receipt.
  • To remove additional cost remaining on a receipt when you return the total quantity received for an item at a location to the vendor.

  For more information, see "I/C Adjustments Screen" (page 643).

• Use the Post Inventory Reconciliation screen to post the counts and costs that you entered in the Physical Inventory Quantities screen. The program creates adjustment transactions when you post inventory reconciliations.

  For more information, see "I/C Post Inventory Reconciliation Screen" (page 512).

**Can I adjust material usage for a project?**

If you use Project and Job Costing, material adjustment transactions created by Project and Job Costing will appear in Inventory Control showing adjustments to particular contracts, projects, job categories and overhead accounts.
**Note:** You cannot adjust materials for jobs from the Inventory Control program.

**Fields and Controls**

**Buttons**

**Process**
Click this button to adjust cost or quantities for items, as specified.

**From/To Item Number**
Enter the range of item numbers for which you are creating adjustments. Type the same number in both fields to create an adjustment for one inventory item.

**From/To Location**
Enter the range of location codes for which you are creating adjustments. Type the same code in both fields to create adjustments for only one inventory location.

**Adjustment (type)**
Choose one of the following types of adjustments:

- Total cost to zero for items with zero quantities.
  This option sets the total cost to zero to match the quantity. Check your quantities to make sure they are zero before continuing.
  This situation typically arises when quantities have been adjusted to zero as a result of a physical count (and the cost not adjusted), or when costs were entered incorrectly with shipments.

- Take a physical count to make sure that total quantities are zero. A zero cost can arise if a user specified cost wasn’t entered properly on a receipt -- or if previous adjustments were entered incorrectly.

- Total cost for items with non-zero quantities and zero total cost.
  You can adjust the cost of items to:
  - Standard cost
  - Most recent cost (includes the tax)
Appendix A: Inventory Control Screen Guides

- Last Unit cost (does not include the tax)
- User defined cost 1
- User defined cost 2

**Cost to Use**
If you choose the third type of adjustment (to add a total cost for items with non-zero quantities), you must also choose the type of cost to use for the adjustment:

- Standard cost
- Most recent cost (includes the tax)
- Last Unit cost (does not include the tax)
- User defined cost 1
- User defined cost 2

**I/C Create G/L Batch Screen**

**To open this screen:**
Open **Inventory Control > I/C Periodic Processing > Create G/L Batch.**

**Related tasks:**
"Creating a Batch of General Ledger Transactions" (page 281)

**Overview**
Use the I/C Create G/L Batch screen to create batches of general ledger transactions from posted receipts, shipments, assemblies, internal usage transactions, adjustments, and transfers.

**Note:** Creating G/L batches in this screen is not necessary if you create G/L transactions automatically (either when you post transactions or when you run Day End Processing). For more information about options that control how general ledger transactions are created, see "I/C G/L Integration Screen" (page 571).

**G/L Integration options and G/L batches**
You use the I/C Create G/L Batch screen to create general ledger batches only if you did not choose the option Create G/L Transactions During Day End
Processing on the Integration tab of the G/L Integration screen.

Other G/L Integration options let you:

- Add new transactions to an existing G/L batch or create a new one (and optionally post it directly to G/L accounts).
- Consolidate transactions during batch creation.
- Select the information to appear in the Entry Description, Detail Description, and Detail Reference and Comment fields in general ledger transactions.

When you create the general ledger batch, the last day-end number processed is entered in the G/L Transactions Generated Through Day End Number field on the Integration tab of the Options screen, as well as the next day-end number the program will assign.

**Locked Fiscal Periods**

If a fiscal period is locked for General Ledger but not for Inventory Control, you can create batches for General Ledger during Day End Processing or using the Create G/L Batch icon (depending on Inventory Control's G/L Integration settings). When you try to post transactions to a locked period in General Ledger, however, the transactions will be placed in an error batch.

You can avoid this situation if you create and post General Ledger batches for outstanding Inventory Control transactions before locking the period for General Ledger.

**Fields and Controls**

**Buttons**

**Process**

Click this button to create a batch of general ledger transactions through the specified Day End number.

**Create G/L Batch Through Day End Number**

Specify the day-end number through which to create general ledger transactions. (You create the transactions for all outstanding day-end numbers up to and including the number you specify.)

**I/C Delete Inactive Records Screen**

To open this screen:

Open **Inventory Control > I/C Periodic Processing > Delete Inactive**
Records.

Related tasks:
"Deleting Inactive Records" (page 280)

Overview

Use the I/C Delete Inactive Records screen to remove obsolete items, account sets, categories, and locations from Inventory Control.

You can delete one or more types of inactive records at the same time.

Fields and Controls

Buttons

Process
Click this button to delete the specified records.

Delete These Records
You can delete inactive items, categories, account sets, locations, and bills of material. Select the types of records to delete, then enter the range of records to delete for each type.

From/To (records)
Enter the range of codes or numbers to delete for each record type you selected, or select them from the Finders.

From/To Inactive Dates
Enter a range of dates to indicate when a record must have been made inactive to delete it. Inventory Control selects records that have a status of Inactive and a corresponding "inactive" date within the range of dates you specify.

The default To date is the current session date.

If you do not want to delete all the records for the same range of inactive dates, process each set of records separately.

I/C Clear History Screen

To open this screen:
Open Inventory Control > I/C Periodic Processing > Clear History.
Related tasks:
"Clearing History" (page 278)

Overview

Use the I/C Clear History screen to selectively clear (remove) data from your Inventory Control system.

You can clear the following types of data:

- Transaction history
- Transaction statistics
- Sales statistics
- Printed posting journals
- Printed item labels
- Expired contract prices
- Transactions
- Serial numbers
- Lot numbers
- Serial history
- Lot history

You can clear one or more types of data at the same time.

Fields and Controls

Transaction History
Select this option to clear transaction history. Specify the year and period up to which to clear transaction history.

Transaction Statistics
Select this option to clear transaction statistics from item records. Specify the year and period up to which to clear transaction statistics.

Through Year, Period
Enter the date up to which you want to clear serial numbers for items shipped and returned.
Sales Statistics
Select this option to clear sales statistics from item records. Specify:

- The year and period up to which to clear sales statistics.
- The method of selecting records to clear.

Select By
Specify the method by which to select item records from which to clear sales statistics. You can clear by item number, category, item segment, or the entries in any of the optional fields added to the Items screen.

If you select Item Segment, a Segment field appears with a list from which you select the segment you want.

Segment
Enter the segment code by which to select item records from which to clear sales statistics.

From/To
Enter the range of item numbers, categories, segment codes, or optional field entries for which you want to clear sales statistics.

Printed Posting Journals
Select this option to clear posting journals. Specify:

- The types of posting journals to clear (you can clear any combination of journals at a time, including: Receipts, Adjustments, Assemblies, Shipment, Transfers, Internal Usage).
- The day-end number up to which to clear printed posting journals. By default, the field displays the most recent day-end number.

Note: Posting journals are cleared only if they have been printed to a printer or file.

Through Day End Number
Enter the day-end number up to which to clear posting journals.

You clear posting journals for only one day-end number at a time.

Printed Labels
Select this option to clear item labels you printed for completed receipts. Specify the range of receipts for which to clear labels.
From Receipt Number/To
Enter the range of receipt numbers for which to clear printed labels.

Expired Contract Prices
Select this option to clear expired contract prices. Specify the date up to which to clear expired contract prices.

Transactions
Select this option to clear completed transactions (receipts, shipments, adjustments, assemblies, transfers, and internal usage transactions). Specify the date up to which to clear completed transactions.

Note:
- You cannot drill down to transactions after you delete them.
- You cannot enter a return for a receipt after you delete the receipt.

Serial Numbers
Select this option to clear serial numbers you have assigned to shipments and sales returns. Specify:

- The date up to which to clear serial numbers.
- Whether to clear history for numbers with vendor contracts that have expired.

Lot Numbers
Select this option to clear lot numbers you have assigned to shipments and sales returns.

- The date up to which to clear lot numbers.
- Whether to clear history for numbers with vendor contracts that have expired.

Serial History
Select this option to clear serial number history.

- The date up to which to clear serial number history.
- Whether to clear history for numbers with customer warranties that have expired.

Lot History
Select this option to clear lot number history.
- The date up to which to clear lot number history.
- Whether to clear history for numbers with customer warranties that have expired.

**I/C Day End Processing Screen**

**To open this screen:**
Open **Inventory Control > I/C Periodic Processing > Day End Processing.**

**Related tasks:**
- "Performing Day End Processing" (page 273)
- "Printing Posting Journals" (page 365)

**Overview**

Use the I/C Day End Processing screen to:
- Update costing data for all transactions (unless you chose the option to update costing during posting).
- Produce general ledger journal entries from the transactions that were posted during the day (unless you do item costing during posting or create G/L transactions using the Create G/L Batch icon).
- Produce a posting journal for each type of transaction that was posted.
- Update Inventory Control statistics and transaction history.

Day End Processing also performs processing tasks for the Order Entry and Purchase Orders modules, if you have them:
- Processing transactions that were posted during the day in Order Entry and Purchase Orders.
- Activating and posting future sales orders and purchase orders that have reached their order date, and updating quantities on sales order and on purchase order.
- Removing quotes and purchase requisitions with expiration dates up to and including the session date for day-end processing.
- Updating sales commissions.
Periodic Processing Screens

- Creating batches of Accounts Receivable summary invoices and credit notes from posted Order Entry transactions.
- Deleting completed transaction details if you do not keep transaction history.
- Updating statistics and history in Order Entry and Purchase Orders.

**Processing Time**

The time it takes to complete day-end processing varies according to your computer and the number of transactions you entered since the last time you ran Day End Processing. We recommend that you run Day End Processing when you do not need to use your computer for other tasks (for example, overnight).

**Checking Data Integrity**

Run Day End Processing before using the Data Integrity icon in Administrative Services to check your Inventory Control data.

**Locked Fiscal Periods**

If a fiscal period is locked for General Ledger but not for Inventory Control, you can create batches for General Ledger during Day End Processing or using the Create G/L Batch icon (depending on Inventory Control's G/L Integration settings). When you try to post transactions to a locked period in General Ledger, however, the transactions will be placed in an error batch.

You can avoid this situation if you create and post General Ledger batches for outstanding Inventory Control transactions *before* locking the period for General Ledger.

**Fields and Controls**

**Buttons**

**Process**

Click this button to start Day End Processing.

**I/C Lot Recalls/Releases Screen**

**To open this screen:**

Open **Inventory Control > I/C Periodic Processing > Lot Recalls/Releases.**
Secondary screens:
"I/C Lot Number Transaction Inquiry Screen" (page 666)

Related tasks:
"Recalling and Releasing Lotted Inventory Items" (page 264)

Overview

Use the I/C Lot Recalls/Releases screen to:

- Process recall documents for lotted items that you need to withdraw from sales.
- Process release documents when you decide to restore the availability of recalled items.

If an item is recalled by your vendor, or if your customers consistently report negative experiences, you should recall the items to restrict further sales, and notify your customers.

Later, you can release recalled units that are subsequently tested and found safe or usable.

Important! Do not confuse the lot release procedure with the quarantine release procedure, which you use to release lots that are quarantined upon receipt.

Note: You can recall and release lotted inventory items only if you have a license to use Serialized Inventory and Lot Tracking.

Fields and Controls

Buttons

Close
Click Close to close the screen.

Post
Click this button to post the current transaction.

Transactions
To view a list of transactions posted for a specified lot number, item and location, in the table on the I/C Lot Recalls/Releases screen, select the location, and then click Transactions.
**Document Number**
If you are entering a new recall or release document, accept the *** NEW *** entry in the Document Number field.

To view an existing recall or release document, use the Finder or the navigation buttons for this field to select the document number, or type the number.

**Entry Type**
Select **Recall** or **Release**.

When you select Release, the Recall Number field appears.

**Item Number**
Select the I/C item number of the lotted item you are recalling.

**Lot Number**
Type the number of the lot you want to recall, or use the Finder to select it.

If you are releasing a lot, the program displays the lot number when you enter the recall number and tab out of the Recall Number field.

**Recall Number**
This field appears if you selected Release as the entry type.

Type the recall document number assigned to the lot when the items were recalled, or use the Finder to select it.

The program displays the lot number and item number when you enter the recall number, and then tab out of the Recall Number field.

**Table**
The table displays the locations where the lots you are recalling are stored.

You can view transactions posted for the item, lot, and location by selecting the location on the table, and then clicking the **Transactions** button.

**I/C Lot Splits/Combines Screen**

**To open this screen:**
Open **Inventory Control > I/C Periodic Processing > Lot Splits/Combines**.

**Related tasks:**
"Splitting and Combining Lots" (page 259)
Overview

Use the I/C Lot Splits/Combines screen to:

- Split existing lots into two or more parts.
- Combine two or more lots into one.

The lots must be for the same inventory item and location.

You can split or combine expired lots. However, you cannot split quarantined or recalled lots, or lots that have been assigned a contract code.

**Note:** You require a license for Serialized Inventory and Lot Tracking to work with lotted inventory items.

Fields and Controls

Buttons

**Close**

Click **Close** to close the screen.

**Post**

Click this button to post the current transaction.

Combine Number

This field appears if you selected Combine in the Type field.

If you are creating a new combine document, accept the default ***NEW*** entry in this field. The program assigns the next combine number when you post the document.

If you want to view an existing document, type the number or use the Finder to select it.

Expiry Date

Entering an expiry date is optional.

This is the date by which the quantities in the lot expire ("become bad"), and cannot be sold—such as the expiry date on a bottle of milk or medicine.

From

The From section of the screen contains fields associated with lot you are splitting or with the lots you are combining.
**Item Number**
Enter the number of the lotted item you want to work with.

**Location**
Specify the inventory location where the lot you want to split or combine is stored.

**Lot Number**
If you are combining lots, you specify the destination lot number in this field.
- To combine lots into an existing lot, use the Finder to select the destination lot.
- To create a new lot for the combined lots, type the new lot number in the field.

**Note:** The new lot number must conform to the lot number mask specified in the item record.

If you are splitting lots, you specify the source lot number (from which you are taking quantities) in this field. You must enter the number of an existing lot for the item at the specified location.

**Qty. Combine**
This field appears only for Combine documents.
Enter the quantity to move to the destination lot.

**Quantity Shippable**
The program displays the quantity shippable after you specify the destination lot (for a Combine document) or the source lot from which you are taking quantities (for a Split document).

**Qty. to Split**
This field appears only for Split documents.
Specify the quantity you are taking from the source lot to include in the split.

**Note:** Do not specify a quantity greater than the quantity shippable.

**Remaining**
Inventory Control displays the quantity remaining to be allocated to destination lots from the source lot.
When you have finished allocating the quantity shippable, the value in this field is zero.

**Split Number**
This field appears if Split is selected in the Type field. (Split is the default type.)

If you are creating a new split document, accept the default *** NEW *** entry in this field. The program assigns the next Split number when you post the document.

If you want to view an existing document, type the number or use the Finder to select it.

**To**
The To section of the screen contains fields associated with the destination lot.

**Transaction Date**
The transaction date is the date to which the document will be posted. The session date appears as the default transaction date for new documents.

Accept the default date, or change the date, if necessary.

**Type**
Select **Split** or **Combine**.

If you select Combine, the Split Number field changes to Combine Number.

**Stock date**
Enter the stock date associated with the destination lot (optional).

The stock date is a reference indicating the date that the item is received into the lot.

It can also be used to calculate the expiry date.

**Example:** Suppose the Days to Expiry option is set (on the I/C Options screen) to calculate the expiry date for lots 30 days from the receipt date. When an item is received into a lot, the default stock date and expiry date will be 30 days apart, the stock date being the receipt date, and the expiry date 30 days later.
Table
For a Split document, you use the table to specify information about the destination lots.

For a Combine document, you use the table to specify information about the source lots from which you are taking quantities.

**Important!** The total of all quantities in the Qty. Split column or the Qty. to Combine column in the table must equal the quantity in the Qty. field in the Qty. to Split field or in the Qty. Combine field above the table, or you will not be able to post the document.

I/C Quarantine Release Screen

**To open this screen:**
Open Inventory Control > I/C Periodic Processing > Quarantine Release.

**Related tasks:**
"Releasing Lots From Quarantine " (page 266)

**Overview**
Use the I/C Quarantine Release screen to release lots you have placed on quarantine.

Lotted inventory items may be placed on quarantine if they have defects that must be resolved before the items are sold, or if you must provide paperwork and/or duties to customs authorities before the items can be used. Once the issues have been resolved, you can release the lots from quarantine.

You must release the total quantity in a quarantined lot, or no quantity.

**Note:** You can quarantine and release lots only if you have a license to use Serialized Inventory and Lot Tracking.

I/C Serial/Lot Reconciliation Screen

**To open this screen:**
Open Inventory Control > I/C Periodic Processing > Serial/Lot Reconciliations.
Related tasks:
- "Reconciling Serial Numbers and Lot Numbers" (page 266)

Overview

Use the I/C Serial/Lot Reconciliations screen to reconcile serial numbers and lot numbers assigned to inventory on hand.

You should reconcile serial number and lot numbers periodically to ensure that the numbers assigned match the quantity of items on hand.

Example: If Inventory Control uses the options to allow the quantities in entries to be different from the serial and lot quantities, you may need to add serial or lot numbers that were not generated when you received items, or remove serial or lot numbers that were not allocated when you sold the items.

Important! Do not use the I/C Serial/Lot Reconciliation screen to enter original receipts from vendors, shipments to customers, or invoices of serialized and or lotted items. You use this screen to adjust numbers only for items already processed in inventory.

You can also use the Serial/Lot Reconciliation screen to change the serial numbers and lot numbers that were assigned when items were received or sold.

Lots Tab

You use the Lots tab to generate lot numbers and to allocate quantities to lots.

Serials Tab

You use the Serials tab to generate serial numbers and to allocate them to items.

I/C Serial Registration Screen

To open this screen:
Open Inventory Control > I/C Periodic Processing > Serial Registration.

Related tasks:
"Registering Serial Numbers for Customer Warranties" (page 263)
Overview

Use the I/C Serial Registration screen to register serial numbers for items that you sell.

You can register serial numbers for warranty management purposes when you sell serialized inventory items, or when you receive completed registration forms from your customers.

The inventory item record for each serialized item specifies the type of warranty, and whether to place the item on warranty when it is sold or when it is registered.

**Note:** You can register warranties only for serialized items.

Fields and Controls

**Buttons**

**Close**

Click **Close** to close the screen.

**Register**

Click this button when you have finished entering information to identify the item and the serial number you want to register.

**Customer Number**

This field displays the code for the customer who bought the item for which you are registering the serial number.

**Document Number**

In this field, specify the document that assigned the serial number.

**Tip:** If you use the Finder to select the document, you select the item number and serial number at the same time.

**Document Type**

In this field, specify the type of document that assigned the serial number.

**Item Number**

In this field, you can specify the item to which the serial number was assigned. (If you used the Finder to specify the document number, you do not need to enter the item number.)
**Note:** You must enter an item number that was included in the specified document.

**Serial Number**
Specify the serial number you are registering. (If you used the Finder to specify the document number, you do not need to enter the serial number.)

**Note:** You must specify a serial number that was assigned to the item in the specified document.

## I/C Warranty Update Screen

**To open this screen:**
Open **Inventory Control > I/C Periodic Processing > Warranty Update**.

**Related tasks:**
"Updating Warranties for Serialized and Lotted Items " (page 262)

**Overview**
You use the I/C Warranty Update screen to apply a warranty for a serialized or lotted item after a sale.

**Example:** A customer might want to purchase an extended warranty for an item, or you might sell a discounted floor model without a warranty during a clearance sale.

**Tip:** You can also apply warranties to serialized and lotted items automatically when you sell the items. (You select options to apply warranties automatically in the individual I/C item records.)

**Note:** This screen is available only if you have a license to use Serialized Inventory and Lot Tracking.

### Fields and Controls

#### Buttons

**Close**
Click **Close** to close the screen.
**Update**
Click this button to update the warranty for the selected serialized number or lot number.

**Document Number**
When you tab out of the Serial Number or Lot Number field, Inventory Control supplies the document number for the transaction in which the serial number or lot number was allocated to the item.

**Item Number**
Enter the code for the item to which you are applying the warranty or for which you are updating terms.

**Lot Number**
This field appears if you selected the Lots option.

Specify the lot number that identifies the lot number that was assigned to the particular item.

When you tab out of the field, Inventory Control supplies the document number and the date of the transaction in which the serial number or lot number was allocated to the item.

**Lots**
Select this option if you are updating warranty information for a lotted item.

**Serials**
Select this option if you are updating warranty information for a serialized item.

**Serial Number**
This field appears if you selected the Serials option.

Specify the serial number that was assigned to the particular item.

When you tab out of the field, Inventory Control supplies the document number and the date of the transaction in which the serial number or lot number was allocated to the item.

**Transaction Date**
When you tab out of the Serial Number or Lot Number field, Inventory Control supplies the date of the transaction in which the serial number or lot number was allocated to the item.
Warranty Code
Select the warranty that has the terms you want to apply to the item.

Tip: When you select a warranty code, and then tab out of the Warranty Code field, Inventory Control displays the terms of the warranty. Check the terms to ensure that you are applying the correct warranty code.

Table
When you select a warranty code, and then tab out of the Warranty Code field, Inventory Control displays the terms of the warranty.

Viewing the terms can help you determine whether you are applying the correct warranty code.

Physical Inventory Screens
Discrepancies between item quantities maintained by the program (quantities on hand) and your physical inventory count can occur for various reasons, such as shrinkage, missing receipts, or theft.

Use the screens in the I/C Physical Inventory folder to enter the results of physical inventory counts into your system and reconcile physical inventory totals with the totals in Inventory Control.

I/C Generate Inventory Worksheet Screen

To open this screen:
Open Inventory Control > I/C Physical Inventory > Generate Inventory Worksheet.

Related tasks:
- "Generating Inventory Worksheets for Stocktaking" (page 233)
- "Printing the Inventory Worksheet" (page 325)

Overview
Use the I/C Generate Inventory Worksheet screen to generate worksheets of item quantities on hand for all inventory locations for which you are taking inventory.

You can optionally print worksheets to use for recording your physical inventory counts prior to entering the data in the Physical Inventory Quantities screen and posting it to your Inventory Control system.
You can create inventory worksheets for a range of items sorted by item number, category, item segment, picking sequence, or any optional field names defined for Inventory Control. You can choose to include:

- Only the items in the specified item range that are assigned to the location(s) for which you are generating worksheets.
- Only the items in the specified item range that are assigned to and have been used in one or more transactions at the location(s) for which you are generating worksheets.
- All the items in the specified item range, regardless of whether they are assigned to the location(s) for which you are generating worksheets.

**Note:** Items are included regardless of whether they are currently allowed to be used in Inventory Control transactions.

If you generate an inventory worksheet for a location that already has a worksheet, the program replaces the old worksheet with a new one.

**Warning!** To ensure quantities and costs on worksheets are current, do not post transactions (receipts, shipments, transfers, adjustments, or assemblies) then run Day End Processing between the time you generate inventory worksheets and the time you post the inventory reconciliation.

### Fields and Controls

#### Buttons

**Generate**

Click this button to generate a worksheet for the items, locations, and account sets you specified.

**Comment**

Enter a comment that you want to appear at the top of the inventory worksheet when printed.

**Default Quantity on Hand**

Select this option to update the Physical Inventory Quantities with the quantity on hand.

You then manually enter figures only if the quantity counted differs from the figure stored as the quantity on hand by Inventory Control.
If you do not select this option, the Quantity Counted column is left blank for warehouse employees to enter the count as they physically check the stock on hand.

You might leave it blank to make sure that warehouse staff always do a full inventory count.

**From Account Set/To**
Enter the range of account set codes whose items you want included on the inventory worksheets, or use the Finders to select the first and last account sets in the range.

**From Location/To**
Enter the range of location codes whose items you want to include on the inventory worksheets, or use the Finders to select the first and last locations in the range.

**From/To**
Type or use the Finder (if available) to select the beginning and ending codes for the type of range you selected in the Sort By field.

**Include**
Specify which items you want to include on the worksheets by selecting one of the following options from the Include list:

- **Items from Location Only**, to select only the items in the Sort By range that are assigned to the location(s) for which you are generating worksheets.

- **In Use Items Only**, to select only the items in the Sort By range that are assigned to and have been used in one or more transactions at the location(s) for which you are generating worksheets.

- **All Items from Inventory List**, to select all the items in your inventory that are in the Sort By range.

  **Note:** Items are included regardless of whether they are currently allowed to be used in Inventory Control transactions.

**Sort By**
If you want to change the type of range in which to list items on the worksheets, select another type from the list.
You can select from Item Number, Category, Item Segment, Picking Sequence, and any optional field names used in your Inventory Control system. If you select Item Segment, a Segment field appears with a drop-down list from which you can select a segment.

**I/C Inventory Counts Screen**

To open this screen:
Open *Inventory Control > I/C Physical Inventory > Inventory Counts*.

Related tasks:
"Entering Physical Inventory Quantities" (page 236)

Overview

Use the I/C Inventory Counts screen to enter inventory counts after taking inventory. This screen is a simpler version of the I/C Physical Inventory Quantities screen.

Tip: Use the I/C Physical Inventory Quantities screen if you want to compare calculated quantities to actual counts, or to enter adjustment unit costs or change the posting status for individual items.

If you use Serialized Inventory and Lot Tracking, you can assign serial and/or lot numbers in the Inventory Counts screen.

The inventory counts entered in the I/C Inventory Counts screen update the current physical inventory worksheet.

Fields and Controls

**Item Number and Description (display)**
Shows the item numbers and descriptions in the range you selected when you generated the worksheet, and for the location that you selected at the top of the screen.

**Location**
Type the code for the location or select it from the Finder.

**Picking Sequence (display)**
Shows each item's picking-sequence code, if any.

**Quantity Counted (F9)**
Enter the number of units you counted for the item. Press F9 to display a
screen with all of the units of measure defined for the item (so you can enter the number of crates, boxes, etc.).

If you selected **Default Quantity On Hand** when you generated the physical inventory worksheet, the Quantity Counted column will list the quantity calculated by Inventory Control.

If you did not select **Default Quantity On Hand** when you generated the physical inventory worksheet, the Quantity Counted column will show zero quantities until you enter a count.

**Starting Item Number**
Enter the first item number to use or select it from the Finder.

**Stocking Unit of Measure (display)**
Displays the stocking unit of measure for each item.

**I/C Physical Inventory Quantities Screen**

**To open this screen:**
Open **Inventory Control > I/C Physical Inventory > Physical Inventory Quantities**.

**Secondary screens:**
- I/C Quantities Screen
- "I/C Serial/Lot Numbers Allocation/Generation Screen" (page 677)

**Related tasks:**
- "Assigning Serial/Lot Numbers to Physical Inventory Quantities" (page 254)
- "Entering Physical Inventory Quantities" (page 236)
- "Printing the Inventory Worksheet" (page 325)

**Overview**

Use the I/C Physical Inventory Quantities screen to:
- Enter inventory counts after taking inventory.
- Edit inventory worksheets (if needed) in preparation for posting reconciliations.
- Assign serial and/or lot numbers if applicable.
You can enter counted quantities (which are all zero on newly generated worksheets) and adjustment unit costs, and change posting status. Press F9 to enter quantities in different units of measure.

You can delete a worksheet (use the Delete button), but you cannot delete individual lines.

Optional fields are available for the I/C Physical Inventory Quantities screen if you add optional fields for adjustments and adjustment details in the Optional Fields screen in Inventory Control. The fields appear on the adjustments generated when you post the inventory reconciliation.

**Note:** Use the I/C Inventory Counts screen for a simpler version on which you enter only inventory quantities.

**Importing and Exporting Data**

You can use the Import and Export commands under the File menu to import and export data from/to Inventory Control. The procedure is slightly different from the way most Sage 300 ERP screens import and export data. Instead of one file, the import/export process involves two files:

- A file that contains the worksheet and optional fields data.
- A file that contains all other data.

When exporting, make sure you use two different file names when prompted to do so. When importing, make sure you select the file with the worksheet and optional fields data first, then the second file.

**Fields and Controls**

**Adjustment Unit Cost**

Type over the displayed cost if you need to change it. Note that you can change the displayed cost only if the quantity counted you enter differs from the item’s quantity on hand.

The Adjustment Unit Cost field and the Estimated Unit Cost field contain the same cost when you generate worksheets. You can compare the costs displayed in these two fields to check whether you changed the adjustment unit cost and, if so, by what amount.

For items using the moving average, FIFO, LIFO, or user-specified costing method, the program displays the item’s average cost per stocking unit. For items using the standard or the most recent cost costing method, the program displays the item’s standard cost or most recent cost per stocking unit, respectively.
Appendix A: Inventory Control Screen Guides

**Comment (display)**
Displays any comments that you entered in the Comment field in the Generate Inventory Worksheet screen when you created the worksheet.

**Cost Variance (display)**
Displays the result of multiplying the quantity variance by the adjustment unit cost. The cost variance is the amount by which the program updates the item's inventory value when you post the reconciliation.

For example, if an item's adjustment unit cost is $5.00 and the quantity counted is 2 more than the quantity on hand, the program multiplies 2 by $5.00 and displays $10.00 in the Cost Variance field. (Note that cost variances are negative amounts when the quantity counted is less than the quantity on hand.)

If the quantity variance is zero (the quantity counted equals the quantity on hand in the Inventory Control system), the program displays zero in the Cost Variance field.

**Estimated Unit Cost (display)**
For items using the moving average, FIFO, LIFO, or user-specified costing method, the program displays the item's average cost per stocking unit. For items using the standard or the most recent cost costing method, the program shows the item's standard cost or most recent cost per stocking unit, respectively.

**Item Number and Description (display)**
Shows the item numbers and descriptions in the range you selected when you generated the worksheet, and for the location that you selected at the top of the screen.

**Location**
Type the code for the location or select it from the Finder.

**Optional Fields**
If you added optional fields to adjustments and adjustment details, you can enter optional field information that will be included in any adjustments that are generated when you post the inventory reconciliation.

Optional fields in adjustment transactions provide information on the adjustment posting journal and when you review adjustments in I/C or drill down to adjustments from G/L transactions.
Picking Sequence (display)
   Shows each item's picking-sequence code, if any.

Quantity Counted (F9)
   Enter the number of units you counted for the item. Press F9 to display a
   screen with all of the units of measure defined for the item (so you can enter
   the number of crates, boxes, etc.).

   If you selected Default Quantity On Hand when you generated the
   physical inventory worksheet, the Quantity Counted column will list the
   quantity calculated by Inventory Control.

   If you did not select Default Quantity On Hand when you generated the
   physical inventory worksheet, the Quantity Counted column will show zero
   quantities until you enter a count.

Quantity on Hand (display)
   Displays the item quantities (in stocking units) maintained by the program.

Quantity Variance (display)
   Shows the result of subtracting the quantity on hand from the quantity
   counted. (Note that quantity variances are negative when the quantity on
   hand in Inventory Control is greater than the physical count.)

   If the quantity counted equals the quantity on hand, the program displays
   zero in the Quantity Variance field.

Starting Item Number
   Enter the first item number to use or select it from the Finder.

Status (display)
   Displays the message "Not Posted" if all items on the worksheet have either
   the status "Ready to post" or the status "On hold."

   Displays the message "Errors on Posting" if the program assigned any items
   on the worksheet a status from the following list:

   • Item does not exist.
   • Non-stock item.
   • Item not allowed at location.
   • Insufficient quantity.
   • Item not active.
**Status**

You can change the posting status of any item. Assign the status "Ready to post" to items you want to post and assign the status "On hold" to items you do not want to post.

**To change an item's posting status:**

1. Tab to the item's Status column in the table, then click the arrow symbol beside the Status heading (or press the Spacebar in the Status column for the item) to open the status list.

2. Double-click a status to select it from the status list, or use the Up Arrow or Down Arrow key to highlight a status then press the Enter key.

**Note:** When you post reconciliations, the program changes the status of any items it cannot post.

**Stocking Unit of Measure (display)**

Displays the stocking unit of measure for each item.

---

**I/C Post Inventory Reconciliation Screen**

**To open this screen:**

Open Inventory Control > I/C Physical Inventory > Post Inventory Reconciliation.

**Related tasks:**

- "Posting an Inventory Reconciliation" (page 238)
- "Deleting Inventory Reconciliations" (page 241)
- "Generating Inventory Worksheets for Stocktaking" (page 233)
- "Printing the Inventory Reconciliation Report" (page 329)
- "Printing the Inventory Worksheet" (page 325)

**Overview**

Use the I/C Post Inventory Reconciliation screen to post inventory counts and costs that you entered in the I/C Physical Inventory Quantities screen or the I/C Inventory Counts screen.
When you post an inventory reconciliation, adjustment transactions are created for any discrepancies between your physical inventory count and the figures calculated by Inventory Control.

**Note:** When you post an inventory reconciliation for which an adjustment number already exists, the Inventory Worksheet will create separate adjustments for every hundred items, and append "1", "2", "3", etc. to the end of the document number.

**FIFO/LIFO Costed Items**

For items that use the FIFO or LIFO costing method, the item's offset bucket is adjusted for inventory reconciliation transactions.

**Fields and Controls**

**Buttons**

**Post**

Click this button to post inventory reconciliations for the specified locations and dates.

**Date**

Enter the date to use for the adjustment transaction, or choose it from the calendar that appears when you click the calendar button next to the Date field. Inventory Control automatically displays the session date.

**Description**

Type an optional description up to 60 characters long, such as comments you want to appear on reports (optional).

The description appears on the Adjustments Posting Journal and can appear on the G/L Transactions report (if you select it for the G/L Entry Description, Detail Description, Detail Reference, or Detail Comment field on the Transactions tab of the G/L Integration screen, and you do not consolidate general ledger transactions).

**From Location/To**

Enter beginning and ending codes or use the Finder to select beginning and ending codes in the range of locations for which you want to post reconciliation adjustments.
**Posting Date**

Enter the posting date for the transaction in addition to the document date.

The posting date is the date for transactions being posted to the General Ledger, so it also determines the contents of the Fiscal Year and Period fields.

If you have a multicurrency system, currency revaluation also uses posting dates to select open documents for revaluation purposes and, thus, revaluation adjustments are posted to General Ledger in the correct fiscal year and period.

Depending on your settings in the I/C Options screen, Inventory Control automatically displays the session date or the document date by default in this field.

You can change the posting date, but you cannot separately change the fiscal year and period.

**Note:** If you consolidate G/L transactions, the posting date for consolidated entries is the last date of the fiscal period.

**Reconciliation No.**

Enter a reconciliation number of up to 22 numerals and upper-case letters to distinguish the reconciliation from other adjustment transactions on the Adjustments Posting Journal.

**Note:** Reconciliation numbers do not have to be unique.

**Reference**

Enter an optional reference up to 60 characters long, such as the reason for adjusting the quantities.

The reference appears on the Adjustments Posting Journal and can appear on the G/L Transactions report (if you select it for the G/L Entry Description, Detail Description, Detail Reference, or Detail Comment field on the Transactions tab of the G/L Integration screen, and you do not consolidate general ledger transactions).

**Year/Period**

This is the fiscal year and period to which the inventory reconciliation adjustments will be posted in the general ledger.
Inventory Control automatically displays the fiscal year and period for the date that you enter in the Posting Date field.

You can only change the fiscal period by changing the posting date.

Report Screens

Use Inventory Control report screens to print setup reports, stock control reports, and analytical reports.

Physical Inventory Reports

Use these reports when reconciling actual (physical) inventory quantities to your records in Inventory Control.

I/C Inventory Worksheet Report

To open this screen:
Open Inventory Control > I/C Physical Inventory > Inventory Worksheet.

Related tasks:
- "Entering Physical Inventory Quantities" (page 236)
- "Generating Inventory Worksheets for Stocktaking" (page 233)
- "Printing the Inventory Worksheet" (page 325)
- "Printing Inventory Worksheets for Stocktaking" (page 327)

Overview

Use the I/C Inventory Worksheet report to record inventory quantities when taking a physical count of inventory. You enter these quantities into Inventory Control to prepare for inventory reconciliation.

The report also sets the range and order of item numbers for the I/C Inventory Reconciliation report.

Note: When you post an inventory reconciliation for which an adjustment number already exists, the Inventory Worksheet will create separate adjustments for every one hundred items, and append "1", "2", "3", etc. to the end of the document number.
**When to Print**

You can print the worksheet to assist you when doing a physical inventory count.

**Information Printed on This Report**

- The date on which you generated the worksheet, and the comment you entered for the worksheet in the I/C Inventory Worksheet screen.

- Details for items.

  **Note:** Details for active items are always included. Details for inactive items are included only if the **Include Inactive Items** option is selected.

- The unit cost (appears if you selected Unit Cost for the report). If you use the most recent cost or standard cost costing methods, the unit cost is the same as that displayed in the Location Details screen. For average and LIFO/FIFO costing, Inventory Control calculates the average unit cost by dividing the actual cost by the quantity on hand.

- A column where you record the inventory count for each item and corresponding unit of measure. You later enter these figures in the Physical Inventory Quantities screen. If you selected the Default Quantity On Hand choice in the Generate Inventory Worksheet screen, the current quantity on hand for each item is already printed in the Quantity Counted column. You then manually enter figures only when the quantity counted differs from the figure stored as the quantity on hand in your Inventory Control program.

- A column where you can record a temporary status of On Hold or Not On Hold for items whose status you want to change for reconciliation purposes. You then use the Physical Inventory Quantities screen to assign the temporary status to affected items. Use the On Hold status to prevent items from being updated when you post the inventory reconciliation. Use the Ready To Post status to allow on-hold items to be updated when you post the reconciliation.

- An optional blank line you can include for writing comments or remarks about each item, for your own information (appears if you selected Comment for the report). You do not enter these comments in Inventory Control.

**I/C Inventory Reconciliation Report**

**To open this screen:**

Open **Inventory Control > I/C Physical Inventory > Inventory**
Reconciliation.

Related tasks:
- "Counting and Reconciling Inventory Quantities" (page 232)
- "Deleting Inventory Reconciliations" (page 241)
- "Entering Physical Inventory Quantities" (page 236)
- "Printing the Inventory Worksheet" (page 325)
- "Posting an Inventory Reconciliation" (page 238)
- "Printing the Inventory Reconciliation Report" (page 329)

Overview

Use the I/C Inventory Reconciliation report to compare physical inventory counts with the totals in your Sage 300 ERP Inventory Control system.

The report identifies discrepancies between item quantities and costs, and shows what will be posted by the I/C Post Inventory Reconciliation screen.

For an overview of the complete stocktaking process, see "Counting and Reconciling Inventory Quantities" (page 232).

When to Print

Print the report after generating an Inventory Worksheet, counting inventory, and entering the counted totals on the I/C Physical Inventory Quantities screen. You can also print the report after posting an inventory reconciliation to list transactions that had errors and were not posted.

Important! If you want to include the latest costing information in the report, run Day End Processing before printing the report.

Information Printed on This Report

The Include All Units Of Measure version of the report includes:

- The ranges of account sets and item numbers selected when you generated the Inventory Worksheet.

- The adjusted unit cost, which is the Adjustment Unit Cost you entered for each item in the Physical Inventory Quantities screen after taking inventory.
Appendix A: Inventory Control Screen Guides

- The quantities on hand, calculated by Inventory Control from the transactions posted for each item.
- The physical count (quantity counted) you entered in the Physical Inventory Quantities screen for each item's units of measure.
- The variance, if any, between quantity on hand as calculated by Inventory Control and the quantity counted you entered.
- The cost variance, which Inventory Control calculates by multiplying the adjusted unit cost by the quantity variance.
- The Serial/Lot Quantity variance (if any) between the quantity counted and the numbers assigned.
- The status code of each item, indicating whether the item information can be posted by the Post Inventory Reconciliation screen.
- Comment lines where you can write remarks for your own information.
- Explanations of each status code:
  - **Ready to post.** The item is ready to post and will be deleted from the report when you post the inventory reconciliation.
  - **On hold.** The item is not ready to post. Information for on-hold items is not updated when you post an inventory reconciliation, and the item is not deleted from the report when you post the reconciliation.
  - **Item does not exist.** The item record was deleted from Inventory Control after you generated the Physical Inventory Worksheet.
  - **Non-stock item.** This status identifies non-stock items.
  - **Item not allowed at location.** This status identifies items at a location which are not allowed to be used in transactions.
  - **Insufficient quantity.** This status applies only when you do not use the Allow Negative Inventory option. The status identifies items whose quantity on hand would fall below zero if you posted the reconciliation.
  - **Item not active.** The item's status has been set to Inactive on the item record.

The Include Stocking Unit Only version of the report includes a single line for each item, showing information for only the stocking unit of measure, rather than for all units defined for the item. The report also includes comment lines if you selected this option.
Both versions of the report include details for active items and, if you selected the Include Inactive Items option, details for inactive items.

Stock Control Reports Screens

Stock Control reports can help you manage your inventory by providing detailed information about your inventory items.

If you use Serialized Inventory and Lot Tracking, you can generate reports that provide details about serialized and lotted items.

I/C Aged Inventory Report

To open this screen:
Open Inventory Control > I/C Stock Control Reports > Aged Inventory.

Related tasks:
"Printing the Aged Inventory Report" (page 331)

Overview

The I/C Aged Inventory report lists the net changes in item quantities and costs for a set of four aging periods you specify.

Note: The cost of the items received in the inventory is the actual cost of the item. The calculation of the cost of the items shipped from inventory depends on the costing methods used.

Information Printed on This Report

You can print a detailed or summary version of the report. The detailed version prints all individual transactions affecting item quantities and costs. The summary version prints only the totals of the net changes for each period.

- Lists the quantities and costs for four aging periods. Period 1 uses the "As of" date as the starting point.
- Shows opening balances, net changes, and closing balances for quantities and costs in each of the aging periods.
- Prints subtotals by the sorting order field (category, item segment, or optional field).
- Prints the report for separate locations, consolidated locations, or items by location.
The summary version of the report includes one line for each item number, listing the net change in item quantities and costs in each of four periods.

**I/C Bin/Shelf Labels Screen**

**To open this screen:**
Open **Inventory Control > I/C Stock Control Reports > Bin/Shelf Labels**

**Related tasks:**
"Printing Bin/Shelf Labels" (page 333)

**Overview**
Use the I/C Bin/Shelf Labels screen to print bin or shelf labels to attach to the bins or shelves where you store inventory items.

Bin and shelf labels can include any of the information in the item record.

**Note:** To print other types of labels (such as price tags), use the I/C Item Labels screen. For more information, see "I/C Item Labels Screen" (page 521).

**I/C Inventory Movement Report**

**To open this screen:**
Open **Inventory Control > I/C Stock Control Reports > Inventory Movement**

**Related tasks:**
"Printing the Inventory Movement Report" (page 335)

**Overview**
The I/C Inventory Movement report lists the quantities and extended costs of inventory items that were received into stock and shipped out of stock during the period that you specify.

The report displays the stock activity showing each transaction in and out of stock for the period. You can group items in all locations together or display items in each location separately.
**Note:** The cost of the items received in the inventory is the actual cost of the item. The calculation of the cost of the items shipped from inventory depends on the costing methods used.

**Information Printed on This Report**

- Reports transactions for a particular period of time—specified using transaction dates or fiscal periods.
- Prints item opening and closing balances, as well as inventory-in and inventory out item totals in functional currency.
- For each transaction, prints the document number, source ledger (e.g. Order Entry, Purchase Orders, Project and Job Costing), inventory location, unit of measure, inventory-in or inventory-out quantity and cost (optionally, in source and functional currencies), and running balances.
- Prints subtotals by the sorting order field (category, item segment, or optional field).
- Prints the report for separate locations, consolidated locations, or items by location.

**I/C Item Labels Screen**

**To open this screen:**
Open **Inventory Control > I/C Stock Control Reports > Item Labels**.

**Related tasks:**
"Printing Item Labels" (page 336)

**Overview**

Use the I/C Item Labels screen to print labels such as price tags that you can attach to items when you receive them from suppliers, and to items already in your inventory.

The sample item labels include the item number and description, picking sequence number (Bin/Shelf), and price per pricing unit.

**Note:** To print labels for the bins or shelves where you store items at your inventory locations, use the I/C Bin/Shelf Labels screen. For more information, see "I/C Bin/Shelf Labels Screen" (page 520).
When to Print

Print item labels when you receive new items into stock and want to attach price tags or other labels to the items. You specify the number of labels to print for each item when you post the receipts.

At any time, you can print labels for items already in your inventory—for example, to replace damaged labels or to update item descriptions and pricing information.

I/C Item Status Report

To open this screen:
Open Inventory Control > I/C Stock Control Reports > Item Status.

Related tasks:
"Printing the Item Status Report" (page 338)

Overview

The I/C Item Status report lists the information entered for each item in the Items screen, as well as the quantities on hand at your inventory locations. If you use the Keep Item Statistics option, the report also shows shipment and receipt statistics for each item.

When to Print

Print the Item Status Report when you need a quick-reference list of item information such as quantities on hand or the names of suppliers. You should also print a new copy for your files after adding, deleting, or changing item records.

Information Printed on This Report

- **Profile.** Lists the information entered on the Items tab of the Items screen.

- **Units of Measure.** Lists all defined units of measure, as entered on the Items tab of the Items screen, including the stocking unit, and the corresponding conversion factors for each non-stocking unit.

- **Taxes.** Lists the authorities and other tax information entered on the Taxes tab of the Items screen.

- **Additional Item Information.** Lists text entered in the Additional Item Information fields on the Optional Fields tab of the Items screen.
- **Optional Fields.** Lists the title and data for any active optional fields that appear on the Optional Fields tab of the Items screen.

- **Quantity by Location.** Lists quantities on hand, on purchase order, and on sales order for each location.

- **Total Quantities.** Lists total quantities on hand, on purchase order, and on sales order for your entire inventory.

- **Statistics.** Lists locations, date of last item shipment, date of last receipt of the item, average days between shipments, and average units shipped by location.

- **FIFO/LIFO Costing.** For each location and item, lists the receipt number and date for each bucket, and the quantity and extended cost for items received, shipped, and available. Quantities and costs of items in the offset bucket are also given for each location, as well as the quantities of items not costed (entered since the last time you ran Day End Processing, if you do costing during Day End Processing).

- **Serials.** Lists the serial number mask used, the next number that will be assigned, the days to expiry and the default warranty/contract settings for each item.

- **Lots.** Lists the lot number mask used, the next number that will be assigned, the days to expiry, days on quarantine, and the warranty and contract default settings for each item.

### I/C Item Valuation Report

**To open this screen:**

Open **Inventory Control > I/C Stock Control Reports > Item Valuation.**

**Related tasks:**

"Printing the Item Valuation Report" (page 340)

**Overview**

The I/C Item Valuation report lists the value of inventory quantities on hand, calculated for the items, locations, costs, or optional amounts you select for the report.

**When to Print**

Print the report when you want to calculate inventory values.
Information Printed on This Report

The report includes different information, depending on the options you select:

- **Print Items by Location in Detail.** If you select this option, the report includes:
  - The costing method that is assigned to the item by its account set.
  - The average unit value and the cost per costing unit for each costing method. If you include costs entered in the optional amount field, unit values in the optional amount column are expressed in stocking units.
  - A column in the "Valuation" section for each costing method you selected for the report, including any optional or alternate costing methods.
  - The totals for all items on the report.
  - Quantities and costs are separate options so that you can include any combination of quantity and cost values, such as positive quantities and negative costs, or zero quantities and positive or negative costs.

- **Print Items by Location in Summary.** If you select this option, the report includes the totals for all items on the report.

- **Print Consolidated Locations in Detail.** If you select this option, the report includes the item number, description, and costing method for each item across all locations. It also prints the quantity on hand and costing information totals for each item.

- **Print Consolidated Locations in Summary.** If you select this option, the report consists of a single line showing the total costs for all inventory items included in the range of items and locations you select.

- **Print Separate Locations in Detail.** If you select this option, the report includes:
  - The location code and location description.
  - The totals for all items at the location.

- **Print Separate Locations in Summary.** If you select this option, the report includes the totals for all items at the location.

- **Default Item Price List.** If you select this option, the report values inventory using the base price of the selected price list.

  The report starts a new page for each location you select.
- **Transaction Costs.** If you select this option, the report includes:
  - The location code and location description.
  - The totals for all items at the location.

**I/C Overstocked Items Report**

**To open this screen:**
Open *Inventory Control > I/C Stock Control Reports > Overstocked Items*.

**Related tasks:**
"Printing the Overstocked Items Report" (page 342)

**Overview**

The I/C Overstocked Items report lists each item at each location for which the quantity on hand (plus the quantity on PO minus the quantity on sales order) exceeds the maximum or projected sales quantity assigned for the item and location.

You can choose from the following basic reports:

- **Quantity Greater Than Maximum Level.** Lists items for which the quantities on hand are more than a specified percentage higher than the maximum levels entered for the items in the Reorder Quantities screen.

- **Quantity Greater Than Projected Sales.** Lists items for which the quantities on hand are greater over the number of days you specify than the projected sales quantities entered for the period in the Reorder Quantities screen.

- **Annualized Turn and Earn Ratio.** Lists items for which the ratio of the inventory turnover rate to the profit margin is less than the percentage you specify.

- **Average Cost of Excess Quantity.** Lists items with an actual cost that is greater than the amount you specify in the Greater Than field.

- **Most Recent Cost of Excess Quantity.** Lists items whose most recent cost is greater than the amount you specify in the Greater Than field.

You can report item quantities for locations that are over the maximum level or over the projected sales figures entered for the items in the Reorder Quantities screen. You can include cost figures on the report to see the costs of carrying the extra inventory items.
To print meaningful data on some versions of this report, you must first enter figures for the items in the Reorder Quantities screen.

**When to Print**

Print the Overstocked Items report when you want to estimate the cost of excess stock, or when you want to determine whether to redistribute overstocked items to other locations.

**Information Printed on This Report**

The report's features differ according to the criterion you select for determining whether items are overstocked. For example:

- If you select overstocked items by their annualized turn and earn ratios, the report includes:
  - The quantities on purchase order and sales order, which are entered and updated by Sage 300 ERP Purchase Orders and Order Entry, respectively.
  - The quantity sold, total sales, and cost amounts posted for the item in the year to date, from the Sales Statistics screen.
  - The number of times the company's average inventory has been sold in the year to date, calculated as:
    \[
    \text{YTD turnover} = \frac{\text{Year-to-Date Quantity Sold} \times 365}{\text{Actual Quantity on Hand} \times \text{Days Gone By in Current Year}}
    \]

    Inventory Control calculates the number of days gone by in the year by subtracting the session date from the first day in the current fiscal year.

- The margin percentage, calculated as:
  \[
  \frac{\text{Sales - Costs}}{\text{Sales}} \times 100
  \]

- The turn and earn ratio, calculated by multiplying the YTD turnover by the margin. The ratio may not exactly equal the YTD turnover multiplied by the margin percentage because the report rounds figures to two decimal places.

- If you select overstocked items by the most recent cost of excess quantity, the report includes:
  - The starting and ending dates for the reorder period, as defined in the Reorder Quantities screen.
• The date of the last shipment and receipt of the item.

• The maximum quantity specified for the item, location, and period entered in the Reorder Quantities screen.

• The amount by which the item quantity on hand exceeds the maximum quantity entered for the item, location, and period in the Reorder Quantities screen.

• The excess cost (excess quantity multiplied by the most recent cost per unit).

You can print this version of the report only if you entered reorder information in the Reorder Quantities screen.

I/C Quarantine Report

To open this screen:
Open Inventory Control > I/C Stock Control Reports > Quarantine.

Related tasks:
"Printing the Quarantine Report" (page 344)

Overview

The I/C Quarantine report lists the lot numbers that are currently on quarantine, as well as the expected release date, lot quantity, and lot cost.

Note: This report is available only if you have a license to use Serialized Inventory and Lot Tracking.

I/C Recall Report

To open this screen:
Open Inventory Control > I/C Stock Control Reports > Recall.

Related tasks:
"Printing the Recall Report" (page 345)

Overview

The I/C Recall report lists the lots that are currently on recall or have been released from recall, and information related to those lots.
Note: This report is available only if you have a license to use Serialized Inventory and Lot Tracking.

Information Printed on This Report

- Original vendor of the items.
- Customers the items were sold to (if applicable).
- Recall/release date.
- Recall quantity.
- Stock dates.
- Sold dates.

I/C Reorder Report

To open this screen:
Open Inventory Control > I/C Stock Control Reports > Reorder.

Related tasks:
"Printing the Reorder Report" (page 346)

Overview

The I/C Reorder report lists items that are out of stock or have low quantities on hand at the selected locations. The report also lists the suggested reorder quantity, estimated cost to replenish, and names of the usual suppliers you assigned for each item on the report.

When to Print

Print the report when you are ready to place orders for inventory items, and want to identify the items and quantities you need to order.

Information Printed on This Report

- The criteria you selected to determine which item quantity levels to list.
- The number and name of the vendor from whom you usually order the item. This information and the vendor's item number appear only if you assigned vendors to the item record in the Items screen.
• The quantities on hand, on purchase order, and on sales order for each location you included in the report. (Purchase order and sales order figures are entered and updated by transactions posted in Sage 300 ERP Purchase Orders and Order Entry, respectively.)

• The starting and ending dates for the reorder periods. You specify the starting date for each period in the Reorder Quantities screen. Inventory Control calculates the period ending dates, based on the starting dates.

• The minimum and reorder quantities specified for the item in the Reorder Quantities screen, as well as the most recent cost.

• The amount it would cost to purchase the full reorder quantity, calculated by multiplying the reorder quantity by the item's most recent cost.

**I/C Slow Moving Items Report**

**To open this screen:**
Open Inventory Control > I/C Stock Control Reports > Slow Moving Items.

**Related tasks:**
"Printing the Slow Moving Items Report" (page 354)

**Overview**

The I/C Slow Moving Items report lists items that are not selling well, according to the criteria you select when you print the report.

**When to Print**

Print the report to identify problem items.

**Information Printed on This Report**

• The criteria you selected to identify slowly moving items.

• The reasons each item was included in the report. The numbers in this column correspond to the criteria you selected to identify slowly moving items.

**I/C Transfer Slips Report**

**To open this screen:**
Open Inventory Control > I/C Stock Control Reports > Transfer Slips.
Related tasks:
"Printing Transfer Slips" (page 357)

Overview

Use the I/C Transfer Slips screen to print transfer slips to accompany goods to the receiving location (either carried by the driver or attached to the goods by way of a clear packing envelope or window envelope).

Transfer slips provide a column where the receiver can check whether the goods received (items and quantities) match the goods shipped.

Transfer slips include the following information:

- Shipping and receiving plant information, including contact names and phone numbers.
- Item number, item description, quantity transferred, and the unit of measure.
- The quantity received, or a blank space where you can write the quantity received (this depends on the type of transfer slip you print). The following transfer slips are available:
  - ICTRNS01.RPT. If you print this type of transfer slip, the quantity received is always blank.
  - ICTRNS02.RPT. If you print this type of transfer slip, the quantity received varies depending on the type of transaction that you have just posted:
    - For a Transfer transaction, the quantity received is blank.
    - For a Transit Transfer, the quantity received shows the total quantities of all the transit receipts that originated from the transit transfer.
    - For a Transit Receipt, the quantity received shows the receipt quantity.
- Space to write comments concerning the receipt.

When to Print

Print transfer slips when you are posting stock transfers and want to attach transfer slips to the transfer shipment.

You can also enter transfer transactions first, and then print transfer slips at a later time by choosing the Transfer Slips icon in the Stock Control Reports folder.
Price Sales Analysis Report Screens

Use the reports in the Price/Sales Analysis Reports folder to review the effects of purchasing and sales activities, and to help determine the optimal prices, margin, and markup levels you need to meet your business objectives.

I/C Contract Pricing Report

To open this screen:
Open Inventory Control > I/C Price/Sales Analysis Reports > Contract Pricing.

Related tasks:
"Printing the Contract Pricing Report" (page 361)

Overview

The I/C Contract Pricing report lists the details of the pricing contracts you have established with one or more customers.

When to Print

Print the report after adding, changing, or deleting pricing contracts, or when you need to check on existing arrangements for particular customers.

Information Printed on This Report

- The range of customer numbers included in the report.
- The customer number and name for each customer included in the report.
- Whether the contract is set up by category code or item number.
- The category code or item number and its description.
- The price list code. Codes appear in this column only if you have selected "item number" as the basis for the contract.
- The expiration date for the contract, if applicable.
- The contract price type.
- The costing method. This column will have entries only if you have selected one of the "cost-plus" pricing options.
I/C G/L Transactions Report

To open this screen:
Open Inventory Control > I/C Price/Sales Analysis Reports > G/L Transactions.

Related tasks:
"Printing the G/L Transactions Report" (page 362)

Overview
The I/C G/L Transactions report lists the general ledger journal entries created from all transactions posted in Inventory Control since the last time you created the general ledger batch.

When to Print
Print the report before you use the Create G/L Batch screen to produce general ledger transactions. When you create the general ledger batch, the program erases the data for the G/L Transactions report.

Information Printed on This Report

The Detail report includes, for each transaction:

- The posting sequence number, which is the number of the day-end processing run during which the transaction was created.

- The entry number indicating the order in which the transaction was processed by Day End Processing. There are no batches in Inventory Control so the batch number is always 0 (zero).

- The source code that identifies the source program (Inventory Control) and the type of transaction in your general ledger. Inventory Control source codes are:
  - IC-AD—adjustments
  - IC-AS—assemblies
  - IC-CO—consolidated transactions
  - IC-DA—disassemblies
  - IC-RA—adjustments to receipts
IC-RC—receipts
IC-RR—returns posted to receipts
IC-SH—shipments
IC-SR—shipment returns
IC-TF—transfers

The data in the Reference, Description, and Comments columns depends on your selections for G/L fields in the G/L Integration screen.

- Totals by sorting option.
- The debit and credit totals of the transactions listed on the report.

The Summary report lists a single line for each general ledger account number, with the total debit and credit amount for the account.

I/C Markup Analysis Report

To open this screen:
Open Inventory Control > I/C Price/Sales Analysis Reports > Markup Analysis.

Related tasks:
"Printing the Markup Analysis Report" (page 364)

Overview

The I/C Markup Analysis report lists each item whose base price varies from a desired selling price by more than the percentage you specify for the report.

When to Print

Use the report to help you identify products that do not meet the desired markup.

Information Printed on This Report

- The most recent cost entered for the item in the Location Details screen.
- The costing unit assigned to the item in the Location Details screen.
- The markup factor entered on the Prices tab of the Item Pricing screen.
• The desired selling price, calculated by multiplying the item's markup factor by the selected cost.

• The pricing unit specified for the item in the Item Pricing screen.

• The base price entered for the item on the Prices tab of the Item Pricing screen.

• The percentage variance between the desired selling price and the base price, calculated as:

\[
\left(\text{Base} - \text{Desired}\right)/\text{Desired} \times 100
\]

**I/C Posting Journals Screen**

**To open this screen:**
Open **Inventory Control > I/C Price/Sales Analysis Reports > Posting Journals**.

**Related tasks:**
• "Printing Posting Journals" (page 365)
• "Posting Inventory Transactions" (page 226)

**Related tasks for specific posting journals:**

• Adjustments posting journal:
  • "Adjusting Item Quantities and Costs" (page 179)

• Assemblies posting journal:
  • "Assembling Items from Bills of Material" (page 170)
  • "Disassembling Master Items" (page 172)

• Receipts posting journal:
  • "Returning Goods to Vendors" (page 191)
  • "Posting Saved Receipts" (page 190)
  • "Receiving Goods from Vendors" (page 184)
• Shipments posting journal:
  ○ "Receiving Returned Goods from Customers" (page 199)
  ○ "Shipping Goods to Customers" (page 196)

• Internal usage posting journal:
  ○ "Identifying an Inventory Item as a Fixed Asset for Sage Fixed Assets" (page 220)
  ○ "Using Goods Internally" (page 218)

• Transfers posting journal:
  ○ "Receiving Goods from a Goods-In-Transit Location" (page 214)
  ○ "Transferring Goods between Two Inventory Locations" (page 206)
  ○ "Transferring Goods Using a Goods-In-Transit Location" (page 210)

**Overview**

Use the I/C Posting Journals screen to generate posting journals.

A posting journal is the printed record of the transactions that were processed together during day-end processing.

You can print the following types of posting journals, one for each transaction type you can post in Inventory Control:

- Adjustments
- Assemblies
- Receipts
- Shipments
- Internal usage
- Transfers

**When to Print**

You should print posting journals after each day-end processing, then file them with your other audit trail records. You must print copies of the journals to a printer or file before you can clear the data for them in the Clear History screen.
Adjustments Posting Journal

The adjustments posting journal includes all adjustments created using:

- Adjustment entry in the Transactions folder.
- Process Adjustments in the Periodic Processing folder.
- Post Inventory Reconciliation in the Physical Inventory folder.

For information about adjustments, see "About Processing Adjustments" (page 175).

The following information is printed on the adjustments posting journal:

- The type of adjustment (Cost Increase, Cost Decrease, Quantity Increase, Quantity Decrease, Both Increase, Both Decrease).
- If you make an adjustment to a LIFO or FIFO item, this column also specifies the bucket type (Offset Bucket, Specific Bucket, or Prorate).
- The Debit and Credit columns show changes in functional currency to your adjustment/write-off accounts when you adjust costs. A change in quantity only does not affect these accounts.

Assemblies Posting Journal

The following information is printed on the assemblies posting journal:

- The Bill Of Material (BOM) number and type of item (master or component).
- The build quantity for the bill of material used in the assembly.
- The quantity in stock, in the stocking unit of measure.
- The unit cost for each item in functional currency, in multicurrency ledgers.
- The fixed and variable costs for the assembly.

Receipts Posting Journal

The following information is printed on the receipts posting journal:

- The day-end number and the entry number assigned by Day End Processing to form a unique set of numbers that identifies each transaction on all Inventory Control posting journals.
- If you use the Source Code/Day End Number/Entry Number option for the G/L Description or Reference fields, these numbers appear with unconsolidated transactions in the general ledger batch.

- The item's extended cost (unit cost multiplied by the quantity). This column also includes the item's prorated additional cost. Extended costs are expressed in source currency in the multicurrency version of the report.

- If you use multicurrency accounting, the Receipts Posting Journal shows the currency code for each detail and prorated additional cost on the report.

- The invoice cost (per unit cost in functional currency). This column also includes the new unit cost (in functional currency), which is the invoice cost plus any allocated portion of an additional cost.

- The general ledger accounts affected by each transaction and the amount debited or credited to each account. This information appears on all Inventory Control posting journals.

- The cost amounts in the Debit and Credit columns are calculated by multiplying the quantity by the new unit cost. On multicurrency journals, the results are in functional currency.

- A summary which lists separate totals for receipts, receipt returns, and receipt adjustments in the posting journal.

- In multicurrency versions of the report, the totals are shown in each currency used in transactions included in the posting journal.

- A general ledger summary which lists the totals for the transactions that were created for each general ledger account by the transactions listed on the posting journal. This information also appears on all Inventory Control posting journals.

  In multicurrency versions of the report, amounts are expressed in both source and functional currencies.

**Shipments Posting Journal**

The following information is printed on the shipments posting journal:

- The price list code for each transaction.

- In multicurrency ledgers, the rate and rate type for each transaction.

- In multicurrency ledgers, the currency code for each transaction.
• In multicurrency ledgers, the price of the shipped item in source currency.
• The extended price of the shipped item in functional currency.

**Internal Usage Posting Journal**

The following information is printed on the internal usage posting journal:
• The item number and item category for each transaction.
• The location from which the item was shipped.
• The quantity and the unit of measure.
• The extended cost.
• The G/L asset/expense account to which the item is debited.

**Transfers Posting Journal**

The following information is printed on the transfers posting journal:
• The item number and category.
• The source and destination locations for the stock transfer.
• The entry number, date, year, period, day-end number, and posting date.
• Additional costs and proration methods.
• Description, reference, and optional fields (if selected) that you entered with the transfer.

**I/C Price Lists Report**

**To open this screen:**
Open *Inventory Control > I/C Price/Sales Analysis Reports > Price Lists*.

**Related tasks:**
"Printing the Price Lists Report" (page 368)

**Overview**

The I/C Price Lists report lists price, markup, discount, and tax information for items in the range of price lists you select.
When to Print

Print the Price List version of the report when you need a list of item base prices and markup or discount prices on one or more price lists. Print the Detail version of the report when you want to check price decimals, previous prices and costs, and the tax authorities and classes assigned to each item on a price list. Print the Price List Summary or Item Number Summary when you need a list of current base prices.

Information Printed on This Report

There are different versions of the report:

- **Price List.** This version of the report includes:
  - In multicurrency ledgers, the currency code for each set of pricing information. A single price list can have more than one currency.
  - The base price and sale price (if any) assigned for the item, and the corresponding units.
  - The markup cost, factor and costing unit for the item.
  - The discount or markup prices calculated for the item.

- **Detail.** This version of the report includes most of the information entered in the Item Pricing screen, and also includes:
  - In multicurrency ledgers, prices in whatever currency you choose, regardless of the currency for the price list.
  - The previous price and previous (markup) cost. If the current base price and markup cost are the first ones you entered for the item, the previous price or markup will be zero.
  - The date of the last change made to the base price and markup cost. If the current base price and markup cost are the first ones you entered for the item, the date of the change will be zeroes.

- **Price List Summary** and **Item Number Summary.** These versions of the report include the current base price and pricing unit for each item.

**I/C Sales Statistics Report**

To open this screen:

Open **Inventory Control > I/C Price/Sales Analysis Reports > Sales Statistics.**
Related tasks:
"Printing the Sales Statistics Report" (page 369)

Overview
The I/C Sales Statistics report lists figures for sales and returns by the statistical reporting periods you specify in the Options screen.

Important! You can print this report only if you use the Keep Item Statistics option.

When to Print
Print the report when you need to review the sales figures for items, or to help you identify trends and determine profit margins.

Information Printed on This Report
The unconsolidated (Show Every Item) report shows sales and returns information by item, location, and period, including:

- The year and period as determined by your selections in the Accumulate By and Period Type fields on the Processing tab on the I/C Options screen.
- Quantities of the item that were sold or returned, by location and period.
- The number of sales and returns transactions for the item, by location and period.
- The total sales and return amounts for the item. In multicurrency ledgers, these amounts are shown only in the functional currency.
- Margin figures for each item, calculated as:
  \[(Sales - Cost \ of \ goods \ sold) - (Returns - Cost \ of \ goods \ returned)\]
- Margin percentage, calculated as:
  \[\text{Margin} \times 100\]
  \[\frac{\text{Sales} - \text{Returns}}{\text{Sales} - \text{Returns}}\]
- Subtotals by item numbers, which is what you see when you print the Consolidate Items version of the report.
I/C Selling Price/Margin Analysis Report

To open this screen:
Open Inventory Control > I/C Price/Sales Analysis Reports > Selling Price/Margin Analysis.

Related tasks:
"Printing the Selling Price/Margin Analysis Report" (page 371)

Overview
The I/C Selling Price/Margin Analysis report lists items whose base prices or discount or markup prices have a gross profit margin that is less than the percentage you specify.

When to Print
Print this report to analyze item profit margins or compare base price margins with the margins on discounted or marked-up prices, or to identify items with unusually low or high profit margins.

Information Printed on This Report

- Amounts in the currency and at the exchange rate you specify, if you use a multicurrency ledger.

  Note: The markup cost is always in the functional currency.

- The unit cost for each type of costing method selected for the report.
- The base price, from the Prices tab of the Item Pricing screen.
- The margin, calculated as follows:
  (Base price - Unit cost) / Base price
- The discount or markup prices calculated as specified for the item on the Discounts tab of the Item Pricing screen.
- The quantity that must be purchased for each discount level to apply, if the prices vary by the volume purchased.
- The margin for each discount or markup price, calculated as follows:
  (Discount or markup price - Unit cost) / Discount or markup price
**I/C Transaction History Report**

**To open this screen:**
Open **Inventory Control** > **I/C Price/Sales Analysis Reports** > **Transaction History**.

**Related tasks:**
"Printing the Transaction History Report" (page 372)

**Overview**

The I/C Transaction History report lists all transactions posted for the items assigned to the account sets you select within the period you specify. The report shows the net change to the inventory control account for the account set and period.

**Important!** Transactions are accumulated for this report only if you use the Keep Transaction History option in the I/C Options screen.

Transaction history is accumulated and reported according to the settings in the Fiscal Calendar in Common Services.

Transactions cleared in the Clear History screen are not included in the report.

**When to Print**

Print the report when you want to review transaction history by item or list transactions from all posting journals.

The report can also be used at the end of an accounting period to check the balance of your general ledger control account, since the total for the account sets on the report should match the total for the general ledger control account.

**Information Printed on This Report**

- The date, fiscal year, and fiscal period of each transaction.
- The document number entered with the transaction.
- Day-end numbers, assigned sequentially each time Day End Processing is run, and entry numbers indicating the order in which each transaction was processed by Day End Processing.
- If you use multicurrency ledgers, the source currency and exchange rate for each transaction.
The amount of the transaction in source currency. Amounts that credit the general ledger inventory control account (such as shipments) are displayed in parentheses.

Debit or credit amounts for each transaction, to be posted to the account set's general ledger inventory control account. In multicurrency ledgers, these amounts are in the functional currency.

The net change posted to the inventory control account from all transactions posted for the item.

The opening and ending balances for the item's inventory control account when you sort the report by account set.

The opening and ending balances and the net change for each location and account set when you sort by account set.

If you sort by item number, the report shows only the net change for each location and account set.

**I/C Transaction Statistics Report**

**To open this screen:**
Open Inventory Control > I/C Price/Sales Analysis Reports > Transaction Statistics.

**Related tasks:**
"Printing the Transaction Statistics Report" (page 374)

**Overview**

The I/C Transaction Statistics report lists statistics from posted transactions for the current year and all the previous years for which you keep history.

Transaction statistics are accumulated according to the selections you made for the Accumulate By and Period Type fields in the I/C Options screen.

**Important!** You can print this report only if you use the Keep Item Statistics option.

**Information Printed on This Report**

The report lists statistical information for receipts, shipments, internal usage transactions, adjustments, and transfers, subtotaled by period.
Setup Reports

Setup reports provide the following information:

- The options you selected in the I/C Options screen and G/L Integration screen.
- Records that you added to set up your Inventory Control system, such as account sets, item categories, price list codes, inventory locations, item number structures and segment codes, units of measure, weight UOMs, and optional fields.
- Additional item information such as item location details, alternate items, bills of material, kit components, manufacturers' item numbers (e.g. bar codes), customer details (item numbers), and reorder quantities.

I/C Account Sets Report

To open this screen:
Open Inventory Control > I/C Setup Reports > Account Sets.

Related tasks:
- "Printing the Account Sets Report" (page 302)
- "Adding Account Sets" (page 43)

Overview

The I/C Account Sets report lists descriptions and numbers of the general ledger accounts in your Inventory Control account sets, and the costing method used by each account set.

When to Print

Print this report when you add, change, or delete account sets.

Information Printed on This Report

For each account set, the report lists:

- The costing method assigned to each account set.
- The account numbers for the Inventory Control, Payables Clearing, Adjustment Write-Off, Assembly Cost, Non-Stock Clearing, Transfer
Clearing, Shipment Clearing, Disassembly Expense, Physical Inventory Adjustment and Credit/Debit Note Clearing accounts.

- The date on which each account set was last edited (last maintained).
- If an account set is inactive, the date it became inactive is also listed. You cannot assign inactive account sets to items or post transactions for items using an inactive set.

**I/C Alternate Items Report**

**To open this screen:**
Open *Inventory Control > I/C Setup Reports > Alternate Items.*

**Related tasks:**
"Printing the Alternate Items Report" (page 303)

**Overview**

The I/C Alternate Items report lists the numbers of items to which alternate items are assigned, together with the numbers and descriptions of the corresponding alternate items.

You can print the report by item numbers, categories, item number segments, optional fields, and vendor numbers.

**When to Print**

Print the report when you add, change, or delete the alternate items you assigned to your item numbers in the I/C Items screen, or when you want to review the alternate items you use.

**Information Printed on This Report**

- The range of item numbers selected for the report.
- For each item, the alternate item number and corresponding description.

**I/C Bills of Material Report**

**To open this screen:**
Open *Inventory Control > I/C Setup Reports > Bills of Material.*
Related tasks:

- "Printing the Bills of Material Report" (page 304)
- "Adding Bills of Material" (page 155)
- "Updating Bills of Material" (page 158)
- "Copying Bills of Material" (page 157)

Overview

The I/C Bills Of Material report lists the component items and quantities required to build the master items in your Inventory Control system.

When to Print

Print this report when you add, delete, or modify components of the master items in your Inventory Control system.

Information Printed on This Report

- Item numbers and descriptions for master and component items, the bill of material number, the build quantity, and the unit of measure for each master and component item.
- Default BOM numbers (for the Assemblies/Disassemblies screen), if any are specified.
- The item numbers and descriptions of each item in each component bill of material, if listing component BOMs.
- The fixed and variable costs of the master item. If you select the Include Costs For Each Item option, the report also lists the unit costs of component items, and the total assembled cost of the master item.

I/C Categories Report

To open this screen:
Open Inventory Control > I/C Setup Reports > Categories.

Related tasks:

- "Printing the Categories Report" (page 306)
- "Setting Up Categories " (page 49)
Overview

The I/C Categories report lists the information entered to define the category codes you use to group inventory items.

When to Print

Print the report after adding, changing, or deleting category records, or when you need to check commission rates, general ledger account numbers, or tax information for a category.

Information Printed on This Report

- The default price list for the category, if one has been assigned. The code of the default price list appears automatically on item records you add that use the category, but you can assign other price lists to items.
- The commission rate allowed on sales from the category.

  This rate is used by Sage 300 ERP Order Entry for commissions unless it is zero. If this rate is zero, Order Entry uses the salespersons’ rates specified on the O/E Salesperson Commission Rates screen.

  **Note:** The commission rate appears only if you selected the *Allow Commissions* option for the category.

- The general ledger accounts to which you post transactions for each category.
- The tax authorities and tax classes applicable to each category. Category tax information appears as the default information in new item records you assign to the category.

I/C Customer Details Report

**To open this screen:**

Open **Inventory Control > I/C Setup Reports > Customer Details**.

**Related tasks:**

"Printing the Customer Details Report" (page 307)

Overview

The I/C Customer Details report lists customer item numbers and inventory item numbers that they identify.
When to Print

Print this report to see the item numbers customers use for your inventory items.

Information Printed on This Report

You can sort the report by item number or by customer number, and specify ranges of item numbers and customers that you want to appear on the report. It displays the following information:

- The numbers your customers use to identify your inventory items, along with the item numbers used in your inventory system.

  **Note:** This report includes details only for customers that are assigned to items on the I/C Customer Details screen. The report will be blank if you have not entered customer item numbers.

- Descriptions entered with each customer's item number.

- The unit of measure used by the item number.

I/C G/L Integration Report

To open this screen:

Open **Inventory Control > I/C Setup Reports > G/L Integration**.

Related tasks:

- "Printing the G/L Integration Report" (page 308)
- "Changing I/C General Ledger Integration Options" (page 77)

Overview

The I/C G/L Integration report lists the General Ledger transaction and batch creation options and other information you entered on the G/L Integration screen to specify how your Inventory Control system sends transactions to General Ledger.

When to Print

Print this report after setting up your Inventory Control system, or whenever you change I/C G/L Integration options.
**Information Printed on This Report**

- General ledger integration options.
- Information transferred from source transactions to General Ledger transaction fields.

**I/C Item Structures Report**

**To open this screen:**
Open **Inventory Control > I/C Setup Reports > Item Structures**.

**Related tasks:**
- "Printing the Item Structures Report" (page 309)
- "Adding Item Structures" (page 59)
- "About Item Number Formats" (page 55)

**Overview**

The I/C Item Structures report lists the information you entered in your Inventory Control system to format item numbers.

**When to Print**

Print this report after setting up your Inventory Control system, and when you add, change, or delete item structures.

**Information Printed on This Report**

- Descriptions of each segment composing an item structure.
- The characters you use in the structure as prefixes to item numbers, or to separate segments of item numbers.
- The total length of the item structure.
- A sample item number that uses the corresponding item structure.

**I/C Location Details Report**

**To open this screen:**
Open **Inventory Control > I/C Setup Reports > Location Details**.
Related tasks:
"Printing the Location Details Report" (page 312)

Overview
The I/C Location Details report lists information for items at each location where you allow the items to be stocked.

When to Print
Print this report before and after using the I/C Location Details screen to add or remove items from locations, or to change location detail records.

Information Printed on This Report
- Whether the item is allowed to be used in transactions at a location.
- Whether any transactions have been posted involving the item. "Yes" indicates that transactions have been posted for the item.
- An alternate cost for which you can enter amounts in the Location Details screen. You can assign the name for up to two alternate amounts in the Options screen. The amounts can also be used by Sage 300 ERP Order Entry and Purchase Orders as the basis of tax calculations.

I/C Locations Report

To open this screen:
Open Inventory Control > I/C Setup Reports > Locations.

Related tasks:
"Printing the Locations Report" (page 313)

Overview
The I/C Locations report lists the information entered to define the inventory locations used in Inventory Control.

When to Print
Print this report when you add, change, or delete locations, or when you want to refer to the address, phone numbers, and contacts for each location.
Information Printed on This Report

- The report includes the name and address of each location, the telephone and fax numbers at the location, the date the record was last maintained (edited), the date the location was set to Inactive status, if applicable, and the name of a contact person or position at the location.

- The report also includes the segments of your general ledger account numbers to which you post transactions for locations that use the Override G/L Account Segments option.

I/C Manufacturers' Items Report

To open this screen:
Open Inventory Control > I/C Setup Reports > Manufacturers' Items.

Related tasks:
"Printing the Manufacturers' Items Report" (page 314)

Overview
The I/C Manufacturers' Items report lists the information for manufacturers' item numbers (such as bar codes) that have been added for your inventory items.

When to Print
Print this report when you add, delete, or modify manufacturer's item numbers.

Information Printed on This Report

- The report includes the manufacturers' item numbers and inventory item numbers that they identify.

- The report also includes the descriptions entered with each manufacturer's item number, and the unit of measure used by the item number (so you can have different codes for individual items, boxes, and pallet loads).

I/C Optional Fields Report

To open this screen:
Inventory Control > I/C Setup Reports > Optional Fields.
Related tasks:
- "Printing the Optional Fields Report" (page 315)
- "Selecting a Print Destination" (page 299)

Overview
This report lists the optional fields you defined for Inventory Control.

When to Print
Print the report when you add, change, or delete optional field records, or when you need a listing of all the optional fields set up for Inventory Control.

Information Printed on the Report
For each type of optional field, the report shows the optional field codes, descriptions, default values, and whether the optional field is set for automatic insertion in new records.

I/C Options Report

To open this screen:
Open Inventory Control > I/C Setup Reports > Options.

Related tasks:
"Printing the Options Report" (page 316)

Overview
The I/C Options report lists the selected options and other information you entered in the I/C Options screen to specify how your Inventory Control system operates.

When to Print
Print the report before and after changing options.

Information Printed on This Report
- Company options
- Processing options
- Item number segment definitions
- Document numbering structure (length, prefix and next number)
- Aging periods for the Aged Inventory report
- Costing options
- Serialized Inventory options (if Serialized Inventory and Lot Tracking license is installed)
- Lotted Inventory options (if Serialized Inventory and Lot Tracking license is installed)
- Options related to the Optimize Inventory screen

I/C Price List Codes Report

**To open this screen:**
Open **Inventory Control > I/C Setup Reports > Price List Codes**.

**Related tasks:**
"Printing the Price List Codes Report" (page 317)

**Overview**
The I/C Price List Codes report lists codes you defined to identify your company’s price lists.

**When to Print**
Print this report when you add, delete, or modify price list codes, or when you need a list of the codes your company uses to identify price lists.

**Information Printed on This Report**
The report includes the code and description for each price list, as well as the discount or markup type and method of calculation, and the tax authorities and classes that apply.

I/C Reorder Quantities Report

**To open this screen:**
Open **Inventory Control > I/C Setup Reports > Reorder Quantities**.

**Related tasks:**
"Printing the Reorder Quantities Report" (page 318)
Overview

The I/C Reorder Quantities report lists the maximum and minimum item quantities permitted at your locations during each period. The report also shows the number of units you usually order at a time and the number of units you expect to sell in each period.

The report includes only items for which you have entered reorder information in the Reorder Quantities screen.

When to Print

Print the report when you are ready to reorder inventory items and want to determine the quantities to order. You can also use the report to review inventory and projected sales levels by period, to see whether you need to adjust figures in the Reorder Quantities screen. When you add, change, or delete information in Reorder Quantities, print a new copy of the report for your permanent Inventory Control files.

Information Printed on This Report

- The report includes the starting and ending dates for the reorder periods you assigned to an item and location.
- The maximum, minimum, and reorder quantities, and the projected sales figures for each period.

I/C Segment Codes Report

To open this screen:
Open Inventory Control > I/C Setup Reports > Segment Codes.

Related tasks:
"Printing the Segment Codes Report" (page 319)

Overview

The I/C Segment Codes report lists the segments used in your Inventory Control system and the segment codes and corresponding descriptions used with each segment.

When to Print

Print this report when you add, delete, or modify segment codes, or when you need a list of the segments and codes your company uses to identify items.
Information Printed on This Report

Printed with the All Segments option, the report lists each segment name and its corresponding segment codes and descriptions.

I/C Units of Measure Report

To open this screen:
Open Inventory Control > I/C Setup Reports > Units of Measure.

Related tasks:
"Printing the Units of Measure Report" (page 321)

Overview

The I/C Units of Measure report lists the information entered to define the inventory units of measure used in your Inventory Control system.

When to Print

Print the report when you add, change, or delete units of measure, or to provide people setting up items with a list of units of measure and their conversion factors that your company uses for inventory items.

Information Printed on This Report

The report lists the units of measure along with their default conversion factors.

I/C Vendor Details Report

To open this screen:
Open Inventory Control > I/C Setup Reports > Vendor Details.

Related tasks:
"Printing the Vendor Details Report" (page 321)

Overview

The I/C Vendor Details report lists vendors from whom you purchase inventory items and the items each supplies. The report includes only the vendors you have assigned to Inventory Control items in the I/C Vendor Details screen.
When to Print

Print the report when you need to review the vendors from whom you buy inventory, or when you change the vendor information for items.

Information Printed on This Report

The order in which the information appears on the Vendor Details report depends on your sorting selections. The other reports print your Inventory Control item numbers in the first column, followed by any additional sorting options (such as categories), and include the same types of information as you see on the sample report.

- The number you assign to identify the vendor in Inventory Control. If you use Sage 300 ERP Accounts Payable, you can select vendor numbers from Finders in Inventory Control.
- The number you use to identify the item in Inventory Control.
- A number you assign to the vendor in the item record, usually to identify vendors from whom you most frequently order the item.
- The code or number used by the vendor to identify the item.

I/C Weight Units of Measure Report

To open this screen:
Open Inventory Control > I/C Setup Reports > Weight Units of Measure.

Related tasks:
"Printing the Weight Units of Measure Report" (page 324)

Overview

The I/C Weight Units of Measure report lists the information entered to define the inventory weight units of measure used in your Inventory Control system.

When to Print

Print the report when you add, change, or delete weight units of measure, or to provide people setting up items with a list of the weight UOMs that have already been added.
**Information Printed on This Report**

The report lists the weight units of measure along with their descriptions and weight conversion factors. It also identifies the default weight unit of measure.

**I/C Transaction Listing Report Screen**

**To open this screen:**
Open *Inventory Control > I/C Transactions > Transaction Listing*.

**Related tasks:**
"Printing Transaction Listings" (page 375)

**Overview**

Use the I/C Transaction Listing Report screen to generate transaction listings.

A transaction listing provides a list of saved and/or posted transactions that have not been cleared from Inventory Control, including details about those transactions.

You can print the following types of transaction listings, one for each transaction type you can post in Inventory Control:

- Adjustments
- Assemblies
- Receipts
- Shipments
- Internal usage
- Transfers

**When to Print**

Depending on how you organize transaction entry, you may:

- Enter and save transactions, and then print a report showing all unposted transactions to review before posting.
- Print posted transaction listings at the end of the day to compare to source documents.
**Adjustments Transaction Listing**

The adjustments transaction listing includes adjustments created using:

- Adjustment entry in the Transactions folder.
- Process Adjustments in the Periodic Processing folder (if you are including posted transactions).
- Post Inventory Reconciliation in the Physical Inventory folder (if you are including posted transactions).

For information about adjustments, see "About Processing Adjustments" (page 175).

The following information is printed on the adjustments transaction listing:

- The adjustment number and the type of adjustment (Cost Increase, Cost Decrease, Quantity Increase, Quantity Decrease, Both Increase, Both Decrease).
- If you make an adjustment to a LIFO or FIFO item, the bucket type (Offset Bucket, Specific Bucket, or Prorate).
- The changes in functional currency to your adjustment/write-off accounts when you adjust costs. A change in quantity only does not affect these accounts.

**Assemblies Transaction Listing**

The following information is printed on the assemblies transaction listing:

- The Assembly number, assembly date, and transaction type (whether an assembly or disassembly).
- The original assembly (if disassembling a previous assembly).
- Bill Of Material (BOM) number and type of item (master or component).
- The build quantity for the bill of material used in the assembly.
- The fixed and variable costs for the assembly.
- The disassembly cost (if disassembling a previous assembly).
Receipts Transaction Listing

The following information is printed on the receipts transaction listing:

- All header material for the receipt, including:
  - Document number
  - Vendor number (if an A/P vendor)
  - Contact
  - Transaction status
  - PO number
  - Any additional costs
  - Date and fiscal period
  - Exchange rates (if applicable)

- All information entered for each item detail, including:
  - Item categories
  - Inventory location
  - Unit and extended prices
  - Unit and extended weights
  - Unit and extended costs
  - Quantity returned
  - Any adjustments to quantities and costs after the original receipt

Shipments Transaction Listing

The following information is printed on the shipments transaction listing:

- All header material for the shipment, including:
  - Document number
  - Customer number (if an A/R customer)
Appendix A: Inventory Control Screen Guides

- Contact
- Price list
- Transaction status
- Exchange rates (if applicable)
- Date and fiscal period
- All information entered for each item detail, including:
  - Item categories
  - Inventory location
  - Unit and extended prices
  - Unit and extended weights
  - Unit and extended costs

**Internal Usage Transaction Listing**

The following information is printed on the internal usage transaction listing:

- All header material for the internal usage transaction, including:
  - Document number
  - Date, year, and period of the transaction
  - Employee requester
  - Description
  - Reference
- All information entered for each item detail, including:
  - Location
  - Quantity
  - Unit of measure
  - Unit cost
  - Extended cost
**Transfers Transaction Listing**

The following information is printed on the transfers transaction listing:

- All header material for the transfer, including:
  - Document number
  - From transit number (if a transit receipt)
  - Transaction type
  - Transaction status
  - Expected arrival date
  - Proration method
  - Date and fiscal period
- All information entered for each item detail, including:
  - Requested and shipped quantities
  - Unit and extended weights
  - Unit and extended costs

**Setup Screens**

Set up records (such as account sets, locations, item structures, and units of measure) and specify options that determine how Inventory Control processes transactions and interacts with other Sage 300 ERP modules.

**I/C Account Sets Screen**

To open this screen:

Open **Inventory Control > I/C Setup > Account Sets**.

Related tasks:

- "Adding Account Sets" (page 43)
- "Setting Up Inventory Control" (page 5)
Overview

You use the I/C Account Sets screen, available in the I/C Setup folder, to create account sets for your Inventory Control ledger.

You can use as many account sets as you need for your inventory items, but you must define at least one account set for your inventory items.

By creating more than one set of control accounts you can:

- Maintain separate inventory control accounts for different types of inventory items.
  
  You can group items by the accounts to which you post item transactions in your general ledger. For example, you can use separate account sets for different item categories, for items assembled in different areas, or for items obtained from different suppliers.

- Use different inventory valuation methods for different groups of items. Because you assign a costing method to each account set, you can group items by the costing method you use to valuing inventory and determining the cost of goods sold.

**Important!** Sales, returns, and COGS accounts are specified in categories—not in account sets

Fields and Controls

Buttons

- **Add**
  
  Button description.

- **Delete**
  
  Button description.

Account Set Code

Each account set is identified by a unique code of up to six numbers and letters.

To begin adding a new account set, you can just type the code for the set, or you can click the New icon next to the Account Set Code field.

To edit an existing account set, type its code or select it from the Finder.
Costing Method
The costing method is the method you use for determining the current value of your inventory and the cost of goods sold.

In Sage 300 ERP, all the items assigned to an account set use the same costing method—which can be one of the following:

- Weighted moving average
- Standard cost
- First-in, first-out (FIFO)
- Last-in, first-out (LIFO)
- Most recent cost
- User-specified
- Serial costing
- Lot costing

If you store the same inventory item at more than one location, the program tracks and costs the item at each location (rather than costing all the items together).

Description
Enter a description of the account set, using up to 60 characters.

General Ledger Account Numbers
Enter the general ledger account numbers for:

- **Inventory Control account.** An asset account containing the total value of the inventory on hand (at actual cost). The account increases when you receive goods, and decreases when you ship goods.

  The word "control" in the account name means that the account contains only totals, whereas the information stored by Inventory Control contains details on an item-by-item basis.

  When you process all accounting entries correctly, the total cost of the inventory in the Inventory Control system equals the totals in the Inventory Control accounts in the general ledger.

- **Payables Clearing account.** A suspense account to which Inventory
Appendix A: Inventory Control Screen Guides

Control posts the "other side" of the accounting entries for inventory you receive (and for previous receipts you return to suppliers).

Inventory Control normally generates credit entries to this account for inventory you receive; therefore, the account can be thought of as the accrued amount payable for goods received into inventory. Inventory Control debits this account when you enter receipt returns.

As you post the related vendor invoices in Sage 300 ERP Accounts Payable, offsetting journal entries (debits) related to the inventory purchased are generated against the Payables Clearing account to clear the balance that is left in this account from posting the inventory receipt.

- **Adjustment Write-Off account.** The account to which you post inventory adjustments and write-offs. Entries to this account are normally expenses (debits); therefore, the account number you specify should be in the expenses or cost of goods sold section of your general ledger.

- **Assembly Cost Credit account.** The account to which you post the variable and fixed costs of assembling items. The program credits this account with the variable and fixed cost of assembly. You may want to create manual entries in the general ledger to redistribute the assembly cost credit to accounts such as labor costs.

- **Non-stock Clearing account.** The account which you credit when you ship non-stock items, and debit when you enter shipment returns for non-stock items.

  You can use non-stock items to handle specially ordered items which you do not stock in your inventory, and to handle service charges that appear on invoices.

- **Transfer Clearing account.** This account is used for the additional cost amount in the Transfer screen.

- **Shipment Clearing.** Debited instead of Cost of Goods sold when shipping goods from Order Entry.

  The Shipment Clearing account is required because the shipment and invoicing functions in Order Entry are separated. The COGS account is debited when you invoice the shipment.

- **Disassembly Expense.** Used if you specify an expense amount when you disassemble items that were previously assembled in Inventory Control.
- **Physical Inventory Adjustment.** The expense account that balances the change in inventory value when you adjust inventory quantities after making a physical inventory count.

- **Credit/Debit Note Clearing.** Debited instead of the IC Control account or the Damaged Goods account in Order Entry returns sent to Accounts Receivable. The G/L transaction credits the clearing account instead of COGS and A/R Control.

The Credit/Debit Note Clearing account is required because the inventory return and credit note functions in Order Entry are separated, with one side of the transaction going through the Accounts Receivable program.

**Inactive**
Select this option if you do not want to assign the account set to any inventory items.

If you make an account set inactive, you can no longer assign it to item records. You also cannot save changes to item records that use the inactive account set, unless you first assign the records to an active account set.

You would primarily use the option when you decide to delete an account set, and want to ensure no further inventory records are assigned to it.

You can change the option from Inactive to Active at any time.

**Last Maintained**
This is an information field in which the program displays the date of the last change made to the account set. You do not make an entry in this field.

**I/C Categories Screen**

**To open this screen:**
Open Inventory Control > I/C Setup > Categories.

**Related tasks:**
- "Setting Up Categories " (page 49)
- "Setting Up Inventory Control" (page 5)
Overview

You use the I/C Categories screen to:

- Set up a record for each category you want to use for grouping inventory items. For example, you can use categories to:
- Classify items into logical groups for reporting purposes.
- Allocate the sales, returns, cost of goods sold, cost variance, and damaged goods amounts for different kinds of items to different sets of general ledger accounts.

**Note:** You must add at least one category to Inventory Control before you can add item records.

Options Tab

Use the Options tab on the Categories screen to:

- Assign a default price list for items that you add to each category.
- Specify whether your sales staff earns commissions on sales in the category, and enter the maximum commission rate for the category.
- Enter the numbers of the general ledger sales, returns, cost of goods sold, cost variance, damaged goods, and internal usage accounts for which to create journal entries from transactions for items in the category.

Taxes Tab

The Taxes tab appears on your screen only if you have activated Tax Services for your Inventory Control company.

Use the fields on this tab to specify the tax authorities and associated sales and purchase tax classes that apply to items in the category.

Fields and Controls

**Category Code and Description**

Enter a code of up to six characters to identify this category of inventory item. You can use letters and numbers in category codes.

Enter a description for the category.
Options Tab

Allow Commissions
If you use Sage 300 ERP Order Entry and want to allow commissions to be earned on the sale of items in the category, select this option.

If you do not select this option and specify a maximum commission rate, Order Entry will not record commissions for the sales of items that use the category.

You can select or clear the Allow Commissions option at any time.

Default Price List
Enter a code or use the Finder to select the price list code (pricing method) you want to assign to the category.

When you later select a category while adding an item record, the category's price list code is included automatically. (You can override this price list code when you add an item record.)

General Ledger Accounts
For each category, you must enter general ledger account numbers for the five following accounts (Sage 300 ERP Order Entry uses the Sales account, Returns account, and Damaged Goods account—Inventory Control does not use them):

- **Sales.** A revenue account which Order Entry credits with the revenue from goods sold.

- **Returns.** A revenue contra account which Order Entry debits to record the reduction of revenue caused when previously sold goods are returned or credit notes are issued.

- **Cost of Goods Sold.** An expense account which Inventory Control automatically debits with the cost of goods sold, and credits with the cost of goods returned.

- **Cost Variance.** An expense account in which Inventory Control records the cost variance between the actual cost and either the standard cost (for items using the standard costing method) or the most recent cost (for items using the most recent costing method) of inventory items sold.
- **Damaged Goods.** A revenue contra account that is debited instead of Sales Returns whenever goods are returned as damaged in Order Entry.

- **Internal Usage.** The default expense or asset account that is debited when an item in this category is used internally. You can override this account when you enter transactions.

- If you use Sage 300 ERP General Ledger with your Inventory Control database, you can use the Finder to select general ledger accounts.

- Click the Finder icon or press F5 to display a list of general ledger account numbers. Highlight the account you want, then press Enter to select it.

**Inactive**

Select this option if you do not want to assign this category to any inventory items.

If you make a category inactive, you can no longer assign it to item records. You also cannot save changes to item records that use the inactive category, unless you first assign the records to an active category.

You would primarily use the option when you decide to delete a category, and want to ensure no further inventory records are assigned to it.

You can change the option from Inactive to Active at any time.

**Last Maintained**

This is an information field in which Inventory Control automatically inserts the date of the last change made to the record. You do not fill in this field.

**Commission Rate**

This field appears only if you selected the Allow Commissions option for the category.

Enter the commission rate (as a percentage of sales or margin) to be paid to a salesperson.

- This rate is used by Sage 300 ERP Order Entry for commissions unless it is 0.0000.
If this rate is zero, Order Entry will use the salespersons' rates specified in the Salesperson Commission Rates screen in the Order Entry program.

Note also the following points concerning sales commissions in Order Entry:

If you choose the Track Commissions option on the Options screen in Order Entry, the Order Entry program will:

- Base commissions on the sales or margin amount, depending on your choice in the Order Entry Options screen.
- Uses the costing information in Inventory Control to determine margins for commission calculations.
- Uses the rates specified for the item categories in Inventory Control unless the category commission rates in Inventory Control are zero.
- Uses the salespersons' rates specified in the Salesperson Commission Rates screen if the commission rates in Inventory Control categories are zero.

Taxes Tab

**Purchase Tax Class and Description**

Enter the tax class number or select the numbers of the tax classes you want to assign to the category for purchases for each selected tax authority. (You can override this purchase tax class for items you assign to this category.)

**Sales Tax Class and Description**

Enter a tax class or select the numbers of the tax classes you want to assign to the category for sales for each selected tax authority. (You can override this sales tax class for items you assign to this category.)

**Tax Authority**

Use the Finder to select the taxing authorities you want to assign to the category. (You define taxing authorities in the Tax Services feature in Common Services.)
**I/C Contract Codes Screen**

To open this screen:
Open **Inventory Control > I/C Setup > Contract Codes**.

Related tasks:
"Adding Contract Codes" (page 63)

Overview

Your vendors likely offer you various guarantees on the quality and durability of serialized or lotted items that you purchase from them, similar to the warranties you provide to your customers.

If you useSerialized Inventory and Lot Tracking, you can use the Contract Codes screen to enter the terms of sales agreements with your suppliers.

Each contract code can have up to five periods, and you can define the number of days in each period of the contract. The number of days in the periods are cumulative. For example, for a 90-day contract, you can have three periods set to 30 days.

Fields and Controls

**Contract Code and description**
A code of up to six characters to identify the contract, and a description of the contract code in the next field. Contracts can be provided by vendors on the serialized and/or lotted items you purchase from them.

**Table**

**Contract Days**
Enter the number of days in this period.

**Note:** This field is not available for a period where the Lifetime field is set to Yes.

**Effective Days**
Enter the number of days after the sold date that the contract period becomes effective.

For example:
Setup Screens

- If Effective Days = 0 (zero), the start date of the contract period is the sold date.
- If Effective Days = 5, the start date of the contract period is 5 days after the sold date.

**Lifetime**
If this contract period is a lifetime contract, double-click this field to display Yes.

When this field displays Yes, the Contract Days field is not available for the period.

**Period**
A contract code can have up to five periods.

When you press the Insert key to begin a new line, the next period number is displayed on the new line.

**Description**
Enter a description of the contract period, up to 60 characters.

**I/C G/L Integration Screen**

**To open this screen:**
Open Inventory Control > I/C Setup > G/L Integration.

**Related tasks:**
"Setting Up Inventory Control" (page 5)

**Overview**
You use the I/C G/L Integration screen to select options and settings that determine how your Inventory Control ledger interacts with your general ledger.

**Integration Tab**
Use this tab to:
- Specify whether to add general ledger transactions to the G/L batch during posting or each time you run Day End Processing, or to create the
transactions at a later date.

**Note:** This choice can have a large impact on the speed of processing inventory transactions and transactions in Order Entry. If you are costing inventory during posting, you may want to create transactions at a later date.

- Choose whether to create a separate G/L batch each time you create the G/L batch (and optionally automatically post the batch) or add new transactions to the existing batch. (This option applies only if you use Sage 300 ERP General Ledger with Inventory Control at the same location.)
- Choose whether to consolidate the G/L batch when you post, or always enter full transaction details in the batch.
- Assign different source codes to general ledger transactions created by Inventory Control and added to G/L batches. (New source codes are automatically added to G/L, but you will have to update G/L source journal profiles to include transactions on source journals.)
- Select the information to appear in the Entry Description, Detail Description, and Detail Reference and Comment fields in G/L transactions. (This information appears for transactions in the G/L Transactions report.)
- Look up the last Day End Number for which you have created general ledger batches.

**Transactions Tab**

Use this tab to:

- Select the information to appear in the Entry Description, Detail Description, and Detail Reference and Comment columns on the Inventory Control G/L Transactions report and in the corresponding fields in the general ledger batch.
- Look up the last Day End Number for which you have created general ledger batches.

**Fields and Controls**

**Buttons**

**Open**

Click this button to open the G/L Integration Detail screen, where you can select segments to use for references and descriptions for G/L
transactions and transaction details.

Include
Click this button to include segments selected on the left side of the screen in the description or reference you are updating for the transaction.

Exclude
Click this button to exclude segments selected on the right side of the screen if you do not want to use them in the description or reference you are updating for the transaction.

Integration Tab

Consolidate G/L Batches
Use the Consolidate G/L Batches option on the G/L Integration screen to specify whether to combine transaction details for the same general ledger account into a single detail, or send unconsolidated Inventory Control transaction details to General Ledger.

Consolidation reduces the amount of information in the general ledger batch, and results in a shorter G/L Transactions Listing.

You can choose:

- **Do Not Consolidate.** All the details posted in Inventory Control will be included in the General Ledger transaction batch.

  Choose this option if you use optional fields and pass optional field information from I/C transaction details to the G/L transaction details.

- **Consolidate Transaction Details by Account.** All the details within a transaction with the same general ledger account number are combined into one detail if the G/L Detail Description and the G/L Detail Reference are also the same. The program will not consolidate details that have a different description or reference.

  Choose this option if you do not use optional fields, but still want to associate general ledger transactions with originating documents (for drilldown or to maintain a manual audit trail).

- **Consolidate by Account and Fiscal Period.** All the details with the same general ledger account number and fiscal period are combined into one detail.
• **Consolidate by Account, Fiscal Period, and Source.** All the details with the same general ledger account number, fiscal period, and source code are combined into one detail.

This option will consolidate details from different transactions if you create transaction batches using the G/L Batch screen.

This option will consolidate details from different transactions if you create transaction batches using the G/L Batch screen.

**Note:** The posting date for consolidated entries is the last date of the fiscal period.

For more information, see "About Consolidating G/L Batches" (page 32).

**Create G/L Transactions**

Specify when to create general ledger transactions using one of the following selections:

• **During Posting or During Day End Processing.** This option lets you create general ledger transactions during posting or when you run day end processing—depending on your settings on the Costing tab of the I/C Options screen.

You choose when to create G/L transactions and audit information on the Costing tab of the I/C Options screen. The Create Subledger Transactions And Audit Info. During option gives you one of two choices on this screen:

  • During Posting (available only if you cost items during posting)
    
    G/L transactions will be created when transactions are posted.

  • During Day End Processing
    
    G/L transactions will be created when you run the Day End Processing task.

**Note:** These choices can have a large impact on the speed of processing transactions in Inventory Control, Order Entry, and Purchase Orders. If you need to speed up order processing, switch to costing inventory when you run Day End Processing (in I/C Options), and create G/L transactions using the Create G/L Batch icon.
Note: This option changes depending on the options you chose on the Costing tab of the I/C Options screen.

- **On Request Using Create G/L Batch Icon.** This option lets you create general ledger transactions at any time that’s convenient for you.

Once you create the transactions, you cannot print the G/L Transactions report in Inventory Control. If you wish to print the report, select the On Request Using G/L Batch Icon for this option. You must then print the report before you use the Create G/L Batch screen to create the transactions.

You can change your selection any time. If you were using the Create G/L Batch screen to create the transactions, print a copy of the latest G/L Transactions report, then create any outstanding transactions before changing your choice for the option.

**Create G/L Transactions By**

Specify whether to add new general ledger transactions to new batches or create new batches and optionally post them automatically to the general ledger.

You can:

- Add general ledger transactions to an existing Sage 300 ERP General Ledger batch.

- Create a new General Ledger batch each time you generate G/L transactions.

- Create a new General Ledger batch each time you generate G/L transactions, and automatically post the batch in the General Ledger program.

*Note:* If you are using Serialized Inventory and Lot Tracking, you cannot use this option to create and automatically post G/L batches during I/C transaction posting.

If you want to post batches automatically, you should choose the option to create subledger batches during day end processing (on the I/C Options screen).
Tip: Remember to create and post G/L batches for outstanding transactions before locking periods for General Ledger.

To have only one General Ledger batch to which all transactions are appended, turn on the Append G/L Transactions To Existing Batch option. Inventory Control must use the same database as Sage 300 ERP General Ledger.

If you do not use Sage 300 ERP General Ledger—or if your Sage 300 ERP General Ledger system is at another location—Inventory Control appends its general ledger transactions to a file in your company’s data directory called icgltran.csv, which can be imported by a remote site Sage 300 ERP General Ledger, or transferred to another general ledger that you use. The file is in a Comma Separated Values (CSV) format.

G/L Transactions Generated Through Day End Number
This field displays the last Day End number generated.

Transaction Type
This column lists the various types of transactions that are generated by the Inventory Control system, such as receipts, shipments, internal usage transactions, adjustments, or consolidated G/L entries.

You can change the source type code for each type of transaction created by I/C. You cannot change the source ledger code.

If you change the source type code for source codes, the new source codes are automatically added to the General Ledger module, but you will have to update G/L source journal profiles to include transactions on source journals.

The combination of source ledger code and source type code is called a source code in the General Ledger module.

Source Ledger
This column shows the source ledger code for all general ledger transactions created by the Inventory Control module.

You can change the source type code for each type of transaction created by I/C, but you cannot change the source ledger code.

The combination of source ledger code and source type code is called a source code in the General Ledger module.
Source Type
This column lists the two-character codes assigned to various types of transactions that are generated by the Inventory Control system, such as receipts, shipments, adjustments, or consolidated G/L entries.

If you want to, you can change the source type code for each type of transaction created by I/C. You cannot change the source ledger code.

If you change the source type code for source codes, the new source codes are automatically added to the General Ledger module, but you will have to update G/L source journal profiles to include transactions on source journals.

Transactions Tab
Optional tab description.

G/L Detail Comment
Select the type of information that you want to appear with unconsolidated details in the Comment column on the G/L Transactions report and in that field in the general ledger batch.

You can assign one or more pieces of information (segments) to each G/L transaction field, provided that the combined length of the segments and separators does not exceed 60 characters. Fields exceeding this limit will be truncated when you post the general ledger transactions.

If you do not consolidate general ledger transactions, information for all the G/L fields is passed to General Ledger.

The information you can select depends on the type of I/C transaction for which you are assigning information. For example, you can include information like the item number, document number, location, PO number, receipt number, reference number, source code, day end number, or entry number. You can separate pieces of information with slashes, parentheses, hyphens, periods, spaces, or number signs.

When you create general ledger transactions, if no data exists in the source transaction field, the field will be blank in the general ledger transaction.

G/L Detail Description
Select the type of information that you want to appear with unconsolidated details in the Description column on the G/L Transactions report and in that field in the general ledger batch. (The Detail Description
field is the description on each detail line, not the main description for the General Ledger transaction.)

You can assign one or more pieces of information (segments) to each G/L transaction field, provided that the combined length of the segments and separators does not exceed 60 characters. Fields exceeding this limit will be truncated when you post the general ledger transactions.

- When you consolidate general ledger transactions, the description for each transaction is changed to "Consol. by I/C on date." (Note that when there is only one of a particular transaction type, the description for the transaction is whatever you selected on the Integration tab in the Options screen.)

- If you do not consolidate general ledger transactions, information for all the G/L fields is passed to General Ledger. The information you can select depends on the type of I/C transaction for which you are assigning information.

  For example, you can include information like the item number, document number, location, PO number, receipt number, reference number, source code, day end number, or entry number. You can separate pieces of information with slashes, parentheses, hyphens, periods, spaces, or number signs.

- When you create general ledger transactions, if no data exists in the source transaction field, the field will be blank in the general ledger transaction.

**G/L Detail Reference**

Select the type of information that you want to appear with unconsolidated details in the Reference column on the G/L Transactions report and in that field in the general ledger batch.

You can assign one or more pieces of information (segments) to each G/L transaction field, provided that the combined length of the segments and separators does not exceed 60 characters. Fields exceeding this limit will be truncated when you post the general ledger transactions.

- When you consolidate general ledger transactions, the reference for each transaction remains blank and the description for each transaction is changed to “Consol. by I/C on date.” (Note that when there is only one of a particular transaction type, the reference and description for the transaction are whatever you selected on the I/C
Integration screen.)

- If you do not consolidate general ledger transactions, information for all the G/L fields is passed to General Ledger.

The information you can select depends on the type of I/C transaction for which you are assigning information.

For example, you can include information like the item number, document number, location, PO number, receipt number, reference number, source code, day end number, or entry number. You can separate pieces of information with slashes, parentheses, hyphens, periods, spaces, or number signs.

- When you create general ledger transactions, if no data exists in the source transaction field, the field will be blank in the general ledger transaction.

**G/L Entry Description**

The Entry Description field is the main description for the General Ledger transaction (not the description on each detail line).

You can assign one or more pieces of information (segments) to the description for each G/L transaction, provided that the combined length of the segments and separators does not exceed 60 characters. Fields exceeding this limit will be truncated when you post general ledger transactions.

If you use the On Request Using Create G/L Batch Icon option to consolidate general ledger transactions, the description for each G/L transaction is changed to "Consol. by I/C on date" (unless there is only one of a particular transaction type).

The information you can select depends on the type of I/C transaction for which you are assigning information.

**I/C Item Structures Screen**

**To open this screen:**

Open **Inventory Control > I/C Setup > Item Structures**.

**Related tasks:**

- "About Item Number Formats" (page 55)
- "About Planning Your Item Numbering System" (page 10)
Overview

You use the I/C Item Structures screen to:

- Specify the length and number of characters in your inventory item numbers.
- Format your item numbers for sorting and grouping items for reports and lists.

You can have as many different item structures as you need to accommodate different item number formats. However, you must add at least one item structure to Inventory Control before you can add item records.

**Note:** You create item structures from the segments you have added to the Options screen.

Fields and Controls

**Item Structure**

The Item Structure field displays a sample item number that uses the format you specified. The sample is updated each time you add a segment to the structure.

**Prefix**

If you want, you can select a character from this list to appear at the front of the item structure.

**Structure Code and Description**

Enter a code of up to six characters to identify the item structure.

To begin adding a new item structure, enter the code for the structure, or click the New icon next to the Structure Code field.

**Total Length**

The Total Length field displays the total number of characters in the selected item structure. The number is updated each time you add a segment to the structure. A complete item number can contain up to 24 characters, including separator characters.

**Use As Default Item Structure**

Select this option if you want the item structure to be the default item
structure that appears in the Items screen when you add an item record to Inventory Control.

This option appears in the Item Structures screen only if you have not selected a default item structure. To change the default item structure, use the Items tab in the Options screen.

You can override the default item structure that appears in the Items screen when you add an item record.

**Table**

**Segment Length**
This column displays the number of characters assigned to each of the segments you select for the item structure. (You specify the length of each item segment on the Items tab of the Options screen.)

**Segment Name**
Select the name of each segment, in the order you want, to use in the item structure.

**Segment Separator**
For each segment, you have the option to select a character from this list to appear at the end of the segment.

In item structures that use multiple segments, separator characters distinguish (visually) the segments from each other.

**I/C Locations Screen**

**To open this screen:**
Open *Inventory Control > I/C Setup > Locations*.

**Related tasks:**
- "Setting Up Inventory Control" (page 5)
- "Printing the Locations Report" (page 313)
- "Printing the Location Details Report" (page 312)
Overview

You use the I/C Locations screen to:

- Set up a record for each location where you stock inventory items.
- Designate locations as physical or logical (that is, used as goods-in-transit locations).
- Override general ledger account segments for an item's category and account set with General Ledger segment codes (typically to indicate the location of the item).
- Assign items to locations (if you do not use the Allow Items At All Locations option).

Address Tab

Use the Address tab to enter the name, address, phone and fax numbers of the location, and to set the location's status to inactive.

You also use this tab to specify whether an inventory site is a physical or logical location. (A logical location cannot receive or ship goods. It can only be used as a goods-in-transit location.)

Contact Tab

On this tab, you specify the name, telephone number, fax and e-mail address of the main contact person at this location.

Integration Tab

On this tab, you specify whether to replace (override) segments in general ledger accounts when you generate Inventory Control transactions involving items stocked at a location.

Items Tab

This tab appears only if you do not use the Allow Items At All Locations option on the I/C Options screen.

On this tab, you assign item numbers to a location and specify which of the assigned items can be used in transactions at the location.

Fields and Controls

Location
Enter a code of up to six characters to identify the location. The code can include letters and numbers, but no spaces.

**Address Tab**

**Address**
Enter the location’s street address in the spaces provided.

**City**
Enter the name of the city where the inventory location is found.

**Contact**
Enter the name of a contact person or a position at the inventory location.

**Country**
Enter the name of the country for the location.

**E-mail**
Enter the e-mail address for the location.

**Inactive**
Select this option if you do not want to assign this location to any inventory items.

If you make a location inactive, you are still allowed to add items to it, however, you cannot post transactions for items that have been assigned to an inactive location.

You would primarily use the option when you decide to delete a location, and want to ensure no further inventory records are assigned to it.

You can change the option from Inactive to Active at any time.

**Last Maintained**
This is an information field in which Inventory Control automatically inserts the date of the last change made to the record. You do not fill in this field.

**Location Type**
Choose whether this is a physical or logical inventory location. (A logical location cannot receive or ship goods. It can only be used as a goods-in-
transit location.)

**State/Province**
Enter the name of the state or province for the location.

**Telephone and Fax Numbers**
Enter the telephone and fax numbers for the location.

**Zip/Postal Code**
Enter the location's zip code or postal code.

**Contact Tab**

**Name**
Enter the name of the contact for this location.

**Telephone**
Enter the telephone number of the contact for this location.

**Fax**
Enter the fax number for the location's contact here.

**E-Mail**
Enter the e-mail address for the contact for this location.

**Items Tab (appears if the option Allow Items At All Locations is not selected)**

**Allow Items at This Location**
Select this option to specify that all the items you are adding to the location can be used in transactions at the location.

You must assign an item to a location before you can:

- Add (receive) the current quantity and cost for the item at the location.
- Transfer any goods to that location or use the location for goods in transit.

Before you can post transactions involving an item at a location, such as receive the item at the location, you must do one of the following:
Select the Allow Items At All Locations option in the I/C Options screen.

Assign the item to a location (an item can be assigned to more than one location).

**From/To**
- **From.** Enter the first item code or use the Finder to select the beginning of the range of items to assign to the location.
- **To.** Enter the last item code or use the Finder to select the end of the range of items to assign to the location.

**Select By**
Use this option to indicate the type of range you want to specify in the From and To fields when you select items to be assigned to the location.

- **Item number.** You must specify a range of item numbers.
- **Category code.** You must specify a range of category codes.
- **Item segment.** You must specify a range of item segments.
- **Picking sequence.** You must specify a range of picking sequence numbers.
- **Optional field.** If you added any optional fields to the Items tab of the Options screen, the titles of these fields appear in this list for you to select. If you select an optional field, then you must specify a range appropriate for the field.

**Table**

- **Allowed**
  Use this column to specify whether an item is allowed to be used in transactions at the location. Press any key in the field or double-click the field to toggle the response between Yes and No.

- **Description**
  This column displays the description entered in the Items screen for the item number.

- **Item Number**
  Enter the item number to add to the list or select the number from the
Finder.

**Integration Tab**

**Override G/L Account Segments**
Select this option if you want to replace (override) segments in general ledger accounts when you generate Inventory Control transactions involving items stocked at this location.

**Table**

**G/L Segment Code**
Enter a code or use the Finder to select the general ledger segment code with which to replace each general ledger account segment.

**G/L Segment**
Inventory Control lets you replace (override) segments in general ledger accounts when you generate Inventory Control transactions involving items stocked at this location.

Select each account segment that you want to replace in the general ledger account references when you post transactions for items at this location.

**I/C Mask Structures Screen**

**To open this screen:**
Open **Inventory Control > I/C Setup > Mask Structures**.

**Related tasks:**
- "Adding Mask Structures" (page 61)
- "Changing or Deleting Mask Structures" (page 62)
- "Printing the Mask Structures Report" (page 310)

**Overview**
If you use Serialized Inventory and Lot Tracking, you use the Mask Structures screen in the I/C Setup folder to define formats, or mask structures, for your serial numbers and lot numbers.
Fields and Controls

Mask Type
Select the type of mask, either Serial (for serial number) or Lot (for lot number).

Mask Structure
The Mask Structure field displays a sample mask number that uses the format you specified. The sample is updated each time you add a segment to the structure.

Numeric segments are shown with an "N" for each number in the segment. All Character segments are shown with an "A" for each character in the segment.

Description
Enter a description for the mask structure.

Structure Code
Enter a code of up to six characters to identify the mask structure.

Prefix
You can select a character from this list to appear at the beginning of the mask structure (optional).

Total Length
The Total Length field displays the total number of characters in the selected mask structure. The number is updated each time you add a segment to the structure. A complete mask number can contain up to 40 characters, including separator characters.

Table

Increment
To increment the number in a selected segment of the mask, double-click the Increment field to display Yes.

You can increment only one segment in a mask, and it must be a numeric segment.

If a mask contains any numeric segments, one of them must be set to increment.
**Segment Length**

Enter the number of characters in the segment. You cannot leave this field blank.

If you enter a length that results in the total length of the mask (including prefix and segment separators) to be more than 40, an error message is displayed.

**Segment Number**

A Mask Structure can have up to five segments, and there must be at least one.

When you press the Insert key to begin a new line, the next segment number is displayed on the new line.

**Segment Type**

Select the type of segment, either **All Characters** or **Numeric**.

In All Characters segments, any character except the characters used for Segment Separators can be entered. In Numeric segments, only numbers can be entered.

For example, AAA-NNNNN would indicate an All Characters segment that is three characters long with a hyphen for the Segment Separator, and a Numeric segment that is five characters long.

**Note:** If you want to be able to generate a sequence of serial numbers or lot numbers automatically, the mask structure must contain a numeric segment that is set up to increment.

**Segment Separator**

If you want to specify a character to separate the segment you are adding from the next segment, select the character from the drop-down list.

Otherwise, leave **None** in this field.

**I/C Options Screen**

**To open this screen:**

Open **Inventory Control > I/C Setup > Options**.
Related tasks:
- "Setting Up Inventory Control" (page 5)
- "Setting Up Multicurrency Accounting in Inventory Control" (page 13)

Overview
You use the I/C Options screen to:
- Select options for Inventory Control processes, items, and documents when you set up your ledger.
- Change Inventory Options after setup, as needed.

Company Tab
Use the Company tab to change the contact name, telephone number, and fax number for the company's Inventory Control administration.

Depending on the selection for the Format Phone Numbers option in the Company Profile (in Common Services), parentheses and hyphens may be inserted.

**Note:**
- To change the company name and address, or to change the contact name, telephone number, and fax number at the company level, use the Company Profile in Common Services.
- To change the contact name, telephone number, and fax number for the Inventory Control administration, use the Company tab on the I/C Options screen.

Costing Tab
Use the Costing tab to:
- Specify when the program should cost inventory—either each time you post an inventory transaction or only when you run Day End Processing.
- Specify when it should create sub-ledger and audit information.

**Important!**
These settings have a large impact on how Sage 300 ERP handles inventory transactions. They apply to all inventory transactions created in Inventory Control, Order Entry, and Purchase Orders.
If you cost inventory during posting, sales order posting and purchase order posting will take longer.

If you create sub-ledger batches during posting, you may also create and post A/R invoice batches with each O/E invoice and A/P invoice batches with each purchase order invoice.

After setup, you can switch from costing during posting to costing during day end processing at any time. However, you must run Day End Processing before switching to costing during posting to make sure that you complete item costing and to make sure that all G/L transactions have been created properly.

For information about setting that determine how and when to create G/L transactions, see "About Creating G/L Transactions" (page 31).

**Documents Tab**

Use the Documents tab to specify the prefix and sequence numbers for all numbers used to identify documents in your inventory system.

Inventory Control assigns a unique number to each document you add (shipments, receipts, returns, transfers, transfer receipts, adjustments, internal usage transactions, assemblies, and disassemblies).

The number is a combination of a prefix you use to identify the transaction type, and a number that Inventory Control assigns sequentially, starting with the number you specify. The default length of each document number is 22 characters (including the prefix).

**Items Tab**

Use the Items tab to:

- Specify the segments to use in your item numbers.

  You use segments to organize items by common attributes such as item category, style, color, or size. On many reports, you can specify the segment of an item number by which you want reports sorted.

  **Note:** Sage 300 Standard ERP allows up to 4 item number segments. Sage 300 Advanced ERP and Sage 300 Premium ERP allow 10 item number segments.

- Assign the default item structure for your Inventory Control ledger.
Setup Screens

- Choose which characters can be used as segment separators in item numbers.

**Tip:** After you add item number segments on this tab, you can define item number structures using the Item Structures screen.

**Lots Tab**

Use the Lots tab to specify default settings for assigning and allocating lot numbers to lotted items.

**Note:** The Lots tab is available only if you have a license to use Serialized Inventory and Lot Tracking.

**Optimizer Tab**

Use the Optimizer tab to specify options for the Optimize Inventory screen. For more information, see "I/C Optimize Inventory Screen" (page 460).

**Processing Tab**

Use the Processing tab to:

- Indicate whether your Inventory Control system uses multicurrency accounting.

- Change settings that determine whether you allow fractional quantities, negative inventory levels, receipt of non-stock items, and items at all locations.

- Set options for deleting transactions after posting, saving transaction history, and prorating additional costs on receipt returns to items remaining on receipts.

- Specify the default weight unit of measure, the default goods-in-transit location, and whether you use only defined units of measure.

- Change settings that determine whether to keep statistics for items and, if so, the type of year and period by which you accumulate the statistics.

- Assign names for up to two alternate cost fields you want to add to the Location Details screen or use as the base for discount pricing.

For more information, see "About Inventory Control Processing Options " (page 21)
Serials Tab

Use the Serials tab to specify default settings for assigning and allocating serial numbers to serialized items.

**Note:** The Serials Tab is available only if you have a license to use Serialized Inventory and Lot Tracking.

Fields and Controls

Company Tab
Enter information about your company in the fields on this tab.

Costing Tab

**Cost Items During**
Specify whether to cost items as soon as transactions are posted or at day end when you run Day End Processing.

- If you select the Cost Items During Posting option, Inventory Control immediately calculates and updates item costs for every shipment and receipt when you post the transaction.

  **Note:** Costing items during posting also means that posting orders from Order Entry can take longer. If you want to speed up order processing, switch to costing inventory when you run Day End Processing.

- If you select the Cost Items During Day End option, you must run Day End to update item costs for inquiries, reports and so on. Posting updates inventory quantities only.

In either case, Inventory Control updates inventory counts when you post transactions, so you always know your inventory levels.

If you choose to create G/L transactions during posting or day end processing, this setting also determines when Inventory Control creates transactions for posting to the general ledger.

**Create Subledger Transactions and Audit Info. During**
If you cost items during posting, you can also specify when to create
subledger transactions and audit information—during posting or when you run Day End Processing.

If you cost inventory items during Day End Processing, the program will also create subledger transactions at that time, unless you select the option on the G/L Integration screen to **Create G/L Transactions On Request Using the Create G/L Batch Icon**. (You will not be able to choose the During Posting option.)

**Note:** This option lets you choose between processing speed and keeping your inventory data up-to-date.

If you want to speed up order processing, you should:

- Create subledger transactions when you run Day End Processing or by using the Create G/L Batch screen.
- Cost inventory when you run Day End Processing.

In any case, Inventory Control updates inventory counts when you post transactions, so you always know your inventory levels.

**Documents Tab**

**Document Type**
Displays the type of documents produced by Inventory Control. For each document type, you can choose the prefix and sequence numbers for new documents.

**Length**
The maximum length of a document number is 22 characters.

If your document numbers are less than 22 characters long, you can edit this field.

**Next Number**
If you do not want to use the default starting number for each type of document, you can enter a different next number.

The program increases the number by 1 each time you post a transaction, but you are not forced to use the numbers assigned by the program.

**Prefix**
Enter the prefixes you use in your existing document numbers, or use the
default prefixes you see on this tab. Each prefix can be up to six alphanumeric characters.

**Items Tab**

**Default Item Structure**
During setup, you cannot select a default item structure to format your item numbers because you have not added your item structures yet. After you add your item structure(s), you can return to the Items tab and use this Finder to select or change the default item structure.

For each segment you want to use in your item structure(s), add the segment number, description, and length. You also specify whether to restrict what can be entered for the segment in item numbers.

**Length**
Enter a number, between one and 24, for how many characters an item number can use for the segment. (Item numbers contain a maximum of 24 characters, including optional separator and prefix characters.)

**Segment Name**
Enter a description of what the segment represents in the item number. For example, you might have a segment for region, color, or size.

**Segment No.**
A segment number appears automatically each time you move to a new line in the table. Segment numbers identify the segments, and you cannot change segment numbers after you save the Options screen.

**Note:** Sage 300 Standard ERP provides a maximum of 4 item number segments.

**Segment Separators**
For each segment, you have the option to select a character from this list to appear at the end of the segment.

In item structures that use multiple segments, separator characters distinguish (visually) the segments from each other.

**Validate**
Set this option to Yes if you want to restrict item numbers to using the
segment codes you add for this segment. For no restrictions, set this field to No.

To toggle between Yes and No, press the spacebar or double-click the field.

**Lots Tab**

**Allow Lot Quantity to be Different from the Quantity in the Entries**
Select the **Allow Lot Quantities to be Different from the Quantity in Entries** option to allow entries to be saved even if the number of assigned lot numbers is less than the quantity of lotted units that you are working with.

**Example:** Receiving 15 lots from a vendor requires you to generate 15 lot numbers during receipt before saving the transaction, unless this option is cleared.

**Auto-Allocation Sort By**
When auto-allocating serial/lot numbers, select whether to sort the numbers by:

- Serial/lot number
- Stock date
- Expiry date

**Days on Quarantine**
If you want all lots to be quarantined for a number of days after receiving them, select the **Days on Quarantine** option, and then specify the number of days for the quarantine period in the adjacent field. Lots are then automatically placed on quarantine after the receipt is processed.

**Note:** You can release individual lots before the specified period using the Quarantine Release screen.

**Days to Expiry**
If you want lot numbers to expire after a specified number of days, select the **Days to Expiry** option, and then enter the number of days from creation to expiration.
Tip: To enforce the expiration period, you should also select Warning or Error as the Expired Lot Allocation Message.

Expired Lot Allocation Message
Select the message that you want to display when lot numbers expire: None, Warning or Error.

Lot Number Mask
Select the code for the lot number mask to use as the default for lot numbers that you add to Inventory Control.

When you select a code, the program displays the description of the mask in the adjacent field.

Note: You can change the mask for a particular item using the I/C Items screen.

Separators Used in Lot Mask Structures
The Separators Used in Lot Mask Structures section lists the different characters that you can use to separate segments in Lot Masks.

To prevent a character from being used when creating a serial mask, double-click the Use column to set it to No for that character.

Use the Qty Ordered field in OE for the Allocation of Lot Numbers
This option affects users of Sage 300 ERP Order Entry. When selected, the quantity of serial/lot numbers that needs to be allocated to ordered items is determined by the Quantity Ordered field in Order Entry.

With Earliest/Latest First
When auto-allocating serial/lot numbers, select whether to sort the numbers with Earliest or Latest first.

Optimizer Tab

Maximum Quantity
The number in this field is used on the Optimize Inventory screen to calculate maximum item reorder quantities in the Optimal Maximum and Order Maximum fields, as follows:

Number specified in this field × Optimal Minimum or Order Minimum on the Optimize Inventory screen.

**Example:** If you specify a Maximum Quantity margin factor of 2, and the Order Minimum field on the Optimize Inventory screen displays 100, the Order Maximum field on the Optimize Inventory screen displays 200.

**Minimum Quantity**

The number in this field is used on the Optimize Inventory screen to calculate optimal minimum item reorder quantities, as follows:

Number specified in this field × Average Sales on the Optimize Inventory screen.

**Example:** If you specify a Minimum Quantity margin factor of 1.1, and the Average Sales field on the Optimize Inventory screen displays 100, the Optimal Minimum field on the Optimize Inventory screen displays 110.

**Sales Periods**

Specify the number of fiscal periods used to calculate optimal item reorder quantities on the Optimize Inventory screen. This must be a number from 1–12 (or 13, if you use 13 fiscal periods).

**Update Location Details**

Normally, when you click **Apply Selected Changes** on the Optimize Inventory screen, minimum and maximum quantities are updated on the Reorder Quantities screen. If you select the **Update Location Details** option, clicking **Apply Selected Changes** on the Optimize Inventory screen also updates the **Inventory Minimum (SIA)** field on the Location Details screen with the order minimum from the Optimize Inventory screen.

**Important!** If you use Sage Inventory Advisor (SIA), do not select this option.
Processing Tab

Accumulate By

The Accumulate By and Period Type fields let you choose whether to report period statistics by fiscal year or calendar year, and to specify the period type to use.

If you choose to accumulate by calendar year, the starting date for statistics will be January 1st. If you choose to accumulate by fiscal year the starting date will be the first day of your fiscal year.

You also specify the type of period by which the statistics are totaled and reported—weekly (Sunday=day 1), seven days (beginning on the first day of the week in your fiscal calendar), bi-weekly (Sunday=day 1), four weeks, monthly, bi-monthly, quarterly, semi-annually, annually, or fiscal period (if you select Fiscal Year for the Accumulate By option) (use the Period Type option).

You can change the type of year and period by which Inventory Control reports statistics, but you will not be able to compare new period figures directly to figures in past periods.

Tip: If you need to change the type of year or period by which Inventory Control reports statistics, you should either do so after year-end, or edit the statistics for the earlier periods in the year to correct distortions.

Note: The Accumulate By option appears only if the Keep Item Statistics option is selected.

Additional Cost For Items On Receipt Returns

When you post a receipt return transaction to record the return of goods to suppliers, Inventory Control can treat any additional costs assigned to the receipt in either of two ways. It can automatically prorate any additional cost assigned to the goods being returned over the remaining goods on the receipt, or leave the additional cost on the receipt. (Freight charges and duty charges are two examples of additional costs.)

You use the Additional Cost For Items On Receipt Returns field to specify how to handle additional costs, as follows:

- To have the program prorate the additional cost on receipt returns to the remaining items on the receipt, select Prorate for this option.
To have the program leave the additional cost assigned to the goods being returned, select **Leave** for this option. Use the I/C Adjustments screen to reassign to another general ledger account the additional cost that was assigned to the items being returned.

You can change your selection for this option at any time, and you can override your choice for this option when entering receipt returns using the I/C Receipts screen.

**Note:** If you return all of the items on a receipt, you must use the I/C Adjustments screen to reassign to another general ledger account the additional cost that was specified on the receipt.

**Allow Edit Of Statistics**

Select the **Allow Edit of Statistics** option if you want to add or edit either of the following statistics:

- Sales statistics for previous periods of the current year or for previous years. (You might want to do this if you set up your Inventory Control system partway through a fiscal year.)

- Transaction statistics from posted transactions.

**Note:** This option appears only if the **Keep Item Statistics** option is turned on.

You use the I/C Sales Statistics screen to add and edit sales statistics, and the I/C Transaction Statistics screen to edit transaction statistics.

Normally, you do not need to edit statistics, because they are updated automatically and accurately each time you run Day End Processing. However, if you set up your Inventory Control system partway through a fiscal year, you may want to use the Allow Edit Of Statistics option. You can then enter more complete inventory records by adding the statistics from your previous system for previous periods in the current year, and for previous years. (You use the Sales Statistics screen to edit the statistics.)

Once your system is operating, you should turn off the option because the program automatically updates the statistics when you post transactions.

You can turn on or turn off the Allow Edit Of Statistics option at any time.

**Allow Fractional Quantities**

If you allow transactions that use fractional quantities (such as 0.5 dozen)
in your present inventory control system and want to set up your Sage 300 ERP Inventory Control system to do the same, select the **Allow Fractional Quantities** option.

Fractional quantities are useful if your inventory includes homogeneous items. (Homogeneous items are those with identical elements that can be broken down into multiple, smaller units, such as oil or grain.) These items can require a wide range of units of measure.

**Tips:**
- **Fractional quantities let you use bigger stocking units.** Instead of using the smallest unit (such as ounces) as the stocking unit, use a larger stocking unit (such as pounds), and fractional quantities for amounts of less than a pound.

- **Fractional quantities in BOMs.** You must select the Allow Fractional Quantities option before creating BOMs that will include fractional quantities.

- **Do not select fractional quantities unless you need them.** If you do not intend to enter any transactions that use fractional quantities, you can simplify transaction entry by not selecting the Allow Fractional Quantities option. This means you do not have to enter decimal places for quantities, and it means that unnecessary decimal places do not appear on reports.

**Note:** You can select the **Allow Fractional Quantities** option at any time. However, once you select the option, you cannot change back.

**Allow Items At All Locations**
Select this option to allow inventory items to be stocked at all locations. You can select or clear the option at any time.

- **Is "All Locations" best for you?** If your company has only one location, or it does not need to restrict any items from being stored at any locations, you can save time setting up your Inventory Control system by permitting every item at all locations.

This allows you to start entering transactions right away involving any item at any location. (Transactions include receipts, shipments, returns, internal usage transactions, transfers, adjustments, and assemblies.)
• "All Locations" turned off. If you do not select the **Allow Items At All Locations** option, then before you can enter transactions for an item at a location you must use either the Location Details screen or the Locations screen to assign the item to the location.

**Allow Negative Inventory Levels**

Select this option if you allow processing of transactions that result in negative inventory levels (that is, permit the "on hand" quantity of stock items to go below zero).

For example, negative quantities can result from timing problems when you enter shipments for items before entering their receipts. In this situation, your inventory figures do not match the physical inventory.

If for any reason you do not want inventory levels to go below zero, do not select the **Allow Negative Inventory Levels** option.

If you do not select the option, you cannot post transactions that require more than the number of item units available at the specified location.

You can change your selection for this option at any time.

**Allow Receipt of Non-Stock Items**

This setting lets you order and receive special items for which you do not maintain an inventory quantity, and update the item’s vendor costing information. (The setting is used by Inventory Control, Order Entry, and Purchase Orders.)

Non-stock items are usually services or specially ordered items which are not normally kept in inventory.

Inventory Control does not maintain quantities and costs for non-stock items, and non-stock items must use the user-specified costing method. Additionally, you cannot enter assemblies for non-stock items.

**Alternate Amount (1 or 2) Name**

You can enter names in these fields as you want them to appear on the Location Details screen. (If you leave these fields blank, they will not appear in the screen.)

Alternate amounts are used in the following ways:

• If you type names in these fields, you can store costs for items in Inventory Control that Sage 300 ERP Order Entry can then use as the
basis for tax calculations. (Order Entry uses the tax base you specify in Tax Services.)

- You can use these fields as the base for discount pricing, marking up an alternate cost by percentages or by amounts.
- You can also print Inventory Control reports showing the amounts in these fields.

You can change the **Alternate Amount 1 Name** and **Alternate Amount 2 Name** at any time.

**Default Goods In Transit Location**
A goods-in-transit location is a virtual location where you store goods while they are in transit. This allows you to more closely match the transfer process, where goods may be on trucks or in transit for days or weeks at a time.

Each time you transfer goods between inventory locations, you can choose to transfer goods:

- Directly (and immediately) to the destination location.
- Using a goods-in-transit location.

Goods in transit are moved to the GIT location first, and then are received at the destination location. This means that goods can travel on different trucks and be received in separate lots. It also means that goods can stay in transit indefinitely.

A goods-in-transit location is treated just like any other inventory location, so you can check item quantities in transit.

**Default Posting Date**
Specify which date the program displays by default for the Posting Date when you enter receipt, shipment, internal usage, adjustment, transfer, and assembly transactions.

You can choose from two settings:

- **Document/Transaction Date.** Select this option if you usually want the posting date and fiscal period to match the document date.

    If you select this option, the program will automatically change the default posting date if you change the date in the associated date field on the document entry screen.
- **Session Date.** Select this option if you usually want the posting date and fiscal period to match the current session date.

  If you select this option, the program keeps the session date as the default posting date even if you change the document date.

  The posting determines the fiscal year and period to which a transaction is posted to General Ledger.

  If you have a multicurrency system, currency revaluation also uses posting dates to select open documents for revaluation purposes and thus, revaluation adjustments are posted to General Ledger in the correct fiscal year/period.

**Default Rate Type**

When you select the Multicurrency option, you also specify a default rate type, such as spot rate, for converting source-currency amounts in transactions to their functional-currency equivalents. To specify the default rate type, enter the code for the type or select a code using the Finder beside the field.

You can change the default rate type on the Processing tab of the Options screen at any time.

**Default Weight Unit of Measure**

Specify the weight unit of measure that is the basic or standard unit that you use for measuring the weight of your inventory items—such as pounds or kilograms.

**Note:** Usually, you will add weight units of measure after choosing inventory options, so you will select the default unit at a later time.

Order Entry uses the weights in inventory item records to estimate the total weight of each order in the unit of weight you specify here.

Purchase Orders can use the weights in inventory records to prorate (distribute) additional costs on orders.

**Functional Currency**

The functional currency is selected for the company in the Company Profile screen in Common Services, and is displayed on the Options screen.
Once the functional currency is assigned for a company, you cannot change it. All programs activated for the company automatically use the same functional currency.

**Keep Item Statistics**

Select the **Keep Item Statistics** option if you want to accumulate statistics from posted transactions.

Inventory Control retains transaction and sales statistics from the transactions processed for up to 53 periods per year, for any number of years. (Sage 300 Standard ERP is limited to accumulating statistics by fiscal year and fiscal period.)

Inventory Control uses these statistics to produce the Transaction Statistics report and the Sales Statistics report. You can print the statistics for an item by period and year, as far back as the oldest year and period for which you keep this information.

You can turn on or turn off the Keep Item Statistics option at any time. If you turn off the option, Inventory Control immediately stops saving statistics, although it retains those already collected until you clear (delete) them using the I/C Clear History option. If you turn the option on again, there will be a gap in the statistics corresponding to the period when the option was not used.

**Keep Transaction History**

To save transaction history for reporting, select the **Keep Transaction History** option on the Processing tab on the I/C Options screen.

Inventory Control can keep the detailed transaction records when you post so you can later print the Transaction History report. The Transaction History report lists all transactions posted for items assigned to the account sets you select within a specified period.

If you do not save transaction history, nothing is reported in the Transaction History report.

**Note:** This setting does not affect drilldown. Inventory Control automatically saves transaction history for drilldown purposes each time you post transactions unless you specifically delete transactions after posting.
Saving transaction details uses a large amount of space on your computer's hard drive, so after you print the Transaction History report, remember to clear the details using the Clear History screen.

**Multicurrency**

You can turn on this option only if you have already selected the **Multicurrency** option for the company on the Company Profile screen in Common Services.

You also specify a default rate type, such as spot rate, for converting source-currency amounts in transactions to their functional-currency equivalents.

**Important!** You can select the **Multicurrency** option at any time, but once you select the option, you cannot change Inventory Control back to a single-currency ledger.

**Only Use Defined UOM**

Inventory Control lets you define all of the buying, stocking, and selling units of measure that you require for inventory items using the I/C Units screen, and set up default conversion factors between each of the units.

- If you choose the **Only Use** setting, you can only use inventory units of measure that you have already defined in the Units setup screen.
  
  This setting lets you enforce consistency for all items added after you select this option.

- If you do not choose this setting, you can specify any units of measure for new inventory items—whether or not they have been added to Inventory Control.

**Note:** This option only affects new inventory items or new units of measure that you add to existing items. If you turn on this option, it will have no effect on existing items unless you add new units of measure to item records.

**Period Type**

**Accumulate By** and **Period Type** let you specify whether to report period statistics by fiscal year or calendar year, and to specify the period type to use.
If you choose to accumulate by calendar year, the starting date for statistics will be January 1st. If you choose to accumulate by fiscal year, the starting date will be the first day of your fiscal year.

The Period Type option is available only if you select the Keep Item Statistics option.

**Prompt To Delete During Posting**
This option lets you delete individual transactions immediately after posting if you do not want to save transaction information.

To delete transaction information, you must select the option Prompt To Delete During Posting on the Processing tab on the I/C Options screen.

If you want to keep all transaction information, make sure that you turn off this option.

**Note:** We recommend that you do not delete transactions.

If you delete transactions after posting, you will not be able to view posted transactions or drill down to them from General Ledger.

Also, if you post transactions using the I/C Post Transactions screen (instead of from a transaction entry screen), you will not have the option to delete. Instead, you can remove transactions using the I/C Clear History screen.

**Weight Unit Of Measure**
Enter the name of the unit of weight (such as "pounds" or "kilograms") you plan to use when you enter the weight of one stocking unit of an inventory item (you enter the weight of one stocking unit when you add your inventory items to Inventory Control).

- **Sage 300 ERP Order Entry.** If you integrate Inventory Control with Order Entry, the weight unit of measure is used by Order Entry to estimate the total weight of an order, for shipping purposes.

- **Sage 300 ERP Purchase Orders.** If you integrate Inventory Control with Purchase Orders, then Purchase Orders can use the weight unit of measure you supply in Inventory Control to prorate (distribute) additional costs on orders.

- **Changing the weight unit of measure.** If necessary, you can change the weight unit of measure after setting up your system;
however, if you have entered any weights in item records, you will need to change them so they correspond with the new unit of measure.

**Serials Tab**

**Allow Duplicate Serial Numbers**
If this option is selected, multiple items can have the same serial number, as long as they do not also have the same item number.

To prevent the assignment of a serial number to more than one item, regardless of item number, clear this option.

**Notes:**
- Even if this option is selected, two items with the same item number cannot have the same serial number.
- Clearing this option does not change existing assigned serial numbers, so any existing duplicated serial numbers remain.

**Allow Serial Quantity to be Different from the Quantity in the Entries**
Select this option to allow entries to be saved even if the number of assigned serial numbers is less than the quantity of serialized units that you are working with.

**Example:** Receiving 15 serialized items from a vendor will require you to generate 15 serial numbers during receipt before saving the transaction, unless this option is cleared.

**Auto-Allocation Sort By**
When auto-allocating serial/lot numbers, select whether to sort the numbers by:

- Serial/lot number
- Stock date
- Expiry date

**Days to Expiry**
If you want lot numbers to expire after a specified number of days, select the **Days to Expiry** option, and then enter the number of days from
creation to expiration.

**Tip:** To enforce the expiration period, you should also select **Warning** or **Error** as the Expired Lot Allocation Message.

**Expired Serial Allocation Message**

Select the message that you want to display when serial numbers expire: None, Warning or Error.

**Separators Used in Serial Mask Structures**

The Separators Used in Lot Mask Structures section lists the different characters that you can use to separate segments in Lot Masks.

To prevent a character from being used when creating a serial mask, double-click the **Use** column to set it to No for that character.

**Serial Number Mask**

Select the code for **Serial Numbers Mask** to use as the default for serial numbers that are added to the system.

You can change the serial numbers mask for individual serialized items in the I/C Items screen.

**Use the Qty Ordered field in OE for the Allocation of Serial Numbers**

This option affects users of Sage 300 ERP Order Entry. When selected, the quantity of serial/lot numbers that needs to be allocated to ordered items is determined by the **Quantity Ordered** field in Order Entry.

**With Earliest/Latest First**

When auto-allocating serial/lot numbers, select whether to sort the numbers with **Earliest** or **Latest** first.

**I/C Optional Fields Screen**

**To open this screen:**
Open **Inventory Control > I/C Setup > Optional Fields**.

**Related tasks:**
- "Setting Up Optional Fields for Inventory Control Records and Transactions"
Overview

Use the I/C Optional Fields setup screen to set up optional fields for use in Inventory Control item records and transactions.

Once you have set up optional fields for Inventory Control, you can use them when you add new items and enter inventory transactions.

**Setting up optional fields is a two-step process in Sage 300 ERP:**

1. Add system-wide optional fields to Sage 300 ERP using the Optional Fields screen in Common Services (see your System Manager Help).

2. Assign optional fields to the Items screen and to different types of Inventory Control transactions and transaction details using the I/C Optional Fields setup screen.

Fields and Controls

Buttons

**Settings**

Click the Settings button to open a separate screen where you specify whether this optional field will be included with transactions sent to General Ledger and other subledgers.

**Optional Fields For**

Select the type of record or transaction to which you want to add the optional field.

You can choose:

- Items
- Reorder Quantities
- Receipts
- Receipt Details
- Shipments
Appendix A: Inventory Control Screen Guides

- Shipment Details
- Adjustments
- Adjustment Details
- Transfers
- Transfer Details
- Assemblies
- Internal Usage
- Internal Usage Details
- Item Serials
- Item Lots

**Table**

**Auto Insert**
Select **Yes** in this field if you want the program to display the optional field and its default value when you set up new records or enter transactions.

Select **No** if you do not want the optional field to appear automatically. (If the field is required, you should choose Yes.)

**Default Value and Description**
If you chose Yes in the Value Set column, enter or select the value (data) that the program will display as the default for the optional field.

If the optional field you selected requires validation, you must select a value that is defined for the optional field in Common Services. However, if the optional field allows blanks, you can leave the default value field blank.

If the optional field does not use validation, you can do one of the following:

- Select a value that is defined for the optional field in Common Services.
- Leave the field blank.
Enter a combination of alphanumeric or special characters and spaces. The entry must be consistent with the type of field (text, number, date, amount, and so on) and must not exceed the number of characters specified for the optional field. In a Yes/No field, you can enter only Yes or No.

When you specify a value that is defined in Common Services, the program displays the description for the value.

**Optional Field and Description**
Use the Finder to select the optional fields that you are adding. (Optional fields must be defined in Common Services before you can select them.)

You can add an unlimited number of optional fields to each record or transaction type, providing the optional fields are set up in Common Services for use in your system.

When you select an optional field code, the program displays the description for the optional field.

**Required**
Double-click the Required column to change the setting to Yes or No.

If the optional field is required, it must be filled in during data entry before you can save the record or transaction.

- If the field has a default value, you can save it with the default.
- If the field does not have a default value set, you must fill in the field before you can proceed.

If you choose Required, the Auto-insert field will change to Yes.

**Value Set**
Double-click the Value Set column to show whether or not the optional field has a default value.

This column has two purposes:

- You must set the Value Set to "Yes" in order to set a default value for the optional field.
- The "Yes" flag provides information to the transaction-entry clerk, letting them know if the field contains default information.
I/C Price List Codes Screen

To open this screen:
Open Inventory Control > I/C Setup > Price List Codes.

Related tasks:
"Setting Up Inventory Control" (page 5)

Overview

Use the I/C Price List Codes screen to:

- Add price list codes to identify your price lists.
- Select default options for calculating customer discounts or markups for the items you later assign to the price lists.
- Check price overrides in Order Entry for customers and orders that use this price list.
- Specify default tax authorities and classes for the items you later assign to the price lists.

Discount Tab

Use the Discounts tab to:

- Specify the number of decimals to use in prices on the price list.
- Specify the method of calculating selling prices for items on the price list.

Price Check Tab

Use the Price Check tab to check price overrides in Order Entry for orders that use this price list.

If you choose None for the Price Check Type, this tab remains blank.

Note: Price checks are available only in Sage 300 Premium ERP.

Taxes Tab

Use the Taxes tab to specify the tax authorities and classes that apply to items on the price list.
Fields and Controls

Price List Code and Description
Enter a code of up to six characters to identify the price list. You can use letters and numbers in the code, but not spaces.

Enter a description for the price list code.

Discounts Tab

Customer types
These letters denote the five possible types of customers to which the discounts or markups you enter apply.

Customer types are assigned to customers in Accounts Receivable and used by the Order Entry program when you enter orders. Inventory Control does not use customer types.

Enter discounts or markups for as many customer types as you use.

Discount on Price By
Select from this list the method to use to calculate discounts on customer invoices.

- **Percentage.** The program discounts the base price using the percentages you specify in the fields in the lower part of this tab.

- **Amount.** The program discounts the base price using the amounts you specify in the fields on the lower part of this tab.

Discount Percent/Amount
Enter up to five price discount percentages or amounts (as appropriate) in the fields.

Enter discount amounts in pricing units (include any taxes that are assigned on the Taxes tab).

Markup on Cost By
Select from this list the method you want to use to mark up items to create different prices for different customers.


- **Percentage.** The program marks up the cost (markup cost or standard cost) using the percentages you specify in the fields in the lower part of the tab.

- **Amount.** The program marks up the cost (markup cost or standard cost) using the amounts you specify in the fields on the lower part of the tab.

**Markup Percent/Amount**

Enter up to five price markup percentages or markup amounts (as appropriate) in the fields.

Enter markup amounts in pricing units.

**Pricing Determined By**

Select from this list the method you want to use to determine price discounts for items.

- **Customer Type.** Inventory Control determines prices according to the customer’s type – A, B, C, D, or E.

- **Volume Discounts.** Inventory Control determines prices according to the quantity of an item the customer purchases.

**Price By Quantity or Weight**

Specify whether the price of the item is based on weight or on quantity.

If you specify weight, I/C lets you set volume discount amounts or percentages that are determined by item weight. The weights are calculated in Order Entry by multiplying the unit weight of an item times the quantity ordered, and converting the weight to default units.

**Note:** Pricing by weight is available only in Sage 300 Premium ERP.

**Price Decimals**

Select from this list the number of decimal places (up to six) you want the program to use for displaying and printing prices and costs.

**Pricing Determined By**

Select from this list the method you want to use to determine price discounts for items.
• **Customer Type.** Inventory Control determines prices according to the customer's type – A, B, C, D, or E.

• **Volume Discounts.** Inventory Control determines prices according to the quantity of an item the customer purchases.

**Quantity Purchased**

Enter up to five quantities (in the stocking units for the item) in the boxes. Each quantity you enter corresponds to the amount or percentage discount or markup (as appropriate) that you enter in the box to the left of it.

**Round To A Multiple Of**

Enter the number to which you want the program to round customer discount prices. For example, type **.05** to round prices that are not already a multiple of .05 to the next such multiple.

The program rounds prices up or down according to what you selected in the Rounding Method field.

**Note:** The Round To A Multiple Of field does not appear if you selected the No Rounding option in the Rounding Method field.

**Rounding Method**

Select the rounding method, Round Up or Round Down, you want the program to use when it calculates customer discount prices.

If you select No Rounding, prices appear exactly as calculated, to the number of decimal places specified by the Price Decimals field (or that your functional currency uses, if it uses fewer).

The program uses the selected rounding method when you discount or mark up prices by a percentage.

**Selling Price Based On**

Use this option to specify how the discount prices of items assigned to this price list will by default be calculated.

• **Discount.** Inventory Control calculates the selling price by discounting your base price for the item.
• **Markup on Markup Cost.** The program calculates the selling price by marking up the "markup cost" entered for the item on the first tab of the Item Pricing screen.

• **Markup on Standard Cost/Most Recent Cost/Average Cost/Last Cost/Alternate Amount 1 or 2.** Inventory Control calculates the selling price by marking up one of the costs kept for your items (including the value you enter as Alternate Amount 1 or Alternate Amount 2 in the Options screen).

**Price Check Tab**

**Check**
Choose whether the check should be done on the unit price or on the sales margin.

**Check Base**
If you are checking the unit price, you can check that the price falls within a percentage range of the cost, an amount range on the cost, or within a fixed range.

**Cost/Margin Base**
Choose the cost on which you are calculating the acceptable range of unit price or sales margin. (This field will not appear if you choose a fixed unit price.)

**Price Check Type**
Choose how you want Order Entry to respond to price overrides. Order Entry can:

- Do nothing (if you choose None).
- Display a warning message and let you continue.
- Display an error message and reject the price override.
- Force you to get a supervisor’s approval on price overrides.

**User ID / Greater Than / Less Than**
Enter the range of prices available to each user ID. If you want, you can create several price approval levels for sales clerks and supervisors.

**Taxes Tab**

**Tax Authority and Description**
Enter a tax authority code or use the Finder to select the tax authority (such as state or province) that taxes sales of the item. Inventory Control displays the tax authority description when you enter the tax authority code.

**Customer Tax Class and Description**
Enter a tax class code or use the Finder to select a customer tax class for the tax authority. Inventory Control displays the tax class description when you enter the tax class code.

**I/C Segment Codes Screen**

**To open this screen:**
Open **Inventory Control > I/C Setup > Segment Codes**.

**Related tasks:**
"Setting Up Inventory Control" (page 5)

**Overview**
You use the I/C Segment Codes screen to:

- Add valid segment codes to a table so Inventory Control will verify the item number segments when adding new items.

You can add segment codes for any segment you have added to the I/C Options screen. Use the Items tab in the I/C Options screen to turn on and off the option to use segment codes for individual segments.

**Note:** Adding segment codes is optional, as is using them once you have entered them.

**Fields and Controls**

**Segment Name**
Select the segment for which you want to add valid segment codes.

**Table**

**Description**
Enter a description or name for each segment code you add.
Segment Code
Enter each code that is valid for the selected segment.
Segment codes can be neither longer nor shorter than the length of the segment for which they will be used.

I/C Units of Measure Screen

To open this screen:
Open Inventory Control > I/C Setup > Units of Measure.

Related tasks:
- "Assigning Units of Measure to Items" (page 121)
- "Setting Up Inventory Control" (page 5)

Overview
You use the I/C Units of Measure screen to add the units of measure (UOMs) in which you buy, sell, price, and stock your inventory items.
Inventory Control lets you define all of your units of measure in a single place so you can add them more easily to item records.
Units of measure can be numbers of items, dry measures, liquid measures, or weights. You can add all of your stocking units and multiples of stocking units to the Units Of Measure screen, and then choose the group of units you need for each item you add.

Note: You can choose in the I/C Options screen whether to allow only the units of measure that you define here in inventory records. If you do not choose Only Use Defined UOM, you can use other units of measure with items.

Fields and Controls

Default Conversion Factor
Enter the factor for converting this unit to the item stocking unit. For example, if "each" is a stocking unit of measure (with a conversion factor of 1), the conversion factor for "dozen" would be 12.
You can have several units with a conversion factor of 1. Each of these units might be used as a stocking unit for an inventory item.
**Units of Measure**

Type the unit of measure as you want it to appear on data entry screens. For example, “each,” “dozen,” or “box.”

If units of measure have already been added to the Units Of Measure screen, you will have to press the Insert key to start a new line.

**I/C Warranty Codes Screen**

**To open this screen:**
Open Inventory Control > I/C Setup > Warranty Codes.

**Related tasks:**
"Adding Warranty Codes" (page 64)

**Overview**

If you sell items with basic and extendable warranties to your customers, and you have a license to use Serialized Inventory and Lot Tracking, you can set up warranty codes that you can apply to serialized or lotted items when you sell them.

Use the I/C Warranty Codes screen to enter the terms of sales agreements with your customers on the serialized or lotted items that they purchase from you.

Each warranty code can have up to five periods, and you can define the number of days in each period of the warranty. The number of days in the periods are cumulative. For example, for a 90-day warranty, you can have three periods set to 30 days.

**Note:** You may have to update the warranties periodically on items you sell.

**Fields and Controls**

**Warranty Code and description**

Enter a code of up to six characters that identifies the warranty, and enter a description of the warranty code in the next field. Warranties can be provided to customers on the serialized and/or lotted items they purchase from you.

**Table**

| Description |
Enter a description of the warranty period, up to 60 characters.

**Effective Days**
Enter the number of days after the sold date that the warranty period becomes effective.

For example:
- If Effective Days = 0 (zero), the start date of the warranty period is the sold date.
- If Effective Days = 5, the start date of the warranty period is 5 days after the sold date.

**Lifetime**
If this warranty period is for a lifetime warranty, double-click the Lifetime field to display Yes.

When this field displays Yes, the Warranty Days field is not available for the period.

**Period**
A Warranty Code can have up to five periods. When you press the Insert key to begin a new line, the next period number is displayed on the new line.

**Warranty Days**
Enter the number of days in this period.

Note that this field is not available for a period where the Lifetime field is set to Yes.

**I/C Weight Units of Measure Screen**

**To open this screen:**
Open **Inventory Control > I/C Setup > Weight Units of Measure**.

**Related tasks:**
- "Assigning Weight Units of Measure to Items" (page 123)
- "Setting Up Inventory Control" (page 5)
## Overview

You use the I/C Weight Units of Measure screen to add the different units that you use to measure the weight of items—such as pounds, tons, kilograms, and metric tons.

**Note:** On the I/C Options screen, you specify a default weight unit of measure, which the Order Entry module uses to express the weight of orders. The default weight unit of measure has a conversion factor of 1, and all other weight UOMs are defined in terms of a default weight UOM.

When you add a weight unit of measure, you specify:

- The weight unit of measure.
- A description of the weight.
- The weight conversion factor between the default weight unit of measure and the unit you are adding (as a multiple of the default weight unit of measure). The conversion factor for the default weight unit of measure is always 1.

**Note:** You can use fractions in weight conversion factors, even if you do not use fractional inventory quantities.

## Fields and Controls

### 1 (default unit) Equals

This column shows the opposite calculation to the conversion factor. For example:

<table>
<thead>
<tr>
<th>Weight UOM</th>
<th>Conversion Factor</th>
<th>1 Pound Equals</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pound—default UOM</td>
<td>1</td>
<td>1 lb.</td>
</tr>
<tr>
<td>Kilogram</td>
<td>2.2</td>
<td>.4545 kg.</td>
</tr>
<tr>
<td>Ton</td>
<td>2,000</td>
<td>.0005 tons</td>
</tr>
</tbody>
</table>

The reciprocal of the conversion factor is automatically calculated by Inventory Control. It provides a visual check on the conversion factor.

## Default Weight Unit of Measure

Specify the weight unit of measure that is the basic or standard unit that you use for measuring the weight of your inventory items—such as pounds or
kilograms.

**Note:** Usually, you will add weight units of measure after choosing inventory options, so you will select the default unit at a later time.

Order Entry uses the weights in inventory item records to estimate the total weight of each order in the unit of weight you specify here.

Purchase Orders can use the weights in inventory records to prorate (distribute) additional costs on orders.

**Description**

Enter a description for the unit of measure, such as pound or kilogram.

**Weight Conversion Factor**

Enter the factor for converting this weight unit to the default weight unit of measure. For example, if "pound" is the default weight unit of measure (with a conversion factor of 1), the conversion factor for “ton” would be 2,000.

You can use fractions in weight conversion factors even if you do not use fractional inventory quantities. For example, the factor to convert kilograms to pounds would be 2.2.

**Weight Unit of Measure**

Type the weight unit of measure as you want it to appear on data entry screens. For example, “lb” or “kg.” You can enter an expanded description in the next field.

---

**Statistics and Inquiries Screens**

Use Inventory Control Statistics and Inquiries screens to look up information about inventory items and transactions.

**I/C Sales Statistics Screen**

**To open this screen:**
Open Inventory Control > I/C Statistics and Inquiries > Sales Statistics.

**Related tasks:**
- "Adding Current Sales and Return Statistics" (page 40)
Statistics and Inquiries Screens

- "Looking Up Sales Statistics" (page 285)
- "Adding or Editing Transaction Statistics" (page 39)
- "Setting Up Inventory Control" (page 5)
- "Allowing Editing of Sales and Transaction Statistics" (page 37)

Overview

Use the I/C Sales Statistics screen to:

- View sales and return statistics for inventory items.
- Enter sales and return quantities and amounts for the years and periods for which you keep data in Inventory Control (if you selected the Allow Edit of Statistics option on the I/C Options screen).

If you want to use the I/C Sales Statistics report to assist you in managing your inventory, use the I/C Sales Statistics screen to add sales and returns data for your inventory items during setup.

You can add sales data for reporting periods from the current year and from previous years. After setup, Inventory Control automatically updates these statistics when you run Day End Processing. If you select the Allow Edit Of Statistics option on the I/C Options screen, you can edit the statistics as needed.

Note:
- To edit sales data, you need security authorization for Day End Processing and/or Item Maintenance.
- If you use multicurrency accounting, enter amounts in your company’s functional currency.

Fields and Controls

Item Number
Specify the item number for which you want to add, edit, or view sales statistics.

Location
Specify the location code for which you want to add, edit, or view sales statistics.

Year
Specify the year for which you want to add, edit, or view sales statistics. The Period Statistics table displays all periods for the selected year.

**Tables**

**Period**
Displays the periods for the year you specify in the **Year** field for the Period Statistics table.

**Returns Amount**
Enter the amounts for returns for the statistical period or year. If you use multicurrency accounting, enter amounts in your company's functional currency.

**Returns Cost**
Enter the cost of goods returned for the statistical period or year. If you use multicurrency accounting, enter amounts in your company's functional currency.

**Returns Count**
Enter the number of returns transactions that occurred during the statistical period or year.

**Returns Quantity**
Enter the number of items returned (in stocking units) during the statistical period or year.

**Sales Amount**
Enter the amounts for sales for the statistical period or year. If you use multicurrency accounting, enter amounts in your company's functional currency.

**Sales Cost**
Enter the cost of goods sold for the statistical period or year. If you use multicurrency accounting, enter amounts in your company's functional currency.

**Sales Count**
Enter the number of sales transactions that occurred during the statistical period or year.
Sales Margin

Inventory Control calculates the margin and displays the amount. Margin is calculated as:

\[(\text{Sales amount} - \text{Sales cost}) - (\text{Returns amount} - \text{Returns cost})\]

Sales Quantity

Enter the number of items sold (in stocking units) during the statistical period or year.

Year

Displays each year for which there are sales statistics.

I/C Transaction Statistics Screen

To open this screen:
Open Inventory Control > I/C Statistics and Inquiries > Transaction Statistics.

Related tasks:
- "Looking Up Transaction Statistics" (page 286)
- "Adding or Editing Transaction Statistics" (page 39)
- "Looking Up Transaction History" (page 291)

Overview

If you selected the Keep Item Statistics option on the I/C Options screen, you can use the I/C Transaction Statistics screen to:

- View transaction statistics for the years and statistical periods for which you keep data.

- Add transaction data for your inventory items so you can use the I/C Transaction Statistics report to assist you in managing your inventory (if you also selected the Allow Edit Of Statistics option on the I/C Options screen).

You can add transaction data for statistical periods from the current year and from previous years during setup. You can also add transaction data after setup.
If you have a multicurrency system, you enter statistical amounts in the functional currency.

**Note:** To edit sales data, you need security authorization for Day End Processing and/or Item Maintenance.

**Fields and Controls**

**Year**
Specify the year for which you want to add, edit, or view transaction statistics. The Period Statistics table displays all periods for the selected year.

**Tables**

**Internal Usage Cost**
Enter the cost of internal usage transactions posted during the statistical period or year. If you use multicurrency accounting, enter amounts in your company's functional currency.

**Internal Usage Count**
Enter the number of internal usage transactions posted during the statistical period or year. If you use multicurrency accounting, enter amounts in your company's functional currency.

**Period**
Displays the periods for the year you specify in the **Year** field for the Period Statistics table.

**Receipt Adjustments Cost**
Enter the cost of receipt adjustments posted during the statistical period or year. If you use multicurrency accounting, enter amounts in your company's functional currency.

**Receipt Adjustments Count**
Enter the number of receipt adjustments posted during the statistical period or year. If you use multicurrency accounting, enter amounts in your company's functional currency.
**Receipt Returns Cost**
Enter the cost of receipt returns posted during the statistical period or year. If you use multicurrency accounting, enter amounts in your company's functional currency.

**Receipt Returns Count**
Enter the number of receipt returns posted during the statistical period or year. If you use multicurrency accounting, enter amounts in your company's functional currency.

**Receipts Cost**
Enter the cost of receipt transactions posted during the statistical period or year. If you use multicurrency accounting, enter amounts in your company's functional currency.

**Receipts Count**
Enter the number of receipt transactions posted during the statistical period or year. If you use multicurrency accounting, enter amounts in your company's functional currency.

**Shipment Adjustments Cost**
Enter the cost of adjustments posted during the statistical period or year. If you use multicurrency accounting, enter amounts in your company's functional currency.

**Shipment Adjustments Count**
Enter the number of adjustments posted during the statistical period or year. If you use multicurrency accounting, enter amounts in your company's functional currency.

**Shipment Returns Amount**
Enter the sales/return amounts of shipment returns for the statistical period or year. If you use multicurrency accounting, enter amounts in your company's functional currency.

**Shipment Returns Cost**
Enter the cost of shipment returns for the statistical period or year. If you use multicurrency accounting, enter amounts in your company's functional currency.
Appendix A: Inventory Control Screen Guides

**Shipment Returns Count**
Enter the number of shipment returns for the statistical period or year. If you use multicurrency accounting, enter amounts in your company's functional currency.

**Shipments Amount**
Enter the sales/return amounts of shipments posted in the statistical period or year. If you use multicurrency accounting, enter amounts in your company's functional currency.

**Shipments Cost**
Enter the cost of shipments posted in the statistical period or year. If you use multicurrency accounting, enter amounts in your company's functional currency.

**Shipments Count**
Enter the number of shipments posted in the statistical period or year. If you use multicurrency accounting, enter amounts in your company's functional currency.

**Transfers Count**
Enter the number of transfers posted during the statistical period or year.

**Year**
Displays each year for which there are transaction statistics.

---

**I/C Current Transactions Inquiry Screen**

**To open this screen:**
Open **Inventory Control > I/C Statistics and Inquiries > Current Transactions Inquiry**.

**Related tasks:**
- "Looking Up Current Order Entry and Purchase Orders Transactions" (page 288)
- "Looking Up Transaction History" (page 291)
- "Looking Up Transaction Statistics" (page 286)
"Looking Up Sales Statistics" (page 285)

Overview

Use the I/C Current Transactions Inquiry screen to look up the following information for an item:

- Current sales orders originating in Order Entry.
- Purchase orders originating in Purchase Orders.

You can click the **Detail** button to view a selected transaction in the associated transaction entry screen (O/E Order Entry or P/O Purchase Order Entry).

Fields and Controls

Buttons

**Details**

Click **Details** to view the selected transaction in the associated transaction entry screen (O/E Order Entry or P/O Purchase Order Entry).

**Clear**

Click **Clear** to restore the default filter criteria for this screen.

**Go »**

Click the Go » button to view documents that match the criteria you specified.

**From / To Expected Ship/Arrival Date**

Specify the earliest and latest expected shipping or arrival dates. You can restrict the search to a single day by entering the same date in both fields.

**Inquire About**

Specify whether to look up purchase orders or sales orders.

**Item Number**

Enter an item number or select one using the Finder ñ.

I/C Transaction History Inquiry Screen

To open this screen:

Open **Inventory Control > I/C Statistics and Inquiries > Transaction**
**History Inquiry.**

**Related tasks:**
- "Looking Up Transaction History" (page 291)
- "Looking Up Transaction Statistics" (page 286)
- "Looking Up Stock Transactions" (page 285)

**Overview**

Use the I/C Transaction History Inquiry to view transactions created in Sage 300 ERP Order Entry, Purchase Orders or Inventory Control.

You can drill down to transactions as follows:

<table>
<thead>
<tr>
<th>Order Entry</th>
<th>Purchase Orders</th>
<th>Inventory Control</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invoices</td>
<td>Receipts</td>
<td>Receipts</td>
</tr>
<tr>
<td>Shipments</td>
<td>Invoices</td>
<td>Shipments</td>
</tr>
<tr>
<td>Credit notes</td>
<td>Returns</td>
<td>Adjustments</td>
</tr>
<tr>
<td>Debit notes</td>
<td>Credit notes</td>
<td>Transfers</td>
</tr>
<tr>
<td></td>
<td>Debit notes</td>
<td>Assemblies</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Internal usage transactions</td>
</tr>
</tbody>
</table>

**Fields and Controls**

**Buttons**

**Clear**

Click **Clear** to restore the default filter criteria for this screen.

**Details**

If you want to view a list of transactions that include an item, select a row, and then click **Details** to open the I/C Transaction History Inquiry Detail screen.

On this screen, you can select a row, and then click the **Drilldown** button to view the transaction in a transaction entry screen.
As At Year/Period
Specify the year and period up to which you want to view transaction history.

From / To Account Set
Specify the range of account sets to include in the inquiry.

From / To Location
Specify the range of locations to include in the inquiry.

From / To Item Number
Specify the range of item numbers to include in the inquiry.

I/C LIFO/FIFO Inquiry Screen

To open this screen:
Open Inventory Control > I/C Statistics and Inquiries > LIFO/FIFO Inquiry.

Fields and Controls

Buttons

Clear
Click Clear to restore the default filter criteria for this screen.

Details
Click Details to view the details of a selected document in the originating entry screen.

Go
Click the Go button to view documents that match the criteria you specified.

From / To Account Set
Specify the range of account sets to include in the inquiry.

From / To Location
Specify the range of locations to include in the inquiry.

From / To Item Number
Specify the range of item numbers to include in the inquiry.
Related tasks:
"Looking Up Costs of LIFO and FIFO Items" (page 292)

Overview

Use the I/C LIFO/FIFO screen to look up the costs of received, shipped and available items that use LIFO or FIFO costing by item and by location.

After you specify criteria, you can select an item and click the Details button to view additional information, including documents processed and quantities and costs shipped, received, and available.

Fields and Controls

Buttons

Clear
Click Clear to restore the default filter criteria for this screen.

Details
Click Details to view the details of a selected document in the originating entry screen.

Go ● ●
Click the Go ● ● button to view documents that match the criteria you specified.

From / To Account Set
Specify the range of account sets to include in the inquiry.

From / To Location
Specify the range of locations to include in the inquiry.

From / To Item Number
Specify the range of item numbers to include in the inquiry.

I/C BOM Component Usage Inquiry Screen

To open this screen:
Open Inventory Control > I/C Statistics and Inquiries > BOM Component Usage Inquiry.
Secondary screens:
"I/C Bills of Material Screen" (page 380)

Related tasks:
- "Looking Up Bills of Material by Component" (page 292)
- "Adding Bills of Material" (page 155)

Overview

Use the BOM Component Usage Inquiry screen to:
- View all bills of material in which a component item appears.
- View bills of material details for BOMs that include the selected component item.

I/C Item Location Details Quantity Inquiry Screen

To open this screen:
Open Inventory Control > I/C Statistics and Inquiries > Item Loc. Detail Qty Inquiry.

Related tasks:
- "Looking Up Sales Orders or Purchase Orders by Item" (page 287)
- "Looking Up Current Order Entry and Purchase Orders Transactions" (page 288)
- "Looking Up Transaction History" (page 291)

Overview

Use the I/C Item Location Details Quantity Inquiry screen to look up sales orders and purchase orders that include an item. You can filter inquiry results by location and by document type.

After you specify criteria, you can select an order and click the Details button to view additional information about the order in a transaction entry screen.

Fields and Controls

Buttons

Clear
Click Clear to restore the default filter criteria for this screen.
Details
Click **Details** to view the details of a selected document in the originating entry screen.

Go
Click the **Go** button to view documents that match the criteria you specified.

PO Receipts
If you use Sage 300 ERP Purchase Orders, click **PO Receipts** to view pending Purchase Orders receipts.

Document Type
Select the type of document to include in your inquiry:

- **Quantity on S/O** (all sales orders).
- **Quantity on P/O** (all purchase orders).
- **Quantity Committed** (documents where the item has been committed for the order).

Inquire For
Select a shipping location or all locations.

Item Number
Specify the item number you want to inquire about.

Table
After you display sales orders or purchase orders containing this item, you can select an order and click **Details** to view quantities and other order information in the transaction entry screen.

**Customer Number and Customer Name**
These fields appear if you selected **Quantity on S/O** or **Quantity Committed** as the document type. They display the numbers and names of customers included on sales orders that contain the item you are inquiring on.

Date
This is the posting date of the order containing the item that you are inquiring about.
**Expected Ship Date / Expected Arrival Date**

If you are viewing quantities on sales order, you see expected ship dates for orders that contain the specified item.

If you are viewing quantities on purchase order, you see the expected arrival dates for orders that contain the specified item.

**Order Number / PO Number**

If you are inquiring on sales orders, you see sales order numbers for orders that contain the specified item.

If you are inquiring on purchase orders, you see purchase order numbers for orders that contain the specified item.

**Vendor Number and Vendor Name**

These fields appear if you select *Quantity on P/O* as the document type. They display the numbers and names of vendors included on purchase orders that contain the item you are inquiring on.

---

**I/C Stock Transactions Inquiry Screen**

**To open this screen:**

Open **Inventory Control > I/C Statistics and Inquiries > Stock Transactions Inquiry**.

**Related tasks:**

- "Looking Up Stock Transactions" (page 285)
- "Looking Up Transaction History" (page 291)
- "Looking Up Transaction Statistics" (page 286)

**Overview**

Use the I/C Stock Transactions Inquiry screen to view opening and closing costs for a fiscal period, and to view transactions that result in movement of inventory items.

You perform this inquiry for a specific fiscal period, and can specify a range of item numbers, account sets, and locations to include in inquiry results.

**Viewing Transaction Details**

After specifying inquiry criteria and viewing results, you can select a row, and then click the **Details** button to open the I/C Stock Transactions Inquiry Detail...
screen and view a list of transactions that include an item, such as Purchase Orders receipts, or Order Entry shipments and invoices.

On this screen, you can select a row, and then click the Drilldown button to view the transaction in a transaction entry screen.

You can also click Print to open the I/C Stock Transactions report screen. For more information, see "Printing the Stock Transactions Report" (page 356).

**Note:**
- The **Quantity** and **Average Cost** columns appear in the table only if you specify a single item (by specifying the same item number in the **From** and **To** fields).
- The opening and closing costs that appear in the table are calculated from the start of the year up to the period you specify.
- Stock Transactions Inquiry replaces the "Stock Card Inquiry" functionality in Stock Card integration.

**Fields and Controls**

**Buttons**

**Clear**
Click **Clear** to restore the default filter criteria for this screen.

**Details**
After specifying inquiry criteria and viewing results, you can select a row, and then click the **Details** button to open the I/C Stock Transactions Inquiry Detail screen and view a list of transactions that include an item, such as Purchase Orders receipts, or Order Entry shipments and invoices.

On this screen, you can select a row, and then click the Drilldown button to view the transaction in a transaction entry screen.

**Go **
Click the Go button to view documents that match the criteria you specified.

**Print**
Click **Print** to open the I/C Stock Transactions report screen. For more
information, see "Printing the Stock Transactions Report" (page 356).

**Transactions**

Click **Transactions** to open the I/C Lot Number Transaction Inquiry screen and view a list of transactions for the selected lot number.

For more information, see "I/C Lot Number Transaction Inquiry Screen" (page 642).

**As at Year/Period**

Specify a year and period for which to view transaction information.

*Note:* The opening and closing costs that appear in the table are calculated from the start of the year up to the period you specify.

**From/To Account Set**

Specify a range of account sets to include in the inquiry.

**From/To Item Number**

Specify a range of item numbers to include in the inquiry.

*Note:* The **Quantity** and **Average Cost** columns appear in the table only if you specify a single item (by specifying the same item number in the **From** and **To** fields).

**From/To Location**

Specify a range of locations to include in the inquiry.

**Table**

The table displays opening and closing costs as at the year and period you selected (calculated from the start of the year up to the period you specify). It also displays information about transactions for the period, such as receipts, returns, sales, adjustments, transfers, assemblies, and internal usage transactions.

*Note:* The **Total Cost** column appears for all inquiries. The **Quantity** and **Average Cost** columns appear in the table only if you specify a single item (by specifying the same item number in the **From** and **To** fields).

**Average Cost**

This field displays the average cost of items for the selected row (that is,
opening costs, closing costs, or costs for the selected transaction type). It is calculated by dividing total cost by quantity.

**Note:** The **Quantity** and **Average Cost** columns appear in the table only if you specify a single item (by specifying the same item number in the **From** and **To** fields).

**Closing**
This field displays costs at period close, calculated from the end of the year.

**Opening**
This field displays costs at period open, calculated from the start of the year.

**Quantity**
This field displays the quantity of items for the selected row (that is, at period open or period close, or for the selected transaction type).

**Total Cost**
This field displays the total cost of items for the selected row (that is, opening costs, closing costs, or costs for the selected transaction type).

### I/C Serial Number Inquiry Screen

**To open this screen:**
Open *Inventory Control > I/C Statistics and Inquiries > Serial Number Inquiry*.

**Secondary screens:**
- I/C Serial Number Transaction Inquiry Screen
- "I/C Serial Numbers Screen" (page 481)

**Related tasks:**
- "Looking Up Serial Number Information" (page 289)
Statistics and Inquiries Screens

- "Looking Up Transaction History" (page 291)
- "Looking Up Transaction Statistics" (page 286)

Overview

If you use Serialized Inventory and Lot Tracking, you can use the I/C Serial Number Inquiry screen to look up serial numbers by criteria such as item number, location, stock date, and status.

When viewing serial number information in the table, you can select a row and view the following information about a serial number:

- **Details.** View details for the selected serial number on the I/C Serial Numbers screen. For more information, see "I/C Serial Numbers Screen" (page 481).

- **Transactions.** View a list of transactions for the selected serial number on the I/C Serial Number Transaction Inquiry screen. For more information, see I/C Serial Number Transaction Inquiry Screen.

You can also click the **Print** button to open the I/C Serial/Lot List report screen. For more information, see "Printing the Serial/Lot Number List Report" (page 348).

Fields and Controls

**Buttons**

**Clear**
Click **Clear** to restore the default filter criteria for this screen.

**Details**
Click **Details** to open the I/C Serial Numbers screen and view serial number details.

For more information, see "I/C Serial Numbers Screen" (page 481).

**Go ➤**
Click the Go ➤ button to view documents that match the criteria you specified.

**Print**
Click **Print** to open the I/C Serial/Lot List report screen.
For more information, see "Printing the Serial/Lot Number List Report" (page 348).

**Transactions**
Click **Transactions** to open the I/C Serial Number Transaction Inquiry screen and view a list of transactions for the selected serial number.

For more information, see I/C Serial Number Transaction Inquiry Screen.

**Item Number**
Specify a range of item numbers to include in the inquiry.

**Location**
Specify a range of locations to include in the inquiry.

**Serial Number**
Specify a range of serial numbers to include in the inquiry.

**Stock Date**
Specify a range of stock dates to include in the inquiry.

**Status**
Specify whether to include available serial numbers, unavailable serial numbers, or both.

**I/C Lot Number Inquiry Screen**

To open this screen:
Open **Inventory Control > I/C Statistics and Inquiries > Lot Number Inquiry**.

**Secondary screens:**
- "I/C Lot Number Transaction Inquiry Screen" (page 642)
- "I/C Lot Numbers Screen" (page 482)

**Related tasks:**
- "Looking Up Lot Number Information" (page 290)
- "Looking Up Transaction History" (page 291)
"Looking Up Transaction Statistics" (page 286)

**Overview**

If you use Serialized Inventory and Lot Tracking, you can use the I/C Lot Number Inquiry screen to look up lot numbers by criteria such as item number, location, stock date, and status.

When viewing lot number information in the table, you can select a row, and then view the following information for a lot number:

- **Details** (to view details for the selected lot number on the I/C Lot Numbers screen). For more information, see "I/C Lot Numbers Screen" (page 482).

- **Transactions** (to view a list of transactions for the selected lot number on the I/C Lot Number Transaction Inquiry screen). For more information, see "I/C Lot Number Transaction Inquiry Screen" (page 642).

You can also click the **Print** button to open the I/C Serial/Lot List report screen. For more information, see "Printing the Serial/Lot Number List Report" (page 348).

**Fields and Controls**

**Buttons**

**Clear**

Click **Clear** to restore the default filter criteria for this screen.

**Details**

Click **Details** to open the I/C Lot Numbers screen and view lot number details.

For more information, see "I/C Lot Numbers Screen" (page 482).

**Go**

Click the **Go** button to view documents that match the criteria you specified.

**Print**

Click **Print** to open the I/C Serial/Lot List report screen.

For more information, see "Printing the Serial/Lot Number List Report" (page 348).
Transactions
Click Transactions to open the I/C Lot Number Transaction Inquiry screen and view a list of transactions for the selected lot number.

For more information, see "I/C Lot Number Transaction Inquiry Screen" (page 642).

Item Number
Specify a range of item numbers to include in the inquiry.

Lot Number
Specify a range of lot numbers to include in the inquiry.

Location
Specify a range of locations to include in the inquiry.

Stock Date
Specify a range of stock dates to include in the inquiry.

Status
Specify whether to include available lot numbers, unavailable lot numbers, or both.

I/C Lot Number Transaction Inquiry Screen

To open this screen:
1. Open Inventory Control > I/C Statistics and Inquiries > Lot Number Inquiry.
2. Specify criteria, and then click the Go button.
3. Select a row, and then click the Transactions button.

Related tasks:
- "Looking Up Lot Number Information" (page 290)
- "Looking Up Transaction History" (page 291)
- "Looking Up Transaction Statistics" (page 286)

Overview
Use the I/C Lot Number Transaction Inquiry screen to view transaction information for a selected lot number.
You can view transaction information in the table, or you can select a row and click the **Details** button to open the source transaction in a transaction entry screen.

**Transactions Screens**

Use Inventory Control transaction entry screens to record the receipt, shipment, return, and internal usage of inventory items, transfers of stock between locations, assemblies of master items from component items, and adjustments of quantities and costs of items.

**I/C Adjustments Screen**

**To open this screen:**

Open *Inventory Control > I/C Transactions > Adjustments*.

**Related tasks:**

- "Adjusting Item Quantities and Costs" (page 179)
- "Assigning Serial/Lot Numbers to Adjustments" (page 248)
- "Posting Inventory Transactions" (page 226)

**Secondary screens:**

- "I/C Optional Fields Screen" (page 696)
- "I/C Serial/Lot Numbers Allocation/Generation Screen" (page 677)

**Overview**

Use this screen to:

- Enter and post adjustments to item quantities and costs.

  For each transaction, you enter the following information:

  - Adjustment Number (a number to distinguish the transaction from other adjustments for audit control purposes).
  - Description (add any information you want about the adjustment; optional).
  - Adjustment Date (to which you want the transaction posted).
  - Year and Period (to which you want the transaction posted).
• Reference (for example, the reason for the adjustment, or the purchase order number or invoice number; optional).

• Optional Fields (add optional fields to Adjustments using the Optional Fields screen in the Setup Folder; optional).

• Import adjustment transactions from other Sage 300 ERP databases or from non-Sage 300 ERP programs.

• Assign serial and/or lot numbers to items in adjustments if you have a license to use Serialized Inventory and Lot Tracking.

**Note:** If you use Project and Job Costing, material adjustment transactions created in Project and Job Costing appear in Inventory Control showing adjustments to particular contracts, projects, job categories and overhead accounts. However, you cannot use the Inventory Control program to adjust materials for jobs.

**Fields and Controls**

**Buttons**

**Delete**
Click **Delete** to remove the current transaction.

**Detail**
Click **Detail** to display information for a selected detail line in a separate Details screen.

**Post**
Click this button to post the current transaction.

**Save**
Click **Save** to save changes you have made to the screen.

**Adjustment Date**
Enter the date for the adjustment or select it from the calendar (click the Calendar button beside the date field).

Inventory Control automatically displays the session date as the default date, but you can change it. (The session date is the date that you entered when you started Sage 300 ERP).
You can also enter a separate posting date, which determines the fiscal year and period to which a transaction is posted in the general ledger.

You can change the document date and the posting date, but you cannot directly change the fiscal period.

**Adjustment Number**

The program automatically assigns a number if you leave "*** NEW ***" in the Adjustment Number field. The program-generated adjustment number is determined by settings in the I/C Options screen.

You can also enter an adjustment number (for example, based on the date) as long as the number is unique to distinguish it from other, existing adjustments.

Adjustment numbers can contain letters, numbers, and special characters (for instance, *, & #). Letters automatically appear in uppercase when you type them.

Note that when you post an inventory reconciliation for which an adjustment number already exists, the Inventory Worksheet will create separate adjustments for every one hundred items, and append "1", "2", "3", etc. to the end of the document number.

**Description**

Enter a description (optional) for the adjustment, using up to 60 characters.

This description appears with the transaction on the Adjustments Posting Journal.

It can also appear on the G/L Transactions report and in the general ledger batch (if Inventory Control uses **Description** for the G/L Entry Description field or the G/L Detail Reference field and you do not consolidate general ledger transactions).

**Entered By**

This field displays the name of the person who entered the transaction.

**Reference**

Enter a reference (optional) for the adjustment, using up to 60 characters.

This reference appears with the transaction on the Adjustments Posting Journal.

It can also appear on the G/L Transactions report and in the general ledger batch, if the G/L Reference field or the G/L Description field uses **Reference**.
in one of its segments, and you do not consolidate general ledger transactions.

**Optional Fields (transaction)**

If optional fields are set up for use in this type of transaction (applying to the entry as a whole), you can enter information in these fields by clicking the **Optional Fields** Zoom button in the top section of the transaction screen.

**Note:**
- Optional fields are available only if you have Sage 300 ERP Transaction Analysis and Optional Field Creator.
- Optional field information can pass to the General Ledger—as long as the optional fields assigned to the transaction screens or transaction details are also assigned to the general ledger accounts.

**Posting Date**

Specify the date to which to post the transaction to the general ledger. The posting date determines the fiscal year and period, which you cannot change directly.

In a multicurrency system, currency revaluation also uses posting dates to select open documents for revaluation purposes and, thus, revaluation adjustments are posted to the general ledger in the correct fiscal year and period.

Depending on your settings in the I/C Options screen, Inventory Control displays the session date or the document date as the default posting date.

**Note:** If you consolidate G/L transactions, the posting date for consolidated entries is the last date of the fiscal period.

**Year/Period**

The displayed year and period is determined by the posting date. You cannot change it except by changing the posting date.

**Table**

**Adjustment/Write-Off Account**

To change the general ledger account number, type over it. If you use Sage 300 ERP General Ledger, you can also select another account from the Finder.
Inventory Control automatically displays the general ledger adjustment write-off account from the item record's account set.

**Average Cost**
Displays the average cost of the item as of the last day-end.

**Bucket Type (FIFO or LIFO costing)**
Select a bucket type from the list to specify the way in which the program is to process the adjustment. Inventory Control automatically displays Offset Bucket.

**Comments**
Enter comments you want to appear on the Adjustments Posting Journal for the detail line. Use up to 250 characters.

**Contract / Project / Category / Overhead (if viewing job-related transactions from PJC)**
These fields appear if you have Sage 300 ERP Project and Job Costing.

If you enter materials adjustments through Project and Job Costing, the transactions created by Project and Job Costing will appear in Inventory Control.

Note, however, that you cannot use the job costing fields in the Inventory Control program.

**Cost Adjustment**
Enter an amount by which to adjust the extended item cost.

**Cost Date (FIFO or LIFO costing)**
To change the date, type over it.

Inventory Control automatically displays the transaction date for the receipt number you specify in the Receipt Number field.

**Cost UOM**
Displays the cost unit of measure.

**Document Number (FIFO or LIFO costing)**
If you selected Specific Bucket in the Bucket Type column, enter the receipt number of the transaction used to enter item units into inventory, or select the number from the Finder.
The receipt number you specify must appear in the Finder for this field.

**Item Description**
Inventory Control automatically displays the description entered for the item in the Items screen. You cannot change it in the Adjustments screen.

**Item Number**
Enter the item number of the item for which you are entering an adjustment, or select the number from the Finder.

You can enter manufacturers' item numbers that have been added to Inventory Control.

Once you press the Tab key, the program replaces the field contents with the inventory item number, and places the manufacturer's item number that you used in the **Manuf. Item No.** field (by default the second last field in the table).

**Line Number**
Line numbers show the order in which you added each detail line to the adjustment. They are assigned in sequence by Inventory Control and you cannot change them.

If you want to insert a detail line ahead of an existing line (except for line 1), select (highlight) the previous line, then press Insert. You cannot insert lines before the first detail line you enter.

To delete a line, place the insertion point in the line, then press the Delete key on your keyboard.

**Location**
Enter the code of the inventory location at which to make the adjustment for the item, or select the code from the Finder.

Locations in Inventory Control are either physical locations or logical locations.

You can adjust goods only at a physical location.

**Manufacturer's Item Number**
If you entered a manufacturer's item number in the Item Number field, the program replaces the Item Number field contents with the inventory item number, and places the manufacturer's item number that you used
in the Manuf. Item No. field (by default the last field in the table).

You must have already added the manufacturer’s item number using the Manufacturers' Items screen in the Items and Price Lists folder.

**Optional Fields (transaction detail)**

If optional fields are set up for use in details for this type of transaction, you can enter information in the detail optional fields by selecting the detail line, and then clicking the **Optional Fields** column heading in the Detail table.

**Note:**

- Optional fields are available only if you have Sage 300 ERP Transaction Analysis and Optional Field Creator.
- If information is entered in optional fields for a transaction detail, **Yes** appears in the Optional Fields column for the detail.

Optional fields can be set up to automatically contain information. If you have optional fields that are set up this way, **Yes** appears in the Optional Fields column for new transaction details.

- Optional field information can pass to the General Ledger—as long as the optional fields assigned to the transaction screens or transaction details are also assigned to the general ledger accounts.

**Quantity**

Enter the number of units by which to adjust the item quantity.

To decrease the quantity of an item in stock to below zero, you must have turned on the Allow Negative Inventory Levels option in the Options screen.

**Transaction Type**

You specify the type of adjustment you want for each item you add to an adjustment transaction. There are six types of adjustments you can enter:

- **Quantity Increase, Quantity Decrease.** Increases or decreases, respectively, the item quantity on hand at the location by the number you specify.
Quantity increase and quantity decrease adjustments affect the item's average unit cost at the location, but the item's extended cost does not change.

The program does not create general ledger transactions for these type of adjustments because the value of the inventory does not change.

- **Cost Increase, Cost Decrease.** Increases or decreases, respectively, the extended item cost at the location by the amount you specify. Inventory Control recalculates the average unit cost at the location based on the item's adjusted extended cost.

- **Both Increase.** Increases both the item quantity on hand and the extended item cost at the location by the increases you specify. Inventory Control recalculates the item's average unit cost at the location based on the increases.

- **Both Decrease.** Reduces both the item quantity on hand and the extended item cost at the location by the decreases you specify. Inventory Control recalculates the item's average unit cost at the location based on the decreases.

**Unit of Measure**

Enter the unit of measure for the item, or select the unit from the Finder.

You must use a unit of measure that has been assigned to the item in the I/C Items screen.

**I/C Assemblies/Disassemblies Screen**

**To open this screen:**
Open **Inventory Control > I/C Transactions > Assemblies**.

**Related tasks:**
- "Assembling Items from Bills of Material" (page 170)
- "Disassembling Master Items" (page 172)
- "Adding Bills of Material" (page 155)
- "Assigning Serial/Lot Numbers to Assemblies/Disassemblies" (page 250)
- "Posting Inventory Transactions" (page 226)
Secondary screens:

- "I/C Optional Fields Screen" (page 696)
- "I/C Serial/Lot Numbers Allocation/Generation Screen" (page 677)

Overview

Use this screen to:

- Enter and post assemblies of master items from component items.
- Enter and post disassemblies of master items from component items.
- Import assembly transactions from other Sage 300 ERP databases or from non-Sage 300 ERP programs.
- Assign serial and/or lot numbers to component or master items if you have a license to use Serialized Inventory and Lot Tracking.

Fields and Controls

Buttons

Delete

Click Delete to delete an unposted assembly or disassembly.

If you have already posted an assembly, it must be costed before you can disassemble the build. (If the status is posted, you must run Day End Processing to re-cost the inventory.)

Details

Click Details to see the assembly numbers and quantities for built components.

The Details button is available when you display a posted assembly that has subassemblies.

Post

When you are finished, click Save or Post.

- If you click Save, Inventory Control saves the transaction so you can edit and post it later.
The program displays a message with the assembly/disassembly number, and reminds you that assemblies and disassemblies will not be costed until they are posted.

**Tip:** You can delete a saved (unposted) assembly transaction.

- If you click Post, Inventory Control posts the assembly/disassembly.
  - If Inventory Control uses the option Prompt To Delete During Posting, the program warns you that you will not be able to drill down to the transaction details from General Ledger if you delete the transaction.
  - If Inventory Control uses the option to Cost Items During Posting, the program will calculate and update item costs for inquiries, reports, and so on.
  - If Inventory Control uses the option to Cost Items During Day End, you must run Day End Processing to update item costs for inquiries, reports, and so on.

**Note:** You cannot disassemble an assembly until it has been costed.

**Serials/Lots**
This button is available only for serialized and/or lotted items.

When you click **Serials/Lots**, a separate screen appears, which you use to assign serial numbers or lot numbers to the items.

**Save**
When you are finished, click **Save** or **Post**.

- If you click Save, Inventory Control saves the transaction so you can edit and post it later.
  The program displays a message with the assembly/disassembly number, and reminds you that assemblies and disassemblies will not be costed until they are posted.
  **Tip:** You can delete a saved (unposted) assembly transaction.

- If you click Post, Inventory Control posts the assembly/disassembly.
  - If Inventory Control uses the option Prompt To Delete During Posting, the program warns you that you will not be able to drill
down to the transaction details from General Ledger if you delete the transaction.

- If Inventory Control uses the option to Cost Items During Posting, the program will calculate and update item costs for inquiries, reports, and so on.

- If Inventory Control uses the option to Cost Items During Day End, you must run Day End Processing to update item costs for inquiries, reports, and so on.

**Note:** You cannot disassemble an assembly until it has been costed.

### Verify Quantities

Click **Verify Quantities** to check whether sufficient quantities of component items are in stock.

This button lets you see if you have enough quantity of the item to build the number of master items entered in the Quantity field, and make sure that Inventory Control will allow each component item to be stocked at the inventory location you specified in the Location field.

### Assembly Number

Press the Tab key to start a new assembly or disassembly using a program-assigned number.

The program automatically assigns the assembly number if you leave "*** NEW ***" in the Assembly Number field. The program-generated assembly number is determined by settings in the I/C Options screen.

You can also enter a assembly number-perhaps based on the date and item number. The assembly number must be unique, and up to 22 characters long to distinguish the new assembly from other existing assemblies.

Assembly numbers can contain letters, numbers, and special characters (for instance, *, & #). Letters automatically appear in uppercase when you type them.

### BOM Number

Enter a number or type over the existing BOM number for the bill of material to use for assembling or disassembling units of the master item, or select the number from the Finder.

You can view (and edit) the bill of material that you specify by clicking the zoom button beside the BOM Number field (or press F9) to open the Bills.
Of Material screen for the selected master item. Click Close to return to the Assemblies screen.

If you are disassembling a specific assembly, you cannot change the BOM.

**Build Quantity**

The Build Quantity field displays the build quantity specified for the master item in the Bills Of Material screen. The number you enter in the Quantity field must be a multiple of this number.

You cannot change this field.

**Component Assembly Method**

If the bill of material contains subassemblies (component master items), you can choose to assemble:

- **None.** Do not assemble any subassemblies.
- **All Component Master Items.** Assemble as many subassemblies as are listed in the build quantity for the master item.
- **Component Master Items With Insufficient Quantity.** Assemble only the number of subassemblies required to complete the master item build quantities. (If enough subassemblies exist, no new ones will be built.)

**Component Disassembly Method**

If the bill of material that you are disassembling contains subassemblies (component master items), you can choose to disassemble:

- **None.** Do not disassemble any subassemblies.
- **All Component Master Items.** Disassemble all subassemblies that are listed in the build quantity for the master item.

Note that you can only disassemble components if they were assembled in the particular build that you are disassembling.

**Date**

Enter the date for the assembly or select it from the calendar (using the calendar button beside the date field).

Inventory Control automatically displays the session date as the default date, but you can change it. (The session date is the date that you entered when you started Sage 300 ERP.)
You can also enter a separate posting date, which determines the fiscal year and period to which a transaction is posted in the general ledger.

You can change the document date and the posting date, but you cannot directly change the fiscal period.

Description
Enter a description (optional) for the assembly entry, using up to 60 characters.

This description appears with the transaction on the Assemblies Posting Journal.

It can also appear on the G/L Transactions report and in the general ledger batch (if Inventory Control uses **Description** for the G/L Entry Description field or the G/L Detail Reference field and you do not consolidate general ledger transactions).

Disassembly Cost
If you are disassembling items, you can enter a disassembly cost.

Entered By
This field displays the name of the person who entered the transaction.

From Assembly Number
If you are entering a disassembly, select the assembly that you are disassembling in the From Assembly field. Leave the field blank if the From Assembly transaction no longer exists.

**Note:** If you are disassembling a previous assembly, you can only specify the quantity being disassembled and a disassembly cost.

Location
Enter the code of the inventory location of the component items and the assembled master items, or select the code from the Finder.

Locations in Inventory Control are either physical locations or logical locations.

You can assemble goods only from a physical location.
**Note:** If the **Allow Items At All Locations** option is not selected on the I/C Options screen, you can post the transaction only if the specific master item and its components are allowed to be stocked at this inventory location.

**Master Assembly Number (disassemblies)**
This field appears if you are displaying a subassembly for a master item (on multi-level bills of material).

Click the Drilldown button to display the master item that included this subassembly.

**Master Item Number**
Enter the item number of the master item being assembled, or select the number from the Finder.

**Note:** The program automatically displays a bill of material number in the BOM Number field if you select the item number from the Finder.

**Optional Fields (transaction)**
If optional fields are set up for use in this type of transaction (applying to the entry as a whole), you can enter information in these fields by clicking the **Optional Fields** Zoom button in the top section of the transaction screen.

**Note:**
- Optional fields are available only if you have Sage 300 ERP Transaction Analysis and Optional Field Creator.
- Optional field information can pass to the General Ledger—as long as the optional fields assigned to the transaction screens or transaction details are also assigned to the general ledger accounts.

**Optional Fields (transaction detail)**
If optional fields are set up for use in details for this type of transaction, you can enter information in the detail optional fields by selecting the detail line, and then clicking the **Optional Fields** column heading in the Detail table.

**Note:**
- Optional fields are available only if you have Sage 300 ERP Transaction
Analysis and Optional Field Creator.

- If information is entered in optional fields for a transaction detail, **Yes** appears in the Optional Fields column for the detail.

Optional fields can be set up to automatically contain information. If you have optional fields that are set up this way, **Yes** appears in the Optional Fields column for new transaction details.

- Optional field information can pass to the General Ledger—as long as the optional fields assigned to the transaction screens or transaction details are also assigned to the general ledger accounts.

**Posting Date**

Specify the date to which to post the transaction to the general ledger. The posting date determines the fiscal year and period, which you cannot change directly.

In a multicurrency system, currency revaluation also uses posting dates to select open documents for revaluation purposes and, thus, revaluation adjustments are posted to the general ledger in the correct fiscal year and period.

Depending on your settings in the I/C Options screen, Inventory Control displays the session date or the document date as the default posting date.

**Note:** If you consolidate G/L transactions, the posting date for consolidated entries is the last date of the fiscal period.

**Quantity**

If you want to change the number displayed in the Quantity field, type over it. Inventory Control automatically displays the bill of material’s build quantity in the bill of material’s unit of measure.

**Note:** The quantity must be a multiple of the number in the Build Quantity field. For example, if the build quantity for the bill of material is 25, then you must specify a multiple of 25 (such as 25, 50, or 75) for the quantity, or the program will not allow you to post the assembly.

Click the Verify Quantities button (or press Alt+V) to check whether sufficient quantities of component items are in stock to build the number of master items you entered in the Quantity field, and to make sure Inventory Control allows each component item to be stocked at the inventory location you specified in the Location field.
Appendix A: Inventory Control Screen Guides

The program allows you to post assemblies for which there are insufficient numbers of component items in stock, only if you turned on the Allow Negative Inventory Levels option in the Options screen.

If you did not turn on the Allow Items At All Locations option in the Options screen, you can post the transaction only if you allowed the component items and the master item to be stocked at the specified inventory location.

**Reference**

Enter a reference (optional) for the assembly, using up to 60 characters.

This reference appears with the transaction on the Assemblies Posting Journal.

It can also appear on the G/L Transactions report and in the general ledger batch, if the G/L Reference field or the G/L Description field uses **Reference** in one of its segments, and you do not consolidate general ledger transactions.

**Status**

The transaction status can be:

- **Entered** (saved but not posted). You can edit and delete a saved transaction. The transaction has not yet updated inventory.

- **Posted**. You can no longer edit the transaction, and you cannot disassemble an assembly until it is costed.

- **Costed**. The transaction is complete.

**Transaction Type**

Choose either Assembly or Disassembly as the transaction type.

You cannot disassemble an assembly until its status is Costed.

You can edit or delete an assembly or disassembly that has been saved, but not posted (where the status is Entered).

**Year/Period**

The displayed year and period is determined by the posting date. You cannot change it except by changing the posting date.

---

**I/C Internal Usage Screen**

To open this screen:

Open **Inventory Control > I/C Transactions > Internal Usage**.
Related tasks:
- "Using Goods Internally" (page 218)
- "About Using Inventory Control with Sage Fixed Assets" (page 81)
- "Identifying an Inventory Item as a Fixed Asset for Sage Fixed Assets" (page 220)
- "Assigning Serial/Lot Numbers for Internal Usage Transactions" (page 252)
- "Posting Inventory Transactions" (page 226)

Secondary screens:
- "I/C Optional Fields Screen" (page 696)
- "I/C Serial/Lot Numbers Allocation/Generation Screen" (page 677)

Overview
Use this screen to:
- Record the withdrawal of items from inventory for your own company's use.
  For example, an office supply store could take a desk from inventory for a new employee, or use office supplies, such as paper, pencils, and pens.
- Import internal usage transactions from other Sage 300 ERP databases or from non-Sage 300 ERP programs.
- Export internal usage transactions.
- Assign serial and/or lot numbers for internal usage of serialized or lotted items if you have a license to use Serialized Inventory and Lot Tracking.

If you use Sage Fixed Assets to manage the fixed assets in your company, you can also mark goods that are taken out of inventory for internal use as fixed assets. Sage 300 ERP will transfer the asset information to Sage Fixed Assets. (For more information, see "About Using Inventory Control with Sage Fixed Assets" (page 81).)

You can display or drill down from General Ledger to posted internal usage transactions unless you delete or clear them. However, you cannot edit the posted transactions.

Fields and Controls

Buttons
**Detail**
Click **Detail** to display information for a selected detail line in a separate Details screen.

**Description**
Enter an optional description for the internal usage transaction, using up to 60 characters.

This description appears with the transaction on the Internal Usage Posting Journal.

It can also appear on the G/L Transactions report and in the general ledger batch (if Inventory Control uses **Description** for the G/L Entry Description field or the G/L Detail Reference field and you do not consolidate general ledger transactions).

**Entered By**
This field displays the name of the person who entered the transaction.

**Internal Usage Date**
Enter the transaction date for the internal usage transaction, or using the calendar button (beside the date field).

Inventory Control automatically displays the session date as the default date, but you can change it. (The session date is the date that you entered when you started Sage 300 ERP).

You can also enter a separate posting date, which determines the fiscal year and period to which a transaction is posted in the general ledger.

You can change the document date and the posting date, but you cannot directly change the fiscal period.

**Optional Fields (transaction)**
If optional fields are set up for use in this type of transaction (applying to the entry as a whole), you can enter information in these fields by clicking the **Optional Fields** Zoom button in the top section of the transaction screen.

**Note:**
- Optional fields are available only if you have Sage 300 ERP Transaction Analysis and Optional Field Creator.
Transactions Screens

- Optional field information can pass to the General Ledger—as long as the optional fields assigned to the transaction screens or transaction details are also assigned to the general ledger accounts.

**Posting Date**
Specify the date to which to post the transaction to the general ledger. The posting date determines the fiscal year and period, which you cannot change directly.

In a multicurrency system, currency revaluation also uses posting dates to select open documents for revaluation purposes and, thus, revaluation adjustments are posted to the general ledger in the correct fiscal year and period.

Depending on your settings in the I/C Options screen, Inventory Control displays the session date or the document date as the default posting date.

**Note:** If you consolidate G/L transactions, the posting date for consolidated entries is the last date of the fiscal period.

**Reference**
Enter an optional reference, using up to 60 characters.

This reference appears with the transaction on the Internal Usage Posting Journal.

It can also appear on the G/L Transactions report and in the general ledger batch, if the G/L Reference field or the G/L Description field uses Reference in one of its segments, and you do not consolidate general ledger transactions.

**Used By**
Enter the person or department that ordered the goods for internal usage.

If you use Sage 300 ERP Payroll (US or Canadian), you can select an employee from the Finder beside the Used By field.

**Year/Period**
The displayed year and period is determined by the posting date. You cannot change it except by changing the posting date.

**Table**

**Category**
Inventory Control displays the category code assigned to the item number
you selected. To change the category, enter another category code or select one from the Finder in the Category column.

**Comments**
Enter comments you want to appear on the Internal Usage Posting Journal for the detail line. Use up to 250 characters.

**Description (FAS)**
Use the Description field to enter the description that you want to use for the asset in Sage Fixed Assets.

**Extended Cost**
When shipping items that use the user-specified costing method, enter the unit cost or the extended cost. You cannot enter costs when shipping items that do not use user-specified costing.

If you enter the extended cost or change it, the program calculates the unit cost. The program recalculates the extended cost if you enter or change the unit cost.

If you use multicurrency accounting, enter costs in your functional (home) currency.

**Fixed Assets (FAS)**
This field appears if you have Sage Fixed Assets (FAS).

If you use Sage Fixed Assets to manage the fixed assets in your company, you can mark goods that are taken out of inventory for internal use as fixed assets.

- Double-click the Fixed Assets column of the entry table to display Yes, and then click the Fixed Assets column heading to display the Fixed Assets screen.

- On the zoomed screen, select the Fixed Assets check box and click the zoom button to display the Fixed Assets screen.

Fill in the fields on the Fixed Assets screen that appears.

**Fixed Asset Quantity**
Enter the quantity of asset items you are removing for internal use.
If the quantity is more than one, and you want to create separate asset records for each item in Sage Fixed Assets, select the Separate Assets option.

**Fixed Asset UOM**
Type the unit of measure for the quantity you entered.

**Fixed Asset Value**
Type the value to book for the asset in Sage Fixed Assets.

**Item Description**
Inventory Control automatically displays the description entered for the item in the Items screen. You cannot change it in the Internal Usage screen.

**Item Number**
Enter the item number of the item being shipped, or select the number from the Finder.

You can enter manufacturers' item numbers that have been added to Inventory Control.

Once you press the Tab key, the program replaces the field contents with the inventory item number, and places the manufacturer's item number that you used in the **Manuf. Item No.** field (by default the second last field in the table).

**Internal Usage Number**
Press the Tab key to start a new transaction with a program-assigned internal usage number.

The program automatically assigns the internal usage number if you leave "*** NEW ****" in the Internal Usage Number field. The program-generated number is determined by settings in the I/C Options screen.

Alternatively, you could assign internal usage numbers using a scheme such as requesting department number and date. In any case, the number must be unique, and up to 22 characters long to distinguish the new shipment from other, existing shipments.

Internal usage numbers can contain letters, numbers, and special characters (for instance, *, & #). Letters automatically appear in uppercase when you type them.
**Line Number**

Line numbers show the order in which each detail line is entered on transactions. They are assigned in sequence by Inventory Control and you cannot change them.

If you want to insert a detail line ahead of an existing line (except for line 1), select (highlight) the previous line, then press Insert. You cannot insert lines before the first detail line you enter.

To delete a line, place the insertion point in the line, then press the Delete key on your keyboard.

**Location**

Enter the code of the inventory location from which you are shipping the units, or select the code from the Finder.

Locations in Inventory Control are either physical locations or logical locations.

You can ship goods only from a physical location.

**Manufacturer's Item Number**

If you entered a manufacturer's item number in the Item Number field, the program replaces the Item Number field contents with the inventory item number, and places the manufacturer's item number that you used in the Manuf. Item No. field (by default the last field in the table).

You must have already added the manufacturer's item number using the Manufacturers' Items screen in the Items and Price Lists folder.

**Optional Fields (transaction details)**

If optional fields are set up for use in details for this type of transaction, you can enter information in the detail optional fields by selecting the detail line, and then clicking the **Optional Fields** column heading in the Detail table.

**Note:**
- Optional fields are available only if you have Sage 300 ERP Transaction Analysis and Optional Field Creator.
- If information is entered in optional fields for a transaction detail, **Yes** appears in the Optional Fields column for the detail.
Optional fields can be set up to automatically contain information. If you have optional fields that are set up this way, **Yes** appears in the Optional Fields column for new transaction details.

- Optional field information can pass to the General Ledger—as long as the optional fields assigned to the transaction screens or transaction details are also assigned to the general ledger accounts.

**Quantity**

Enter the number of units being shipped for internal usage on each detail line, expressed in the unit of measure selected for the detail line.

You can ship more units than are in stock if you turned on the Allow Negative Inventory Levels option in the Options screen.

**Separate Assets (FAS)**

If the quantity is more than one, and you want to create separate asset records for each item in Sage Fixed Assets, select the Separate Assets option.

The program allocates the Sage Fixed Assets value entered on the Fixed Assets screen proportionately to each Sage Fixed Assets record it creates. For example, for a quantity of 10 and a value of $25,000, the program creates 10 asset records with a value of $2,500 each.

**Template (FAS)**

If you want to use a different template from the one displayed on the Fixed Assets screen, use the Finder for the Template field to select a different one. Otherwise, either accept the default template field that appears or clear the entry from this field. (You do not have to use a template to create the asset in Sage Fixed Assets.)

**Unit Cost**

When shipping items that use the user-specified costing method, enter the unit cost or the extended cost. You cannot enter costs when shipping items that do not use user-specified costing.

If you enter the unit cost or change it, the program calculates the extended cost. If you enter the extended cost or change it, the program calculates the unit cost.

**Unit of Measure**

Enter the unit of measure for the quantity of items being shipped for
internal usage, or select the unit from the Finder. You can select only a unit of measure that is assigned to the item in the Items screen.

Inventory Control automatically displays the stocking unit for the items being shipped.

**Usage Account**

Enter the expense or asset account to which you are debiting this entry. For example, this transaction might debit the Office Supplies expense account.

By default, the program displays the Internal Usage account that is specified in the I/C category that you selected for this inventory item.

**Usage Account Description**

Inventory Control automatically displays the description entered for the account in the General Ledger; you cannot change it in the Internal Usage screen.

**I/C Lot Number Transaction Inquiry Screen**

**To open this screen:**

1. Open **Inventory Control > I/C Periodic Processing > Lot Recalls/Releases**.
2. Enter header information for the recall or release document, including the lot number and item number.
3. In the table, select a location.
4. Click **Transactions**.

**Overview**

Use the I/C Lot Number Transaction Inquiry screen to view a list of transactions processed for a lot, item, and location selected on the I/C Lot Recalls/Releases screen.

**I/C Post Transactions Screen**

**To open this screen:**

Open **Inventory Control > I/C Transactions > Post Transactions**.
Related tasks:
- "Posting Inventory Transactions" (page 226)
- "Performing Day End Processing" (page 273)

Overview
Use this screen to post transactions—receipts, shipments, returns, internal usage, adjustments, assemblies and disassemblies—that have been entered and saved.

Inventory Control lets you enter transactions and post them directly or save transactions after entry and post them later—either using the transaction entry screen or using the Post Transactions screen.

Once you post transactions, the program updates inventory quantities and costing (if you choose the option to update costing data during posting).

I/C Receipts Screen

to open this screen:
Open Inventory Control > I/C Transactions > Receipts.

Related tasks:
- "Assigning Serial/Lot Numbers when Receiving Goods" (page 246)
- "Entering Adjustments to Existing Receipts" (page 188)
- "Posting Inventory Transactions" (page 226)
- "Posting Saved Receipts" (page 190)
- "Receiving Goods from Vendors" (page 184)
- "Receiving Goods from a Goods-In-Transit Location" (page 214)
- "Returning Goods to Vendors" (page 191)

Secondary screens:
- "I/C Optional Fields Screen" (page 696)
- "I/C Serial/Lot Numbers Allocation/Generation Screen" (page 677)
Overview

Use the I/C Receipts screen to:

- Enter and post new receipts of items.
- Enter returns and adjustments to incomplete receipts you posted previously.
- Change the status of incomplete receipts to Complete.
- Import receipt transactions from other Sage 300 ERP databases or from non-Sage 300 ERP programs.
- If you use Serialized Inventory and Lot Tracking, assign serial numbers or lot numbers when you receive serialized or lotted items.

Fields and Controls

Additional Cost

Enter the amount of any additional cost.

Examples of additional costs are lump sums included on invoices and custom brokerage fees.

Additional Cost Currency

If you have a multicurrency system, this field displays the additional cost currency. The additional cost currency must be the same as either the receipt currency or your company's functional (home) currency.

If you use Accounts Payable with the same company database as Inventory Control and you entered the number of an existing Accounts Payable vendor in the Vendor Number field, the program automatically displays the vendor's currency code.

If the vendor number you entered does not exist in Accounts Payable, you do not use Accounts Payable, or you did not enter a vendor number, this field displays your company's functional (home) currency.

Adjusted Unit Cost

This column displays the existing unit cost for the detail line, but you can change it to adjust the receipt. (The Adjusted Unit Cost column appears to the right of the Comments column when you select Adjustment as the type of transaction.)
If you change the cost, Inventory Control automatically recalculates the amount in the **Adjusted Cost** column.

**Note:** You see adjusted unit costs only on receipt adjustments.

**Adjusted Cost**

This column displays the extended total of the cost adjustment to the detail line, but you can change the amount when adjusting the receipt. (The **Adjusted Cost** column appears to the right of the **Comments** and **Adjusted Unit Cost** columns when you select **Adjustment** as the type of transaction.)

If you change the cost, Inventory Control automatically recalculates the amount in the **Adjusted Unit Cost** column.

**Note:** You see adjusted costs only on receipt adjustments.

**Comments**

Enter comments you want to appear on the Receipts Posting Journal for the detail line. You can also enter or change comments on receipt returns and adjustments. You can enter up to 250 characters for the comment on a detail line.

**Description (optional)**

Enter an optional description for the transfer entry, using up to 60 characters.

This description appears with the transaction on the Receipts Posting Journal.

It can also appear on the G/L Transactions report and in the general ledger batch (if Inventory Control uses **Description** for the G/L Entry Description field or the G/L Detail Reference field and you do not consolidate general ledger transactions).

**Entered By**

This field displays the name of the person who entered the transaction.

**Exchange Rate (multicurrency ledgers)**

This field appears only if you use multicurrency accounting and specify a currency for the transaction that is not the functional currency. The field displays the exchange rate for the date you entered for the transaction, but you can change it.
To open the I/C Rate Selection screen, click the Zoom button, or press F9 when the insertion point is in the **Exchange Rate** field.

**Extended Cost**

Inventory Control calculates the extended cost by multiplying the unit cost by the quantity being received, but you can enter another amount, if needed.

If you enter a new extended cost, the program recalculates the unit cost for the detail line.

If you use multicurrency accounting, enter costs in the receipt currency.

You can change extended costs only on receipts. They are displayed on receipt returns and adjustments, but cannot be changed there.

**Item Description**

This field displays the description entered for the item on the I/C Items screen.

**Item Number**

Enter the item number of the item being received, or select the number from the Finder.

You can enter manufacturers' item numbers that have been added to Inventory Control.

Once you press the Tab key, the program replaces the field contents with the inventory item number, and places the manufacturer's item number that you used in the **Manuf. Item No.** field (by default the second last field in the table).

You enter item numbers only on receipts. They are displayed on receipt returns and adjustments, but cannot be changed there.

**Labels**

If you selected the **Require Labels** option, Inventory Control displays the same number as the number you entered in the **Quantity Received** column for the detail line. If you did not select the option, you see zero for each detail line.

You can edit the displayed number to specify a different number of labels. When the receipt is processed by Day End Processing, the labels you specify are generated.
You specify numbers of labels only on receipts. The numbers are displayed on receipt returns and adjustments, but cannot be changed there.

**Line Number**
Line numbers show the order in which each detail line is added to a transaction. They are assigned in sequence by Inventory Control and you cannot change them.

If you want to insert a detail line ahead of an existing line (except for line 1), select the previous line, and then press the Insert key. You cannot insert lines before the first detail line you enter.

To delete a line, place the insertion point in the line, and then press the Delete key.

**Location**
Enter the code of the inventory location at which you are receiving the units, or select the code from the Finder.

You enter location codes only on receipts. They are displayed on receipt returns and adjustments, but you cannot change them.

Locations in Inventory Control are either physical locations or logical locations.

You can receive goods only at a physical location.

**Manufacturer's Item Number**
If you entered a manufacturer's item number in the Item Number field, the program replaces it with the inventory item number, and the manufacturer's item number appears in the Manuf. Item No. field (by default the last column in the table).

You must have already added the manufacturer's item number using the I/C Manufacturers' Items screen in Items and Price Lists.

**Optional Fields (transaction)**
If optional fields are set up for use in this type of transaction (applying to the entry as a whole), you can enter information in these fields by clicking the Optional Fields Zoom button in the top section of the transaction screen.

**Note:**
- Optional fields are available only if you have Sage 300 ERP Transaction
Analysis and Optional Field Creator.

- Optional field information can pass to the General Ledger—as long as the optional fields assigned to the transaction screens or transaction details are also assigned to the general ledger accounts.

Optional Fields (transaction detail)

If optional fields are set up for use in details for this type of transaction, you can enter information in the detail optional fields by selecting the detail line, and then clicking the Optional Fields column heading in the Detail table.

Note:

- Optional fields are available only if you have Sage 300 ERP Transaction Analysis and Optional Field Creator.

- If information is entered in optional fields for a transaction detail, Yes appears in the Optional Fields column for the detail.

Optional fields can be set up to automatically contain information. If you have optional fields that are set up this way, Yes appears in the Optional Fields column for new transaction details.

- Optional field information can pass to the General Ledger—as long as the optional fields assigned to the transaction screens or transaction details are also assigned to the general ledger accounts.

PO Number

Enter your company's purchase order number, if any, for the receipt.

Posting Date

Specify the date to which to post the transaction to the general ledger. The posting date determines the fiscal year and period, which you cannot change directly.

In a multicurrency system, currency revaluation also uses posting dates to select open documents for revaluation purposes and, thus, revaluation adjustments are posted to the general ledger in the correct fiscal year and period.

Depending on your settings in the I/C Options screen, Inventory Control displays the session date or the document date as the default posting date.
**Note:** If you consolidate G/L transactions, the posting date for consolidated entries is the last date of the fiscal period.

**Prorate/Leave Additional Cost**
Specify whether the additional cost assigned to the goods being returned is prorated to the remaining goods on the receipt or left assigned to the items to which it was originally allocated.

**Note:** If you return all of the items on the receipt, you must use the I/C Adjustments screen to write off the additional cost from the receipt to a general ledger write-off account, even if you select the **Prorate** option.

**Quantity Received**
Enter the number of units being received, expressed in the unit of measure you selected for the detail line.

You enter the quantity only on receipts. Quantities are displayed on receipt returns and adjustments, but you cannot change them.

**Quantity Returned**
Enter the number of units being returned from each detail line, expressed in the unit of measure selected for the detail line. (The **Quantity Returned** column appears to the right of the **Comments** column when you select **Return** as the type of transaction.)

You can return units from as many detail lines as there are on the receipt, but you cannot return more items on any given detail line than were originally received on that line.

You enter returned quantities only on receipt returns.

**Receipt Currency**
This field appears only if you use multicurrency accounting. It displays either the functional currency code for the Inventory Control company or the currency code assigned to the vendor number you entered, if you use Sage 300 ERP Accounts Payable.

If necessary, you can specify another code.

**Receipt Date**
Enter the transaction date for the receipt.
Inventory Control automatically displays the session date as the default date, but you can change it. (The session date is the date that you entered when you started Sage 300 ERP).

You can also enter a separate posting date, which determines the fiscal year and period to which a transaction is posted in the general ledger.

You can change the document date and the posting date, but you cannot directly change the fiscal period.

**Receipt Number**
Press the Tab key to start a new receipt using the program-assigned number.

The program automatically assigns the receipt number if you leave "*** NEW ***" in the Receipt Number field. The program-generated receipt number is determined by settings on the I/C Options screen.

You can also enter a receipt number—perhaps based on the date and supplier. In any case, the receipt number must be unique, and up to 22 characters long to distinguish the receipt from other receipts.

Receipt numbers can contain letters, numbers, and special characters (for instance, *, & #). Letters automatically appear in uppercase when you type them.

**Reference**
Enter an optional reference for the transaction, using up to 60 characters.

This reference appears with the transaction on the Receipts Posting Journal.

It can also appear on the G/L Transactions report and in the general ledger batch, if the G/L Reference field or the G/L Description field uses Reference in one of its segments, and you do not consolidate general ledger transactions.

**Require Labels**
If you want to print exactly one item label for each item being received, select this option. Inventory Control updates the number in the Labels column on each item's detail line with the number you entered in the item's Quantity Received column.

If you want to print more or fewer labels, you can change the number in the Labels column.
Clear the option if you do not want to print item labels, or if you want to print more or fewer labels than the number of items being received on any detail line. When you clear the option, the **Labels** column on each item's detail line displays zero, but you can change it.

**Return Cost**
This column appears to the right of the **Comments** column when you select **Return** as the type of transaction. It displays the extended cost of the items being returned on the detail line, using the unit of measure and unit cost specified for the line on the original receipt.

**Note:** You see return costs only on receipt returns.

**Total Cost**
This field displays the total extended cost for all the detail lines and any additional cost entered for a receipt.

On receipt adjustments, the total cost includes the current total costs entered for the receipt, plus or minus any adjusted cost or additional amounts you enter.

This field does not appear when you are entering receipt returns.

- If you specify the same currency for the receipt currency and the additional cost currency, the program displays the total cost in that currency.

  **Example:** If the receipt currency and the additional cost currency are both in the source currency, the total cost appears in the source currency.

- If you specify different currencies for the receipt currency and the additional cost currency, the program displays the total cost in the functional currency.

  **Example:** If the receipt currency is the source currency, and the additional cost currency is the functional currency, the total cost appears in the functional currency.

**Total Extended Cost**
This field displays the total extended cost for all the detail lines on the receipt or adjustment. The amount does not include any additional cost entered for the receipt or adjustment.
In multicurrency ledgers, the program displays this cost in the receipt currency.

**Total Return Cost**
This field displays the total extended cost for all the detail lines for which you enter returns. It does not include any additional cost because you cannot change the additional cost amount on a receipt return.

**Type**
Select the type of edit you want to perform on the incomplete receipt, as follows:

- **Complete.** Complete the receipt. If you select Complete and post the transaction, you will not be able to add a return or an adjustment.
- **Return.** Enter a receipt return for the receipt.
- **Adjustment.** Enter an adjustment for the receipt.

**Unit Cost**
Inventory Control displays the item's most recent cost for the selected unit of measure, but you can type another amount, if needed.

If you type a new unit cost, the program recalculates the extended cost for the detail line.

If you use multicurrency accounting, enter costs in the receipt currency.

You can change unit costs only on receipts. They are displayed on receipt returns and adjustments, but you cannot change them.

**Unit of Measure**
Enter the unit of measure for the quantity of items being received, or select the unit from the Finder. You can select only a unit of measure that is assigned to the item in the Items screen.

You enter the unit of measure only on receipts. They are displayed on receipt returns and adjustments, but you cannot change them.

**Vendor Number**
Vendor numbers are optional on Inventory Control receipt transactions.

Enter the vendor number, if desired. If you use Sage 300 ERP Accounts Payable, you can select the vendor number from the Vendor Number Finder.
Year/Period

The displayed year and period is determined by the posting date. You cannot change it except by changing the posting date.

I/C Serial/Lot Numbers Allocation/Generation Screen

To open this screen:

1. Open Inventory Control > I/C Transactions.
2. Select the screen for the type of document you want to enter (for example, Receipts or Shipments).
3. Enter document information, including details for serialized or lotted items.

When you specify the quantity for a serialized or lotted item in a detail, and then tab out of the quantity field, the respective Serial/Lot Numbers Allocation or Generation screen appears. You use it to assign the required serial numbers and lot numbers to items in the detail line.

You can also open the Serial/Lot Number Allocation/Generation screen by clicking the quantity column heading (with the Zoom button).

Related tasks:

- "Assigning Serial/Lot Numbers to Adjustments" (page 248)
- "Assigning Serial/Lot Numbers to Assemblies/Disassemblies" (page 250)
- "Assigning Serial/Lot Numbers when Receiving Goods" (page 246)
- "Assigning Serial/Lot Numbers for Internal Usage Transactions" (page 252)
- "Assigning Serial/Lot Numbers to Physical Inventory Quantities" (page 254)
- "Assigning Serial/Lot Numbers for Shipments" (page 256)
- "Assigning Serial/Lot Numbers to Transfers" (page 257)

Overview

Use the I/C Serial/Lot Numbers Allocation screen or I/C Serial/Lot Numbers Generation screen to allocate or generate serial or lot numbers.

Serials Tab

On the Serials tab, you assign serial numbers to serialized items when you enter adjustments, assemblies and disassemblies, shipments, receipts, internal usage transactions, physical inventory quantities, and transfers.
Serial numbers are used to track individual items. Each serial number must be unique to one specific item.

**Example:** An electronics retailer can use serial numbers to record sales of items that have warranties.

**Lots Tab**

On the Lots tab, you assign lot numbers to lotted items when you enter adjustments, assemblies and disassemblies, shipments, receipts, internal usage transactions, physical inventory quantities, and transfers.

Lot numbers are used to track groups of items. Unlike serial numbers, a lot number can be allocated to multiple items.

**Example:** A food distribution company can use lot numbers to record purchases and sales of unique batches of product.

**Fields and Controls**

**Buttons**

**Assign Master**

The **Assign Master** button appears on the allocation screen used to assign serial and/or lot numbers for component and/or master items in an assembly. This button appears only if:

- The master item and at least one component are serialized and/or lotted items.
- Component numbers are already allocated.

Click this button to change the allocations that are assigned to the master item in the assembly.

**Auto Alloc.**

Click this button to allocate required serial numbers or lot numbers automatically to items.

If you specify a number in the **Auto-Allocate From** field before you click the button, Inventory Control assigns numbers starting with the number you specify.

Allocated numbers appear in the list of serial number or lot numbers.
Auto Gen
Click the Auto Gen button to generate all the serial numbers or lot numbers you require.

The program generates and assigns serial numbers and lot numbers, starting with the next serial number or lot number you specified.

If you did not specify the next number to use, the program automatically assigns the next available numbers.

Clear All
Click this button to remove all allocated numbers from the list.

Close
Click Close to close the screen.

Return All
The Return All button appears when you are processing a return of serialized or lotted items. Click it to return all the allocated numbers in the list.

Auto Allocate From
Specify the starting lot number from which to automatically allocate lot numbers:

1. Select the Auto-Allocate From option.
2. In the Auto Allocate From field, specify a starting lot number.
3. Click the Auto Alloc button to allocate the required number of lot numbers, starting from the specified number.

Make_ Lots OR Each Lot Has _
When you auto-generate lots, you must enter a number in one of these fields to define how the lots are generated:

- Make __ Lots. If you want to create a fixed number of lots, with the quantity evenly distributed across all of the lots, enter the number of lots.

  Example: If you create 10 lots and have 400 items, each lot will have 40 items.

- Each Lot Has __. If you want to distribute a fixed quantity to each lot, enter the number to include in each lot.
Example: If you want to have 50 items in each lot, the process will generate the number of lots needed to accommodate the quantity of items.

**Next Lot Number**
This field displays the next sequential lot number available for the item. You can:

- Click **Add** to add the displayed number to the **Lot Numbers** list. Repeat this for as many numbers as you need.
- Click **Auto-Gen** to add the required number of lot numbers to the **Lot Numbers** list, starting from the displayed number.

After you add numbers, this field displays the next lot number that is now available.

**Next Serial Number**
This field displays the next sequential serial number available for the item. You can:

- Click **Add** to add the displayed number to the **Serial Numbers** list. Repeat this for as many numbers as you need.
- Click **Auto-Gen** to add the required number of numbers to the **Serial Numbers** list, starting from the displayed number.

After you add numbers, this field displays the next number that is now available.

**I/C Shipments Screen**

**To open this screen:**
Open **Inventory Control > I/C Transactions > Shipments.**

**Related tasks:**
- "Shipping Goods to Customers" (page 196)
- "Receiving Returned Goods from Customers" (page 199)
- "Assigning Serial/Lot Numbers for Shipments" (page 256)
- "Posting Inventory Transactions" (page 226)
Secondary screens:
- "I/C Optional Fields Screen" (page 696)
- "I/C Serial/Lot Numbers Allocation/Generation Screen" (page 677)

Overview

Use the I/C Shipments screen to:
- Record shipments of items out of inventory.
- Record returns of items to inventory (sales returns).
- Import shipment and sales return transactions from other Sage 300 ERP databases or from non-Sage 300 ERP programs.
- Export shipment and sales return transactions.
- Assign serial/lot numbers for shipments of serialized/lotted items if you have the Serialized Inventory and Lot Tracking license installed. For more information, see "Assigning Serial/Lot Numbers for Shipments" (page 256).

If you use Sage 300 ERP Order Entry, you can process shipments and sales returns in either Inventory Control or Order Entry.

Fields and Controls

Category
This field displays the category code assigned to the item number you selected. To change the category, enter another category code or select one from the Category Finder.

Comments
Enter comments you want to appear on the Shipments Posting Journal for the detail line. Use up to 250 characters.

Contact
Enter the name or position of the customer's contact person.

If you use Sage 300 ERP Accounts Receivable with Inventory Control, the contact name from the customer record is displayed automatically, but you can change it.
Appendix A: Inventory Control Screen Guides

**Contract / Project / Category / WIP Account**
These fields appear if you use Sage 300 ERP Project and Job Costing.

If you use Project and Job Costing to assign goods to jobs, the shipment transactions created by Project and Job Costing will appear in Inventory Control.

**Note:** You cannot use these fields in Inventory Control.

**Currency**
If you have a multicurrency system, enter the code for the currency in which you will enter shipment or sales return transactions, or select it from the Currency Finder.

You cannot change the currency code after you have entered the first detail line.

**Note:**
- This field displays the customer’s currency as the default if you select a customer record from Accounts Receivable.
- The program does not display item prices unless the specified price list includes prices in the currency specified in the Currency field.

**Customer Number**
If applicable, enter a customer number.

If you use Sage 300 ERP Accounts Receivable with Inventory Control, you can also select a customer number from the Customer Number Finder.

**Description**
Enter an optional description for the shipment entry, using up to 60 characters.

This description appears with the transaction on the Shipments Posting Journal.

It can also appear on the G/L Transactions report and in the general ledger batch (if Inventory Control uses Description for the G/L Entry Description field or the G/L Detail Reference field and you do not consolidate general ledger transactions).

**Entered By**
This field displays the name of the person who entered the transaction.
**Entry Type**
Select **Shipment** to enter a new shipment, or select **Return** to enter a sales return.

**Exchange Rate (multicurrency ledgers)**
This field appears only if you use multicurrency accounting and specify a currency for the transaction that is not the functional currency. The field displays the exchange rate for the date you entered for the transaction, but you can change it.

To open the I/C Rate Selection screen, click the Zoom button, or press F9 when the insertion point is in the **Exchange Rate** field.

**Extended Cost**
When shipping items that use the user-specified costing method, enter the unit cost or the extended cost. (You cannot enter costs when shipping items that do not use user-specified costing.)

For all sales returns, this field automatically displays the item's most recent cost, but you can change it.

If you enter the extended cost or change it, the program calculates the unit cost. The program recalculates the extended cost if you enter or change the unit cost.

If you use multicurrency accounting, enter costs in your functional (home) currency.

**Extended Price**
Inventory Control calculates the extended price by multiplying the unit price by the quantity being shipped or returned, but you can enter another amount, if needed.

If you enter a new extended price, the program recalculates the unit price for the detail line.

If you use multicurrency accounting, enter prices in the currency you selected for the transaction.

**Item Description**
This field displays the description entered for the item on the I/C Items screen.

**Item Number**
Enter the item number, or select the number from the Finder.
You can enter manufacturers' item numbers that have been added to Inventory Control.

Once you press the Tab key, the program replaces the field contents with the inventory item number, and places the manufacturer's item number that you used in the Manuf. Item No. field (by default the second last field in the table).

**Line Number**

Line numbers show the order in which each detail line is added to a transaction. They are assigned in sequence by Inventory Control and you cannot change them.

If you want to insert a detail line ahead of an existing line (except for line 1), select the previous line, and then press the Insert key. You cannot insert lines before the first detail line you enter.

To delete a line, place the insertion point in the line, and then press the Delete key.

**Location**

Enter the code of the inventory location from which you are shipping (or to which you are returning) the units, or select the code from the Finder.

Locations in Inventory Control are either physical locations or logical locations.

You can ship goods only from a physical location.

**Manufacturer's Item Number**

If you entered a manufacturer's item number in the Item Number field, the program replaces it with the inventory item number, and the manufacturer's item number appears in the Manuf. Item No. field (by default the last column in the table).

You must have already added the manufacturer's item number using the I/C Manufacturers' Items screen in Items and Price Lists.

**Optional Fields (transaction)**

If optional fields are set up for use in this type of transaction (applying to the entry as a whole), you can enter information in these fields by clicking the Optional Fields Zoom button in the top section of the transaction screen.
Note:
- Optional fields are available only if you have Sage 300 ERP Transaction Analysis and Optional Field Creator.
- Optional field information can pass to the General Ledger—as long as the optional fields assigned to the transaction screens or transaction details are also assigned to the general ledger accounts.

Optional Fields (transaction detail)
If optional fields are set up for use in details for this type of transaction, you can enter information in the detail optional fields by selecting the detail line, and then clicking the Optional Fields column heading in the Detail table.

Note:
- Optional fields are available only if you have Sage 300 ERP Transaction Analysis and Optional Field Creator.
- If information is entered in optional fields for a transaction detail, Yes appears in the Optional Fields column for the detail.

Optional fields can be set up to automatically contain information. If you have optional fields that are set up this way, Yes appears in the Optional Fields column for new transaction details.

- Optional field information can pass to the General Ledger—as long as the optional fields assigned to the transaction screens or transaction details are also assigned to the general ledger accounts.

Posting Date
Specify the date to which to post the transaction to the general ledger. The posting date determines the fiscal year and period, which you cannot change directly.

In a multicurrency system, currency revaluation also uses posting dates to select open documents for revaluation purposes and, thus, revaluation adjustments are posted to the general ledger in the correct fiscal year and period.

Depending on your settings in the I/C Options screen, Inventory Control displays the session date or the document date as the default posting date.

Note: If you consolidate G/L transactions, the posting date for consolidated entries is the last date of the fiscal period.
Price List (detail line)
If necessary, enter a price list code for the detail line, or select one from the Finder.

Inventory Control automatically displays the price list code, if any, you selected in the shipment header.

In multicurrency ledgers, if the price list you specify uses the currency you selected for the transaction, Inventory Control automatically displays the unit price for the item.

Price List (header—optional)
If you wish, enter the price list code to use as the default code for detail lines, or select the code from the Price List Finder.

If you use multicurrency accounting, you should select a price list that uses the currency you specify. If the price list you select does not contain prices in the currency you specify, you see a warning message as you begin entering each detail line. (Inventory Control will not display default prices on detail lines in this case.)

If you specify price lists in the Sage 300 ERP Accounts Receivable records, the price list for the customer will appear in the Price List field when you select the customer.

If you want item prices on detail lines to automatically come from one price list, you specify the desired price list in this field before you start to enter transaction details. The price list you specify overrides the default price lists from item records. Prices appear when you enter item numbers.

Quantity
Enter the number of units being shipped or returned on each detail line, expressed in the unit of measure selected for the detail line.

You can ship more units than are in stock if you selected the Allow Negative Inventory Levels option on the I/C Options screen.

Reference
Enter an optional reference, using up to 60 characters.

This reference appears with the transaction on the Shipments Posting Journal.

It can also appear on the G/L Transactions report and in the general ledger batch, if the G/L Reference field or the G/L Description field uses
Reference in one of its segments, and you do not consolidate general ledger transactions.

Ship Date
Enter the date for the shipment or sales return.

Inventory Control automatically displays the session date as the default date, but you can change it. (The session date is the date that you entered when you started Sage 300 ERP).

You can also enter a separate posting date, which determines the fiscal year and period to which a transaction is posted in the general ledger.

You can change the document date and the posting date, but you cannot directly change the fiscal period.

Shipment Number
Press the Tab key to start a new shipment with a program-assigned shipment number.

The program automatically assigns the shipment number if you leave "*** NEW ***" in the Shipment Number field. The program-generated shipment number is determined by settings on the I/C Options screen.

You can also enter a shipment number-perhaps based on the date and order number. In any case, the shipment number must be unique, and up to 22 characters long to distinguish the new shipment from other, existing shipments.

Shipment numbers can contain letters, numbers, and special characters (for instance, *, & #). Letters automatically appear in uppercase when you type them.

Unit Cost
When shipping items that use the user-specified costing method, enter the unit cost or the extended cost. You cannot enter costs when shipping items that do not use user-specified costing.

For all sales returns, the program automatically displays the item’s most recent cost, which you can type over if you want to change it.

If you enter the unit cost or change it, the program calculates the extended cost. If you enter the extended cost or change it, the program calculates the unit cost.
If you use multicurrency accounting, enter costs in your functional (home) currency.

**Unit of Measure**
Enter the unit of measure for the quantity of items being shipped or returned, or select the unit from the Finder. You can select only a unit of measure that is assigned to the item on the I/C Items screen.

Inventory Control automatically displays the stocking unit for the items being shipped or returned.

**Unit Price**
If necessary, change the displayed price.

The program automatically displays prices when you enter the item number, unless the item is not on the price list selected for the detail line.

If you enter or change a unit price, the program calculates the extended price. If you enter or change an extended price, the program calculates the unit price.

If you use multicurrency accounting, enter prices in the currency selected for the shipment (by default the customer’s currency). The program will not display item prices unless the price list you specify lists prices in the currency specified in the **Currency** field.

**Year/Period**
The displayed year and period is determined by the posting date. You cannot change it except by changing the posting date.

**I/C Transfers Screen**

**To open this screen:**
Open *Inventory Control > I/C Transactions > Transfers*.

**Related tasks:**
- "Assigning Serial/Lot Numbers to Transfers" (page 257)
- "Posting Inventory Transactions" (page 226)
- "Receiving Goods from a Goods-In-Transit Location" (page 214)
- "Transferring Goods between Two Inventory Locations" (page 206)
- "Transferring Goods Using a Goods-In-Transit Location" (page 210)
Secondary screens:
- "I/C Optional Fields Screen" (page 696)
- "I/C Serial/Lot Numbers Allocation/Generation Screen" (page 677)

Overview

Use I/C Transfers screen to:

- Enter and post stock transfers between physical inventory locations if you store items at more than one location.
- Import transfer transactions from other Sage 300 ERP databases or from non-Sage 300 ERP programs.
- Export transfer transactions.
- "Assigning Serial/Lot Numbers to Transfers" (page 257) , if you use Serialized Inventory and Lot Tracking.

Note: If you have a multicurrency system, you enter costs in functional currency.

Fields and Controls

Additional Cost
Enter any additional cost associated with the transfer, such as the cost of shipping. You can then prorate this amount over the items in the shipment by selecting a proration method from the Proration Method list.

Comments
Enter comments you want to appear on the Transfers Posting Journal for the detail line. Use up to 250 characters.

Completed
Select this option to complete the transaction.

Generally, you will complete a line for a GIT transfer on receipt of all goods. If you complete it before all goods are received, the unreceived items will remain in the GIT location, and you will have to create a new transfer to move them to the destination location.
Description
Enter a description for the transfer, using up to 60 characters.

This description appears with the transaction on the Transfers Posting Journal.

It can also appear on the G/L Transactions report and in the general ledger batch (if Inventory Control uses Description for the G/L Entry Description field or the G/L Detail Reference field and you do not consolidate general ledger transactions).

Document Number
Press the Tab key to start a new transfer with a program-assigned transfer number.

The program automatically assigns the transfer number if you leave "***NEW***" in the Transfer Number field. The program-generated transfer number is determined by settings on the I/C Options screen.

You can also enter a transfer number—for example, you might base this number on the date and waybill number. In any case, the transfer number must be unique, and up to 22 characters long to distinguish the new transfer from other, existing transfers.

Transfer numbers can contain letters, numbers, and special characters (for instance, *, & #). Letters automatically appear in uppercase when you type them.

Entered By
This field displays the name of the person who entered the transaction.

Extended Cost
When transferring items that use the user-specified costing method, enter the unit cost or the extended cost. You cannot enter costs when transferring items that do not use user-specified costing.

If you enter the extended cost or change it, the program calculates the unit cost. The program recalculates the extended cost if you enter or change the unit cost.

If you use multicurrency accounting, enter costs in your functional (home) currency.

Extended Weight
This field displays the weight from the item record. However, you can
modify this information if necessary.

If you enter a unit weight, the program calculates the extended weight; if you enter an extended weight, it calculates the unit weight.

Make sure that this information is correct when transferring items that use cost proration by weight.

**From Location**

Enter the code of the inventory location from which you are transferring stock, or select the code from the Finder.

**GIT Location**

If you are entering a transit transfer, enter the code for the goods-in-transit inventory location.

If you are entering a transit receipt (receiving goods from a goods-in-transit location), you cannot change this field.

**Item Description**

This field displays the description entered for the item on the I/C Items screen.

**Item Number**

Enter the item number of the item being transferred, or select the number from the Finder.

You can enter manufacturers' item numbers that have been added to Inventory Control.

Once you press the Tab key, the program replaces the field contents with the inventory item number, and places the manufacturer's item number that you used in the **Manuf. Item No.** field (by default the second last field in the table).

**Line Number**

Line numbers show the order in which you added each detail line to the transfer. They are assigned in sequence by Inventory Control and you cannot change them.

If you want to insert a detail line ahead of an existing line (except for line 1), select the previous line, and then press the Insert key. You cannot insert lines before the first detail line you enter.
To delete a line, place the insertion point in the line, and then press the Delete key on your keyboard.

**Location Descriptions**

Inventory Control displays the description assigned to each location code you select. Use the descriptions to verify that you specified the correct locations.

**Manual Proration**

Enter an amount for the item’s portion of the additional cost as entered in the **Additional Cost** field. You can do this only if you selected "manually" as the proration method.

**Manufacturer’s Item Number**

If you entered a manufacturer's item number in the **Item Number** field, the program replaces it with the inventory item number, and the manufacturer's item number that you used appears in the **Manuf. Item No.** field (by default the last column in the table).

You must have already added the manufacturer's item number using the I/C Manufacturers' Items screen in Items and Price Lists.

**Optional Fields (transaction)**

If optional fields are set up for use in this type of transaction (applying to the entry as a whole), you can enter information in these fields by clicking the **Optional Fields** Zoom button in the top section of the transaction screen.

**Note:**
- Optional fields are available only if you have Sage 300 ERP Transaction Analysis and Optional Field Creator.
- Optional field information can pass to the General Ledger—as long as the optional fields assigned to the transaction screens or transaction details are also assigned to the general ledger accounts.

**Optional Fields (transaction detail)**

If optional fields are set up for use in details for this type of transaction, you can enter information in the detail optional fields by selecting the detail line, and then clicking the **Optional Fields** column heading in the Detail table.
Note:
- Optional fields are available only if you have Sage 300 ERP Transaction Analysis and Optional Field Creator.
- If information is entered in optional fields for a transaction detail, Yes appears in the Optional Fields column for the detail.
  Optional fields can be set up to automatically contain information. If you have optional fields that are set up this way, Yes appears in the Optional Fields column for new transaction details.
- Optional field information can pass to the General Ledger—as long as the optional fields assigned to the transaction screens or transaction details are also assigned to the general ledger accounts.

Outstanding Quantity
This is the amount still required to meet the requested quantity.

Posting Date
Specify the date to which to post the transaction to the general ledger. The posting date determines the fiscal year and period, which you cannot change directly.

In a multicurrency system, currency revaluation also uses posting dates to select open documents for revaluation purposes and, thus, revaluation adjustments are posted to the general ledger in the correct fiscal year and period.

Depending on your settings in the I/C Options screen, Inventory Control displays the session date or the document date as the default posting date.

Note: If you consolidate G/L transactions, the posting date for consolidated entries is the last date of the fiscal period.

Proration Method
You can prorate the additional cost for the transfer (if you entered one in the Additional Cost field) over the items in the transfer using one of the following methods: by quantity, by weight, by cost, equally, or manually.

Selecting Manually allows you to enter each item’s share of the additional cost in the Manual Proration field. All other options cause the program to automatically calculate amounts, and the Manual Proration field cannot be used.
Receipt Unit
Inventory Control automatically displays the stocking unit for the items being transferred.

You can post receipts in any unit of measure defined for the item, unless the item units have serial numbers, in which case you must select the item’s stocking unit.

Received to Date
This is the number of units received from the GIT location for this transfer.

Reference (optional)
Enter reference information for the transfer, using up to 60 characters.

This reference appears with the transaction on the Transfers Posting Journal.

It can also appear on the G/L Transactions report and in the general ledger batch, if the G/L Reference field or the G/L Description field uses Reference in one of its segments, and you do not consolidate general ledger transactions.

Requested Quantity
This field appears only if you are using a goods-in-transit location, and is useful when you are adding to a transfer over some period of time (for example, loading several trucks over a period of days).

The transfer quantity cannot exceed the amount requested.

When you enter an amount in this field, the same amount appears by default in the Transfer Quantity field.

To Location
Enter the code of the inventory location to which you are transferring stock, or select the code from the Finder.

If you did not select the Allow Items At All Locations option on the I/C Options screen, you must have specified that the item is allowed at the inventory location to which you are transferring stock.

Transfer Date
Enter the date for the transfer.
Inventory Control automatically displays the session date as the default date, but you can change it. (The session date is the date that you entered when you started Sage 300 ERP).

You can also enter a separate posting date, which determines the fiscal year and period to which a transaction is posted in the general ledger.

You can change the document date and the posting date, but you cannot directly change the fiscal period.

**Transfer Number**

If you are receiving goods at a destination location or if you are adding to the goods being moved into transit, enter the transfer number from the previously entered transit transfer.

**Transfer Quantity**

Enter the number of units to transfer between locations.

You can transfer more units than are in stock if you selected the **Allow Negative Inventory Levels** option on the I/C Options screen.

If you had entered an amount in the **Requested Quantity** field, that amount appears by default in the **Transfer Quantity** field. This amount can be changed.

To assign a lot tracking number or a serialized inventory number to the transfer, click the Zoom button at the top of the **Transfer Quantity** field. This opens a Lot Tracking or Serialized Inventory Allocation screen where you assign the tracking number.

**Transfer Unit**

If you want to change the unit of measure, type over it or select one from the Finder. Inventory Control automatically displays the stocking unit for the items being transferred.

**Note:** You can post transfers in any unit of measure defined for the item, unless the item units have serial numbers; in which case, you must select the item’s stocking unit (which has a conversion factor of one) for the Transfer UOM.

**Transferred to Date**

This is the number of units previously entered for this transfer to the GIT location.
Unit Cost
When transferring items that use the user-specified costing method, enter the unit cost or the extended cost. You cannot enter costs when transferring items that do not use user-specified costing.

If you enter the unit cost or change it, the program calculates the extended cost. If you enter the extended cost or change it, the program calculates the unit cost.

If you use multicurrency accounting, enter costs in your functional (home) currency.

Unit Weight
This field displays the weight from the item record. However, you can modify this information if necessary.

If you enter a unit weight, the program calculates the extended weight; if you enter an extended weight, it calculates the unit weight.

Make sure that this information is correct when transferring items that use cost proration by weight.

Weight Conversion Factor
This field displays the factor for converting this weight unit to the default weight unit of measure.

For example, if "pound" is the default weight unit of measure (with a conversion factor of 1), the conversion factor for "ton" would be 2,000. Similarly, the factor to convert kilograms to pounds would be 2.2.

Weight Unit of Measure
This field displays the default weight unit of measure from the item record. You cannot change it.

Year/Period
The displayed year and period is determined by the posting date. You cannot change it except by changing the posting date.

I/C Optional Fields Screen

To open this screen:
1. Open Inventory Control > I/C Transactions.
2. Open Receipts, Shipments, Internal Usage, Adjustments, Transfers, or Assemblies.

3. Enter a transaction.

4. Do one of the following:

   - To enter optional fields that apply to the transaction as a whole:
     In the top section of the screen, click the Optional Fields Zoom button.
   - To enter optional fields that apply to an individual transaction detail:
     In the Details table, select a transaction detail, and then click the Optional Fields column heading.

Related tasks:
- "Using Optional Fields in Transactions " (page 225)

Overview

Use the I/C Optional Fields screen to enter information in optional fields.

Optional fields may apply to a transaction as a whole, or to an individual transaction detail. There is a separate version of this screen for each of these types of optional fields:

- **Optional fields for transactions.** If optional fields are set up for use in this type of transaction (applying to the entry as a whole), you can enter information in these fields by clicking the Optional Fields Zoom button in the top section of the transaction screen.

- **Optional fields for transaction details.** If optional fields are set up for use in details for this type of transaction, you can enter information in the detail optional fields by selecting the detail line, and then clicking the Optional Fields column heading in the Detail table.

**Note:**
- Optional fields are available only if you have Sage 300 ERP Transaction Analysis and Optional Field Creator.
- If information is entered in optional fields for a transaction detail, Yes appears in the Optional Fields column for the detail.
Optional fields can be set up to automatically contain information. If you have optional fields that are set up this way, **Yes** appears in the Optional Fields column for new transaction details.

- Optional field information can pass to the General Ledger—as long as the optional fields assigned to the transaction screens or transaction details are also assigned to the general ledger accounts.
Appendix B: Inventory Control Security Authorizations

If security is turned on for your Sage 300 ERP system, the system administrator must assign users security authorization for Inventory Control screens.

For information on turning on security, setting up security groups, and assigning authorizations, refer to the System Manager help.

**Note:** To change the print destination for forms and reports, you must have Change Print Destination security authorization for Administrative Services.

To view records and to print reports in Inventory Control, you must belong to a security group with Common Inquiry authorization. Common Inquiry permission by itself does not let you edit any Inventory Control records. To edit records or perform processing tasks, the system administrator must grant the group access to additional tasks from the following list:

### Inventory Control Security Authorizations

<table>
<thead>
<tr>
<th>Security Authorization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sage 300 ERP Inquiry</td>
<td>Query Inventory Control data in the portal. If you also have Export Processing authorization for Inventory Control, print or export the results of these queries.</td>
</tr>
<tr>
<td>Common Inquiry</td>
<td>View setup screens. Print setup reports. You must also have Cost Inquiry permission to view the Location Details, Bills of Material and Kitting Items screens, and to print and preview the Bills of Material, Kitting Items, Item Status and Location Details reports.</td>
</tr>
<tr>
<td>Price/Sales Analysis Inquiry</td>
<td>Preview and print Price Lists and Contract Pricing reports.</td>
</tr>
<tr>
<td>Stock Control Inquiry</td>
<td>Preview and print Overstocked Items (Quantity Greater than Maximum Level, Quantity Greater Than Projected Sales), Reorder Report, Slow Moving Items, Inventory Movement, Aged Inventory, Bin/Shelf Labels and Item Labels reports.</td>
</tr>
<tr>
<td>Transaction Inquiry</td>
<td>View Receipts, Shipments, Adjustments, Transfers, Assemblies, Internal Usage, Transaction History Inquiry, Sales Statistics and</td>
</tr>
</tbody>
</table>
## Appendix B: Inventory Control Security Authorizations

<table>
<thead>
<tr>
<th>Security Authorization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost Inquiry</td>
<td>Combined with Common Inquiry permission, view the same screens as with Common Inquiry and view costing information in Location Details, Bills of Material, Kitting Items, and view LIFO/FIFO costing information on Item Status report. If you use Serialized Inventory and Lot Tracking, preview and print the Lot Number Inquiry and Serial Number Inquiry reports.</td>
</tr>
<tr>
<td>Stock Control Inquiry (gives Cost Inquiry rights)</td>
<td>View the same screen as with Cost Inquiry, and view LIFO/FIFO Inquiry. Also, view, preview and print the Item Valuation, Overstocked Items (all available print options), Reorder Report, Slow Moving Items, Inventory Movement, Aged Inventory, Bin/Shelf Labels, Item Labels and Location Details (includes cost information) reports.</td>
</tr>
<tr>
<td>Price/Sales Analysis Inquiry (gives Cost Inquiry rights)</td>
<td>View the same screens as with Cost Inquiry. As well, preview and print the Price Lists, Contract Pricing, Selling Price/Margin Analysis, Markup Analysis, Location Details (includes cost information), Bills of Material / Kitting Items / BOM Component Usage Inquiry (includes costing information), Item Status (includes LIFO/FIFO costing information) reports.</td>
</tr>
<tr>
<td>Setup Maintenance</td>
<td>View the Items, Vendor Details, Customer Details, Location Details, Reorder Quantities and Manufacturers’ Items icons. Add, update, and delete Options, G/L Integration, Item Structures, Segment Codes, Locations, Categories, Account Sets, Units of Measure, Weight UOMs, Bills of Material, Copy BOMs, Update BOMs, Kitting Items and Price List Codes. Preview and print the Alternate Items, Vendor Details, Customer Details, Options, G/L Integration, Item Mappings, Item Structures, Segment Codes, Locations, Categories, Account Sets, Units of Measure, Weight UOMs, Bills of Material, Kitting Items, Price List Codes, Reorder Quantities, Item Status, Location Details, Manufacturers’ Items, BOM Component Usage Inquiry and Item Status reports. Costing information will not appear on the Bills of Material, Kitting Items, Item Status, and Location Details reports unless Cost</td>
</tr>
<tr>
<td>Security Authorization</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Authorization</td>
<td>Inquiry authorization is also granted.</td>
</tr>
<tr>
<td>Transaction Optional Fields</td>
<td>Add, update, and delete optional fields in adjustments, assemblies, receipts, shipments, transfers, and other Inventory Control functions that create transactions automatically.</td>
</tr>
<tr>
<td>Item Maintenance</td>
<td>Add, update, and delete Items, Items Wizard, Vendor Details, Customer Details, Location Details, Reorder Quantities and Manufacturers’ Items. Preview and print the Alternate Items, Vendor Details, Customer Details, Location Details, Reorder Quantities, Item Status, and Manufacturers’ Items reports. Costing information will not appear on the Location Details and Item Status reports unless Cost Inquiry authorization is also granted.</td>
</tr>
<tr>
<td>Physical Inventory Maintenance</td>
<td>Preview and print the Inventory Worksheet and Inventory Reconciliation reports. Generate inventory worksheets. Update and delete Physical Inventory Quantities. Post, update, and delete Inventory Reconciliation and Inventory Counts.</td>
</tr>
<tr>
<td>Adjustment Posting</td>
<td>Post adjustments. Also view, add, update and delete Location Details. Preview and print the Location Details, Transactions Listing (adjustments only) reports.</td>
</tr>
<tr>
<td>Assembly Posting</td>
<td>Post assemblies. View, add, update and delete Location Details. Preview and print the Location Details report and the Transaction Listing report (for assemblies only).</td>
</tr>
<tr>
<td>Internal Usage Posting</td>
<td>Post internal usage transactions. View, add, update and delete Location Details. Preview and print the Location Details report and the Transaction Listing report (for internal usage only).</td>
</tr>
</tbody>
</table>
### Appendix B: Inventory Control Security Authorizations

<table>
<thead>
<tr>
<th>Security Authorization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receipt Posting</td>
<td>Post and update receipts. View, add, update and delete Location Details. Preview and print the Location Details report and the Transaction Listing report (for receipts only).</td>
</tr>
<tr>
<td>Shipment Posting</td>
<td>Post shipments. View, add, update and delete Location Details. Preview and print the Location Details report and the Transaction Listing report (for shipments only).</td>
</tr>
<tr>
<td>Transfer Posting</td>
<td>Post transfers. View, add, update and delete Location Details. Preview and print the Location Details report and the Transaction Listing report (for transfers only).</td>
</tr>
<tr>
<td>Clear History/Inactive Records</td>
<td>Delete Inactive Records (account sets, categories, items, locations, and BOMs) and Clear History (transaction history, transaction statistics, sales statistics, printed posting journals, serial numbers, printed labels, receipts, expired contract prices, transactions).</td>
</tr>
<tr>
<td>Import I/C Data (combine with other security rights)</td>
<td>Import the following records: Receipts, Shipments, Adjustments, Transfers, Assemblies, Items, Vendor Details, Customer Details, Item Pricing, Contract Pricing, Location Details, Reorder Quantities, Sales Statistics, Transaction Statistics, Item Structures, Segment Codes, Locations, Categories, Account Sets, Bills of Material, Price List Codes, Physical Inventory Quantities, Manufacturer's Items, Kitting Items, Units of Measure and Weight Units of Measure.</td>
</tr>
<tr>
<td>Export I/C Data (combine with other security rights)</td>
<td>Allows users to export the following records: Receipts, Shipments, Adjustments, Transfers, Assemblies, Items, Vendor Details, Customer Details, Item Pricing, Contract Pricing, Location Details, Reorder Quantities, Sales Statistics, Transaction Statistics, Item Structures, Segment Codes, Locations, Categories, Account Sets,</td>
</tr>
</tbody>
</table>
### Security Authorization

<table>
<thead>
<tr>
<th>Security Authorization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bills of Material, Price List Codes, Physical Inventory Quantities, Manufacturer’s Items, Kitting Items, Units of Measure and Weight Units of Measure.</td>
<td></td>
</tr>
<tr>
<td>Dashboard</td>
<td>Allows users to view Sage 300 ERP Dashboards that pertain to Inventory Control.</td>
</tr>
<tr>
<td>Item Developer Inquiry</td>
<td>Developers of third-party programs, including macros, must incorporate this permission in their security structures.</td>
</tr>
</tbody>
</table>

The following authorizations are also available if you use Serialized Inventory and Lot Tracking:

#### Security Authorizations for Serialized Inventory and Lot Tracking

<table>
<thead>
<tr>
<th>Security Authorization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lot Recalls</td>
<td>Recall lots using Lot Recall and print the Lot Recall report.</td>
</tr>
<tr>
<td>Lot Splits/Combines</td>
<td>Split and combine lots using Lot Splits/Combines.</td>
</tr>
<tr>
<td>Serial/Lot Reconciliation</td>
<td>Reconcile serial numbers and lots using Serial/Lot Reconciliation.</td>
</tr>
<tr>
<td>Quarantine Release</td>
<td>Release lots from quarantine using Quarantine Release.</td>
</tr>
<tr>
<td>Serial Registration</td>
<td>Register serial numbers using Serial Registration.</td>
</tr>
<tr>
<td>Warranty Update</td>
<td>Update warranties using Warranty Update.</td>
</tr>
</tbody>
</table>
Appendix C: Data Entry Tools, Tips, and Shortcuts

Use these tools and tips to speed up data entry in Sage 300 ERP.

Inventory Control Menu Commands

The following commands appear on the File, Settings (when available), and Help menus on Sage 300 ERP screens.

Note: Menu names and commands may differ by screen.

File Menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close</td>
<td>Closes the current screen.</td>
<td>You can also press Alt+F4 to close a screen.</td>
</tr>
<tr>
<td>Customize</td>
<td>Lets you hide or display fields for users by UI Profile ID.</td>
<td>Click File &gt; Customize to hide fields on an open screen for users assigned to a UI Profile ID for that screen. When these fields are hidden, data that would normally appear in these fields cannot be printed. For more information, see the help for the UI Profile Maintenance screen in the System Manager help.</td>
</tr>
<tr>
<td>Export</td>
<td>Exports data records to other Sage 300 ERP databases and non-Sage 300 ERP programs.</td>
<td>Click File &gt; Export to export data. For example, you could export purchase statistics for use in spreadsheet or database software. Note: You cannot export serial or lot numbers for kit components.</td>
</tr>
<tr>
<td>Import</td>
<td>Imports data records from other databases and from non-Sage 300</td>
<td>Click File &gt; Import to import data. For example, you could use a spreadsheet to</td>
</tr>
</tbody>
</table>
### Command Table

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERP programs.</td>
<td>enter current requisitions or purchase orders when setting up your system, and then import the transactions later.</td>
<td><strong>Note:</strong> You cannot import serial or lot numbers for kit components.</td>
</tr>
<tr>
<td>Print</td>
<td>Prints the current report, list, or screen.</td>
<td>On screens with a corresponding report, click <strong>File &gt; Print</strong> to open the report screen, which you use to select report options (if applicable) before printing the report.</td>
</tr>
<tr>
<td>Print Setup</td>
<td>Selects a printer and sets printing options.</td>
<td>Click <strong>File &gt; Print Setup</strong> to set up your printer. You can select the default printer or select another from the list of installed printers. For more information about print options, refer to your operating system documentation.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the entries or changes you have made to the current screen.</td>
<td>If you have just entered a new record, <strong>Add</strong> appears instead of <strong>Save</strong>.</td>
</tr>
</tbody>
</table>

### Settings Menu

#### Settings Menu Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Clear</td>
<td>Creates a new entry automatically when you post a transaction.</td>
<td>Use the <strong>Auto Clear</strong> option to streamline data entry in transaction entry screens.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If Auto Clear is turned on, all fields are cleared each time you post a transaction, allowing you to immediately begin entering another transaction.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If Auto Clear is turned off, transaction information remains on the screen after you post it. Click the <strong>New</strong> button to begin entering another transaction.</td>
</tr>
<tr>
<td>Clear Saved Settings</td>
<td>Restores default settings for a report.</td>
<td>This command is available for screens and for some reports.</td>
</tr>
<tr>
<td>Save Settings</td>
<td>Saves the current</td>
<td>This command is available for screens and</td>
</tr>
</tbody>
</table>
Data Entry Tools and Shortcuts

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>as Defaults</td>
<td>report settings as personal defaults.</td>
<td>for some reports.</td>
</tr>
</tbody>
</table>

**Help Menu**

*Help Menu Commands*

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>About</td>
<td>Displays version and copyright information for the current screen and program.</td>
</tr>
<tr>
<td>Contents</td>
<td>Opens Help.</td>
</tr>
<tr>
<td>Using Help</td>
<td>Opens Help to an introductory topic on how to use Help.</td>
</tr>
</tbody>
</table>

**Data Entry Tools and Shortcuts**

Use these tools and shortcuts to speed up data entry in Sage 300 ERP.

*Data Entry Tools and Shortcuts*

<table>
<thead>
<tr>
<th>Tool</th>
<th>Button</th>
<th>Shortcut Key</th>
<th>Description</th>
</tr>
</thead>
</table>
| Drilldown|        | n/a          | The Drilldown button appears beside some data entry fields and in some column headings in transaction detail entry tables. Click it to view details of the record or transaction in the corresponding field. You can "drill down" both within Sage 300 ERP programs and between separate programs. For example, you can drill down:  
- From General Ledger transactions to original transaction entries.  
- From Accounts Receivable to Order Entry.  
- From Accounts Payable to Purchase Orders.  
- From one transaction to an originating transaction (such as from a credit note to the invoice) within a |
## Tool Button Shortcut Key Description

<table>
<thead>
<tr>
<th>Tool</th>
<th>Button</th>
<th>Shortcut Key</th>
<th>Description</th>
</tr>
</thead>
</table>
| Finder     | ![Finder Icon] | F5           | The Finder appears in some data entry fields, and in some table headings in transaction entry screens. Click it when you want to look up records you can select for a field. Use the Finder to search lists of codes maintained in or used by Sage 300 ERP programs (such as document numbers, terms codes, and account set codes). You can use menu commands in the Finder to help you search, as follows:  
  - On the Settings menu, select **Color** options to highlight a field using color for the text or for the background.  
  - On the Settings menu, select **Field Name as Column Heading** to use field descriptions or internal field names as column headings.  
  - On the Settings menu, use **Columns** options to specify columns that appear in the table.  
  - On the Global Settings menu, select the **Go to Filter First** option if you want the Finder to display the same filter settings you specified on the **Find By** list the next time you search this type of record.  
You can also use the **Auto Search** option to locate a record quickly in a long list. To do this, select **Auto Search** and the criteria by which you want to search, and then begin typing the characters that start or are contained in the field you are searching on. |

---
## Data Entry Tools and Shortcuts

<table>
<thead>
<tr>
<th>Tool</th>
<th>Button</th>
<th>Shortcut Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note:</td>
<td></td>
<td></td>
<td>Records that appear in the Finder are restricted by any selection criteria you apply to this field. If you cannot find the record you are looking for with the Finder or the navigation buttons, check the Finder to see whether any criteria are being used to limit the selection. If necessary, remove the selection criteria. (For more information, see &quot;Setting Finder Criteria&quot; (page 712))</td>
</tr>
<tr>
<td>Tip:</td>
<td></td>
<td></td>
<td>For additional instructions on using the Finder to select records, press F1 when the Finder screen appears.</td>
</tr>
<tr>
<td>Go</td>
<td>⏩</td>
<td>F7</td>
<td>The Go button appears on screens where you must enter information (such as filter criteria) before viewing records that match the information you enter. For example, on some Statistics and Inquiries screens, you must select a range of years and periods and specify an item number or vendor number before you can view statistics. (If you use multicurrency accounting, you must also specify a currency.) After specifying this information, you click the Go button or press F7 to view statistics.</td>
</tr>
<tr>
<td>Inquiry</td>
<td>🔍</td>
<td>n/a</td>
<td>The Inquiry button appears beside some data entry fields. Click it to view comprehensive information for the record selected in the field.</td>
</tr>
<tr>
<td>Example:</td>
<td></td>
<td></td>
<td>In Accounts Receivable transaction screens, an Inquiry button appears beside the Customer Number field. You can click it to view all available information about the selected customer in the A/R Customer Inquiry screen.</td>
</tr>
<tr>
<td>Navigation</td>
<td>⚪️</td>
<td>n/a</td>
<td>Click the Previous and Next buttons to navigate through a list of existing records, or click the First and Last</td>
</tr>
</tbody>
</table>
## Appendix C: Data Entry Tools, Tips, and Shortcuts

<table>
<thead>
<tr>
<th>Tool</th>
<th>Button</th>
<th>Shortcut Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td><img src="image" alt="New Button" /></td>
<td>n/a</td>
<td>Click the New button or select <strong>New</strong> from a menu to begin creating a new record.</td>
</tr>
</tbody>
</table>
| Zoom     | ![Zoom Button](image) | F9           | Click the Zoom button or press the F9 key to view or enter supplementary information for a transaction detail or for a field.  

In any detail entry table, you can select a detail line and press F9 to open a screen that displays all the fields for a single detail, including additional tax-related fields that do not appear on the detail table. You can edit existing details, and even add new details for the document.  

Beside any field that displays a Zoom button, you can click the button (or select the field and then press F9) to open a separate screen where you can view and enter supplementary information specific to that field.  

**Note:** If another Zoom button appears on the detail screen, you can click it or press Shift+F9 to open the new detail screen. (If you simply press F9 again, the first detail screen closes.) This function is referred to as "Detail Zoom." To close the second detail screen, press Shift+F9 again.  

After viewing or editing the information in the detail screen, you can press F9 to close the screen. 

---

710 Sage 300 ERP Inventory Control
Working with Detail Entry Tables

The first tab of each transaction entry screen in Sage 300 ERP contains a detail entry table that shows the document details in tabular format.

In most cases, you can enter all the necessary details for a document right on the table.

**Tip:** If there are more columns than can be displayed at one time, you can use the horizontal scroll bar at the bottom of a list to view the additional columns. You can also rearrange the order of columns, or change column widths, consistent with how you enter data.

You can also view and edit all the fields for a single detail on a separate Detail Items/Taxes screen. To view this screen, select a detail line and click the Item/Tax button below the table, or press F9.

**Note:** You use the Detail Items/Taxes screen to view or change tax information for a detail. Detail tax fields do not appear in the detail table.

**To add details using the detail table, do one of the following:**

- If a blank line is highlighted, tab to the Item Number field, then either type the item number or select it from the Finder. Enter the remaining information for the detail.

- To start a new line, press Insert or tab through the end of the last line on the table.

  If you want to insert a new line in a specific location, highlight the line above the location, and then press Insert.

**Note:** A detail line is saved as you enter it on the detail entry table.

**To edit details using the detail table:**

- Select the line you want to edit, and then enter your changes on that line.

  **Note:** For information about using your keyboard to move within a detail table, see "Keyboard Shortcuts for Detail Tables" (page 712)

**To delete details using the detail table:**

1. Select the line you want to delete.

2. Press the Delete key on your keyboard.
3. If you see a message asking you to confirm the deletion, click Yes.

To edit item information or detail tax information using the Detail Items/Taxes screen:

1. Select the detail on the table, and then either click the Item/Tax button, or press F9.
2. Edit the item information and/or change the Tax Class or Tax Included options for the detail.

Keyboard Shortcuts for Detail Tables

Use the following keyboard shortcuts to navigate in detail tables.

<table>
<thead>
<tr>
<th>Key</th>
<th>Menu Command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ins/Insert</td>
<td>New</td>
<td>Insert a blank row to add a new record.</td>
</tr>
<tr>
<td>Del/Delete</td>
<td>Delete</td>
<td>Remove the selected row.</td>
</tr>
<tr>
<td>Up or Down Arrow</td>
<td></td>
<td>Go up or down one row.</td>
</tr>
<tr>
<td>Left or Right Arrow</td>
<td></td>
<td>Go left or right one column.</td>
</tr>
<tr>
<td>Pg Up</td>
<td></td>
<td>Go to the top row in view.</td>
</tr>
<tr>
<td>Pg Dn</td>
<td></td>
<td>Go to the bottom row in view.</td>
</tr>
<tr>
<td>Home</td>
<td>First</td>
<td>Go to the first row in a list.</td>
</tr>
<tr>
<td>End</td>
<td>Last</td>
<td>Go to the last row in a list.</td>
</tr>
<tr>
<td>Tab or Enter;</td>
<td></td>
<td>Go to the next or previous column in a list.</td>
</tr>
<tr>
<td>Shift+Tab or</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shift+Enter</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Setting Finder Criteria

To help you search quickly through a long list of records, you can use criteria to restrict the records that are displayed in the Finder and when you use the navigation buttons.

However, at other times, if the Finder uses criteria, it might not display all the records you expect to see.
To check or remove the criteria:

1. Click the Finder ♩.
2. Click the Set Criteria button.
3. On the screen that appears, click the Clear button.

For instructions on setting criteria, click the Help button when the Set Criteria screen appears.
Appendix D: Support and Resources

Find support and resources to help get Sage 300 ERP up and running quickly.

Finding Help and Documentation

You can find information about setting up and using Sage 300 ERP in the Sage 300 ERP Learning Center and in the product documentation included with this release.

**Note:** For technical support, visit our customer support website at [http://na.sage.com/sage-300-erp/product-support](http://na.sage.com/sage-300-erp/product-support) or contact your Sage business partner.

The Sage 300 ERP Learning Center

The Learning Center is where you'll find documentation for new product features and modules in the Sage 300 ERP Portal. It features articles and information about the portal, shortcuts, snapshots, and Inquiry.

**You view the Learning Center in one of the following ways:**

- Open the Sage 300 ERP Portal, and on the welcome bar at the top of the screen, click **Help > Learning Center**.
- On the tab menu for any portal tab, click **Help**.

Context-Sensitive Help

Sage 300 ERP features context-sensitive help that you can use to quickly open and view articles and information directly from Sage 300 ERP screens.

- In the Sage 300 ERP Portal, click **Help** on the tab menu to view help for the current screen.
- On the Sage 300 ERP Desktop, press **F1** to view help for the current screen.
Appendix D: Support and Resources

Product Documentation

Sage 300 ERP includes guides in printable PDF format, including the Installation and Administration Guide, Upgrade Guide, and other documentation related to installation and setup.

These guides are available in the Docs folder on the Sage 300 ERP server, and online in the Sage Customer Portal at:

- [https://customers.sagenorthamerica.com/irj/go/km/docs/sageKM/Sage Accpac ERP/Ungated Customers/Browsable/Product Documentation/Accpac_UA_Resources.htm](https://customers.sagenorthamerica.com/irj/go/km/docs/sageKM/Sage Accpac ERP/Ungated Customers/Browsable/Product Documentation/Accpac_UA_Resources.htm).

To view the guides in the Docs folder:

- On the Windows taskbar, click Start > Programs > Sage 300 ERP > Documentation.

Support and Resources

Use the links below to find instructions, software training, one-on-one support, technical specifications, or other resources to get Sage 300 ERP working smoothly for your business.

Your Sage Business Partner is also an excellent resource to consult when you have questions about Sage 300 ERP.

How can we help you?

I'm setting up Sage 300 ERP and need information or assistance

- Sage 300 ERP Resources online — [https://customers.sagenorthamerica.com/irj/go/km/docs/sageKM/Sage Accpac ERP/Ungated Customers/Browsable/Product Documentation/Accpac_UA_Resources.htm](https://customers.sagenorthamerica.com/irj/go/km/docs/sageKM/Sage Accpac ERP/Ungated Customers/Browsable/Product Documentation/Accpac_UA_Resources.htm)

  Find and download user guides, technical specifications, and more.

- Sage 300 ERP Web Portal — [http://www.sage300erp.com](http://www.sage300erp.com)

  Find a business partner, get priority support, and more.

I'm looking for instructions to complete a task in Sage 300 ERP

While using Sage 300 ERP, you can get instructions directly from the software in the following ways:
• **Contextual Help** — To see topics related to your current task:
  - In the Sage 300 ERP Desktop, press **F1**
  - In the Sage 300 ERP Portal, press **Alt+F1**

• **Help Topics** — To explore topics and information:
  - In the Sage 300 ERP Desktop, click **Help > Help Topics**
  - In the Sage 300 ERP Portal, click **Help > Learning Center**

**I think something is broken, or I’m getting error messages**
Search our knowledge base for solutions to common issues, or contact us for one-on-one assistance.

• **Knowledge Base** — [https://customers.sagenorthamerica.com](https://customers.sagenorthamerica.com)
  Find answers and solutions to FAQs and known software issues.

• **Support and Services** — [http://na.sage.com/sage-300-erp/product-support](http://na.sage.com/sage-300-erp/product-support)
  Find links to support services or contact our support team.

• **Customer Center** — [https://customers.sagenorthamerica.com/irj/portal/anonymous/login](https://customers.sagenorthamerica.com/irj/portal/anonymous/login)
  Exclusive support for Sage customers.

• **Partner Center** — [https://partners.sagenorthamerica.com](https://partners.sagenorthamerica.com)
  Exclusive support for Sage partners.

  Learn how to get unlimited support by phone, e-mail, and live chat.

**I’m looking for downloads, updates, or technical specifications**
Find product updates, download resources, or review technical specifications for Sage 300 ERP.

• **Sage 300 ERP Resources online** —
  [https://customers.sagenorthamerica.com/irj/go/km/docs/sageKM/Accpac ERP/Ungated Customers/Browsable/Product Documentation/Accpac_UA_Resources.htm](https://customers.sagenorthamerica.com/irj/go/km/docs/sageKM/Accpac ERP/Ungated Customers/Browsable/Product Documentation/Accpac_UA_Resources.htm)
Appendix D: Support and Resources

Find and download user guides, technical specifications, and more.

  Find links to support services, contact our support team, and learn how to guarantee your Sage software is always up to date.

**I want to become a more skilled user of Sage 300 ERP**
Find links to Sage software training, online communities, and more.

- **Sage University** — [www.sageu.com/sage300erp](http://www.sageu.com/sage300erp)
  Convenient, professional training options to help you achieve your business goals.

- **Sage Summit** — [http://na.sage.com/sage-summit](http://na.sage.com/sage-summit)
  Connect with peers and experts at our annual conference.

  Learn how to get unlimited support by phone, e-mail, and live chat.

**I want to share knowledge with other Sage 300 ERP users**
Find and share tips, tricks, and solutions online in the Sage 300 ERP Community.

- **Sage 300 ERP Community** — [http://community.sageaccpac.com](http://community.sageaccpac.com)
  Explore Sage 300 ERP blogs, discussions, FAQs, resources, and more.

- **Sage Summit** — [http://na.sage.com/sage-summit](http://na.sage.com/sage-summit)
  Connect with peers and experts at our annual conference.

**I want to contact a Sage 300 ERP representative**

  Find links to support services, contact our support team, and learn how to guarantee your Sage software is always up to date.

- **Live Chat** — [http://community.sageaccpac.com](http://community.sageaccpac.com)
  Chat with a Sage representative at the Sage 300 ERP Community Web site
Account set codes 161-162
Account sets 41, 43, 561
   about deleting 46
   assigning costing methods to 119
   changing for an item 126
   costing method used for 16-17
Account Sets report 544
   printing 302
Account Sets screen 561
   fields and controls 562
Accumulate by calendar year 29
Actual costs 516, 519, 521
   entering/editing statistics 39
   under standard costing 16
   used to calculate variances 567
   using for physical inventory adjustments 235
Adding
   account sets 43
   items to price lists 91
Return statistics 40
Sales statistics 40
Segment codes 54
Statistics 40
Transaction statistics 39
Additional costs 184, 688
Adjustments 175
   adjustment types 176
   fields (Adjustments screen) 643
   job-related 644
   of item quantities and item costs 179
   of items that use average costing 235
   of items that use FIFO or LIFO costing 178
   processing automatically 276, 483
   receipts 187-188, 667
   using average (actual) cost for physical inventory 235
Adjustments screen 643
   fields and controls 644
Aged Inventory Report 519
   printing 331
Allow Items At All Locations 24
Alternate cost names 591
Alternate items 108
Alternate Items report 545
   printing 303
Assemblies 167, 170, 650
   and negative inventory levels 153
   build quantity 152
   for multilevel bills of material 154
   negative inventory levels 153
   of items that use FIFO or LIFO costing 169
   with alternative bills of material 154
Assemblies/Disassemblies screen 650
   fields and controls 651
assigning items to locations 137
audit reports 297-298, 365
authorizations (I/C security)
   to use Inventory Control screens 699
average cost
   defined 17
   used in variance calculation 17
   using for physical inventory adjustments 235

B

bar codes 142
   adding to items 142
   scanning serial numbers 245
bills of material 155, 157-158, 380, 387, 474
   about 151
   alternative BOMs 154
   build quantity 152
deleting 156
   fixed and variable costs 153
   looking up by component 292
   multilevel 154
   rules for setting up 154
   using to assemble master items 170
   when to use 151
Bills of Material report 545
   printing 304
Bills of Material screen 380
   fields and controls 380
bin numbers
   adding to items 141
bin/shelf labels 520
   printing 333
BOM Component Usage Inquiry screen 632
BOMs See bills of materials
buckets, used in costing 15
build quantity 152
   fractional quantities 152
buttons
   Drilldown 707
   Finder 708
   Go 709
   Inquiry 709
   Navigation 709
   New 710
   Zoom 710

C

calculating the cost of goods
   shipped/returned 19
categories 49, 565
   about deleting 51
   and General Ledger 48
   and general ledger accounts 567
   and Order Entry 49
   and Purchase Orders 49
   overview 47
Categories report 546
   printing 306
Categories screen 565
   fields and controls 566
categories, changing for an item 126
   and cost variances 127
Clear History screen 488
   fields and controls 489
clearing history 271, 278
codes 10, 49, 52, 87, 553, 612
   item number segments 56
   report of price list codes 317
   segments 617
collections of items 453
combining lots 259
commands 707
commissions 565
company options 589
components 151, 161
   tracking using serial and/or lot numbers 261
Construct Item Number screen
   fields and controls 384
contacts 583, 589
Contract Codes screen 570
   fields and controls 570
contract codes, adding 63
contract prices
   adding for customers 135
   clearing 278
Contract Pricing report 531
   printing 361
Contract Pricing screen 385
   fields and controls 385
Copy Bills of Material screen 387
   fields and controls 388
Copy Item Pricing screen 391
   fields and controls 392
Cost of Goods Sold account 567
Cost Variance account 567
cost variances 510
   calculated during inventory reconciliation 518
   calculated for standard cost items 16
distributed to G/L accounts 127
for Most Recent Cost 17
G/L account 229
costing See also costing methods
costing methods 15, 19
   about Serial and Lot costing 18
   about transfers of FIFO/LIFO costed items 206
assigning to items 119
FIFO costing method 20
LIFO costing method 20
Lot (costing method) 21
Most Recent Cost (costing method) 17, 20
Moving Average (costing method) 17
Serial costing method 21
Standard Cost (costing method) 16, 20
User-Specified (costing method) 18, 21
Weighted Moving Average (costing method) 19
costing options 589
costs See costing methods
   adjusting for items 179
   reports of 523
counting inventory 232, 325, 508, 515
counts 508
Create G/L Batch screen 486
   fields and controls 487
Create Subledger Transactions option 589
creating G/L batches 281
currency 13
current-year transactions 38, 117
Current Transactions Inquiry screen 628
fields and controls 629
Customer Details report 547
printing 307
Customer Details screen 395
fields and controls 395
customer item numbers
adding 134
customer returns
receiving 199
customer warranties
registering serial numbers for 263

damaged goods account 567-568
data entry screens 712
day-end processing 228, 272, 492
about physical inventory 231
changing options for 35
performing 273
Day End Processing screen 492
fields and controls 493
Delete Inactive Records screen 487
fields and controls 488
deleting
account sets 46
an item from a price list 103
batches, to avoid posting twice 118
bills of material 156
categories 51
inactive records 280
item records 130
detail entry tables 711
details 182, 184, 194, 204
adding 711
deleting 711
editing 711
disassembling master items 172
discounts 440, 612
document See transactions
document numbering options 590
documentation and help 715
documents See transactions
Drilldown button 707

e-mail
printing reports as attachments to 299
editing
item records 126-127
option to allow edit of statistics 591
return statistics 40
sales statistics 40
statistics 40
transaction statistics 39
entering physical inventory quantities 236
entering transactions
adjustments 188
internal usage 218
receipts 185, 191
shipments 196, 199
transfers 210, 214
exporting 282
formats 7
**F**

fax number 589  
FIFO (costing method) 15, 20  
and adjustments to items 178  
and transfers of items 206  
assembling items that use 169  
FIFO items  
looking up costs 292  
File menu commands 705  
Close 705  
Customize 705  
Export 705  
Import 705  
Print 706  
Print Setup 706  
Save 706  
Finder button 708  
setting criteria 712  
First-in, First-out costing method See FIFO (costing method)  
fixed and variable costs  
in bills of material 153  
fixed assets  
identifying an item as 220  
fractional quantities  
build quantities 152  
function keys 707

**G**

G/L entries See general ledger transactions  
G/L integration options 73  
changing 77  
G/L Integration report 548  
printing 308  
G/L Integration screen 571  
fields and controls 572  
General Ledger 72  
accounts 44, 562  
and I/C categories 48  
general ledger account  
cost variance 229  
general ledger accounts 567-568  
general ledger batches 228, 486  
general ledger entries See general ledger transactions  
general ledger transactions 228, 487, 532  
clearing 278  
creating batches 281  
print 362  
Generate Inventory Worksheet screen  
fields and controls 505  
Go button 709  
Goods-In-Transit locations  
processing transfers to a G.I.T. location 210  
receiving transfers from G.I.T. location 214  
guides and documentation 715-716

**H**

Help menu 707  
history 38, 118, 488  
clearing 278
icons 707
importing
  formats 7
inactive records
  deleting 280, 487
Inquiry button 709
Inquiry screens
  BOM Component Usage Inquiry 632
  Current Transactions Inquiry 628
  Item Location Details Quantity Inquiry 633
  LIFO/FIFO Inquiry 631
  Lot Number Inquiry 640
  Lot Number Transaction Inquiry 642, 666
  Sales Statistics 622
  Serial Number Inquiry 638
  Stock Transactions Inquiry 635
  Transaction History Inquiry 629
  Transaction Statistics 625
Installation and Administration Guide 716
Installation and System Administrator's Guide 716
installing Sage 300 ERP, documentation on 716
integration with other programs 7, 81
  changing G/L integration options 77
internal usage
  entering transactions for 218
Internal Usage account 567-568
  Internal Usage screen 658
    fields and controls 659
inventory buckets (for costing inventory) 15
inventory costing options 589
inventory counts 504, 508, 512
  quantities 508
Inventory Counts screen 507
  fields and controls 507
Inventory Movement report 520
  printing 335
inventory quantities
  counting and reconciling 232
inventory reconciliation 241, 329, 516
  errors 239
inventory reports 515
inventory valuation See costing methods
inventory worksheets 241, 325, 515
  generating 504
  generating for stocktaking 233
item costs 117
  adjusting 179
item labels 336, 521
Item Location Details Quantity Inquiry screen 633
  fields and controls 633
item numbers 10
  adding customer numbers 134
  format 55
  report of manufacturers' numbers 551
  segments 590
  separator characters used in 59
item pricing 391, 475
  contract pricing 385
  updating for groups of items 104
Item Pricing screen 439
  fields and controls 442, 477
item quantities 117, 508
  adjusting 179
  counting and reconciling 232
item records 396
  deleting 130
item reorder quantities
  adding 145
  optimizing 147
item status 522
  report 338
item structures 55
  about setting up 57
  adding 59
  default 59
Item Structures report 549
  printing 309
Item Structures screen 579
  fields and controls 580
item valuation
  printing report of 340
  reports 523
item weight option 591
items 10, 130, 137, 406, 472, 476, 580
  adding bar codes/manufacturers' numbers to 142
  adding bin numbers 141
  adding kitting items 162
  adding picking sequences 141
  adding to price lists 91
  adding using the Items Wizard 109
  adding vendor details 132
  assigning costing methods to items 119
  assigning to locations 138
  assigning units of measure to 121
  assigning weight units of measure to 123
category, changing 126
deleting from a price list 103
editing 127
editing information using the Items Wizard 128
editing records 126
identifying as fixed assets 220
Items Wizard 406
kitting items 160
location details 454
master items 155, 157-158
non-stock 109
overview of setup 106
pricing 439
sold as collections 453
viewing location details for 140
Items screen 396
  fields and controls 396
Items Wizard 406
  adding items using 109
  fields and controls 407
  using to edit item information 128

J

job-related adjustments 644
journal entries 228
  adjustments 229
  receipts 228
  shipments 228
  transfers 229
Index

K

keyboard shortcuts
  for detail tables 712

keys 707

kitting items
  about 160
  adding 162
  when to use 151

Kitting Items report
  printing 311

Kitting Items screen 453
  fields and controls 453

L

labels 336, 521
  printing 333

Last-in, First-out costing method  See LIFO (costing method)

LIFO (costing method) 15, 20
  and adjustments to items 178
  and transfers of items 206

LIFO items
  looking up costs 292

LIFO/FIFO Inquiry screen 631
  fields and controls 631-632

location details
  adding 138
  viewing for an item 140

Location Details report 549
  printing 312

Location Details screen 454
  fields and controls 455

locations 52, 137, 581, 583
  about deleting 53
  assigning items to 138
  viewing details for an item 140

Locations report
  printing 313

Locations screen 550
  fields and controls 582

looking up BOMs by component 292

looking up costs of LIFO/FIFO items 292

looking up information
  lot numbers 290
  O/E transactions 287-288
  P/O transactions 287-288
  serial numbers 289
  statistics 285-286
  transaction history 285, 291

Lot (costing method) 21
  about 18

Lot Number Inquiry screen 640
  fields and controls 641

Lot Number Transaction Inquiry screen 642, 666

lot numbers 205, 243, 678
  assigning to adjustments 248
  assigning to
    assemblies/disassemblies 250
  assigning to internal usage transactions 252
  assigning to physical inventory quantities 254
  assigning to receipts 246
  assigning to shipments 256
  assigning to transfers 257
  looking up information 290
reconciling 499
  using to track components 261
  viewing/editing details for 149
Lot Numbers screen 482
Lot Recalls/Releases screen 493
  fields and controls 494
Lot Splits/Combines screen 495
  fields and controls 496
lot tracking 243
  Allocation/Generation screen 202
lots, splitting and combining 259
lotted items
  creating G/L transactions for 32, 575
  restricted costing options 589
  updating warranties for 262
  viewing/editing details for 149
master items 651
  assembling using bills of material 170
maximum quantities 471
  optimizing 460
menus and commands 705, 707
  File 705
  Help 707
  Settings 706
minimum quantities 471
  optimizing 460
month-end processing 271, 486-488
Most Recent Cost (costing method) 17, 20
  and cost variances 17
multicurrency 13-14, 591
multilevel bills of material 154

N
Navigation buttons 709
negative costs 524
negative inventory levels
  and assemblies 153
New button 710
non-stock items 109
numbers 10
  formatting 55

O
offset buckets 15
  used for adjustments 178
Optimize Inventory screen 460
  fields and controls 462
Optional Fields report 551
  printing 315
Optional Fields screen (setup) 69, 608-609
assigning optional fields in IC 608
creating optional fields 608
saving optional fields 608
Optional Fields screen (transactions) 696
fields and controls 609
optional fields, using in transactions 223, 225
options 21, 73, 316, 552
allowing edit of statistics 37
changing G/L integration options 77
company contact information 589
document numbering 590
for lotted items 591
for Optimize Inventory screen 591
for printing reports 298
for serialized items 592
general ledger integration 571
item number segments 590
processing 591
Options screen 588
fields and controls 592
Order Entry 79
and I/C categories 49
Order Entry transactions
looking up 288
ordering 471
overstocked items 525
printing report of 342

Create G/L Batch screen 486
creating G/L batches 281
Day End Processing 273
deleting inactive records 280
physical inventory 329, 504, 509, 512, 516
about 231
printing worksheets for stocktaking 327
using average (actual) cost for adjustment 235
physical inventory quantities
entering 236
Physical Inventory Quantities screen 508
fields and controls 509
picking sequences
adding to items 141
positive quantities 524
post an inventory reconciliation 238
Post Inventory Reconciliation screen 512
fields and controls 513
Post Transactions screen 666
posting 226, 492
saved receipts 190
posting journals 298, 365, 534
posting options 31-32
changing 35
price checks
messages for overrides 440
price list codes 317, 553, 612
adding 65
Price List Codes screen 612
fields and controls 613
price lists 86, 100, 368, 439, 476, 538
adding items to 91
delete an item 103

period-end processing 271
periodic processing 508
  clearing history and statistics 278

P

728 Sage 300 ERP Inventory Control
maintaining 90
price/sales analysis reports 360
prices
  adding contracts for customers 135
  updating prices for groups of items 104
pricing 391, 475, 612
pricing items 439
print destinations 299
  e-mail attachment 299
  file 299
  physical printer 299
  preview (on screen) 299
printer
  assigning to a specific report 300
printer, physical
  setting as print destination 299
printing
  Aged Inventory report 331
  Inventory Movement report 335
  Mask Structures report 310
  Optional Fields report 315
  Quarantine report 344
  Recall report 345
  Serial/Lot Number List report 348
  Serial/Lot Number Quantity on Hand report 350
  Serial/Lot Stock Listing report 351
  Serial/Lot Transactions report 353
  Stock Transactions report 356
  Transaction Listings 375, 557
  Units of Measure report 321
  Warranty/Contract Codes report 323
  Warranty/Contract List report 359
  Weight Units of Measure report 324, 556
  worksheets for stocktaking 327
printing labels 333
printing reports 300
  Account Sets 302
  Alternate Items 303
  Bills of Material 304
  Bin/Shelf Labels 333
  Categories 306
  Customer Details 307
  G/L integration 308
  G/L Transactions 362
  Inventory Reconciliation 329
  Inventory Worksheet 325
  Item Status 338
  Item Structures 309
  Item Valuation 340
  Kitting items 311
  Location Details 312
  Locations 313
  Manufacturers' Items 314
  Markup Analysis 364
  options 298
  Options report 316
  Overstocked Items 342
  Posting Journals 365
  Price List Codes 317
  Price/Sales Analysis 368
  Reorder 346
  Reorder Quantities 318
  Sales Statistics 369
  Segment Codes 319
  Selling Price/Margin Analysis 371
  Slow Moving Items 354
  Transaction History 372

User's Guide 729
**Transaction Statistics** 374
**Vendor Details** 321
printing transfer slips 357
**Process Adjustments screen** 483
fields and controls 485
processing options 21
accumulating item statistics for reporting 28
allowing edit of statistics 37
allowing negative inventory quantities 24
alternate cost fields 26
changing 34
changing posting and day-end processing options 35
defining a unit of weight 27
handling additional costs on receipt returns 27
organizing statistics 29
saving transaction history for reporting 25
using fractional quantities 22
using multicurrency accounting 22
**Project and Job Costing** 80
projected sales 472
prorate 667
purchase orders 630
looking up by item 287
**Purchase Orders** 80
and I/C categories 49
**Purchase Orders transactions** looking up 288

**Q**
quantities 117, 471
adjusting for items 179
counting and reconciling inventory quantities 232
reports 523
quarantine
about placing lots on/releasing from 129
Quarantine Release screen 499
Quarantine Report 527
printing 344
quarantined lots
releasing 266

**R**
Recall Report 527
printing 345
recalling lotted items 264
receipt returns 190
receipts 184, 187, 667
adjusting 188
adjustments 187
entering 184
posting 190
Receipts screen 667
fields and controls 668
receiving goods 184
reconciling 512
reconciling inventory quantities 232
reconciling lot numbers 499
steps 266
reconciling serial numbers 499
  steps 266
records 7, 15, 17, 41, 48, 52, 86, 112, 130, 144
registering serial numbers for customer warranties 263
releasing
  quarantined lots 266
releasing lotted items 264
reorder 528
reorder information 144, 318, 347, 528
reorder quantities 318, 553
  adding 145
  optimizing 147
Reorder Quantities screen 471
  fields and controls 472
reordering 471
reorders
  printing report of 346
reporting general ledger data 362
reports 295, 297, 515, 538, 545
  Alternate Items 545
overstocked items 525
posting journals 534
print destinations 299-300
printing 375
  Price/Sales Analysis reports 360, 365, 368
  Setup reports 310, 315, 323-324, 544-549, 551
  Stock Control reports 331, 335, 344-345, 348, 350-351, 353, 355-356, 359, 519-520, 529
printing options 298
printing Weight Units of Measure 324, 556
Quarantine 527
Recall 527
Transaction Listings 557
return statistics
  adding 40
  editing 40
returning goods
  to vendors 191
returns 190, 193, 668, 681
  entering for goods returned by customers 199
Returns account 567

S
Sage Fixed Assets
  integration with 81
sales 100, 193, 681
Sales account 567
sales analysis reports 360
sales orders
  drilling down to 630
  looking up by item 287
sales returns 193, 681
sales statistics 38, 369, 539
  adding 40
  editing 40
  looking up 285
Sales Statistics screen 622
  fields and controls 623
screen guides 379, 571
  Items and Price Lists 379
  Periodic Processing 483

User's Guide 731
<table>
<thead>
<tr>
<th>Physical Inventory</th>
<th>504</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reports</td>
<td>515</td>
</tr>
<tr>
<td>Setup</td>
<td>561</td>
</tr>
<tr>
<td>Statistics and Inquiries</td>
<td>622</td>
</tr>
<tr>
<td>Transactions</td>
<td>643</td>
</tr>
<tr>
<td>security authorizations</td>
<td>699</td>
</tr>
<tr>
<td>segment codes</td>
<td>56, 319, 554, 617</td>
</tr>
<tr>
<td>Segment Codes screen</td>
<td>617</td>
</tr>
<tr>
<td>fields and controls</td>
<td>617</td>
</tr>
<tr>
<td>specifying for use in item numbers</td>
<td>590</td>
</tr>
<tr>
<td>selling price/markup analysis</td>
<td>371, 541</td>
</tr>
<tr>
<td>separator characters</td>
<td>used in item numbers</td>
</tr>
<tr>
<td>Serial (costing method)</td>
<td>21</td>
</tr>
<tr>
<td>about</td>
<td>18</td>
</tr>
<tr>
<td>Serial Number Inquiry screen</td>
<td>638</td>
</tr>
<tr>
<td>fields and controls</td>
<td>639</td>
</tr>
<tr>
<td>serial numbers</td>
<td>677</td>
</tr>
<tr>
<td>assigning to adjustments</td>
<td>248</td>
</tr>
<tr>
<td>assigning to</td>
<td>assemblies/disassemblies</td>
</tr>
<tr>
<td>assigning to internal usage transactions</td>
<td>252</td>
</tr>
<tr>
<td>assigning to physical inventory quantities</td>
<td>254</td>
</tr>
<tr>
<td>assigning to receipts</td>
<td>246</td>
</tr>
<tr>
<td>assigning to shipments</td>
<td>256</td>
</tr>
<tr>
<td>assigning to transfers</td>
<td>257</td>
</tr>
<tr>
<td>looking up information</td>
<td>289</td>
</tr>
<tr>
<td>reconciling</td>
<td>499</td>
</tr>
<tr>
<td>registering for customer warranties</td>
<td>263</td>
</tr>
<tr>
<td>using bar code readers to scan</td>
<td>245</td>
</tr>
<tr>
<td>using to track components</td>
<td>261</td>
</tr>
<tr>
<td>viewing/editing details for</td>
<td>148</td>
</tr>
<tr>
<td>Serial Numbers screen</td>
<td>481</td>
</tr>
<tr>
<td>Serial Registration screen</td>
<td>500</td>
</tr>
<tr>
<td>fields and controls</td>
<td>501</td>
</tr>
<tr>
<td>Serial/Lot Number Generation screen</td>
<td>677</td>
</tr>
<tr>
<td>Serial/Lot Number List Report</td>
<td>printing</td>
</tr>
<tr>
<td>Serial/Lot Number Quantity on Hand Report</td>
<td>printing</td>
</tr>
<tr>
<td>Serial/Lot Numbers Allocation/Generation screen</td>
<td>677</td>
</tr>
<tr>
<td>fields and controls</td>
<td>678</td>
</tr>
<tr>
<td>Serial/Lot Stock Listing Report</td>
<td>printing</td>
</tr>
<tr>
<td>Serial/Lot Transactions Report</td>
<td>printing</td>
</tr>
<tr>
<td>serialized inventory</td>
<td>205</td>
</tr>
<tr>
<td>creating G/L transactions for</td>
<td>32, 575</td>
</tr>
<tr>
<td>restricted costing options</td>
<td>589</td>
</tr>
<tr>
<td>updating warranties for</td>
<td>262</td>
</tr>
<tr>
<td>viewing/editing details for</td>
<td>148</td>
</tr>
<tr>
<td>setting up Inventory Control</td>
<td></td>
</tr>
<tr>
<td>account sets</td>
<td>43, 561</td>
</tr>
<tr>
<td>adding current and historical information</td>
<td>38, 117</td>
</tr>
<tr>
<td>bills of material</td>
<td>155, 157-158, 380</td>
</tr>
<tr>
<td>categories</td>
<td>49, 565</td>
</tr>
<tr>
<td>costing methods</td>
<td>15-18</td>
</tr>
<tr>
<td>importing and exporting</td>
<td>7</td>
</tr>
<tr>
<td>item structure</td>
<td>579</td>
</tr>
<tr>
<td>item structures</td>
<td>11, 59, 61</td>
</tr>
<tr>
<td>items</td>
<td>106, 112, 130, 396</td>
</tr>
<tr>
<td>locations</td>
<td>52, 137, 581</td>
</tr>
<tr>
<td>multicurrency</td>
<td>13</td>
</tr>
<tr>
<td>options</td>
<td>21</td>
</tr>
</tbody>
</table>
price list codes 65, 612
price lists 86, 391, 440, 476
reorder quantities 144, 460, 471
segment codes 617
steps for setting up I/C 5
units of measure 618
warranty codes 64
Settings menu 706
Settings menu commands
   Auto Clear 706
   Clear Saved Settings 706
   Save Settings as Defaults 706
setup reports
   Account Sets 544
   Alternate Items 545
   Bills of Material 545
   Categories 546
   Customer Details 547
   G/L Integration 548
   Item Structures 549
shipment returns
   entering 199
shipments 193, 680
   entering 196
Shipments screen 680
   fields and controls 681
shortcuts 707
slow-moving items 529
   printing report of 354
specifying different account segments for locations 55
splitting lots 259
Standard Cost (costing method) 16, 20
statistics 38, 117
   adding 40
   allowing editing 37
   clearing 278
stock 271, 504, 508, 512
stock control reports 325, 329, 515-516
stock transactions
   looking up 285
Stock Transactions Inquiry screen 635
   fields and controls 636
Stock Transactions Report
   printing 356
stocktaking
   generating inventory worksheets for 233
   printing worksheets for stocktaking 327
structure codes
   about setting up 57
   default 59
structure, items 579
T
taxes 406
technical support 715-716
tools 707
tracking components
   using serial and/or lot numbers 261
tracking lot numbers 243
transaction history 38, 372, 542
   clearing 278
   looking up 291
Transaction History Inquiry screen 629
   fields and controls 630
Transaction Listings report  557
  printing  375
transaction screens
  Serial/Lot Number Allocation  677
transaction statistics  374, 543
  adding  39
  editing  39
  looking up  286
Transaction Statistics screen  625
  fields and controls  626
transactions  38, 118, 165, 167, 184, 190, 217-218, 228, 362, 532, 651, 659, 668, 681, 689
  entering shipments  196
  internal usage, entering  218
  optional fields  223
Post Transactions screen  666
  posting  226
  receipts  187
  using optional fields in  225
transfer slips
  printing  357
Transfer Slips Report  529
transferring data to Inventory Control  7
transfers  202, 688
  and FIFO/LIFO costing methods  206
  entering  206
  processing from a Goods-In-Transit location  214
  using a Goods-In-Transit location  210
Transfers screen  688
  fields and controls  689
types of adjustments  176

U

units of measure  620
  about  82
  assigning to items  121
  printing report of  321
  setup screen  618
Units of Measure report  555
  printing  321
Units of Measure screen
  fields and controls  618
UOMs  See units of measure
Update Bills of Material screen  474
  fields and controls  474
  updating item pricing
    for groups of items  104
Upgrade Guide  716
UseActualCostForPI field
  using for physical inventory adjustments  235
User-Specified (costing method)  21, 109
  using I/C with other modules  72, 79-80

V

valuation  See costing methods
valuation methods  See costing methods
variance
  calculated for standard cost items  16
vendor details
  about  132
  adding to items  132
Vendor Details report  321
  printing  321
Vendor Details screen
  fields and controls 480
vendors 479, 555
viewing location details for an item 140

W

warranties
  registering serial numbers for customers 263
  updating for serialized and lotted items 262
warranty codes
  adding 64
Warranty Codes screen 619
  fields and controls 619
Warranty Update screen 502
  fields and controls 502
Warranty/Contract Codes report
  printing 323
Warranty/Contract List Report
  printing 359
weight option 591
weight units of measure
  assigning to items 123
Weight Units of Measure report 556
  printing 324, 556
Weight Units of Measure screen 620
  fields and controls 621
Weighted Moving Average (costing method) 17, 19
wizards
  Items Wizard 406
worksheets 325, 508, 515
  generating for stocktaking 233

Z

zero quantities 524
Zoom button 710